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Chapter
 1
Introducing Veritas 

Storage Foundation and 

High Availability Solutions 

This chapter includes the following topics:

■ “About the solutions guides” on page 23

■ “About Quick Recovery” on page 24

■ “About high availability” on page 24

■ “About campus clusters” on page 24

■ “About disaster recovery” on page 24

■ “About Microsoft clustering solutions” on page 25

■ “How this guide is organized” on page 25

About the solutions guides
The Veritas Storage Foundation and High Availability Solutions Solutions Guide 

contains solutions for the following:

■ Quick Recovery

■ High availability (HA)

■ Campus clusters

■ Disaster recovery (DR)

■ Microsoft clustering

Separate guides are available for Microsoft SQL Server solutions.
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About Quick Recovery
About Quick Recovery
Quick Recovery is the process of creating and maintaining on-host point-in-time 

images of dynamic volumes that can be used to quickly recover from logical 

errors in data files.

Quick Recovery is designed to augment your traditional backup methodology.

About high availability
The term high availability (HA) refers to a state where data and applications are 

highly available because software or hardware is in place to maintain the 

continued functioning in the event of computer failure. High availability can 

refer to any software or hardware that provides fault tolerance, but generally 

the term has become associated with clustering. Local clustering provides high 

availability through database and application failover. Veritas Storage 

Foundation HA for Windows (SFW HA) includes Veritas Storage Foundation and 

Veritas Cluster Server and provides the capability for local clustering.

About campus clusters
A campus cluster is a single cluster that stretches over two sites using fiber 

channel connectivity, with SAN connections for data mirroring and network 

connections for cluster communication. Although two sites are the most 

common, more than two can be used for additional redundancy.

Campus clusters provide disaster protection when an entire site goes down by 

locating the clustered servers in different buildings or areas. This solution 

provides a level of high availability that is above mirroring or clustering at a 

single site and is an alternative to using replication software.

About disaster recovery
Wide area disaster recovery (DR) provides the ultimate protection for data and 

applications in the event of a disaster. If a disaster affects a local or 

metropolitan area, data and critical services are failed over to a site hundreds or 

thousands of miles away. Veritas Storage Foundation HA for Windows (SFW 

HA) provides the capability for implementing disaster recovery.
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About Microsoft clustering solutions
About Microsoft clustering solutions
Microsoft clustering may be used with Veritas Storage Foundation for Windows 

to provide high availability for any application or server role. 

Microsoft clustering may be used with Veritas Storage Foundation for Windows 

and Veritas Volume Replicator to provide high availability and replication 

support.

How this guide is organized
Where applicable, the Veritas Storage Foundation and High Availability 

Solutions Solutions Guide is organized to follow the workflow in the Solutions 

Configuration Center. 

See Chapter 2, “Using the Solutions Configuration Center”.

When setting up a site for disaster recovery using the Configuration Center, you 

first follow the steps under High Availability (HA) Configuration and then 

continue with the steps under Disaster Recovery Configuration. Likewise, in this 

guide, you first follow the instructions in the high availability section and then 

continue with the appropriate chapter in the disaster recovery section.



26 Introducing Veritas Storage Foundation and High Availability Solutions

How this guide is organized



Chapter
 2
Using the Solutions 

Configuration Center

This chapter covers the following topics:

■ About the Solutions Configuration Center

■ Starting the Solutions Configuration Center

■ Available options from the Configuration Center

■ How to launch the Configuration Center wizards

■ Using the Configuration Center from remote systems

■ Solutions wizard logs

■ Following the workflow in the Configuration Center

About the Solutions Configuration Center
The Storage Foundation and High Availability Solutions Configuration Center 

guides you through setting up your Veritas Storage Foundation for Windows 

(SFW) or Veritas Storage Foundation High Availability for Windows (SFW HA) 

environment. The Configuration Center provides solutions for the following 

applications:

■ Microsoft SQL Server 2008, 2008 R2, and 2012

■ Additional applications

Depending on the application, the following solutions may be available:

■ High availability at a single site for a new installation

■ High availability at a single site for an existing server

■ Campus cluster disaster recovery, including the following:
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Starting the Solutions Configuration Center
■ Campus cluster using SFW HA

■ Campus cluster using Microsoft clustering

■ Wide area disaster recovery involving multiple sites

■ Quick Recovery for on-host recovery from logical errors in application data

■ Fire drill to test the fault readiness of a disaster recovery environment 

Starting the Solutions Configuration Center
You can start the Solutions Configuration Center in the following ways:

■ Click Start > All Programs > Symantec > Veritas Storage Foundation > 

Solutions Configuration Center.

■ Click Start > All Programs > Symantec > Veritas Cluster Server > Solutions 

Configuration Center.

■ Click Start > Run and type scc.

Available options from the Configuration Center
On the Applications tab, the Solutions Configuration Center is context-sensitive 

to the application. For example, the solutions displayed when you click the 

application name are those available for that application. The steps that are 

shown when you click on a solution are customized for that application.
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How to launch the Configuration Center wizards
Figure 2-1 shows the solutions available when you click Solutions for Additional 

Applications. 

Figure 2-1 Solutions Configuration Center for additional applications

How to launch the Configuration Center wizards
The Solutions Configuration Center provides two ways to access wizards:

Applications tab Lists solutions by application. Provides step-by-step configuration 

instructions that include buttons to launch the appropriate wizard 

for each step.
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Using the Configuration Center from remote systems
Using the Configuration Center from remote 
systems

The Solutions Configuration Center and some wizards can be run from a remote 

system. Wizards that you can run remotely include the following:

Solutions tab (For advanced users) Lists wizards by solution, without additional 

instructions, as follows:

■ High Availability Configuration Wizards

■ Disaster Recovery Configuration Wizards

■ Quick Recovery Configuration Wizards

■ Fire Drill Configuration Wizards

You can go directly to a particular wizard.

Note: Solutions wizards cannot be used to perform Disaster 

Recovery, Fire Drill, or Quick Recovery remotely on Windows 2012 

Server Core systems.

Disaster Recovery 

Configuration Wizard

Configures wide area disaster recovery, including cloning 

storage, cloning service groups, and configuring the global 

cluster. Also can configure Veritas Volume Replicator (VVR) 

replication or configure the VCS resource for EMC SRDF and 

Hitachi TrueCopy array-based hardware replication. Requires 

first configuring high availability on the primary site.

To configure IPv6 settings, the wizard must be launched from 

a system on which the IPv6 stack is installed.

Fire Drill Wizard Sets up a fire drill to test disaster recovery. Requires 

configuring disaster recovery first.

To configure IPv6 settings, the wizard must be launched from 

a system on which the IPv6 stack is installed.

Quick Recovery 

Configuration Wizard

Schedules preparation of snapshot mirrors and schedules the 

Quick Recovery snapshots.

VCS Configuration Wizard Sets up the VCS cluster.

VVR Security Service 

Configuration Wizard

Configures the VVR security service.
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Solutions wizard logs
Wizards related to storage configuration and application installation must be 

run locally on the system where the process is occurring. Wizards that you must 

run locally include the following:

The Additional Applications section of the Configuration Center provides 

wizards to be run locally for creating service groups for the following 

applications or server roles:

Solutions wizard logs
The Solutions Configuration Center provides access to many wizards. However, 

three wizards are built in to the Solutions Configuration Center:

■ Disaster Recovery Wizard

■ Fire Drill Wizard

■ Quick Recovery Configuration Wizard

These three Solutions wizards are launched only from the Solutions 

Configuration Center, whereas other wizards can be launched from product 

consoles or the Start menu.

Logs created by these three Solutions wizards are located in the following path:

C:\ProgramData\Veritas\winsolutions\log

New Dynamic Disk Group 

Wizard

Launched from the Veritas Enterprise Administrator console.

New Volume Wizard Launched from the Veritas Enterprise Administrator console.

MSMQ Configuration 

Wizard

Configures a Microsoft Message Queuing (MSMQ) service 

group.

SFW Configuration 

Utility for Hyper-V Live 

Migration Support

Configure SFW for Microsoft Hyper-V Live Migration support 

on the selected systems.

File Share Configuration 

Wizard

Configures file shares for high availability

IIS Configuration Wizard Configures IIS for high availability

Application 

Configuration Wizard

Configures any other application service group for which 

application-specific wizards have not been provided
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Following the workflow in the Configuration Center
Following the workflow in the Configuration Center
During the multi-step High Availability Configuration workflow, you may find it 

helpful to run an SFW HA client on another system and leave the Solutions 

Configuration Center open on that system. In this way, you can see what step 

comes next, drill down to the information about that step, and access the online 

help if needed. You can also print the online help topics and the documentation 

in PDF format.

When setting up a site for disaster recovery, you first follow the steps under 

High Availability (HA) Configuration and then continue with the steps under 

Disaster Recovery Configuration.

Figure 2-2 shows the high-level overview of the workflow steps for configuring 

high availability for additional applications from the Solutions Configuration 

Center.

Figure 2-2 Workflow for configuring high availability for additional 

applications



Chapter
 3
SFW best practices for 

storage

This chapter includes the following topics

■ “Best practices for storage availability” on page 33

■ “Best practices configuring SFW disk groups for availability” on page 35

■ “Best practices for storage performance” on page 36

■ “Best practices for I/O performance tuning” on page 37 

■ “Best practices for storage capacity management” on page 39

Best practices for storage availability 
For high availability of storage, use the following best practices to ensure 

continued access to data:

■ Adding software mirrors for critical data

■ Locating data objects for optimum recovery

■ Managing three-way software mirrors for reliability

■ Software striping and mirroring on top of hardware RAID for high 

availability

Adding software mirrors for critical data 

For data that is absolutely critical to enterprise operation, use three-way 

mirrored volumes. 

Using host-based volume management to construct the mirrors takes very little 

CPU (server) bandwidth, because the data and log writes are concurrent. 

Additionally, connect the disks composing a three-way mirrored volume to the 
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hosts using independent paths (cables, host bus adapters, connectors) to protect 

against path failure as well as disk failure. 

Locating data objects for optimum recovery

When laying out volumes on disks with SFW, locate data objects that depend on 

each other on separate volumes, on separate disks. This ensures that a single 

disk failure does not destroy both data and its recovery mechanism.

Enterprise server environments often have interdependent sets of data. For 

example, the datasets in a database, its archive logs, and its redo log all depend 

on each other. If a volume holding database data fails, causing data loss, the 

typical practice would be the following steps: 

■ Repair the cause of the failure (for example, replace one or more disks). 

■ Restore the database to some baseline from a backup copy. 

■ Play the archive and redo logs against the restored copy to bring the 

database state as close to current as possible. 

If the database logs reside on the same volume as the data, however, both data 

and logs are inaccessible, and database recovery is impossible.

Managing three-way software mirrors for reliability

The storage on a broken-off mirror should be restored to the original volume 

during periods of low application I/O load, if possible, because 

resynchronization and regeneration are I/O-intensive activities that can 

adversely affect application performance. 

If a mirror is regularly broken off from a three-way mirrored volume, note that 

susceptibility to failure is greater during the interval between the third-mirror 

breakoff and the completion of resynchronization after the third-mirror storage 

is returned to the mirrored volume. By performing the restoration during 

periods of low I/O load, the susceptibility-to-failure window is minimized. 

Software striping and mirroring on top of hardware RAID for 
high availability

For data protection in addition to the performance of striping, apply mirroring 

on top of striping. Perform the striping first and then mirror the striped 

volumes. 

Striped volumes store large amounts of low-value or easily reproduced data 

where rapid access is required. Because striping alone will not maintain the 

availability of the data in a disk failure, consider mirroring also. 
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Best practices configuring SFW disk groups for availability
Best practices configuring SFW disk groups for 
availability

Veritas Storage Foundation for Windows supports multiple disk groups. Disk 

groups provide a way of organizing physical disks in a system into logical 

entities and simplify storage management for systems with large numbers of 

disks. 

Disk groups are useful for managing storage in clusters, as well as convenient 

for organizing and managing disk storage resources for applications. SFW 

allows moving disks between host systems, providing an easy method of 

transferring storage from one system to another. 

For high-availability with SFW disk groups, use the following best practices to 

ensure continued access to data:

■ Configuring disk groups for separate storage capacity pools or common 

pools

■ Allocating disk groups for availability in clusters

Configuring disk groups for separate storage capacity pools 
or common pools

Creating multiple disk groups creates separate storage capacity pools. 

Effective use of subdisks is key to efficient disk group structure. The subdisks 

composing any given volume must be allocated from disks within a single disk 

group. Raw physical storage in one of these pools is available exclusively for use 

within the pool and cannot be used in other disk groups, unless an administrator 

specifically moves a disk from one disk group to another. 

System administrators must decide on the basis of projected application and 

administrative needs whether to use disk groups to create disjointed storage 

pools or to manage all storage as a common pool. 

Effective configuration of disk groups depends on an organization's application 

needs. 

■ If a critical application requires frequent volume expansion, allocating its 

storage in a private disk group helps guarantee that capacity is available 

when required. When storage capacity is added to the system, it is not 

absorbed by other applications. 

■ If a critical application unexpectedly requires additional storage and none is 

available in the disk group from which its volumes are allocated, the 

application will fail, even if the required amount of storage is available in 

other disk groups. 
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In general, multiple pools give the administrator greater flexibility, whereas a 

common pool may be more convenient for applications. 

Allocating disk groups for availability in clusters 

In a cluster, each application that fails over independently of other applications 

should have its data stored on volumes in disk groups exclusive to that 

application. 

In a clustered environment, the disk group is the unit in which storage fails over 

from one computer to another. Only entire disk groups fail over. Thus, volumes 

that hold data for applications that are required to fail over should belong to 

disk groups that hold data for that application only. This allows an application’s 

storage to fail over with the application and have no adverse effects on other 

applications or their associated storage. The disk groups should also be part of 

the application’s resource group, so that failover can occur. 

Best practices for storage performance 
For optimal performance of storage, use the following best practices to ensure 

fast access to data:

■ Best practices for storage performance

■ Host-based mirroring for increased read performance and failure tolerance

■ Using software RAID 5 for read-mostly data

Host-based mirroring for increased read performance and 
failure tolerance 

Use host-based mirroring of virtual disks to increase overall system read 

performance and failure tolerance.

SFW provides host-based volume management to RAID subsystems, increasing 

overall data availability and I/O performance. With host-based volume 

management, software RAID can be applied across RAID subsystems from the 

same or different vendors, thus aggregating all the desirable properties of RAID 

subsystems. 

In a mirrored configuration, read requests are handled in a round-robin fashion. 

The round-robin algorithm distributes read requests across all members, or 

“plexes,” of a mirrored volume. Mirroring can increase read performance 

significantly. 

Additionally, by configuring the hardware RAID subsystem-based virtual disks 

exported by different controllers as members of a host-based mirrored volume, 
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the host-based mirrored volume provides protection against I/O bus, host bus 

adapter, enclosure power and cooling, RAID controller, and disk failures. 

Software striping across hardware for increased 
performance 

Use SFW to combine multiple hardware arrays connected to the host via 

multiple buses in a single large striped volume, for higher transfer rates with 

some applications.

Host-based volume management can be used to aggregate the performance of 

multiple hardware subsystems by striping data across two or more virtual disks, 

each managed by a different RAID controller. Construct stripes across similar 

devices for the best use of storage. Because certain high-bandwidth applications, 

such as audio-visual streaming, have data transfer requirements that surpass 

the capability of a hardware array controller attached to the host by a single 

connection, the ability to aggregate the bandwidth of multiple data buses is 

needed. 

Using software RAID 5 for read-mostly data 

Host-based RAID-5 volumes are recommended for read-mostly data, because 

noticeable performance degradation may occur due to the overhead that writes 

generate. 

Host-based RAID-5 volumes should be avoided in applications in which the rate 

of updates is high (more than about 10% of the aggregate I/O request-handling 

capacity of the disks constituting the volume), unless sufficient host CPU cycles 

are available. Disk controller RAID-5 volumes equipped with nonvolatile write-

back cache may be used for more write-intensive applications (up to about 40% 

of the aggregate I/O request capacity of the disks composing the volume). 

Best practices for I/O performance tuning 
SFW enables administrators to “tune” any type of striped volume, including 

RAID-5 and mirrored striped volumes, by adjusting the stripe unit size. This 

feature is particularly useful for optimizing the I/O performance of these 

volume types. 

Most I/O-bound applications can be characterized as one of the following: 

■ I/O-request intensive, making I/O requests faster than the hardware to 

which they are made can satisfy them 

With rare exceptions, transaction-oriented applications (for example, credit 

verification, point of sale, order taking) are I/O-request intensive. 

See “Striping for I/O-request-intensive applications” on page 38.
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■ Data-transfer intensive, moving large single streams of data between 

memory and storage 

Scientific, engineering, audio, video, and imaging applications are typically 

data-transfer intensive. 

See “Striping for data-transfer-intensive applications” on page 39.

If a striped volume will be used predominantly for one or the other of these I/O 

load types, the stripe unit size can be set at volume creation to optimize I/O 

performance. 

Striping for I/O-request-intensive applications 

A good compromise stripe unit size for I/O-request-intensive applications is one 

that results in a 3% to 5% probability of splitting in a uniform distribution of 

requests. For example, a 2 KB (four-block) database page size would have an 

ideal stripe unit size of 100 blocks. This would typically be rounded up to the 

nearest power of two (128 blocks, or 65,536 bytes) for simplicity.

I/O-request-intensive applications are typically characterized by small (for 

example, 2 to 16 KB) data transfers for each request. These applications are I/O 

bound because they make so many I/O requests, not because they transfer large 

amounts of data. 

For example, an application that makes 1,000 I/O requests per second with an 

average request size of 2 KB uses at most 2 MB per second of data transfer 

bandwidth. Because each I/O request occupies a disk completely for the duration 

of its execution, the way to maximize I/O throughput for I/O-request-intensive 

applications is to maximize the number of disks that can be executing requests 

concurrently. Clearly, the largest number of concurrent I/O requests that can be 

executed on a volume is the number of disks that contribute to the volume’s 

storage. Each application I/O request that “splits” across two stripe units 

occupies two disks for the duration of its execution, reducing the number of 

requests that can be executed concurrently and thus the efficiency of I/O 

response. 

Therefore, try to minimize the probability that I/O requests “split” across stripe 

units in I/O-request-intensive applications. 

The following factors influence whether an I/O request with a random starting 

address will split across two stripe units: 

■ The request starting address relative to the starting address of the storage 

allocation unit (the file extent) 

■ The size of the request relative to the stripe unit size 

Most database management systems will allocate pages in alignment with the 

blocks in a file, so that requests for the first page will almost never split across 

stripe units. However, database requests for two or more consecutive pages may 
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split across stripe units. In this case, larger stripe unit sizes reduce the 

probability of split I/O requests. However, the primary objective of striping data 

across a volume is to cause I/O requests to be spread across the volume’s disks. 

Too large a stripe unit size is likely to reduce this spreading effect. 

Striping for data-transfer-intensive applications 

The ideal stripe unit size for data-transfer-intensive applications that use a 

striped volume is the typical I/O request size of the application, divided by the 

number of data disks in the stripe. For example, if an application typically 

makes requests for 256 KB, an ideal stripe size for a four-disk striped volume 

would be 64 KB (256 KB/4). 

Data-transfer-intensive applications typically request a large amount of data 

with every request, between 64 KB and 1 MB, or more. When a large amount of 

data is requested, the data-transfer phase of the request represents the majority 

of the request execution time. Thus, reducing data-transfer time improves I/O 

performance.

A single disk can transfer data only as fast as the data passes under the disk’s 

read-write head. For example, a disk that rotates at 10,000 RPM and has 200 

blocks on a certain track cannot transfer data to or from that track any faster 

than 17.06 MB per second (200 blocks x 512 bytes per block/0.006 seconds per 

revolution). An application request for 500 KB would require five platter 

revolutions, or 30 milliseconds, to execute. If the request were addressed to a 

volume of five identical disks created with SFW, each disk would ideally deliver 

one-fifth of the data, and the request would complete in a shorter time. 

In general, if a striped volume is optimized for data-transfer-intensive 

applications, each application I/O request will split evenly across all of the 

volume’s disks (or all but the disk containing parity data in the case of a RAID-5 

volume). 

Best practices for storage capacity management 
Maintaining a percentage of unallocated storage capacity in a disk group is a 

useful means of managing online storage to avoid application failures. When an 

application requires more storage, its volumes can be extended quickly and 

easily by a system administrator while it’s online, using the unallocated 

capacity. If volume expansion causes unallocated capacity to drop below a safety 

threshold, the event can be displayed in the GUI provided with SFW. Additional 

storage should then be installed and added to the disk group to maintain an 

adequate cushion for anticipated application requirements. 

For storage capacity management, use the following best practices to ensure the 

best allocation of data:
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■ Managing storage allocation for flexibility

■ Aggregating hardware RAID for very large volumes

■ Managing unallocated space for free space savings

■ Reserving spares for failure-tolerant volume recovery

Managing storage allocation for flexibility

One way to maximize the flexibility of storage allocation is to manage the disks 

in a disk group in units of a single capacity or of a small number of discrete 

capacities. This maximizes SFW’s flexibility to allocate storage when new 

subdisks are required for new volumes, for volume extension, or for moving a 

subdisk from one disk to another.

To ensure that the amount of unallocated storage in each disk group is adequate, 

an appropriate level of unallocated storage be maintained. The distribution of 

unallocated storage across disks must allow for management operations such as 

failure-tolerant volume expansion to be carried out without violating volume 

failure tolerance and performance restrictions. 

For example, if an additional mirror must be added to a mirrored striped 

volume, each subdisk of the added mirror must be located either on the same 

disk as the subdisk it extends, or on a disk separate from any of the volume’s 

existing subdisks. (A subdisk is defined as a number of consecutively addressed 

blocks on a disk.) Subdisks are created by SFW as building blocks from which 

volumes are created. When an administrator makes a request to extend a 

volume, SFW checks the unallocated space in the disk group containing the 

volume to make sure that extension is possible. An administrator must maintain 

a distribution of unallocated capacity that allows such operations. 

Aggregating hardware RAID for very large volumes 

Combine LUNs from multiple RAID controllers with SFW to construct a very 

large volume capable of holding a very large database or file system, spanning 

multiple LUNs across controllers. This combined capability can give users better 

access to their data than if the file system or database is split across multiple 

LUNs.

For any type of hardware RAID used in an array, the size of a database or file 

system is limited to the maximum size of a logical unit number (LUN) in the 

particular hardware array. However, this limitation is removed with advanced 

host-based volume management. 
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Managing unallocated space for free space savings

Any policy for maintaining a minimum percentage of a disk group’s capacity as 

unallocated space should include a cap to avoid maintaining wastefully large 

amounts of free space. 

How much unallocated capacity to maintain depends strongly on application 

characteristics. In most cases, however, there are lower and upper bounds 

beyond which less or more unallocated storage would be of little use. 

For example, an installation may observe a policy of maintaining a level of 8% to 

10% of a disk group’s total capacity as unallocated space. As the capacity of the 

disk group grows, however, the amount of unallocated space maintained by this 

policy can grow beyond any reasonable expectation of exploiting it effectively. If 

unallocated space is typically used in quantities of around 1 to 10 GB to relocate 

subdisks or to accommodate data processing peaks, then growing the disk group 

to 1 TB total capacity would mean that 100 GB are reserved for this purpose. If 

the typical number of subdisk moves or volume adds is one or two, a significant 

amount of storage capacity would never be used. 

Reserving spares for failure-tolerant volume recovery 

Reserve one or more spare disks for every 10 disks that are part of a failure-

tolerant volume, with a minimum of one spare disk for any disk group that 

contains failure-tolerant volumes. 

Storage capacity is managed in subdisk units, but entire disks usually 

fail.Because entire disks fail, spare capacity reserved for recovering from disk 

failures should be entire disks whose capacity is at least as large as that of the 

largest disk in a failure-tolerant volume in the disk group.

When a disk fails, all non-failure-tolerant volumes having subdisks on it fail, 

and all failure-tolerant volumes become degraded. 
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Section 
2

Quick Recovery

This section contains the following chapters:

■ Quick Recovery overview

■ Quick Recovery example
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Chapter
 4
Quick Recovery overview

The chapter’s topics are:

■ “About the Quick Recovery solution” on page 45

■ “Need for implementing the SFW Quick Recovery solution” on page 46

■ “Understanding the underlying components of SFW’s Quick Recovery 

process” on page 47

■ “Overview of the Quick Recovery process” on page 49

■ “Other applications for point-in-time snapshots” on page 50

About the Quick Recovery solution
Veritas FlashSnap is an option to SFW that is a highly efficient procedure 

involving multiple commands that allows detaching of a mirrored volume. Once 

the volume is detached, it can be used for a variety of purposes. This chapter 

focuses on the SFW Quick Recovery solution, which uses split-mirror snapshots 

to recover from logical errors in data files. It also gives a summary of the other 

uses for split-mirror snapshots.

Quick Recovery is the process of using on-host point-in-time copies of 

production data and a transaction log to recover a database that has been 

corrupted or that has missing data. If a database becomes corrupted, for 

example, you could reload the original data from the most recent snapshot, and 

then use the transaction log to bring the database current to the point before the 

corruption. 

The SFW Quick Recovery solution uses on-host, disk-based snapshots to provide 

fast recovery from logical errors and eliminates the time-consuming process of 

restoring data from tape.

 Additionally, Quick Recovery of Microsoft SQL Server databases is supported. 

Those procedures are provided through SFW’s vxsnap restore command and 

the VSS Snapshot wizards. 
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Need for implementing the SFW Quick Recovery solution
This chapter gives a general overview of SFW’s Quick Recovery solution.

For detailed information about implementing a Quick Recovery solution with 

SFW and Microsoft SQL Server, see the Veritas Storage Foundation and High 

Availability Solutions Quick Recovery  Solutions Guide for Microsoft SQL.

Need for implementing the SFW Quick Recovery 
solution

Advantages of using SFW’s Quick Recovery solution:

■ Faster than Restoring from Tape or Other Media 

On-host snapshot recovery is faster than restoring a full backup from tape 

or other media; this reduces downtime and helps meet service-level 

agreements for application availability. A Quick Recovery solution serves as 

a first line of defense to recover a corrupted database or missing data. The 

impact on system performance of maintaining a Quick Recovery image is 

limited to the brief time of detaching a split-mirror snapshot from its 

original volume. 

■ A Less Costly and More Flexible Solution than Array-based Snapshots

SFW’s split-mirror snapshots are based on the FlashSnap technology. 

FlashSnap puts the snapshot logic on the host system itself, so you can use 

any storage you have or might acquire to create snapshots. This is in 

contrast to a split-mirror image created through a hardware storage array, 

where you are limited to only the storage provided by the array vendor. 

FlashSnap provides several benefits over a hardware-based approach:

■ You can use virtually any storage hardware to create snapshots, 

including expensive arrays and simple JBOD storage.

■ The volumes that are copied can span physical devices.

■ The original and snapshot volumes can use different vendors’ storage 

arrays.

■ Integration with Microsoft Server Volume Shadow Copy Service

SFW integrates with the Windows Server Volume Shadow Copy Service 

(VSS) as both a VSS requestor and a VSS provider. This integration is 

provided by FlashSnap and SFW’s vxsnap command line utility and VSS 

Snapshot wizards. The VSS process enables a VSS-aware application, such 

as SQL Server, to be quiesced before the snapshot operation occurs and then 

resumed immediately after it. This pause of the application can produce 

Microsoft supported and guaranteed snapshots of your data. It protects the 

integrity of your data.

■ Allows Multiple Snapshots at One Time
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Understanding the underlying components of SFW’s Quick Recovery process
SFW offers the option to create simultaneous, multiple split-mirror 

snapshots. These snapshots can be done either through the GUI Snap Shot 

command or through the vxsnap CLI command.

Understanding the underlying components of 
SFW’s Quick Recovery process

SFW’s Quick Recovery solution uses Veritas FlashSnap and FastResync 

technology to leverage the Microsoft Volume Shadow Copy Service (VSS) 

capability to pause and resume a VSS-aware application.

FlashSnap 
FlashSnap provides the ability to create and maintain the on-host point-in-time 

copies that are integral to the Quick Recovery solution. FlashSnap is the multi-

step process used to create and maintain split-mirror snapshots that are copies 

of the original volumes they mirror. Both the original and snapshot volumes 

may consist of multiple physical devices, as in the case of RAID 0+1 (mirrored 

striped) volumes. FlashSnap cannot be used with software RAID-5 volumes. 

FlashSnap includes the following commands:

Prepare 

Creates a snapshot mirror and attaches it to the original volume. The Prepare 

procedure may take considerable time because it involves creating a mirror, but 

it has to be done only the first time you perform the snap commands sequence.

Note: The Prepare command replaces the Snap Start command in the GUI. Both 

prepare and snapstart keywords are available in the CLI, however 

prepare is the recommended keyword.

Snap Shot 

Detaches the snapshot mirror from the original volume. This split-mirror 

snapshot volume is an exact duplicate of the original volume at the point in time 

the snapshot command is executed.

Snap Back 

Reattaches the snapshot mirror to the original volume. The volumes can be 

resynchronized using either the original volume or the snapshot volume as the 

source. If a logical error has occurred on the original database volume, the 

snapshot volume can be used to quickly restore a consistent, point-in-time 

image to the original volume.

Snap Clear
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Permanently removes the association between the snapshot volume and the 

original volume.

Snap Abort

Aborts the snapshot operation after a Prepare or Snap Back command is issued. 

Snap Abort permanently removes the snapshot mirror from the volume and 

releases its space.

The FlashSnap commands listed above are implemented through the SFW GUI. 

There are also command line equivalents, using the vxassist or vxsnap 

command. 

FastResync (FR)
The FastResync capability optimizes the resynchronization of a snapshot 

volume and its original volume. FlashSnap uses FastResync technology to track 

the changed blocks in an original volume after a snapshot is detached. When the 

snapshot volume is resynchronized with the original volume by using the Snap 

Back command, only the changed data blocks are written to the snapshot 

volume. This greatly reduces the time and performance impact of 

resynchronization, which means that a Quick Recovery image can be refreshed 

with minimal impact on production.

FR is automatically enabled for a volume when the prepare operation is 

performed on the volume through the GUI Prepare command or the command 

line interface vxassist snapstart command.

Microsoft Volume Shadow Copy Service (VSS)
Microsoft Volume Shadow Copy Service (VSS) is a Windows service that 

provides the capability of creating snapshots or volume shadow copies. A 

volume shadow copy is a volume that represents a duplicate of the state of the 

original volume at the time the copy began. SFW integrates VSS into its 

snapshot function through the vxsnap command. Because SFW is a VSS 

requestor, it can initiate VSS snapshots at any time. 

The vxsnap command makes use of both FlashSnap and VSS technology to 

create high-quality snapshots that can be done when application files are open. 

VSS can quiesce the application for the moment when the snapshot is created 

and then resume the application immediately after the snapshot; but a VSS-

aware application must be used, such as Microsoft SQL Server. 

For more information on how VSS and SFW work together, see the Veritas 

Storage Foundation Administrator’s Guide.
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Overview of the Quick Recovery process
The Quick Recovery process can be broken down into three phases: creating, 

refreshing, and recovering.

Creating initial snapshots 
Split-mirror snapshots should be created on a regular schedule, following the 

backup of the database from tape. You can snapshot a database volume by itself 

or you can use the SFW GUI Snap Shot command or the vxsnap utility to 

snapshot one or more database volumes and any database log volumes 

simultaneously. If you have an application that is VSS-aware, such as Microsoft 

SQL Server, you have the advantage of creating VSS snapshots. By taking VSS-

enabled snapshots, you can create snapshot images without needing to take the 

database offline. 

Creating a snapshot is a two-step process. The first step, Prepare, creates the 

snapshot mirror attached to the original volume. The second step, Snap Shot, 

detaches the snapshot mirror from the original volume and creates a separate 

on-host split-mirror snapshot volume. 

Once a snapshot has been created, it can be refreshed quickly without repeating 

the time-consuming Prepare step.

Refreshing a snapshot
Periodically refresh or update your snapshot or set of snapshots so they contain 

a current copy of the original volumes. Refreshing a snapshot is a two-step 

process. During the first step, the Snap Back operation reattaches a snapshot 

volume to its original volume and uses Fast Resync to automatically update the 

snapshot mirror and synchronize it with the original volume, applying only the 

changes tracked in the Disk Change Object (DCO) volume. This process takes less 

time than the traditional method of copying the entire original volume to the 

returning mirror. In the second step, the Snap Shot operation is performed to 

detach the snapshot mirrors again, creating a new point-in-time copy of the 

database. If you are creating multiple snapshots, the SFW GUI Snap Shot 

command or the vxsnap CLI command must be used to snapshot all the database 

and log volumes simultaneously. This step is done without taking the database 

offline.

The Snap Back and vxsnap commands can be called from either the 

bpend_notify.bat file in Veritas NetBackup or from a batch file in a pre/post 

command to run at the completion of a Veritas Backup Exec for Windows 

Servers backup job. Additionally, a script could be written and used with the 

Windows Task Scheduler to automatically update the snapshot or set of 

snapshots on a regular basis.



50 Quick Recovery overview

Other applications for point-in-time snapshots
Recovering a database
In the event a database needs to be recovered, you can use the snapshot or set of 

snapshots to restore the data.

Caution: Data corruption can occur if the FlashSnap utility does not have 

exclusive access to the volumes accessed in the Snap Back command. Before 

running the Snap Back command when using the snapshot data as the source, 

close any Explorer windows, applications, consoles, or third-party system 

management tools that may be accessing the volumes.

For Microsoft SQL Server, you can use the snapshot volumes in a snapshot set to 

restore a corrupt database. You can restore a database to a specified point in 

time, the point of failure, or the point in time that the snapshot set was created 

(or last refreshed).

Refer to the Veritas Storage Foundation and High Availability Solutions, Quick 

Recovery Solutions Guide for Microsoft SQL for detailed procedures on Quick 

Recovery in a Microsoft SQL Server environment.

Other applications for point-in-time snapshots
This section describes several of the possible applications for using FlashSnap’s 

snapshots for off-host processing. Topics include:

■ “Off-host backups” on page 50

■ “Reporting and analysis” on page 51

■ “Application testing and training” on page 53

Off-host backups
The more frequent your backups, the less data lost or, in the case of a database 

with a transaction log, the faster your recovery. Incremental backups reduce the 

backup time but increase recovery time. For organizations with little or no 

backup window, off-host backups offer a good solution, particularly as the 

amount of data to be managed grows.

Because backups take place on another host, the backup window is of less 

concern, and you can make full backups each day. This speeds recovery time in 

the event a problem does occur.
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Figure 4-1 Mirror break-off and import of the snapshot to the alternate host

FlashSnap simplifies the process of making snapshot volumes available for off-

host processing with the Disk Group Split and Join feature. Using this feature, 

administrators can split one or more volume snapshots into another disk group, 

then “deport” the disk group. The alternate host, running Storage Foundation 

for Windows, can then import that disk group and its volumes for off-host 

processing.

When the off-host processing is complete, you can rejoin the snapshot volume 

and its disk group in a similar manner, deporting it from the secondary host, 

importing it to the primary host, and rejoining the original disk group.

FlashSnap snapshots can be backed up with Veritas NetBackup or Backup Exec. 

Reporting and analysis 
Decision support and business intelligence are data-intensive activities that are 

critical to many organizations. Analysts and others frequently need to access 

up-to-date or even real-time data in their analysis. Retail organizations, for 

example, want to spot sales trends as they occur, and typically require at least 

daily updates. Financial institutions likewise must keep a close eye on current 

transactions to spot trends or potential problems quickly.

Unfortunately, reporting and analysis data needs typically conflict with the 

performance requirements of transactional database applications. Reporting 

Import Disk Group
Break Off Mirror / Snapshot

Volume SnapshotVolume

Production Server

Alternate Host
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and analysis activities generally implement a few selected statements that scan 

a large number of records, and may include complex processing. This will have 

an impact on the many simpler write and update activities characteristic of a 

transactional system. For this reason, among others, many companies load data 

from operational systems into data warehouses specifically designed and tuned 

for analytic queries. But even the process of creating the data loads can have a 

performance impact on your operational systems, causing most organizations to 

schedule these Extract, Transform, and Load (ETL) processes during off-hours, 

such as in the middle of the night.

You can solve this problem by creating point-in-time snapshots of the 

production systems to be used for reporting and analysis purposes. You can 

either run reports directly against the snapshot volumes or use the snapshots to 

extract data for a data load to the warehouse.

Figure 4-2 Extract, transform, and load (ETL) process

Because taking the snapshot itself has a very brief, limited impact on the 

production system, you can generate fresh data for analysis on a regular basis. 

You can even create a replica of the production database on a secondary system 

to be accessible for “drill-down” analysis from OLAP applications. Again, in the 

off-host scenario, the analysis has no impact on the production system.
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Application testing and training
Software testing and training are other valuable applications for FlashSnap 

point-in-time copies. These are needs that cannot be addressed by simple data 

replication, because you need to be able to update and modify the copy of the 

data used for testing. FlashSnap addresses these needs easily.

By taking a snapshot and loading it on a host used for testing or development, 

you can provide developers and QA staff with the most realistic test data 

possible. By actually using a point-in-time copy of the production data, you can 

anticipate the behavior of the application in the production setting. You also 

save the time of creating and maintaining test data sets. This data can also be 

used for training purposes.
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High availability: Overview

This chapter contains the following topics:

■ “About high availability” on page 57

■ “About clusters” on page 57

About high availability
A high availability solution maintains continued functioning of applications in 

the event of computer failure, where data and applications are available using 

redundant software and hardware. “High availability” can refer to any software 

or hardware that provides fault tolerance, but generally it has become 

associated with clustering. This section will focus on local clustering 

configurations that use Veritas Cluster Server (VCS) with Veritas Storage 

Foundation for Windows.

About clusters
A cluster is a group of independent computers working together as a single 

system to ensure that mission-critical applications and resources are highly 

available. The cluster is managed as a single system, shares a common 

namespace, and is specifically designed to tolerate component failures and to 

support the addition or removal of components in a way that is transparent to 

users.

Keeping data and applications functioning 24 hours day and seven days a week 

is a requirement for critical applications today. Clustered systems have several 

advantages, including fault tolerance, high availability, scalability, simplified 

management, and support for rolling upgrades.
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How VCS monitors storage components
VCS provides specific agents that monitor storage components and ensure that 

the shared disks, disk groups, LUNs, volumes, and mounts are accessible on the 

system where the application is running. Separate agents are available for 

shared and non-shared storage and for third-party storage arrays such as 

NetApp filers. Your storage configuration determines which agent should be 

used in the high availability configuration.

For details on the various VCS storage agents, refer to the VCS Bundled Agents 

Reference Guide.

Shared storage—if you use NetApp filers
The VCS hardware replication agents for NetApp provide failover support and 

recovery in environments that employ NetApp filers for storage and NetApp 

SnapMirror for replication. The agents enable configuring NetApp filers over an 

iSCSI or Fibre Channel (FC) connection in a VCS cluster environment.

The VCS agents for NetApp are as follows:

■ NetAppFiler

■ NetAppSnapDrive

■ NetAppSnapMirror

These agents monitor and manage the state of replicated filer devices and 

ensure that only one system has safe and exclusive access to the configured 

devices at a time. The agents can be used in local clusters, single VCS replicated 

data clusters, and multi-cluster environments that are set up using the VCS 

Global Cluster Option (GCO).

In a typical configuration, the agents are installed on each system in the cluster. 

The systems are connected to the NetApp filers through a dedicated (private) 
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storage network. VCS cluster systems are physically attached to the NetApp filer 

via an ethernet cable supporting iSCSI or FC as the transport protocol.

VCS also provides agents for other third-party hardware arrays. For details on 

the supported arrays, refer to the product Software Compatibility List (SCL):

http://www.symantec.com/docs/TECH201485

Shared storage—if you use SFW to manage cluster dynamic  
disk groups

The VCS MountV and VMDg agents are used to monitor shared storage that is 

managed using Storage Foundation for Windows (SFW). SFW manages storage 

by creating disk groups from physical disks. These disk groups are further 

divided into volumes that are mounted on the cluster systems.

The MountV agent monitors volumes residing on disk groups. The VMDg agent 

monitors cluster dynamic disk groups and is designed to work using SCSI 

reservations. Together the MountV and VMDg agents ensure that the shared 

cluster dynamic disk groups and volumes are available.

Shared storage—if you use Windows LDM to manage  
shared disks

The VCS Mount and DiskReservation (DiskRes) agents are used to monitor 

shared disks that are managed using Windows Logical Disk Management (LDM).

The Mount agent monitors basic disks and mount points and ensures that each 

system is able to access the volume or mount path in the same way. The DiskRes 

agent monitors shared disks and uses persistent reservation to ensure that only 

one system has exclusive access to the disks. During failovers, these agents 

ensure that the disks and volumes are deported and imported on the node where 

the application is running.

http://www.symantec.com/docs/TECH201485
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Non-shared storage—if you use SFW to manage dynamic  
disk groups

VCS introduces the Volume Manager Non-Shared Diskgroup (VMNSDg) agent to 

support local non-shared storage configurations that are managed using SFW. 

The VMNSDg agent works without SCSI reservations and is designed for locally 

attached storage devices that do not support SCSI.

The VMNSDg agent monitors and manages the import and deport of dynamic 

disk groups created on local storage. The only difference between the VMDg 

agent and the VMNSDg agent is that the VMDg agent is designed for shared 

cluster dynamic disk groups and uses SCSI reservations, whereas the VMNSDg 

agent supports only non-shared local dynamic disk groups and works without 

SCSI reservations.

The VMNSDg agent can be used to set up single node Replicated Data Clusters 

(RDC) or Disaster Recovery (DR) configurations with replication set up between 

the sites.

During a failover, the VCS MountV and VMNSDg agents deport the locally 

attached storage from the affected node and then import the locally attached 

storage of the target node. Replication ensures that the data is consistent and 

the application is up and running successfully.

Note: The VMNSDg agent does not support fast failover and Intelligent 

Monitoring Framework (IMF).

Non-shared storage—if you use Windows LDM to manage  
local disks

VCS introduces the NativeDisks agent to support local non-shared storage 

configurations managed using Windows LDM. The NativeDisks agent works 

without SCSI reservations and is designed for local storage that does not 

support SCSI.

Together with the Mount agent, the NativeDisks agent monitors and manages 

the import and deport of basic local disks on the system. The only difference 

between the DiskRes agent and the NativeDisks agent is that the DiskRes agent 

is designed for shared disks and uses SCSI reservations, whereas the 

NativeDisks agent supports only non-shared local disks and works without SCSI 

reservations.

Note: The NativeDisks agent does not support fast failover and Intelligent 

Monitoring Framework (IMF).
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Non-shared storage—if you use VMware storage
VCS introduces the VMwareDisks agent to support storage configurations in a 

VMware virtual environment. The agent is platform independent and supports 

VMware Virtual Machine Disk (VMDK), Raw Device Mapping (RDM) disk files 

(virtual), and storage that is configured using Network File System (NFS). The 

VMwareDisks agent works without SCSI reservations and supports locally 

attached non-shared storage.

VMware features such as snapshots, vMotion, and DRS do not work when SCSI 

disks are shared between virtual machines. The VMwareDisks agent is designed 

to address this limitation. With this agent, the disks can now be attached to a 

single virtual machine at a time in the VCS cluster. On failover, along with the 

service group, the VMwareDisks agent moves the disks to the target virtual 

machine.

The VMwareDisks agent communicates with the host ESXi server to configure 

storage. This agent manages the disk attach and detach operations on a virtual 

machine in the VCS cluster. The agent is VMware HA aware. During failovers, 

the agent detaches the disk from one system and then attaches it to the system 

where the application is actively running. The VMwareDisks agent presents the 

virtual disks to the operating system. On Windows, the agent relies on the 

VMNSDg agent (in case of SFW-managed local storage) and the NativeDisks 

agent (in case of LDM-managed local storage) for initializing and managing the 

virtual disks. On Linux, the agent relies on the LVM and VxVM agents.

Note: The VMwareDisks agent does not support fast failover and Intelligent 

Monitoring Framework (IMF).
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Deploying SFW HA for high 

availability: New 

installation

This chapter covers the following topics:

■ “About the high availability solution” on page 64

■ “Tasks for a new high availability (HA) installation —additional 

applications” on page 64

■ “Reviewing the requirements” on page 66

■ “Reviewing the configuration” on page 73

■ “Configuring the storage hardware and network” on page 74

■ “Installing Veritas Storage Foundation and High Availability for Windows” 

on page 75

■ “Configuring disk groups and volumes” on page 85Configuring the cluster

■ “Configuring the cluster” on page 94

■ “Installing and configuring the application or server role” on page 113

■ “Configuring the service group” on page 115

■ “Enabling fast failover for disk groups (optional)” on page 156

■ “Possible tasks after completing the configuration” on page 160
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About the high availability solution
About the high availability solution
This chapter provides the steps for setting up a High Availability (HA) solution, 

using SFW HA in a new installation. The chapter describes the process for any 

generic application or server role and specifically for File Share and IIS.

Symantec recommends using the Solutions Configuration Center as a guide for 

installing and configuring SFW HA solutions for the example applications or 

server roles.

See “Using the Solutions Configuration Center” on page 27.

Tasks for a new high availability (HA) installation 
—additional applications

This chapter provides information on how to install and configure the high 

availability and application components. 

Table 6-1 outlines the high-level objectives for implementing the configuration 

and the tasks for each objective. 

Active-Passive One application instance per node with one to one failover 

capabilities. The active node of the cluster hosts the virtual 

server. The second node is a dedicated redundant server 

able to take over and host the virtual server in the event of 

a failure on the active node.

Active-Active Multiple application instances per cluster node.

For example, in a two-node cluster with two application 

instances, a different instance is online on each of the two 

servers. If a failure occurs, the instance on the failing node 

is brought online on the other server, resulting in two 

instances online on one server.

Table 6-1 Task list: New High Availability configuration 

Objectives Tasks

“Reviewing the requirements” on 

page 66

■ Verify hardware and software prerequisites

■ Review the requirements

“Reviewing the configuration” on 

page 73

Review the configuration

“Configuring the storage hardware 

and network” on page 74

Configure the storage hardware and network
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Tasks for a new high availability (HA) installation —additional applications
“Installing Veritas Storage 

Foundation and High Availability for 

Windows” on page 75

Install SFW HA

“Configuring disk groups and 

volumes” on page 85

■ Plan your storage layout

■ Create disk groups

■ Create volumes

■ Manage disk groups and volumes

“Configuring the cluster” on page 94 Use the VCS Cluster Configuration Wizard 

(VCW) to set up the cluster

“Installing and configuring the 

application or server role” on 

page 113

■ As necessary, install the application 

program files on the local system drive of 

the first node

■ Install files relating to the data and logs on 

the  target storage

■ Deport the disk groups on the first node 

and import them on the second node

■ Install the application on the second node

“Configuring the service group” on 

page 115

■ Use the applicable wizard to create and 

configure the VCS service group or groups

■ Create the application service group 

manually using templates from the Cluster 

Manager (Java Console) (if using a 

non-shared storage configuration)

■ Bring the service group online

“Enabling fast failover for disk groups 

(optional)” on page 156

■ Ensure that you have installed the Fast 

Failover option and met the prerequisites 

for storage

■ Use the Java Console to enable the 

FastFailover attribute for VMDg resources.

“Enabling fast failover for disk groups 

(optional)” on page 156

■ Switch the service group to the second node

■ Shut down an active cluster node

“Possible tasks after completing the 

configuration” on page 160

■ Modify the cluster configuration

■ Modify the application or server role 

service group

Table 6-1 Task list: New High Availability configuration (Continued)

Objectives Tasks



66 Deploying SFW HA for high availability: New installation

Reviewing the requirements
Reviewing the requirements
Review these product installation requirements for your systems before 

installation. Minimum requirements and Symantec recommended requirements 

may vary.

■ “Disk space requirements” on page 66

■ “Requirements for Veritas Storage Foundation High Availability for 

Windows (SFW HA)” on page 66

Disk space requirements
The following table estimates disk space requirements for SFW HA.

 

Requirements for Veritas Storage Foundation 
High Availability for Windows (SFW HA)

Before installing Veritas Storage Foundation High Availability for Windows 

(SFW HA), ensure that you review the following:

■ Review the general installation requirements for SFW HA in the Veritas 

Storage Foundation and High Availability Solutions for Windows Installation 

and Upgrade Guide.

■ Review the SFW HA Hardware Compatibility List to confirm supported 

hardware:

http://www.symantec.com/docs/TECH152806

■ Review the SFW HA Software Compatibility List to confirm supported 

software:

http://www.symantec.com/docs/TECH201485

Note: Solutions wizards cannot be used to perform Disaster Recovery, Fire 

Drill, or Quick Recovery remotely on Windows Server Core systems.

■ Review the operating systems supported with Veritas Storage Foundation 

High Availability for Windows (SFW HA).

Table 6-2 Disk space requirements

Installation options Required disk space

SFW HA + all options 832 MB

Client components 916 MB

http://www.symantec.com/docs/TECH152806
http://www.symantec.com/docs/TECH201485
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■ When installing SFW HA for a Disaster Recovery configuration, ensure that 

you select the VCS Global Clustering Option and if required for your 

replication solution, select the SFW Veritas Volume Replicator option.

■ When installing SFW HA for a Replicated Data Cluster configuration, ensure 

that you select the VCS option to install Veritas Volume Replicator.

Supported operating systems
SFW and SFW HA have client and server components that run on specific 

Windows operating systems.

SFW and SFW HA software for servers

Your system must run one of the operating systems listed to install the SFW or 

SFW HA server software.

Note: SFW software for servers supports Hyper-V and parent partitions. SFW 

HA software for servers does not support Hyper-V and parent partitions.

The following table shows supported operating systems.

SFW and SFW HA software for clients

The SFW or SFW HA client software can be installed on any one of the operating 

system versions, editions, and architectures that the Server Components are 

supported on, except Server Core.

Table 6-3 Supported operating systems

Windows Server Platform Edition Version

Windows Server 2012 x64 Standard, Datacenter GA

Windows 2012 Server Core x64 GA
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The following table shows the additional client operating systems that are 

supported.

Table 6-4 Additional supported client operating systems

Windows Client Platform Edition Version

Windows XP x86, x64 SP3 required 

for x86; SP2 

required for 

x64

Windows Vista x86, x64 Ultimate, Business, Premium SP1 or SP2 

required

Windows 7 x86, x64 Professional, Ultimate RTM or SP1 

required

Windows 8 x86, x64 Windows 8, Windows 8 Pro GA
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System requirements for SFW HA
Systems must meet the following requirements for SFW HA:

■ Memory must be a minimum 4 GB of RAM per server for SFW HA.

■ Shared disks to support applications that migrate between nodes in the 

cluster. Campus clusters require more than one array for mirroring. Disaster 

recovery configurations require one array for each site. Replicated data 

clusters with no shared storage are also supported.

If your storage devices are SCSI-3 compliant, and you wish to use SCSI-3 

Persistent Group Reservations (PGR), you must enable SCSI-3 support using 

the Veritas Enterprise Administrator (VEA). See the Veritas Storage 

Foundation Administrator’s Guide for more information.

■ SCSI, Fibre Channel, iSCSI host bus adapters (HBAs), or iSCSI Initiator 

supported NICs to access shared storage.

■ A minimum of two NICs is required. One NIC will be used exclusively for 

private network communication between the nodes of the cluster. The 

second NIC will be used for both private cluster communications and for 

public access to the cluster. Symantec recommends three NICs.

See “Best practices for SFW HA” on page 72.

■ NIC teaming is not supported for the VCS private network.

Network requirements for SFW HA
SFW HA has the following network requirements:

■ Do not install SFW HA on servers that are assigned the role of a Domain 

Controller. Configuring a cluster on a domain controller is not supported.

■ Ensure that your firewall settings allow access to ports used by SFW HA 

wizards and services. For a detailed list of services and ports used by SFW 

HA, refer to the Veritas Storage Foundation and High Availability Solutions 

for Windows Installation and Upgrade Guide.

■ Static IP addresses are required for certain purposes when configuring high 

availability or disaster recovery solutions. For IPv4 networks, ensure that 

you have the addresses available to enter. For IPv6 networks, ensure that the 

network advertises the prefix so that addresses are autogenerated. Static IP 

addresses are required for the following purposes:

■ One static IP address per site for each application virtual server.

■ A minimum of one static IP address for each physical node in the 

cluster.
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■ One static IP address per cluster used when configuring Notification or 

the Global Cluster Option. The same IP address may be used for all 

options.

■ For VVR replication in a disaster recovery configuration, a minimum of 

one static IP address per site for each application instance running in 

the cluster.

■ For VVR replication in a Replicated Data Cluster configuration, a 

minimum of one static IP address per zone for each application 

instance running in the cluster.

■ Configure name resolution for each node.

■ Verify the availability of DNS Services. AD-integrated DNS or BIND 8.2 or 

higher are supported.

Make sure a reverse lookup zone exists in the DNS. Refer to the application 

documentation for instructions on creating a reverse lookup zone.

■ DNS scavenging affects virtual servers configured in SFWHA because the 

Lanman agent uses Dynamic DNS (DDNS) to map virtual names with IP 

addresses. If you use scavenging, then you must set the DNSRefreshInterval 

attribute for the Lanman agent. This enables the Lanman agent to refresh 

the resource records on the DNS servers.

See the Veritas Cluster Server Bundled Agents Reference Guide.

■ In an IPv6 environment, the Lanman agent relies on the DNS records to 

validate the virtual server name on the network. If the virtual servers 

configured in the cluster use IPv6 addresses, you must specify the DNS 

server IP, either in the network adapter settings or in the Lanman agent’s 

AdditionalDNSServers attribute.

■ If Network Basic Input/Output System (NetBIOS) is disabled over the TCP/IP, 

then you must set the Lanman agent’s DNSUpdateRequired attribute to 1 

(True).
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IPv6 support

For IPv6 networks, the following is supported:

Note: Support is limited to mixed mode (IPv4 and IPv6) network configurations 

only; a pure IPv6 environment is currently not supported.

Permission requirements for SFW HA
The following permissions are required:

■ You must be a domain user.

■ You must be a member of the local Administrators group on all nodes where 

you are installing.

■ You must have write permissions for the Active Directory objects 

corresponding to all the nodes.

■ If you plan to create a new user account for the VCS Helper service, you must 

have Domain Administrator privileges or belong to the Account Operators 

group. If you plan to use an existing user account context for the VCS Helper 

service, you must know the password for the user account.

■ If User Access Control (UAC) is enabled on Windows Server systems, then 

you cannot log on to VEA GUI with an account that is not a member of the 

Types of addresses The following types of IPv6 addresses are supported:

■ Unicast addresses

Only Global Unicast and Unique Local Unicast addresses are 

supported.

■ Automatic configuration

Only Stateless IPv6 address configuration is supported. In 

stateless mode, the IP address is configured automatically 

based on router advertisements. The prefix must be 

advertised.

LLT over UDP LLT over UDP is supported on both IPv4 and IPv6.

You can use the Cluster Configuration Wizard (VCW) to configure 

LLT over UDP over IPv6.

VCS agents, wizards, 

and other 

components

VCS agents that require an IP address attribute and wizards that 

configure or discover IP addresses now support IPv6 addresses (of 

the type described above).

The VCS High Availability Engine (HAD) and the Global Cluster 

resource (WAC) also support IPv6 addresses.



72 Deploying SFW HA for high availability: New installation

Reviewing the requirements
Administrators group, such as a guest user. This happens because such user 

does not have the "Write" permission for the "Veritas" folder in the 

installation directory (typically, C:\Program Files\Veritas). As a 

workaround, an OS administrator user can set "Write" permission for the 

guest user using the Security tab of the "Veritas" folder's properties.

Additional requirements for SFW HA
Please review the following additional requirements:

■ Installation media for all products and third-party applications.

■ Licenses for all products and third-party applications.

■ For a Replicated Data Cluster, install only in a single domain.

Best practices for SFW HA
Symantec recommends that you perform the following tasks:

■ Verify that you have three network adapters (two NICs exclusively for the 

private network and one for the public network).

When using only two NICs, lower the priority of one NIC and use the 

low-priority NIC for public and private communication.

Note: If you wish to use Windows NIC teaming, you must select the Static 

Teaming mode. Only the Static Teaming mode is currently supported.

■ Route each private NIC through a separate hub or switch to avoid single 

points of failure.

■ NIC teaming is not supported for the VCS private network.

■ Verify that your DNS server is configured for secure dynamic updates. For 

the Forward and Reverse Lookup Zones, set the Dynamic updates option to 

"Secure only". (DNS > Zone Properties > General tab)

■ This is applicable for a Replicated Data Cluster configuration.

You can configure single node clusters as the primary and secondary zones. 

However, if using a shared storage configuration, you must create the disk 

groups as clustered disk groups. If you cannot create a clustered disk group 

due to the unavailability of disks on a shared bus, use the vxclus 

UseSystemBus ON command.
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Reviewing the configuration
This example configuration is one of the most common configurations for a 

cluster. It is a new installation with two servers and one storage array, in an 

Active-Passive configuration where the active node of the cluster hosts the 

virtual server and the second node is a dedicated redundant server able to take 

over and host the virtual server in the event of a failure on the active node. The 

example describes a generic database application.

The example configuration does not include dynamic multi-pathing. 

See “Adding DMP to a clustering configuration” on page 173.

Figure 6-1 SFW HA Active-Passive configuration with two servers
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Configuring the storage hardware and network
Use the following procedures to configure the hardware and verify DNS 

settings. Repeat this procedure for every node in the cluster.

To configure the hardware

1 Install the required network adapters, and SCSI controllers or Fibre Channel 

HBA.

2 Connect the network adapters on each system.

■ To prevent lost heartbeats on the private networks, and to prevent VCS 

from mistakenly declaring a system down, Symantec recommends 

disabling the Ethernet autonegotiation options on the private network 

adapters. Contact the NIC manufacturer for details on this process.

■ Symantec recommends removing TCP/IP from private NICs to lower 

system overhead.

3 Use independent hubs or switches for each VCS communication network 

(GAB and LLT). You can use cross-over Ethernet cables for two-node 

clusters. LLT supports hub-based or switch network paths, or two-system 

clusters with direct network links.

4 Verify that each system can access the storage devices. Verify that each 

system recognizes the attached shared disk and that the attached shared 

disks are visible.

To verify the DNS settings and binding order for Windows Server systems

1 Open the Control Panel (Start > Control Panel).

2 Click Network and Internet, and then click Network and Sharing Center.

3 In the Network and Sharing Center window, on the left side of the screen 

under Tasks, double-click Manage network connections.

4 Ensure the public network adapter is the first bound adapter:

■ From the Advanced menu in the Network Connections window, click 

Advanced Settings.

■ In the Adapters and Bindings tab, verify the public adapter is the first 

adapter in the Connections list. If necessary, use the arrow button to 

move the adapter to the top of the list.

■ Click OK.

5 Open the Public status dialog box by doing one of the following in the 

Network Connections window:

■ Double-click the adapter for the public network.
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■ Right-click the adapter for the public network and click Status.

■ Select the adapter for the public network and click View status of this 

connection in the toolbar.

When enabling DNS name resolution, make sure that you use the public 

network adapters, and not those configured for the VCS private network.

6 In the Public Status dialog box, on the General tab, click Properties.

7 In the Public Properties dialog box, on the General tab:

■ Select the Internet Protocol Version 4 (TCP/IPv4) or Internet Protocol 

Version 6 (TCP/IPv6) check box, depending on which protocol your 

network is using.

■ Click Properties.

8 Select the Use the following DNS server addresses option.

9 Verify the correct value for the IP address of the DNS server.

10 Click Advanced.

11 In the DNS tab, make sure the Register this connection’s address in DNS 

check box is selected.

12 Make sure the correct domain suffix is entered in the DNS suffix for this 

connection field.

13 Click OK.
 

Installing Veritas Storage Foundation and 
High Availability for Windows

You can install SFW HA using either the product installer wizard or the 

command line interface (CLI). Before you begin to install the product, ensure 

that you have reviewed and performed the required preinstallation and 

planning tasks.

Note: The Windows MPIO feature must be enabled for Windows Server before 

you proceed with SFW HA installation.
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During the installation you can choose to separately install the server 

components or the client components. If you choose to install the server 

components, the following components are installed by default.

Note: The high availability agents that get installed with the product software 

are also available in the form of an agent pack. The agent pack is released on a 

quarterly basis. The agent pack includes support for new applications as well as 

fixes and enhancements to existing agents. You can install the agent pack on an 

existing SFW HA installation. Refer to the Symantec Operations Readiness 

Tools (SORT) website for information on the latest agent pack availability.  
https://sort.symantec.com 
Refer to the agent-specific configuration guide for more details about the 

application agents.

Table 6-5 List of options installed by default

Option Description

Client components Installs the VCS Java Console on the same node where 

the server components are installed.

High Availability Hardware 

Replication Agents

■ Veritas Cluster Server Hardware Replication 

Agent for EMC MirrorView

Enables VCS to manage MirrorView replicated 

devices.

■ Veritas Cluster Server Hardware Replication 

Agent for EMC SRDF

Enables VCS to manage SRDF replicated devices. 

■ Veritas Cluster Server Hardware Replication 

Agent for EMC SRDFSTAR

Enables VCS to manage SRDFSTAR replicated 

devices.

■ Veritas Cluster Server Hardware Replication 

Agent for Hitachi TrueCopy

Enables VCS to manage TrueCopy replicated 

devices.

■ Veritas Cluster Server Hardware Replication 

Agent for MetroMirror

Enables VCS to manage MetroMirror replicated 

devices.

High Availability Database 

Agents

■ Veritas Cluster Server Database Agent for SQL 

Server—installs the VCS agent for SQL Server 

2008, 2008 R2, and 2012
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To install the server components,

See “Installing SFW HA server components using the product installer” on 

page 77.

To install the client components,

See “Installing the client components using the product installer” on page 83.

Installing SFW HA server components using the product installer
Use the following procedure to install SFW HA server components using the 

product installer.

Ensure that there are no parallel installations, live updates, or Microsoft 

Windows updates in progress.

During installation, some product features are installed by default and others 

must be selected, as follows:

■ For a disaster recovery configuration, select the VCS global cluster (GCO) 

option. 

■ If you plan to use Veritas Volume Replicator (VVR) for replication, select the 

SFW VVR option. 

■ If you plan to use the Fast Failover feature, select the VCS Fast Failover 

option.

To install SFW HA server components using the product installer

1 Insert the disc containing the installation software into your system’s disk 

drive or download the installation software from the Symantec website.

https://fileconnect.symantec.com

2 Allow the autorun feature to start the installation or double-click Setup.exe. 

The CD browser appears.

Note: If you are installing the software using the product software disc, the 

CD browser displays the installation options for all the products specified 

earlier. However, if you are downloading the installation package from the 

Symantec website, the CD browser displays the installation options only for 

the product to be installed.

3 Click to download the required contents.
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Note: The client components are installed by default along with the server 

components. However, on a server core machine, the client components will 

not be installed.

4 On the Welcome panel, review the list of prerequisites and click Next.

5 On the License panel, read the license terms, select I accept the terms of 

License Agreement, and then click Next.

6 On the System Selection panel, select the systems and the desired 

Installation and Product options.

You can select the systems in one of the following ways:

■ In the System Name or IP text box, manually type the system name or 

its IP address and click Add.

Note: The wizard does not support IPv6. To add systems having IPv6, 

you must type the system name.

The local host is populated by default.

■ Alternatively, browse to select the systems.

The systems that belong to the domain in which you have logged in are 

listed in the Available Systems list. Select one or more systems and 

Storage Foundation HA 

for Windows

Click to install the server and client components for 

SFW HA.

Late Breaking News Click to access the latest information about updates, 

patches, and software issues regarding this release.

Windows Data Collector Click to verify that your configuration meets all 

pertinent software and hardware requirements.

SORT Click to access the Symantec Operations Readiness 

Tools site.

In addition to the product download you can also 

download the custom reports about your computer 

and Symantec enterprise products, a checklist 

providing configuration recommendations, and 

system and patch requirements to install or upgrade 

your software.

Browse Content Click to view the software disc contents.

Technical Support Click to contact Symantec Technical Support.
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click the right arrow to move them to the Selected Systems list. Click 

OK.

Once you add or select a system, the wizard performs certain validation 

checks and notes the details in the Verification Details box. To review the 

details, select the desired system.

To select the installation and product options, perform the following tasks 

on each of the selected systems.

Note: To apply the selection to multiple systems, select the system for 

which you have selected the installation and product options and then click 

Apply to multiple systems. 
See “Applying the selected installation and product options to multiple 

systems” on page 82.

■ By default the wizard uses %ProgramFiles%\Veritas as the 

installation directory. To customize the installation directory, click 

Browse and select the desired location. Click OK.

■ Select the required license type from the License key drop-down list.

Note: The default license type is “Keyless”.

If you select the "Keyless" license type, all the available product options 

are displayed and are selected by default.

If you select "User entered license key" as your license type, the License 

Details panel appears by default. On the License Details panel, enter the 

license key and then click Add. You can add multiple licenses for the 

various product options you want to use.

The wizard validates the entered license keys and displays the relevant 

error if the validation fails. After the validation is complete, click OK.
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■ From the list of product options, select the appropriate options to be 

installed. The options differ depending on your product and 

environment.

Storage 

Foundation 

Options

■ Veritas Volume Replicator (VVR): Replicates data 

across multiple sites for disaster recovery.

■ FlashSnap: Allows you to create and maintain 

split-mirror, persistent snapshots of volumes and 

application components. FlashSnap supports VSS 

based snapshots to provide application data in a 

consistent state after the application is restored.

■ Replace Disk Management Snap-in with SFW VEA 

GUI: Replaces the Disk Management Snap-in in the 

Windows Computer Management console and the 

Server Manager console with the Veritas Enterprise 

Administrator GUI for Windows Server.
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7 On the System Selection panel, click Next. 

Note that the wizard fails to proceed with the installation unless all the 

selected systems have passed the validation checks and are ready for 

installation. If the validation checks have failed on any of the systems, 

review the details and rectify the issue. Before you choose to proceed with 

DMP Device 

Specific Modules

■ 3PARDATA array (V3PAR)

■ Dell Compellent array (VCOMPLNT)

■ Dell EqualLogic array (VEQLOGIC)

■ EMC cx4240 array (VEMCCLAR)

■ EMC VMAX array (VEMCSYMM)

■ Hitachi VSP array (VHDSAA)

■ HP P6000 array (VHPEVA)

■ IBM DS8000 array (VIBMAADS)

■ IBM XiV Storage System (VXIV)

Symantec maintains a Hardware Compatibility List (HCL), 

which provides information on HBAs and firmware that 

have been tested with each supported array. Check the HCL 

for details about your hardware before installing or using 

DMP DSMs.

The HCL is located at:

http://www.symantec.com/docs/TECH152806

Note: Do not use a DMP DSM together with a third-party 

DSM for the same array. Only one DSM at a time can claim 

the LUNs in an array. According to Microsoft Multipath I/O 

(MPIO) documentation, if multiple DSMs are installed, the 

Microsoft MPIO framework contacts each DSM to 

determine which is appropriate to handle a device. There is 

no particular order in which the MPIO framework contacts 

the DSMs. The first DSM to claim ownership of the device is 

associated with that device. Other DSMs cannot claim an 

already claimed device. Therefore, to ensure that the DMP 

DSM claims the LUNs of an array, no other DSM should be 

installed for that same array.

Veritas Cluster 

Server Options

■ Global Cluster Option (GCO): Enables you to link the 

clusters located in different geographies. This 

provides wide-area failover and disaster recovery.

■ Fast Failover: Improves the failover time taken by 

storage resources during the service group failovers, in 

a clustered environment. Fast failover is particularly 

noticeable in clusters having multiple storage stacks 

configured, typically over 20 disk groups and over 150 

volumes.

http://www.symantec.com/docs/TECH152806
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the installation, select the system and click Re-verify to re-initiate the 

validation checks for this system.

8 On the Pre-install Summary panel, review the summary and click Next. 

Note that the Automatically reboot systems after installer completes 

operation check box is selected by default. This will reboot all the selected 

remote systems immediately after the installation is complete on the 

respective system. If you do not want the wizard to initiate this auto reboot, 

clear the selection of Automatically reboot systems after installer 

completes operation check box. 

9 On the Installation panel, review the progress of installation and click Next 

after the installation is complete.

If an installation is not successful on any of the systems, the status screen 

shows a failed installation.

10 On the Post-install Summary panel, review the installation result and click 

Next.

If the installation has failed on any of the systems, refer to the log file for 

details. You may have to re-install the software.

11 On the Finish panel, click Finish.

If you chose to initiate the auto reboot, a confirmation message to reboot 

the local system appears. Click Yes to reboot immediately or No to reboot 

later.

If you did not choose to initiate the auto reboot, ensure that you manually 

reboot these systems.

This completes the product installation. 

Applying the selected installation and product options to 
multiple systems

The following procedure gives details on applying options to multiple systems.

To apply the selected installation and product options to multiple systems

1 Click on any one of the selected systems and select the desired installation 

and product options.

2 Click Apply to multiple systems.

3 On the Apply Installation Options panel, select the installation options to be 

applied and then select the desired systems. Click OK.
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Installing the client components using the product installer
Use the following procedure to install SFW HA client components using the 

product installer.

Note: Client components cannot be installed on server core systems.

Before you begin the installation, ensure that there are no parallel installations, 

live updates, or Microsoft Windows updates in progress on the system where 

you want to install the client components.

To install SFW HA client components using the product installer

1 Insert the software disk containing the installation package into your 

system's disc drive or download the installation package from the following 

Symantec Web site.

https://fileconnect.symantec.com

2 Allow the autorun feature to start the installation or double-click Setup.exe.

The CD browser appears.

3 Click to download the required contents.

4 On the Welcome panel, review the list of prerequisites and click Next.

Veritas Storage 

Foundation HA for 

Windows

Click to install the server or client components for 

SFW HA.

Late Breaking News Click to access the latest information about updates, 

patches, and software issues regarding this release.

Windows Data Collector Click to verify that your configuration meets all 

pertinent software and hardware requirements.

SORT Click to access the Symantec Operations Readiness 

Tools site.

In addition to the product download you can also 

download the custom reports about your computer 

and Symantec enterprise products, a checklist 

providing configuration recommendations, and 

system and patch requirements to install or upgrade 

your software.

Browse Content Click to view the software disc contents.

Technical Support Click to contact Symantec Technical Support.
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5 On the License Agreement panel, read the license terms, select I accept the 

terms of License Agreement, and then click Next.

6 On the System Selection panel, select the systems and the installation 

directory.

You can select the systems in one of the following ways:

■ In the System Name or IP text box, manually type the system name or 

its IP address and click Add.

Note: The wizard does not support IPv6. To add the systems having 

IPv6, you must type the system name.

Local host is populated by default.

■ Alternatively, browse to select the systems.

The systems that belong to the domain in which you have logged in are 

listed in the Available Systems list. Select one or more systems and 

click the right arrow to move them to the Selected Systems list. Click 

OK.

Once you add or select a system, the wizard performs certain validation 

checks and notes the details in the Verification Details box. To review the 

details, select the desired system.

By default the wizard uses %ProgramFiles%\Veritas as the installation 

directory. To customize the installation directory, click Browse and select 

the desired location. Click OK.

To apply the customized directory to multiple systems, click Apply to 

multiple systems. On the Apply Installation Options panel, select the 

systems to apply the customized directory. Click OK.

7 On the System Selection panel, click Next.

Note that the wizard fails to proceed with the installation unless all the 

selected systems have passed the validation checks and are ready for 

installation. If the validation checks have failed on any of the system, 

review the details and rectify the issue. Before you choose to proceed with 

the installation select the system and click Re-verify to re-initiate the 

validation checks for this system.

8 On the Pre-install Summary panel, review the summary and click Next.

9 On the Installation panel, review the progress of installation and click Next 

after the installation is complete.

If an installation is not successful on any of the systems, the status screen 

shows a failed installation.

10 On the Post-install Summary panel, review the installation result and click 

Next.
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If the installation has failed on any of the system, refer to the log file for 

details. You may have to re-install the software.

11 On the Finish panel, click Finish.

This completes the installation of the client components.
 

Configuring disk groups and volumes 
Use Veritas Storage Foundation for Windows to create disk groups and dynamic 

volumes for the application on the shared storage. A dynamic disk group is a 

collection of one or more disks that behave as a single storage repository. 

Within each disk group, you can have dynamic volumes with different RAID 

layouts.

Note: If your storage devices are SCSI-3 compliant, and you wish to use SCSI-3 

Persistent Group Reservations (PGR), you must enable SCSI-3 support using the 

Veritas Enterprise Administrator (VEA - Control Panel - System Settings). See the 

Veritas Storage Foundation Administrator’s Guide for more information.

Configuring disk groups and volumes involves the following tasks:

■ “Planning disk groups and volumes” on page 85

■ “Creating dynamic disk groups” on page 88

■ “Creating dynamic volumes” on page 90

Planning disk groups and volumes
The requirements for disk groups and volumes depend on the type of 

application or server role. Review the requirements and best practices for your 

application or server role:

■ Planning your File Share storage

■ Planning your IIS storage

■ Planning your storage for additional applications

■ Considerations for a fast failover configuration

Planning your File Share storage

Considerations for planning the File Share storage:

■ Make sure that the disk group and volumes for the file server shared 

directory are configured on shared storage (VMDg) or non-shared storage 

(VMNSDg).
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■ When configuring a new set up, first create the disk groups and volumes on 

the shared storage (VMDg) or non-shared storage (VMNSDg) and then create 

the directory structure for the file shares.

■ For an existing configuration that has a file server with shares on the local 

storage, move these shares to the shared storage (VMDg) or non-shared 

storage (VMNSDg) using the practices recommended by Microsoft.

Planning your IIS storage

Considerations for planning the IIS storage:

■ Make sure that the disk groups and volumes which will host the directory 

and files for the web sites are on the shared storage (VMDg) or non-shared 

storage (VMNSDg).

■ For a new IIS installation, make sure that the directory for the web sites is 

created on volumes on the shared storage (VMDg) or non-shared storage 

(VMNSDg).

■ For existing web sites, stop the sites and then move the website content to 

volumes on the shared storage (VMDg) or non-shared storage (VMNSDg). 

You must also reconfigure the home directory location for the web site in IIS 

and then restart the web site again.

Planning your storage for additional applications

The information provided in this section is generic to any application. Make 

sure you create the appropriate disk groups and volumes to hold the application 

data. If your application requires replication of registry keys between the cluster 

systems, then Symantec recommends that you create a dedicated RegRep 

volume so that its MountV dependency is not linked with any other 

application-specific resources in the group. 

Decide how you want to organize the disk groups and the number and type of 

volumes you want to create. Some considerations are:

■ The number of disk groups that are needed

The number of disk groups depends on your application and the planned 

organization of the data. VCS requires that the application program files be 

installed on the local system drive of the server. Data files and other related 

files, such as logs, are placed on the shared storage (VMDg) or non-shared 

storage (VMNSDg). Typically, a main organizational unit in your 

application would be contained in a single disk group.

■ The type of volumes you want to create

■ Mirrored and RAID-5 volumes provide fault tolerance for critical data. 

■ Striped volumes add performance capability. 
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■ Volumes that are both mirrored and striped offer both performance 

and fault tolerance.

Note: If you plan to use replication software, such as VVR, do not use 

software RAID-5 volumes. This does not apply to hardware RAID-5.

Recommendations: 

■ Use mirrored volumes for logs.

■ Use striped or mirrored striped volumes for data.

■ The implications of backup and restore operations for the disk group setup.

■ The sizes of databases and logs, which depend on the traffic load.

■ If you plan to implement a disaster recovery configuration with VVR, a 

Storage Replicator Log (SRL) volume is required for each disk group that 

contains volumes that are replicated. You can create the SRL volume now or 

you can create it later when you run the Disaster Recovery Wizard. If you 

create it later, ensure that you allow sufficient disk space for this volume.

Considerations for a fast failover configuration

For VCS service groups that contain many disk groups, you can greatly reduce 

failover time by implementing fast failover. Fast failover is a licensable feature 

of SFW HA. Fast failover speeds up the failover of storage resources in several 

ways:

■ Fast failover provides a “read-only deported” mode for disk groups on 

inactive nodes. This mode speeds up the process of importing a disk group. 

■ Fast failover maintains the current disk group configuration in memory on 

the inactive nodes. Any changes are automatically synchronized so that all 

nodes maintain an identical disk group configuration.

For more details about fast failover, refer to the Veritas Storage Foundation 

Administrator’s Guide.

To use fast failover, install the VCS Fast Failover option during SFW HA 

installation. Additional steps are required after you complete the service group 

configuration.

Take the following storage-related requirements into account if you are 

planning to implement fast failover:

■ Fast failover is currently not supported for the following:

■ RAID-5 volumes

■ SCSI-2

■ Active/Passive (A/P) arrays for DMP
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■ In synchronous mode of replication, if fast failover is set, then the RVG 

cannot be stopped and started when a disk group fails over to another node. 

If the RLINK is in hard synchronous mode, it may not be connected when 

the volume arrives, and the I/Os may fail. In such case, the Event Viewer 

displays NTFS errors and file system reports the volume as RAW. Therefore, 

fast failover is not supported if the RLINK is in hard synchronous mode.

■ The disk group version must be 60 or later for fast failover to work. To verify 

the disk group version, from the VEA console, right-click the disk group and 

click Properties. Disk group version upgrade is required after upgrading 

SFW HA on the cluster nodes. Refer to the Veritas Storage Foundation and 

High Availability Solutions Installation and Upgrade Guide for more 

information.
 

Creating dynamic disk groups
Follow the steps in this section to create one or more disk groups for your 

application.

Note: Dynamic disks belonging to a Microsoft Disk Management Disk Group do 

not support cluster disk groups.

To create a dynamic disk group

1 Open the VEA console by clicking Start > All Programs > Symantec > Veritas 

Storage Foundation > Veritas Enterprise Administrator (or launch the VEA 

from the Solutions Configuration Center) and select a profile if prompted.

2 Click Connect to a Host or Domain.

3 In the Connect dialog box, select the host name from the pull-down menu 

and click Connect.

To connect to the local system, select localhost. Provide the user name, 

password, and domain if prompted.

4 To start the New Dynamic Disk Group wizard, expand the tree view under 

the host node, right click the Disk Groups icon, and select New Dynamic Disk 

Group from the context menu.

5 In the Welcome screen of the New Dynamic Disk Group wizard, click Next.
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6 Provide information about the cluster disk group:

■ Enter the disk group name (for example, DG1).

■ Check the Create cluster group check box if you wish to create cluster 

dynamic disk groups that are used in a shared storage environment.

■ Select the appropriate disks in the Available disks list, and use the Add 

button to move them to the Selected disks list.

Optionally, check the Disk names prefix checkbox and enter a disk 

name prefix to give the disks in the disk group a specific identifier.

For example, entering TestGroup as the prefix for a disk group that 

contains three disks creates TestGroup1, TestGroup2, and TestGroup3 

as internal names for the disks in the disk group.

Note: For Windows Server operating systems, Windows Disk Management 

Compatible Dynamic Disk Group creates a type of disk group that is created 

by Windows Disk Management (LDM).

■ Click Next.

7 Click Next to accept the confirmation screen with the selected disks.

8 Click Finish to create the dynamic disk group.
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Creating dynamic volumes
Once the disk groups are created, make the disks within them usable by creating 

the dynamic volumes that will store data.

To create dynamic volumes

1 If the VEA console is not already open, click Start > All Programs > 

Symantec > Veritas Storage Foundation > Veritas Enterprise Administrator 

and select a profile if prompted.

2 Click Connect to a Host or Domain.

3 In the Connect dialog box select the host name from the pull-down menu 

and click Connect.

To connect to the local system, select localhost. Provide the user name, 

password, and domain if prompted.

4 To start the New Volume wizard, expand the tree view under the host node 

to display all the disk groups. Right click a disk group and select New 

Volume from the context menu.

You can right-click the disk group you have just created.

5 At the New Volume wizard opening screen, click Next.

6 Select the disks for the volume.

■ Make sure the appropriate disk group name appears in the Group name 

drop-down list.

■ For Site Preference, leave the setting as Siteless (the default).

■ Automatic disk selection is the default setting. To manually select the 

disks, click Manually select disks and use the Add and Remove buttons 

to move the appropriate disks to the Selected disks list. Manual 

selection of disks is recommended.

■ You may also check Disable Track Alignment to disable track alignment 

for the volume. Disabling Track Alignment means that the volume does 

not store blocks of data in alignment with the boundaries of the 

physical track of the disk.

■ Click Next.
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7 Specify the volume attributes.

■ Enter a volume name. The name is limited to 18 ASCII characters and 

cannot contain spaces or forward or backward slashes.

■ Select a volume layout type. To select mirrored striped, click both the 

Mirrored checkbox and the Striped radio button.

■ If you are creating a striped volume, the Columns and Stripe unit size 

boxes need to have entries. Defaults are provided.

■ Provide a size for the volume.

■ If you click on the Max Size button, a size appears in the Size box that 

represents the maximum possible volume size for that layout in the 

dynamic disk group.

■ In the Mirror Info area, select the appropriate mirroring options. 

■ Click Next.

8 In the Add Drive Letter and Path dialog box, assign a drive letter or mount 

point to the volume. You must use the same drive letter or mount point on 

all systems in the cluster. Make sure to verify the availability of the drive 

letter before assigning it. 

■ To assign a drive letter, select Assign a Drive Letter, and choose a drive 

letter.
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■ To mount the volume as a folder, select Mount as an empty NTFS 

folder, and click Browse to locate an empty folder on the disk.

9 Click Next.

10 Create an NTFS file system.

■ Make sure the Format this volume checkbox is checked and click NTFS.

■ Select an allocation size or accept the Default.
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■ The file system label is optional. SFW makes the volume name the file 

system label.

■ Select Perform a quick format if you want to save time.

■ Select Enable file and folder compression to save disk space. Note that 

compression consumes system resources and performs encryption and 

decryption, which may result in reduced system performance.

■ Click Next.

11 Click Finish to create the new volume.

12 Repeat these steps to create additional volumes.

Create the cluster disk group and volumes on the first node of the cluster 

only.
 

Managing disk groups and volumes
This section includes the following procedures:

■ Importing a disk group and mounting a shared volume

■ Unmounting a volume and deporting a disk group

During the process of setting up an SFW environment, refer to these general 

procedures for managing disk groups and volumes:

■ When a disk group is initially created, it is imported on the node where it is 

created.

■ A disk group can be imported on only one node at a time. 

■ To move a cluster dynamic disk group from one node to another, unmount 

the volumes in the disk group, deport the disk group from its current node, 

import it to a new node and mount the volumes.

Importing a disk group and mounting a volume
Use the VEA Console to import a disk group and mount a volume.

To import a disk group

1 From the VEA Console, right-click a disk name in a disk group or the group 

name in the Groups tab or tree view.

2 From the menu, click Import Dynamic Disk Group.

To mount a volume

1 If the disk group is not imported, import it.
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2 To verify if a disk group is imported, from the VEA Console, click the Disks 

tab and check if the status is imported.

3 Right-click the volume, click File System, and click Change Drive Letter and 

Path.

4 Select one of the following options in the Drive Letter and Paths dialog box 

depending on whether you want to assign a drive letter to the volume or 

mount it as a folder.

■ To assign a drive letter

Select Assign a Drive Letter, and select a drive letter.

■ To mount the volume as a folder

Select Mount as an empty NTFS folder, and click Browse to locate an 

empty folder on the shared disk.

5 Click OK.

Unmounting a volume and deporting a disk group
Use the VEA Console to unmount a volume and deport a disk group.

To unmount a volume and deport the dynamic disk group

1 From the VEA tree view, right-click the volume, click File System, and click 

Change Drive Letter and Path.

2 In the Drive Letter and Paths dialog box, click Remove. Click OK to continue.

3 Click Yes to confirm.

4 From the VEA tree view, right-click the disk group, and click Deport Dynamic 

Disk Group.

5 Click Yes.
 

Configuring the cluster
After installing SFW HA using the installer, set up the components required to 

run a cluster. The VCS Cluster Configuration Wizard (VCW) sets up the cluster 

infrastructure, including LLT and GAB, and configures Symantec Product 

Authentication Service in the cluster. The wizard also configures the 

ClusterService group, which contains resources for  notification and global 

clusters.

Complete the following tasks before creating a cluster:

■ Verify that each node uses static IP addresses (DHCP is not supported) and 

name resolution is configured for each node. 
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■ Set the required permissions:

■ You must have administrator privileges on the system where you run 

the wizard. The user account must be a domain account.

■ You must have administrative access to all systems selected for cluster 

operations. Add the domain user to the Local Administrators group of 

each system.

■ If you plan to create a new user account for the VCS Helper service, you 

must have Domain Administrator privileges or belong to the Domain 

Account Operators group. If you plan to use an existing user account 

for the VCS Helper service, you must know the password for the user 

account.

■ When configuring a user account for the VCS Helper service, make sure 

that the user account is a domain user. The VCS HAD, which runs in the 

context of the local system built-in account, uses the VCS Helper 

service user context to access the network. This account does not 

require domain admin privileges.

■ Make sure the VCS Helper service domain user account has “Add 

workstations to domain” privilege enabled in the Active Directory.

Refer to the Veritas Cluster Server Administrator’s Guide for complete 

installation and configuration details on VCS, and additional instructions on 

removing or modifying cluster configurations.

To configure a VCS cluster

1 Start the VCS Cluster Configuration Wizard.

Click Start > All Programs > Symantec > Veritas Cluster Server > 

Configuration Tools > Cluster Configuration Wizard.

2 Read the information on the Welcome panel and click Next.

3 On the Configuration Options panel, click Cluster Operations and click 

Next.
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4 On the Domain Selection panel, select or type the name of the domain in 

which the cluster resides and select the discovery options.

Do one of the following:

■ To discover information about all systems and users in the domain:

■ Clear the Specify systems and users manually check box.

■ Click Next.

■ Proceed to step 8 on page 97.

■ To specify systems and user names manually (recommended for large 

domains):

■ Check the Specify systems and users manually check box.

Additionally, you may instruct the wizard to retrieve a list of 

systems and users in the domain by selecting appropriate check 

boxes.

■ Click Next.

■ If you chose to retrieve the list of systems, proceed to step 6 on 

page 97. Otherwise, proceed to the next step.

5 On the System Selection panel, type the name of each system to be added, 

click Add, and then click Next.

Do not specify systems that are part of another cluster.

Proceed to step 8 on page 97.
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6 On the System Selection panel, specify the systems for the cluster and then 

click Next. Do not select systems that are part of another cluster.

Enter the name of the system and click Add to add the system to the 

Selected Systems list, or click to select the system in the Domain Systems 

list and then click the > (right-arrow) button.

7 The System Report panel displays the validation status, whether Accepted 

or Rejected, of all the systems you specified earlier. Review the status and 

then click Next.

Click on a system name to see the validation details. If you wish to include a 

rejected system, rectify the error based on the reason for rejection and then 

run the wizard again.

A system can be rejected for any of the following reasons:

■ System is not pingable.

■ WMI access is disabled on the system.

■ Wizard is unable to retrieve the system architecture or operating 

system.

■ VCS is either not installed on the system or the version of VCS is 

different from what is installed on the system on which you are 

running the wizard.

8 On the Cluster Configuration Options panel, click Create New Cluster and 

click Next.
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9 On the Cluster Details panel, specify the details for the cluster and then 

click Next.

10 The wizard validates the selected systems for cluster membership. After the 

systems are validated, click Next.

Cluster Name Type a name for the new cluster. Symantec recommends a 

maximum length of 32 characters for the cluster name.

Cluster ID Select a cluster ID from the suggested cluster IDs in the 

drop-down list or type a unique ID for the cluster. The 

cluster ID can be any number from 0 to 65535.

Caution: If you chose to specify systems and users manually in 

step 4 or if you share a private network between more than one 

domain, make sure that the cluster ID is unique.

Operating System From the drop-down list select the operating system.

All the systems running Windows Server 2012 are displayed.

Available Systems Select the systems that you wish to configure in the cluster.

Check the Select all systems check box to select all the 

systems simultaneously.

The wizard discovers the network interface cards (NICs) on 

the selected systems. For single-node clusters with the 

required number of NICs, the wizard prompts you to 

configure a private link heartbeat. In the dialog box, click 

Yes to configure a private link heartbeat.
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If a system is not validated, review the message associated with the failure 

and restart the wizard after rectifying the problem.

If you chose to configure a private link heartbeat in the earlier step, proceed 

to the next step. Otherwise, proceed to step 12 on page 101.

11 On the Private Network Configuration panel, configure the VCS private 

network and then click Next.

You can configure the VCS private network either over ethernet or over the 

User Datagram Protocol (UDP) layer using IPv4 or IPv6 network.

Do one of the following:

■ To configure the VCS private network over the ethernet, complete the 

following steps:

■ Select Configure LLT over Ethernet.

■ Select the check boxes next to the two NICs to be assigned to the 

private network. You can assign a maximum of eight network 

links.

Symantec recommends reserving two NICs exclusively for the 

private network. However, you could lower the priority of one of 

the NICs and use the low-priority NIC for both public and private 

communication.

■ If you have only two NICs on a selected system, it is recommended 

that you lower the priority of at least one NIC that will be used for 

private as well as public network communication.
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To lower the priority of a NIC, right-click the NIC and select Low 

Priority from the pop-up menu.

Note: If you wish to use Windows NIC teaming, you must select the 

Static Teaming mode. Only the Static Teaming mode is currently 

supported.

■ If your configuration contains teamed NICs, the wizard groups 

them as "NIC Group #N" where "N" is a number assigned to the 

teamed NIC. A teamed NIC is a logical NIC, formed by grouping 

several physical NICs together. All NICs in a team have an identical 

MAC address. Symantec recommends that you do not select 

teamed NICs for the private network.

The wizard configures the LLT service (over ethernet) on the selected 

network adapters.

■ To configure the VCS private network over the User Datagram Protocol 

(UDP) layer, complete the following steps:

■ Select Configure LLT over UDP on IPv4 network or Configure LLT 

over UDP on IPv6 network depending on the IP protocol that you 

wish to use.

The IPv6 option is disabled if the network does not support IPv6.

■ Select the check boxes next to the two NICs to be assigned to the 

private network. You can assign a maximum of eight network 
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links. Symantec recommends reserving at least two adapters 

exclusively for the VCS private network.

■ For each selected NIC, verify the displayed IP address. If a selected 

NIC has multiple IP addresses assigned, double-click the field and 

choose the desired IP address from the drop-down list. In case of 

IPv4, each IP address can be in a different subnet.

The IP address is used for the VCS private communication over the 

specified UDP port.

■ Specify a unique UDP port for each of the link. Click Edit Ports if 

you wish to edit the UDP ports for the links. You can use ports in 

the range 49152 to 65535. The default ports numbers are 50000 

and 50001 respectively. Click OK.

For each selected NIC, double-click the respective field in the Link 

column and choose a link from the drop-down list. Specify a 

different link (Link1 or Link2) for each adapter. Each link is 

associated with a UDP port that you specified earlier.

The wizard configures the LLT service (over UDP) on the selected 

network adapters. The specified UDP ports will be used for the private 

network communication.

12 On the VCS Helper Service User Account panel, specify a domain user 

account for the VCS Helper service. The VCS high availability engine (HAD), 

which runs in the context of the local system built-in account, uses the VCS 

Helper service user context to access the network.

This account does not require Domain Administrator privileges.
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Specify a domain user as follows:

■ To specify an existing user, do one of the following:

■ Click Existing user and select a user name from the drop-down list

■ If you chose not to retrieve the list of users in step 4 on page 96, 

type the user name in the Specify User field, and then click Next.

■ To specify a new user, click New user and type a valid user name in the 

Create New User field, and then click Next.

Do not append the domain name to the user name; do not type the user 

name as Domain\user or user@domain.

■ In the Password dialog box, type the password for the specified user 

and click OK, and then click Next.

13 On the Configure Security Service Option panel, specify the security options 

for the cluster communications and then click Next.

Do one of the following:

■ To use VCS cluster user privileges, click Use VCS User Privileges and 

then type a user name and password.

The wizard configures this user as a VCS Cluster Administrator. In this 

mode, communication between cluster nodes and clients, including the 

Cluster Manager (Java Console), occurs using the encrypted VCS cluster 

administrator credentials. The wizard uses the VCSEncrypt utility to 

encrypt the user password.

The default user name for the VCS administrator is admin and the 

password is password. Both are case-sensitive. You can accept the 

default user name and password for the VCS administrator account or 

type a new name and password.

Symantec recommends that you specify a new user name and 

password.

■ To configure a secure cluster using the single sign-on feature, click Use 

Single Sign-on.

In this mode, the VCS Authentication Service is used to secure 

communication between cluster nodes and clients by using digital 

certificates for authentication and SSL to encrypt communication over 

the public network. VCS uses SSL encryption and platform-based 

authentication. The VCS high availability engine (HAD) and Veritas 

Command Server run in secure mode.

The wizard configures all the cluster nodes as root brokers (RB) and

authentication brokers (AB). Authentication brokers serve as 

intermediate registration and certification authorities. Authentication 

brokers have certificates signed by the root. These brokers can 
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authenticate clients such as users and services. The wizard creates a 

copy of the certificates on all the cluster nodes.

14 Review the summary information on the Summary panel, and click 

Configure.

The wizard configures the VCS private network. If the selected systems 

have LLT or GAB configuration files, the wizard displays an informational 

dialog box before overwriting the files. In the dialog box, click OK to 

overwrite the files. Otherwise, click Cancel, exit the wizard, move the 

existing files to a different location, and rerun the wizard.

The wizard starts running commands to configure VCS services. If an 

operation fails, click View configuration log file to see the log.

15 On the Completing Cluster Configuration panel, click Next to configure the 

ClusterService group; this group is required to set up components for 

notification and for global clusters.

To configure the ClusterService group later, click Finish.

At this stage, the wizard has collected the information required to set up the 

cluster configuration. After the wizard completes its operations, with or 

without the ClusterService group components, the cluster is ready to host 

application service groups. The wizard also starts the VCS engine (HAD) 

and the Veritas Command Server at this stage.

Note: After configuring the cluster you must not change the names of the 

nodes that are part of the cluster. If you wish to change a node name, run 

this wizard to remove the node from the cluster, rename the system, and 

then run this wizard again to add that system to the cluster.

16 On the Cluster Service Components panel, select the components to be 

configured in the ClusterService service group and click Next.

■ Check the Notifier Option check box to configure notification of 

important events to designated recipients.

See “Configuring notification” on page 104.

■ Check the GCO Option check box to configure the wide-area connector 

(WAC) process for global clusters. The WAC process is required for 

inter-cluster communication.

Configure the GCO Option using this wizard only if you are configuring 

a Disaster Recovery (DR) environment and are not using the Disaster 

Recovery wizard.

Refer to the Veritas Cluster Server Administrator’s Guide for details on 

configuring GCO using the cluster configuration wizard.
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You can configure the GCO Option using the DR wizard. The Disaster 

Recovery chapters discuss how to use the Disaster Recovery wizard to 

configure the GCO option.

Configuring notification
This section describes steps to configure notification.

To configure notification

1 On the Notifier Options panel, specify the mode of notification to be 

configured and click Next.

You can configure VCS to generate SNMP (V2) traps on a designated server 

and send emails to designated recipients in response to certain events.
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2 If you chose to configure SNMP, specify information about the SNMP 

console and click Next.

■ Click a field in the SNMP Console column and type the name or IP 

address of the console. The specified SNMP console must be MIB 2.0 

compliant.

■ Click the corresponding field in the Severity column and select a 

severity level for the console.

■ Click ‘+’ to add a field; click ‘-’ to remove a field.

■ Enter an SNMP trap port. The default value is “162”.

3 If you chose to configure SMTP, specify information about SMTP recipients 

and click Next.
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■ Type the name of the SMTP server.

■ Click a field in the Recipients column and enter a recipient for 

notification. Enter recipients as admin@example.com.

■ Click the corresponding field in the Severity column and select a 

severity level for the recipient. VCS sends messages of an equal or 

higher severity to the recipient.

■ Click + to add fields; click - to remove a field.

4 On the Notifier Network Card Selection panel, specify the network 

information and click Next.

■ If the cluster has a ClusterService service group configured, you can 

use the NIC resource configured in the service group or configure a new 

NIC resource for notification.

■ If you choose to configure a new NIC resource, select a network adapter 

for each node in the cluster. The wizard lists the public network 

adapters along with the adapters that were assigned a low priority.

5 Review the summary information and choose whether you want to bring the 

notification resources online when VCS is started.

6 Click Configure.

7 Click Finish to exit the wizard.
 

Adding a node to an existing VCS cluster
You use the VCS Cluster Configuration Wizard (VCW) to add one or more nodes 

to an existing VCS cluster.
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Prerequisites for adding a node to an existing cluster are as follows:

■ Verify that the logged-on user has VCS Cluster Administrator privileges.

■ The logged-on user must be a local Administrator on the system where you 

run the wizard.

■ Verify that Command Server is running on all nodes in the cluster. Select 

Services on the Administrative Tools menu and verify that the Veritas 

Command Server shows that it is started.

■ Verify that the Veritas High Availability Daemon (HAD) is running on the 

node on which you run the wizard. Select Services on the Administrative 

Tools menu and verify that the Veritas High Availability Daemon is running.

To add a node to a VCS cluster

1 Start the VCS Cluster Configuration wizard.

Click Start > All Programs > Symantec > Veritas Cluster Server > 

Configuration Tools > Cluster Configuration Wizard.

Run the wizard from the node to be added or from a node in the cluster. The 

node that is being added should be part of the domain to which the cluster 

belongs.

2 Read the information on the Welcome panel and click Next.

3 On the Configuration Options panel, click Cluster Operations and click 

Next.
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4 In the Domain Selection panel, select or type the name of the domain in 

which the cluster resides and select the discovery options.

Do one of the following:

■ To discover information about all the systems and users in the domain:

■ Clear the Specify systems and users manually check box.

■ Click Next.

Proceed to step 8 on page 164.

■ To specify systems and user names manually (recommended for large 

domains):

■ Check the Specify systems and users manually check box.

Additionally, you may instruct the wizard to retrieve a list of 

systems and users in the domain by selecting appropriate check 

boxes.

■ Click Next.

If you chose to retrieve the list of systems, proceed to step 6 on 

page 163. Otherwise proceed to the next step.
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5 On the System Selection panel, complete the following and click Next.

■ Type the name of a node in the cluster and click Add.

■ Type the name of the system to be added to the cluster and click Add.

If you specify only one node of an existing cluster, the wizard discovers all 

nodes for that cluster. To add a node to an existing cluster, you must specify 

a minimum of two nodes; one that is already a part of a cluster and the other 

that is to be added to the cluster.

Proceed to step 8 on page 164.
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6 On the System Selection panel, specify the systems to be added and the 

nodes for the cluster to which you are adding the systems.

Enter the system name and click Add to add the system to the Selected 

Systems list. Alternatively, you can select the systems from the Domain 

Systems list and click the right-arrow icon.

If you specify only one node of an existing cluster, the wizard discovers all 

nodes for that cluster. To add a node to an existing cluster, you must specify 

a minimum of two nodes; one that is already a part of a cluster and the other 

that is to be added to the cluster.

7 The System Report panel displays the validation status, whether Accepted 

or Rejected, of all the systems you specified earlier. Review the status and 

then click Next.

A system can be rejected for any of the following reasons:

■ System is not pingable.

■ WMI access is disabled on the system.

■ Wizard is unable to retrieve the system architecture or operating 

system.

■ VCS is either not installed on the system or the version of VCS is 

different from what is installed on the system on which you are 

running the wizard.

Click on a system name to see the validation details. If you wish to include a 

rejected system, rectify the error based on the reason for rejection and then 

run the wizard again.
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8 On the Cluster Configuration Options panel, click Edit Existing Cluster and 

click Next.

9 On the Cluster Selection panel, select the cluster to be edited and click Next.

If you chose to specify the systems manually in step 4, only the clusters 

configured with the specified systems are displayed.

10 On the Edit Cluster Options panel, click Add Nodes and click Next.

In the Cluster User Information dialog box, type the user name and 

password for a user with administrative privileges to the cluster and click 

OK.

The Cluster User Information dialog box appears only when you add a node 

to a cluster with VCS user privileges, that is when the cluster configuration 

does not use the Symantec Product Authentication Service for secure 

cluster communication.

11 On the Cluster Details panel, check the check boxes next to the systems to be 

added to the cluster and click Next.

The right pane lists nodes that are part of the cluster. The left pane lists 

systems that can be added to the cluster.

12 The wizard validates the selected systems for cluster membership. After the 

nodes have been validated, click Next.

If a node does not get validated, review the message associated with the 

failure and restart the wizard after rectifying the problem.

13 On the Private Network Configuration panel, configure the VCS private 

network communication on each system being added and then click Next. 

How you configure the VCS private network communication depends on 
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how it is configured in the cluster. If LLT is configured over ethernet, you 

have to use the same on the nodes being added. Similarly, if LLT is 

configured over UDP in the cluster, you have to use the same on the nodes 

being added.

Do one of the following:

■ To configure the VCS private network over ethernet, complete the 

following steps:

■ Select the check boxes next to the two NICs to be assigned to the 

private network.

Symantec recommends reserving two NICs exclusively for the 

private network. However, you could lower the priority of one NIC 

and use the low-priority NIC for both public and private 

communication.

■ If you have only two NICs on a selected system, it is recommended 

that you lower the priority of at least one NIC that will be used for 

private as well as public network communication.

To lower the priority of a NIC, right-click the NIC and select Low 

Priority from the pop-up menu.

Note: If you wish to use Windows NIC teaming, you must select the 

Static Teaming mode. Only the Static Teaming mode is currently 

supported.

■ If your configuration contains teamed NICs, the wizard groups 

them as "NIC Group #N" where "N" is a number assigned to the 

teamed NIC. A teamed NIC is a logical NIC, formed by grouping 

several physical NICs together. All NICs in a team have an identical 

MAC address. Symantec recommends that you do not select 

teamed NICs for the private network.

The wizard configures the LLT service (over ethernet) on the selected 

network adapters.

■ To configure the VCS private network over the User Datagram Protocol 

(UDP) layer, complete the following steps:

■ Select the check boxes next to the two NICs to be assigned to the 

private network. You can assign maximum eight network links.

Symantec recommends reserving at least two NICs exclusively for 

the VCS private network.

■ Specify a unique UDP port for each of the link. Click Edit Ports if 

you wish to edit the UDP ports for the links. You can use ports in 

the range 49152 to 65535. The default ports numbers are 50000 

and 50001 respectively. Click OK.
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■ For each selected NIC, verify the displayed IP address. If a selected 

NIC has multiple IP addresses assigned, double-click the field and 

choose the desired IP address from the drop-down list. In case of 

IPv4, each IP address can be in a different subnet.

The IP address is used for the VCS private communication over the 

specified UDP port.

■ For each selected NIC, double-click the respective field in the Link 

column and choose a link from the drop-down list. Specify a 

different link (Link1 or Link2) for each NIC. Each link is associated 

with a UDP port that you specified earlier.

The wizard configures the LLT service (over UDP) on the selected network 

adapters. The specified UDP ports will be used for the private network 

communication.

14 On the Public Network Communication panel, select a NIC for public 

network communication, for each system that is being added, and then click 

Next.

This step is applicable only if you have configured the ClusterService 

service group, and the system being added has multiple adapters. If the 

system has only one adapter for public network communication, the wizard 

configures that adapter automatically.

Note: If you wish to use Windows NIC teaming, you must select the Static 

Teaming mode. Only the Static Teaming mode is currently supported.

15 Specify the password for the user in whose context the VCS Helper service 

runs.

16 Review the summary information and click Add.

The wizard starts running commands to configure the VCS components on 

the node. In case of a secure cluster, the wizard also configures the VCS 

Authentication Service on the new node that is being added.

17 After all commands have been successfully run, click Finish.
 

Installing and configuring the application or server 
role

This section provides considerations for installing and configuring your 

application or server role. 

See the following topics:

■ Configuring a File Share server role
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■ Installing and configuring the IIS application

■ Installing additional applications

Configuring a File Share server role
Points to note when configuring a File Share:

■ Make sure that the disk group and volumes for the file server shared 

directory are configured on shared storage (VMDg) or non-shared storage 

(VMNSDg).

■ When configuring a new set up, first create the disk groups and volumes on 

the shared storage (VMDg) or non-shared storage (VMNSDg) and then create 

the directory structure for the file shares.

■ For an existing configuration that has a file server with shares on the local 

storage, move these shares to the shared storage (VMDg) or non-shared 

storage (VMNSDg) using the practices recommended by Microsoft.

■ The FileShare agent is installed automatically with SFW HA.

Installing and configuring the IIS application
Points to note when installing IIS:

■ Verify that IIS is installed and configured identically on all nodes hosting 

the service group. Verify that the sites to be monitored are on the shared 

storage (VMDg) or non-shared storage (VMNSDg).

■ Import the disk groups and mount the volumes that contain the website 

data, on the first node. 

■ For a new IIS installation, while creating new web sites, create the site folder 

on the shared storage (VMDg) or non-shared storage (VMNSDg) and place 

the site content in that folder. 

■ Change the default home directory path for all the IIS sites to be monitored 

to a location on the shared storage (VMDg) or non-shared storage 

(VMNSDg). See the IIS documentation for instructions. 

■ For existing web sites, stop the sites and then move the website content to 

volumes on the shared storage (VMDg) or non-shared storage (VMNSDg). 

You must also reconfigure the home directory location for the website in IIS 

and then restart the website again.

■ Verify the port numbers assigned to IIS sites are not used by other 

applications or sites. 

■ Synchronize the IIS configuration on all nodes hosting the service group.
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Installing additional applications
Following are some very generic points for installing any application:

■ Make sure that the disk groups and volumes are mounted on the node before 

installing the application. 

■ VCS requires the application program files to be installed on the same local 

drive on all nodes. For example, if you install the application program files 

on drive C of one node, installation of these same files on all other nodes. 

must be on drive C. 

■ Make sure that the same drive letter is available on all nodes and has 

adequate space for the installation.

■ The data files and any associated files, such as log files, should be installed 

on the shared storage (VMDg) or non-shared storage (VMNSDg).

Configuring the service group 
The Solutions Configuration Center provides wizards to configure the service 

groups for the additional SFW HA applications or server roles. It also supports 

the Application Configuration Wizard which can be used to configure any other 

application for which application specific wizards have not been provided. 

Depending on the application that you have installed, complete the appropriate 

procedure to configure the service group:

■ Configuring the file share service group

■ Configuring the IIS service group

■ Configuring the service group for any additional applications

Configuring the file share service group
Configuring the File Share service group involves creating a FileShare service 

group and defining the attribute values for its resources. After the service group 

is created, you must configure the shares to mount automatically at startup.

Prerequisites

■ Verify that you have local administrator privileges on the system where you 

run the wizard.

■ If you have configured a firewall, add the following to the firewall exceptions 

list:

■ Port 14150 or the VCS Command Server service, 

%vcs_home%\bin\CmdServer.exe
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Here, %vcs_home% is the installation directory for VCS, typically 

C:\Program Files\Veritas\Cluster Server.

■ Port 14141

For a detailed list of services and ports used by SFW HA, refer to the Veritas 

Storage Foundation and High Availability Solutions for Windows Installation 

and Upgrade Guide.

■ Verify that the VCS high availability engine, HAD, is running on the system 

from which you run the wizard.

■ Verify that the directories to be shared reside on shared drives.

■ Mount the drives containing the shared directories on the system where you 

run the wizard. Unmount the drives from other systems in the cluster.

■ Verify that Veritas Command Server service is running on all systems in the 

cluster.

■ Verify that you have the following information ready. The wizard will 

prompt you for this information:

■ A unique virtual computer name to be assigned to the file share server.

This is the name by which clients will access the server. The virtual 

name must not exceed 16 characters. If you specify a virtual computer 

name in lowercase letters, the name is converted to uppercase. For 

example, the name VCSServer is converted to VCSSERVER.

■ A unique virtual IP address to be assigned to the file share server.

The virtual IP address is required only if you wish to configure an IPv4 

address. In case of IPv6, the wizard prompts you to select the IPv6 

prefix and automatically generates an IPv6 address that is valid and 

unique on the network. The wizard uses the prefix that is advertised by 

the router on the IPv6 network.

Note: Windows Server does not support accessing file shares using the 

virtual IP address. 
You can work around this restriction by using non-scoped file shares. 

For more information: 
See “Creating non-scoped file shares configured with VCS” on 

page 181. 
See “Making non-scoped file shares accessible while using virtual 

server name or IP address if NetBIOS and WINS are disabled” on 

page 182.

■ The list of directories to be shared.

The wizard enables you to add existing shares to the VCS 

configuration. However, you cannot add special shares (shares created 



117Deploying SFW HA for high availability: New installation

Configuring the service group
by the operating system for administrative and system use). For 

example, you cannot add the shares ADMIN$, print$, IPC$, and 

DriveLetter$ to the VCS configuration.

■ On Windows Server Core, you have to add the required resources and 

configure the service group manually. You can perform the steps either 

directly on the Server Core machine using the command line, or remotely 

using the Cluster Manager (Java console).

Refer to the Veritas Cluster Server Administrator’s Guide for instructions on 

using the command line and the Cluster Manager (Java Console).

Note: If User Access Control (UAC) is enabled on Windows Server systems, 

you must launch the command prompt in the Run as administrator mode 

and then run the VCS commands.

■ Before configuring the service group, review the resource types and the 

attribute definitions of the FileShare agent, described in the Veritas Cluster 

Server Bundled Agents Reference Guide.

■ If your storage is SCSI-3 compliant and you wish to use SCSI-3 persistent 

reservations, enable SCSI-3 support using Veritas Enterprise Administrator 

(VEA).
 

Creating the file share service group using the wizard

Use the File Share Configuration Wizard to create and modify file share service 

groups, making file shares highly available in a VCS cluster. Refer to the Veritas 

Cluster Server Bundled Agents Reference Guide for information on resource 

types, attribute definitions, resource dependencies, and sample service group 

configurations.

If you are using a non-shared storage configuration (dynamic disk groups 

configured on local disks), you have to configure the service group manually 

either using the Cluster Manager (Java Console) or the command line. The 

wizard currently cannot configure resources (VMNSDg agent) required for 

monitoring non-shared storage.

See “Configuring the service group in a non-shared storage environment” on 

page 157.

To create a file share service group using the wizard

1 Start the File Share Configuration Wizard from the Solutions Configuration 

Center. Click Start > All Programs > Symantec > Veritas Cluster Server > 

Solutions Configuration Center .

From the Solutions Configurations Center expand the Solutions for 

Additional Applications and from the display click High Availability (HA) 
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Configuration > Configure the Service Group > File Share Configuration 

Wizard.

or

Click Start > All Programs > Symantec > Veritas Cluster Server > 

Configuration Tools > File Share Configuration Wizard.

2 Review the information in the Welcome panel and click Next.

3 On the Wizard Options panel, click Create service group and click Next.

4 On the Service Group Configuration panel, specify the service group details 

and then click Next. The wizard then starts validating your configuration. 

Various messages indicate the validation status.

5 On the File Share Configuration panel, specify the configuration 

information for the FileShare resources to be created and then click Next. 

Service Group Name Type a name for the File Share service group.

Group System List In the Available Cluster Systems list, select the systems 

on which to configure the service group and click the 

right arrow to move the systems to the service group’s 

system list.

To remove a system from the service group’s system list, 

click the system in the Systems in Priority Order box and 

click the left arrow.

To change a system’s priority in the service group’s 

system list, select the system in the Systems in Priority 

Order and click the up and down arrows.

System priority defines the order in which service 

groups are failed over to systems. The system at the top 

of the list has the highest priority while the system at 

the bottom of the list has the lowest priority.

Include selected 

systems in the service 

group's AutoStartList 

attribute

To enable the service group to automatically come online 

on one of the systems, select this checkbox.

For information about the AutoStartList attribute, see 

the Veritas Cluster Server Administrator’s Guide.
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The wizard begins validating your configuration. Various messages indicate 

the validation status.

Virtual Computer Name Type a unique virtual computer name by which the 

server will be known to clients. The virtual name 

must not exceed 16 characters.

List Shares Click List Shares to view the existing shares on the 

shared storage, then select a share and click Add.

You cannot add special shares (shares created

by the operating system for administrative and 

system use).

Path Click the field and either type the path of the 

directory to be shared or click the ellipsis button (...) 

to browse for a directory.

The selected directories must meet the following 

conditions:

■ The selected drive, the mount path, and the file path 

must not exist in the VCS configuration.

■ The directories to be shared must reside on shared, 

non-system drives.

The wizard validates the selected directory and 

displays an error message if the directory does not 

meet any of the conditions.
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Share Name If a selected directory is already shared, the Share 

Name column lists the names by which it is shared. 

You can select a listed share name to make an existing 

share highly available. You can also create a new 

share for the same directory by typing a new share 

name.

Remove To remove a file share from the configuration, click to 

select the file share and then click Remove.
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6 On the Share Permissions panel, select the file share, specify the users for 

the file shares and assign permissions to them, and then click Next.

Select the FileShare From the drop-down list, select the file share with which 

to associate user permissions, or select the default All 

FileShares to set the same permissions for all file shares.

Select the Permission From the drop-down list, select the permission to be 

associated with the user.

Select the User Click the ellipsis button (...), select a user, and click OK.

Add Click Add to add the specified user to the Selected Users 

list. By default, all selected users are given 

READ_ACCESS permission.

Selected Users Displays a list of selected users and the file share 

permissions. You can configure a maximum of 50 users 

for each file share. To configure more users, create a user 

group.

To change the file share permission associated with a 

user, click a user name in the Selected Users list and 

then select the desired permission from the Select the 

Permission drop-down list.

Remove To deny file share access to a user, click the user name in 

the Selected Users list and click Remove.
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7 On the Share Properties panel, set the share properties for the file shares 

and then click Next.

Select the FileShare From the drop-down list select a file share whose 

properties you wish to set.

Enable access-based 

enumeration for this 

file share

Check the Enable access-based enumeration check box 

to enable the Windows access-based enumeration 

feature on the selected file share.

User Limit Specify the number of users that are allowed access to 

the selected file share.

Choose from the following options:

■ Maximum allowed users: Select this option to allow 

access to the maximum numbers of users allowed on 

Windows.

■ Allow this number of users: Select this option and then 

type the number of users that you wish to grant access to 

the selected file share.

If you type zero or a value greater than what Windows 

supports, access is granted to the maximum allowed 

users on Windows.
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Enable cache Check the Enable cache check box to enable local 

caching of the contents of the selected file share.

Then, specify how the contents of the file share are 

available to users for offline access.

In the drop down list select from the following caching 

options:

■ Manual caching of files and programs: Only the files and 

programs specified by the user are available offline. This 

sets the FileShare resource attribute ClientCacheType to 

MANUAL.

■ Automatic caching of programs: All the files and 

programs that the users access from the file share are 

available offline. This sets the FileShare resource 

attribute ClientCacheType to DOCS.

■ Optimized automatic caching of files and programs: All 

files and programs, including executables, are cached 

locally. The next time the user accesses the executable 

files, they are launched from the local cache. This sets 

the FileShare resource attribute ClientCacheType to 

PROGRAMS.

Hide share Check the Hide Share check box to make the new share a 

hidden share.

Share all subfolder Check the Share all subfolders check box to share the 

subdirectories.

Hide child shares Check the Hide child shares check box to hide the shared 

subdirectories.

Apply these settings 

to

To apply the specified share properties to multiple file 

shares simultaneously, do the following:

1 Click the ellipsis (...) button.

2 On the Copy Share Properties dialog box, select the file 

shares from the Available Shares list and click the right 

arrow to move them to the Selected Shares list.

Note that only those files shares that are not already 

shared are available for selection.

3 Click OK.

Note: This option is not visible if you are configuring only one 

share in the service group.
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8 On the Network Configuration panel, specify information related to your 

network and then click Next.

Do the following:

■ Select IPv4 to configure an IPv4 address for the virtual server.

■ In the Virtual IP Address field, type a unique virtual IPv4 address 

for the virtual server.

■ In the Subnet Mask field, type the subnet to which the virtual IPv4 

address belongs.

■ Select IPv6 to configure an IPv6 address for the virtual server. The IPv6 

option is disabled if the network does not support IPv6.

■ Select the prefix from the drop-down list. The wizard uses the 

prefix and automatically generates an IPv6 address that is valid 

and unique on the network.

■ For each system in the cluster, select the public network adapter name. 

The Adapter Display Name field displays the TCP/IP enabled adapters 

on a system, including the private network adapters, if applicable. 

To view the adapters associated with a system, click the Adapter 

Display Name field and click the arrow. Verify that you select the adapters 

assigned to the public network, not the private.

■ Click Advanced Settings to specify additional details for the Lanman 

resource.
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On the Lanman Advanced Configuration dialog box, complete the 

following:

■ Check Active Directory Update required check box to enable the 

Lanman resource to update the Active Directory with the virtual 

name. This sets the Lanman agent attributes ADUpdateRequired 

and ADCriticalForOnline to true.

■ In the Organizational Unit field, type the distinguished name of 

the Organizational Unit for the virtual server in the format 

CN=containername,DC=domainname,DC=com.

To browse for an OU, click the ellipsis (...) button and search for the 

OU using the Windows Find Organization Units dialog box. By 

default, the Lanman resource adds the virtual server to the default 

container "Computers."

■ Click OK.

The user account for VCS Helper service must have adequate 

privileges on the specified container to create and update 

computer accounts.

9 On the Service Group Summary panel, review the service group 

configuration.

Click Next.

Click Yes on the message box that appears, informing you that the wizard 

will run commands to modify the service group configuration.

The wizard starts running commands to create the service group. Various 

messages indicate the status of these commands.

Resources Displays a list of configured resources. The wizard 

assigns unique names to resources. Change the names 

of resource, if required.

To edit a resource name, select the resource name and 

either click it or press the F2 key. Edit the resource 

name and then press the Enter key to confirm the 

changes. To cancel editing a resource name, press the 

Esc key.

Attributes Displays the attributes and their configured values for 

a resource selected in the Resources list.

Enable FastFailOver 

attribute for all the 

VMDg resources in the 

service group

To enable all the VMDg resources in the service group 

for fast failover, select this checkbox.

For information about the FastFailOver attribute, see 

the Veritas Cluster Server Administrator’s Guide.
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10 In the completion dialog box, check Bring the service group online check 

box if you want to bring the service group online on the local system, and 

then click Finish.

Creating non-scoped file shares configured with VCS

File shares configured with VCS on Windows Server are accessible only using 

the virtual server name (Lanman resource). These file shares are not accessible 

using the IP address.

The FileShare agent is enhanced to address this issue. The FileShare agent 

behavior can be controlled using the following registry key:

HKLM\SOFTWARE\VERITAS\VCS\BundledAgents\Lanman\<VirtualName>\ 
DisableServerNameScoping

Set the DisableServerNameScoping key to have the FileShare agent 

support non-scoped file shares.

You must create this registry key manually. Perform the following steps to 

create and set the DisableServerNameScoping registry key that is used by 

the FileShare agent to support non-scoped file shares.

Note: Incorrectly editing the registry may severely damage your system. Make a 

backup copy before making changes to the registry.

To configure DisableServerNameScoping registry parameter

1 To open the Registry Editor, click Start > Run, type regedit, and then click 

OK.

2 In the registry tree (on the left), navigate to 

HKLM\SOFTWARE\VERITAS\VCS\BundledAgents.

3 Click Edit > New > Key and create a key by the name Lanman, if it does not 

exist already.

4 Select the Lanman key and click Edit > New > Key and create a key by the 

name virtualName.

Here virtualName should be the virtual computer name assigned to the file 

share server. This is the VirtualName attribute of the Lanman resource in 

the file share service group.

The newly created registry key should look like this:

HKLM\SOFTWARE\VERITAS\VCS\BundledAgents\Lanman\virtualName

5 Select the key that you created in step 4 (virtualName) and add a DWORD 

type of value.

The value name should be DisableServerNameScoping and value data 

should be 1.
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The value 1 indicates that the FileShare and Lanman agents support 

non-scoped file shares on Windows Server systems.

6 If there are multiple file share service groups to be used in the non-scoped 

mode, repeat steps 4 and 5 for each Lanman resource that is configured in 

the file share service group.

You must create this key only for Lanman resources that are part of VCS file 

share service groups. Configuring this key for Lanman resources that are part of 

other VCS service groups may result in an unexpected behavior.

Making non-scoped file shares accessible while using virtual 
server name or IP address if NetBIOS and WINS are disabled

The VCS FileShare agent depends on NetBIOS or DNS to resolve the virtual 

name. If NetBIOS and WINS are disabled or the DNS is not updated, the agent is 

unable to resolve the virtual name.

This may typically occur when the file share service groups are configured to 

use localized IP addresses. When the service group is switched or failed over, the 

virtual name to IP address mapping changes. In such a case if WINS database or 

the DNS are not updated, the agent is unable to resolve the virtual name. As a 

result the FileShare resources fault and the shares become inaccessible.

The following message is seen in the agent log:

VCS INFO V-16-10051-10530 
FileShare:<servicegroupname>:online:Failed to access the network 
path (\\virtualname)

The FileShare agent is enhanced to address this issue. The FileShare agent 

behavior can be controlled using the following registry key:

HKLM\SOFTWARE\VERITAS\VCS\BundledAgents\Lanman\virtualName\DisableS
trictVirtualNameCheck

Set the DisableStrictVirtualNameCheck key to have the FileShare agent 

make the file shares accessible irrespective of whether or not the virtual name is 

resolvable. In case the virtual name is not resolvable, the file shares are 

accessible using the virtual IP.

You must create this registry key manually. Perform the following steps to 

create and set the DisableStrictVirtualNameCheck registry key that is 

used by the FileShare agent to disable virtual name availability as a requirement 

for file shares to be available on the network.

Note: Incorrectly editing the registry may severely damage your system. Make a 

backup copy before making changes to the registry.
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To configure DisableStrictVirtualNameCheck registry parameter

1 To open the Registry Editor, click Start > Run, type regedit, and then click 

OK.

2 In the registry tree (on the left), navigate to 

HKLM\SOFTWARE\VERITAS\VCS\BundledAgents.

3 Click Edit > New > Key and create a key by the name Lanman, if it does not 

exist already.

4 Select the Lanman key and click Edit > New > Key and create a key by the 

name virtualName.

Here virtualName should be the virtual computer name assigned to the file 

share server. This is the VirtualName attribute of the Lanman resource in 

the file share service group.

The newly created registry key should look like this:

HKLM\SOFTWARE\VERITAS\VCS\BundledAgents\Lanman\virtualName

5 Select the key that you created in step 4 (virtualName) and add a DWORD 

type of value.

The value name should be DisableStrictVirtualNameCheck and 

value data should be 1.

6 If there are multiple file share service groups to be used in the non-scoped 

mode, repeat steps 4 and 5 for each Lanman resource that is configured in 

the file share service group.

7 Save and exit the Registry Editor.

You must create this key only for Lanman resources that are part of VCS file 

share service groups. Configuring this key for Lanman resources that are part of 

other VCS service groups may result in an unexpected behavior.
 

 

Configuring the IIS service group
Configuring the IIS service group involves creating a IIS service group and 

defining the attribute values for its resources. After the service group is created, 

you must configure the shares to mount automatically at startup.

Prerequisites

■ Verify that you have local administrator privileges on the system where you 

run the wizard.

■ Verify IIS is installed and configured identically on all nodes hosting the 

service group. Verify the sites to be monitored are on shared storage.
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■ For IIS 8.0 on Windows Server 2012, you must install the following 

components:

■ IIS 6 Metabase Compatibility

■ IIS 6 WMI Compatibility

These options are available under Management Tools on the Role Services 

page of the Add Roles Wizard.

These components are required for the IIS agent to function on Windows 

Server 2012.

For IIS 8.0 on Windows Server Core, you must install IIS in the specified 

order. See “Installing IIS 8.0 on Windows Server Core” on page 130 for 

instructions.

■ If IIS configuration is using IPv6 addresses, then you must install the IIS 

Management Scripts and Tools role service.

IPv6 requires WMI 7 Provider that is part of the IIS Management Scripts 

and Tools role.

■ Do not use the IIS agent to configure SMTP and NNTP sites if you have 

Microsoft Exchange installed.

■ Change the default home directory path for all IIS sites to monitored to a 

location on the shared storage. See the IIS documentation for instructions.

■ Verify the port numbers assigned to IIS sites are not used by other 

programs.

■ If you have configured a firewall, add the following to the firewall exceptions 

list:

■ Port 14150 or the VCS Command Server service, 

%vcs_home%\bin\CmdServer.exe

Here, %vcs_home% is the installation directory for VCS, typically 

C:\Program Files\Veritas\Cluster Server.

■ Port 14141

For a detailed list of services and ports used by SFW HA, refer to the Veritas 

Storage Foundation and High Availability Solutions for Windows Installation 

and Upgrade Guide.

■ To configure IIS agent on Windows Server Core, you must manually add the 

required resources and configure the service group. You can perform the 

manual configuration steps either directly on the Server Core machine 

using the command line, or remotely using the Cluster Manager (Java 

console).

For instructions on using the command line and the Cluster Manager (Java 

Console), refer to the Veritas Cluster Server Administrator’s Guide.
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Note: If User Access Control (UAC) is enabled on Windows Server systems, 

you must launch the command prompt in the Run as administrator mode 

and then run the VCS commands.

■ Verify that the VCS high availability engine, HAD, is running on the system 

where you run the wizard.

■ Mount the drives containing the shared directories from the system from 

which you run the wizard. Unmount the drives from other systems in the 

cluster.

■ If your storage is SCSI-3 compliant and you wish to use SCSI-3 persistent 

reservations, enable SCSI-3 support using Veritas Enterprise Administrator 

(VEA).

■ Verify that you have the following information ready. The wizard will 

prompt you for this information:

■ IIS sites to be monitored.

■ Application pools associated with each site.

■ Port numbers associated with each site.

■ Virtual IP addresses and computer names associated with the sites. The 

virtual IP addresses and the virtual computer names must have 

forward and reverse entries in the DNS.

■ Before configuring the service group, review the resource types and the 

attribute definitions of the IIS agent, described in the Veritas Cluster Server 

Bundled Agents Reference Guide.

Installing IIS 8.0 on Windows Server Core

Complete the following steps.

To install IIS 8.0 on Windows Server Core

1 Type the following at the command prompt:

start /w pkgmgr 

/iu:IIS-WebServerRole;IIS-WebServer;IIS-CommonHttpFea

tures; 
IIS-StaticContent;IIS-DefaultDocument;IIS-DirectoryBr
owsing; 
IIS-HttpErrors;IIS-HttpRedirect;IIS-ApplicationDevelo

pment; 
IIS-ASP;IIS-CGI;IIS-ISAPIExtensions;IIS-ISAPIFilter; 
IIS-ServerSideIncludes;IIS-HealthAndDiagnostics; 
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IIS-HttpLogging;IIS-LoggingLibraries;IIS-RequestMonit

or; 
IIS-HttpTracing;IIS-CustomLogging;IIS-ODBCLogging;IIS

-Security;IIS-BasicAuthentication;IIS-WindowsAuthenti

cation; 
IIS-DigestAuthentication; 
IIS-ClientCertificateMappingAuthentication; 
IIS-IISCertificateMappingAuthentication; 
IIS-URLAuthorization;IIS-RequestFiltering;IIS-IPSecur

ity; 
IIS-Performance;IIS-HttpCompressionStatic; 
IIS-HttpCompressionDynamic;IIS-WebServerManagementToo
ls; 
IIS-ManagementScriptingTools;IIS-IIS6ManagementCompat

ibility; 
IIS-Metabase;IIS-WMICompatibility;IIS-LegacyScripts; 
IIS-FTPPublishingService;WAS-WindowsActivationService

; 
IIS-FTPPublishingService;IIS-FTPServer

2 Verify that all the components specified in the earlier step have successfully 

installed. Type the following at the command prompt:

notepad C:\windows\logs\cbs\cbd.log

This opens the log file, cbd.log, in the Notepad text editor.

3 Check the entries in the log file, cbd.log. The last log entry should resemble 

the following:

Info CBS Pkgmgr: return code: 0x0

This message indicates that all the components are installed successfully.

4 Run the oclist command to verify that the following components are 

installed: 

IIS-WebServerRole; IIS-WebServer; IIS-IIS6ManagementCompatibility; 

IIS-Metabase; IIS-WMICompatibility; IIS-FTPPublishingService; 

WAS-WindowsActivationService; IIS-FTPPublishingService; IIS-FTPServer

Type the following at the command prompt:

oclist

5 Repeat the steps on all the nodes on which you wish to configure the IIS 

service group.
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Creating the IIS service group

Refer to the Veritas Cluster Server Bundled Agents Reference Guide for 

information on resource types, attribute definitions, resource dependencies, and 

sample service group configurations.

If you are using a non-shared storage configuration (dynamic disk groups 

configured on local disks), you have to configure the service group manually 

either using the Cluster Manager (Java Console) or the command line. The 

wizard currently cannot configure resources (VMNSDg agent) required for 

monitoring non-shared storage.

See “Configuring the service group in a non-shared storage environment” on 

page 157.

To create an IIS service group

1 Start the IIS Configuration Wizard from the Solutions Configuration Center. 

Click Start > All Programs > Symantec > Veritas Cluster Server > Solutions 

Configuration Center.

From the Solutions Configurations Center expand the Solutions for 

Additional Applications and from the display click High Availability (HA) 

Configuration > Configure the Service Group > IIS Configuration Wizard.

or

Click Start > All Programs > Symantec > Veritas Cluster Server > 

Configuration Tools > IIS Configuration Wizard.

2 Review the information in the Welcome panel and click Next.

3 On the Wizard Options panel, click Create service group and click Next.

4 On the Service Group Configuration panel, specify the service group details 

and then click Next. The wizard then starts validating your configuration. 

Various messages indicate the validation status.

Service Group Name Type a name for the IIS service group.
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5 On the Configure IIS Sites panel, add and remove sites from the service 

group, configure IP addresses, ports, and virtual computer names, and then 

click Next.

Group System List In the Available Cluster Systems list, select the systems 

on which to configure the service group and click the 

right arrow to move the systems to the service group’s 

system list.

To remove a system from the service group’s system list, 

click the system in the Systems in Priority Order box and 

click the left arrow.

To change a system’s priority in the service group’s 

system list, select the system in the Systems in Priority 

Order and click the up and down arrows.

System priority defines the order in which service 

groups are failed over to systems. The system at the top 

of the list has the highest priority while the system at 

the bottom of the list has the lowest priority.

Include selected 

systems in the service 

group's AutoStartList 

attribute

To enable the service group to automatically come online 

on one of the systems, select this checkbox.

For information about the AutoStartList attribute, see 

the Veritas Cluster Server Administrator's Guide.

Add Check the check box corresponding to the site to be 

configured in VCS.
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6 On the Network Configuration panel, specify information related to the 

virtual IP addresses and click Next.

IP Verify or type the virtual IP address for each site to be 

configured.

Make sure that each virtual IP address is associated with 

only one virtual computer name and vice-versa.

Port Type the port number for each site to be configured.

Virtual Name Type a virtual name for the selected site. Each virtual 

name can be associated with only one virtual IP address 

at a time.

IP Address Displays the virtual IP addresses. The wizard groups 

systems by the virtual IP addresses associated with the 

systems.

Subnet Mask If the virtual IP is an IPv4 address, verify or type the 

subnet mask associated with each virtual IPv4 address.

If the virtual IP is an IPv6 address, verify or type the 

associated IPv6 prefix.

The prefix is generally represented in the following 

format: ipv6-address/prefix-length.

For example, 2001:db8:0:1::/64.

Adapter Name Select the adapter associated with the virtual IP address 

on each system.
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7 On the Application Pool Configuration panel, select the monitoring options 

for application pools associated with each site and click Next.

Site Name Displays the site names.

AppPoolMon For each site, select the monitoring options from the 

AppPoolMon list.

Choose from the following options from the drop-down 

list:

■ NONE—The agent will not monitor the application pool 

associated with the site.

■ DEFAULT—Starts and monitors the root application pool 

associated with the site.

■ ALL—Starts all application pools associated with the site 

and monitors root application pool.
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8 On the Service Group Summary panel, review the service group 

configuration.

Click Next.

Click Yes on the message box that appears, informing you that the wizard 

will run commands to modify the service group configuration.

The wizard starts running commands to create the service group. Various 

messages indicate the status of these commands.

9 In the completion dialog box, check Bring the service group online if you 

want to bring the service group online on the local system, and then click 

Finish.
 

Configuring the service group for any additional applications
Configuring the service group for any additional application involves creating 

an application service group and defining the attribute values for its resources. 

This can be done using the Application Configuration Wizard. After the service 

group is created, you must configure the shares to mount automatically at 

startup.

Prerequisites

■ The application is installed on all the nodes that are going to be part of the 

service group.

■ The shared drives required for the application are mounted on this node.

■ The startup type of the application service is set to manual on all nodes in 

the service group.

Resources Displays a list of configured resources. The wizard 

assigns unique names to resources. Change the names 

of resource, if required.

To edit a resource name, select the resource name and 

either click it or press the F2 key. Edit the resource 

name and then press the Enter key to confirm the 

changes. To cancel editing a resource name, press the 

Esc key.

Attributes Displays the attributes and their configured values, for 

a resource selected in the Resources list.

Enable FastFailOver 

attribute for all the 

VMDg resources in the 

service group

To enable all the VMDg resources in the service group 

for fast failover, select this checkbox.

For information about the FastFailOver attribute, see 

the Veritas Cluster Server Administrator’s Guide.
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■ The application service is stopped on all nodes in the service group.

■ If your storage is SCSI-3 compliant and you wish to use SCSI-3 persistent 

reservations, enable SCSI-3 support using Veritas Enterprise Administrator 

(VEA).

■ If you have configured a firewall, add the following to the firewall exceptions 

list:

■ Port 14150 or the VCS Command Server service, 

%vcs_home%\bin\CmdServer.exe

Here, %vcs_home% is the installation directory for VCS, typically 

C:\Program Files\Veritas\Cluster Server.

■ Port 14141

For a detailed list of services and ports used by SFW HA, refer to the Veritas 

Storage Foundation and High Availability Solutions for Windows Installation 

and Upgrade Guide.

■ On Windows Server Core, you have to add the required resources and 

configure the service group manually. You can perform the steps either 

directly on the Server Core machine using the command line, or remotely 

using the Cluster Manager (Java console).

Refer to the Veritas Cluster Server Administrator’s Guide for instructions on 

using the command line and the Cluster Manager (Java Console).

Note: If User Access Control (UAC) is enabled on Windows Server systems, 

you must launch the command prompt in the Run as administrator mode 

and then run the VCS commands.

Before configuring the service group, review the resource types and the 

attribute definitions of the FileShare agent, described in the Veritas Cluster 

Server Bundled Agents Reference Guide.

■ Before running the wizard, make sure you have the following information 

ready:

■ Details (service name, start parameters, startup directory, etc.) of the 

application that you wish to configure.

■ Shared storage used by the applications.

■ Application registry entries for configuring registry replication.

■ Network and virtual computer (Lanman) details for the application.
 

Creating the application service group

The following procedure describes how to create an application service group 

using the Application Configuration Wizard.
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If you are using a non-shared storage configuration (dynamic disk groups 

configured on local disks), you have to configure the service group manually 

either using the Cluster Manager (Java Console) or the command line. The 

wizard currently cannot configure resources (VMNSDg agent) required for 

monitoring non-shared storage.

See “Configuring the service group in a non-shared storage environment” on 

page 157.

To create an application service group

1 Start the Application Configuration Wizard from the Solutions 

Configuration Center. Click Start > All Programs > Symantec > Veritas 

Cluster Server > Solutions Configuration Center.

From the Solutions Configurations Center expand the Solutions for 

Additional Applications and from the display click High Availability (HA) 

Configuration > Configure the Service Group > Application Configuration 

Wizard.

or

Click Start > All Programs > Symantec > Veritas Cluster Server > 

Configuration Tools > Application Configuration Wizard.

2 Review the information in the Welcome panel and click Next.

3 In the Wizard Options panel, click Create service group and click Next.

4 Specify the service group name and system list.

■ Enter a name for the service group.

■ In the Available Cluster Systems box, select the systems on which to 

configure the service group and click the right-arrow icon to move the 

systems to the service group’s system list.

To remove a system from the service group’s system list, select the 

system in the Systems in Priority Order list and click the left arrow.

■ To change a system’s priority in the service group’s system list, select 

the system in the Systems in Priority Order list and click the up and 

down arrows. The system at the top of the list has the highest priority 

while the system at the bottom of the list has the lowest priority.

■ To enable the service group to automatically come online on one of the 

systems, select the Include selected systems in the service group's 

AutoStartList attribute checkbox.

For information about the AutoStartList attribute, see the Veritas 

Cluster Server Administrator's Guide.

■ Click Next.

The wizard starts validating your configuration. Various messages 

indicate the validation status.
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5 The Application Options panel provides you the option to specify the type of 

application to be configured. The available options are:

■ Generic Service: Configures a service using the Generic Service agent. 

The agent brings services online, takes them offline, and monitors their 

status. See “Configuring a GenericService resource” on page 139.

■ Process: Configures a process using the Process agent. The agent brings 

processes online, takes them offline, and monitors their status. See 

“Configuring processes” on page 143.

■ Service Monitor: Configures a service using the ServiceMonitor agent. 

The agent monitors a service or starts a user-defined script and 

interprets the exit code of the script. See “Configuring a 

ServiceMonitor resource” on page 147.

Configuring a GenericService resource

1 In the Application Options panel, click Create, select GenericService from 

the corresponding drop-down list, and click Next.
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2 Select the service name for which you wish to configure a GenericService 

resource. Also specify the attributes for the resource.

■ Click the icon (...) adjacent to the Service Name text box.

■ In the Services dialog box, select a service and click OK. The selected 

service appears in the Service Name text box.

■ In the Start Parameters text box, provide the start parameters for the 

service, if any.

■ In the Delay After Online text box, specify the number of seconds the 

agent waits after the service is brought online before starting the 

monitor routine.

■ In the Delay After Offline text box, specify the number of seconds the 

agent waits after the service is taken offline before starting the monitor 

routine.

■ Click Next.
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3 Specify the information about the user in whose context the service will run.

■ To configure a service to run in the context of a local system account, 

click Local System account.

■ To configure a service to run in the context of another user account, 

click This Account. Specify the Domain Name, User Name, and 

Password for the user account.

■ Click Next.
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4 Select the shared storage required for the GenericService resource. The 

shared storage, which you select will be in addition to the mount where the 

service binaries exist.

■ In the Available Shared Drives box, select the check box adjacent to the 

shared drive.

■ Click Next.

5 In the Application Resource Summary panel, review the summary of the 

GenericService resource. Click Back to make changes. Otherwise, click Next.

6 The Application Options panel appears. Select one of the following options:

■ To configure another GenericService resource, repeat step 1 through 

step 5.

■ To configure a Process resource, proceed to “Configuring processes” on 

page 143 for instructions.

■ To configure a ServiceMonitor resource, proceed to “Configuring a 

ServiceMonitor resource” on page 147 for instructions.

■ To configure other resources, including FileShare, Registry 

Replication, and Network resources, proceed to “Configuring VCS 

components” on page 150 for instructions.

If you do not want to add any more resources to your service group, proceed to 

“Configuring application dependencies” on page 153.
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Configuring processes

1 In the Application Options panel, click Create, select Process from the 

corresponding list, and click Next.

2 Specify the details for the process.

■ In the Start Program text box, specify the complete path of the 

program that will start the process to be monitored by VCS. You can 
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choose to either type in the location of the program or browse for it 

using the (...) icon.

■ In the Start Program Parameters text box, specify the parameters used 

by the Process agent start program.

■ In the Program Startup Directory text box, enter the complete path of 

the Process agent program or browse for it by clicking the (...) icon.

■ In the Stop Program text box, enter the complete path of the program 

that will stop the process started by the Start Program or browse for it 

by clicking the (...) icon.

■ In the Stop Program Parameters text box, specify the parameters used 

by the stop program.

■ In the Monitor Program text box, enter the complete path of the 

program that monitors the Start Program or browse for it by clicking 

the (...) icon.

If you do not specify a value for this attribute, VCS monitors the Start 

Program. If the Start Program is a script to launch another program, 

you must specify a monitor program.

■ In the Monitor Program Parameters text box, specify the parameters 

used by the monitor program.

■ In the Clean Program text box, enter the complete path of the Clean 

process or browse for it by clicking the (..) icon.

■ If no value is specified, the agent kills the process indicated by the Start 

Program.

■ In the Clean Program Parameters text box, specify the parameters used 

by the Clean program.

■ Select the Process interacts with the desktop check box if you want the 

process to interact with your Windows desktop. Setting this option 

enables user intervention for the process.

■ Click Next.
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3 Specify information about the user in whose context the process will run.

■ To configure a service to run in the context of a local system account, 

click Local System account.

■ To configure a service to run in the context of another user account, 

click This Account. Specify the Domain Name, User Name, and 

Password for the user account.

■ Click Next.
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4 Select the shared storage required for the Process resource. The shared 

storage, which you select will be in addition to the mount where the service 

binaries exist.

■ From the Available Shared Drives box, select the check box adjacent to 

the shared drive.

■ Click Next.

5 In the Application Resource Summary panel, review the summary of the 

Process resource. Click Back to make changes. Otherwise, click Next.

6 The Application Options panel appears. Select one of the following options:

■ To configure another Process resource, repeat step 1 through step 5.

■ To configure a GenericService resource, see “Configuring a 

GenericService resource” on page 139 for instructions.

■ To configure a ServiceMonitor resource, proceed to “Configuring a 

ServiceMonitor resource” on page 147 for instructions.

■ To configure other resources, including FileShare, Registry 

Replication, and Network resources, proceed to “Configuring VCS 

components” on page 150 for instructions.

If you do not want to add any more resources to your service group, proceed to 

“Configuring application dependencies” on page 153.
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Configuring a ServiceMonitor resource

1 In the Application Options panel, click Create, select ServiceMonitor from 

the corresponding drop-down list, and click Next.

2 Specify the service to be monitored or a user-defined script to monitor a 

service.
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If you want VCS to monitor the service:

■ Select the Service option and click the icon (...) adjacent to the Service 

Name text box.

■ In the Service dialog box, select the service and click OK. The selected 

service name appears in the Service Name text box. Alternatively, You 

may also type in the service name to be monitored.

■ Click Next.

If you want a script to monitor the service:

■ Specify the complete path for the script using the Browse button (...).

■ Specify the parameters for the script.

■ Specify the time in seconds for the agent to receive a return value from 

the monitor script.

■ Click Next.

3 Specify the user information in whose context the service will be monitored.

■ To configure a service to run in the context of a local system account, 

click Local System account.

■ To configure a service to run in the context of another user account, 

click This Account. Specify the Domain Name, User Name, and 

Password for the user account.

If the service selected in step 2 on page 147 is running in the context of 

a local system account, the This Account option is disabled. Similarly, if 
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the service is running in the context of any other user account, the 

Local System account option is disabled.

■ Click Next.

ServiceMonitor resource belongs to the category of persistence resources. 

Such resources do not depend on other VCS resources, including shared 

storage. Hence, the Shared Storage Option panel does not appear if you 

select the ServiceMonitor option.

4 In the Application Resource Summary panel, review the summary of the 

ServiceMonitor resource. Click Back to make changes. Otherwise, click Next.

5 The Application Options panel appears. Select one of the following options:

■ To configure another ServiceMonitor resource, repeat step 1 through 

step 4.

■ To configure a GenericService resource, see “Configuring a 

GenericService resource” on page 139 for instructions.

■ To configure a Process resource, see “Configuring processes” on 

page 143 for instructions.

■ To configure other resources, including FileShare, Registry 

Replication, and Network resources, proceed to “Configuring VCS 

components” on page 150 for instructions.

If you do not want to add any more resources to your service group, proceed to 

“Configuring application dependencies” on page 153.
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Configuring VCS components

Applications configured using GenericService or Process resources may require  

network components, or Registry Replication resources. You can configure 

these VCS components only for service groups created using the wizard.

Note: Configure these components only after configuring all application 

resources. The wizard creates a service group after these components are 

configured. To add more application resources, you must rerun the wizard in the 

Modify mode.

To configure VCS components

1 In the Application Options panel, click Configure Other Components.
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2 Select the VCS component to be configured for your applications.

The available options are:

■ Registry Replication Component: Select this option to configure 

registry replication for your application. To configure a Registry 

Replication resource, proceed to step 3 on page 151.

■ Network Component: Select this option to configure network 

components for your application. If you wish to configure a virtual 

computer name, check Lanman component also. To configure a 

network resource, proceed to step 4 on page 152.

The wizard does not enable the Lanman Component check box unless the 

Network Component check box is checked.

To configure Registry Replication

The RegistryReplication panel appears only if you chose to configure the 

Registry Replication Component in the Application Component panel.

3 Specify the registry keys to be replicated.

■ Specify the directory on the shared disk in which the registry changes 

are logged.

■ Click Add.

■ In the Registry Keys dialog box, select the registry key to be replicated.

■ Click OK.

■ The selected registry key is added to Registry KeyList box. Click Next.
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If you chose Network Component from the Application Component panel, 

proceed to the next step. Otherwise, proceed to step 5 on page 153.

To configure network components

The Virtual Computer Configuration panel appears only if you chose to 

configure the Network Component in the Application Component panel.

4 Specify information related to your network.

■ Select IPv4 to configure an IPv4 address for the virtual server.

■ In the Virtual IP Address field, type a unique virtual IPv4 address 

for the virtual server.

■ In the Subnet Mask field, type the subnet to which the virtual IPv4 

address belongs.

■ Select IPv6 to configure an IPv6 address for the virtual server. The IPv6 

option is disabled if the network does not support IPv6.

■ Select the prefix from the drop-down list. The wizard uses the 

prefix and automatically generates an IPv6 address that is valid 

and unique on the network.

■ In the Virtual Server Name field, enter a unique virtual computer name 

by which the node will be visible to the other nodes. Note that the 

virtual name must not exceed 15 characters.

Note that the Virtual Computer Name text box is displayed only if you 

chose to configure the Lanman Component in Application Component 

panel. 

■ Click Advanced to specify additional details for the Lanman resource.

■ Check AD Update required to enable the Lanman resource to 

update the Active Directory with the virtual name. This sets the 

Lanman agent attributes ADUpdateRequired and 

ADCriticalForOnline to true.

■ In the Organizational Unit field type the distinguished name of the 

Organizational Unit for the virtual server in the format 

CN=containername,DC=domainname,DC=com. To browse for an 

OU, click the ellipsis (...) button and search for the OU using the 

Windows Find Organization Units dialog box.for the virtual server. 

By default, the Lanman resource adds the virtual server to the 

default container "Computers."

The user account for VCS Helper service must have adequate 

privileges on the specified container to create and update 

computer accounts.

■ Click OK.
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■ For each system in the cluster, select the public network adapter name. 

The Adapter Display Name field displays the TCP/IP enabled adapters 

on a system, including the private network adapters, if applicable. 

To view the adapters associated with a system, click the Adapter 

Display Name field and click the arrow. Verify that you select the adapters 

assigned to the public network, not the private.

■ Click Next.

5 The Application Options panel is displayed. Select one of the following 

options:

■ To configure additional VCS components, repeat step 1 on page 150 

through step 4 on page 152.

■ To configure a GenericService resource, see “Configuring a 

GenericService resource” on page 139 for instructions.

■ To configure a Process resource, see “Configuring processes” on 

page 143 for instructions.

■ To configure a Service Monitor resource, see “Configuring a 

ServiceMonitor resource” on page 147 for instructions.

If you do not want to add any more resources to your service group, proceed 

to “Configuring application dependencies” on page 153.

Configuring application dependencies

The Application Configuration Wizard enables you to create service group for 

the application resources and other VCS components configured using the 

wizard. This section describes how to create the service group using the wizard.
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To create a service group

1 In the Application Options panel, click Configure application dependency 

and create service group.

The option is enabled only if:

■ resources and VCS components are already configured using the 

wizard.

■ you clicked Modify Service Group in the wizard options panel.
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2 Specify the dependency between the applications.

You must have at least two resources configured for Application 

Dependency panel to appear. Of the two resources, one should either be a 

GenericService or a Process resource.

■ From the Select Application list, select the application that would 

depend on other applications. The selected application becomes the 

parent application.

■ From the Available Applications list, select the application on which 

the parent application would depend and click the right-arrow icon to 

move the application to the Child Applications list.

■ To remove an application from the Child Applications list, select the 

application in the list and click the left arrow.

■ Repeat these steps for all such applications for which you want to 

create a dependency.

■ Click Next.

The Application Dependency panel enables you to link resources configured 

using the wizard. If these resources are dependent on other services outside 

the VCS environment, you should first configure resources for such services 

and then create the appropriate dependency.

3 Review the service group configuration.

The Resources box lists the configured resources. Click on a resource to 

view its attributes and their configured values in the Attributes box.
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■ The wizard assigns unique names to resources. Change names of 

resource, if required.

To edit a resource name, select the resource name and either click it or 

press the F2 key. Press Enter after editing each resource name. To 

cancel editing a resource name, press the Esc key.

■ To enable all the VMDg resources in the service group for fast failover, 

select the Enable FastFailOver attribute for all the VMDg resources in 

the service group checkbox.

For information about the FastFailOver attribute, see the Veritas 

Cluster Server Administrator’s Guide.

■ Click Next.

■ A message appears informing you that the wizard will run commands 

to modify the service group configuration. Click Yes.

The wizard starts running commands to create the service group. 

Various messages indicate the status of these commands. After the 

commands are executed, the completion dialog box appears.

4 In the completion panel, check Bring the service group online if you want to 

bring the service group online on the local system.

5 Click Finish to create the service group and exit the Application 

Configuration Wizard.
 

 

 

Enabling fast failover for disk groups (optional)
For service groups that contain many disk groups, you can greatly reduce 

failover time by implementing the SFW fast failover feature for disk groups. 

More information is available about fast failover benefits and requirements.

See “Considerations for a fast failover configuration” on page 87.

To use fast failover for VCS clusters, install the VCS Fast Failover option during 

SFW HA installation. A license is required to activate the feature.

For implementing the fast failover feature, VCS provides a new attribute, 

FastFailOver, for the Volume Manager Diskgroup (VMDg) resource. This 

attribute determines whether or not a disk group is enabled for fast failover.

Note: The disk group version must be 60 or later for fast failover to work. To 

verify the disk group version, from the VEA console, right-click the disk group 

and click Properties. Disk group version upgrade is required after upgrading 

SFW HA on the cluster nodes. Refer to the Veritas Storage Foundation and High 

Availability Solutions Installation and Upgrade Guide for more information.
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You can enable fast failover for all the VMDg resources while configuring the 

service group using the configuration wizard. The service group configuration 

wizard provides a checkbox to enable fast failover.

Perform these steps if you did not enable fast failover using the wizard or if you 

have configured the service group manually.

The following procedure describes how to enable the FastFailOver attribute 

using the VCS Java Console.

To enable the FastFailover attribute for a VMDg resource

1 In Cluster Manager (Java Console), select a service group with a VMDg 

resource configured for it. Select the Properties tab from the right pane.

2 Scroll down to choose the FastFailOver attribute and click to edit the 

attribute value.

3 In the Edit Attribute dialog box, check the FastFailOver check box and then 

click OK.

4 Repeat these steps for every VMDg resource for which you want to enable 

fast failover.
 

 

Configuring the service group in a non-shared 
storage environment

If you are using a non-shared storage configuration, you have to use the VCS 

MountV – VMNSDg agents to monitor the local disks. Currently, the service 

group configuration wizard does not support configuring these agents in the 

service group. You have to configure these agents manually by using the Cluster 

Manager (Java Console) or the VCS commands.

VCS provides templates for configuring application service groups that use 

non-shared storage agent resources.

The Java Console templates are located in the following directory:

%VCS_HOME%\Templates

Here, %VCS_HOME% is the default product installation directory for VCS, 

typically, C:\Program Files\Veritas\Cluster Server.

For information about adding a service group using templates from the Cluster 

Manager (Java Console), refer to the VCS Administrator’s Guide.

The following steps describe how to create a service group using the Java 

Console.
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To configure the service group in a non-shared storage environment

5 Open the Cluster Manager (Java Console). Click Start > All Programs > 

Symantec > Veritas Cluster Server and then click Veritas Cluster Manager - 

Java Console.

6 Log on to the cluster. On the Cluster Monitor window click File > New 

Cluster, then on the New Cluster window type localhost in the Host name 

field, and then click OK.

7 Launch the service group configuration wizard. From the Cluster Explorer 

window menu, click Tools > Configuration Wizard.

8 On the Service Group Configuration Wizard Welcome panel, click Next.

9 Fill in the following information and then click Next:

■ Specify a name for the service group.

■ Select the systems for the service group. Click a system in the Available 

Systems box and then click the right arrow to move the system to 

Systems for Service Group.

■ Leave the service group type as the default, Failover.

10 Click Next again.

11 In the Templates list, select the desired service group template depending 

on the configuration and then click Next.

Table 6-5 displays the templates available.

Table 6-6 Non-shared storage: service group templates

Template name Description

FileShareVMNSGroup

IIS60VMNSGroup

MSMQVMNSGroup

Use these templates to create a single node high 

availability service group that uses non-shared 

storage.

These templates include resources for configuring 

MountV and VMNSDg agents.

FileShareVirtVMNSGroup

IIS60VirtVMNSGroup

MSMQVirtVMNSGroup

Use these templates to create a single node high 

availability service group in a VMware virtual 

environment.

These templates includes resources for 

configuring MountV, VMwareDisks, and VMNSDg 

agents.

VvrRvgVMNSRVGGroup Use this template to create a VVR replication 

service group on a single node that uses 

non-shared storage.



159Deploying SFW HA for high availability: New installation

Verifying the cluster configuration
The Templates box lists the templates available on the system to which 

Cluster Manager is connected. The resource dependency graph of the 

templates, the number of resources, and the resource types are also 

displayed.

12 Click Next. The wizard starts creating the service group.

13 After the service group is successfully created, click Next to edit attributes 

using the wizard.

14 The wizard lists the resources and their attributes. You must specify values 

for the mandatory attributes that appear in bold. The remaining resources 

listed in the window are preconfigured by the template and do not require 

editing.

To modify an attribute, do the following:

■ Click the resource.

■ Click the attribute to be modified.

■ Click the Edit icon at the end of the table row.

■ In the Edit Attribute dialog box, enter the attribute values.

■ Click OK.

For details on application-specific agent attributes, refer to the 

application-specific agent or solutions guide. For details on the storage, 

network, and other agent attributes, refer to the VCS Bundled Agents 

Reference Guide.

15 Click Finish.

16 Right-click the newly created service group and select Enable Resources.

17 Right-click the newly created service group, select Online from the context 

menu, and then select a system on which to bring the service group online.

If you are configuring the service group on a node at the secondary site in a 

DR environment, bring the service group online only after completing all 

the DR configuration steps.
 

Verifying the cluster configuration

To verify the configuration of a cluster, either move the online groups, or shut 

down an active cluster node.

■ Use Veritas Cluster Manager (Java Console) to switch all the service groups 

from one node to another.

■ Simulate a local cluster failover by shutting down an active cluster node.
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To switch service groups

1 In the Veritas Cluster Manager (Java Console), click the cluster in the 

configuration tree, click the Service Groups tab, and right-click the service 

group icon in the view panel. 

■ Click Switch To, and click the appropriate node from the menu.

■ In the dialog box, click Yes. The service group you selected is taken 

offline on the original node and brought online on the node you 

selected.

If there is more than one service group, you must repeat this step until 

all the service groups are switched.

2 Verify that the service group is online on the node you selected to switch to 

in step 1.

3 To move all the resources back to the original node, repeat step 1 for each of 

the service groups.

To shut down an active cluster node

1 Gracefully shut down or restart the cluster node where the service group is 

online.

2 In the Veritas Cluster Manager (Java Console) on another node, connect to 

the cluster.

3 Verify that the service group has failed over successfully, and is online on 

the next node in the system list.

4 If you need to move all the service groups back to the original node:

■ Restart the node you shut down in step 1.

■ Click Switch To, and click the appropriate node from the menu.

■ In the dialog box, click Yes. 

The service group you selected is taken offline and brought online on 

the node that you selected.
 

Possible tasks after completing the configuration
After completing the configuration, you may want to make some changes to the 

cluster configuration or modify the application service groups. Depending on 

your specific requirements perform one of the following operations:

■ Modifying the existing cluster configuration to add additional nodes or 

remove existing nodes.

See “Modifying the existing cluster configuration” on page 161.

■ Modifying the replication service group configuration.
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See “Modifying the application service groups” on page 166.

Modifying the existing cluster configuration

To add a node to a VCS cluster

1 Start the VCS Cluster Configuration wizard.

Click Start > All Programs > Symantec > Veritas Cluster Server > 

Configuration Tools > Cluster Configuration Wizard.

Run the wizard from the node to be added or from a node in the cluster. The 

node that is being added should be part of the domain to which the cluster 

belongs.

2 Read the information on the Welcome panel and click Next.

3 On the Configuration Options panel, click Cluster Operations and click 

Next.

4 In the Domain Selection panel, select or type the name of the domain in 

which the cluster resides and select the discovery options.

Do one of the following:

■ To discover information about all the systems and users in the domain:

■ Clear the Specify systems and users manually check box.

■ Click Next.

Proceed to step 8 on page 164.
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■ To specify systems and user names manually (recommended for large 

domains):

■ Check the Specify systems and users manually check box.

Additionally, you may instruct the wizard to retrieve a list of 

systems and users in the domain by selecting appropriate check 

boxes.

■ Click Next.

If you chose to retrieve the list of systems, proceed to step 6 on 

page 163. Otherwise proceed to the next step.

5 On the System Selection panel, complete the following and click Next.

■ Type the name of a node in the cluster and click Add.

■ Type the name of the system to be added to the cluster and click Add.

If you specify only one node of an existing cluster, the wizard discovers all 

nodes for that cluster. To add a node to an existing cluster, you must specify 

a minimum of two nodes; one that is already a part of a cluster and the other 

that is to be added to the cluster.

Proceed to step 8 on page 164.
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6 On the System Selection panel, specify the systems to be added and the 

nodes for the cluster to which you are adding the systems.

Enter the system name and click Add to add the system to the Selected 

Systems list. Alternatively, you can select the systems from the Domain 

Systems list and click the right-arrow icon.

If you specify only one node of an existing cluster, the wizard discovers all 

nodes for that cluster. To add a node to an existing cluster, you must specify 

a minimum of two nodes; one that is already a part of a cluster and the other 

that is to be added to the cluster.

7 The System Report panel displays the validation status, whether Accepted 

or Rejected, of all the systems you specified earlier. Review the status and 

then click Next.

A system can be rejected for any of the following reasons:

■ System is not pingable.

■ WMI access is disabled on the system.

■ Wizard is unable to retrieve the system architecture or operating 

system.

■ VCS is either not installed on the system or the version of VCS is 

different from what is installed on the system on which you are 

running the wizard.

Click on a system name to see the validation details. If you wish to include a 

rejected system, rectify the error based on the reason for rejection and then 

run the wizard again.
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8 On the Cluster Configuration Options panel, click Edit Existing Cluster and 

click Next.

9 On the Cluster Selection panel, select the cluster to be edited and click Next.

If you chose to specify the systems manually in step 4, only the clusters 

configured with the specified systems are displayed.

10 On the Edit Cluster Options panel, click Add Nodes and click Next.

In the Cluster User Information dialog box, type the user name and 

password for a user with administrative privileges to the cluster and click 

OK.

The Cluster User Information dialog box appears only when you add a node 

to a cluster with VCS user privileges, that is when the cluster configuration 

does not use the Symantec Product Authentication Service for secure 

cluster communication.

11 On the Cluster Details panel, check the check boxes next to the systems to be 

added to the cluster and click Next.

The right pane lists nodes that are part of the cluster. The left pane lists 

systems that can be added to the cluster.

12 The wizard validates the selected systems for cluster membership. After the 

nodes have been validated, click Next.

If a node does not get validated, review the message associated with the 

failure and restart the wizard after rectifying the problem.

13 On the Private Network Configuration panel, configure the VCS private 

network communication on each system being added and then click Next. 

How you configure the VCS private network communication depends on 
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how it is configured in the cluster. If LLT is configured over ethernet, you 

have to use the same on the nodes being added. Similarly, if LLT is 

configured over UDP in the cluster, you have to use the same on the nodes 

being added.

Do one of the following:

■ To configure the VCS private network over ethernet, complete the 

following steps:

■ Select the check boxes next to the two NICs to be assigned to the 

private network.

Symantec recommends reserving two NICs exclusively for the 

private network. However, you could lower the priority of one NIC 

and use the low-priority NIC for both public and private 

communication.

■ If you have only two NICs on a selected system, it is recommended 

that you lower the priority of at least one NIC that will be used for 

private as well as public network communication.

To lower the priority of a NIC, right-click the NIC and select Low 

Priority from the pop-up menu.

Note: If you wish to use Windows NIC teaming, you must select the 

Static Teaming mode. Only the Static Teaming mode is currently 

supported.

■ If your configuration contains teamed NICs, the wizard groups 

them as "NIC Group #N" where "N" is a number assigned to the 

teamed NIC. A teamed NIC is a logical NIC, formed by grouping 

several physical NICs together. All NICs in a team have an identical 

MAC address. Symantec recommends that you do not select 

teamed NICs for the private network.

The wizard configures the LLT service (over ethernet) on the selected 

network adapters.

■ To configure the VCS private network over the User Datagram Protocol 

(UDP) layer, complete the following steps:

■ Select the check boxes next to the two NICs to be assigned to the 

private network. You can assign maximum eight network links.

Symantec recommends reserving at least two NICs exclusively for 

the VCS private network.

■ Specify a unique UDP port for each of the link. Click Edit Ports if 

you wish to edit the UDP ports for the links. You can use ports in 

the range 49152 to 65535. The default ports numbers are 50000 

and 50001 respectively. Click OK.
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■ For each selected NIC, verify the displayed IP address. If a selected 

NIC has multiple IP addresses assigned, double-click the field and 

choose the desired IP address from the drop-down list. In case of 

IPv4, each IP address can be in a different subnet.

The IP address is used for the VCS private communication over the 

specified UDP port.

■ For each selected NIC, double-click the respective field in the Link 

column and choose a link from the drop-down list. Specify a 

different link (Link1 or Link2) for each NIC. Each link is associated 

with a UDP port that you specified earlier.

The wizard configures the LLT service (over UDP) on the selected network 

adapters. The specified UDP ports will be used for the private network 

communication.

14 On the Public Network Communication panel, select a NIC for public 

network communication, for each system that is being added, and then click 

Next.

This step is applicable only if you have configured the ClusterService 

service group, and the system being added has multiple adapters. If the 

system has only one adapter for public network communication, the wizard 

configures that adapter automatically.

Note: If you wish to use Windows NIC teaming, you must select the Static 

Teaming mode. Only the Static Teaming mode is currently supported.

15 Specify the password for the user in whose context the VCS Helper service 

runs.

16 Review the summary information and click Add.

The wizard starts running commands to configure the VCS components on 

the node. In case of a secure cluster, the wizard also configures the VCS 

Authentication Service on the new node that is being added.

17 After all commands have been successfully run, click Finish.
 

Modifying the application service groups
You may want to modify existing application service groups. Use one of the 

following options depending on your specific application environment:

■ Modifying the FileShare service group

■ Modifying the IIS service group

■ Modifying any other application service group
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Modifying the FileShare service group

To modify a File Share service group

1 Start the File Share Configuration Wizard from the Solutions Configuration 

Center. Click Start > All Programs > Symantec > Veritas Cluster Server > 

Solutions Configuration Center.

From the Solutions Configurations Center expand the Solutions for 

Additional Applications and from the display click High Availability (HA) 

Configuration > Configure the Service Group > File Share Configuration 

Wizard.

2 Review the information in the Welcome panel and click Next.

3 In the Wizard Options panel, select Modify service group, select the service 

group to be modified, and click Next.

4 Follow the wizard instructions and make required modifications to the 

service group configuration.
 

 

 

Modifying the IIS service group

The IIS configuration wizard enables you to modify an IIS service group.

Note the following before you modify an IIS service group:

■ If the IIS service group is online, you must run the wizard from a system on 

which the service group is online. You can then add and remove resources to 

the configuration using the wizard; you cannot modify resources that are 

online.

■ To change the online resource attributes, you must take the service group 

offline. However, the MountV and VMDg resources for the service group 

should be online on the node where you run the wizard and offline on all 

other nodes.

■ If you are running the wizard to remove a node from the service group’s 

system list, do not run the wizard on the node being removed.

■ If the service group contains resources that were not part of the default 

service group configuration, then modifying the service group may change 

those resources. You may then have to manually restore the settings of those 

resources later.

To modify the IIS service group

1 Start the IIS Configuration Wizard from the Solutions Configuration Center. 

Click Start > All Programs > Symantec > Veritas Cluster Server > Solutions 

Configuration Center.
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2 From the Solutions Configurations Center, expand the Solutions for 

Additional Applications and from the display click High Availability (HA) 

Configuration > Configure the Service Group > IIS Configuration Wizard.

3 Review the information in the Welcome panel and click Next.

4 In the Wizard Options panel, choose the Modify service group option, select 

the service group to be modified, and click Next.

5 Follow the wizard instructions and make required modifications to the 

service group configuration.
 

 

 

Modifying any other application service group

This section describes how to modify a service group using the Application 

Configuration Wizard. Following are some points to note before modifying the 

service group:

■ If the service group to be modified is online, you must run the wizard from a 

system on which the service group is online. You can then add and remove 

resources to the configuration using the wizard; you cannot modify 

resources that are online.

■ To change the resource attributes, you must take the service group offline. 

However, the MountV and VMDg resources for the service group should be 

online on the node where you run the wizard and offline on all other nodes.

■ If you are running the wizard to remove a node from the service group’s 

system list, do not run the wizard on the node being removed.

■ If the service group contains resources that were not part of the default 

service group configuration, then modifying the service group may change 

those resources. You may then have to manually restore the settings of those 

resources later.

Note: Symantec recommends that you do not use the wizard to modify service 

groups that were not created using the wizard.

To modify a service group

1 Start the Application Configuration Wizard from the Solutions 

Configuration Center. Click Start > All Programs > Symantec > Veritas 

Cluster Server > Solutions Configuration Center.

From the Solutions Configurations Center, expand the Solutions for 

Additional Applications and from the display click High Availability (HA) 
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Configuration > Configure the Service Group > Application Configuration 

Wizard.

2 Review the information in the Welcome panel and click Next.

3 In the Wizard Options panel, click Modify service group. From the Service 

Groups list, select the service group containing the resource that you want 

to modify.

4 In the Service Group Configuration panel, perform the following optional 

tasks if desired, and then click Next.

■ In the Available Cluster Systems box, select additional systems on 

which to configure the service group and click the right-arrow icon to 

move the systems to the service group’s system list.

To remove a system from the service group’s system list, select the 

system in the Systems in Priority Order list and click the left arrow.

■ To change a system’s priority in the service group’s system list, select 

the system in the Systems in Priority Order list and click the up and 

down arrows. The system at the top of the list has the highest priority 

while the system at the bottom of the list has the lowest priority.

■ To enable the service group to automatically come online on one of the 

systems, select the Include selected systems in the service group's 

AutoStartList attribute checkbox.

For information about the AutoStartList attribute, see the Veritas 

Cluster Server Administrator's Guide.



170 Deploying SFW HA for high availability: New installation

Possible tasks after completing the configuration
5 Click Modify and select the resource you want to modify and then click Next.

The Modify option is enabled only if:

■ Service and Process resources are already configured using the wizard.

■ You selected the Modify Service Groups option in the Wizard Options 

dialog box.

6 Depending on the resource you chose to modify from the Application 

Options page, you would either get the Generic Service Options, Process 

Details, or Service Monitor Options dialog box. Make required changes in 

the appropriate dialog box and click Next.

7 In the User Details dialog box, specify the user information and click Next.

8 In the Application Resource Summary dialog box, review the summary of 

the resource.

When modifying a volume in the service group, the Enable FastFailOver 

attribute for all the VMDg resources in the service group checkbox appears. 

Select this checkbox to enable all the VMDg resources in the service group 

for fast failover. For information about the FastFailOver attribute, see the 

Veritas Cluster Server Administrator’s Guide.

Click Back to make other changes to the resource. Otherwise, click Next.

9 The Application Options dialog box appears. Repeat step 5 through step 8 

for each resource that you want to modify.

10 After modifying the required resources, you can use the wizard to:
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■ Add additional resources to the service group.

■ Delete resources from the service group.

■ Add VCS components to the service group.
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Chapter
 7
Adding DMP to a 

clustering configuration

This chapter has the following topics:

■ “About dynamic multi-pathing” on page 173

■ “Overview of configuration tasks for adding DMP DSMs” on page 174

■ “Reviewing prerequisites” on page 174

■ “Reviewing the configuration” on page 175

■ “Steps for a new cluster configuration” on page 176

■ “Steps for an existing cluster configuration” on page 177

About dynamic multi-pathing
Dynamic Multi-pathing is an optional software component in SFW that provides 

redundant path support for your storage. This support is provided by DMP 

DSMs (DMP Device Specific Modules). You can add Dynamic Multi-pathing 

(DMP) to a clustering configuration.

The steps for adding Dynamic Multi-pathing are given for both a new cluster 

configuration and an existing cluster configuration. The cluster configuration 

can be either VCS or Microsoft clustering. The steps for enabling Dynamic 

Multi-pathing are done after a cluster is up and running and tested. A second 

host bus adapter in each computer allows redundant paths to the storage for 

fault tolerance purposes. The Dynamic Multi-pathing software controls the 

usage of the paths and allows only one path to the storage to operate at a time. 

However, if one path fails, the Dynamic Multi-pathing software will 

automatically transfer the storage to the second path. 

In installing DMP DSMs you must connect only one host bus adapter path while 

you are setting up the hardware and installing the DMP DSM software and any 
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other software. This is true for both a new installation and an existing 

installation.

For the hardware setup step for each server, install the second host bus adapter 

in each computer, but do not connect it to the switch. After SFW and the cluster 

are set up and working and the DMP DSMs software is installed and running, 

then perform the additional steps to activate the DMP DSMs.

Overview of configuration tasks for adding DMP 
DSMs

There are multiple tasks to add DMP DSMs on each server. The order in which 

the tasks are done in relation to the rest of the configuration depends on 

whether you are installing a new configuration or upgrading an existing cluster 

configuration. Detailed steps are presented in later sections. In summary, the 

tasks are the following:

■ Install a second host bus adapter in each server. Do not connect the second 

path to each additional switch at this point. The path must be left 

unconnected.

For a new install, this step can be done with the initial hardware 

configuration before the servers are running.

For an existing cluster system, a rolling upgrade procedure is used to allow 

installation of the hardware and software on the inactive node on the 

cluster. When the installation of one node is complete, switch the active 

node and complete the hardware and software installation on the remaining 

node that is inactive.

■ Install the DMP DSMs software on the inactive node.

Installing DMP DSMs requires a reboot, and this avoids rebooting the active 

node of the cluster. 

■ Using appropriate cables, connect the second path on Server A to the second 

switch. Configure the switch, if necessary. Do the same for the second switch 

on Server B.

■ Verify that both paths are under DMP DSMs control.

■ Access the Array Settings dialog for each array and make sure that the array 

load balancing settings are set to active/passive.

Reviewing prerequisites
This solution assumes that the required software is already installed and 

configured. Refer to the Veritas Storage Foundation Administrator’s Guide and 
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Veritas Storage Foundation and High Availability Solutions Installation and 

Upgrade Guide for installation and configuration information. 

Supported software

■ Veritas Storage Foundation for Windows (SFW) or Veritas Storage 

Foundation HA for Windows (SFW HA) with the Dynamic Multi-pathing 

(DMP) option

If you already have the SFW or SFW HA software installed and want to add 

Dynamic Multi-pathing, purchase a license key for the Dynamic Multi-pathing 

option and use Add or Remove Programs from the Windows Control Panel to 

add the option.

Hardware requirements (Two-server cluster)

■ 2 HBAs with appropriate cabling

■ 2 fibre switches

Before you install SFW HA, verify that your configuration meets these criteria 

and that you have reviewed the Hardware Compatibility List to confirm 

supported hardware at:

http://www.symantec.com/docs/TECH152806

Reviewing the configuration
The purpose of the configuration is to add Dynamic Multi-pathing (DMP) to a 

clustering configuration. Dynamic Multi-pathing is an optional software 

component in SFW and SFW HA that provides redundant path support for your 

storage. You need to have two switches per server, one switch to accommodate 

each path. The diagram illustrates the four different host bus adapter paths.

http://www.symantec.com/docs/TECH152806
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Figure 7-1 Adding fault tolerance with DMP

Steps for a new cluster configuration
Use the following procedure to set up DMP DSMs.

To set up DMP DSMs

1 Install additional hardware and its appropriate drivers.

2 Connect only one path from the array to the computer.

3 Install the appropriate DMP DSMs using Add or Remove Programs from the 

Windows Control Panel. For more information, see the Veritas Storage 

Foundation and High Availability Solutions Installation and Upgrade Guide.

4 Reconnect the additional physical path.

5 Reboot the system.

6 Verify that the additional path is displayed.
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Steps for an existing cluster configuration
Use the following procedure to set up DMP DSMs.

To set up DMP DSMs

1 Move resources to another node or take the resources offline.

2 Install additional hardware and its appropriate drivers.

3 Connect only one path from the array to the computer.

4 Install the appropriate DMP DSM using Add or Remove Programs from the 

Windows Control Panel. For more information, see the Veritas Storage 

Foundation and High Availability Solutions Installation and Upgrade Guide.

5 Reconnect the additional physical path.

6 Reboot the system.

7 Verify that the additional path is displayed.
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■ Introduction to campus clustering
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Chapter
 8
Introduction to campus 

clustering

This chapter contains the following topics:

■ “About Campus Clusters” on page 181

■ “Sample campus cluster configuration” on page 182

■ “Differences between campus clusters and local clusters” on page 183

About Campus Clusters
A campus cluster is a single cluster that stretches over two sites using fiber 

channel connectivity, with SAN connections for data mirroring and network 

connections for cluster communication. Although two sites are the most 

common, more than two can be used for additional redundancy.

Clusters are usually located across a campus or a city but can range over much 

wider distances if their infrastructure supports it, using Fibre Channel SANs and 

long-wave optical technologies. 

Storage administrators can protect their clusters by using campus clusters to 

protect from natural disasters, such as floods and hurricanes, and from 

unpredictable power blackouts. Campus clusters provide disaster protection 

when an entire site goes down by locating the clustered servers in different 

buildings or areas. This solution provides a level of high availability that is 

above mirroring or clustering at a single site and is an alternative to using 

replication software.
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Sample campus cluster configuration
The following sample configuration represents a campus cluster with two sites, 

Site A and Site B.

Figure 8-1 Typical campus clustering configuration

With SFW, a campus cluster can be set up using a Veritas Cluster Server (VCS) 

configuration. Both configurations involve setting up a single cluster with two 

nodes that are in separate buildings and are connected via a single subnet and 

Fibre Channel SAN. Each node has its own storage array with an equal number 

of disks and contains mirrored data of the storage on the other array. SFW 

provides the mirrored storage and the disk groups that make it possible to fail 

over the storage by deporting the disk groups on one node and importing them 

on the other.

If a site failure occurs in a two-node campus cluster, the remaining cluster node 

will not be able to bring the cluster disk groups online because it cannot reserve 

a majority of disks in the disk groups. To allow for failover to the other site, a 

procedure forces the import to the other node, allowing a cluster disk group to 
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be brought online on another node when that node has a minority of the cluster 

disks.

Implementing these force import procedures should be done with care. The 

primary site may appear to have failed but what really has happened is that both 

the storage interconnect between sites and the heartbeats have been lost. In that 

case, cluster disk groups can still be online on the primary node. If a force 

import is done so that the data can be accessed on the secondary site, the cluster 

disks will be online on both sites, risking data corruption.

Differences between campus clusters and local 
clusters

The procedures for setting up a campus cluster are nearly the same as those for 

local clusters, except that a campus cluster has the nodes located in separate 

buildings, so the hardware setup requires SAN interconnects that allows these 

connections. Also, in a campus cluster, each node has its own storage array 

rather than having a shared storage array between the two clusters. Both local 

clusters and campus clusters have SFW dynamic disk groups and volumes, but 

the volumes on each campus cluster node are mirrors of one another.
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Chapter
 9
Deploying SFW HA for 

campus cluster

This chapter contains the following topics:

■ “About the Campus Cluster solution” on page 186

■ “Reviewing the requirements” on page 187

■ “Reviewing the configuration” on page 194

■ “Installing and configuring the hardware” on page 199

■ “Configuring the storage hardware and network” on page 200

■ “Installing Veritas Storage Foundation HA for Windows” on page 201

■ “Configuring the cluster” on page 211

■ “Creating disk groups and volumes” on page 223

■ “Installing the application on cluster nodes” on page 233

■ “Configuring service groups” on page 237

■ “Verifying the cluster configuration” on page 278
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About the Campus Cluster solution
This chapter presents a VCS campus clustering configuration example with 

SFW HA. 

The table below outlines the configuration’s high-level objectives and the tasks 

for each objective.

Table 9-1 Task list: Campus Cluster configuration 

Objectives Tasks

“Reviewing the requirements” on 

page 187

Verify hardware and software prerequisites.

“Reviewing the configuration” on 

page 194

■ Review the configuration requirements.

■ Overview of VCS campus cluster, and 

recovery scenarios

“Installing and configuring the 

hardware” on page 199

■ Install the hardware for Site A. 

■ Install the hardware in the same manner 

for Site B.

■ Make all the necessary hardware 

connections between the two cluster 

nodes.

“Configuring the storage hardware and 

network” on page 200

■ Install the operating system on both 

nodes.

■ Make necessary networking settings on 

both nodes.

“Installing Veritas Storage Foundation 

HA for Windows” on page 201

■ Install SFW HA on both nodes with the 

push install. Doing so installs SFW, VCS, 

and the Veritas Cluster Server Enterprise 

Agent on both cluster nodes.

“Configuring the cluster” on page 211 Use the VCS Cluster Configuration Wizard 

(VCW) to set up the cluster.

“Creating disk groups and volumes” on 

page 223

■ Create dynamic cluster disk groups.

■ Create dynamic volumes.
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Reviewing the requirements 
Review these product installation requirements for your systems before 

installation. Minimum requirements and Symantec recommended requirements 

may vary.

Note: Before you install the SFW or SFW HA software, verify that your 

configuration meets the following criteria and that you have reviewed the 

Hardware compatibility List to confirm supported hardware: 
http://www.symantec.com/docs/TECH152806

Disk space requirements
The following table estimates disk space requirements for SFW HA.

 

“Installing the application on cluster 

nodes” on page 233

■ Install the application program files on 

the local drive of the first node.

■ Install files relating to the data and logs 

on the shared storage.

■ Deport the disk groups on the first node 

and import them on the second node.

■ Install the application on the second node.

“Configuring service groups” on 

page 237

■ Use an appropriate method to create and 

configure the VCS service group or groups.

■ Bring the service group online.

“Verifying the cluster configuration” 

on page 278

■ Switch the service group to the second 

node.

■ Switch it back to the first node.

Table 9-1 Task list: Campus Cluster configuration (Continued)

Objectives Tasks

Table 9-2 Disk space requirements

Installation options Required disk space

SFW HA + all options 832 MB

Client components 916 MB

http://www.symantec.com/business/support/index.jsp
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Requirements for Veritas Storage Foundation 
High Availability for Windows (SFW HA)

Before installing Veritas Storage Foundation High Availability for Windows 

(SFW HA), ensure that you review the following:

■ Review the general installation requirements for SFW HA in the Veritas 

Storage Foundation and High Availability Solutions for Windows Installation 

and Upgrade Guide.

■ Review the SFW HA Hardware Compatibility List to confirm supported 

hardware:

http://www.symantec.com/docs/TECH152806

■ Review the SFW HA Software Compatibility List to confirm supported 

software:

http://www.symantec.com/docs/TECH201485

Note: Solutions wizards cannot be used to perform Disaster Recovery, Fire 

Drill, or Quick Recovery remotely on Windows Server Core systems.

■ Review the operating systems supported with Veritas Storage Foundation 

High Availability for Windows (SFW HA).

■ When installing SFW HA for a Disaster Recovery configuration, ensure that 

you select the VCS Global Clustering Option and if required for your 

replication solution, select the SFW Veritas Volume Replicator option.

■ When installing SFW HA for a Replicated Data Cluster configuration, ensure 

that you select the VCS option to install Veritas Volume Replicator.

Supported operating systems
SFW and SFW HA have client and server components that run on specific 

Windows operating systems.

SFW and SFW HA software for servers

Your system must run one of the operating systems listed to install the SFW or 

SFW HA server software.

Note: SFW software for servers supports Hyper-V and parent partitions. SFW 

HA software for servers does not support Hyper-V and parent partitions.

http://www.symantec.com/docs/TECH152806
http://www.symantec.com/docs/TECH201485
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The following table shows supported operating systems.

SFW and SFW HA software for clients

The SFW or SFW HA client software can be installed on any one of the operating 

system versions, editions, and architectures that the Server Components are 

supported on, except Server Core.

The following table shows the additional client operating systems that are 

supported.

Table 9-3 Supported operating systems

Windows Server Platform Edition Version

Windows Server 2012 x64 Standard, Datacenter GA

Windows 2012 Server Core x64 GA

Table 9-4 Additional supported client operating systems

Windows Client Platform Edition Version

Windows XP x86, x64 SP3 required 

for x86; SP2 

required for 

x64

Windows Vista x86, x64 Ultimate, Business, Premium SP1 or SP2 

required

Windows 7 x86, x64 Professional, Ultimate RTM or SP1 

required

Windows 8 x86, x64 Windows 8, Windows 8 Pro GA
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System requirements for SFW HA
Systems must meet the following requirements for SFW HA:

■ Memory must be a minimum 4 GB of RAM per server for SFW HA.

■ Shared disks to support applications that migrate between nodes in the 

cluster. Campus clusters require more than one array for mirroring. Disaster 

recovery configurations require one array for each site. Replicated data 

clusters with no shared storage are also supported.

If your storage devices are SCSI-3 compliant, and you wish to use SCSI-3 

Persistent Group Reservations (PGR), you must enable SCSI-3 support using 

the Veritas Enterprise Administrator (VEA). See the Veritas Storage 

Foundation Administrator’s Guide for more information.

■ SCSI, Fibre Channel, iSCSI host bus adapters (HBAs), or iSCSI Initiator 

supported NICs to access shared storage.

■ A minimum of two NICs is required. One NIC will be used exclusively for 

private network communication between the nodes of the cluster. The 

second NIC will be used for both private cluster communications and for 

public access to the cluster. Symantec recommends three NICs.

See “Best practices for SFW HA” on page 193.

■ NIC teaming is not supported for the VCS private network.

Network requirements for SFW HA
SFW HA has the following network requirements:

■ Do not install SFW HA on servers that are assigned the role of a Domain 

Controller. Configuring a cluster on a domain controller is not supported.

■ Ensure that your firewall settings allow access to ports used by SFW HA 

wizards and services. For a detailed list of services and ports used by SFW 

HA, refer to the Veritas Storage Foundation and High Availability Solutions 

for Windows Installation and Upgrade Guide.

■ Static IP addresses are required for certain purposes when configuring high 

availability or disaster recovery solutions. For IPv4 networks, ensure that 

you have the addresses available to enter. For IPv6 networks, ensure that the 

network advertises the prefix so that addresses are autogenerated. Static IP 

addresses are required for the following purposes:

■ One static IP address per site for each application virtual server.

■ A minimum of one static IP address for each physical node in the 

cluster.
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■ One static IP address per cluster used when configuring Notification or 

the Global Cluster Option. The same IP address may be used for all 

options.

■ For VVR replication in a disaster recovery configuration, a minimum of 

one static IP address per site for each application instance running in 

the cluster.

■ For VVR replication in a Replicated Data Cluster configuration, a 

minimum of one static IP address per zone for each application 

instance running in the cluster.

■ Configure name resolution for each node.

■ Verify the availability of DNS Services. AD-integrated DNS or BIND 8.2 or 

higher are supported.

Make sure a reverse lookup zone exists in the DNS. Refer to the application 

documentation for instructions on creating a reverse lookup zone.

■ DNS scavenging affects virtual servers configured in SFWHA because the 

Lanman agent uses Dynamic DNS (DDNS) to map virtual names with IP 

addresses. If you use scavenging, then you must set the DNSRefreshInterval 

attribute for the Lanman agent. This enables the Lanman agent to refresh 

the resource records on the DNS servers.

See the Veritas Cluster Server Bundled Agents Reference Guide.

■ In an IPv6 environment, the Lanman agent relies on the DNS records to 

validate the virtual server name on the network. If the virtual servers 

configured in the cluster use IPv6 addresses, you must specify the DNS 

server IP, either in the network adapter settings or in the Lanman agent’s 

AdditionalDNSServers attribute.

■ If Network Basic Input/Output System (NetBIOS) is disabled over the TCP/IP, 

then you must set the Lanman agent’s DNSUpdateRequired attribute to 1 

(True).
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IPv6 support

For IPv6 networks, the following is supported:

Note: Support is limited to mixed mode (IPv4 and IPv6) network configurations 

only; a pure IPv6 environment is currently not supported.

Permission requirements for SFW HA
The following permissions are required:

■ You must be a domain user.

■ You must be a member of the local Administrators group on all nodes where 

you are installing.

■ You must have write permissions for the Active Directory objects 

corresponding to all the nodes.

■ If you plan to create a new user account for the VCS Helper service, you must 

have Domain Administrator privileges or belong to the Account Operators 

group. If you plan to use an existing user account context for the VCS Helper 

service, you must know the password for the user account.

Types of addresses The following types of IPv6 addresses are supported:

■ Unicast addresses

Only Global Unicast and Unique Local Unicast addresses are 

supported.

■ Automatic configuration

Only Stateless IPv6 address configuration is supported. In 

stateless mode, the IP address is configured automatically 

based on router advertisements. The prefix must be 

advertised.

LLT over UDP LLT over UDP is supported on both IPv4 and IPv6.

You can use the Cluster Configuration Wizard (VCW) to configure 

LLT over UDP over IPv6.

VCS agents, wizards, 

and other 

components

VCS agents that require an IP address attribute and wizards that 

configure or discover IP addresses now support IPv6 addresses (of 

the type described above).

The VCS High Availability Engine (HAD) and the Global Cluster 

resource (WAC) also support IPv6 addresses.
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■ If User Access Control (UAC) is enabled on Windows Server systems, then 

you cannot log on to VEA GUI with an account that is not a member of the 

Administrators group, such as a guest user. This happens because such user 

does not have the "Write" permission for the "Veritas" folder in the 

installation directory (typically, C:\Program Files\Veritas). As a 

workaround, an OS administrator user can set "Write" permission for the 

guest user using the Security tab of the "Veritas" folder's properties.

Additional requirements for SFW HA
Please review the following additional requirements:

■ Installation media for all products and third-party applications.

■ Licenses for all products and third-party applications.

■ For a Replicated Data Cluster, install only in a single domain.

Best practices for SFW HA
Symantec recommends that you perform the following tasks:

■ Verify that you have three network adapters (two NICs exclusively for the 

private network and one for the public network).

When using only two NICs, lower the priority of one NIC and use the low-

priority NIC for public and private communication.

Note: If you wish to use Windows NIC teaming, you must select the Static 

Teaming mode. Only the Static Teaming mode is currently supported.

■ Route each private NIC through a separate hub or switch to avoid single 

points of failure.

■ NIC teaming is not supported for the VCS private network.

■ Verify that your DNS server is configured for secure dynamic updates. For 

the Forward and Reverse Lookup Zones, set the Dynamic updates option to 

"Secure only". (DNS > Zone Properties > General tab)

■ This is applicable for a Replicated Data Cluster configuration.

You can configure single node clusters as the primary and secondary zones. 

However, if using a shared storage configuration, you must create the disk 

groups as clustered disk groups. If you cannot create a clustered disk group 

due to the unavailability of disks on a shared bus, use the vxclus 

UseSystemBus ON command.
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Campus cluster requirements

■ Interconnects between the clusters are required for the storage and the 

network. 

■ The configuration requires a storage array for each site, with an equal 

number of disks at each site for the mirrored volumes.

Note: Plan for an equal number of disks on the two sites, because each disk 

group must contain the same number of disks on each site. 

Reviewing the configuration
This configuration example describes the most common configuration, a two-

node campus cluster with each node at a separate site.

For an overview of campus clusters with VCS, see “Overview of campus 

clustering with VCS” on page 195.
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Figure 9-1 VCS campus clustering configuration example

The two nodes can be located miles apart and are connected via a single subnet 

and Fibre Channel SAN. Each node has its own storage array with an equal 

number of disks and contains mirrored data of the storage on the other array. 

The example describes a generic database application.

Plan for an equal number and size of disks on the two sites, because each disk 

group must contain the same number of disks on each site for the mirrored 

volumes. 

The configuration does not include DMP. For instructions on how to add DMP to 

a clustering configuration, see the DMP chapter, “Adding DMP to a clustering 

configuration” on page 173.

Overview of campus clustering with VCS
This overview focuses on the recovery with a VCS campus cluster. Automated 

recovery is handled differently in a VCS campus cluster than with a VCS local 

cluster.
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The table below lists failure situations and the outcomes that occur with the two 

different settings for the ForceImport attribute of the VMDg resource. This 

attribute can be set to 1 (automatically forcing the import of the disk groups to 

the another node) or 0 (not forcing the import). Information on how to set the 

ForceImport attribute are given in “Setting the ForceImport attribute” on 

page 198.

Table 9-5 Failure Situations  

Failure Situation ForceImport set to 0

(import not forced)

ForceImport set to 1

(automatic force import)

1) Application fault

May mean the services stopped for 

an application, a NIC failed, or a 

database table went offline.

Application 

automatically moves to 

other site.

Service Group failover is 

automatic on the 

standby or preferred 

system or node.

2) Server failure

May mean that a power cord was 

unplugged, a system hang 

occurred, or another failure 

caused the system to stop 

responding.

Application 

automatically moves to 

other site. 100% of the 

disks are still available.

Service Group failover is 

automatic on the 

standby or preferred 

system or node. 100% of 

the mirrored disks are 

still available.

3) Failure of disk array or all 

disks

Remaining disks in mirror are still 

accessible from the other site.

No interruption of 

service. Remaining disks 

in mirror are still 

accessible from other 

site.

The Service Group does 

not failover. 50% of the 

mirrored disk is still 

available at remaining 

site.

4) Site failure

All access to the server and 

storage is lost.

Manual intervention 

required to move 

application. Can’t import 

with only 50% of the 

disks available.

Application 

automatically moves to 

the other site.

5) Split-brain situation (loss of 

both heartbeats)

If the public network link is used 

as a low-priority heartbeat, it is 

assumed that link is also lost.

No interruption of 

service. Can’t import 

disks because original 

site still has the SCSI 

reservation.

No interruption of 

service. Failover does not 

occur due to Service 

Group resources 

remaining online on the 

original nodes. Example: 

Online node has SCSI 

reservation to own disk.
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Reinstating faulted hardware 
Once a failure occurs and an application is migrated to another node or site, it is 

important to know what will happen when the original hardware is reinstated.

For failure scenarios 3 through 7 above, the table below lists the behavior when 

various hardware components affecting the configuration (array or disks, site 

hardware, networking cards or cabling, storage interconnect, etc.) are reinstated 

after failure. Situations 1 and 2 have no effect when reinstated. Keep in mind 

that the cluster has already responded to the initial failure as indicated in the 

table above. 

6) Storage interconnect lost

Fibre interconnect severed.

No interruption of 

service. Disks on the 

same node are 

functioning. Mirroring is 

not working.

No interruption of 

service. Service Group 

resources remain online, 

but 50% of the mirror 

disk becomes detached. 

7) Split-brain situation and 

storage interconnect lost 

If a single pipe is used between 

buildings for the Ethernet and 

storage, this situation can occur.

No interruption of 

service. Can’t import 

with only 50% of disks 

available. Disks on the 

same node are 

functioning. Mirroring is 

not working.

Automatically imports 

disks on secondary site. 

Now disks are online in 

both locations—data can 

be kept from only one.

Table 9-5 Failure Situations  (Continued)

Failure Situation ForceImport set to 0

(import not forced)

ForceImport set to 1

(automatic force import)

Table 9-6 Behavior exhibited when hardware is reinstated

Failure Situation, before 

Reinstating the Configuration

ForceImport set to 0

(import not forced)

ForceImport set to 1

(automatic force import)

3) Failure of disk array or all 

disks

Remaining disks in mirror are still 

accessible from the other site.

No interruption of 

service. Resync the 

mirror from the remote 

site. 

Same behavior. 
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While the outcomes of using both settings of the ForceImport attribute for most 

scenarios are the same, the ForceImport option provides automatic failover in 

the event of site failure. This advantage comes at the cost of potential data loss 

if all storage and network communication paths between the sites are severed. 

Choose an option that is suitable given your cluster infrastructure, uptime 

requirements, and administrative capabilities. 

Setting the ForceImport attribute
After the VCS campus cluster is configured, set the ForceImport attribute. The 

command for implementing the force import setting in VCS is:

hares -modify <vmdg_resource_name> ForceImport 1|0

ForceImport is a flag that defines whether the agent forcibly imports the disk 

group when exactly half the disks are available. The value 1 indicates the agent 

imports the configured disk group when half the disks are available. The value 0 

4) Site failure

All access to the server and 

storage is lost.

Inter-node heartbeat 

communication is 

restored and the original 

cluster node becomes 

aware that the 

application is online at 

the remote site. Resync 

the mirror from the 

remote site. 

Same behavior. 

5) Split-brain situation (loss of 

both heartbeats)

 No interruption of 

service. 

Same behavior. 

6) Storage interconnect lost

Fibre interconnect severed.

No interruption of 

service. Resync the 

mirror from the original 

site. 

Same behavior. 

7) Split-brain situation and 

storage interconnect lost 

No interruption of 

service. Resync the 

mirror from the original 

site. 

VCS alerts administrator 

that volumes are online 

at both sites. Resync the 

mirror from the copy 

with the latest data. 

Table 9-6 Behavior exhibited when hardware is reinstated

Failure Situation, before 

Reinstating the Configuration

ForceImport set to 0

(import not forced)

ForceImport set to 1

(automatic force import)
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indicates it does not. Default is 0. This means that the disk group will be 

imported only when SFW acquires control over the majority of the disks. 

Caution: Set this attribute to 1 only after verifying the integrity of your data. If 

due caution is not exercised before setting this attribute to 1, you risk potential 

data loss. 

Example

hares -modify vmdg_Dg1 ForceImport 1

Import is forced on vmdg_Dg1.

Installing and configuring the hardware
This topic gives the general steps for the hardware installation. For complete 

details on installing the hardware, refer to the hardware documentation.

To set up the hardware

1 Install the hardware for Site A, using the manufacturers’ instructions.

■ Install three network interface cards.

■ One for the public network.

■ Two are recommended for the private network.

Use independent hubs or switches for each VCS communication 

network (GAB and LLT). GAB supports hub-based or switch network 

paths, or two-system clusters with direct network links.

Note: To prevent lost heartbeats on the private networks and to prevent 

VCS from mistakenly declaring a system down, Symantec recommends 

disabling the Ethernet autonegotiation options on the private network 

adapters. Symantec also recommends removing TCP/IP from private NICs 

to lower system overhead. Contact the NIC manufacturer for details on this 

process. 

■ Install the host adapter.

■ Install the switch and the storage array.

■ Verify that the system can access the storage devices.

2 Install the hardware in the same manner for Site B.

3 Make the necessary hardware connections to connect the two clusters 

together.
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■ Connect corresponding cables between the three networking cards on 

the two sites.

■ Connect the two switches at the two sites through the storage 

interconnect. 

■ Test the connectivity between the two sites. Test the IP addresses of all 

the network adapter cards in the cluster. Bring up the command 

window and type ping ipaddress, where the ipaddress is the 

corresponding network adapter in the other node.

Configuring the storage hardware and network
Use the following procedures to configure the hardware and verify DNS 

settings. Repeat this procedure for every node in the cluster.

To configure the hardware

1 Install the required network adapters, and SCSI controllers or Fibre Channel 

HBA.

2 Connect the network adapters on each system.

■ To prevent lost heartbeats on the private networks, and to prevent VCS 

from mistakenly declaring a system down, Symantec recommends 

disabling the Ethernet autonegotiation options on the private network 

adapters. Contact the NIC manufacturer for details on this process.

■ Symantec recommends removing TCP/IP from private NICs to lower 

system overhead.

3 Use independent hubs or switches for each VCS communication network 

(GAB and LLT). You can use cross-over Ethernet cables for two-node 

clusters. LLT supports hub-based or switch network paths, or two-system 

clusters with direct network links.

4 Verify that each system can access the storage devices. Verify that each 

system recognizes the attached shared disk and that the attached shared 

disks are visible.

To verify the DNS settings and binding order for Windows Server systems

1 Open the Control Panel (Start > Control Panel).

2 Click Network and Internet, and then click Network and Sharing Center.

3 In the Network and Sharing Center window, on the left side of the screen 

under Tasks, double-click Manage network connections.

4 Ensure the public network adapter is the first bound adapter:
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■ From the Advanced menu in the Network Connections window, click 

Advanced Settings.

■ In the Adapters and Bindings tab, verify the public adapter is the first 

adapter in the Connections list. If necessary, use the arrow button to 

move the adapter to the top of the list.

■ Click OK.

5 Open the Public status dialog box by doing one of the following in the 

Network Connections window:

■ Double-click the adapter for the public network.

■ Right-click the adapter for the public network and click Status.

■ Select the adapter for the public network and click View status of this 

connection in the toolbar.

When enabling DNS name resolution, make sure that you use the public 

network adapters, and not those configured for the VCS private network.

6 In the Public Status dialog box, on the General tab, click Properties.

7 In the Public Properties dialog box, on the General tab:

■ Select the Internet Protocol Version 4 (TCP/IPv4) or Internet Protocol 

Version 6 (TCP/IPv6) check box, depending on which protocol your 

network is using.

■ Click Properties.

8 Select the Use the following DNS server addresses option.

9 Verify the correct value for the IP address of the DNS server.

10 Click Advanced.

11 In the DNS tab, make sure the Register this connection’s address in DNS 

check box is selected.

12 Make sure the correct domain suffix is entered in the DNS suffix for this 

connection field.

13 Click OK.
 

Installing Veritas Storage Foundation HA for 
Windows

You can install SFW HA using either the product installer wizard or the 

command line interface (CLI). Before you begin to install the product, ensure 

that you have reviewed and performed the required preinstallation and 

planning tasks.
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Note: The Windows MPIO feature must be enabled for Windows Server before 

you proceed with SFW HA installation.

During the installation you can choose to separately install the server 

components or the client components. If you choose to install the server 

components, the following components are installed by default.

Table 9-7 List of options installed by default

Option Description

Client components Installs the VCS Java Console on the same node where 

the server components are installed.

High Availability Hardware 

Replication Agents

■ Veritas Cluster Server Hardware Replication 

Agent for EMC MirrorView

Enables VCS to manage MirrorView replicated 

devices.

■ Veritas Cluster Server Hardware Replication 

Agent for EMC SRDF

Enables VCS to manage SRDF replicated devices. 

■ Veritas Cluster Server Hardware Replication 

Agent for EMC SRDFSTAR

Enables VCS to manage SRDFSTAR replicated 

devices.

■ Veritas Cluster Server Hardware Replication 

Agent for Hitachi TrueCopy

Enables VCS to manage TrueCopy replicated 

devices.

■ Veritas Cluster Server Hardware Replication 

Agent for MetroMirror

Enables VCS to manage MetroMirror replicated 

devices.

High Availability Database 

Agents

■ Veritas Cluster Server Database Agent for SQL 

Server—installs the VCS agent for SQL Server 

2008, 2008 R2, and 2012
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Note: The high availability agents that get installed with the product software 

are also available in the form of an agent pack. The agent pack is released on a 

quarterly basis. The agent pack includes support for new applications as well as 

fixes and enhancements to existing agents. You can install the agent pack on an 

existing SFW HA installation. Refer to the Symantec Operations Readiness 

Tools (SORT) website for information on the latest agent pack availability.  
https://sort.symantec.com 
Refer to the agent-specific configuration guide for more details about the 

application agents.

To install the server components,

See “Installing SFW HA server components using the product installer” on 

page 203.

To install the client components,

See “Installing the client components using the product installer” on page 209.

Installing SFW HA server components using the product installer
Use the following procedure to install SFW HA server components using the 

product installer.

Ensure that there are no parallel installations, live updates, or Microsoft 

Windows updates in progress.

During installation, some product features are installed by default and others 

must be selected, as follows:

■ For a disaster recovery configuration, select the VCS global cluster (GCO) 

option. 

■ If you plan to use Veritas Volume Replicator (VVR) for replication, select the 

SFW VVR option. 

■ If you plan to use the Fast Failover feature, select the VCS Fast Failover 

option.

To install SFW HA server components using the product installer

1 Insert the disc containing the installation software into your system’s disk 

drive or download the installation software from the Symantec website.

https://fileconnect.symantec.com

2 Allow the autorun feature to start the installation or double-click Setup.exe. 

The CD browser appears.
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Note: If you are installing the software using the product software disc, the 

CD browser displays the installation options for all the products specified 

earlier. However, if you are downloading the installation package from the 

Symantec website, the CD browser displays the installation options only for 

the product to be installed.

3 Click to download the required contents.

Note: The client components are installed by default along with the server 

components. However, on a server core machine, the client components will 

not be installed.

4 On the Welcome panel, review the list of prerequisites and click Next.

5 On the License panel, read the license terms, select I accept the terms of 

License Agreement, and then click Next.

6 On the System Selection panel, select the systems and the desired 

Installation and Product options.

You can select the systems in one of the following ways:

■ In the System Name or IP text box, manually type the system name or 

its IP address and click Add.

Storage Foundation HA 

for Windows

Click to install the server and client components for 

SFW HA.

Late Breaking News Click to access the latest information about updates, 

patches, and software issues regarding this release.

Windows Data Collector Click to verify that your configuration meets all 

pertinent software and hardware requirements.

SORT Click to access the Symantec Operations Readiness 

Tools site.

In addition to the product download you can also 

download the custom reports about your computer 

and Symantec enterprise products, a checklist 

providing configuration recommendations, and 

system and patch requirements to install or upgrade 

your software.

Browse Content Click to view the software disc contents.

Technical Support Click to contact Symantec Technical Support.
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Note: The wizard does not support IPv6. To add systems having IPv6, 

you must type the system name.

The local host is populated by default.

■ Alternatively, browse to select the systems.

The systems that belong to the domain in which you have logged in are 

listed in the Available Systems list. Select one or more systems and 

click the right arrow to move them to the Selected Systems list. Click 

OK.

Once you add or select a system, the wizard performs certain validation 

checks and notes the details in the Verification Details box. To review the 

details, select the desired system.

To select the installation and product options, perform the following tasks 

on each of the selected systems.

Note: To apply the selection to multiple systems, select the system for 

which you have selected the installation and product options and then click 

Apply to multiple systems. 
See “Applying the selected installation and product options to multiple 

systems” on page 208.

■ By default the wizard uses %ProgramFiles%\Veritas as the 

installation directory. To customize the installation directory, click 

Browse and select the desired location. Click OK.

■ Select the required license type from the License key drop-down list.

Note: The default license type is “Keyless”.

If you select the "Keyless" license type, all the available product options 

are displayed and are selected by default.

If you select "User entered license key" as your license type, the License 

Details panel appears by default. On the License Details panel, enter the 

license key and then click Add. You can add multiple licenses for the 

various product options you want to use.

The wizard validates the entered license keys and displays the relevant 

error if the validation fails. After the validation is complete, click OK.
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■ From the list of product options, select the appropriate options to be 

installed. The options differ depending on your product and 

environment.

Storage 

Foundation 

Options

■ Veritas Volume Replicator (VVR): Replicates data 

across multiple sites for disaster recovery.

■ FlashSnap: Allows you to create and maintain split-

mirror, persistent snapshots of volumes and 

application components. FlashSnap supports VSS 

based snapshots to provide application data in a 

consistent state after the application is restored.

■ Replace Disk Management Snap-in with SFW VEA 

GUI: Replaces the Disk Management Snap-in in the 

Windows Computer Management console and the 

Server Manager console with the Veritas Enterprise 

Administrator GUI for Windows Server.
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7 On the System Selection panel, click Next. 

Note that the wizard fails to proceed with the installation unless all the 

selected systems have passed the validation checks and are ready for 

installation. If the validation checks have failed on any of the systems, 

review the details and rectify the issue. Before you choose to proceed with 

DMP Device 

Specific Modules

■ 3PARDATA array (V3PAR)

■ Dell Compellent array (VCOMPLNT)

■ Dell EqualLogic array (VEQLOGIC)

■ EMC cx4240 array (VEMCCLAR)

■ EMC VMAX array (VEMCSYMM)

■ Hitachi VSP array (VHDSAA)

■ HP P6000 array (VHPEVA)

■ IBM DS8000 array (VIBMAADS)

■ IBM XiV Storage System (VXIV)

Symantec maintains a Hardware Compatibility List (HCL), 

which provides information on HBAs and firmware that 

have been tested with each supported array. Check the HCL 

for details about your hardware before installing or using 

DMP DSMs.

The HCL is located at:

http://www.symantec.com/docs/TECH152806

Note: Do not use a DMP DSM together with a third-party 

DSM for the same array. Only one DSM at a time can claim 

the LUNs in an array. According to Microsoft Multipath I/O 

(MPIO) documentation, if multiple DSMs are installed, the 

Microsoft MPIO framework contacts each DSM to 

determine which is appropriate to handle a device. There is 

no particular order in which the MPIO framework contacts 

the DSMs. The first DSM to claim ownership of the device is 

associated with that device. Other DSMs cannot claim an 

already claimed device. Therefore, to ensure that the DMP 

DSM claims the LUNs of an array, no other DSM should be 

installed for that same array.

Veritas Cluster 

Server Options

■ Global Cluster Option (GCO): Enables you to link the 

clusters located in different geographies. This 

provides wide-area failover and disaster recovery.

■ Fast Failover: Improves the failover time taken by 

storage resources during the service group failovers, in 

a clustered environment. Fast failover is particularly 

noticeable in clusters having multiple storage stacks 

configured, typically over 20 disk groups and over 150 

volumes.

http://www.symantec.com/docs/TECH152806
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the installation, select the system and click Re-verify to re-initiate the 

validation checks for this system.

8 On the Pre-install Summary panel, review the summary and click Next. 

Note that the Automatically reboot systems after installer completes 

operation check box is selected by default. This will reboot all the selected 

remote systems immediately after the installation is complete on the 

respective system. If you do not want the wizard to initiate this auto reboot, 

clear the selection of Automatically reboot systems after installer 

completes operation check box. 

9 On the Installation panel, review the progress of installation and click Next 

after the installation is complete.

If an installation is not successful on any of the systems, the status screen 

shows a failed installation.

10 On the Post-install Summary panel, review the installation result and click 

Next.

If the installation has failed on any of the systems, refer to the log file for 

details. You may have to re-install the software.

11 On the Finish panel, click Finish.

If you chose to initiate the auto reboot, a confirmation message to reboot 

the local system appears. Click Yes to reboot immediately or No to reboot 

later.

If you did not choose to initiate the auto reboot, ensure that you manually 

reboot these systems.

This completes the product installation. 

Applying the selected installation and product options to 
multiple systems

The following procedure gives details on applying options to multiple systems.

To apply the selected installation and product options to multiple systems

1 Click on any one of the selected systems and select the desired installation 

and product options.

2 Click Apply to multiple systems.

3 On the Apply Installation Options panel, select the installation options to be 

applied and then select the desired systems. Click OK.
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Installing the client components using the product installer
Use the following procedure to install SFW HA client components using the 

product installer.

Note: Client components cannot be installed on server core systems.

Before you begin the installation, ensure that there are no parallel installations, 

live updates, or Microsoft Windows updates in progress on the system where 

you want to install the client components.

To install SFW HA client components using the product installer

1 Insert the software disk containing the installation package into your 

system's disc drive or download the installation package from the following 

Symantec Web site.

https://fileconnect.symantec.com

2 Allow the autorun feature to start the installation or double-click Setup.exe.

The CD browser appears.

3 Click to download the required contents.

4 On the Welcome panel, review the list of prerequisites and click Next.

Veritas Storage 

Foundation HA for 

Windows

Click to install the server or client components for 

SFW HA.

Late Breaking News Click to access the latest information about updates, 

patches, and software issues regarding this release.

Windows Data Collector Click to verify that your configuration meets all 

pertinent software and hardware requirements.

SORT Click to access the Symantec Operations Readiness 

Tools site.

In addition to the product download you can also 

download the custom reports about your computer 

and Symantec enterprise products, a checklist 

providing configuration recommendations, and 

system and patch requirements to install or upgrade 

your software.

Browse Content Click to view the software disc contents.

Technical Support Click to contact Symantec Technical Support.
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5 On the License Agreement panel, read the license terms, select I accept the 

terms of License Agreement, and then click Next.

6 On the System Selection panel, select the systems and the installation 

directory.

You can select the systems in one of the following ways:

■ In the System Name or IP text box, manually type the system name or 

its IP address and click Add.

Note: The wizard does not support IPv6. To add the systems having 

IPv6, you must type the system name.

Local host is populated by default.

■ Alternatively, browse to select the systems.

The systems that belong to the domain in which you have logged in are 

listed in the Available Systems list. Select one or more systems and 

click the right arrow to move them to the Selected Systems list. Click 

OK.

Once you add or select a system, the wizard performs certain validation 

checks and notes the details in the Verification Details box. To review the 

details, select the desired system.

By default the wizard uses %ProgramFiles%\Veritas as the installation 

directory. To customize the installation directory, click Browse and select 

the desired location. Click OK.

To apply the customized directory to multiple systems, click Apply to 

multiple systems. On the Apply Installation Options panel, select the 

systems to apply the customized directory. Click OK.

7 On the System Selection panel, click Next.

Note that the wizard fails to proceed with the installation unless all the 

selected systems have passed the validation checks and are ready for 

installation. If the validation checks have failed on any of the system, 

review the details and rectify the issue. Before you choose to proceed with 

the installation select the system and click Re-verify to re-initiate the 

validation checks for this system.

8 On the Pre-install Summary panel, review the summary and click Next.

9 On the Installation panel, review the progress of installation and click Next 

after the installation is complete.

If an installation is not successful on any of the systems, the status screen 

shows a failed installation.

10 On the Post-install Summary panel, review the installation result and click 

Next.
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If the installation has failed on any of the system, refer to the log file for 

details. You may have to re-install the software.

11 On the Finish panel, click Finish.

This completes the installation of the client components.
 

Configuring the cluster
After installing SFW HA using the installer, set up the components required to 

run a cluster. The VCS Cluster Configuration Wizard (VCW) sets up the cluster 

infrastructure, including LLT and GAB, and configures Symantec Product 

Authentication Service in the cluster. The wizard also configures the 

ClusterService group, which contains resources for notification and global 

clusters.

Complete the following tasks before creating a cluster:

■ Verify that each node uses static IP addresses (DHCP is not supported) and 

name resolution is configured for each node. 

■ Set the required permissions:

■ You must have administrator privileges on the system where you run 

the wizard. The user account must be a domain account.

■ You must have administrative access to all systems selected for cluster 

operations. Add the domain user to the Local Administrators group of 

each system.

■ If you plan to create a new user account for the VCS Helper service, you 

must have Domain Administrator privileges or belong to the Domain 

Account Operators group. If you plan to use an existing user account 

for the VCS Helper service, you must know the password for the user 

account.

■ When configuring a user account for the VCS Helper service, make sure 

that the user account is a domain user. The VCS HAD, which runs in the 

context of the local system built-in account, uses the VCS Helper 

service user context to access the network. This account does not 

require domain admin privileges.

■ Make sure the VCS Helper service domain user account has “Add 

workstations to domain” privilege enabled in the Active Directory.

Refer to the Veritas Cluster Server Administrator’s Guide for complete 

installation and configuration details on VCS, and additional instructions on 

removing or modifying cluster configurations.
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To configure a VCS cluster

1 Start the VCS Cluster Configuration Wizard.

Click Start > All Programs > Symantec > Veritas Cluster Server > 

Configuration Tools > Cluster Configuration Wizard.

2 Read the information on the Welcome panel and click Next.

3 On the Configuration Options panel, click Cluster Operations and click 

Next.

4 On the Domain Selection panel, select or type the name of the domain in 

which the cluster resides and select the discovery options.

Do one of the following:

■ To discover information about all systems and users in the domain:

■ Clear the Specify systems and users manually check box.

■ Click Next.

■ Proceed to step 8 on page 214.

■ To specify systems and user names manually (recommended for large 

domains):

■ Check the Specify systems and users manually check box.

Additionally, you may instruct the wizard to retrieve a list of 

systems and users in the domain by selecting appropriate check 

boxes.

■ Click Next.
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■ If you chose to retrieve the list of systems, proceed to step 6 on 

page 213. Otherwise, proceed to the next step.

5 On the System Selection panel, type the name of each system to be added, 

click Add, and then click Next.

Do not specify systems that are part of another cluster.

Proceed to step 8 on page 214.

6 On the System Selection panel, specify the systems for the cluster and then 

click Next. Do not select systems that are part of another cluster.

Enter the name of the system and click Add to add the system to the 

Selected Systems list, or click to select the system in the Domain Systems 

list and then click the > (right-arrow) button.

7 The System Report panel displays the validation status, whether Accepted 

or Rejected, of all the systems you specified earlier. Review the status and 

then click Next.

Click on a system name to see the validation details. If you wish to include a 

rejected system, rectify the error based on the reason for rejection and then 

run the wizard again.

A system can be rejected for any of the following reasons:

■ System is not pingable.

■ WMI access is disabled on the system.

■ Wizard is unable to retrieve the system architecture or operating 

system.
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■ VCS is either not installed on the system or the version of VCS is 

different from what is installed on the system on which you are 

running the wizard.

8 On the Cluster Configuration Options panel, click Create New Cluster and 

click Next.

9 On the Cluster Details panel, specify the details for the cluster and then 

click Next.

Cluster Name Type a name for the new cluster. Symantec recommends a 

maximum length of 32 characters for the cluster name.

Cluster ID Select a cluster ID from the suggested cluster IDs in the 

drop-down list or type a unique ID for the cluster. The 

cluster ID can be any number from 0 to 65535.

Caution: If you chose to specify systems and users manually in 

step 4 or if you share a private network between more than one 

domain, make sure that the cluster ID is unique.

Operating System From the drop-down list select the operating system.

All the systems running Windows Server 2012 are displayed.
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10 The wizard validates the selected systems for cluster membership. After the 

systems are validated, click Next.

If a system is not validated, review the message associated with the failure 

and restart the wizard after rectifying the problem.

If you chose to configure a private link heartbeat in the earlier step, proceed 

to the next step. Otherwise, proceed to step 12 on page 218.

11 On the Private Network Configuration panel, configure the VCS private 

network and then click Next.

You can configure the VCS private network either over ethernet or over the 

User Datagram Protocol (UDP) layer using IPv4 or IPv6 network.

Do one of the following:

■ To configure the VCS private network over the ethernet, complete the 

following steps:

■ Select Configure LLT over Ethernet.

Available Systems Select the systems that you wish to configure in the cluster.

Check the Select all systems check box to select all the 

systems simultaneously.

The wizard discovers the network interface cards (NICs) on 

the selected systems. For single-node clusters with the 

required number of NICs, the wizard prompts you to 

configure a private link heartbeat. In the dialog box, click 

Yes to configure a private link heartbeat.
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■ Select the check boxes next to the two NICs to be assigned to the 

private network. You can assign a maximum of eight network 

links.

Symantec recommends reserving two NICs exclusively for the 

private network. However, you could lower the priority of one of 

the NICs and use the low-priority NIC for both public and private 

communication.

■ If you have only two NICs on a selected system, it is recommended 

that you lower the priority of at least one NIC that will be used for 

private as well as public network communication.

To lower the priority of a NIC, right-click the NIC and select Low 

Priority from the pop-up menu.

Note: If you wish to use Windows NIC teaming, you must select the 

Static Teaming mode. Only the Static Teaming mode is currently 

supported.

■ If your configuration contains teamed NICs, the wizard groups 

them as "NIC Group #N" where "N" is a number assigned to the 

teamed NIC. A teamed NIC is a logical NIC, formed by grouping 

several physical NICs together. All NICs in a team have an identical 

MAC address. Symantec recommends that you do not select 

teamed NICs for the private network.

The wizard configures the LLT service (over ethernet) on the selected 

network adapters.
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■ To configure the VCS private network over the User Datagram Protocol 

(UDP) layer, complete the following steps:

■ Select Configure LLT over UDP on IPv4 network or Configure LLT 

over UDP on IPv6 network depending on the IP protocol that you 

wish to use.

The IPv6 option is disabled if the network does not support IPv6.

■ Select the check boxes next to the two NICs to be assigned to the 

private network. You can assign a maximum of eight network 

links. Symantec recommends reserving at least two adapters 

exclusively for the VCS private network.

■ For each selected NIC, verify the displayed IP address. If a selected 

NIC has multiple IP addresses assigned, double-click the field and 

choose the desired IP address from the drop-down list. In case of 

IPv4, each IP address can be in a different subnet.

The IP address is used for the VCS private communication over the 

specified UDP port.

■ Specify a unique UDP port for each of the link. Click Edit Ports if 

you wish to edit the UDP ports for the links. You can use ports in 

the range 49152 to 65535. The default ports numbers are 50000 

and 50001 respectively. Click OK.

For each selected NIC, double-click the respective field in the Link 

column and choose a link from the drop-down list. Specify a 

different link (Link1 or Link2) for each adapter. Each link is 

associated with a UDP port that you specified earlier.
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The wizard configures the LLT service (over UDP) on the selected 

network adapters. The specified UDP ports will be used for the private 

network communication.

12 On the VCS Helper Service User Account panel, specify a domain user 

account for the VCS Helper service. The VCS high availability engine (HAD), 

which runs in the context of the local system built-in account, uses the VCS 

Helper service user context to access the network.

This account does not require Domain Administrator privileges.

Specify a domain user as follows:

■ To specify an existing user, do one of the following:

■ Click Existing user and select a user name from the drop-down list

■ If you chose not to retrieve the list of users in step 4 on page 212, 

type the user name in the Specify User field, and then click Next.

■ To specify a new user, click New user and type a valid user name in the 

Create New User field, and then click Next.

Do not append the domain name to the user name; do not type the user 

name as Domain\user or user@domain.

■ In the Password dialog box, type the password for the specified user 

and click OK, and then click Next.

13 On the Configure Security Service Option panel, specify the security options 

for the cluster communications and then click Next.

Do one of the following:
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■ To use VCS cluster user privileges, click Use VCS User Privileges and 

then type a user name and password.

The wizard configures this user as a VCS Cluster Administrator. In this 

mode, communication between cluster nodes and clients, including the 

Cluster Manager (Java Console), occurs using the encrypted VCS cluster 

administrator credentials. The wizard uses the VCSEncrypt utility to 

encrypt the user password.

The default user name for the VCS administrator is admin and the 

password is password. Both are case-sensitive. You can accept the 

default user name and password for the VCS administrator account or 

type a new name and password.

Symantec recommends that you specify a new user name and 

password.

■ To configure a secure cluster using the single sign-on feature, click Use 

Single Sign-on.

In this mode, the VCS Authentication Service is used to secure 

communication between cluster nodes and clients by using digital 

certificates for authentication and SSL to encrypt communication over 

the public network. VCS uses SSL encryption and platform-based 

authentication. The VCS high availability engine (HAD) and Veritas 

Command Server run in secure mode.

The wizard configures all the cluster nodes as root brokers (RB) and

authentication brokers (AB). Authentication brokers serve as 

intermediate registration and certification authorities. Authentication 

brokers have certificates signed by the root. These brokers can 

authenticate clients such as users and services. The wizard creates a 

copy of the certificates on all the cluster nodes.

14 Review the summary information on the Summary panel, and click 

Configure.

The wizard configures the VCS private network. If the selected systems 

have LLT or GAB configuration files, the wizard displays an informational 

dialog box before overwriting the files. In the dialog box, click OK to 

overwrite the files. Otherwise, click Cancel, exit the wizard, move the 

existing files to a different location, and rerun the wizard.

The wizard starts running commands to configure VCS services. If an 

operation fails, click View configuration log file to see the log.

15 On the Completing Cluster Configuration panel, click Next to configure the 

ClusterService group; this group is required to set up components for 

notification and for global clusters.

To configure the ClusterService group later, click Finish.
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At this stage, the wizard has collected the information required to set up the 

cluster configuration. After the wizard completes its operations, with or 

without the ClusterService group components, the cluster is ready to host 

application service groups. The wizard also starts the VCS engine (HAD) 

and the Veritas Command Server at this stage.

Note: After configuring the cluster you must not change the names of the 

nodes that are part of the cluster. If you wish to change a node name, run 

this wizard to remove the node from the cluster, rename the system, and 

then run this wizard again to add that system to the cluster.

16 On the Cluster Service Components panel, select the components to be 

configured in the ClusterService service group and click Next.

■ Check the Notifier Option check box to configure notification of 

important events to designated recipients.

See “Configuring notification” on page 220.

■ Check the GCO Option check box to configure the wide-area connector 

(WAC) process for global clusters. The WAC process is required for 

inter-cluster communication.

Configure the GCO Option using this wizard only if you are configuring 

a Disaster Recovery (DR) environment and are not using the Disaster 

Recovery wizard.

Refer to the Veritas Cluster Server Administrator’s Guide for details on 

configuring GCO using the cluster configuration wizard.

You can configure the GCO Option using the DR wizard. The Disaster 

Recovery chapters discuss how to use the Disaster Recovery wizard to 

configure the GCO option.

Configuring notification
This section describes steps to configure notification.
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To configure notification

1 On the Notifier Options panel, specify the mode of notification to be 

configured and click Next.

You can configure VCS to generate SNMP (V2) traps on a designated server 

and send emails to designated recipients in response to certain events.

2 If you chose to configure SNMP, specify information about the SNMP 

console and click Next.

■ Click a field in the SNMP Console column and type the name or IP 

address of the console. The specified SNMP console must be MIB 2.0 

compliant.
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■ Click the corresponding field in the Severity column and select a 

severity level for the console.

■ Click ‘+’ to add a field; click ‘-’ to remove a field.

■ Enter an SNMP trap port. The default value is “162”.

3 If you chose to configure SMTP, specify information about SMTP recipients 

and click Next.

■ Type the name of the SMTP server.

■ Click a field in the Recipients column and enter a recipient for 

notification. Enter recipients as admin@example.com.

■ Click the corresponding field in the Severity column and select a 

severity level for the recipient. VCS sends messages of an equal or 

higher severity to the recipient.

■ Click + to add fields; click - to remove a field.
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4 On the Notifier Network Card Selection panel, specify the network 

information and click Next.

■ If the cluster has a ClusterService service group configured, you can 

use the NIC resource configured in the service group or configure a new 

NIC resource for notification.

■ If you choose to configure a new NIC resource, select a network adapter 

for each node in the cluster. The wizard lists the public network 

adapters along with the adapters that were assigned a low priority.

5 Review the summary information and choose whether you want to bring the 

notification resources online when VCS is started.

6 Click Configure.

7 Click Finish to exit the wizard.
 

Creating disk groups and volumes
Use the Veritas Enterprise Administrator (VEA) console installed with SFW to 

create disk groups and dynamic volumes on the cluster storage, which in a 

campus cluster consists of two storage arrays. 

Configuring cluster disk groups and volumes is covered in the following topics:

■ “About cluster disk groups and volumes” on page 224

■ “Example disk group and volume configuration in campus cluster” on 

page 225
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■ “Considerations when creating disk groups and volumes for a campus 

cluster” on page 225

■ “Viewing the available disk storage” on page 227

■ “Creating a dynamic (cluster) disk group” on page 227

■ “Adding disks to campus cluster sites” on page 229

■ “Creating a volume” on page 229

About cluster disk groups and volumes
SFW uses disk groups to organize disks or LUNs for management purposes. A 

dynamic disk group is a collection of disks that is imported or deported as a 

single unit. A cluster disk group is a special type of dynamic disk group that is 

created on shared storage and is designed to be moved or to failover between 

hosts. In order to prevent data corruption a cluster disk group uses SCSI 

reservations to protect the shared disks and limits access to a single host at a 

time.

Volumes are logical entities that are comprised of portions of one or more 

physical disks and are accessed by a drive letter or mount point. Volumes can be 

configured for performance and high availability.

Note: You create a cluster disk group and volumes on only one node of a cluster. 

The volumes can be accessed by other nodes in a high-availability cluster by 

first deporting the cluster disk group from the current node and then importing 

it on the desired node. In a campus cluster, the volumes are mirrored across the 

storage arrays.

Note: If your storage devices are SCSI-3 compliant, and you wish to use SCSI-3 

Persistent Group Reservations (PGR), you must enable SCSI-3 support using the 

Veritas Enterprise Administrator (VEA - Control Panel - System Settings). See the 

Veritas Storage Foundation Administrator’s Guide for more information.

Before you create a disk group, consider the following items:

■ The type of volume configurations that are required

■ The number of LUNs required for the disk group

■ The implications of backup and restore operations on the disk group setup

■ The size of databases and logs that depend on the traffic load

■ The disk groups and number of disks on each site 
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■ Types of volumes required and location of the plex of each volume in the 

storage array

Example disk group and volume configuration in campus cluster
The illustration that follows shows a VCS campus cluster configuration of disks. 

For campus clusters, each disk group must contain an equal number of disks on 

each site. This example has one disk group that spans the storage arrays at both 

sites. 

The data and database log on Site A are mirrored to Site B. Each volume should 

be a mirrored volume with one plex of the volume on Site A’s storage array and 

the other plex of the volume on Site B’s storage array.

Note: Each mirrored volume does not need to be limited to two disks, but can 

have four disks for greater resiliency. 

All the data on one site could be in one large mirrored volume with multiple 

disks, but this also requires the same number of disks on both sites for the 

mirroring. It is recommended that the log volumes be on separate disks from the 

data.

Figure 9-2 VCS campus cluster disks example

Considerations when creating disk groups and volumes 
for a campus cluster

When you create the disk groups for a campus cluster, ensure that each disk 

group has the same number of disks on each physical site. You create each 

volume as a mirrored volume with one plex of the volume on Site A’s storage 

array and the other plex of the volume on Site B’s storage array.

Symantec recommends using the SFW site-aware allocation feature for campus 

cluster storage. Site-aware allocation can ensure that site boundary limits are 

maintained for operations like volume grow, subdisk move, and disk relocation. 
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Enabling site-aware allocation for campus clusters requires the following steps 

in the VEA:

■ After creating the disk groups, you tag the disks with site names to enable 

site-aware allocation. This is a separate operation, referred to in the VEA as 

adding disks to a site.

As an example, say you had a disk group with four disks. Disk1 and Disk2 

are physically located on Site A. Disk3 and Disk4 are physically located on 

Site B. Therefore, you add Disk1 and Disk2 to “site_a” and add Disk3 and 

Disk4 to “site_b”. 

■ During volume creation, you specify the volume site type as Site Separated. 

This ensures that the volume is restricted to the disks on the selected site.

Note: The hot relocation operation does not  adhere to site boundary 

restrictions. If hot relocation causes the site boundary to be crossed, then the 

Site Separated property of the volumes is changed to Siteless. This is done so as 

not to disable hot relocation. To restore site boundaries later, you can relocate 

the data that crossed the site boundary back to a disk on the original site and 

then change back the properties of the affected volumes. 

For more information on site-aware allocation, refer to the Veritas Storage 

Foundation Administrator’s Guide.

When you create the volumes for a campus cluster, consider the following:

■ During disk selection, configure the volume as “Site Separated” and select 

the two sites of the campus cluster from the site list.

■ For volume attributes, select the “mirrored” and “mirrored across 

enclosures” options. 

■ Symantec recommends using either simple mirrored (concatenated) or 

striped mirrored options for the new volumes. Striped mirrored gives you 

better performance compared to concatenated.

When selecting striped mirrored, select two columns in order to stripe one 

enclosure that is mirrored to the second enclosure.

■ During the volume creation procedure for Site Separated volumes, you can 

only create as many mirrors as there are sites. However, once volume 

creation is complete, you can add additional mirrors if desired.

■ Choosing “Mirrored” and the “mirrored across” option without having two 

enclosures that meet requirements causes new volume creation to fail.

■ You cannot selecting RAID-5 for mirroring.

■ Selecting “stripe across enclosures” is not recommended because then you 

need four enclosures, instead of two.
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■ Logging can slow performance.
 

Viewing the available disk storage
Before creating disk groups and volumes you may want to view available disk 

storage.

To view the available disk storage

1 Open the VEA console by clicking Start > All Programs >Symantec> Veritas 

Storage Foundation >Veritas Enterprise Administrator and select a profile 

if prompted.

2 Click Connect to a Host or Domain. 

3 In the Connect dialog box, select the host name from the pull-down menu 

and click Connect. 

To connect to the local system, select localhost. Provide the user name, 

password, and domain if prompted.

4 In the VEA configuration tree, expand hostname > StorageAgent and then 

click Disks.

The internal names for the disks which the current system can access for 

available storage are displayed, with names Harddisk1, Harddisk2, etc. The 

list includes both disks internal to the local system and any external storage 

that is available.

Creating a dynamic (cluster) disk group
Use the following procedure to create a dynamic disk group.

Note: Dynamic disks belonging to a Microsoft Disk Management Disk Group do 

not support cluster disk groups.

To create a dynamic disk group

1 Open the VEA console by clicking Start > All Programs > Symantec > Veritas 

Storage Foundation > Veritas Enterprise Administrator (or launch the VEA 

from the Solutions Configuration Center) and select a profile if prompted.

2 Click Connect to a Host or Domain.

3 In the Connect dialog box, select the host name from the pull-down menu 

and click Connect.

To connect to the local system, select localhost. Provide the user name, 

password, and domain if prompted.



228 Deploying SFW HA for campus cluster

Creating disk groups and volumes
4 To start the New Dynamic Disk Group wizard, expand the tree view under 

the host node, right click the Disk Groups icon, and select New Dynamic Disk 

Group from the context menu.

5 In the Welcome screen of the New Dynamic Disk Group wizard, click Next.

6 Provide information about the cluster disk group:

■ Enter the disk group name (for example, DG1).

■ Check the Create cluster group check box if you wish to create cluster 

dynamic disk groups that are used in a shared storage environment.

■ Select the appropriate disks in the Available disks list, and use the Add 

button to move them to the Selected disks list.

Optionally, check the Disk names prefix checkbox and enter a disk 

name prefix to give the disks in the disk group a specific identifier.

For example, entering TestGroup as the prefix for a disk group that 

contains three disks creates TestGroup1, TestGroup2, and TestGroup3 

as internal names for the disks in the disk group.

Note: For Windows Server operating systems, Windows Disk Management 

Compatible Dynamic Disk Group creates a type of disk group that is created 

by Windows Disk Management (LDM).

■ Click Next.

7 Click Next to accept the confirmation screen with the selected disks.
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8 Click Finish to create the dynamic disk group.
 

Proceed to create the appropriate volumes on each disk.

Adding disks to campus cluster sites
For campus cluster storage, Symantec recommends using Veritas Storage 

Foundation for Windows (SFW) site-aware allocation. To enable site-aware 

allocation, you assign a site name to disks after they are added to a disk group. In 

the VEA assigning a site name is referred to as adding disks to a site.

For example, Disk1 and Disk2 are physically located on Site A and Disk3 and 

Disk4 are physically located on Site B. Therefore, you add Disk1 and Disk2 to 

site_a and add Disk3 and Disk4 to site_b.

To add disks to a site

1 From the VEA console, right-click a disk that needs to be added to a site and 

select Add Disk to Site.

Disks must be part of a dynamic disk group in order to add them to a site.

2 In the Add Disk to a Site screen, choose one of the following:

■ Choose Select a new site and specify a new site name.

The site name can include any alphanumeric value and valid characters 

like the period (.), dash (-), and underscore ( _ ). It cannot exceed 31 

characters. Site names are case insensitive; all names are converted to 

lowercase.

■ Choose Available Sites and select a site from the list.

3 From the Available Disks column, select the disk or disks to add to the 

specified site.

4 Click OK.
 

Creating a volume
Use the following procedure to create dynamic volumes for a campus cluster.

Note: When assigning drive letters to volumes, ensure that the drive letters that 

you assign are available on all nodes.

To create dynamic volumes

1 If the VEA console is not already open, click Start > All Programs > 

Symantec > Veritas Storage Foundation > Veritas Enterprise Administrator 
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on the desktop. (Skip to step 4 if VEA is already connected to the appropriate 

host.)

2 Click Connect to a Host or Domain. 

3 In the Connect dialog box select the host name and click Connect.  
To connect to the local system, select localhost. Provide the user name, 

password, and domain if prompted.

4 To start the New Volume wizard, expand the tree view under the host node 

to display all the disk groups. Right click a disk group and select New 

Volume from the context menu.

You can right-click the disk group you have just created.

5 At the New Volume wizard opening screen, click Next.

6 Select the disks for the volume as follows:

Click Next.

Group name Make sure the appropriate disk group is selected.

Site preference Select the Site Separated option.

Select site from Select the campus cluster sites. Press CTRL to select multiple 

sites.

Note: If no sites are listed, the disks have not yet been added to 

a site. 

Auto select disks Automatic disk selection is recommended for campus clusters. 

SFW automatically selects the disks based on the following 

criteria:

■ Their port assignment (disks with two different ports are 

selected). Note that in the list of available disks, the entry 

after each disk name starts with the port number. For 

example, the “P3” in the entry P3C0T2L1 refers to port 3.

■ Amount of available space on the disks. SFW will pick 

two disks (one from each array) with the most space.

Manually select disks If you manually select disks, use the Add and Remove buttons 

to move the appropriate disks to the Selected disks list.

Disable Track 

Alignment

You may also check Disable Track Alignment to disable track 

alignment for the volume. Disabling Track Alignment means 

that the volume does not store blocks of data in alignment 

with the boundaries of the physical track of the disk.
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7 Specify the volume attributes as follows:

Click Next.

Volume name Specify a name for the volume. The name is limited to 18 

ASCII characters and cannot contain spaces or forward or 

backward slashes.

Size Specify a size for the volume. If you click Max Size, the Size 

box shows the maximum possible volume size for that layout 

in the dynamic disk group.

Layout Ensure that the Mirrored checkbox is selected.

Select a layout type as follows:

Select either Concatenated or Striped. 

If you are creating a striped volume, the Columns and Stripe 

unit size boxes need to have entries. Defaults are provided. In 

addition, click the Stripe across checkbox and select Ports 

from the drop-down list.

Mirror Info Click Mirror across and select Enclosures from the drop-down 

list. 

When creating a site separated volume, as required for 

campus clusters, the number of mirrors must correspond to 

the number of sites. If needed, you can add more mirrors after 

creating the volume.

Enable logging Verify that this option is not selected.
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8 In the Add Drive Letter and Path dialog box, assign a drive letter or mount 

point to the volume. You must use the same drive letter or mount point on 

all systems in the cluster. Make sure to verify the availability of the drive 

letter before assigning it. 

■ To assign a drive letter, select Assign a Drive Letter, and choose a drive 

letter.

■ To mount the volume as a folder, select Mount as an empty NTFS 

folder, and click Browse to locate an empty folder on the shared disk.

9 Click Next.
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10 Create an NTFS file system.

■ Make sure the Format this volume checkbox is checked and select 

NTFS.

■ Select an allocation size or accept the Default.

■ The file system label is optional. SFW makes the volume name the file 

system label.

■ Select Perform a quick format if you want to save time.

■ Select Enable file and folder compression to save disk space. Note that 

compression consumes system resources and performs encryption and 

decryption, which may result in reduced system performance. Click 

Next.

11 Click Finish to create the new volume.

12 Repeat these steps to create additional volumes as needed.

Note: Create the cluster disk group and volumes on the first node of the 

cluster only.

 

Installing the application on cluster nodes
VCS requires that the application program files be installed on the same local 

drive of all cluster nodes and that the application data and log files or other files 

related to the application data be installed on the shared storage. 
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Pointers for installing the application on the first node

■ Applications may have built-in procedures for running on a cluster. Consult 

the application documentation to determine whether these procedures are 

available.

■ Make sure that the disk groups and volumes are imported and thus mounted 

on the server before you install the application. 

■ If you have just created the disk groups and volumes, they will be mounted 

and accessible. When a disk group is created, it is automatically imported on 

that node. You can verify that the disk group and volumes are accessible if 

you can see the disk group and volume icons in VEA for the server.

■ All nodes of the clustered application need to share the same virtual name 

and IP address. 

■ Remember not to accept the default location for the application data and log 

files when installing the application. Instead, click to browse to the dynamic 

volumes that were prepared previously.

Pointers for installing the application on the second node

■ To install the application on the second node, deport any disk groups from 

the first node and import them on the second node. Steps for deporting and 

importing disk groups are in the section “Deporting and importing a disk 

group” on page 236.

■ Make sure that the shared volumes when accessed on the second node have 

the corresponding drive letters or mount points that they had when 

accessed from the first node. To change a drive letter or mount point, see the 

instructions in the section “To add or change a drive letter or mount point” 

on page 236.

■ If you are installing a database, you may need to stop the database service on 

the first node while the shared disks are being manipulated by the 

installation on the second node. Then restart the service after the 

application is installed.

Configuring a File Share server role
Points to note when configuring a File Share:

■ Make sure that the disk group and volumes for the file server shared 

directory are configured on shared storage.

■ When configuring a new set up, first create the disk groups and volumes on 

the shared storage and then create the directory structure for the file shares 

on the shared storage. 
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■ For an existing configuration that has a file server with shares on the local 

storage, move these shares to the shared storage using the practices 

recommended by Microsoft.

■ The FileShare agent is installed automatically with SFW HA.

Installing and configuring the IIS application
Points to note when installing IIS:

■ Verify IIS is installed and configured identically on all nodes hosting the 

service group. Verify that the sites to be monitored are on shared storage.

■ Import the cluster disk groups and mount the volumes that contain the 

website data, on the first node. 

■ For a new IIS installation, while creating new web sites, create the site folder 

on the shared storage and place the site content in that folder. 

■ Change the default home directory path for all IIS sites to monitored to a 

location on the shared storage. See the IIS documentation for instructions. 

■ For existing web sites, stop the sites and then move the website content to 

volumes on the shared storage. You must also reconfigure the home 

directory location for the website in IIS and then restart the website again.

■ Verify the port numbers assigned to IIS sites are not used by other 

applications or sites. 

■ Synchronize the IIS configuration on all nodes hosting the service group.

To synchronize the IIS configuration on Windows 2003 systems

1 Synchronize the IIS configuration on all nodes that will host the IIS service 

group. Run the script iiscnfg.vbs, located at %systemroot%\System32. 

The script copies the IIS metabase from the local system to the target 

system. 

For example, the following command copies the IIS metabase to 

target_sytem. You must enter a valid user name and password for the target 

system.

%systemroot%\System32> iiscnfg /copy /ts target_system /tu 
user_name /tp password

2 Stop and restart IIS Admin Service on all nodes.

Installing additional applications
Following are some very generic points for installing any application:



236 Deploying SFW HA for campus cluster

Installing the application on cluster nodes
■ Make sure that the disk groups and volumes are mounted on the node before 

installing the application. 

■ VCS requires the application program files to be installed on the same local 

drive on all nodes. For example, if you install the application program files 

on drive C of one node, installation of these same files on all other nodes. 

must be on drive C. 

■ Make sure that the same drive letter is available on all nodes and has 

adequate space for the installation.

■ The data files and any associated files, such as log files, should be installed 

on the shared storage.

Deporting and importing a disk group
This section describes the steps for deporting and importing a disk group in 

order to install the application on the second node.

To deport a disk group on the first node

1 If VEA is not already running, start the Veritas Enterprise Administrator 

(Start > All Programs > Symantec > Veritas Enterprise Administrator). If the 

Storage Foundation Assistant automatically opens, close it.

2 Navigate to dynamic disk groups on the node on which the dynamic disk 

group is currently imported.

3 Right-click the dynamic disk group to be deported and click Deport.

To import the dynamic disk group on the second node

1 Start the Veritas Enterprise Administrator (Start > All Programs > 

Symantec > Veritas Enterprise Administrator). If the Storage Foundation 

Assistant automatically opens, close it.

2 Navigate to dynamic disk groups on the node to which you will import the 

dynamic disk group.

3 Right-click the dynamic disk group to be imported and click Import.

No drive letter may be associated with an existing dynamic volume when it 

is imported to a computer for the first time. In such a case, use VEA to add 

or change drive letters. You need to make sure that drive letters or mount 

points for the volumes on the second node are the same as were used on the 

first node.

To add or change a drive letter or mount point

1 In VEA, right-click on the volume for which the drive letter will be added or 

changed.
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2 Select File System and click Change Drive Letter and Path. The Drive Letter 

and Paths window appears.

3 To add a drive letter, click the Add radio button. The Assign a drive letter 

drop-down list becomes available. Assign a drive letter and click OK.

4 To change a drive letter, click the Modify radio button. The Assign a drive 

letter drop-down list becomes available. Select the new drive letter and click 

OK.

5 To add a mount point, click the Add radio button, click the Mount as an 

empty NTFS folder radio button, browse to select an empty folder or click 

the New Folder button to create a new folder, and click OK to mount the 

volume.

Note: A mount point is also referred to as a “drive path.”

6 To change a mount point, you must remove it and recreate it (step 5). To 

remove it, select it in the Drive Letter and Paths window and click the 

Remove radio button. 

Configuring service groups
In order for VCS to be able to monitor and fail over an application in a cluster, 

the application must be included in a VCS service group. 

A service group is a collection of resources working together to provide 

application services to clients. It can also relate to a print or a file share that 

does not contain a specific application. A service group’s resources fail over as a 

group to another cluster node when there is an application failure or server 

failure on the active node. 

Creating a VCS service group provides the following:

■ Defining the cluster resources and their attributes.

■ Setting their dependencies; for example, a NIC resource depends on an 

IP resource.

■ Logically grouping the resources together.

■ Providing capabilities for monitoring the service group and taking it 

online or offline.

For an example of installing a service group with the Application Configuration 

wizard, see the section “Configuring the service group” on page 115 in 

Chapter 6, “Deploying SFW HA for high availability: New installation”.

The Solutions Configuration Center provides wizards to configure the service 

groups for the additional SFW HA applications or server roles. It also supports 
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the Application Configuration Wizard which can be used to configure any other 

application for which application specific wizards have not been provided. 

Depending on the application that you have installed, complete the appropriate 

procedure to configure the service group:

■ Configuring the File Share service group

■ Configuring the IIS service group

■ Configuring the service group for any additional applications

Configuring the File Share service group
Configuring the File Share service group involves creating a FileShare service 

group and defining the attribute values for its resources. After the service group 

is created, you must configure the shares to mount automatically at startup.

Prerequisites

■ Verify that you have local administrator privileges on the system where you 

run the wizard.

■ If you have configured a firewall, add the following to the firewall exceptions 

list:

■ Port 14150 or the VCS Command Server service, 

%vcs_home%\bin\CmdServer.exe

Here, %vcs_home% is the installation directory for VCS, typically 

C:\Program Files\Veritas\Cluster Server.

■ Port 14141

For a detailed list of services and ports used by SFW HA, refer to the Veritas 

Storage Foundation and High Availability Solutions for Windows Installation 

and Upgrade Guide.

■ Verify that the VCS high availability engine, HAD, is running on the system 

from which you run the wizard.

■ Verify that the directories to be shared reside on shared drives.

■ Mount the drives containing the shared directories on the system where you 

run the wizard. Unmount the drives from other systems in the cluster.

■ Verify that Veritas Command Server service is running on all systems in the 

cluster.

■ Verify that you have the following information ready. The wizard will 

prompt you for this information:

■ A unique virtual computer name to be assigned to the file share server.
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This is the name by which clients will access the server. The virtual 

name must not exceed 16 characters. If you specify a virtual computer 

name in lowercase letters, the name is converted to uppercase. For 

example, the name VCSServer is converted to VCSSERVER.

■ A unique virtual IP address to be assigned to the file share server.

The virtual IP address is required only if you wish to configure an IPv4 

address. In case of IPv6, the wizard prompts you to select the IPv6 

prefix and automatically generates an IPv6 address that is valid and 

unique on the network. The wizard uses the prefix that is advertised by 

the router on the IPv6 network.

Note: Windows Server does not support accessing file shares using the 

virtual IP address. 
You can work around this restriction by using non-scoped file shares. 

For more information: 
See “Creating non-scoped file shares configured with VCS” on 

page 181. 
See “Making non-scoped file shares accessible while using virtual 

server name or IP address if NetBIOS and WINS are disabled” on 

page 182.

■ The list of directories to be shared.

The wizard enables you to add existing shares to the VCS 

configuration. However, you cannot add special shares (shares created 

by the operating system for administrative and system use). For 

example, you cannot add the shares ADMIN$, print$, IPC$, and 

DriveLetter$ to the VCS configuration.

■ On Windows Server Core, you have to add the required resources and 

configure the service group manually. You can perform the steps either 

directly on the Server Core machine using the command line, or remotely 

using the Cluster Manager (Java console).

Refer to the Veritas Cluster Server Administrator’s Guide for instructions on 

using the command line and the Cluster Manager (Java Console).

Note: If User Access Control (UAC) is enabled on Windows Server systems, 

you must launch the command prompt in the Run as administrator mode 

and then run the VCS commands.

■ Before configuring the service group, review the resource types and the 

attribute definitions of the FileShare agent, described in the Veritas Cluster 

Server Bundled Agents Reference Guide.
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■ If your storage is SCSI-3 compliant and you wish to use SCSI-3 persistent 

reservations, enable SCSI-3 support using Veritas Enterprise Administrator 

(VEA).
 

Creating the File Share service group

Refer to the Veritas Cluster Server Bundled Agents Reference Guide. for 

information on resource types, attribute definitions, resource dependencies, and 

sample service group configurations.

To configure a FileShare 

1 Start the File Share Configuration Wizard from the Solutions Configuration 

Center. Click Start > All Programs > Symantec > Veritas Cluster Server > 

Solutions Configuration Center .

From the Solutions Configurations Center expand the Solutions for 

Additional Applications and from the display click Campus Cluster 

Configuration > Configure the Service Group > File Share Configuration 

Wizard.

or

Click Start > All Programs > Symantec > Veritas Cluster Server > 

Configuration Tools > File Share Configuration Wizard.

2 Review the information in the Welcome panel and click Next.

3 On the Wizard Options panel, click Create service group and click Next.

4 On the Service Group Configuration panel, specify the service group details 

and then click Next. The wizard then starts validating your configuration. 

Various messages indicate the validation status.

Service Group Name Type a name for the File Share service group.
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5 On the File Share Configuration panel, specify the configuration 

information for the FileShare resources to be created and then click Next. 

Group System List In the Available Cluster Systems list, select the systems 

on which to configure the service group and click the 

right arrow to move the systems to the service group’s 

system list.

To remove a system from the service group’s system list, 

click the system in the Systems in Priority Order box and 

click the left arrow.

To change a system’s priority in the service group’s 

system list, select the system in the Systems in Priority 

Order and click the up and down arrows.

System priority defines the order in which service 

groups are failed over to systems. The system at the top 

of the list has the highest priority while the system at 

the bottom of the list has the lowest priority.

Include selected 

systems in the service 

group's AutoStartList 

attribute

To enable the service group to automatically come online 

on one of the systems, select this checkbox.

For information about the AutoStartList attribute, see 

the Veritas Cluster Server Administrator’s Guide.
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The wizard begins validating your configuration. Various messages indicate 

the validation status.

Virtual Computer Name Type a unique virtual computer name by which the 

server will be known to clients. The virtual name 

must not exceed 16 characters.

List Shares Click List Shares to view the existing shares on the 

shared storage, then select a share and click Add.

You cannot add special shares (shares created

by the operating system for administrative and 

system use).
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Path Click the field and either type the path of the 

directory to be shared or click the ellipsis button (...) 

to browse for a directory.

The selected directories must meet the following 

conditions:

■ The selected drive, the mount path, and the file path 

must not exist in the VCS configuration.

■ The directories to be shared must reside on shared, 

non-system drives.

The wizard validates the selected directory and 

displays an error message if the directory does not 

meet any of the conditions.

Share Name If a selected directory is already shared, the Share 

Name column lists the names by which it is shared. 

You can select a listed share name to make an existing 

share highly available. You can also create a new 

share for the same directory by typing a new share 

name.

Remove To remove a file share from the configuration, click to 

select the file share and then click Remove.
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6 On the Share Permissions panel, select the file share, specify the users for 

the file shares and assign permissions to them, and then click Next.

Select the FileShare From the drop-down list, select the file share with which 

to associate user permissions, or select the default All 

FileShares to set the same permissions for all file shares.

Select the Permission From the drop-down list, select the permission to be 

associated with the user.

Select the User Click the ellipsis button (...), select a user, and click OK.

Add Click Add to add the specified user to the Selected Users 

list. By default, all selected users are given 

READ_ACCESS permission.

Selected Users Displays a list of selected users and the file share 

permissions. You can configure a maximum of 50 users 

for each file share. To configure more users, create a user 

group.

To change the file share permission associated with a 

user, click a user name in the Selected Users list and 

then select the desired permission from the Select the 

Permission drop-down list.

Remove To deny file share access to a user, click the user name in 

the Selected Users list and click Remove.



245Deploying SFW HA for campus cluster

Configuring service groups
7 On the Share Properties panel, set the share properties for the file shares 

and then click Next.

Select the FileShare From the drop-down list select a file share whose 

properties you wish to set.

Enable access-based 

enumeration for this 

file share

Check the Enable access-based enumeration check box 

to enable the Windows access-based enumeration 

feature on the selected file share.

User Limit Specify the number of users that are allowed access to 

the selected file share.

Choose from the following options:

■ Maximum allowed users: Select this option to allow 

access to the maximum numbers of users allowed on 

Windows.

■ Allow this number of users: Select this option and then 

type the number of users that you wish to grant access to 

the selected file share.

If you type zero or a value greater than what Windows 

supports, access is granted to the maximum allowed 

users on Windows.
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Enable cache Check the Enable cache check box to enable local 

caching of the contents of the selected file share.

Then, specify how the contents of the file share are 

available to users for offline access.

In the drop down list select from the following caching 

options:

■ Manual caching of files and programs: Only the files and 

programs specified by the user are available offline. This 

sets the FileShare resource attribute ClientCacheType to 

MANUAL.

■ Automatic caching of programs: All the files and 

programs that the users access from the file share are 

available offline. This sets the FileShare resource 

attribute ClientCacheType to DOCS.

■ Optimized automatic caching of files and programs: All 

files and programs, including executables, are cached 

locally. The next time the user accesses the executable 

files, they are launched from the local cache. This sets 

the FileShare resource attribute ClientCacheType to 

PROGRAMS.

Hide share Check the Hide Share check box to make the new share a 

hidden share.

Share all subfolder Check the Share all subfolders check box to share the 

subdirectories.

Hide child shares Check the Hide child shares check box to hide the shared 

subdirectories.

Apply these settings 

to

To apply the specified share properties to multiple file 

shares simultaneously, do the following:

1 Click the ellipsis (...) button.

2 On the Copy Share Properties dialog box, select the file 

shares from the Available Shares list and click the right 

arrow to move them to the Selected Shares list.

Note that only those files shares that are not already 

shared are available for selection.

3 Click OK.

Note: This option is not visible if you are configuring only one 

share in the service group.
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8 On the Network Configuration panel, specify information related to your 

network and then click Next.

Do the following:

■ Select IPv4 to configure an IPv4 address for the virtual server.

■ In the Virtual IP Address field, type a unique virtual IPv4 address 

for the virtual server.

■ In the Subnet Mask field, type the subnet to which the virtual IPv4 

address belongs.

■ Select IPv6 to configure an IPv6 address for the virtual server. The IPv6 

option is disabled if the network does not support IPv6.

■ Select the prefix from the drop-down list. The wizard uses the 

prefix and automatically generates an IPv6 address that is valid 

and unique on the network.

■ For each system in the cluster, select the public network adapter name. 

The Adapter Display Name field displays the TCP/IP enabled adapters 

on a system, including the private network adapters, if applicable. 

To view the adapters associated with a system, click the Adapter 

Display Name field and click the arrow. Verify that you select the adapters 

assigned to the public network, not the private.

■ Click Advanced Settings to specify additional details for the Lanman 

resource.
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On the Lanman Advanced Configuration dialog box, complete the 

following:

■ Check Active Directory Update required check box to enable the 

Lanman resource to update the Active Directory with the virtual 

name. This sets the Lanman agent attributes ADUpdateRequired 

and ADCriticalForOnline to true.

■ In the Organizational Unit field, type the distinguished name of 

the Organizational Unit for the virtual server in the format 

CN=containername,DC=domainname,DC=com.

To browse for an OU, click the ellipsis (...) button and search for the 

OU using the Windows Find Organization Units dialog box. By 

default, the Lanman resource adds the virtual server to the default 

container "Computers."

■ Click OK.

The user account for VCS Helper service must have adequate 

privileges on the specified container to create and update 

computer accounts.

9 On the Service Group Summary panel, review the service group 

configuration.

Click Next.

Click Yes on the message box that appears, informing you that the wizard 

will run commands to modify the service group configuration.

The wizard starts running commands to create the service group. Various 

messages indicate the status of these commands.

Resources Displays a list of configured resources. The wizard 

assigns unique names to resources. Change the names 

of resource, if required.

To edit a resource name, select the resource name and 

either click it or press the F2 key. Edit the resource 

name and then press the Enter key to confirm the 

changes. To cancel editing a resource name, press the 

Esc key.

Attributes Displays the attributes and their configured values for 

a resource selected in the Resources list.

Enable FastFailOver 

attribute for all the 

VMDg resources in the 

service group

To enable all the VMDg resources in the service group 

for fast failover, select this checkbox.

For information about the FastFailOver attribute, see 

the Veritas Cluster Server Administrator’s Guide.
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10 In the completion dialog box, check Bring the service group online check 

box if you want to bring the service group online on the local system, and 

then click Finish.

Creating non-scoped file shares configured with VCS

File shares configured with VCS on Windows Server are accessible only using 

the virtual server name (Lanman resource). These file shares are not accessible 

using the IP address.

The FileShare agent is enhanced to address this issue. The FileShare agent 

behavior can be controlled using the following registry key:

HKLM\SOFTWARE\VERITAS\VCS\BundledAgents\Lanman\<VirtualName>\ 
DisableServerNameScoping

Set the DisableServerNameScoping key to have the FileShare agent support 

non-scoped file shares.

You must create this registry key manually. Perform the following steps to 

create and set the DisableServerNameScoping registry key that is used by the 

FileShare agent to support non-scoped file shares.

Note: Incorrectly editing the registry may severely damage your system. Make a 

backup copy before making changes to the registry.

To configure DisableServerNameScoping registry parameter

1 To open the Registry Editor, click Start > Run, type regedit, and then click 

OK.

2 In the registry tree (on the left), navigate to 

HKLM\SOFTWARE\VERITAS\VCS\BundledAgents.

3 Click Edit > New > Key and create a key by the name Lanman, if it does not 

exist already.

4 Select the Lanman key and click Edit > New > Key and create a key by the 

name virtualName.

Here virtualName should be the virtual computer name assigned to the file 

share server. This is the VirtualName attribute of the Lanman resource in 

the file share service group.

The newly created registry key should look like this:

HKLM\SOFTWARE\VERITAS\VCS\BundledAgents\Lanman\virtualName

5 Select the key that you created in step 4 (virtualName) and add a DWORD 

type of value.

The value name should be DisableServerNameScoping and value data 

should be 1.
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The value 1 indicates that the FileShare and Lanman agents support non-

scoped file shares on Windows Server systems.

6 If there are multiple file share service groups to be used in the non-scoped 

mode, repeat steps 4 and 5 for each Lanman resource that is configured in 

the file share service group.

You must create this key only for Lanman resources that are part of VCS file 

share service groups. Configuring this key for Lanman resources that are part of 

other VCS service groups may result in an unexpected behavior.

Making non-scoped file shares accessible while using virtual 
server name or IP address if NetBIOS and WINS are disabled

The VCS FileShare agent depends on NetBIOS or DNS to resolve the virtual 

name. If NetBIOS and WINS are disabled or the DNS is not updated, the agent is 

unable to resolve the virtual name.

This may typically occur when the file share service groups are configured to 

use localized IP addresses. When the service group is switched or failed over, the 

virtual name to IP address mapping changes. In such a case if WINS database or 

the DNS are not updated, the agent is unable to resolve the virtual name. As a 

result the FileShare resources fault and the shares become inaccessible.

The following message is seen in the agent log:

VCS INFO V-16-10051-10530 
FileShare:<servicegroupname>:online:Failed to access the network 
path (\\virtualname)

The FileShare agent is enhanced to address this issue. The FileShare agent 

behavior can be controlled using the following registry key:

HKLM\SOFTWARE\VERITAS\VCS\BundledAgents\Lanman\virtualName\DisableS
trictVirtualNameCheck

Set the DisableStrictVirtualNameCheck key to have the FileShare agent make 

the file shares accessible irrespective of whether or not the virtual name is 

resolvable. In case the virtual name is not resolvable, the file shares are 

accessible using the virtual IP.

You must create this registry key manually. Perform the following steps to 

create and set the DisableStrictVirtualNameCheck registry key that is used by 

the FileShare agent to disable virtual name availability as a requirement for file 

shares to be available on the network.

Note: Incorrectly editing the registry may severely damage your system. Make a 

backup copy before making changes to the registry.
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To configure DisableStrictVirtualNameCheck registry parameter

1 To open the Registry Editor, click Start > Run, type regedit, and then click 

OK.

2 In the registry tree (on the left), navigate to 

HKLM\SOFTWARE\VERITAS\VCS\BundledAgents.

3 Click Edit > New > Key and create a key by the name Lanman, if it does not 

exist already.

4 Select the Lanman key and click Edit > New > Key and create a key by the 

name virtualName.

Here virtualName should be the virtual computer name assigned to the file 

share server. This is the VirtualName attribute of the Lanman resource in 

the file share service group.

The newly created registry key should look like this:

HKLM\SOFTWARE\VERITAS\VCS\BundledAgents\Lanman\virtualName

5 Select the key that you created in step 4 (virtualName) and add a DWORD 

type of value.

The value name should be DisableStrictVirtualNameCheck and value data 

should be 1.

6 If there are multiple file share service groups to be used in the non-scoped 

mode, repeat steps 4 and 5 for each Lanman resource that is configured in 

the file share service group.

7 Save and exit the Registry Editor.

You must create this key only for Lanman resources that are part of VCS file 

share service groups. Configuring this key for Lanman resources that are part of 

other VCS service groups may result in an unexpected behavior.
 

 

 

Configuring the IIS service group
Configuring the IIS service group involves creating a IIS service group and 

defining the attribute values for its resources. After the service group is created, 

you must configure the shares to mount automatically at startup.

Prerequisites

■ Verify that you have local administrator privileges on the system where you 

run the wizard.

■ Verify IIS is installed and configured identically on all nodes hosting the 

service group. Verify the sites to be monitored are on shared storage.
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■ For IIS 8.0 on Windows Server 2012, you must install the following 

components:

■ IIS 6 Metabase Compatibility

■ IIS 6 WMI Compatibility

These options are available under Management Tools on the Role Services 

page of the Add Roles Wizard.

These components are required for the IIS agent to function on Windows 

Server 2012.

For IIS 8.0 on Windows Server Core, you must install IIS in the specified 

order. See “Installing IIS 8.0 on Windows Server Core” on page 253 for 

instructions.

■ If IIS configuration is using IPv6 addresses, then you must install the IIS 

Management Scripts and Tools role service.

IPv6 requires WMI 7 Provider that is part of the IIS Management Scripts 

and Tools role.

■ Do not use the IIS agent to configure SMTP and NNTP sites if you have 

Microsoft Exchange installed.

■ Change the default home directory path for all IIS sites to monitored to a 

location on the shared storage. See the IIS documentation for instructions.

■ Verify the port numbers assigned to IIS sites are not used by other 

programs.

■ If you have configured a firewall, add the following to the firewall exceptions 

list:

■ Port 14150 or the VCS Command Server service, 

%vcs_home%\bin\CmdServer.exe

Here, %vcs_home% is the installation directory for VCS, typically 

C:\Program Files\Veritas\Cluster Server.

■ Port 14141

For a detailed list of services and ports used by SFW HA, refer to the Veritas 

Storage Foundation and High Availability Solutions for Windows Installation 

and Upgrade Guide.

■ To configure IIS agent on Windows Server Core, you must manually add the 

required resources and configure the service group. You can perform the 

manual configuration steps either directly on the Server Core machine 

using the command line, or remotely using the Cluster Manager (Java 

console).

For instructions on using the command line and the Cluster Manager (Java 

Console), refer to the Veritas Cluster Server Administrator’s Guide.
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Note: If User Access Control (UAC) is enabled on Windows Server systems, 

you must launch the command prompt in the Run as administrator mode 

and then run the VCS commands.

■ Verify that the VCS high availability engine, HAD, is running on the system 

where you run the wizard.

■ Mount the drives containing the shared directories from the system from 

which you run the wizard. Unmount the drives from other systems in the 

cluster.

■ If your storage is SCSI-3 compliant and you wish to use SCSI-3 persistent 

reservations, enable SCSI-3 support using Veritas Enterprise Administrator 

(VEA).

■ Verify that you have the following information ready. The wizard will 

prompt you for this information:

■ IIS sites to be monitored.

■ Application pools associated with each site.

■ Port numbers associated with each site.

■ Virtual IP addresses and computer names associated with the sites. The 

virtual IP addresses and the virtual computer names must have 

forward and reverse entries in the DNS.

■ Before configuring the service group, review the resource types and the 

attribute definitions of the IIS agent, described in the Veritas Cluster Server 

Bundled Agents Reference Guide.

Installing IIS 8.0 on Windows Server Core

Complete the following steps.

To install IIS 8.0 on Windows Server Core

1 Type the following at the command prompt:

start /w pkgmgr /iu:IIS-WebServerRole;IIS-WebServer;IIS-
CommonHttpFeatures; 
IIS-StaticContent;IIS-DefaultDocument;IIS-DirectoryBrowsing; 
IIS-HttpErrors;IIS-HttpRedirect;IIS-ApplicationDevelopment; 
IIS-ASP;IIS-CGI;IIS-ISAPIExtensions;IIS-ISAPIFilter; 
IIS-ServerSideIncludes;IIS-HealthAndDiagnostics; 
IIS-HttpLogging;IIS-LoggingLibraries;IIS-RequestMonitor; 
IIS-HttpTracing;IIS-CustomLogging;IIS-ODBCLogging;IIS-
Security;IIS-BasicAuthentication;IIS-WindowsAuthentication; 
IIS-DigestAuthentication; 
IIS-ClientCertificateMappingAuthentication; 
IIS-IISCertificateMappingAuthentication; 
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IIS-URLAuthorization;IIS-RequestFiltering;IIS-IPSecurity; 
IIS-Performance;IIS-HttpCompressionStatic; 
IIS-HttpCompressionDynamic;IIS-WebServerManagementTools; 
IIS-ManagementScriptingTools;IIS-IIS6ManagementCompatibility; 
IIS-Metabase;IIS-WMICompatibility;IIS-LegacyScripts; 
IIS-FTPPublishingService;WAS-WindowsActivationService; 
IIS-FTPPublishingService;IIS-FTPServer

2 Verify that all the components specified in the earlier step have successfully 

installed. Type the following at the command prompt:

notepad C:\windows\logs\cbs\cbd.log

This opens the log file, cbd.log, in the Notepad text editor.

3 Check the entries in the log file, cbd.log. The last log entry should resemble 

the following:

Info CBS Pkgmgr: return code: 0x0

This message indicates that all the components are installed successfully.

4 Run the oclist command to verify that the following components are 

installed: 

IIS-WebServerRole; IIS-WebServer; IIS-IIS6ManagementCompatibility; IIS-

Metabase; IIS-WMICompatibility; IIS-FTPPublishingService; WAS-

WindowsActivationService; IIS-FTPPublishingService; IIS-FTPServer

Type the following at the command prompt:

oclist

5 Repeat the steps on all the nodes on which you wish to configure the IIS 

service group.
 

Creating the IIS service group

Refer to the Veritas Cluster Server Bundled Agents Reference Guide for 

information on resource types, attribute definitions, resource dependencies, and 

sample service group configurations.

The following steps describe how to create an IIS service group.

To create an IIS service group

1 Start the IIS Configuration Wizard from the Solutions Configuration Center. 

Click Start > All Programs > Symantec > Veritas Cluster Server > Solutions 

Configuration Center.

From the Solutions Configurations Center expand the Solutions for 

Additional Applications and from the display click Campus Cluster 

Configuration > Configure the Service Group > IIS Configuration Wizard.

or

Click Start > All Programs > Symantec > Veritas Cluster Server > 

Configuration Tools > IIS Configuration Wizard.
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2 Review the information in the Welcome panel and click Next.

3 On the Wizard Options panel, click Create service group and click Next.

4 On the Service Group Configuration panel, specify the service group details 

and then click Next. The wizard then starts validating your configuration. 

Various messages indicate the validation status.

Service Group Name Type a name for the IIS service group.

Group System List In the Available Cluster Systems list, select the systems 

on which to configure the service group and click the 

right arrow to move the systems to the service group’s 

system list.

To remove a system from the service group’s system list, 

click the system in the Systems in Priority Order box and 

click the left arrow.

To change a system’s priority in the service group’s 

system list, select the system in the Systems in Priority 

Order and click the up and down arrows.

System priority defines the order in which service 

groups are failed over to systems. The system at the top 

of the list has the highest priority while the system at 

the bottom of the list has the lowest priority.

Include selected 

systems in the service 

group's AutoStartList 

attribute

To enable the service group to automatically come online 

on one of the systems, select this checkbox.

For information about the AutoStartList attribute, see 

the Veritas Cluster Server Administrator's Guide.
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5 On the Configure IIS Sites panel, add and remove sites from the service 

group, configure IP addresses, ports, and virtual computer names, and then 

click Next.

6 On the Network Configuration panel, specify information related to the 

virtual IP addresses and click Next.

Add Check the check box corresponding to the site to be 

configured in VCS.

IP Verify or type the virtual IP address for each site to be 

configured.

Make sure that each virtual IP address is associated with 

only one virtual computer name and vice-versa.

Port Type the port number for each site to be configured.

Virtual Name Type a virtual name for the selected site. Each virtual 

name can be associated with only one virtual IP address 

at a time.

IP Address Displays the virtual IP addresses. The wizard groups 

systems by the virtual IP addresses associated with the 

systems.
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7 On the Application Pool Configuration panel, select the monitoring options 

for application pools associated with each site and click Next.

Subnet Mask If the virtual IP is an IPv4 address, verify or type the 

subnet mask associated with each virtual IPv4 address.

If the virtual IP is an IPv6 address, verify or type the 

associated IPv6 prefix.

The prefix is generally represented in the following 

format: ipv6-address/prefix-length.

For example, 2001:db8:0:1::/64.

Adapter Name Select the adapter associated with the virtual IP address 

on each system.

Site Name Displays the site names.

AppPoolMon For each site, select the monitoring options from the 

AppPoolMon list.

Choose from the following options from the drop-down 

list:

■ NONE—The agent will not monitor the application pool 

associated with the site.

■ DEFAULT—Starts and monitors the root application pool 

associated with the site.

■ ALL—Starts all application pools associated with the site 

and monitors root application pool.



258 Deploying SFW HA for campus cluster

Configuring service groups
8 On the Service Group Summary panel, review the service group 

configuration.

Click Next.

Click Yes on the message box that appears, informing you that the wizard 

will run commands to modify the service group configuration.

The wizard starts running commands to create the service group. Various 

messages indicate the status of these commands.

9 In the completion dialog box, check Bring the service group online if you 

want to bring the service group online on the local system, and then click 

Finish.
 

 

Configuring the service group for any additional applications
Configuring the service group for any additional application involves creating 

an application service group and defining the attribute values for its resources. 

This can be done using the Application Configuration Wizard. After the service 

group is created, you must configure the shares to mount automatically at 

startup.

Prerequisites

■ The application is installed on all the nodes that are going to be part of the 

service group.

■ The shared drives required for the application are mounted on this node.

Resources Displays a list of configured resources. The wizard 

assigns unique names to resources. Change the names 

of resource, if required.

To edit a resource name, select the resource name and 

either click it or press the F2 key. Edit the resource 

name and then press the Enter key to confirm the 

changes. To cancel editing a resource name, press the 

Esc key.

Attributes Displays the attributes and their configured values, for 

a resource selected in the Resources list.

Enable FastFailOver 

attribute for all the 

VMDg resources in the 

service group

To enable all the VMDg resources in the service group 

for fast failover, select this checkbox.

For information about the FastFailOver attribute, see 

the Veritas Cluster Server Administrator’s Guide.
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■ The startup type of the application service is set to manual on all nodes in 

the service group.

■ The application service is stopped on all nodes in the service group.

■ If your storage is SCSI-3 compliant and you wish to use SCSI-3 persistent 

reservations, enable SCSI-3 support using Veritas Enterprise Administrator 

(VEA).

■ If you have configured a firewall, add the following to the firewall exceptions 

list:

■ Port 14150 or the VCS Command Server service, 

%vcs_home%\bin\CmdServer.exe

Here, %vcs_home% is the installation directory for VCS, typically 

C:\Program Files\Veritas\Cluster Server.

■ Port 14141

For a detailed list of services and ports used by SFW HA, refer to the Veritas 

Storage Foundation and High Availability Solutions for Windows Installation 

and Upgrade Guide.

■ On Windows Server Core, you have to add the required resources and 

configure the service group manually. You can perform the steps either 

directly on the Server Core machine using the command line, or remotely 

using the Cluster Manager (Java console).

Refer to the Veritas Cluster Server Administrator’s Guide for instructions on 

using the command line and the Cluster Manager (Java Console).

Note: If User Access Control (UAC) is enabled on Windows Server systems, 

you must launch the command prompt in the Run as administrator mode 

and then run the VCS commands.

Before configuring the service group, review the resource types and the 

attribute definitions of the FileShare agent, described in the Veritas Cluster 

Server Bundled Agents Reference Guide.

■ Before running the wizard, make sure you have the following information 

ready:

■ Details (service name, start parameters, startup directory, etc.) of the 

application that you wish to configure.

■ Shared storage used by the applications.

■ Application registry entries for configuring registry replication.

■ Network and virtual computer (Lanman) details for the application.
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Creating the application service group

The following steps describe how to create an IIS service group.

To create an application service group

1 Start the Application Configuration Wizard from the Solutions 

Configuration Center. Click Start > All Programs > Symantec > Veritas 

Cluster Server > Solutions Configuration Center.

From the Solutions Configurations Center expand the Solutions for 

Additional Applications and from the display click Campus Cluster 

Configuration > Configure the Service Group > Application Configuration 

Wizard.

or

Click Start > All Programs > Symantec > Veritas Cluster Server > 

Configuration Tools > Application Configuration Wizard.

2 Review the information in the Welcome panel and click Next.

3 In the Wizard Options panel, click Create service group and click Next.

4 Specify the service group name and system list.

■ Enter a name for the service group.

■ In the Available Cluster Systems box, select the systems on which to 

configure the service group and click the right-arrow icon to move the 

systems to the service group’s system list.

To remove a system from the service group’s system list, select the 

system in the Systems in Priority Order list and click the left arrow.

■ To change a system’s priority in the service group’s system list, select 

the system in the Systems in Priority Order list and click the up and 

down arrows. The system at the top of the list has the highest priority 

while the system at the bottom of the list has the lowest priority.

■ To enable the service group to automatically come online on one of the 

systems, select the Include selected systems in the service group's 

AutoStartList attribute checkbox.

For information about the AutoStartList attribute, see the Veritas 

Cluster Server Administrator's Guide.

■ Click Next.

The wizard starts validating your configuration. Various messages 

indicate the validation status.

5 The Application Options panel provides you the option to specify the type of 

application to be configured. The available options are:
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■ Generic Service: Configures a service using the Generic Service agent. 

The agent brings services online, takes them offline, and monitors their 

status. See “Configuring a GenericService resource” on page 261.

■ Process: Configures a process using the Process agent. The agent brings 

processes online, takes them offline, and monitors their status. See 

“Configuring processes” on page 265.

■ Service Monitor: Configures a service using the ServiceMonitor agent. 

The agent monitors a service or starts a user-defined script and 

interprets the exit code of the script. See “Configuring a 

ServiceMonitor resource” on page 269.

Configuring a GenericService resource

1 In the Application Options panel, click Create, select GenericService from 

the corresponding drop-down list, and click Next.
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2 Select the service name for which you wish to configure a GenericService 

resource. Also specify the attributes for the resource.

■ Click the icon (...) adjacent to the Service Name text box.

■ In the Services dialog box, select a service and click OK. The selected 

service appears in the Service Name text box.

■ In the Start Parameters text box, provide the start parameters for the 

service, if any.

■ In the Delay After Online text box, specify the number of seconds the 

agent waits after the service is brought online before starting the 

monitor routine.

■ In the Delay After Offline text box, specify the number of seconds the 

agent waits after the service is taken offline before starting the monitor 

routine.

■ Click Next.
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3 Specify the information about the user in whose context the service will run.

■ To configure a service to run in the context of a local system account, 

click Local System account.

■ To configure a service to run in the context of another user account, 

click This Account. Specify the Domain Name, User Name, and 

Password for the user account.

■ Click Next.
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4 Select the shared storage required for the GenericService resource. The 

shared storage, which you select will be in addition to the mount where the 

service binaries exist.

■ In the Available Shared Drives box, select the check box adjacent to the 

shared drive.

■ Click Next.

5 In the Application Resource Summary panel, review the summary of the 

GenericService resource. Click Back to make changes. Otherwise, click Next.

6 The Application Options panel appears. Select one of the following options:

■ To configure another GenericService resource, repeat step 1 through 

step 5.

■ To configure a Process resource, proceed to “Configuring processes” on 

page 265 for instructions.

■ To configure a ServiceMonitor resource, proceed to “Configuring a 

ServiceMonitor resource” on page 269 for instructions.

■ To configure other resources, including FileShare, Registry 

Replication, and Network resources, proceed to “Configuring VCS 

components” on page 272 for instructions.

If you do not want to add any more resources to your service group, proceed to 

“Configuring application dependencies” on page 275.
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Configuring processes

1 In the Application Options panel, click Create, select Process from the 

corresponding list, and click Next.

2 Specify the details for the process.

■ In the Start Program text box, specify the complete path of the 

program that will start the process to be monitored by VCS. You can 
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choose to either type in the location of the program or browse for it 

using the (...) icon.

■ In the Start Program Parameters text box, specify the parameters used 

by the Process agent start program.

■ In the Program Startup Directory text box, enter the complete path of 

the Process agent program or browse for it by clicking the (...) icon.

■ In the Stop Program text box, enter the complete path of the program 

that will stop the process started by the Start Program or browse for it 

by clicking the (...) icon.

■ In the Stop Program Parameters text box, specify the parameters used 

by the stop program.

■ In the Monitor Program text box, enter the complete path of the 

program that monitors the Start Program or browse for it by clicking 

the (...) icon.

If you do not specify a value for this attribute, VCS monitors the Start 

Program. If the Start Program is a script to launch another program, 

you must specify a monitor program.

■ In the Monitor Program Parameters text box, specify the parameters 

used by the monitor program.

■ In the Clean Program text box, enter the complete path of the Clean 

process or browse for it by clicking the (..) icon.

■ If no value is specified, the agent kills the process indicated by the Start 

Program.

■ In the Clean Program Parameters text box, specify the parameters used 

by the Clean program.

■ Select the Process interacts with the desktop check box if you want the 

process to interact with your Windows desktop. Setting this option 

enables user intervention for the process.

■ Click Next.
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3 Specify information about the user in whose context the process will run.

■ To configure a service to run in the context of a local system account, 

click Local System account.

■ To configure a service to run in the context of another user account, 

click This Account. Specify the Domain Name, User Name, and 

Password for the user account.

■ Click Next.
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4 Select the shared storage required for the Process resource. The shared 

storage, which you select will be in addition to the mount where the service 

binaries exist.

■ From the Available Shared Drives box, select the check box adjacent to 

the shared drive.

■ Click Next.

5 In the Application Resource Summary panel, review the summary of the 

Process resource. Click Back to make changes. Otherwise, click Next.

6 The Application Options panel appears. Select one of the following options:

■ To configure another Process resource, repeat step 1 through step 5.

■ To configure a GenericService resource, see “Configuring a 

GenericService resource” on page 261 for instructions.

■ To configure a ServiceMonitor resource, proceed to “Configuring a 

ServiceMonitor resource” on page 269 for instructions.

■ To configure other resources, including FileShare, Registry 

Replication, and Network resources, proceed to “Configuring VCS 

components” on page 272 for instructions.

If you do not want to add any more resources to your service group, proceed to 

“Configuring application dependencies” on page 275.
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Configuring a ServiceMonitor resource

1 In the Application Options panel, click Create, select ServiceMonitor from 

the corresponding drop-down list, and click Next.

2 Specify the service to be monitored or a user-defined script to monitor a 

service.



270 Deploying SFW HA for campus cluster

Configuring service groups
If you want VCS to monitor the service:

■ Select the Service option and click the icon (...) adjacent to the Service 

Name text box.

■ In the Service dialog box, select the service and click OK. The selected 

service name appears in the Service Name text box. Alternatively, You 

may also type in the service name to be monitored.

■ Click Next.

If you want a script to monitor the service:

■ Specify the complete path for the script using the Browse button (...).

■ Specify the parameters for the script.

■ Specify the time in seconds for the agent to receive a return value from 

the monitor script.

■ Click Next.

3 Specify the user information in whose context the service will be monitored.

■ To configure a service to run in the context of a local system account, 

click Local System account.

■ To configure a service to run in the context of another user account, 

click This Account. Specify the Domain Name, User Name, and 

Password for the user account.
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If the service selected in step 2 on page 269 is running in the context of 

a local system account, the This Account option is disabled. Similarly, if 

the service is running in the context of any other user account, the 

Local System account option is disabled.

■ Click Next.

ServiceMonitor resource belongs to the category of persistence resources. 

Such resources do not depend on other VCS resources, including shared 

storage. Hence, the Shared Storage Option panel does not appear if you 

select the ServiceMonitor option.

4 In the Application Resource Summary panel, review the summary of the 

ServiceMonitor resource. Click Back to make changes. Otherwise, click Next.

5 The Application Options panel appears. Select one of the following options:

■ To configure another ServiceMonitor resource, repeat step 1 through 

step 4.

■ To configure a GenericService resource, see “Configuring a 

GenericService resource” on page 261 for instructions.

■ To configure a Process resource, see “Configuring processes” on 

page 265 for instructions.

■ To configure other resources, including FileShare, Registry 

Replication, and Network resources, proceed to “Configuring VCS 

components” on page 272 for instructions.

If you do not want to add any more resources to your service group, proceed to 

“Configuring application dependencies” on page 275.
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Configuring VCS components

Applications configured using GenericService or Process resources may require  

network components, or Registry Replication resources. You can configure 

these VCS components only for service groups created using the wizard.

Note: Configure these components only after configuring all application 

resources. The wizard creates a service group after these components are 

configured. To add more application resources, you must rerun the wizard in the 

Modify mode.

To configure VCS components

1 In the Application Options panel, click Configure Other Components.
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2 Select the VCS component to be configured for your applications.

The available options are:

■ Registry Replication Component: Select this option to configure 

registry replication for your application. To configure a Registry 

Replication resource, proceed to step 3 on page 273.

■ Network Component: Select this option to configure network 

components for your application. If you wish to configure a virtual 

computer name, check Lanman component also. To configure a 

network resource, proceed to step 4 on page 274.

The wizard does not enable the Lanman Component check box unless the 

Network Component check box is checked.

To configure Registry Replication

The RegistryReplication panel appears only if you chose to configure the 

Registry Replication Component in the Application Component panel.

3 Specify the registry keys to be replicated.

■ Specify the directory on the shared disk in which the registry changes 

are logged.

■ Click Add.

■ In the Registry Keys dialog box, select the registry key to be replicated.

■ Click OK.

■ The selected registry key is added to Registry KeyList box. Click Next.
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If you chose Network Component from the Application Component panel, 

proceed to the next step. Otherwise, proceed to step 5 on page 275.

To configure network components

The Virtual Computer Configuration panel appears only if you chose to 

configure the Network Component in the Application Component panel.

4 Specify information related to your network.

■ Select IPv4 to configure an IPv4 address for the virtual server.

■ In the Virtual IP Address field, type a unique virtual IPv4 address 

for the virtual server.

■ In the Subnet Mask field, type the subnet to which the virtual IPv4 

address belongs.

■ Select IPv6 to configure an IPv6 address for the virtual server. The IPv6 

option is disabled if the network does not support IPv6.

■ Select the prefix from the drop-down list. The wizard uses the 

prefix and automatically generates an IPv6 address that is valid 

and unique on the network.

■ In the Virtual Server Name field, enter a unique virtual computer name 

by which the node will be visible to the other nodes. Note that the 

virtual name must not exceed 15 characters.

Note that the Virtual Computer Name text box is displayed only if you 

chose to configure the Lanman Component in Application Component 

panel. 

■ Click Advanced to specify additional details for the Lanman resource.

■ Check AD Update required to enable the Lanman resource to 

update the Active Directory with the virtual name. This sets the 

Lanman agent attributes ADUpdateRequired and 

ADCriticalForOnline to true.

■ In the Organizational Unit field type the distinguished name of the 

Organizational Unit for the virtual server in the format 

CN=containername,DC=domainname,DC=com. To browse for an 

OU, click the ellipsis (...) button and search for the OU using the 

Windows Find Organization Units dialog box.for the virtual server. 

By default, the Lanman resource adds the virtual server to the 

default container "Computers."

The user account for VCS Helper service must have adequate 

privileges on the specified container to create and update 

computer accounts.

■ Click OK.
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■ For each system in the cluster, select the public network adapter name. 

The Adapter Display Name field displays the TCP/IP enabled adapters 

on a system, including the private network adapters, if applicable. 

To view the adapters associated with a system, click the Adapter 

Display Name field and click the arrow. Verify that you select the adapters 

assigned to the public network, not the private.

■ Click Next.

5 The Application Options panel is displayed. Select one of the following 

options:

■ To configure additional VCS components, repeat step 1 on page 272 

through step 4 on page 274.

■ To configure a GenericService resource, see “Configuring a 

GenericService resource” on page 261 for instructions.

■ To configure a Process resource, see “Configuring processes” on 

page 265 for instructions.

■ To configure a Service Monitor resource, see “Configuring a 

ServiceMonitor resource” on page 269 for instructions.

If you do not want to add any more resources to your service group, proceed 

to “Configuring application dependencies” on page 275.

Configuring application dependencies

The Application Configuration Wizard enables you to create service group for 

the application resources and other VCS components configured using the 

wizard. This section describes how to create the service group using the wizard.
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To create a service group

1 In the Application Options panel, click Configure application dependency 

and create service group.

The option is enabled only if:

■ resources and VCS components are already configured using the 

wizard.

■ you clicked Modify Service Group in the wizard options panel.
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2 Specify the dependency between the applications.

You must have at least two resources configured for Application 

Dependency panel to appear. Of the two resources, one should either be a 

GenericService or a Process resource.

■ From the Select Application list, select the application that would 

depend on other applications. The selected application becomes the 

parent application.

■ From the Available Applications list, select the application on which 

the parent application would depend and click the right-arrow icon to 

move the application to the Child Applications list.

■ To remove an application from the Child Applications list, select the 

application in the list and click the left arrow.

■ Repeat these steps for all such applications for which you want to 

create a dependency.

■ Click Next.

The Application Dependency panel enables you to link resources configured 

using the wizard. If these resources are dependent on other services outside 

the VCS environment, you should first configure resources for such services 

and then create the appropriate dependency.

3 Review the service group configuration.

The Resources box lists the configured resources. Click on a resource to 

view its attributes and their configured values in the Attributes box.
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■ The wizard assigns unique names to resources. Change names of 

resource, if required.

To edit a resource name, select the resource name and either click it or 

press the F2 key. Press Enter after editing each resource name. To 

cancel editing a resource name, press the Esc key.

■ To enable all the VMDg resources in the service group for fast failover, 

select the Enable FastFailOver attribute for all the VMDg resources in 

the service group checkbox.

For information about the FastFailOver attribute, see the Veritas 

Cluster Server Administrator’s Guide.

■ Click Next.

■ A message appears informing you that the wizard will run commands 

to modify the service group configuration. Click Yes.

The wizard starts running commands to create the service group. 

Various messages indicate the status of these commands. After the 

commands are executed, the completion dialog box appears.

4 In the completion panel, check Bring the service group online if you want to 

bring the service group online on the local system.

5 Click Finish to create the service group and exit the Application 

Configuration Wizard.
 

 

 

Verifying the cluster configuration
After completing the configuration, verify that failover occurs as desired.

To verify the configuration of a cluster, either move the online groups, or shut 

down an active cluster node.

■ Use Veritas Cluster Manager (Java Console) to switch all the service groups 

from one node to another.

■ Simulate a local cluster failover by shutting down an active cluster node.

To switch service groups

1 In the Veritas Cluster Manager (Java Console), click the cluster in the 

configuration tree, click the Service Groups tab, and right-click the service 

group icon in the view panel. 

■ Click Switch To, and click the appropriate node from the menu.

■ In the dialog box, click Yes. The service group you selected is taken 

offline on the original node and brought online on the node you 

selected.
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If there is more than one service group, you must repeat this step until 

all the service groups are switched.

2 Verify that the service group is online on the node you selected to switch to 

in step 1.

3 To move all the resources back to the original node, repeat step 1 for each of 

the service groups.

To shut down an active cluster node

1 Gracefully shut down or restart the cluster node where the service group is 

online.

2 In the Veritas Cluster Manager (Java Console) on another node, connect to 

the cluster.

3 Verify that the service group has failed over successfully, and is online on 

the next node in the system list.

4 If you need to move all the service groups back to the original node:

■ Restart the node you shut down in step 1.

■ Click Switch To, and click the appropriate node from the menu.

■ In the dialog box, click Yes. 

The service group you selected is taken offline and brought online on 

the node that you selected.
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Chapter
 10
About Replicated Data 

Clusters

This chapter includes the following topics:

■ “About Replicated Data Clusters” on page 283

■ “How VCS Replicated Data Clusters work” on page 284

■ “Setting up a Replicated Data Cluster configuration” on page 286

■ “Migrating the service group” on page 288

About Replicated Data Clusters
A Replicated Data Cluster (RDC) uses data replication, instead of shared storage 

(VMDg) or non-shared storage (VMNSDg), to assure data access to all the nodes 

in a cluster. 

The Replicated Data Cluster configuration provides both local high availability 

and disaster recovery functionality in a single VCS cluster. You can set up RDC 

in a VCS environment using Veritas Volume Replicator (VVR).

An RDC exists within a single VCS cluster with a primary zone and a secondary 

zone, which can stretch over two buildings or data centers connected with 

Ethernet. In an RDC configuration, if an application or a system fails, the 

application is failed over to another system within the current primary zone. If 

the entire primary zone fails, the application is migrated to a system in the 

secondary zone (which then becomes the new primary).

For VVR replication to occur, the disk groups containing the Replicated Volume 

Group (RVG) must be imported at the primary and secondary zones. The 

replication service group must be online at both zones simultaneously, and must 

be configured as a hybrid VCS service group.
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Note: If you are creating a DR configuration manually in a non-shared storage 

environment, create a failover type of RVG service group.

The application service group is configured as a failover service group. You must 

configure the application service group with an online local hard dependency on 

the replication service group.

Note: VVR supports multiple replication secondary targets for any given 

primary. However, RDC for VCS supports only one replication secondary for a 

primary.

An RDC configuration is appropriate in situations where dual dedicated LLT 

links are available between the primary zone and the secondary zone but lack 

shared storage (VMDg) or non-shared storage (VMNSDg) or SAN interconnect 

between the primary and secondary data centers. In an RDC, data replication 

technology provides node access to data in a remote zone. 

You must use dual dedicated LLT links between the replicated nodes.

How VCS Replicated Data Clusters work
To understand how a RDC configuration works, let us look at an application 

configured in a VCS replicated data cluster. The configuration has two system 

zones:

■ Primary zone (zone 0) comprising nodes located at the primary site and 

attached to the primary storage

■ Secondary zone (zone 1) comprising nodes located at the secondary site and 

attached to the secondary storage

The application is installed and configured on all nodes in the cluster. The 

application data is located on shared disks within each RDC zone and is 

replicated across RDC zones to ensure data concurrency. The application service 
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group is online on a system in the current primary zone and is configured to fail 

over in the cluster.

If the system or application fails, VCS attempts to fail over the application 

service group to another system within the same RDC system zone. However, if 

VCS cannot find a failover target node within the primary zone, VCS switches 

the service group to a node in the current secondary system zone (zone 1). VCS 

also redirects clients once the application is online on the new location.

While this example required using shared storage, you can also set up an RDC 

cluster that uses non-shared storage. This involves installing and configuring 

the application on a single system in each of the RDC zones. The application 

data is located on the local disks attached to the system within each RDC zone. 

The data is replicated between the systems across the RDC zones to ensure 

concurrency.

The application service group is online on the single node in the primary RDC 

zone (Zone 0). In the event of a failure, VCS switches the service group to the 

node in the secondary RDC zone (Zone 1). Data replication ensures that the 

application is able to successfully handle client requests from the new node.

Figure 10-1 shows failover in a replicated data cluster using non-shared storage.
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Figure 10-1 Failover in a replicated data cluster using non-shared storage

Setting up a Replicated Data Cluster configuration
In the example, the application is configured as a VCS service group in a 

four-node cluster, with two nodes in the primary RDC zone and two in the 

secondary RDC zone. If a failure occurs on the primary node, VCS can fail over 

the application to the second node in the primary zone. 

The process involves the following tasks:

■ Setting up replication

■ Configuring the service groups

Setting up replication
Set up replication between the shared disk groups. Use VVR to group the shared 

data volumes into a Replicated Volume Group, and creating the VVR Secondary 

on hosts in your secondary zone.

Create a Replicated Data Set (RDS) with the Primary RVG consisting of the 

shared volumes between the nodes in the first zone and Secondary RVG 

consisting of shared volumes between nodes in the second zone. Therefore, use 

the same Disk Group and RVG name in both zones so that the MountV resources 

will mount the same block devices.
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Configuring the service groups
For a successful wide-area failover, the mount points and applications must fail 

over to the secondary RDC zone. Additionally, the VVR secondary disk group 

and RVG must be imported and started on the secondary RDC zone. 

The following screen from the VCS Cluster Manager (Java Console) depicts a 

typical application service group RDC configuration. This example uses the SQL 

Server application; however, the basic concepts are same, regardless of the 

application.
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The following screen from the VCS Cluster Manager (Java Console) depicts a 

typical replication service group (RVG) configuration, again using SQL Server as 

an example:

Migrating the service group
In the RDC configuration, consider a case where the primary RDC zone suffers a 

total failure of the shared storage (VMDg) or non-shared storage (VMNSDg). In 

this situation, none of the nodes in the primary zone see any device.

The service group cannot fail over locally within the primary RDC zone, because 

the shared volumes cannot be mounted on any node. So, the service group must 

fail over to a node in the current secondary RDC zone.

The RVGPrimary agent ensures that VVR volumes are made writable. The 

application can be started at the secondary RDC zone and run there until the 

problem with the local storage is corrected.

If the storage problem is corrected, you can switch the application back to the 

primary zone using VCS.

Before you switch the application back to the original primary RDC zone, you 

must resynchronize any changed data from the active secondary RDC zone since 

the failover. Once the resynchronization completes, switch the service group to 

the primary zone.
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To switch the service group

1 In the Service Groups tab of the of the Cluster Explorer configuration tree, 

right-click the service group.

2 Click Switch To and select the system in the primary RDC zone to switch to.

3 Click OK.
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Deploying Replicated Data 

Clusters: New application 

installation

This chapter includes the following topics:

■ “Tasks for a new replicated data cluster installation—additional 

applications” on page 292

■ “Reviewing the requirements” on page 294

■ “Reviewing the configuration” on page 301

■ “Configuring the storage hardware and network” on page 302

■ “Installing Veritas Storage Foundation HA for Windows” on page 303

■ “Configuring VxSAS” on page 313

■ “Configuring the cluster” on page 315

■ “Configuring disk groups and volumes” on page 327

■ “Installing and configuring the application or server role” on page 335

■ “Configuring the service group” on page 337

■ “Creating the primary system zone for the application service group” on 

page 377

■ “Verifying the installation in the primary zone” on page 378

■ “Creating a parallel environment in the secondary zone” on page 379

■ “Adding the systems in the secondary zone to the cluster” on page 380

■ “Setting up the Replicated Data Sets (RDS)” on page 386

■ “Configuring a RVG service group for replication” on page 398
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■ “Setting a dependency between the service groups” on page 409

■ “Adding the nodes from the secondary zone to the RDC” on page 410

■ “Verifying the RDC configuration” on page 421

■ “Additional instructions for GCO disaster recovery” on page 423

Tasks for a new replicated data cluster 
installation—additional applications

Configure the high availability and application components on the primary and 

secondary zones, then complete the Replicated Data Set solution by configuring 

the components for both zones. 

For more information on VVR, see the Veritas Volume Replicator Administrator’s 

Guide.

Table 11-1 outlines the high-level objectives and the tasks to complete each 

objective:

Table 11-1 Task List: New RDC configuration 

Objective Tasks

“Reviewing the 

requirements” on page 294

Verifying hardware and software prerequisites

“Reviewing the 

configuration” on page 301

■ Understanding active/passive configuration and 

zone failover in a RDC environment

■ Reviewing the sample configuration

“Configuring the storage 

hardware and network” on 

page 302

■ Setting up the storage hardware for a cluster 

environment

■ Verifying the DNS entries for the systems on which 

the application will be installed

“Installing Veritas Storage 

Foundation HA for 

Windows” on page 303

■ Verifying the driver signing option for the system

■ Installing Veritas Storage Foundation for Windows 

HA (automatic installation)

■ Selecting the option to install VVR; this will also 

automatically install the Veritas Cluster Server 

Agent for VVR

■ If applicable, selecting the option to install the 

Veritas Cluster Server Agent for your application

“Configuring VxSAS” on 

page 313

■ Using the VVR Security Service Configuration 

wizard to configure the VxSAS service for VVR
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“Configuring the cluster” on 

page 315

■ Verifying static IP addresses and name resolution 

configured for each node

■ Configuring cluster components using the VCS 

Cluster Configuration Wizard (VCW)

■ Setting up secure communication for the cluster

“Configuring disk groups and 

volumes” on page 327

■ Planning your storage layout

■ Create disk groups

■ Create volumes

■ Managing disk groups and volumes

“Installing and configuring 

the application or server 

role” on page 335

Installing and configuring the application or server role 

on the cluster nodes

“Configuring the service 

group” on page 337

■ Using the applicable wizard to create and configure 

the VCS service group

■ Creating the application service group manually 

using templates from the Cluster Manager (Java 

Console) (if using a non-shared storage 

configuration)

■ Bringing the service group online

“Creating the primary 

system zone for the 

application service group” on 

page 377

In the VCS console, selecting the service group and 

configuring the primary zone nodes as zone 0

“Verifying the installation in 

the primary zone” on 

page 378

■ Simulating failover

■ Switching online nodes

“Creating a parallel 

environment in the 

secondary zone” on page 379

■ Reviewing the prerequisites

■ Reviewing the configuration

■ Configuring the network and storage

■ Installing SFW HA

■ Configuring disk groups and volumes for the 

application, matching the configuration on the 

primary zone

■ Adding the secondary nodes to the cluster

■ Installing and configuring the application or server 

role

“Setting up the Replicated 

Data Sets (RDS)” on page 386

Using the Setup Replicated Data Set Wizard to create RDS 

and start replication for the primary and secondary zones

Table 11-1 Task List: New RDC configuration (Continued)

Objective Tasks
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Reviewing the requirements
Before you install Veritas Storage Foundation HA for Windows, make sure that 

your configuration meets the following requirements. This replication recovery 

solution requires installation and configuration at a primary zone and a 

secondary zone.

Disk space requirements
The following table estimates disk space requirements for SFW HA.

 

Requirements for Veritas Storage Foundation 
High Availability for Windows (SFW HA)

Before installing Veritas Storage Foundation High Availability for Windows 

(SFW HA), ensure that you review the following:

“Configuring a RVG service 

group for replication” on 

page 398

■ Creating a Replicated Volume Group (RVG) service 

group

■ Configuring the RVG service group

“Setting a dependency 

between the service groups” 

on page 409

Setting up an online local hard dependency of the 

application service group (the parent) on the RVG service 

group (the child) 

“Adding the nodes from the 

secondary zone to the RDC” 

on page 410

■ Using the Volume Replicator Agent Configuration 

Wizard to add the nodes from the secondary zone to 

the RVG service group 

■ Configuring the secondary nodes as zone 1

■ Configuring the IP resources for failover

“Verifying the RDC 

configuration” on page 421

Verifying that failover occurs first within zones and then 

from the primary to the secondary zone

Table 11-1 Task List: New RDC configuration (Continued)

Objective Tasks

Table 11-2 Disk space requirements

Installation options Required disk space

SFW HA + all options 832 MB

Client components 916 MB
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■ Review the general installation requirements for SFW HA in the Veritas 

Storage Foundation and High Availability Solutions for Windows Installation 

and Upgrade Guide.

■ Review the SFW HA Hardware Compatibility List to confirm supported 

hardware:

http://www.symantec.com/docs/TECH152806

■ Review the SFW HA Software Compatibility List to confirm supported 

software:

http://www.symantec.com/docs/TECH201485

Note: Solutions wizards cannot be used to perform Disaster Recovery, Fire 

Drill, or Quick Recovery remotely on Windows Server Core systems.

■ Review the operating systems supported with Veritas Storage Foundation 

High Availability for Windows (SFW HA).

■ When installing SFW HA for a Disaster Recovery configuration, ensure that 

you select the VCS Global Clustering Option and if required for your 

replication solution, select the SFW Veritas Volume Replicator option.

■ When installing SFW HA for a Replicated Data Cluster configuration, ensure 

that you select the VCS option to install Veritas Volume Replicator.

Supported operating systems
SFW and SFW HA have client and server components that run on specific 

Windows operating systems.

SFW and SFW HA software for servers

Your system must run one of the operating systems listed to install the SFW or 

SFW HA server software.

Note: SFW software for servers supports Hyper-V and parent partitions. SFW 

HA software for servers does not support Hyper-V and parent partitions.

The following table shows supported operating systems.

Table 11-3 Supported operating systems

Windows Server Platform Edition Version

Windows Server 2012 x64 Standard, Datacenter GA

http://www.symantec.com/docs/TECH152806
http://www.symantec.com/docs/TECH201485
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SFW and SFW HA software for clients

The SFW or SFW HA client software can be installed on any one of the operating 

system versions, editions, and architectures that the Server Components are 

supported on, except Server Core.

The following table shows the additional client operating systems that are 

supported.

Windows 2012 Server Core x64 GA

Table 11-4 Additional supported client operating systems

Windows Client Platform Edition Version

Windows XP x86, x64 SP3 required 

for x86; SP2 

required for 

x64

Windows Vista x86, x64 Ultimate, Business, Premium SP1 or SP2 

required

Windows 7 x86, x64 Professional, Ultimate RTM or SP1 

required

Windows 8 x86, x64 Windows 8, Windows 8 Pro GA

Table 11-3 Supported operating systems

Windows Server Platform Edition Version
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System requirements for SFW HA
Systems must meet the following requirements for SFW HA:

■ Memory must be a minimum 4 GB of RAM per server for SFW HA.

■ Shared disks to support applications that migrate between nodes in the 

cluster. Campus clusters require more than one array for mirroring. Disaster 

recovery configurations require one array for each site. Replicated data 

clusters with no shared storage are also supported.

If your storage devices are SCSI-3 compliant, and you wish to use SCSI-3 

Persistent Group Reservations (PGR), you must enable SCSI-3 support using 

the Veritas Enterprise Administrator (VEA). See the Veritas Storage 

Foundation Administrator’s Guide for more information.

■ SCSI, Fibre Channel, iSCSI host bus adapters (HBAs), or iSCSI Initiator 

supported NICs to access shared storage.

■ A minimum of two NICs is required. One NIC will be used exclusively for 

private network communication between the nodes of the cluster. The 

second NIC will be used for both private cluster communications and for 

public access to the cluster. Symantec recommends three NICs.

See “Best practices for SFW HA” on page 300.

■ NIC teaming is not supported for the VCS private network.

Network requirements for SFW HA
SFW HA has the following network requirements:

■ Do not install SFW HA on servers that are assigned the role of a Domain 

Controller. Configuring a cluster on a domain controller is not supported.

■ Ensure that your firewall settings allow access to ports used by SFW HA 

wizards and services. For a detailed list of services and ports used by SFW 

HA, refer to the Veritas Storage Foundation and High Availability Solutions 

for Windows Installation and Upgrade Guide.

■ Static IP addresses are required for certain purposes when configuring high 

availability or disaster recovery solutions. For IPv4 networks, ensure that 

you have the addresses available to enter. For IPv6 networks, ensure that the 

network advertises the prefix so that addresses are autogenerated. Static IP 

addresses are required for the following purposes:

■ One static IP address per site for each application virtual server.

■ A minimum of one static IP address for each physical node in the 

cluster.
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■ One static IP address per cluster used when configuring Notification or 

the Global Cluster Option. The same IP address may be used for all 

options.

■ For VVR replication in a disaster recovery configuration, a minimum of 

one static IP address per site for each application instance running in 

the cluster.

■ For VVR replication in a Replicated Data Cluster configuration, a 

minimum of one static IP address per zone for each application 

instance running in the cluster.

■ Configure name resolution for each node.

■ Verify the availability of DNS Services. AD-integrated DNS or BIND 8.2 or 

higher are supported.

Make sure a reverse lookup zone exists in the DNS. Refer to the application 

documentation for instructions on creating a reverse lookup zone.

■ DNS scavenging affects virtual servers configured in SFWHA because the 

Lanman agent uses Dynamic DNS (DDNS) to map virtual names with IP 

addresses. If you use scavenging, then you must set the DNSRefreshInterval 

attribute for the Lanman agent. This enables the Lanman agent to refresh 

the resource records on the DNS servers.

See the Veritas Cluster Server Bundled Agents Reference Guide.

■ In an IPv6 environment, the Lanman agent relies on the DNS records to 

validate the virtual server name on the network. If the virtual servers 

configured in the cluster use IPv6 addresses, you must specify the DNS 

server IP, either in the network adapter settings or in the Lanman agent’s 

AdditionalDNSServers attribute.

■ If Network Basic Input/Output System (NetBIOS) is disabled over the TCP/IP, 

then you must set the Lanman agent’s DNSUpdateRequired attribute to 1 

(True).
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IPv6 support

For IPv6 networks, the following is supported:

Note: Support is limited to mixed mode (IPv4 and IPv6) network configurations 

only; a pure IPv6 environment is currently not supported.

Permission requirements for SFW HA
The following permissions are required:

■ You must be a domain user.

■ You must be a member of the local Administrators group on all nodes where 

you are installing.

■ You must have write permissions for the Active Directory objects 

corresponding to all the nodes.

■ If you plan to create a new user account for the VCS Helper service, you must 

have Domain Administrator privileges or belong to the Account Operators 

group. If you plan to use an existing user account context for the VCS Helper 

service, you must know the password for the user account.

■ If User Access Control (UAC) is enabled on Windows Server systems, then 

you cannot log on to VEA GUI with an account that is not a member of the 

Types of addresses The following types of IPv6 addresses are supported:

■ Unicast addresses

Only Global Unicast and Unique Local Unicast addresses are 

supported.

■ Automatic configuration

Only Stateless IPv6 address configuration is supported. In 

stateless mode, the IP address is configured automatically 

based on router advertisements. The prefix must be 

advertised.

LLT over UDP LLT over UDP is supported on both IPv4 and IPv6.

You can use the Cluster Configuration Wizard (VCW) to configure 

LLT over UDP over IPv6.

VCS agents, wizards, 

and other 

components

VCS agents that require an IP address attribute and wizards that 

configure or discover IP addresses now support IPv6 addresses (of 

the type described above).

The VCS High Availability Engine (HAD) and the Global Cluster 

resource (WAC) also support IPv6 addresses.
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Administrators group, such as a guest user. This happens because such user 

does not have the "Write" permission for the "Veritas" folder in the 

installation directory (typically, C:\Program Files\Veritas). As a 

workaround, an OS administrator user can set "Write" permission for the 

guest user using the Security tab of the "Veritas" folder's properties.

Additional requirements for SFW HA
Please review the following additional requirements:

■ Installation media for all products and third-party applications.

■ Licenses for all products and third-party applications.

■ For a Replicated Data Cluster, install only in a single domain.

Best practices for SFW HA
Symantec recommends that you perform the following tasks:

■ Verify that you have three network adapters (two NICs exclusively for the 

private network and one for the public network).

When using only two NICs, lower the priority of one NIC and use the 

low-priority NIC for public and private communication.

Note: If you wish to use Windows NIC teaming, you must select the Static 

Teaming mode. Only the Static Teaming mode is currently supported.

■ Route each private NIC through a separate hub or switch to avoid single 

points of failure.

■ NIC teaming is not supported for the VCS private network.

■ Verify that your DNS server is configured for secure dynamic updates. For 

the Forward and Reverse Lookup Zones, set the Dynamic updates option to 

"Secure only". (DNS > Zone Properties > General tab)

■ This is applicable for a Replicated Data Cluster configuration.

You can configure single node clusters as the primary and secondary zones. 

However, if using a shared storage configuration, you must create the disk 

groups as clustered disk groups. If you cannot create a clustered disk group 

due to the unavailability of disks on a shared bus, use the vxclus 

UseSystemBus ON command.
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Note: Although you can use a single node cluster as the primary and secondary 

zones, you must create the disk groups as clustered disk groups. If you cannot 

create a clustered disk group due to the unavailability of disks on a shared bus, 

use the vxclus UseSystemBus ON command.

Reviewing the configuration
During the configuration process you will create virtual IP addresses for the 

following:

■ Application virtual server; this IP address should be the same on all nodes at 

the primary and secondary zones

■ Replication IP address for the primary zone

■ Replication IP address for the secondary zone

Before you start deploying your environment, you should have these IP 

addresses available.

Sample configuration
The sample setup has four servers, two for the primary zone and two for the 

secondary zone. The nodes will form two separate clusters, one at the primary 

zone and one at the secondary zone. 

The procedures in this section are illustrated by a sample deployment and use 

the following names to describe the objects created and used during the 

installation and configuration. These names apply to the FileShare application. 

If you work with a different application, your names will be different.

Table 11-5 RDC configuration objects

Object Name Description

Primary zone

SYSTEM1 & SYSTEM2 First and second nodes of the primary zone

FS File Share server name

FS_SG File Share service group

FS_SG_DG Disk group names

FS_REPLOG Replicator log volume required by VVR

Secondary zone
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Configuring the storage hardware and network
Use the following procedures to configure the hardware and verify DNS 

settings. Repeat this procedure for every node in the cluster.

To configure the hardware

1 Install the required network adapters, and SCSI controllers or Fibre Channel 

HBA.

2 Connect the network adapters on each system.

■ To prevent lost heartbeats on the private networks, and to prevent VCS 

from mistakenly declaring a system down, Symantec recommends 

disabling the Ethernet autonegotiation options on the private network 

adapters. Contact the NIC manufacturer for details on this process.

■ Symantec recommends removing TCP/IP from private NICs to lower 

system overhead.

3 Use independent hubs or switches for each VCS communication network 

(GAB and LLT). You can use cross-over Ethernet cables for two-node 

clusters. LLT supports hub-based or switch network paths, or two-system 

clusters with direct network links.

4 Verify that each system can access the storage devices. Verify that each 

system recognizes the attached shared disk and that the attached shared 

disks are visible.

To verify the DNS settings and binding order for Windows Server systems

1 Open the Control Panel (Start > Control Panel).

2 Click Network and Internet, and then click Network and Sharing Center.

3 In the Network and Sharing Center window, on the left side of the screen 

under Tasks, double-click Manage network connections.

SYSTEM3 & SYSTEM4 First and second nodes of the secondary zone

All the other parameters are the same as on the primary zone.

RDS and VVR 

Components

FS_RVG RVG name for File Share server

Table 11-5 RDC configuration objects

Object Name Description
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4 Ensure the public network adapter is the first bound adapter:

■ From the Advanced menu in the Network Connections window, click 

Advanced Settings.

■ In the Adapters and Bindings tab, verify the public adapter is the first 

adapter in the Connections list. If necessary, use the arrow button to 

move the adapter to the top of the list.

■ Click OK.

5 Open the Public status dialog box by doing one of the following in the 

Network Connections window:

■ Double-click the adapter for the public network.

■ Right-click the adapter for the public network and click Status.

■ Select the adapter for the public network and click View status of this 

connection in the toolbar.

When enabling DNS name resolution, make sure that you use the public 

network adapters, and not those configured for the VCS private network.

6 In the Public Status dialog box, on the General tab, click Properties.

7 In the Public Properties dialog box, on the General tab:

■ Select the Internet Protocol Version 4 (TCP/IPv4) or Internet Protocol 

Version 6 (TCP/IPv6) check box, depending on which protocol your 

network is using.

■ Click Properties.

8 Select the Use the following DNS server addresses option.

9 Verify the correct value for the IP address of the DNS server.

10 Click Advanced.

11 In the DNS tab, make sure the Register this connection’s address in DNS 

check box is selected.

12 Make sure the correct domain suffix is entered in the DNS suffix for this 

connection field.

13 Click OK.
 

Installing Veritas Storage Foundation HA for 
Windows

You can install SFW HA using either the product installer wizard or the 

command line interface (CLI). Before you begin to install the product, ensure 
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that you have reviewed and performed the required preinstallation and 

planning tasks.

Note: The Windows MPIO feature must be enabled for Windows Server before 

you proceed with SFW HA installation.

During the installation you can choose to separately install the server 

components or the client components. If you choose to install the server 

components, the following components are installed by default.

Table 11-6 List of options installed by default

Option Description

Client components Installs the VCS Java Console on the same node where 

the server components are installed.

High Availability Hardware 

Replication Agents

■ Veritas Cluster Server Hardware Replication 

Agent for EMC MirrorView

Enables VCS to manage MirrorView replicated 

devices.

■ Veritas Cluster Server Hardware Replication 

Agent for EMC SRDF

Enables VCS to manage SRDF replicated devices. 

■ Veritas Cluster Server Hardware Replication 

Agent for EMC SRDFSTAR

Enables VCS to manage SRDFSTAR replicated 

devices.

■ Veritas Cluster Server Hardware Replication 

Agent for Hitachi TrueCopy

Enables VCS to manage TrueCopy replicated 

devices.

■ Veritas Cluster Server Hardware Replication 

Agent for MetroMirror

Enables VCS to manage MetroMirror replicated 

devices.

High Availability Database 

Agents

■ Veritas Cluster Server Database Agent for SQL 

Server—installs the VCS agent for SQL Server 

2008, 2008 R2, and 2012
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Note: The high availability agents that get installed with the product software 

are also available in the form of an agent pack. The agent pack is released on a 

quarterly basis. The agent pack includes support for new applications as well as 

fixes and enhancements to existing agents. You can install the agent pack on an 

existing SFW HA installation. Refer to the Symantec Operations Readiness 

Tools (SORT) website for information on the latest agent pack availability.  
https://sort.symantec.com 
Refer to the agent-specific configuration guide for more details about the 

application agents.

To install the server components,

See “Installing SFW HA server components using the product installer” on 

page 305.

To install the client components,

See “Installing the client components using the product installer” on page 311.

Installing SFW HA server components using the product installer
Use the following procedure to install SFW HA server components using the 

product installer.

Ensure that there are no parallel installations, live updates, or Microsoft 

Windows updates in progress.

During installation, some product features are installed by default and others 

must be selected, as follows:

■ For a disaster recovery configuration, select the VCS global cluster (GCO) 

option. 

■ If you plan to use Veritas Volume Replicator (VVR) for replication, select the 

SFW VVR option. 

■ If you plan to use the Fast Failover feature, select the VCS Fast Failover 

option.

To install SFW HA server components using the product installer

1 Insert the disc containing the installation software into your system’s disk 

drive or download the installation software from the Symantec website.

https://fileconnect.symantec.com

2 Allow the autorun feature to start the installation or double-click Setup.exe. 

The CD browser appears.
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Note: If you are installing the software using the product software disc, the 

CD browser displays the installation options for all the products specified 

earlier. However, if you are downloading the installation package from the 

Symantec website, the CD browser displays the installation options only for 

the product to be installed.

3 Click to download the required contents.

Note: The client components are installed by default along with the server 

components. However, on a server core machine, the client components will 

not be installed.

4 On the Welcome panel, review the list of prerequisites and click Next.

5 On the License panel, read the license terms, select I accept the terms of 

License Agreement, and then click Next.

6 On the System Selection panel, select the systems and the desired 

Installation and Product options.

You can select the systems in one of the following ways:

■ In the System Name or IP text box, manually type the system name or 

its IP address and click Add.

Storage Foundation HA 

for Windows

Click to install the server and client components for 

SFW HA.

Late Breaking News Click to access the latest information about updates, 

patches, and software issues regarding this release.

Windows Data Collector Click to verify that your configuration meets all 

pertinent software and hardware requirements.

SORT Click to access the Symantec Operations Readiness 

Tools site.

In addition to the product download you can also 

download the custom reports about your computer 

and Symantec enterprise products, a checklist 

providing configuration recommendations, and 

system and patch requirements to install or upgrade 

your software.

Browse Content Click to view the software disc contents.

Technical Support Click to contact Symantec Technical Support.
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Note: The wizard does not support IPv6. To add systems having IPv6, 

you must type the system name.

The local host is populated by default.

■ Alternatively, browse to select the systems.

The systems that belong to the domain in which you have logged in are 

listed in the Available Systems list. Select one or more systems and 

click the right arrow to move them to the Selected Systems list. Click 

OK.

Once you add or select a system, the wizard performs certain validation 

checks and notes the details in the Verification Details box. To review the 

details, select the desired system.

To select the installation and product options, perform the following tasks 

on each of the selected systems.

Note: To apply the selection to multiple systems, select the system for 

which you have selected the installation and product options and then click 

Apply to multiple systems. 
See “Applying the selected installation and product options to multiple 

systems” on page 310.

■ By default the wizard uses %ProgramFiles%\Veritas as the 

installation directory. To customize the installation directory, click 

Browse and select the desired location. Click OK.

■ Select the required license type from the License key drop-down list.

Note: The default license type is “Keyless”.

If you select the "Keyless" license type, all the available product options 

are displayed and are selected by default.

If you select "User entered license key" as your license type, the License 

Details panel appears by default. On the License Details panel, enter the 

license key and then click Add. You can add multiple licenses for the 

various product options you want to use.

The wizard validates the entered license keys and displays the relevant 

error if the validation fails. After the validation is complete, click OK.



308 Deploying Replicated Data Clusters: New application installation

Installing Veritas Storage Foundation HA for Windows
■ From the list of product options, select the appropriate options to be 

installed. The options differ depending on your product and 

environment.

Storage 

Foundation 

Options

■ Veritas Volume Replicator (VVR): Replicates data 

across multiple sites for disaster recovery.

■ FlashSnap: Allows you to create and maintain 

split-mirror, persistent snapshots of volumes and 

application components. FlashSnap supports VSS 

based snapshots to provide application data in a 

consistent state after the application is restored.

■ Replace Disk Management Snap-in with SFW VEA 

GUI: Replaces the Disk Management Snap-in in the 

Windows Computer Management console and the 

Server Manager console with the Veritas Enterprise 

Administrator GUI for Windows Server.
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7 On the System Selection panel, click Next. 

Note that the wizard fails to proceed with the installation unless all the 

selected systems have passed the validation checks and are ready for 

installation. If the validation checks have failed on any of the systems, 

review the details and rectify the issue. Before you choose to proceed with 

DMP Device 

Specific Modules

■ 3PARDATA array (V3PAR)

■ Dell Compellent array (VCOMPLNT)

■ Dell EqualLogic array (VEQLOGIC)

■ EMC cx4240 array (VEMCCLAR)

■ EMC VMAX array (VEMCSYMM)

■ Hitachi VSP array (VHDSAA)

■ HP P6000 array (VHPEVA)

■ IBM DS8000 array (VIBMAADS)

■ IBM XiV Storage System (VXIV)

Symantec maintains a Hardware Compatibility List (HCL), 

which provides information on HBAs and firmware that 

have been tested with each supported array. Check the HCL 

for details about your hardware before installing or using 

DMP DSMs.

The HCL is located at:

http://www.symantec.com/docs/TECH152806

Note: Do not use a DMP DSM together with a third-party 

DSM for the same array. Only one DSM at a time can claim 

the LUNs in an array. According to Microsoft Multipath I/O 

(MPIO) documentation, if multiple DSMs are installed, the 

Microsoft MPIO framework contacts each DSM to 

determine which is appropriate to handle a device. There is 

no particular order in which the MPIO framework contacts 

the DSMs. The first DSM to claim ownership of the device is 

associated with that device. Other DSMs cannot claim an 

already claimed device. Therefore, to ensure that the DMP 

DSM claims the LUNs of an array, no other DSM should be 

installed for that same array.

Veritas Cluster 

Server Options

■ Global Cluster Option (GCO): Enables you to link the 

clusters located in different geographies. This 

provides wide-area failover and disaster recovery.

■ Fast Failover: Improves the failover time taken by 

storage resources during the service group failovers, in 

a clustered environment. Fast failover is particularly 

noticeable in clusters having multiple storage stacks 

configured, typically over 20 disk groups and over 150 

volumes.

http://www.symantec.com/docs/TECH152806
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the installation, select the system and click Re-verify to re-initiate the 

validation checks for this system.

8 On the Pre-install Summary panel, review the summary and click Next. 

Note that the Automatically reboot systems after installer completes 

operation check box is selected by default. This will reboot all the selected 

remote systems immediately after the installation is complete on the 

respective system. If you do not want the wizard to initiate this auto reboot, 

clear the selection of Automatically reboot systems after installer 

completes operation check box. 

9 On the Installation panel, review the progress of installation and click Next 

after the installation is complete.

If an installation is not successful on any of the systems, the status screen 

shows a failed installation.

10 On the Post-install Summary panel, review the installation result and click 

Next.

If the installation has failed on any of the systems, refer to the log file for 

details. You may have to re-install the software.

11 On the Finish panel, click Finish.

If you chose to initiate the auto reboot, a confirmation message to reboot 

the local system appears. Click Yes to reboot immediately or No to reboot 

later.

If you did not choose to initiate the auto reboot, ensure that you manually 

reboot these systems.

This completes the product installation. 

Applying the selected installation and product options to 
multiple systems

The following procedure gives details on applying options to multiple systems.

To apply the selected installation and product options to multiple systems

1 Click on any one of the selected systems and select the desired installation 

and product options.

2 Click Apply to multiple systems.

3 On the Apply Installation Options panel, select the installation options to be 

applied and then select the desired systems. Click OK.
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Installing the client components using the product installer
Use the following procedure to install SFW HA client components using the 

product installer.

Note: Client components cannot be installed on server core systems.

Before you begin the installation, ensure that there are no parallel installations, 

live updates, or Microsoft Windows updates in progress on the system where 

you want to install the client components.

To install SFW HA client components using the product installer

1 Insert the software disk containing the installation package into your 

system's disc drive or download the installation package from the following 

Symantec Web site.

https://fileconnect.symantec.com

2 Allow the autorun feature to start the installation or double-click Setup.exe.

The CD browser appears.

3 Click to download the required contents.

4 On the Welcome panel, review the list of prerequisites and click Next.

Veritas Storage 

Foundation HA for 

Windows

Click to install the server or client components for 

SFW HA.

Late Breaking News Click to access the latest information about updates, 

patches, and software issues regarding this release.

Windows Data Collector Click to verify that your configuration meets all 

pertinent software and hardware requirements.

SORT Click to access the Symantec Operations Readiness 

Tools site.

In addition to the product download you can also 

download the custom reports about your computer 

and Symantec enterprise products, a checklist 

providing configuration recommendations, and 

system and patch requirements to install or upgrade 

your software.

Browse Content Click to view the software disc contents.

Technical Support Click to contact Symantec Technical Support.
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5 On the License Agreement panel, read the license terms, select I accept the 

terms of License Agreement, and then click Next.

6 On the System Selection panel, select the systems and the installation 

directory.

You can select the systems in one of the following ways:

■ In the System Name or IP text box, manually type the system name or 

its IP address and click Add.

Note: The wizard does not support IPv6. To add the systems having 

IPv6, you must type the system name.

Local host is populated by default.

■ Alternatively, browse to select the systems.

The systems that belong to the domain in which you have logged in are 

listed in the Available Systems list. Select one or more systems and 

click the right arrow to move them to the Selected Systems list. Click 

OK.

Once you add or select a system, the wizard performs certain validation 

checks and notes the details in the Verification Details box. To review the 

details, select the desired system.

By default the wizard uses %ProgramFiles%\Veritas as the installation 

directory. To customize the installation directory, click Browse and select 

the desired location. Click OK.

To apply the customized directory to multiple systems, click Apply to 

multiple systems. On the Apply Installation Options panel, select the 

systems to apply the customized directory. Click OK.

7 On the System Selection panel, click Next.

Note that the wizard fails to proceed with the installation unless all the 

selected systems have passed the validation checks and are ready for 

installation. If the validation checks have failed on any of the system, 

review the details and rectify the issue. Before you choose to proceed with 

the installation select the system and click Re-verify to re-initiate the 

validation checks for this system.

8 On the Pre-install Summary panel, review the summary and click Next.

9 On the Installation panel, review the progress of installation and click Next 

after the installation is complete.

If an installation is not successful on any of the systems, the status screen 

shows a failed installation.

10 On the Post-install Summary panel, review the installation result and click 

Next.
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If the installation has failed on any of the system, refer to the log file for 

details. You may have to re-install the software.

11 On the Finish panel, click Finish.

This completes the installation of the client components.
 

Configuring VxSAS
You can run the VVR Security Service Configuration (VxSAS) wizard after you 

install SFW HA on both the primary and secondary nodes. When you run the 

wizard, you can then specify the primary and secondary sites in one step.

Complete the following procedure to configure the VxSAS service for VVR.

The procedure has these prerequisites:

■ You must be logged on with administrative privileges on the server for the 

wizard to be launched.

■ The account you specify must have administrative and log-on as service 

privileges on all the specified hosts.

■ Avoid specifying blank passwords. In a Windows Server environment, 

accounts with blank passwords are not supported for log-on service 

privileges.

■ Make sure that the hosts on which you want to configure the VxSAS service 

are accessible from the local host.

Note: For details on this required service, see Veritas Storage Foundation Veritas 

Volume Replicator Administrator’s Guide.

To configure the VxSAS service

1 Launch the VVR Security Service Configuration Wizard.

Click Start > All Programs > Symantec > Veritas Storage Foundation > 

Configuration Wizards > VVR Security Service Configuration Wizard.

or 

Type vxsascfg.exe at the command prompt.

2 Read the information provided on the Welcome page and click Next.

3 Complete the Account Information panel as follows and then click Next:

Account name 

(domain\account)

Enter the administrative account name.

Password Specify a password.
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If you have already configured the VxSAS service for one host that is 

intended to be a part of the RDS, make sure you specify the same username 

and password when configuring the VxSAS service on the other hosts.

4 On the Domain Selection panel, select the domain to which the hosts that 

you want to configure belong and then click Next:

5 On the Host Selection panel, select the required hosts:

Selecting domains The Available domains pane lists all the domains that are 

present in the Windows network neighborhood.

Move the appropriate name from the Available domains list 

to the Selected domains list, either by double-clicking it or 

using the arrow button.

Adding a domain If the domain name that you require is not displayed, click 

Add domain. This displays a dialog that allows you to 

specify the domain name. Click Add to add the name to the 

Selected domains list.

Selecting hosts The Available hosts pane lists the hosts that are present in 

the specified domain.

Move the appropriate host from the Available hosts list to 

the Selected hosts list, either by double-clicking it or using 

the arrow button. Use the Shift key with the up or down 

arrow keys to select multiple hosts.
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After you have selected a host name, the Configure button is enabled. Click 

Configure to proceed with configuring the VxSAS service.

6 After the configuration completes, the Configuration Results page displays 

whether or not the operation was successful. If the operation was not 

successful, the page displays the details on why the account update failed, 

along with the possible reasons for failure and recommendations on getting 

over the failure.

When configuring the VxSAS service for VVR in a firewall setup, the VxSAS 

wizard may not be able to configure the machines that are across the 

firewall, although the Host Selection dialog may list these nodes. In this 

case, configure the VxSAS service locally on the machines that are across 

the firewall.

Click Back to change any information you had provided earlier.

7 Click Finish to exit the wizard.
 

Configuring the cluster 
After you install SFW HA using the installer, set up the components required to 

run a cluster. The VCS Cluster Configuration Wizard (VCW) does the following:

■ Sets up the cluster infrastructure, including LLT and GAB

■ Configures Symantec Product Authentication Service in the cluster

■ Configures the ClusterService group, which contains resources for 

notification and global clusters

Before you create a cluster, do the following:

■ Verify that each node uses static IP addresses (DHCP is not supported) and 

that name resolution is configured for each node.

■ Set the required privileges:

■ You must have administrator privileges on the system where you run 

the wizard. The user account must be a domain account.

■ You must have administrative access to all systems selected for cluster 

operations. Add the domain user to the Local Administrators group of 

each system.

Adding a host If the host name you require is not displayed, click Add 

host. In the Add Host dialog specify the required host name 

or IP in the Host Name field. Click Add to add the name to 

the Selected hosts list.
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■ If you plan to create a new user account for the VCS Helper service, you 

must have Domain Administrator privileges or belong to the Domain 

Account Operators group. If you plan to use an existing user account 

for the VCS Helper service, you must know the password for the user 

account.

■ When configuring a user account for the VCS Helper service, make sure 

that the user account is a domain user. The VCS HAD, which runs in the 

context of the local system built-in account, uses the VCS Helper 

service user context to access the network. This account does not 

require domain admin privileges.

■ Make sure the VCS Helper service domain user account has “Add 

workstations to domain” privilege enabled in the Active Directory.

For complete installation and configuration details on VCS, and additional 

instructions on removing or modifying cluster configurations, see the Veritas 

Cluster Server Administrator’s Guide.

Note: Add only systems in the primary zone (zone 0) to the cluster at this time.

To configure a VCS cluster

1 Start the VCS Cluster Configuration Wizard.

Click Start > All Programs > Symantec > Veritas Cluster Server > 

Configuration Tools > Cluster Configuration Wizard.

2 Read the information on the Welcome panel and click Next.

3 On the Configuration Options panel, click Cluster Operations and click 

Next.
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4 On the Domain Selection panel, select or type the name of the domain in 

which the cluster resides and select the discovery options.

Do one of the following:

■ To discover information about all systems and users in the domain:

■ Clear the Specify systems and users manually check box.

■ Click Next.

■ Proceed to step 8 on page 318.

■ To specify systems and user names manually (recommended for large 

domains):

■ Check the Specify systems and users manually check box.

Additionally, you may instruct the wizard to retrieve a list of 

systems and users in the domain by selecting appropriate check 

boxes.

■ Click Next.

■ If you chose to retrieve the list of systems, proceed to step 6 on 

page 318. Otherwise, proceed to the next step.

5 On the System Selection panel, type the name of each system to be added, 

click Add, and then click Next.

Do not specify systems that are part of another cluster.

Proceed to step 8 on page 318.
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6 On the System Selection panel, specify the systems for the cluster and then 

click Next. Do not select systems that are part of another cluster.

Enter the name of the system and click Add to add the system to the 

Selected Systems list, or click to select the system in the Domain Systems 

list and then click the > (right-arrow) button.

7 The System Report panel displays the validation status, whether Accepted 

or Rejected, of all the systems you specified earlier. Review the status and 

then click Next.

Click on a system name to see the validation details. If you wish to include a 

rejected system, rectify the error based on the reason for rejection and then 

run the wizard again.

A system can be rejected for any of the following reasons:

■ System is not pingable.

■ WMI access is disabled on the system.

■ Wizard is unable to retrieve the system architecture or operating 

system.

■ VCS is either not installed on the system or the version of VCS is 

different from what is installed on the system on which you are 

running the wizard.

8 On the Cluster Configuration Options panel, click Create New Cluster and 

click Next.



319Deploying Replicated Data Clusters: New application installation

Configuring the cluster
9 On the Cluster Details panel, specify the details for the cluster and then 

click Next.

10 The wizard validates the selected systems for cluster membership. After the 

systems are validated, click Next.

Cluster Name Type a name for the new cluster. Symantec recommends a 

maximum length of 32 characters for the cluster name.

Cluster ID Select a cluster ID from the suggested cluster IDs in the 

drop-down list or type a unique ID for the cluster. The 

cluster ID can be any number from 0 to 65535.

Caution: If you chose to specify systems and users manually in 

step 4 or if you share a private network between more than one 

domain, make sure that the cluster ID is unique.

Operating System From the drop-down list select the operating system.

All the systems running Windows Server 2012 are displayed.

Available Systems Select the systems that you wish to configure in the cluster.

Check the Select all systems check box to select all the 

systems simultaneously.

The wizard discovers the network interface cards (NICs) on 

the selected systems. For single-node clusters with the 

required number of NICs, the wizard prompts you to 

configure a private link heartbeat. In the dialog box, click 

Yes to configure a private link heartbeat.
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If a system is not validated, review the message associated with the failure 

and restart the wizard after rectifying the problem.

If you chose to configure a private link heartbeat in the earlier step, proceed 

to the next step. Otherwise, proceed to step 12 on page 322.

11 On the Private Network Configuration panel, configure the VCS private 

network and then click Next.

You can configure the VCS private network either over ethernet or over the 

User Datagram Protocol (UDP) layer using IPv4 or IPv6 network.

Do one of the following:

■ To configure the VCS private network over the ethernet, complete the 

following steps:

■ Select Configure LLT over Ethernet.

■ Select the check boxes next to the two NICs to be assigned to the 

private network. You can assign a maximum of eight network 

links.

Symantec recommends reserving two NICs exclusively for the 

private network. However, you could lower the priority of one of 

the NICs and use the low-priority NIC for both public and private 

communication.

■ If you have only two NICs on a selected system, it is recommended 

that you lower the priority of at least one NIC that will be used for 

private as well as public network communication.

To lower the priority of a NIC, right-click the NIC and select Low 

Priority from the pop-up menu.
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Note: If you wish to use Windows NIC teaming, you must select the 

Static Teaming mode. Only the Static Teaming mode is currently 

supported.

■ If your configuration contains teamed NICs, the wizard groups 

them as "NIC Group #N" where "N" is a number assigned to the 

teamed NIC. A teamed NIC is a logical NIC, formed by grouping 

several physical NICs together. All NICs in a team have an identical 

MAC address. Symantec recommends that you do not select 

teamed NICs for the private network.

The wizard configures the LLT service (over ethernet) on the selected 

network adapters.

■ To configure the VCS private network over the User Datagram Protocol 

(UDP) layer, complete the following steps:

■ Select Configure LLT over UDP on IPv4 network or Configure LLT 

over UDP on IPv6 network depending on the IP protocol that you 

wish to use.

The IPv6 option is disabled if the network does not support IPv6.

■ Select the check boxes next to the two NICs to be assigned to the 

private network. You can assign a maximum of eight network 

links. Symantec recommends reserving at least two adapters 

exclusively for the VCS private network.

■ For each selected NIC, verify the displayed IP address. If a selected 

NIC has multiple IP addresses assigned, double-click the field and 
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choose the desired IP address from the drop-down list. In case of 

IPv4, each IP address can be in a different subnet.

The IP address is used for the VCS private communication over the 

specified UDP port.

■ Specify a unique UDP port for each of the link. Click Edit Ports if 

you wish to edit the UDP ports for the links. You can use ports in 

the range 49152 to 65535. The default ports numbers are 50000 

and 50001 respectively. Click OK.

For each selected NIC, double-click the respective field in the Link 

column and choose a link from the drop-down list. Specify a 

different link (Link1 or Link2) for each adapter. Each link is 

associated with a UDP port that you specified earlier.

The wizard configures the LLT service (over UDP) on the selected 

network adapters. The specified UDP ports will be used for the private 

network communication.

12 On the VCS Helper Service User Account panel, specify a domain user 

account for the VCS Helper service. The VCS high availability engine (HAD), 

which runs in the context of the local system built-in account, uses the VCS 

Helper service user context to access the network.

This account does not require Domain Administrator privileges.

Specify a domain user as follows:

■ To specify an existing user, do one of the following:

■ Click Existing user and select a user name from the drop-down list
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■ If you chose not to retrieve the list of users in step 4 on page 317, 

type the user name in the Specify User field, and then click Next.

■ To specify a new user, click New user and type a valid user name in the 

Create New User field, and then click Next.

Do not append the domain name to the user name; do not type the user 

name as Domain\user or user@domain.

■ In the Password dialog box, type the password for the specified user 

and click OK, and then click Next.

13 On the Configure Security Service Option panel, specify the security options 

for the cluster communications and then click Next.

Do one of the following:

■ To use VCS cluster user privileges, click Use VCS User Privileges and 

then type a user name and password.

The wizard configures this user as a VCS Cluster Administrator. In this 

mode, communication between cluster nodes and clients, including the 

Cluster Manager (Java Console), occurs using the encrypted VCS cluster 

administrator credentials. The wizard uses the VCSEncrypt utility to 

encrypt the user password.

The default user name for the VCS administrator is admin and the 

password is password. Both are case-sensitive. You can accept the 

default user name and password for the VCS administrator account or 

type a new name and password.

Symantec recommends that you specify a new user name and 

password.

■ To configure a secure cluster using the single sign-on feature, click Use 

Single Sign-on.

In this mode, the VCS Authentication Service is used to secure 

communication between cluster nodes and clients by using digital 

certificates for authentication and SSL to encrypt communication over 

the public network. VCS uses SSL encryption and platform-based 

authentication. The VCS high availability engine (HAD) and Veritas 

Command Server run in secure mode.

The wizard configures all the cluster nodes as root brokers (RB) and

authentication brokers (AB). Authentication brokers serve as 

intermediate registration and certification authorities. Authentication 

brokers have certificates signed by the root. These brokers can 

authenticate clients such as users and services. The wizard creates a 

copy of the certificates on all the cluster nodes.

14 Review the summary information on the Summary panel, and click 

Configure.
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The wizard configures the VCS private network. If the selected systems 

have LLT or GAB configuration files, the wizard displays an informational 

dialog box before overwriting the files. In the dialog box, click OK to 

overwrite the files. Otherwise, click Cancel, exit the wizard, move the 

existing files to a different location, and rerun the wizard.

The wizard starts running commands to configure VCS services. If an 

operation fails, click View configuration log file to see the log.

15 On the Completing Cluster Configuration panel, click Next to configure the 

ClusterService group; this group is required to set up components for 

notification and for global clusters.

To configure the ClusterService group later, click Finish.

At this stage, the wizard has collected the information required to set up the 

cluster configuration. After the wizard completes its operations, with or 

without the ClusterService group components, the cluster is ready to host 

application service groups. The wizard also starts the VCS engine (HAD) 

and the Veritas Command Server at this stage.

Note: After configuring the cluster you must not change the names of the 

nodes that are part of the cluster. If you wish to change a node name, run 

this wizard to remove the node from the cluster, rename the system, and 

then run this wizard again to add that system to the cluster.

16 On the Cluster Service Components panel, select the components to be 

configured in the ClusterService service group and click Next.

■ Check the Notifier Option check box to configure notification of 

important events to designated recipients.

See “Configuring notification” on page 325.

■ Check the GCO Option check box to configure the wide-area connector 

(WAC) process for global clusters. The WAC process is required for 

inter-cluster communication.

Configure the GCO Option using this wizard only if you are configuring 

a Disaster Recovery (DR) environment and are not using the Disaster 

Recovery wizard.

Refer to the Veritas Cluster Server Administrator’s Guide for details on 

configuring GCO using the cluster configuration wizard.

You can configure the GCO Option using the DR wizard. The Disaster 

Recovery chapters discuss how to use the Disaster Recovery wizard to 

configure the GCO option.
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Configuring notification
This section describes steps to configure notification.

To configure notification

1 On the Notifier Options panel, specify the mode of notification to be 

configured and click Next.

You can configure VCS to generate SNMP (V2) traps on a designated server 

and send emails to designated recipients in response to certain events.

2 If you chose to configure SNMP, specify information about the SNMP 

console and click Next.
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■ Click a field in the SNMP Console column and type the name or IP 

address of the console. The specified SNMP console must be MIB 2.0 

compliant.

■ Click the corresponding field in the Severity column and select a 

severity level for the console.

■ Click ‘+’ to add a field; click ‘-’ to remove a field.

■ Enter an SNMP trap port. The default value is “162”.

3 If you chose to configure SMTP, specify information about SMTP recipients 

and click Next.

■ Type the name of the SMTP server.

■ Click a field in the Recipients column and enter a recipient for 

notification. Enter recipients as admin@example.com.

■ Click the corresponding field in the Severity column and select a 

severity level for the recipient. VCS sends messages of an equal or 

higher severity to the recipient.

■ Click + to add fields; click - to remove a field.



327Deploying Replicated Data Clusters: New application installation

Configuring disk groups and volumes
4 On the Notifier Network Card Selection panel, specify the network 

information and click Next.

■ If the cluster has a ClusterService service group configured, you can 

use the NIC resource configured in the service group or configure a new 

NIC resource for notification.

■ If you choose to configure a new NIC resource, select a network adapter 

for each node in the cluster. The wizard lists the public network 

adapters along with the adapters that were assigned a low priority.

5 Review the summary information and choose whether you want to bring the 

notification resources online when VCS is started.

6 Click Configure.

7 Click Finish to exit the wizard.
 

Configuring disk groups and volumes
A dynamic disk group is a collection of one or more disks that behave as a single 

storage repository. Within each disk group, you can have dynamic volumes with 

different RAID layouts. 

Use Veritas Storage Foundation for Windows to create disk groups and dynamic 

volumes for the application on the shared storage (VMDg) or non-shared storage 

(VMNSDg). 
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Note: If your storage devices are SCSI-3 compliant, and you wish to use SCSI-3 

Persistent Group Reservations (PGR), you must enable SCSI-3 support using the 

Veritas Enterprise Administrator (VEA - Control Panel - System Settings). See the 

Veritas Storage Foundation Administrator’s Guide for more information.

Configuring disk groups and volumes involves the following tasks:

■ “Planning disk groups and volumes” on page 328

■ “Creating dynamic disk groups” on page 329

■ “Creating dynamic volumes” on page 331

Planning disk groups and volumes
The requirements for disk groups and volumes depend on the type of 

application or server role. Review the requirements and best practices for your 

application or server role:

■ Planning your File Share storage

■ Planning your IIS storage

■ Planning your storage for additional applications

Planning your File Share storage

Considerations for planning the File Share storage include the following:

■ The disk group and volumes for the file server shared directory must be 

configured on shared storage (VMDg) or non-shared storage (VMNSDg).

■ When you configure a new set up, create the disk groups and volumes on the 

shared storage (VMDg) or non-shared storage (VMNSDg) first, then create 

the directory structure for the file shares.

■ For an existing configuration that has a file server with shares on the local 

storage, move these shares to the shared storage (VMDg) or non-shared 

storage (VMNSDg) using the practices recommended by Microsoft.

Planning your IIS storage

Considerations for planning the IIS storage include the following:

■ The disk groups and volumes which will host the directory and files for the 

web sites must be on the shared storage (VMDg) or non-shared storage 

(VMNSDg).

■ For a new IIS installation, the directory for the web sites must be created on 

volumes on the shared storage (VMDg) or non-shared storage (VMNSDg).
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■ For existing web sites, stop the sites and then move the web site content to 

volumes on the shared storage (VMDg) or non-shared storage (VMNSDg). 

You must also reconfigure the home directory location for the web site in IIS 

and then restart the web site again.

Planning your storage for additional applications

The information in this section is generic to any application. Make sure that you 

create the appropriate disk groups and volumes to hold the application data. If 

your application requires replication of registry keys between the cluster 

systems, Symantec recommends that you create a dedicated RegRep volume so 

that its MountV dependency is not linked with any other application-specific 

resources in the group. 

Decide how you want to organize the disk groups and the number and type of 

volumes you want to create. Considerations include the following:

■ The number of disk groups that are needed

The number of disk groups depends on your application and the planned 

organization of the data. VCS requires that you install the application 

program files on the local system drive of the server. Data files and other 

related files, such as logs, are placed on the shared storage (VMDg) or 

non-shared storage (VMNSDg). Typically, a main organizational unit in 

your application would be contained in a single disk group.

■ The type of volumes you want to create.

■ Mirrored and RAID-5 volumes provide fault tolerance for critical data. 

■ Striped volumes add performance capability. 

■ Volumes that are both mirrored and striped offer both performance 

and fault tolerance.

Note: If you plan to use replication software, such as VVR, do not use 

software RAID-5 volumes. This does not apply to hardware RAID-5.

Recommendations: 

■ Use mirrored volumes for logs.

■ Use striped or mirrored striped volumes for data.

■ The implications of backup and restore operations for the disk group setup.

■ The sizes of databases and logs, which depend on the traffic load.

Creating dynamic disk groups
Follow the steps in this section to create one or more disk groups for your 

application.
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Note: Dynamic disks belonging to a Microsoft Disk Management Disk Group do 

not support cluster disk groups.

To create a dynamic disk group

1 Open the VEA console by clicking Start > All Programs > Symantec > Veritas 

Storage Foundation > Veritas Enterprise Administrator (or launch the VEA 

from the Solutions Configuration Center) and select a profile if prompted.

2 Click Connect to a Host or Domain.

3 In the Connect dialog box, select the host name from the pull-down menu 

and click Connect.

To connect to the local system, select localhost. Provide the user name, 

password, and domain if prompted.

4 To start the New Dynamic Disk Group wizard, expand the tree view under 

the host node, right click the Disk Groups icon, and select New Dynamic Disk 

Group from the context menu.

5 In the Welcome screen of the New Dynamic Disk Group wizard, click Next.

6 Provide information about the cluster disk group:

■ Enter the disk group name (for example, DG1).

■ Check the Create cluster group check box if you wish to create cluster 

dynamic disk groups that are used in a shared storage environment.
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■ Select the appropriate disks in the Available disks list, and use the Add 

button to move them to the Selected disks list.

Optionally, check the Disk names prefix checkbox and enter a disk 

name prefix to give the disks in the disk group a specific identifier.

For example, entering TestGroup as the prefix for a disk group that 

contains three disks creates TestGroup1, TestGroup2, and TestGroup3 

as internal names for the disks in the disk group.

Note: For Windows Server operating systems, Windows Disk Management 

Compatible Dynamic Disk Group creates a type of disk group that is created 

by Windows Disk Management (LDM).

■ Click Next.

7 Click Next to accept the confirmation screen with the selected disks.

8 Click Finish to create the dynamic disk group.
 

Creating dynamic volumes
After you create the disk groups, make the disks within them usable by creating 

the dynamic volumes that will store data.

To create dynamic volumes

1 If the VEA console is not already open, click Start > All Programs > 

Symantec > Veritas Storage Foundation > Veritas Enterprise Administrator 

and select a profile if prompted.

2 Click Connect to a Host or Domain.

3 In the Connect dialog box select the host name from the pull-down menu 

and click Connect.

To connect to the local system, select localhost. Provide the user name, 

password, and domain if prompted.

4 To start the New Volume wizard, expand the tree view under the host node 

to display all the disk groups. Right click a disk group and select New 

Volume from the context menu.

You can right-click the disk group you have just created.

5 At the New Volume wizard opening screen, click Next.

6 Select the disks for the volume.

■ Make sure the appropriate disk group name appears in the Group name 

drop-down list.

■ For Site Preference, leave the setting as Siteless (the default).
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■ Automatic disk selection is the default setting. To manually select the 

disks, click Manually select disks and use the Add and Remove buttons 

to move the appropriate disks to the Selected disks list. Manual 

selection of disks is recommended.

■ You may also check Disable Track Alignment to disable track alignment 

for the volume. Disabling Track Alignment means that the volume does 

not store blocks of data in alignment with the boundaries of the 

physical track of the disk.

■ Click Next.

7 Specify the volume attributes.

■ Enter a volume name. The name is limited to 18 ASCII characters and 

cannot contain spaces or forward or backward slashes.

■ Select a volume layout type. To select mirrored striped, click both the 

Mirrored checkbox and the Striped radio button.

■ If you are creating a striped volume, the Columns and Stripe unit size 

boxes need to have entries. Defaults are provided.

■ Provide a size for the volume.

■ If you click on the Max Size button, a size appears in the Size box that 

represents the maximum possible volume size for that layout in the 

dynamic disk group.

■ In the Mirror Info area, select the appropriate mirroring options. 

■ Click Next.

8 In the Add Drive Letter and Path dialog box, assign a drive letter or mount 

point to the volume. You must use the same drive letter or mount point on 
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all systems in the cluster. Make sure to verify the availability of the drive 

letter before assigning it. 

■ To assign a drive letter, select Assign a Drive Letter, and choose a drive 

letter.

■ To mount the volume as a folder, select Mount as an empty NTFS 

folder, and click Browse to locate an empty folder on the disk.

9 Click Next.

10 Create an NTFS file system.
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■ Make sure the Format this volume checkbox is checked and click NTFS.

■ Select an allocation size or accept the Default.

■ The file system label is optional. SFW makes the volume name the file 

system label.

■ Select Perform a quick format if you want to save time.

■ Select Enable file and folder compression to save disk space. Note that 

compression consumes system resources and performs encryption and 

decryption, which may result in reduced system performance.

■ Click Next.

11 Click Finish to create the new volume.

12 Repeat these steps to create additional volumes.

Create the cluster disk group and volumes on the first node of the cluster 

only.
 

Managing the disk group and volumes
This section includes the following procedures:

■ Importing a disk group and mounting a shared volume

■ Unmounting a volume and deporting a disk group

During the process of setting up an SFW environment, refer to these general 

procedures for managing disk groups and volumes:

■ When a disk group is initially created, it is imported on the node where it is 

created.

■ A disk group can be imported on only one node at a time. 

■ To move a cluster dynamic disk group from one node to another, unmount 

the volumes in the disk group, deport the disk group from its current node, 

import it to a new node and mount the volumes.

Importing a disk group and mounting a volume
Use the VEA Console to import a disk group and mount a volume.

To import a disk group

1 From the VEA Console, right-click a disk name in a disk group or the group 

name in the Groups tab or tree view.

2 From the menu, click Import Dynamic Disk Group.
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To mount a volume

1 If the disk group is not imported, import it.

2 To verify if a disk group is imported, from the VEA Console, click the Disks 

tab and check if the status is imported.

3 Right-click the volume, click File System, and click Change Drive Letter and 

Path.

4 Select one of the following options in the Drive Letter and Paths dialog box 

depending on whether you want to assign a drive letter to the volume or 

mount it as a folder.

■ To assign a drive letter

Select Assign a Drive Letter, and select a drive letter.

■ To mount the volume as a folder

Select Mount as an empty NTFS folder, and click Browse to locate an 

empty folder on the shared disk.

5 Click OK.

Unmounting a volume and deporting a disk group
Use the VEA Console to unmount a volume and deport a disk group.

To unmount a volume and deport the dynamic disk group

1 From the VEA tree view, right-click the volume, click File System, and click 

Change Drive Letter and Path.

2 In the Drive Letter and Paths dialog box, click Remove. Click OK to continue.

3 Click Yes to confirm.

4 From the VEA tree view, right-click the disk group, and click Deport Dynamic 

Disk Group.

5 Click Yes.
 

Installing and configuring the application or server 
role

This section provides considerations for installing and configuring your 

application or server role. It includes the following topics:

■ Configuring a File Share server role

■ Installing and configuring the IIS application
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■ Installing additional applications

Configuring a File Share server role
When you configure a File Share server role, keep in mind the following:

■ Configure the disk group and volumes for the file server shared directory on 

the shared storage (VMDg) or non-shared storage (VMNSDg).

■ When you configure a new setup, create the disk group and volumes on the 

shared storage (VMDg) or non-shared storage (VMNSDg) first, then create 

the directory structure for the file shares.

■ For an existing configuration that has a file server with shares on the local 

storage, move these shares to the shared storage (VMDg) or non-shared 

storage (VMNSDg) using the practices recommended by Microsoft.

■ The FileShare agent is installed automatically with SFW HA.

Installing and configuring the IIS application
When you install and configure the IIS application, keep in mind the following:

■ Install and configure IIS identically on all nodes hosting the service group. 

The sites to be monitored must be on the shared storage (VMDg) or 

non-shared storage (VMNSDg).

■ Import the disk group and mount the volumes that contain the web site 

data, on the first node. 

■ For a new IIS installation, while you are creating new web sites, create the 

site folder on the shared storage (VMDg) or non-shared storage (VMNSDg) 

and place the site content in that folder. 

■ Change the default home directory path for all the IIS sites to be monitored 

to a location on the shared storage (VMDg) or non-shared storage 

(VMNSDg). For instructions, see the IIS documentation. 

■ For existing web sites, stop the sites and then move the web site content to 

volumes on the shared storage (VMDg) or non-shared storage (VMNSDg). 

Reconfigure the home directory location for the web site in IIS and then 

restart the web site again.

■ Verify the port numbers assigned to IIS sites are not used by other 

applications or sites. 

■ Synchronize the IIS configuration on all nodes hosting the service group.
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Installing additional applications
The following are some very generic points for installing any application:

■ Before you install the application, make sure that the disk group and 

volumes are mounted on the node.

■ VCS requires the application program files to be installed on the same local 

drive on all nodes. For example, if you install the application program files 

on drive C of one node, installation of these same files on all other nodes 

must be on drive C. 

■ Make sure that the same drive letter is available on all nodes and has 

adequate space for the installation.

■ You should install the data files and any associated files, such as log files, on 

the shared storage (VMDg) or non-shared storage (VMNSDg).

Configuring the service group
You can use the Application Configuration Wizard to configure any application 

for which application specific wizards have not been provided. Depending on the 

application that you have installed, complete the appropriate procedure to 

configure the following service groups:

■ Configuring the file share service group

■ Configuring the IIS service group

■ Configuring the service group for any additional applications

Configuring the file share service group
To configure the File Share service group, you create a FileShare service group 

and define the attribute values for its resources. After you create the service 

group, you must configure the shares to mount automatically at startup.

Prerequisites

■ Verify that you have local administrator privileges on the system where you 

run the wizard.

■ If you have configured a firewall, add the following to the firewall exceptions 

list:

■ Port 14150 or the VCS Command Server service, 

%vcs_home%\bin\CmdServer.exe

Here, %vcs_home% is the installation directory for VCS, typically 

C:\Program Files\Veritas\Cluster Server.
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■ Port 14141

For a detailed list of services and ports used by SFW HA, refer to the Veritas 

Storage Foundation and High Availability Solutions for Windows Installation 

and Upgrade Guide.

■ Verify that the VCS high availability engine, HAD, is running on the system 

from which you run the wizard.

■ Verify that the directories to be shared reside on shared drives.

■ Mount the drives containing the shared directories on the system where you 

run the wizard. Unmount the drives from other systems in the cluster.

■ Verify that Veritas Command Server service is running on all systems in the 

cluster.

■ Verify that you have the following information ready. The wizard will 

prompt you for this information:

■ A unique virtual computer name to be assigned to the file share server.

This is the name by which clients will access the server. The virtual 

name must not exceed 16 characters. If you specify a virtual computer 

name in lowercase letters, the name is converted to uppercase. For 

example, the name VCSServer is converted to VCSSERVER.

■ A unique virtual IP address to be assigned to the file share server.

The virtual IP address is required only if you wish to configure an IPv4 

address. In case of IPv6, the wizard prompts you to select the IPv6 

prefix and automatically generates an IPv6 address that is valid and 

unique on the network. The wizard uses the prefix that is advertised by 

the router on the IPv6 network.

Note: Windows Server does not support accessing file shares using the 

virtual IP address. 
You can work around this restriction by using non-scoped file shares. 

For more information: 
See “Creating non-scoped file shares configured with VCS” on 

page 181. 
See “Making non-scoped file shares accessible while using virtual 

server name or IP address if NetBIOS and WINS are disabled” on 

page 182.

■ The list of directories to be shared.

The wizard enables you to add existing shares to the VCS 

configuration. However, you cannot add special shares (shares created 

by the operating system for administrative and system use). For 

example, you cannot add the shares ADMIN$, print$, IPC$, and 

DriveLetter$ to the VCS configuration.
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■ On Windows Server Core, you have to add the required resources and 

configure the service group manually. You can perform the steps either 

directly on the Server Core machine using the command line, or remotely 

using the Cluster Manager (Java console).

Refer to the Veritas Cluster Server Administrator’s Guide for instructions on 

using the command line and the Cluster Manager (Java Console).

Note: If User Access Control (UAC) is enabled on Windows Server systems, 

you must launch the command prompt in the Run as administrator mode 

and then run the VCS commands.

■ Before configuring the service group, review the resource types and the 

attribute definitions of the FileShare agent, described in the Veritas Cluster 

Server Bundled Agents Reference Guide.

■ If your storage is SCSI-3 compliant and you wish to use SCSI-3 persistent 

reservations, enable SCSI-3 support using Veritas Enterprise Administrator 

(VEA).
 

Creating the file share service group

For information on resource types, attribute definitions, resource dependencies, 

and sample service group configurations, refer to the Veritas Cluster Server 

Bundled Agents Reference Guide.

If you are using a non-shared storage configuration (dynamic disk groups 

configured on local disks), you have to configure the service group manually 

either using the Cluster Manager (Java Console) or the command line. The 

wizard currently cannot configure resources (VMNSDg agent) required for 

monitoring non-shared storage.

See “Configuring the service group in a non-shared storage environment” on 

page 157.

To configure a FileShare

1 Start the File Share Configuration Wizard. Click Start > All Programs > 

Symantec > Veritas Cluster Server > Configuration Wizards > File Share 

Configuration Wizard.

2 Review the information in the Welcome panel and click Next.

3 On the Wizard Options panel, click Create service group and click Next.
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4 On the Service Group Configuration panel, specify the service group details 

and then click Next. The wizard then starts validating your configuration. 

Various messages indicate the validation status.

5 On the File Share Configuration panel, specify the configuration 

information for the FileShare resources to be created and then click Next. 

Service Group Name Type a name for the File Share service group.

Group System List In the Available Cluster Systems list, select the systems 

on which to configure the service group and click the 

right arrow to move the systems to the service group’s 

system list.

To remove a system from the service group’s system list, 

click the system in the Systems in Priority Order box and 

click the left arrow.

To change a system’s priority in the service group’s 

system list, select the system in the Systems in Priority 

Order and click the up and down arrows.

System priority defines the order in which service 

groups are failed over to systems. The system at the top 

of the list has the highest priority while the system at 

the bottom of the list has the lowest priority.

Include selected 

systems in the service 

group's AutoStartList 

attribute

To enable the service group to automatically come online 

on one of the systems, select this checkbox.

For information about the AutoStartList attribute, see 

the Veritas Cluster Server Administrator’s Guide.
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The wizard begins validating your configuration. Various messages indicate 

the validation status.

Virtual Computer Name Type a unique virtual computer name by which the 

server will be known to clients. The virtual name 

must not exceed 16 characters.

List Shares Click List Shares to view the existing shares on the 

shared storage, then select a share and click Add.

You cannot add special shares (shares created

by the operating system for administrative and 

system use).

Path Click the field and either type the path of the 

directory to be shared or click the ellipsis button (...) 

to browse for a directory.

The selected directories must meet the following 

conditions:

■ The selected drive, the mount path, and the file path 

must not exist in the VCS configuration.

■ The directories to be shared must reside on shared, 

non-system drives.

The wizard validates the selected directory and 

displays an error message if the directory does not 

meet any of the conditions.
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Share Name If a selected directory is already shared, the Share 

Name column lists the names by which it is shared. 

You can select a listed share name to make an existing 

share highly available. You can also create a new 

share for the same directory by typing a new share 

name.

Remove To remove a file share from the configuration, click to 

select the file share and then click Remove.
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6 On the Share Permissions panel, select the file share, specify the users for 

the file shares and assign permissions to them, and then click Next.

Select the FileShare From the drop-down list, select the file share with which 

to associate user permissions, or select the default All 

FileShares to set the same permissions for all file shares.

Select the Permission From the drop-down list, select the permission to be 

associated with the user.

Select the User Click the ellipsis button (...), select a user, and click OK.

Add Click Add to add the specified user to the Selected Users 

list. By default, all selected users are given 

READ_ACCESS permission.

Selected Users Displays a list of selected users and the file share 

permissions. You can configure a maximum of 50 users 

for each file share. To configure more users, create a user 

group.

To change the file share permission associated with a 

user, click a user name in the Selected Users list and 

then select the desired permission from the Select the 

Permission drop-down list.

Remove To deny file share access to a user, click the user name in 

the Selected Users list and click Remove.
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7 On the Share Properties panel, set the share properties for the file shares 

and then click Next.

Select the FileShare From the drop-down list select a file share whose 

properties you wish to set.

Enable access-based 

enumeration for this 

file share

Check the Enable access-based enumeration check box 

to enable the Windows access-based enumeration 

feature on the selected file share.

User Limit Specify the number of users that are allowed access to 

the selected file share.

Choose from the following options:

■ Maximum allowed users: Select this option to allow 

access to the maximum numbers of users allowed on 

Windows.

■ Allow this number of users: Select this option and then 

type the number of users that you wish to grant access to 

the selected file share.

If you type zero or a value greater than what Windows 

supports, access is granted to the maximum allowed 

users on Windows.
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Enable cache Check the Enable cache check box to enable local 

caching of the contents of the selected file share.

Then, specify how the contents of the file share are 

available to users for offline access.

In the drop down list select from the following caching 

options:

■ Manual caching of files and programs: Only the files and 

programs specified by the user are available offline. This 

sets the FileShare resource attribute ClientCacheType to 

MANUAL.

■ Automatic caching of programs: All the files and 

programs that the users access from the file share are 

available offline. This sets the FileShare resource 

attribute ClientCacheType to DOCS.

■ Optimized automatic caching of files and programs: All 

files and programs, including executables, are cached 

locally. The next time the user accesses the executable 

files, they are launched from the local cache. This sets 

the FileShare resource attribute ClientCacheType to 

PROGRAMS.

Hide share Check the Hide Share check box to make the new share a 

hidden share.

Share all subfolder Check the Share all subfolders check box to share the 

subdirectories.

Hide child shares Check the Hide child shares check box to hide the shared 

subdirectories.

Apply these settings 

to

To apply the specified share properties to multiple file 

shares simultaneously, do the following:

1 Click the ellipsis (...) button.

2 On the Copy Share Properties dialog box, select the file 

shares from the Available Shares list and click the right 

arrow to move them to the Selected Shares list.

Note that only those files shares that are not already 

shared are available for selection.

3 Click OK.

Note: This option is not visible if you are configuring only one 

share in the service group.
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8 On the Network Configuration panel, specify information related to your 

network and then click Next.

Do the following:

■ Select IPv4 to configure an IPv4 address for the virtual server.

■ In the Virtual IP Address field, type a unique virtual IPv4 address 

for the virtual server.

■ In the Subnet Mask field, type the subnet to which the virtual IPv4 

address belongs.

■ Select IPv6 to configure an IPv6 address for the virtual server. The IPv6 

option is disabled if the network does not support IPv6.

■ Select the prefix from the drop-down list. The wizard uses the 

prefix and automatically generates an IPv6 address that is valid 

and unique on the network.

■ For each system in the cluster, select the public network adapter name. 

The Adapter Display Name field displays the TCP/IP enabled adapters 

on a system, including the private network adapters, if applicable. 

To view the adapters associated with a system, click the Adapter 

Display Name field and click the arrow. Verify that you select the adapters 

assigned to the public network, not the private.

■ Click Advanced Settings to specify additional details for the Lanman 

resource.
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On the Lanman Advanced Configuration dialog box, complete the 

following:

■ Check Active Directory Update required check box to enable the 

Lanman resource to update the Active Directory with the virtual 

name. This sets the Lanman agent attributes ADUpdateRequired 

and ADCriticalForOnline to true.

■ In the Organizational Unit field, type the distinguished name of 

the Organizational Unit for the virtual server in the format 

CN=containername,DC=domainname,DC=com.

To browse for an OU, click the ellipsis (...) button and search for the 

OU using the Windows Find Organization Units dialog box. By 

default, the Lanman resource adds the virtual server to the default 

container "Computers."

■ Click OK.

The user account for VCS Helper service must have adequate 

privileges on the specified container to create and update 

computer accounts.

9 On the Service Group Summary panel, review the service group 

configuration.

Click Next.

Click Yes on the message box that appears, informing you that the wizard 

will run commands to modify the service group configuration.

The wizard starts running commands to create the service group. Various 

messages indicate the status of these commands.

Resources Displays a list of configured resources. The wizard 

assigns unique names to resources. Change the names 

of resource, if required.

To edit a resource name, select the resource name and 

either click it or press the F2 key. Edit the resource 

name and then press the Enter key to confirm the 

changes. To cancel editing a resource name, press the 

Esc key.

Attributes Displays the attributes and their configured values for 

a resource selected in the Resources list.

Enable FastFailOver 

attribute for all the 

VMDg resources in the 

service group

To enable all the VMDg resources in the service group 

for fast failover, select this checkbox.

For information about the FastFailOver attribute, see 

the Veritas Cluster Server Administrator’s Guide.
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10 In the completion dialog box, check Bring the service group online check 

box if you want to bring the service group online on the local system, and 

then click Finish.

Creating non-scoped file shares configured with VCS

File shares configured with VCS on Windows Server are accessible only using 

the virtual server name (Lanman resource). These file shares are not accessible 

using the IP address.

The FileShare agent is enhanced to address this issue. The FileShare agent 

behavior can be controlled using the following registry key:

HKLM\SOFTWARE\VERITAS\VCS\BundledAgents\Lanman\<VirtualName>\ 
DisableServerNameScoping

Set the DisableServerNameScoping key to have the FileShare agent 

support non-scoped file shares.

You must create this registry key manually. Perform the following steps to 

create and set the DisableServerNameScoping registry key that is used by 

the FileShare agent to support non-scoped file shares.

Note: Incorrectly editing the registry may severely damage your system. Make a 

backup copy before making changes to the registry.

To configure DisableServerNameScoping registry parameter

1 To open the Registry Editor, click Start > Run, type regedit, and then click 

OK.

2 In the registry tree (on the left), navigate to 

HKLM\SOFTWARE\VERITAS\VCS\BundledAgents.

3 Click Edit > New > Key and create a key by the name Lanman, if it does not 

exist already.

4 Select the Lanman key and click Edit > New > Key and create a key by the 

name virtualName.

Here virtualName should be the virtual computer name assigned to the file 

share server. This is the VirtualName attribute of the Lanman resource in 

the file share service group.

The newly created registry key should look like this:

HKLM\SOFTWARE\VERITAS\VCS\BundledAgents\Lanman\virtualName

5 Select the key that you created in step 4 (virtualName) and add a DWORD 

type of value.

The value name should be DisableServerNameScoping and value data 

should be 1.
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The value 1 indicates that the FileShare and Lanman agents support 

non-scoped file shares on Windows Server systems.

6 If there are multiple file share service groups to be used in the non-scoped 

mode, repeat steps 4 and 5 for each Lanman resource that is configured in 

the file share service group.

You must create this key only for Lanman resources that are part of VCS file 

share service groups. Configuring this key for Lanman resources that are part of 

other VCS service groups may result in an unexpected behavior.

Making non-scoped file shares accessible while using virtual 
server name or IP address if NetBIOS and WINS are disabled

The VCS FileShare agent depends on NetBIOS or DNS to resolve the virtual 

name. If NetBIOS and WINS are disabled or the DNS is not updated, the agent is 

unable to resolve the virtual name.

This may typically occur when the file share service groups are configured to 

use localized IP addresses. When the service group is switched or failed over, the 

virtual name to IP address mapping changes. In such a case if WINS database or 

the DNS are not updated, the agent is unable to resolve the virtual name. As a 

result the FileShare resources fault and the shares become inaccessible.

The following message is seen in the agent log:

VCS INFO V-16-10051-10530 
FileShare:<servicegroupname>:online:Failed to access the network 
path (\\virtualname)

The FileShare agent is enhanced to address this issue. The FileShare agent 

behavior can be controlled using the following registry key:

HKLM\SOFTWARE\VERITAS\VCS\BundledAgents\Lanman\virtualName\DisableS
trictVirtualNameCheck

Set the DisableStrictVirtualNameCheck key to have the FileShare agent 

make the file shares accessible irrespective of whether or not the virtual name is 

resolvable. In case the virtual name is not resolvable, the file shares are 

accessible using the virtual IP.

You must create this registry key manually. Perform the following steps to 

create and set the DisableStrictVirtualNameCheck registry key that is 

used by the FileShare agent to disable virtual name availability as a requirement 

for file shares to be available on the network.

Note: Incorrectly editing the registry may severely damage your system. Make a 

backup copy before making changes to the registry.



350 Deploying Replicated Data Clusters: New application installation

Configuring the service group
To configure DisableStrictVirtualNameCheck registry parameter

1 To open the Registry Editor, click Start > Run, type regedit, and then click 

OK.

2 In the registry tree (on the left), navigate to 

HKLM\SOFTWARE\VERITAS\VCS\BundledAgents.

3 Click Edit > New > Key and create a key by the name Lanman, if it does not 

exist already.

4 Select the Lanman key and click Edit > New > Key and create a key by the 

name virtualName.

Here virtualName should be the virtual computer name assigned to the file 

share server. This is the VirtualName attribute of the Lanman resource in 

the file share service group.

The newly created registry key should look like this:

HKLM\SOFTWARE\VERITAS\VCS\BundledAgents\Lanman\virtualName

5 Select the key that you created in step 4 (virtualName) and add a DWORD 

type of value.

The value name should be DisableStrictVirtualNameCheck and 

value data should be 1.

6 If there are multiple file share service groups to be used in the non-scoped 

mode, repeat steps 4 and 5 for each Lanman resource that is configured in 

the file share service group.

7 Save and exit the Registry Editor.

You must create this key only for Lanman resources that are part of VCS file 

share service groups. Configuring this key for Lanman resources that are part of 

other VCS service groups may result in an unexpected behavior.
 

 

Configuring the IIS service group
To configure the IIS service group, you create an IIS service group and define the 

attribute values for its resources. After you create the service group, you must 

configure the shares to mount automatically at startup.

Prerequisites

■ Verify that you have local administrator privileges on the system where you 

run the wizard.

■ Verify IIS is installed and configured identically on all nodes hosting the 

service group. Verify the sites to be monitored are on shared storage.

■ For IIS 8.0 on Windows Server 2012, you must install the following 

components:
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■ IIS 6 Metabase Compatibility

■ IIS 6 WMI Compatibility

These options are available under Management Tools on the Role Services 

page of the Add Roles Wizard.

These components are required for the IIS agent to function on Windows 

Server 2012.

For IIS 8.0 on Windows Server Core, you must install IIS in the specified 

order. See “Installing IIS 8.0 on Windows Server Core” on page 352 for 

instructions.

■ If IIS configuration is using IPv6 addresses, then you must install the IIS 

Management Scripts and Tools role service.

IPv6 requires WMI 7 Provider that is part of the IIS Management Scripts 

and Tools role.

■ Do not use the IIS agent to configure SMTP and NNTP sites if you have 

Microsoft Exchange installed.

■ Change the default home directory path for all IIS sites to monitored to a 

location on the shared storage. See the IIS documentation for instructions.

■ Verify the port numbers assigned to IIS sites are not used by other 

programs.

■ If you have configured a firewall, add the following to the firewall exceptions 

list:

■ Port 14150 or the VCS Command Server service, 

%vcs_home%\bin\CmdServer.exe

Here, %vcs_home% is the installation directory for VCS, typically 

C:\Program Files\Veritas\Cluster Server.

■ Port 14141

For a detailed list of services and ports used by SFW HA, refer to the Veritas 

Storage Foundation and High Availability Solutions for Windows Installation 

and Upgrade Guide.

■ To configure IIS agent on Windows Server Core, you must manually add the 

required resources and configure the service group. You can perform the 

manual configuration steps either directly on the Server Core machine 

using the command line, or remotely using the Cluster Manager (Java 

console).

For instructions on using the command line and the Cluster Manager (Java 

Console), refer to the Veritas Cluster Server Administrator’s Guide.
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Note: If User Access Control (UAC) is enabled on Windows Server systems, 

you must launch the command prompt in the Run as administrator mode 

and then run the VCS commands.

■ Verify that the VCS high availability engine, HAD, is running on the system 

where you run the wizard.

■ Mount the drives containing the shared directories from the system from 

which you run the wizard. Unmount the drives from other systems in the 

cluster.

■ If your storage is SCSI-3 compliant and you wish to use SCSI-3 persistent 

reservations, enable SCSI-3 support using Veritas Enterprise Administrator 

(VEA).

■ Verify that you have the following information ready. The wizard will 

prompt you for this information:

■ IIS sites to be monitored.

■ Application pools associated with each site.

■ Port numbers associated with each site.

■ Virtual IP addresses and computer names associated with the sites. The 

virtual IP addresses and the virtual computer names must have 

forward and reverse entries in the DNS.

■ Before configuring the service group, review the resource types and the 

attribute definitions of the IIS agent, described in the Veritas Cluster Server 

Bundled Agents Reference Guide.

Installing IIS 8.0 on Windows Server Core

Complete the following steps.

To install IIS 8.0 on Windows Server Core

1 Type the following at the command prompt:

start /w pkgmgr 
/iu:IIS-WebServerRole;IIS-WebServer;IIS-CommonHttpFeatures; 
IIS-StaticContent;IIS-DefaultDocument;IIS-DirectoryBrowsing; 
IIS-HttpErrors;IIS-HttpRedirect;IIS-ApplicationDevelopment; 
IIS-ASP;IIS-CGI;IIS-ISAPIExtensions;IIS-ISAPIFilter; 
IIS-ServerSideIncludes;IIS-HealthAndDiagnostics; 
IIS-HttpLogging;IIS-LoggingLibraries;IIS-RequestMonitor; 
IIS-HttpTracing;IIS-CustomLogging;IIS-ODBCLogging;IIS-Security;
IIS-BasicAuthentication;IIS-WindowsAuthentication; 
IIS-DigestAuthentication; 
IIS-ClientCertificateMappingAuthentication; 
IIS-IISCertificateMappingAuthentication; 
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IIS-URLAuthorization;IIS-RequestFiltering;IIS-IPSecurity; 
IIS-Performance;IIS-HttpCompressionStatic; 
IIS-HttpCompressionDynamic;IIS-WebServerManagementTools; 
IIS-ManagementScriptingTools;IIS-IIS6ManagementCompatibility; 
IIS-Metabase;IIS-WMICompatibility;IIS-LegacyScripts; 
IIS-FTPPublishingService;WAS-WindowsActivationService; 
IIS-FTPPublishingService;IIS-FTPServer

2 Verify that all the components specified in the earlier step have successfully 

installed. Type the following at the command prompt:

notepad C:\windows\logs\cbs\cbd.log

This opens the log file, cbd.log, in the Notepad text editor.

3 Check the entries in the log file, cbd.log. The last log entry should resemble 

the following:

Info CBS Pkgmgr: return code: 0x0

This message indicates that all the components are installed successfully.

4 Run the oclist command to verify that the following components are 

installed: 

IIS-WebServerRole; IIS-WebServer; IIS-IIS6ManagementCompatibility; 

IIS-Metabase; IIS-WMICompatibility; IIS-FTPPublishingService; 

WAS-WindowsActivationService; IIS-FTPPublishingService; IIS-FTPServer

Type the following at the command prompt:

oclist

5 Repeat the steps on all the nodes on which you wish to configure the IIS 

service group.
 

Creating the IIS service group

If you are using a non-shared storage configuration (dynamic disk groups 

configured on local disks), you have to configure the service group manually 

either using the Cluster Manager (Java Console) or the command line. The 

wizard currently cannot configure resources (VMNSDg agent) required for 

monitoring non-shared storage.

See “Configuring the service group in a non-shared storage environment” on 

page 157.

To create an IIS service group

1 Start the File Share Configuration Wizard. Click Start > All Programs > 

Symantec > Veritas Cluster Server > Configuration Wizards > IIS 

Configuration Wizard.

2 Review the information in the Welcome panel and click Next.

3 On the Wizard Options panel, click Create service group and click Next.
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4 On the Service Group Configuration panel, specify the service group details 

and then click Next. The wizard then starts validating your configuration. 

Various messages indicate the validation status.

Service Group Name Type a name for the IIS service group.

Group System List In the Available Cluster Systems list, select the systems 

on which to configure the service group and click the 

right arrow to move the systems to the service group’s 

system list.

To remove a system from the service group’s system list, 

click the system in the Systems in Priority Order box and 

click the left arrow.

To change a system’s priority in the service group’s 

system list, select the system in the Systems in Priority 

Order and click the up and down arrows.

System priority defines the order in which service 

groups are failed over to systems. The system at the top 

of the list has the highest priority while the system at 

the bottom of the list has the lowest priority.

Include selected 

systems in the service 

group's AutoStartList 

attribute

To enable the service group to automatically come online 

on one of the systems, select this checkbox.

For information about the AutoStartList attribute, see 

the Veritas Cluster Server Administrator's Guide.
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5 On the Configure IIS Sites panel, add and remove sites from the service 

group, configure IP addresses, ports, and virtual computer names, and then 

click Next.

6 On the Network Configuration panel, specify information related to the 

virtual IP addresses and click Next.

Add Check the check box corresponding to the site to be 

configured in VCS.

IP Verify or type the virtual IP address for each site to be 

configured.

Make sure that each virtual IP address is associated with 

only one virtual computer name and vice-versa.

Port Type the port number for each site to be configured.

Virtual Name Type a virtual name for the selected site. Each virtual 

name can be associated with only one virtual IP address 

at a time.

IP Address Displays the virtual IP addresses. The wizard groups 

systems by the virtual IP addresses associated with the 

systems.
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7 On the Application Pool Configuration panel, select the monitoring options 

for application pools associated with each site and click Next.

Subnet Mask If the virtual IP is an IPv4 address, verify or type the 

subnet mask associated with each virtual IPv4 address.

If the virtual IP is an IPv6 address, verify or type the 

associated IPv6 prefix.

The prefix is generally represented in the following 

format: ipv6-address/prefix-length.

For example, 2001:db8:0:1::/64.

Adapter Name Select the adapter associated with the virtual IP address 

on each system.

Site Name Displays the site names.

AppPoolMon For each site, select the monitoring options from the 

AppPoolMon list.

Choose from the following options from the drop-down 

list:

■ NONE—The agent will not monitor the application pool 

associated with the site.

■ DEFAULT—Starts and monitors the root application pool 

associated with the site.

■ ALL—Starts all application pools associated with the site 

and monitors root application pool.
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8 On the Service Group Summary panel, review the service group 

configuration.

Click Next.

Click Yes on the message box that appears, informing you that the wizard 

will run commands to modify the service group configuration.

The wizard starts running commands to create the service group. Various 

messages indicate the status of these commands.

9 In the completion dialog box, check Bring the service group online if you 

want to bring the service group online on the local system, and then click 

Finish.
 

 

Configuring the service group for any additional applications
To configure the service group for any additional application, create an 

application service group and define the attribute values for its resources. You 

can do this using the Application Configuration Wizard. After you create the 

service group, you must configure the shares to mount automatically at startup.

Prerequisites

■ The application is installed on all the nodes that are going to be part of the 

service group.

■ The shared drives required for the application are mounted on this node.

■ The startup type of the application service is set to manual on all nodes in 

the service group.

Resources Displays a list of configured resources. The wizard 

assigns unique names to resources. Change the names 

of resource, if required.

To edit a resource name, select the resource name and 

either click it or press the F2 key. Edit the resource 

name and then press the Enter key to confirm the 

changes. To cancel editing a resource name, press the 

Esc key.

Attributes Displays the attributes and their configured values, for 

a resource selected in the Resources list.

Enable FastFailOver 

attribute for all the 

VMDg resources in the 

service group

To enable all the VMDg resources in the service group 

for fast failover, select this checkbox.

For information about the FastFailOver attribute, see 

the Veritas Cluster Server Administrator’s Guide.



358 Deploying Replicated Data Clusters: New application installation

Configuring the service group
■ The application service is stopped on all nodes in the service group.

■ If your storage is SCSI-3 compliant and you wish to use SCSI-3 persistent 

reservations, enable SCSI-3 support using Veritas Enterprise Administrator 

(VEA).

■ If you have configured a firewall, add the following to the firewall exceptions 

list:

■ Port 14150 or the VCS Command Server service, 

%vcs_home%\bin\CmdServer.exe

Here, %vcs_home% is the installation directory for VCS, typically 

C:\Program Files\Veritas\Cluster Server.

■ Port 14141

For a detailed list of services and ports used by SFW HA, refer to the Veritas 

Storage Foundation and High Availability Solutions for Windows Installation 

and Upgrade Guide.

■ On Windows Server Core, you have to add the required resources and 

configure the service group manually. You can perform the steps either 

directly on the Server Core machine using the command line, or remotely 

using the Cluster Manager (Java console).

Refer to the Veritas Cluster Server Administrator’s Guide for instructions on 

using the command line and the Cluster Manager (Java Console).

Note: If User Access Control (UAC) is enabled on Windows Server systems, 

you must launch the command prompt in the Run as administrator mode 

and then run the VCS commands.

Before configuring the service group, review the resource types and the 

attribute definitions of the FileShare agent, described in the Veritas Cluster 

Server Bundled Agents Reference Guide.

■ Before running the wizard, make sure you have the following information 

ready:

■ Details (service name, start parameters, startup directory, etc.) of the 

application that you wish to configure.

■ Shared storage used by the applications.

■ Application registry entries for configuring registry replication.

■ Network and virtual computer (Lanman) details for the application.
 

Creating the application service group

The following procedure describes how to create an application service group 

using the Application Configuration Wizard.
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If you are using a non-shared storage configuration (dynamic disk groups 

configured on local disks), you have to configure the service group manually 

either using the Cluster Manager (Java Console) or the command line. The 

wizard currently cannot configure resources (VMNSDg agent) required for 

monitoring non-shared storage.

See “Configuring the service group in a non-shared storage environment” on 

page 157.

To create the application service group

1 Start the Application Configuration Wizard. Click Start > All Programs > 

Symantec > Veritas Cluster Server > Configuration Tools > > Application 

Configuration Wizard.

2 Review the information in the Welcome panel and click Next.

3 In the Wizard Options panel, click Create service group and click Next.

4 Specify the service group name and system list.

■ Enter a name for the service group.

■ In the Available Cluster Systems box, select the systems on which to 

configure the service group and click the right-arrow icon to move the 

systems to the service group’s system list.

To remove a system from the service group’s system list, select the 

system in the Systems in Priority Order list and click the left arrow.

■ To change a system’s priority in the service group’s system list, select 

the system in the Systems in Priority Order list and click the up and 

down arrows. The system at the top of the list has the highest priority 

while the system at the bottom of the list has the lowest priority.

■ To enable the service group to automatically come online on one of the 

systems, select the Include selected systems in the service group's 

AutoStartList attribute checkbox.

For information about the AutoStartList attribute, see the Veritas 

Cluster Server Administrator's Guide.

■ Click Next.

The wizard starts validating your configuration. Various messages 

indicate the validation status.

5 The Application Options panel provides you the option to specify the type of 

application to be configured. The available options are:

■ Generic Service: Configures a service using the Generic Service agent. 

The agent brings services online, takes them offline, and monitors their 

status. See “Configuring a GenericService resource” on page 360.
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■ Process: Configures a process using the Process agent. The agent brings 

processes online, takes them offline, and monitors their status. See 

“Configuring processes” on page 364.

■ Service Monitor: Configures a service using the ServiceMonitor agent. 

The agent monitors a service or starts a user-defined script and 

interprets the exit code of the script. See “Configuring a 

ServiceMonitor resource” on page 368.

Configuring a GenericService resource

1 In the Application Options panel, click Create, select GenericService from 

the corresponding drop-down list, and click Next.
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2 Select the service name for which you wish to configure a GenericService 

resource. Also specify the attributes for the resource.

■ Click the icon (...) adjacent to the Service Name text box.

■ In the Services dialog box, select a service and click OK. The selected 

service appears in the Service Name text box.

■ In the Start Parameters text box, provide the start parameters for the 

service, if any.

■ In the Delay After Online text box, specify the number of seconds the 

agent waits after the service is brought online before starting the 

monitor routine.

■ In the Delay After Offline text box, specify the number of seconds the 

agent waits after the service is taken offline before starting the monitor 

routine.

■ Click Next.
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3 Specify the information about the user in whose context the service will run.

■ To configure a service to run in the context of a local system account, 

click Local System account.

■ To configure a service to run in the context of another user account, 

click This Account. Specify the Domain Name, User Name, and 

Password for the user account.

■ Click Next.
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4 Select the shared storage required for the GenericService resource. The 

shared storage, which you select will be in addition to the mount where the 

service binaries exist.

■ In the Available Shared Drives box, select the check box adjacent to the 

shared drive.

■ Click Next.

5 In the Application Resource Summary panel, review the summary of the 

GenericService resource. Click Back to make changes. Otherwise, click Next.

6 The Application Options panel appears. Select one of the following options:

■ To configure another GenericService resource, repeat step 1 through 

step 5.

■ To configure a Process resource, proceed to “Configuring processes” on 

page 364 for instructions.

■ To configure a ServiceMonitor resource, proceed to “Configuring a 

ServiceMonitor resource” on page 368 for instructions.

■ To configure other resources, including FileShare, Registry 

Replication, and Network resources, proceed to “Configuring VCS 

components” on page 371 for instructions.

If you do not want to add any more resources to your service group, proceed to 

“Configuring application dependencies” on page 374.
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Configuring processes

1 In the Application Options panel, click Create, select Process from the 

corresponding list, and click Next.

2 Specify the details for the process.

■ In the Start Program text box, specify the complete path of the 

program that will start the process to be monitored by VCS. You can 

choose to either type in the location of the program or browse for it 

using the (...) icon.
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■ In the Start Program Parameters text box, specify the parameters used 

by the Process agent start program.

■ In the Program Startup Directory text box, enter the complete path of 

the Process agent program or browse for it by clicking the (...) icon.

■ In the Stop Program text box, enter the complete path of the program 

that will stop the process started by the Start Program or browse for it 

by clicking the (...) icon.

■ In the Stop Program Parameters text box, specify the parameters used 

by the stop program.

■ In the Monitor Program text box, enter the complete path of the 

program that monitors the Start Program or browse for it by clicking 

the (...) icon.

If you do not specify a value for this attribute, VCS monitors the Start 

Program. If the Start Program is a script to launch another program, 

you must specify a monitor program.

■ In the Monitor Program Parameters text box, specify the parameters 

used by the monitor program.

■ In the Clean Program text box, enter the complete path of the Clean 

process or browse for it by clicking the (..) icon.

■ If no value is specified, the agent kills the process indicated by the Start 

Program.

■ In the Clean Program Parameters text box, specify the parameters used 

by the Clean program.

■ Select the Process interacts with the desktop check box if you want the 

process to interact with your Windows desktop. Setting this option 

enables user intervention for the process.

■ Click Next.
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3 Specify information about the user in whose context the process will run.

■ To configure a service to run in the context of a local system account, 

click Local System account.

■ To configure a service to run in the context of another user account, 

click This Account. Specify the Domain Name, User Name, and 

Password for the user account.

■ Click Next.
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4 Select the shared storage required for the Process resource. The shared 

storage, which you select will be in addition to the mount where the service 

binaries exist.

■ From the Available Shared Drives box, select the check box adjacent to 

the shared drive.

■ Click Next.

5 In the Application Resource Summary panel, review the summary of the 

Process resource. Click Back to make changes. Otherwise, click Next.

6 The Application Options panel appears. Select one of the following options:

■ To configure another Process resource, repeat step 1 through step 5.

■ To configure a GenericService resource, see “Configuring a 

GenericService resource” on page 360 for instructions.

■ To configure a ServiceMonitor resource, proceed to “Configuring a 

ServiceMonitor resource” on page 368 for instructions.

■ To configure other resources, including FileShare, Registry 

Replication, and Network resources, proceed to “Configuring VCS 

components” on page 371 for instructions.

If you do not want to add any more resources to your service group, proceed to 

“Configuring application dependencies” on page 374.
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Configuring a ServiceMonitor resource

1 In the Application Options panel, click Create, select ServiceMonitor from 

the corresponding drop-down list, and click Next.

2 Specify the service to be monitored or a user-defined script to monitor a 

service.
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If you want VCS to monitor the service:

■ Select the Service option and click the icon (...) adjacent to the Service 

Name text box.

■ In the Service dialog box, select the service and click OK. The selected 

service name appears in the Service Name text box. Alternatively, You 

may also type in the service name to be monitored.

■ Click Next.

If you want a script to monitor the service:

■ Specify the complete path for the script using the Browse button (...).

■ Specify the parameters for the script.

■ Specify the time in seconds for the agent to receive a return value from 

the monitor script.

■ Click Next.

3 Specify the user information in whose context the service will be monitored.

■ To configure a service to run in the context of a local system account, 

click Local System account.

■ To configure a service to run in the context of another user account, 

click This Account. Specify the Domain Name, User Name, and 

Password for the user account.

If the service selected in step 2 on page 368 is running in the context of 

a local system account, the This Account option is disabled. Similarly, if 

the service is running in the context of any other user account, the 

Local System account option is disabled.
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■ Click Next.

ServiceMonitor resource belongs to the category of persistence resources. 

Such resources do not depend on other VCS resources, including shared 

storage. Hence, the Shared Storage Option panel does not appear if you 

select the ServiceMonitor option.

4 In the Application Resource Summary panel, review the summary of the 

ServiceMonitor resource. Click Back to make changes. Otherwise, click Next.

5 The Application Options panel appears. Select one of the following options:

■ To configure another ServiceMonitor resource, repeat step 1 through 

step 4.

■ To configure a GenericService resource, see “Configuring a 

GenericService resource” on page 360 for instructions.

■ To configure a Process resource, see “Configuring processes” on 

page 364 for instructions.

■ To configure other resources, including FileShare, Registry 

Replication, and Network resources, proceed to “Configuring VCS 

components” on page 371 for instructions.

If you do not want to add any more resources to your service group, proceed to 

“Configuring application dependencies” on page 374.
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Configuring VCS components

Applications configured using GenericService or Process resources may require  

network components, or Registry Replication resources. You can configure 

these VCS components only for service groups created using the wizard.

Note: Configure these components only after configuring all application 

resources. The wizard creates a service group after these components are 

configured. To add more application resources, you must rerun the wizard in the 

Modify mode.

To configure VCS components

1 In the Application Options panel, click Configure Other Components.
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2 Select the VCS component to be configured for your applications.

The available options are:

■ Registry Replication Component: Select this option to configure 

registry replication for your application. To configure a Registry 

Replication resource, proceed to step 3 on page 372.

■ Network Component: Select this option to configure network 

components for your application. If you wish to configure a virtual 

computer name, check Lanman component also. To configure a 

network resource, proceed to step 4 on page 373.

The wizard does not enable the Lanman Component check box unless the 

Network Component check box is checked.

To configure Registry Replication

The RegistryReplication panel appears only if you chose to configure the 

Registry Replication Component in the Application Component panel.

3 Specify the registry keys to be replicated.

■ Specify the directory on the shared disk in which the registry changes 

are logged.

■ Click Add.

■ In the Registry Keys dialog box, select the registry key to be replicated.

■ Click OK.

■ The selected registry key is added to Registry KeyList box. Click Next.
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If you chose Network Component from the Application Component panel, 

proceed to the next step. Otherwise, proceed to step 5 on page 374.

To configure network components

The Virtual Computer Configuration panel appears only if you chose to 

configure the Network Component in the Application Component panel.

4 Specify information related to your network.

■ Select IPv4 to configure an IPv4 address for the virtual server.

■ In the Virtual IP Address field, type a unique virtual IPv4 address 

for the virtual server.

■ In the Subnet Mask field, type the subnet to which the virtual IPv4 

address belongs.

■ Select IPv6 to configure an IPv6 address for the virtual server. The IPv6 

option is disabled if the network does not support IPv6.

■ Select the prefix from the drop-down list. The wizard uses the 

prefix and automatically generates an IPv6 address that is valid 

and unique on the network.

■ In the Virtual Server Name field, enter a unique virtual computer name 

by which the node will be visible to the other nodes. Note that the 

virtual name must not exceed 15 characters.

Note that the Virtual Computer Name text box is displayed only if you 

chose to configure the Lanman Component in Application Component 

panel. 

■ Click Advanced to specify additional details for the Lanman resource.

■ Check AD Update required to enable the Lanman resource to 

update the Active Directory with the virtual name. This sets the 

Lanman agent attributes ADUpdateRequired and 

ADCriticalForOnline to true.

■ In the Organizational Unit field type the distinguished name of the 

Organizational Unit for the virtual server in the format 

CN=containername,DC=domainname,DC=com. To browse for an 

OU, click the ellipsis (...) button and search for the OU using the 

Windows Find Organization Units dialog box.for the virtual server. 

By default, the Lanman resource adds the virtual server to the 

default container "Computers."

The user account for VCS Helper service must have adequate 

privileges on the specified container to create and update 

computer accounts.

■ Click OK.
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■ For each system in the cluster, select the public network adapter name. 

The Adapter Display Name field displays the TCP/IP enabled adapters 

on a system, including the private network adapters, if applicable. 

To view the adapters associated with a system, click the Adapter 

Display Name field and click the arrow. Verify that you select the adapters 

assigned to the public network, not the private.

■ Click Next.

5 The Application Options panel is displayed. Select one of the following 

options:

■ To configure additional VCS components, repeat step 1 on page 371 

through step 4 on page 373.

■ To configure a GenericService resource, see “Configuring a 

GenericService resource” on page 360 for instructions.

■ To configure a Process resource, see “Configuring processes” on 

page 364 for instructions.

■ To configure a Service Monitor resource, see “Configuring a 

ServiceMonitor resource” on page 368 for instructions.

If you do not want to add any more resources to your service group, proceed 

to “Configuring application dependencies” on page 374.

Configuring application dependencies

The Application Configuration Wizard enables you to create service group for 

the application resources and other VCS components configured using the 

wizard. This section describes how to create the service group using the wizard.



375Deploying Replicated Data Clusters: New application installation

Configuring the service group
To create a service group

1 In the Application Options panel, click Configure application dependency 

and create service group.

The option is enabled only if:

■ resources and VCS components are already configured using the 

wizard.

■ you clicked Modify Service Group in the wizard options panel.
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2 Specify the dependency between the applications.

You must have at least two resources configured for Application 

Dependency panel to appear. Of the two resources, one should either be a 

GenericService or a Process resource.

■ From the Select Application list, select the application that would 

depend on other applications. The selected application becomes the 

parent application.

■ From the Available Applications list, select the application on which 

the parent application would depend and click the right-arrow icon to 

move the application to the Child Applications list.

■ To remove an application from the Child Applications list, select the 

application in the list and click the left arrow.

■ Repeat these steps for all such applications for which you want to 

create a dependency.

■ Click Next.

The Application Dependency panel enables you to link resources configured 

using the wizard. If these resources are dependent on other services outside 

the VCS environment, you should first configure resources for such services 

and then create the appropriate dependency.

3 Review the service group configuration.

The Resources box lists the configured resources. Click on a resource to 

view its attributes and their configured values in the Attributes box.
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■ The wizard assigns unique names to resources. Change names of 

resource, if required.

To edit a resource name, select the resource name and either click it or 

press the F2 key. Press Enter after editing each resource name. To 

cancel editing a resource name, press the Esc key.

■ To enable all the VMDg resources in the service group for fast failover, 

select the Enable FastFailOver attribute for all the VMDg resources in 

the service group checkbox.

For information about the FastFailOver attribute, see the Veritas 

Cluster Server Administrator’s Guide.

■ Click Next.

■ A message appears informing you that the wizard will run commands 

to modify the service group configuration. Click Yes.

The wizard starts running commands to create the service group. 

Various messages indicate the status of these commands. After the 

commands are executed, the completion dialog box appears.

4 In the completion panel, check Bring the service group online if you want to 

bring the service group online on the local system.

5 Click Finish to create the service group and exit the Application 

Configuration Wizard.
 

Creating the primary system zone for the 
application service group

In the application service group, set up systems in the primary zone (zone 0) to 

specify that initial failover occurs to systems within the primary zone.

To set up the primary system zone

1 From VCS Cluster Manager (Java Console), log on to the cluster.

2 In the left pane and the Properties tab in the right pane, select the service 

group.

3 In the Properties pane, click the button Show All Attributes.

4 In the Attributes View, scroll down and select the SystemZones attribute.

5 Click the Edit icon for the SystemZones attribute.

6 In the Edit Attribute dialog box, click the plus sign and enter the systems 

and the zone number (zone 0) for the primary zone.
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In case of a non-shared storage configuration, add only the single node to 

the primary zone.

7 Click OK.

After setting up the primary system zone, you can verify the service group 

failover on systems within the primary zone.

See “Verifying the RDC configuration” on page 421.

Verifying the installation in the primary zone
An important part of configuration testing is simulating a failover.

To verify the configuration of a cluster, either move the online groups, or shut 

down an active cluster node.

■ Use Veritas Cluster Manager (Java Console) to switch all the service groups 

from one node to another.

■ Simulate a local cluster failover by shutting down an active cluster node.

To switch service groups

1 In the Veritas Cluster Manager (Java Console), click the cluster in the 

configuration tree, click the Service Groups tab, and right-click the service 

group icon in the view panel. 

■ Click Switch To, and click the appropriate node from the menu.

■ In the dialog box, click Yes. The service group you selected is taken 

offline on the original node and brought online on the node you 

selected.

If there is more than one service group, you must repeat this step until 

all the service groups are switched.

2 Verify that the service group is online on the node you selected to switch to 

in step 1.
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3 To move all the resources back to the original node, repeat step 1 for each of 

the service groups.

To shut down an active cluster node

1 Gracefully shut down or restart the cluster node where the service group is 

online.

2 In the Veritas Cluster Manager (Java Console) on another node, connect to 

the cluster.

3 Verify that the service group has failed over successfully, and is online on 

the next node in the system list.

4 If you need to move all the service groups back to the original node:

■ Restart the node you shut down in step 1.

■ Click Switch To, and click the appropriate node from the menu.

■ In the dialog box, click Yes. 

The service group you selected is taken offline and brought online on 

the node that you selected.
 

Creating a parallel environment in the secondary 
zone

Before you begin to configure the secondary zone, in the application service 

group in the primary zone, take the following resources offline:

■ Application resource

■ Application virtual IP resource

The remaining resources should be online, including the storage resources.

In VEA, make sure to remove all the drive letters from the configured volumes, 

to avoid conflicts when configuring the zones.

After you set up a SFW HA environment in the primary zone (zone 0), use the 

guidelines in the following list to complete the same tasks in the secondary zone 

(zone 1).

■ “Reviewing the requirements” on page 294

■ “Reviewing the configuration” on page 301

■ “Configuring the storage hardware and network” on page 302

■ “Installing Veritas Storage Foundation HA for Windows” on page 303

■ “Configuring VxSAS” on page 313

■ “Adding the systems in the secondary zone to the cluster” on page 380
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■ “Configuring disk groups and volumes” on page 327

During the creation of disk group and volumes for the secondary zone, 

make sure the following are exactly the same as the cluster at the primary 

zone:

■ Disk group name

■ Volume sizes

■ Volume names

■ Drive letters

■ “Installing and configuring the application or server role” on page 335

Adding the systems in the secondary zone to the 
cluster

Use the VCS Cluster Configuration Wizard (VCW) to add the systems in the 

secondary zone (zone1) to the existing cluster.

To add a node to a VCS cluster

1 Start the VCS Cluster Configuration wizard.

Click Start > All Programs > Symantec > Veritas Cluster Server > 

Configuration Tools > Cluster Configuration Wizard.

Run the wizard from the node to be added or from a node in the cluster. The 

node that is being added should be part of the domain to which the cluster 

belongs.

2 Read the information on the Welcome panel and click Next.

3 On the Configuration Options panel, click Cluster Operations and click 

Next.
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4 In the Domain Selection panel, select or type the name of the domain in 

which the cluster resides and select the discovery options.

Do one of the following:

■ To discover information about all the systems and users in the domain:

■ Clear the Specify systems and users manually check box.

■ Click Next.

Proceed to step 8 on page 384.

■ To specify systems and user names manually (recommended for large 

domains):

■ Check the Specify systems and users manually check box.

Additionally, you may instruct the wizard to retrieve a list of 

systems and users in the domain by selecting appropriate check 

boxes.

■ Click Next.

If you chose to retrieve the list of systems, proceed to step 6 on 

page 383. Otherwise proceed to the next step.
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5 On the System Selection panel, complete the following and click Next.

■ Type the name of a node in the cluster and click Add.

■ Type the name of the system to be added to the cluster and click Add.

If you specify only one node of an existing cluster, the wizard discovers all 

nodes for that cluster. To add a node to an existing cluster, you must specify 

a minimum of two nodes; one that is already a part of a cluster and the other 

that is to be added to the cluster.

Proceed to step 8 on page 384.
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6 On the System Selection panel, specify the systems to be added and the 

nodes for the cluster to which you are adding the systems.

Enter the system name and click Add to add the system to the Selected 

Systems list. Alternatively, you can select the systems from the Domain 

Systems list and click the right-arrow icon.

If you specify only one node of an existing cluster, the wizard discovers all 

nodes for that cluster. To add a node to an existing cluster, you must specify 

a minimum of two nodes; one that is already a part of a cluster and the other 

that is to be added to the cluster.

7 The System Report panel displays the validation status, whether Accepted 

or Rejected, of all the systems you specified earlier. Review the status and 

then click Next.

A system can be rejected for any of the following reasons:

■ System is not pingable.

■ WMI access is disabled on the system.

■ Wizard is unable to retrieve the system architecture or operating 

system.

■ VCS is either not installed on the system or the version of VCS is 

different from what is installed on the system on which you are 

running the wizard.

Click on a system name to see the validation details. If you wish to include a 

rejected system, rectify the error based on the reason for rejection and then 

run the wizard again.
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8 On the Cluster Configuration Options panel, click Edit Existing Cluster and 

click Next.

9 On the Cluster Selection panel, select the cluster to be edited and click Next.

If you chose to specify the systems manually in step 4, only the clusters 

configured with the specified systems are displayed.

10 On the Edit Cluster Options panel, click Add Nodes and click Next.

In the Cluster User Information dialog box, type the user name and 

password for a user with administrative privileges to the cluster and click 

OK.

The Cluster User Information dialog box appears only when you add a node 

to a cluster with VCS user privileges, that is when the cluster configuration 

does not use the Symantec Product Authentication Service for secure 

cluster communication.

11 On the Cluster Details panel, check the check boxes next to the systems to be 

added to the cluster and click Next.

The right pane lists nodes that are part of the cluster. The left pane lists 

systems that can be added to the cluster.

12 The wizard validates the selected systems for cluster membership. After the 

nodes have been validated, click Next.

If a node does not get validated, review the message associated with the 

failure and restart the wizard after rectifying the problem.

13 On the Private Network Configuration panel, configure the VCS private 

network communication on each system being added and then click Next. 

How you configure the VCS private network communication depends on 

how it is configured in the cluster. If LLT is configured over ethernet, you 
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have to use the same on the nodes being added. Similarly, if LLT is 

configured over UDP in the cluster, you have to use the same on the nodes 

being added.

Do one of the following:

■ To configure the VCS private network over ethernet, complete the 

following steps:

■ Select the check boxes next to the two NICs to be assigned to the 

private network.

Symantec recommends reserving two NICs exclusively for the 

private network. However, you could lower the priority of one NIC 

and use the low-priority NIC for both public and private 

communication.

■ If you have only two NICs on a selected system, it is recommended 

that you lower the priority of at least one NIC that will be used for 

private as well as public network communication.

To lower the priority of a NIC, right-click the NIC and select Low 

Priority from the pop-up menu.

Note: If you wish to use Windows NIC teaming, you must select the 

Static Teaming mode. Only the Static Teaming mode is currently 

supported.

■ If your configuration contains teamed NICs, the wizard groups 

them as "NIC Group #N" where "N" is a number assigned to the 

teamed NIC. A teamed NIC is a logical NIC, formed by grouping 

several physical NICs together. All NICs in a team have an identical 

MAC address. Symantec recommends that you do not select 

teamed NICs for the private network.

The wizard configures the LLT service (over ethernet) on the selected 

network adapters.

■ To configure the VCS private network over the User Datagram Protocol 

(UDP) layer, complete the following steps:

■ Select the check boxes next to the two NICs to be assigned to the 

private network. You can assign maximum eight network links.

Symantec recommends reserving at least two NICs exclusively for 

the VCS private network.

■ Specify a unique UDP port for each of the link. Click Edit Ports if 

you wish to edit the UDP ports for the links. You can use ports in 

the range 49152 to 65535. The default ports numbers are 50000 

and 50001 respectively. Click OK.
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■ For each selected NIC, verify the displayed IP address. If a selected 

NIC has multiple IP addresses assigned, double-click the field and 

choose the desired IP address from the drop-down list. In case of 

IPv4, each IP address can be in a different subnet.

The IP address is used for the VCS private communication over the 

specified UDP port.

■ For each selected NIC, double-click the respective field in the Link 

column and choose a link from the drop-down list. Specify a 

different link (Link1 or Link2) for each NIC. Each link is associated 

with a UDP port that you specified earlier.

The wizard configures the LLT service (over UDP) on the selected network 

adapters. The specified UDP ports will be used for the private network 

communication.

14 On the Public Network Communication panel, select a NIC for public 

network communication, for each system that is being added, and then click 

Next.

This step is applicable only if you have configured the ClusterService 

service group, and the system being added has multiple adapters. If the 

system has only one adapter for public network communication, the wizard 

configures that adapter automatically.

Note: If you wish to use Windows NIC teaming, you must select the Static 

Teaming mode. Only the Static Teaming mode is currently supported.

15 Specify the password for the user in whose context the VCS Helper service 

runs.

16 Review the summary information and click Add.

The wizard starts running commands to configure the VCS components on 

the node. In case of a secure cluster, the wizard also configures the VCS 

Authentication Service on the new node that is being added.

17 After all commands have been successfully run, click Finish.
 

Return to the task list “Creating a parallel environment in the secondary zone” 

on page 379.

Setting up the Replicated Data Sets (RDS)
Set up the Replicated Data Sets (RDS) in the primary zone and secondary zone. 

You can configure an RDS using the Create RDS wizard for both zones.

■ Verify that the data volumes are not of the following types, as VVR does not 

support these types of volumes:
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■ Storage Foundation for Windows (software) RAID 5 volumes

■ Volumes with a Dirty Region Log (DRL) 

■ Volumes that are already part of another RVG

■ Volumes names containing a comma

■ Verify that the disk group is imported and the volumes are mounted in the 

primary and secondary zone.

■ Verify that you have set the appropriate IP preference, whether VVR should 

use IPv4 or IPv6 addresses. The default setting is IPv4.

When you specify host names while configuring replication, VVR resolves 

the host names with the IP addresses associated with them. This setting 

determines which IP protocol VVR uses to resolve the host names. 

Use Veritas Enterprise Administrator (VEA) (Control Panel > VVR 

Configuration > IP Settings tab) to set the IP preference. 

■ Configure the VxSAS service if you have not already done so.

See “Configuring VxSAS” on page 313.

To create the Replicated Data Set

1 Use the Veritas Enterprise Administrator (VEA) console to launch the Setup 

Replicated Data Set Wizard from the cluster node on the Primary where the 

cluster disk group is imported:

Click Start > All Programs > Symantec > Veritas Storage Foundation > 

Veritas Enterprise Administrator.

From the VEA console, click View > Connection > Replication Network.

2 Right-click Replication Network and select Setup Replicated Data Set.

3 Read the information on the Welcome page and then click Next.
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4 Specify names for the Replicated Data Set (RDS) and Replicated Volume 

Group (RVG) and then click Next.

By default, the local host is selected as the Primary Host. To specify a 

different host name, make sure the required host is connected to the VEA 

console and select it in the Primary Host list.

If the required primary host is not connected to the VEA console, it does not 

appear in the drop-down list of the Primary Host field. Use the VEA console 

to connect to the host.
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5 Select from the table the dynamic disk group and data volumes that will 

undergo replication and then click Next.

To select multiple volumes, press the Shift or Control key while using the up 

or down arrow keys.

By default, a mirrored DCM log is automatically added for all selected 

volumes. If disk space is inadequate to create a DCM log with two plexes, a 

single plex is created.

6 Complete the Select or create a volume for Replicator Log page as follows:
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To select an existing volume

■ Select the volume for the Replicator Log in the table (APP_REPL_LOG).

If the volume does not appear in the table, click Back and verify that the 

Replicator Log volume was not selected on the previous page.

■ Click Next.

To create a new volume

■ Click Create Volume and enter the following information in the dialog 

box that displays.

■ Click OK to create the Replicator Log volume.

■ Click Next in the Select or create a volume for Replicator Log dialog 

box.

7 Review the information on the summary page and click Create Primary RVG.

8 After the Primary RVG has been created successfully, VVR displays the 

following message:

Name Enter the name for the volume in the Name field.

Size Enter a size for the volume in the Size field.

Layout Select the desired volume layout.

Disk Selection Enables you to specify the disk selection method.

■ Enable the Thin Provisioned Disks Only check box to 

ensure that the Replicator Log volume is created 

only on Thin Provisioned (TP) disks.

Note: The check box will remain disabled if the diskgroup 

does not have any TP disk.

If this option is selected along with the Select disks 

automatically option, then the Replicator Log volume will 

be created only on TP disks. However, if you enable this 

check box along with Select disks manually option, then 

the user can select only TP disks from Available Disks.

For more information on Thin Provisioning refer to the 

Veritas Storage Foundation Administrator’s Guide.

■ Choose the Select disks automatically option if you 

want VVR to select the disks.

■ Choose the Select disks manually option to use 

specific disks from the Available disks pane for 

creating the volume. Either double-click on it or 

select Add to move the disks into the Selected disks 

pane.
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RDS with Primary RVG has been created successfully. Do you want 
to add Secondary host to this RDS for replication now?

Click No to exit the Setup Replicated Data Set wizard without adding the 

Secondary host. To add the Secondary host later, use the Add Secondary 

option from the RDS right-click menu.

Click Yes to add the Secondary host to the Primary RDS now. The Specify 

Secondary host for replication page appears.

9 On the Specify Secondary host for replication page, enter the name or IP 

address of the Secondary host in the Secondary Host field and then click 

Next.

If the Secondary host is not connected to VEA, the wizard tries to connect it 

when you click Next. This wizard allows you to specify only one Secondary 

host. Additional Secondary hosts can be added using the Add Secondary 

option from the RDS right-click menu.

Wait till the connection process is complete and then click Next again.

10 If only a disk group without any data volumes or Replicator Log, as on the 

Primary host exists on the Secondary, then VVR displays a message. Read 

the message carefully.

The option to automatically create volumes on the Secondary host is 

available only if the disks that are part of the disk group have:

■ The same or larger amount of space as that on the Primary

■ Enough space to create volumes with the same layout as on the Primary

Otherwise, the RDS setup wizard enables you to create the required 

volumes manually.

■ Click Yes to automatically create the Secondary data volumes and the 

Replicator Log.

■ Click No to create the Secondary data volumes and the Replicator Log 

manually, using the Volume Information on the connected hosts page.

11 The Volume Information on connected hosts page appears. This page 

displays information on the availability of volumes on the Secondary nodes, 

if the Primary and Secondary hosts are connected to VEA.

This page does not appear if all the required volumes that are available on 

the Primary host are also available on the Secondary hosts.

■ If the required data volumes and the Replicator Log have not been 

created on the Secondary host, then the page displays the appropriate 

message against the volume name on the Secondary.

■ If an error occurs or a volume needs to be created, a volume displays 

with a red icon and a description of the situation. To address the error, 

or to create a new Replicator Log volume on the secondary site, click 
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the volume on the secondary site, click the available task button and 

follow the wizard.

Depending on the discrepancies between the volumes on the primary 

site and the secondary site, you may have to create a new volume, 

recreate or resize a volume (change attributes), or remove either a DRL 

or DCM log.

When all the replicated volumes meet the replication requirements and 

display a green check mark, click Next.

■ If all the data volumes to be replicated meet the requirements, this 

screen does not occur.

12 Complete the Edit replication settings page to specify the basic and 

advanced replication settings for a Secondary host as follows:

■ To modify each of the default values listed on this page, select the 

required value from the drop-down list for each property. If you do not 
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wish to modify basic properties then replication can be started with the 

default values when you click Next.

Primary side IP Enter the virtual IP address for the Primary IP resource 

that will be used for replication. If there is more than one IP 

address available for replication, you can choose the one 

that you want to use from the drop-down list. If the 

required IP address is not displayed in the list then edit the 

field to add the IP address.

Secondary side IP Enter the virtual IP address on the Secondary that is to be 

used for replication. If there is more than one IP address 

available for replication, you can choose the one that you 

want to use from the drop-down list. If the required IP 

address is not displayed in the list then edit the field to add 

the IP address.

Replication Mode Select the required mode of replication: Synchronous 

Override, Synchronous, or Asynchronous. The default is 

synchronous override.

Synchronous Override enables synchronous updates under 

typical operating conditions. If the Secondary site is 

disconnected from the Primary site, and write operations 

occur on the Primary site, the mode of replication 

temporarily switches to Asynchronous.

Synchronous determines updates from the application on 

the Primary site are completed only after the Secondary 

site successfully receives the updates.

Asynchronous determines updates from the application on 

the Primary site are completed after VVR updates in the 

Replicator Log. From there, VVR writes the data to the data 

volume and replicates the updates to the secondary site 

asynchronously.

If the Secondary is set to the synchronous mode of 

replication and is disconnected, the Primary data volumes 

with NTFS file systems may be displayed with the status as 

MISSING.

Replicator Log 

Protection

The AutoDCM is the default selected mode for the 

Replicator Log overflow protection when all the volumes in 

the Primary RVG have a DCM log. The DCM is enabled 

when the Replicator Log overflows.
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The DCM option enables the Replicator Log protection for 

the Secondary host when the Replicator Log overflows, and 

the connection between the Primary and Secondary is lost. 

This option is available only if all the data volumes under 

the Primary RVG have a DCM Log associated with them.

The Off option disables Replicator Log Overflow protection.

In the case of the Bunker node. Replicator Log protection is 

set to Off, by default. Thus, if the Primary RLINK overflows 

due to the Bunker RLINK, then this RLINK is detached.

The Override option enables log protection. If the 

Secondary node is still connected and the Replicator Log is 

about to overflow then the writes are stalled until a 

predetermined amount of space, that is, 5% or 20 MB 

(whichever is lesser) becomes available in the Replicator 

Log.

If the Secondary becomes inactive due to disconnection or 

administrative action then Replicator Log protection is 

disabled, and the Replicator Log overflows.

The Fail option enables log protection. If the log is about to 

overflow the writes are stalled until a predetermined 

amount of space, that is, 5% or 20 MB (whichever is lesser) 

becomes available in the Replicator Log. If the connection 

between Primary and Secondary RVG is broken, then, any 

new writes to the Primary RVG are failed.

Primary RLINK Name This option enables you to specify a Primary RLINK name 

of your choice. If you do not specify any name then VVR 

assigns a default name.

Secondary RLINK Name This option enables you to specify a Secondary RLINK 

name of your choice. If you do not specify any name then 

VVR assigns a default name.
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■ If you want to specify advanced replication settings, click Advanced. 

Edit the replication settings for a secondary host as needed.

Latency protection Determines the extent of stalling write operations on the 

primary site to allow the secondary site to “catch up” with 

the updates before new write operations can occur.

Off is the default option and disables latency protection.

Fail enables latency protection. If the number of 

outstanding write operations reaches the High Mark Value 

(described below), and the secondary site is connected, 

VVR stalls the subsequent write operations until the 

number of outstanding write operations is lowered to the 

Low Mark Value (described below). If the secondary site is 

disconnected, the subsequent write operations fail.

Override enables latency protection. This option 

resembles the Off option when the secondary site is 

disconnected, and the Fail option when the secondary site 

is connected.

Throttling of write operations affects application 

performance on the primary site; use this protection only 

when necessary according to replication throughput and 

application write patterns.

High Mark Value Is enabled only when either the Override or Fail latency 

protection option is selected. This value triggers the 

stalling of write operations and specifies the maximum 

number of pending updates on the Replicator Log waiting 

for replication to the secondary site. The default value is 

10000, the maximum number of updates allowed in a 

Replicator Log.
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Click OK to close the dialog box and then click Next.

13 On the Start Replication page, choose the appropriate option as follows:

Low Mark Value Is enabled only when either the Override or Fail latency 

protection options is selected. After reaching the High 

Mark Value, write operations on the Replicator Log are 

stalled until the number of pending updates drops to an 

acceptable point at which the secondary site can “catch 

up” to the activity on the primary site; this acceptable 

point is determined by the Low Mark Value. The default 

value is 9950.

Caution: When determining the high mark and low mark values for latency 

protection, select a range that is sufficient but not too large to prevent long 

durations of throttling for write operations.

Protocol UDP/IP is the default protocol for replication.

Packet Size Updates to the host on the secondary site are sent in 

packets; the default size 1400 bytes. The option to select 

the packet size is enabled only when UDP/IP protocol is 

selected.

Bandwidth By default, VVR uses the maximum available bandwidth. 

To control the bandwidth used, specify the bandwidth 

limit in Mbps.

Enable Compression Enable this checkbox if you want to enable Compression 

for the secondary host.
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■ To add the Secondary and start replication immediately, select Start 

Replication with one of the following options:

■ To add the secondary without starting replication, deselect the Start 

Replication option. You can start replication later by using the Start 

Replication option from the Secondary RVG right-click menu.

■ Click Next to display the Summary page.

14 Review the information.

Click Back to change any information you had specified and click Finish to 

add the secondary host to the RDS and exit the wizard.
 

If you have set up additional disk groups for the application, repeat the 

procedure “Setting up the Replicated Data Sets (RDS)” on page 386 for each 

Synchronize 

Automatically

If virtual IPs have been created, select the Synchronize 

Automatically option, which is the default recommended 

for initial setup to start synchronization of Secondary 

and start replication immediately.

If the virtual IPs for replication are not yet created, 

automatic synchronization remains paused and resumes 

after the Replication Service Group is created and 

brought online.

When this option is selected, VVR by default performs 

intelligent synchronization to replicate only those blocks 

on a volume that are being used by the file system. If 

required, you can disable intelligent synchronization.

Note: Intelligent synchronization is applicable only to 

volumes with the NTFS file systems and not to raw 

volumes or volumes with FAT/FAT32 file systems.

Synchronize from 

Checkpoint

If you want to use this method, then you must first create 

a checkpoint.

If you have considerable amount of data on the Primary 

data volumes, then you may first want to synchronize the 

secondary for existing data using the backup-restore 

method with checkpoint. After the restore is complete, 

use the Synchronize from Checkpoint option to start 

replication from checkpoint to synchronize the 

secondary with the writes that happened when 

backup-restore was in progress.

For information on synchronizing from checkpoints, 

refer Veritas Storage Foundation TM Volume Replicator 

Administrator's Guide.
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additional disk group. Provide unique names for the Replicated Data Set name, 

and the Replicated Volume Group name. 

Configuring a RVG service group for replication

The RVG service group is a hybrid because it behaves as a failover service group 

within a zone and as a parallel service group between zones.

Note: If you are creating a DR configuration manually in a non-shared storage 

environment, create a failover type of RVG service group.

For more information about service group types, see the Veritas Cluster Server 

Administrator’s Guide.

Configure the RVG service group resources manually by copying and modifying 

components of the application service group. Then create new RVG resources 

and bring them online.

Table 11-7 lists the resources in the RVG service group for RDC.

Creating the RVG service group
To contain the resources for replication, you need to create a hybrid replicated 

volume (RVG) service group.

Note: If you are creating a DR configuration manually in a non-shared storage 

environment, create a failover type of RVG service group.

To create a RVG service group

1 From VCS Cluster Manager (Java Console), log on to the cluster.

Table 11-7 Replication service group resources

Resource Description

IP IP address for replication

NIC Associated NIC for this IP

VMDg (shared storage) or VMNSDg (non-shared 

storage) for the disk group

Volume Manager disk group for the 

application

VvrRvg for the disk group Replicated volume group for the 

application
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2 In the VCS Cluster Explorer window, right-click the cluster in the left pane 

and select Add Service Group.

3 In the Add Service Group window, do the following, in the order presented:

■ Enter a name for the service group. Choose a service group name that is 

meaningful for the type of application you are using. This example 

adds a FileShare RVG service group called FS_RVG_SG.

■ Select the systems in the primary zone (zone 0) and click the right 

arrow to add them to the service group.

■ Select Hybrid.

If you creating the RVG service group for a DR configuration in a 

non-shared storage environment, select Failover.

■ Click OK.

Note: If you are setting up replication in a non-shared storage environment, you 

can use the replication service group template, VvrRvgVMNSRVGGroup, available 

in the Java Console. For an RDC configuration, ensure that you select the service 

group type as Hybrid while creating the service group using the Configuration 

Wizard from Java Console.
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Configuring the resources in the RVG service group  
for RDC replication

Configure the RVG service group’s resources manually for RVG by completing 

the tasks in Table 11-8:

Configuring the IP and NIC resources

Configure the following resources and attributes for the IP and NIC:

Table 11-8 RVG service group configuration tasks

Task For more information, see

Copy IP and NIC resources of the application 

service group, paste and modify them for the 

RVG service group.

“Configuring the IP and NIC resources” on 

page 400

Copy the VMDg (in case of shared storage) or 

VMNSDg (in case of non-shared storage) 

resources for the disk groups in the 

application service group, paste and modify 

them for the RVG service group.

“Configuring the VMDg or VMNSDg 

resources for the disk groups” on 

page 402

Create the VVR RVG resources for the disk 

group and enter the attributes for the disk 

group and the replication IP address.

“Adding the VVR RVG resources for the 

disk groups” on page 404

Link the VVR RVG resources to establish the 

dependencies between the VMDg or 

VMNSDg resources, the IP resource for 

replication, and the VVR RVG resources for 

the disk group.

Configure the RVG service group’s VMDg or 

VMNSDg resources to point to the disk group 

that contain the RVGs.

“Linking the VVR RVG resources to 

establish dependencies” on page 405

Delete the VMDg or VMNSDg resources from 

the application service group, because they 

depend on the replication and were 

configured in the RVG service group.

“Deleting the VMDg or VMNSDg resource 

from the application service group” on 

page 406

Table 11-9 IP and NIC resources

Resource Attributes to modify

IP Address

NIC (none)
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Note: In a non-shared storage environment, if you use the Java Console 

template, VvrRvgVMNSRVGGroup, to create the RVG service group, then do not 

recreate these resources; you modify the attributes of the existing IP and NIC 

resources in the service group.

To create the IP resource and NIC resource

1 In the VCS Cluster Explorer window, select the application service group in 

the left pane.

2 On the Resources tab, right-click the IP resource, and click Copy > Self and 

Child Nodes.

3 In the left pane, select the RVG service group.

4 On the Resources tab, right-click in the blank resource display area and 

click Paste.

5 In the Name Clashes window, change the names of the IP and NIC resources 

for the RVG service group and click OK.

To modify the IP resource and NIC

1 In the Resources tab display area, right-click the IP resource and select View 

> Properties View.

2 In the Properties View window, for the Address attribute, click Edit.

3 In the Edit Attribute window, enter the VVR IP address for the Primary Zone 

as the scalar value. This is the IP address you specified as the Primary side 

IP address while configuring the Replicated Data Set (RDS) earlier using the 

RDS wizard.

4 Close the Properties View window.
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To enable the IP resource and NIC

1 In the Resources tab display area, right-click the IP resource and select 

Enabled.

2 In the Resources tab display area, right-click the NIC resource and select 

Enabled.

Configuring the VMDg or VMNSDg resources for the disk 
groups

Configuration involves the following tasks:

■ Create the VMDg (in case of shared storage) or VMNSDg (in case of 

non-shared storage) resources in the RVG service group by copying them 

from the application service group.

■ If you are creating a DR configuration in a non-shared storage environment, 

modify the DGGuid attribute for the new VMDg or VMNSDg resource in the 

RVG service groups at both the sites (primary site and the disaster recovery 

site) separately to ensure the desired failover behavior.

Configure the following attributes in the application service group for the 

MountV resource:

To create a VMDg or VMNSDg resource for the disk group

1 In the VCS Cluster Explorer window, select the application service group in 

the left pane.

2 On the Resources tab, right-click the VMDg or VMNSDg resource for the 

disk group, and click Copy > Self.

3 In the left pane, select the RVG service group.

4 On the Resources tab, right-click in the blank resource display area and 

click Paste.

5 In the Name Clashes window, change the name of the VMDg or VMNSDg 

resource for the RVG service group.

6 Click OK.

Table 11-10 MountV resources

Resource Attributes to modify

Resources for the disk group for the application files:

MountV VMDg Resource Name 
Volume Name
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To modify the DGGuid attribute for the new VMDg or VMNSDg resource in the 

RVG service group

1 From the VCS Cluster Explorer, in the left pane, select the RVG service group 

(EVS1_RVG_SG).

2 In the right pane, select the Resources tab.

3 In the Resources tab display area, right-click the new VMDg or VMNSDg 

resource and click View > Properties View.

4 In the Properties View window, locate the DGGuid attribute and click the 

edit icon.

5 In the Edit Attribute window, edit the attribute as follows:

a Select Per System.

b From the dropdown list select the first node in the primary zone (Zone 

0). 

c In the Scalar Value field specify the GUID of the disk group that is 

imported on the node.

Run the VMGetDrive utility at the command prompt to retrieve the 

GUID.

d Repeat steps b and c, each time select a different node from the 

dropdown list. You must specify the GUID separately for each node 

displayed in the dropdown list.

In case of a shared storage environment (VMDg resource), if there are 

multiple nodes in the primary zone, then the disk group GUID will be 

the same for all systems within the zone. However, the GUID will 

always be different across zones.

6 In the Properties View window, verify that all nodes in the RDC primary 

zone have DGGuid values specified.

Note: If you are creating a DR configuration manually for a non-shared 

storage environment, you have to modify the DGGuid attribute of the 

VMNSDg resource in the RVG service groups at both the sites (primary site 

and the disaster recovery site) separately.

7 Close the Properties View window.
 

To modify the MountV resources in the application service group

1 In the VCS Cluster Explorer window, select the application service group in 

the left pane.
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2 In the Resources tab display area, right-click the MountV resource for the 

application and select View > Properties View.

3 In the Properties View window, verify that the Volume Name attribute is the 

volume created for the application.

4 In the same Properties View window, for the VMDg Resource Name 

attribute, click Edit.

5 In the Edit Attribute window, modify the VMDGResName scalar value to be 

the VMDg (in case of shared storage) or VMNSDg (in case of non-shared 

storage) resource that was just created in the RVG service group.

6 Close the Properties View window.

7 Repeat the steps for any additional MountV resources for the application.

To enable the VMDg or VMNSDg resource in the RVG service group

1 In the left pane, select the RVG service group.

2 In the Resources tab display area, right-click the VMDg or VMNSDg 

resource and select Enabled.

Adding the VVR RVG resources for the disk groups

Add a VvrRvg resource for replication of the disk group. If the application has 

multiple disk groups, create a separate VvrRvg resource for each disk group.

Configure the following attributes in the RVG service group for the VvrRvg 

resource:

To create the VVR RVG resource for the disk group

1 In the left pane, select the RVG service group. Right-click it and select Add 

Resource.

2 In the Add Resource window, do the following, in the order presented:

■ Enter the Resource Name for the VVR RVG resource.

■ Select the Resource Type of VvrRvg.

Table 11-11 VvrRvg resources

Resource Attributes to modify

Resources for the disk group for the application files:

VvrRvg VMDgResName 
IPResName
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3 In the Add Resource window the attributes appear. For the RVG attribute, 

click Edit.

4 In the Edit Attribute window, enter the name of the RVG that is being 

managed.

The RVG name is the name you specified when you created the Replicated 

Data Set (RDS) earlier using the RDS wizard. You can retrieve the RVG 

name by running the command vxprint -VPl.

5 Click OK.

6 In the Add Resource window, for the VMDGResName attribute, click Edit.

7 In the Edit Attribute window, enter the name of the disk group containing 

the RVG.

8 Click OK.

9 In the Add Resource window, for the IPResName attribute, click Edit.

10 In the Edit Attribute window, enter the name of the IP resource managing 

the IP address for replication.

11 Click OK.

12 In the Add Resource window, verify that the attributes have been modified.

13 Click OK.

Linking the VVR RVG resources to establish dependencies

In the VCS Cluster Explorer window, link the resources in the RVG service group 

to establish the dependencies between the resources. Start from the top parent 

and link the following resources. Depending on the application you use, your 

resource names may be different.
(

To link the VVR RVG resources

1 In the left pane, select the RVG service group.

2 Click the Link button in the right pane.

Table 11-12 Dependencies for VVR RVG resources for RDC

Parent Child

Resources for the disk group for the application system files:

FS_RVG_SG-VvrRvg The IP for replication, for example FS_RVG_SG-IP

FS_RVG_SG-VvrRvg The VMDg or VMNSDg for the application, for example 

FS_RVG_SG-VMDg or FS_RVG_SG-VMNSDg
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3 To link the VvrRvg resource to the IP resource, click the parent resource, for 

example FS_RVG_SG_VvrRvg, and then click the child resource, for example 

FS_RVG_SG_-IP.

4 When prompted to confirm, click OK.

5 To link the VvrRvg resource to the VMDg or VMNSDg resource, click the 

parent resource, for example INST1_DB1_VvrRvg, and then click the child 

resource, for example INST1_RVG_SG-VMDg or INST1_RVG_SG-VMNSDg.

6 When prompted to confirm, click OK.

7 Repeat these steps to link all the RVG resources.

Notice that when you enable a resource and the state of the entity which it 

is monitoring is online, the corresponding VCS agent reports status for that 

resource as online. You do not have to bring the resource online manually.

Deleting the VMDg or VMNSDg resource from the application 
service group

The VMDg (in case of shared storage) or VMNSDg (in case of non-shared 

storage) resources must now be manually deleted from the application service 

group, because they depend on replication and were configured in the RVG 

service group.

To delete the VMDg or VMNSDg Resources from the application group

1 In the VCS Cluster Explorer window, select the application service group 

from the left pane.

2 In the Resources tab display area, right-click the VMDg or VMNSDg 

resource for the disk group and select Delete.

3 Click Yes to confirm that you want to delete it (even if it is online).

4 In the Resources tab display area, right-click the VMDg or VMNSDg 

resource for any additional group and select Delete.

5 Click Yes to confirm that you want to delete it (even if it is online).

Configuring the RVG Primary resources
For each application disk group, add a resource of type RVGPrimary to the 

application service group and configure the attributes.

Set the value of the RvgResourceName attribute to the name of the RVG 

resource for the RVGPrimary agent. This is the name of the VvrRvg resource in 

the RVG replication service group.
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Configure the following attributes in the application service group for the RVG 

Primary resources:

Creating the RVG Primary resources

Create an RVG Primary Resource for replication.

To create the RVG Primary resource for an application’s disk group

1 In the VCS Cluster Explorer window, right-click the application service 

group in the left pane, and select Add Resource.

2 In the Add Resource window, do the following, in the order presented:

■ Enter the Resource Name for the RVG Primary resource for the 

application disk group.

■ Select the Resource Type of RVGPrimary.

3 In the Add Resource window the attributes appear. For the 

RvgResourceName attribute, click Edit.

4 In the Edit Attribute window, enter the name of the VVR RVG resource, and 

click OK.

This is the name of the VvrRvg resource in the RVG replication service 

group.

Table 11-13 RVG Primary resources

Resource Attributes to Modify

Resources for the disk group for the application:

RVGPrimary RvgResourceName
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5 If desired, set the AutoTakeover and AutoResync attributes from their 

defaults. See the VVR Administrator’s Guide for more information about the 

RVG Primary agent.

6 Verify that Critical and Enabled are both checked.

7 Click OK.

Linking the RVG Primary resources to establish 
dependencies

In the VCS Cluster Explorer window, link the resources in the application service 

group to establish the dependencies between the resources for replication. 

Start from the top parent and link the resources for your application.

As an example, Table 11-14 lists the Parent and Child relationship for the 

FileShare application.

To link the RVG Primary resources

1 In the left pane, select the application service group.

2 Click the Link button in the right pane.

3 Click the parent resource.

4 Click the child resource.

5 When prompted to confirm, click OK.

6 Repeat these steps to link any additional RVG Primary resources.

Bringing the RVG Primary resources online

In the VCS Cluster Explorer window, bring the RVG Primary resources in the 

application service group online on the first node in the primary zone.

To bring the RVG Primary resources online

1 In the left pane, select the application service group.

2 In the right pane on the Resources tab, right-click the first RVG Primary 

resource, and select Online > SYSTEM1.

3 In the right pane on the Resources tab, right click any additional RVG 

Primary resource, and select Online > SYSTEM1.

Table 11-14 Dependencies for the RVG Primary resources for RDC

Parent Child

FS_ SG-MountV FS_RvgPrimary
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Configuring the primary system zone for the RVG service group
In the RVG service group, set up systems in the primary zone (zone 0) to specify 

that initial failover occurs to systems within the primary zone for the RVG 

service group.

To configure the primary system zone for the RVG service group

1 From VCS Cluster Explorer, in the left pane, select the RVG service group.

2 In the right pane, select the Properties tab.

3 In the Properties pane, click the button Show All Attributes.

4 In the Attributes View, scroll down and select the SystemZones attribute.

5 Click the Edit icon for the SystemZones attribute.

6 In the Edit Attribute dialog box, click the plus sign and enter the systems 

and the zone number (zone 0) for the primary zone. 

In case of a non-shared storage configuration, add only the single node to 

the primary zone.

7 Click OK.

Setting a dependency between the service groups
The RVG service group must be online on both the primary and secondary 

zones. However, if a failover occurs from one node to another within the same 

zone, the RVG service group must fail over along with the application service 

group.

To ensure that the application service group and the RVG service group fail over 

and switch together from one node to another within the same zone, set up an 

online local hard dependency between the RVG service group and the 

application service group. The application service group depends on the RVG 

service group.

To set up an online local hard dependency

1 From VCS Cluster Explorer, in the left pane, select the cluster 

(MYCLUSTER).

2 In the right pane, select the Service Groups tab.

3 Click the Link button to create a dependency between service groups.

4 Click the application service group (the parent service group).

5 Click the RVG service group (the child resource).

6 In the Link Service Groups window, do the following, in this order:
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■ Select the Relationship of online local.

■ Select the Dependency Type of hard.

■ Click OK.

Adding the nodes from the secondary zone to the 
RDC

Configuration of the systems in the Primary Zone (zone 0) is complete. The 

nodes in the Secondary Zone (zone 1) can now be added to the RDC 

configuration.

Adding the nodes from the secondary zone 
to the RVG service group

Use the Volume Replicator Agent Configuration Wizard to add the nodes from 

the secondary zone to the RVG.

Note: In case of a non-shared storage environment, perform this task manually 

using the Java Console. You cannot use the wizard to modify the RVG service 

group.

To add the nodes from the secondary zone to the RVG

1 From the active node of the cluster in the primary zone, click Start > All 

Programs > Symantec > Veritas Cluster Server > Configuration Tools > 

Volume Replicator Agent Configuration Wizard to launch the configuration 

wizard. 

2 Read and verify the requirements on the Welcome page, and click Next.

3 In the Wizard Options dialog box, do the following, in the order presented: 

■ Click Modify an existing replication service group. The existing 

replication service group is selected, by default.

■ Click Next.

4 If a VCS notice message appears, asking if you want to continue, click Yes.

5 Specify the system priority list. Do the following in the order presented:

■ In the Available Cluster Systems box, click the nodes in the secondary 

zone to add to the service group, and click the right-arrow icon to move 

the nodes to the service group’s system list. 
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■ To remove a node from the service group’s system list, click the node in 

the Systems in Priority Order box, and click the left arrow icon.

■ To change the priority of a node in the system list, click the node in the 

Systems in Priority Order box, then click the up and down arrow icons. 

The node at the top of the list has the highest priority.

■ To enable the service group to automatically come online on one of the 

systems, select the Include selected systems in the service group's 

AutoStartList attribute checkbox.

For information about the AutoStartList attribute, see the Veritas 

Cluster Server Administrator's Guide.

■ Click Next.

6 If a message appears, indicating that the configuration will be changed from 

Read Only to Read/Write, click Yes to continue.

7 Review the Disk Group and Replicated Volume Group Configuration and 

click Next. 

8 In the IP Resource Options dialog box, select Modify IP resource and click 

Next.

9 If a VCS error appears, click OK.

10 In the Network Configuration dialog box, verify that the selected adapters 

are correct and click Next. 

11 Review the summary of the service group configuration. In the Resources 
box, click a resource to view its attributes and their configured values in the 

Attributes box.

12 Click Next to modify the replication service group.

13 At the prompt, click Yes to modify the service group. 

14 Click Finish.

Use the following procedure if the RVG service group contains a VMNSDg 

resource (non-shared storage environment).

To add nodes from the secondary zone to the RVG service group using Java 

Console

1 From VCS Cluster Explorer, in the left pane, right-click the RVG service 

group and select View > Properties View.

2 In the Attributes window, click Show all attributes.

3 From the attributes list, select the attribute SystemList and click the edit 

icon.

4 In the Edit Attribute window, edit the SystemList attribute as follows:
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a Click the + button to add an empty row.

b In the System field type the cluster node name from the secondary 

zone.

c In the Priority field type 1.

d Click OK.

5 Close the Attributes windows.

Configuring secondary zone nodes in the RVG service group
Specify zone 1 for the nodes in the secondary zone.

To specify the secondary zone for the nodes in the RVG service group

1 From VCS Cluster Explorer, in the left pane, select the RVG service group.

2 In the right pane, select the Properties tab.

3 In the Properties pane, click the button Show All Attributes.

4 In the Attributes View, scroll down and select the SystemZones attribute.

5 Click the Edit icon for the SystemZones attribute.

6 If a message appears indicating that the configuration be changed to 

read/write, click Yes. 

7 In the Edit Attribute dialog box, click the plus sign and enter the systems 

and the zone number (zone 1) for the secondary zone. 

In case of a non-shared storage configuration, add only the single node to 

the secondary zone.

8 Click OK and close the Attributes View window.

Configuring the RVG service group NIC resource  
for fail over (VMNSDg only)

This procedure is applicable only if you setting up RDC configuration in a 

non-shared storage environment where the RVG service group contains a 

VMNSDg resource.

Modify the MACAddress attribute of the NIC resource in the RVG service group 

to ensure desired fail over behavior in the RDC.

To modify the NIC resource in the RVG service group

1 From the VCS Cluster Explorer, in the left pane, select the RVG service 

group.
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2 In the right pane, select the Resources tab.

3 In the Resources tab display area, right-click the NIC resource and click View 

> Properties View.

4 In the Properties View window, locate the MACAddress attribute and click 

the edit icon.

5 In the Edit Attribute window, edit the attribute as follows:

■ Select Per System.

■ From the dropdown list, select the node in the RDC primary zone.

■ In the Scalar Value field, enter the physical address (MAC address) of 

the network interface card (NIC) to be monitored on the primary zone 

system.

Use the ipconfig -all command to retrieve the physical address.

■ From the dropdown list, select the node in the RDC secondary zone.

■ In the Scalar Value field, enter the physical address (MAC address) of 

the network interface card (NIC) to be monitored on the secondary zone 

system.

Use the ipconfig -all command to retrieve the physical address.

■ Click OK.

6 In the Properties View window, verify that the MACAddress attribute for the 

nodes in the primary and secondary zone are different.

7 Close the Properties View window.
 

Configuring the RVG service group IP resource for failover
Modify the IP resources in the RVG service group to ensure the desired failover 

behavior in the RDC.
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If the application fails, VCS tries to fail over the application service group to 

another system within the same RDC system zone. However, if VCS cannot find 

a failover target node in the primary zone, it switches the service group to a 

node in the current secondary system zone. 

Use the following procedure to modify the IP resources.

Note: For IPv6 networks, modify the IPv6 resource.

To modify the IP resources in the RVG service group

1 From VCS Cluster Explorer, in the left pane, select the RVG service group.

2 In the right pane, select the Resources tab.

3 Right-click the RVG IP resource and select View > Properties View.

4 In the Edit Attributes window, edit the Address attribute. Do the following in 

the order presented:

■ Select Per System.

■ Select the first node in the primary zone and enter the virtual IP 

address for the primary zone.

■ Select the second node in the primary zone and enter the virtual IP 

address for the primary zone (the same IP address as the first node).

■ Repeat for all nodes in the primary zone.

■ Select the first node in the secondary zone and enter the virtual IP 

address for the secondary zone.

■ Select the second node in the secondary zone and enter the virtual IP 

address for the secondary zone (the same IP address as the first node in 

the secondary zone).

■ Repeat for all nodes in the secondary zone.

■ Click OK.

5 In the Properties View window, verify that all nodes in the primary zone 

have the same IP address. Also verify that all nodes in the secondary zone 
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have the same IP address. The IP address at the primary zone and the 

secondary zone should be different.

6 This step is applicable only if you are using a non-shared storage 

environment (VMNSDg agent).

In the Edit Attributes window, edit the MACAddress attribute as follows:

■ Select Per System.

■ From the dropdown list, select the node in the RDC primary zone.

■ In the Scalar Value field, enter the physical address (MAC address) of 

the network interface card (NIC) to be monitored on the primary zone 

system.

Use the ipconfig -all command to retrieve the physical address.

■ From the dropdown list, select the node in the RDC secondary zone.

■ In the Scalar Value field, enter the physical address (MAC address) of 

the network interface card (NIC) to be monitored on the secondary zone 

system.

Use the ipconfig -all command to retrieve the physical address.

■ Click OK.

7 In the Properties View window, verify that the MACAddress attribute for the 

nodes in the primary and secondary zone are different.

8 Close the Properties View window.

Since this is the final task in configuring the RVG service group for the 

primary and secondary zones, you can now bring the RVG service group 

online in both the primary and secondary zones.
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Configuring the RVG service group VMNSDg resources  
for fail over

This procedure is applicable only if you setting up RDC configuration in a 

non-shared storage environment where the RVG service group contains a 

VMNSDg resource.

Modify the DGGuid attribute of the VMNSDg resources in the RVG service group 

to ensure the desired failover behavior in the RDC.

To modify the VMNSDg resources in the RVG service group

1 From VCS Cluster Explorer, in the left pane, select the RVG service group.

2 In the right pane, select the Resources tab.

3 Right-click the RVG VMNSDg resource and select View > Properties View.

4 In the Edit Attributes window, edit the DGGuid attribute as follows:

■ Select Per System.

■ Select the node in the RDC secondary zone.

■ In the Scalar Value field, enter the GUID of the dynamic disk group that 

is imported on the single node in the RDC secondary zone.

You can retrieve the disk group details running the VMGetDrive utility 

from the command prompt.

■ Click OK.

5 In the Properties View window, verify that the DGGuid for the nodes in the 

primary and secondary zone are different.

6 Close the Properties View window.

As this is the final task in configuring the RVG service group for the 

primary and secondary zones, you can now bring the RVG service group 

online in both the primary and secondary zones.
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Adding the nodes from the secondary zone to the application  
service group

Use the wizard appropriate to your application to add the nodes from the 

secondary zone to the application service group.

Note: In case of a non-shared storage environment, perform this task manually 

using the Java Console. You cannot use the wizard to modify the application 

service group.

Use the following procedure if the service group contains a VMDg resource 

(shared storage environment).

To add nodes from the secondary zone to the application service group

1 Select Start > All Programs > Symantec > Veritas Cluster Server > 

Configuration Tools > File Share Configuration Wizard.

2 The File Share Configuration Wizard screen appears. This screen displays 

the pre-requisites and User Input Required. Verify that you have meet the 

prerequisites listed and click Next.

3 The Wizard Options window is then displayed. In the Wizard Options 

window, select the Modify service group option. Then, select the File Share 

service group below this option and click Next.

4 In the Service Group Configuration window, review and make the following 

updates if required:

■ To add nodes from the secondary zone to the application service group, 

select them in Available Cluster Systems and use the right arrow 

button to move them to Systems in Priority Order.

■ To change the priority of a system, select the system in the Systems in 

Priority Order list and click the up and down arrow buttons.

Arrange the systems in priority order in as failover targets for the 

group. The server that needs to come online first must be at the top of 

the list followed by the next one that will be brought online. This set of 

nodes selected for the application service group must be the same as 

the nodes selected for the RVG service group. Ensure that the nodes are 

also in the same priority order.

■ To enable the service group to automatically come online on one of the 

systems, select the Include selected systems in the service group's 

AutoStartList attribute checkbox.

For information about the AutoStartList attribute, see the Veritas 

Cluster Server Administrator's Guide.



418 Deploying Replicated Data Clusters: New application installation

Adding the nodes from the secondary zone to the RDC
Click Next.

5 In the FileShare Configuration window, enter a virtual computer name and 

select the directories to be shared. Click Next.

6 In the Share Permissions window, select the fileshare users and assign them 

permissions. Click Next.

7 In the Network Configuration window, configure your Virtual IP address and 

Subnet Mask. Specify the adapter to be used on each system, by entering the 

system name and adapter display name. Click Next.

8 In the Service Group Summary window, review the service group 

configuration.

■ Press F2 to edit the resource names.

■ To enable all the VMDg resources in the service group for fast failover, 

select the Enable FastFailOver attribute for all the VMDg resources in 

the service group checkbox.

For information about the FastFailOver attribute, see the Veritas 

Cluster Server Administrator’s Guide.

Click Next.

9 A message appears if the configuration is currently in the Read Only mode. 

Click Yes to make the configuration read and write enabled. The wizard 

validates the configuration and modifies it.

10 Click Finish.

Use the following procedure if the service group contains a VMNSDg 

resource (non-shared storage environment).

To add nodes from the secondary zone to the application service group using 

Java Console

1 From VCS Cluster Explorer, in the left pane, right-click the application 

service group and select View > Properties View.

2 In the Attributes window, click Show all attributes.

3 From the attributes list, select the attribute SystemList and click the edit 

icon.

4 In the Edit Attribute window, edit the SystemList attribute as follows:

a Click the + button to add an empty row.

b In the System field type the cluster node name from the secondary 

zone.

c In the Priority field type 1.



419Deploying Replicated Data Clusters: New application installation

Adding the nodes from the secondary zone to the RDC
d Click OK.

5 Close the Attributes windows.

Configuring the zones in the application service group
Specify zone 1 for the nodes in the secondary zone.

To specify the secondary zone for the nodes in the application service group

1 From VCS Cluster Explorer, in the left pane, select the application service 

group.

2 In the right pane, select the Properties tab.

3 In the Properties pane, click the button Show All Attributes.

4 In the Attributes View, scroll down and select the SystemZones attribute.

5 Click the Edit icon for the SystemZones attribute.

6 If a message appears indicating that the configuration be changed to 

read/write, click Yes. 

7 In the Edit Attribute dialog box, click the plus sign and enter the systems 

and the zone number (zone 1) for the secondary zone. 

In case of a non-shared storage configuration, add only the single node to 

the secondary zone.

8 Click OK.

9 Close the Attributes View window.

Configuring the application service group IP resource  
for fail over (VMNSDg only)

This procedure is applicable only if you setting up RDC configuration in a 

non-shared storage environment (VMNSDg agent).

Modify the IP resource in the application service group to ensure the desired 

failover behavior in the RDC.

Note: For IPv6 networks, modify the IPv6 resources.

To modify the IP resource in the application service group

1 From VCS Cluster Explorer, in the left pane, select the application service 

group.
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2 In the right pane, select the Resources tab.

3 Right-click the IP resource and select View > Properties View.

4 In the Edit Attributes window, edit the MACAddress attribute as follows:

■ Select Per System.

■ From the dropdown list, select the node in the RDC primary zone.

■ In the Scalar Value field, enter the physical address (MAC address) of 

the network interface card (NIC) to be monitored on the primary zone 

system.

Use the ipconfig -all command to retrieve the physical address.

■ From the dropdown list, select the node in the RDC secondary zone.

■ In the Scalar Value field, enter the physical address (MAC address) of 

the network interface card (NIC) to be monitored on the secondary zone 

system.

Use the ipconfig -all command to retrieve the physical address.

■ Click OK.

5 In the Properties View window, verify that the MACAddress attribute for the 

nodes in the primary and secondary zone are different.

6 Close the Properties View window.
 

 

Configuring the application service group NIC resource  
for fail over (VMNSDg only)

This procedure is applicable only if you setting up RDC configuration in a 

non-shared storage environment (VMNSDg agent).

Modify the MACAddress attribute of the NIC resource in the application service 

group to ensure desired fail over behavior in the RDC.

To modify the NIC resource in the application service group

1 From the VCS Cluster Explorer, in the left pane, select the application 

service group.

2 In the right pane, select the Resources tab.

3 In the Resources tab display area, right-click the NIC resource and click View 

> Properties View.

4 In the Properties View window, locate the MACAddress attribute and click 

the edit icon.
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5 In the Edit Attribute window, edit the attribute as follows:

■ Select Per System.

■ From the dropdown list, select the node in the RDC primary zone.

■ In the Scalar Value field, enter the physical address (MAC address) of 

the network interface card (NIC) to be monitored on the primary zone 

system.

Use the ipconfig -all command to retrieve the physical address.

■ From the dropdown list, select the node in the RDC secondary zone.

■ In the Scalar Value field, enter the physical address (MAC address) of 

the network interface card (NIC) to be monitored on the secondary zone 

system.

Use the ipconfig -all command to retrieve the physical address.

■ Click OK.

6 In the Properties View window, verify that the MACAddress attribute for the 

nodes in the primary and secondary zone are different.

7 Close the Properties View window.
 

Verifying the RDC configuration
After completing all the configuration tasks for the primary and secondary 

zones, you can bring the service group online, then verify the configuration.

Perform the following tasks:

■ Bringing the service group online

■ Switching online nodes
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Bringing the service group online
After completing all configuration, ensure that the RVG service group is online 

in both the primary and secondary zone. Then you can bring the service group 

online in the primary zone.

To bring the service group online 

1 From VCS Cluster Explorer, in the left pane, right-click the service group (for 

example, EVS1_SG1).

2 Click Online.

Switching online nodes
An important part of configuration testing is simulating a failover. Test the 

failover by switching the application service group between online nodes.

The RVG service group is online in both the primary and secondary zone. 

However, within a zone, if more than node is configured, the RVG service group 

should fail over with the application service group.

Note: This should never be tested on systems with live data. A reliable and tested 

backup should be available. A tested backup means that it has been tested 

successfully by a restore.

Switch the application service group between nodes using Veritas Cluster 

Manager (Java Console). When you complete the procedure, you will see the 

online system role shift from one system to another.

If you enter the system name manually from the Java Console, specify the name 

in upper case.

To switch online nodes

1 Open the Veritas Cluster Manager (Java Console). Click Start > All Programs 

> Symantec > Veritas Cluster Manager (Java Console).

2 Click Click here to log in for the appropriate cluster. If this is your first use 

of the Veritas Cluster Manager, in the File menu, click New Cluster. In the 

New Cluster - Connectivity Configuration window, enter the computer name 

in the Host name field and click OK.

3 In the Machinename - Login window, enter your user name and password in 

the respective fields and click OK.

4 In the left pane, right-click the service group, and select an alternate system 

name from the Switch To entry.
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5 In the Question dialog box, click Yes to confirm that you want to switch the 

service group to the other node.

Additional instructions for GCO disaster recovery
After you complete the tasks for setting up a replicated data cluster for an 

application service group, you can optionally create a secondary site for wide 

area disaster recovery using the SFW HA Global Cluster option (GCO).

With this option, if a disaster affects a local or metropolitan area, data and 

critical services are failed over to a site hundreds or thousands of miles away. 

To configure disaster recovery using a secondary site, you must install the SFW 

HA Global Cluster Option on all nodes on the primary (replicated data cluster) 

site cluster, as well as the secondary (DR) site cluster. GCO configuration also 

requires a static IP address available for each site.

You can use the Disaster Recovery (DR) wizard when setting up the secondary 

site. The secondary site is not configured as a replicated data cluster. There can 

be only one replicated data cluster in the DR environment. The DR wizard does 

the following tasks:

■ Clones the storage

■ Clones the application service group

■ Sets up VVR replication for the secondary site

■ Configures the primary and secondary site clusters as global clusters

See “Deploying disaster recovery: New application installation” on page 435.
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Disaster Recovery

This section includes the following chapters:

■ Disaster recovery: Overview

■ Deploying disaster recovery: New application installation

■ Testing fault readiness by running a fire drill
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Disaster recovery: 

Overview

This chapter covers the following topics:

■ “About a disaster recovery solution” on page 427

■ “Need for implementing a disaster recovery solution” on page 429

■ “Overview of the recovery process” on page 430

■ “Components of VVR that enable disaster recovery” on page 431

About a disaster recovery solution
A disaster recovery (DR) solution is a series of procedures used to safely and 

efficiently restore application data and services in the event of a catastrophic 

failure. A typical disaster recovery solution requires that you have a source host 

on the primary site and a destination host on the secondary site. The application 

data is stored on the primary site and replicated to the secondary site by using a 

tool such as the Veritas Volume Replicator. The primary site provides data and 

services during normal operation. If a disaster occurs on the primary site and its 

data is destroyed, a secondary host can take over the role of the primary host to 

make the data accessible. The application can be restarted on that host. 

This chapter is an overview of the Veritas Volume Replicator disaster recovery 

solution that can be used with SFW HA and VCS. SFW HA also supports array-

based hardware replication. SFW HA provides a configuration wizard for 

disaster recovery, which can be used with either VVR or hardware replication.

For details on configuring SFW HA disaster recovery using the wizard, see 

“Deploying disaster recovery: New application installation” on page 435.

For a SFW and VVR configuration with Microsoft clustering, see the following:
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■ Chapter 18, “Deploying SFW and VVR with Microsoft failover clustering” 

on page 651

The illustration below shows the SFW HA-VVR configuration with VCS. The 

example has one disk group on each site for the application. Note that a VVR 

Replicator Log is needed on each site. If there is more than one disk group, an 

additional Replicator Log is required for each disk group.
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Figure 12-1 SFW HA-VVR configuration with VCS

Need for implementing a disaster recovery solution
Two major trends affecting businesses today are reliance on data and 

geographic distribution. Continuous, consistent, fast, and reliable access to data 

is important. If a disaster occurs, quick availability of data becomes important. 

One of the ways of achieving this is by using replication.

A well-designed disaster recovery solution prepares a business for unexpected 

disasters and provides the following benefits in the event of a disaster:

■ Minimizes economic loss due to the unavailability or loss of data.

■ Ensures safe and efficient recovery of data and services.

■ Minimizes decision making during the disaster recovery.

■ Reduces reliance on key individuals.

■ Minimizes data loss during recovery and ensures availability of the most 

recent data.

A strategic disaster recovery (DR) solution can provide businesses with ways to 

meet their service level agreements, comply with government regulations, and 

minimize their business risk.
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Overview of the recovery process
The illustrations that follow show the typical disaster recovery setup before and 

after a disaster. 

In the illustration before the disaster, the primary host replicates its application 

data to the secondary host. In a disaster recovery environment, the cluster on 

the primary site provides data and services during normal operation; the cluster 

on the secondary site provides data and services if the primary cluster fails. 

Note that the primary and the secondary sites have clusters to make both the 

application and VVR highly available.

Figure 12-2 Typical disaster recovery configuration setup

If a disaster, such as an earthquake, causes a failure at the primary site, a host 

on the secondary site can take over the role of the primary host to make the data 

accessible and restore the application services and data to users.

Figure 12-3 Recovery situation after a disaster occurs
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Components of VVR that enable disaster recovery
This topic provides information about components of VVR that make the 

disaster recovery solution work.

Understanding replication
The term “replication” generally refers to the use of a tool or service, or a 

combination of tools or services, to automate the process of regularly placing an 

up-to-date copy of data from a designated source, or primary, to one or more 

remote locations. 

Replication can be used to provide solutions to problems in a variety of 

application environments. Any application that needs redundancy at multiple 

sites or can achieve better performance through geographic distribution can 

benefit from replication. Redundancy at multiple sites, where updates to the 

primary site are immediately reflected at remote sites, can be effectively used to 

manage disaster recovery with the use of a replication tool.

Veritas Volume Replicator (VVR) is a data replication service that helps to 

maintain a consistent copy of the application data at a remote site. It is built to 

contribute to an effective disaster recovery plan. If the primary data center is 

destroyed, the application data is readily available at the remote site, and the 

application can be restarted at the remote site. VVR works as an integrated 

component of Veritas Storage Foundation for Windows. Any application, even 

with existing data, can be configured to use VVR transparently. For more 

information on VVR, refer to the Veritas Storage Foundation Veritas Volume 

Replicator, Administrator’s Guide.

Modes of replication
VVR replicates in synchronous, asynchronous, and synchronous override 

modes. 

Synchronous replication

The synchronous mode ensures that an update has been acknowledged by the 

secondary host before completing the update at the primary site. Thus, the 

primary site and the secondary site have the same data. If a disaster occurs on 

the primary site and its data is destroyed, the secondary site will already have an 

up-to-date copy of the data.

The synchronous mode of replication is most effective in application 

environments that have lower update rates but require all the hosts to always 

reflect the same data, or where a delay in updates between the primary and 

secondary hosts is not acceptable.



432 Disaster recovery: Overview

Components of VVR that enable disaster recovery
Asynchronous replication

In the asynchronous mode of replication, the application updates are 

immediately reflected at the primary site and sent to the secondary site as soon 

as possible. The updates are stored in the Replicator Log until they are sent to 

the secondary site. This allows asynchronous replication to deal with temporary 

network or secondary host failures without affecting the performance of the 

application. 

Asynchronous replication mode is most effective in application environments 

where it is not acceptable for the application performance to be impacted, only a 

minimal data loss can be tolerated, or the application has a high rate of updates.

Synchronous override replication 

The synchronous override mode of replication provides synchronous 

replication, as long as the network is available. If the network becomes 

unavailable, replication is continued in asynchronous mode. 

The synchronous override replication mode is most effective in application 

environments where it is not acceptable for the primary site to be affected by a 

network failure.

Note: For additional information, refer to the Veritas Storage Foundation Veritas 

Volume Replicator, Administrator’s Guide. 

Features of VVR that help in disaster recovery
While many of the components described above are replicated at the disaster 

recovery site through conventional means, VVR solves the difficult problem of 

replicating the user database. Refer to the following information on how VVR 

helps with disaster recovery in any application environment:

■ Write Order Fidelity: VVR guarantees that changes made to data on the 

primary host are made in the same sequence on the secondary host. This 

ensures that the data remains in a consistent state in the event of a disaster.

■ Synchronous Replication: VVR guarantees that changes committed on the 

primary host are committed on the secondary host first. This ensures that 

the data on the secondary host matches the data on the primary host and 

minimizes data loss in the event of a disaster.

■ Asynchronous Replication: VVR reflects the changes to the application 

immediately on the primary, and changes are then reflected on the 

secondary as soon as possible. Until the data is sent to the secondary, it is 

stored on the Replicator Log.
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■ RVG Snapshot: This provides the ability within VVR to take a point-in-time 

snapshot of a volume. This allows verification of the consistency of the data 

on the secondary host without impacting replication between the primary 

and secondary hosts.

■ Heterogeneous Storage Support: VVR provides a replication technology that 

works with heterogeneous storage hardware. VVR allows replication to 

occur between similar or dissimilar storage arrays from a vendor or between 

different storage arrays from different vendors. This allows for maximum 

use of existing hardware and provides flexibility when adding new 

hardware.
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Chapter 
13
Deploying disaster 

recovery: New application 
installation

This chapter covers the following topics:

■ “Tasks for a new disaster recovery installation —additional applications” on 

page 436

■ “Tasks for setting up DR in a non-shared storage environment” on page 440

■ “Reviewing the requirements” on page 442

■ “Reviewing the configuration” on page 449

■ “Configuring the storage hardware and network” on page 450

■ “Managing disk groups and volumes” on page 452

■ “Setting up the secondary site: Configuring SFW HA and setting up a 

cluster” on page 453

■ “Verifying that your application or server role is configured for HA at the 

primary site” on page 476

■ “Setting up your replication environment” on page 477

■ “Assigning user privileges (secure clusters only)” on page 484

■ “Configuring disaster recovery with the DR wizard” on page 485

■ “Cloning the storage on the secondary site using the DR wizard (VVR 

replication option)” on page 489

■ “Creating temporary storage on the secondary site using the DR wizard 

(array-based replication)” on page 493
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■ “Installing and configuring the application or server role (secondary site)” 

on page 497

■ “Cloning the service group configuration from the primary to the secondary 

site” on page 499

■ “Configuring replication and global clustering” on page 503

■ “Creating the replicated data sets (RDS) for VVR replication” on page 520

■ “Creating the VVR RVG service group for replication” on page 520

■ “Configuring the global cluster option for wide-area failover” on page 521

■ “Verifying the disaster recovery configuration” on page 525

■ “Establishing secure communication within the global cluster (optional)” on 

page 527

■ “Adding multiple DR sites (optional)” on page 529

■ “Possible task after creating the DR environment: Adding a new failover 

node to a VVR environment” on page 529

■ “Maintaining: Normal operations and recovery procedures (VVR 

environment)” on page 532

■ “Recovery procedures for service group dependencies” on page 534

Tasks for a new disaster recovery installation 
—additional applications

Before setting up disaster recovery at the secondary site, you must complete the 

high availability configuration for the application on the primary site.

See Chapter 6, “Deploying SFW HA for high availability: New installation” on 

page 63. 

You can also configure disaster recovery for a primary site that is configured as 

a replicated data cluster.

See Chapter 11, “Deploying Replicated Data Clusters: New application 

installation” on page 291.

After setting up an SFW HA environment on the primary site, you can create a 

secondary or “failover” site for disaster recovery.

The Disaster Recovery (DR) wizard helps you to clone the storage configuration 

and the service group configuration from the primary site to the secondary site. 

You can install the application on the secondary site during the DR wizard 

workflow.
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After service group configuration, the DR wizard helps you set up replication 

and global clustering (GCO option). You can choose to configure replication 

using VVR or an agent-supported array-based hardware replication. The DR 

wizard can configure required options for the VCS agents for EMC SRDF and for 

Hitachi TrueCopy. To use the wizard with any other agent-supported 

array-based replication, you must complete configuring global clustering with 

the wizard before configuring replication on the array.

The DR wizard is available from the Solutions Configuration Center. Symantec 

recommends using the Solutions Configuration Center as a guide for installing 

and configuring disaster recovery. 

See “Using the Solutions Configuration Center” on page 27.

Note: If you are using non-shared storage (dynamic disk groups monitored using 

VMNSDg agent), you cannot use the DR wizard to configure disaster recovery. 

You have to set up DR manually. Refer to the separate workflow table (See 

Table 13-2) available for configuring DR manually.

This chapter describes the process for any generic application or applications 

such as FileShare and IIS.

Table 13-1 outlines the high-level objectives and the tasks to complete each 

objective.
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Table 13-1 Task list for deploying disaster recovery

Objective Tasks

“Reviewing the 

requirements” on page 442

Verifying hardware and software prerequisites

“Reviewing the 

configuration” on page 449

Understanding active-passive configuration and site 

failover in a DR environment

“Configuring the storage 

hardware and network” on 

page 450

■ Setting up the network and storage for a cluster 

environment

■ Verifying the DNS entries for the systems on which 

the application will be installed

“Setting up the secondary 

site: Configuring SFW HA 

and setting up a cluster” on 

page 453

■ Installing SFW HA

■ Configuring the cluster using the Veritas Cluster 

Server Configuration Wizard

“Verifying that your 

application or server role is 

configured for HA at the 

primary site” on page 476

Verifying that the application has been configured for 

high availability at the primary site

“Setting up your replication 

environment” on page 477

Ensuring replication prerequisites for your selected 

method of replication are met before running the DR 

wizard

“Assigning user privileges 

(secure clusters only)” on 

page 484

For secure clusters only, assigning user privileges

“Configuring disaster 

recovery with the DR wizard” 

on page 485

■ Reviewing prerequisites for the DR wizard

■ Starting the DR wizard and selecting a primary site 

system, the service group, the secondary site system, 

and the replication method

“Cloning the storage on the 

secondary site using the DR 

wizard (VVR replication 

option)” on page 489

(VVR replication option) Cloning the storage 

configuration on the secondary 

“Creating temporary storage 

on the secondary site using 

the DR wizard (array-based 

replication)” on page 493

(EMC SRDF, Hitachi TrueCopy, or GCO only replication 

option) Using the DR wizard to create temporary storage 

for installation on the secondary site
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“Installing and configuring 

the application or server role 

(secondary site)” on page 497

■ Reviewing the prerequisite checklist

■ Installing the application

“Cloning the service group 

configuration from the 

primary to the secondary 

site” on page 499

Cloning the service group configuration from the primary 

to the secondary site using the DR wizard

“Configuring replication and 

global clustering” on 

page 503

■ (VVR replication) Using the wizard to configure 

replication and global clustering

■ (EMC SRDF replication) Setting up replication and 

then using the wizard to configure the SRDF 

resource and global clustering

■ (Hitachi TrueCopy) Setting up replication and then 

using the wizard to configure the HTC resource and 

global clustering

■ (Other array-based replication) Using the wizard to 

configure global clustering, and then setting up 

replication

“Verifying the disaster 

recovery configuration” on 

page 525

Verifying that the secondary site has been fully 

configured for disaster recovery

“Establishing secure 

communication within the 

global cluster (optional)” on 

page 527

Adding secure communication between local clusters 

within the global cluster (optional task)

“Adding multiple DR sites 

(optional)” on page 529

Optionally, adding additional DR sites to a VVR 

environment

“Possible task after creating 

the DR environment: Adding 

a new failover node to a VVR 

environment” on page 529

Completing required tasks when adding a new failover 

system to either the primary or secondary site in a VVR 

environment

“Maintaining: Normal 

operations and recovery 

procedures (VVR 

environment)” on page 532

■ Monitor replication

■ Perform planned migration

■ Complete the recovery procedures after the primary 

site goes down

Objective Tasks
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Tasks for setting up DR in a non-shared storage 
environment

Table 13-2 outlines the high-level objectives and tasks for a creating a 

single-node DR configuration at the secondary site. Refer to this table if you are 

setting up DR in a non-shared storage environment (dynamic disk groups 

configured using VMNSDg agent).

You cannot use the DR wizard to configure disaster recovery in a non-shared 

storage environment. You have to configure DR manually.

Note: Some procedures (for example, configuring VVR replication) are common 

if you are setting up a DR or an RDC configuration. To avoid duplication, the 

topics referenced in this table point to the procedures described in the RDC 

chapter covered earlier.

Table 13-2 Non-shared storage: Configuring Disaster Recovery

Action Description

Install SFW HA and configure 

the cluster on the secondary 

site

■ Verify the software and hardware prerequisites

■ Set up the network and storage

■ Install SFW HA

■ Configure the cluster at the secondary site 

Ensure that you select the GCO option to configure 

the Global Cluster Option resource for the cluster.

Caution: Ensure that the name you assign to the 

secondary site cluster is different from the name 

assigned to the primary site cluster.

■ Configure disk groups and volumes

See “Setting up the secondary site: Configuring SFW HA 

and setting up a cluster” on page 453.

Verify that the application has 

been configured for high 

availability at the primary site

Verify that the application has been configured for high 

availability at the primary site and that the service 

groups are online.

See “Verifying that your application or server role is 

configured for HA at the primary site” on page 476.
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Set up the replication 

prerequisites

■ Ensure that VVR replication prerequisites are met

■ Configure the VxSAS service for VVR, specifying 

the cluster nodes at both primary and secondary 

sites

See “Configuring the VVR security service” on page 478.

(Secure cluster only) Assign 

user privileges

For a secure cluster only, assign user privileges.

See “Assigning user privileges (secure clusters only)” on 

page 484.

Install the application at the 

secondary site

■ Reviewing the prerequisite checklist

■ Installing the application

See “Installing and configuring the application or server 

role (secondary site)” on page 497.

Configure the application 

service group for VCS 

(secondary site)

■ Configure the application service group manually 

using the Cluster Manager (Java Console)

■ Ensure that the name of the service group is the 

same as that on the primary site

See “Configuring the application service group in a 

non-shared storage environment” on page 502.

Set up the replicated data sets 

(RDS) for VVR replication

■ Use the Setup Replicated Data Set Wizard to create 

RDS and start replication for the primary and 

secondary sites

■ Use the Setup Replicated Data Set Wizard to create 

Replicator Log volumes for the primary and 

secondary sites

See “Creating the replicated data sets (RDS) for VVR 

replication” on page 520.

Create the VVR RVG service 

group

(repeat steps on primary and 

secondary site separately)

■ Create the VVR RVG service group for the replicated 

volume group

■ Use the Cluster Manager (Java Console) to manually 

create the service group

■ Create the RVG service group at the primary site 

and the secondary site separately

■ Bring the RVG service group online on the primary 

site

See “Creating the VVR RVG service group for 

replication” on page 520.

Table 13-2 Non-shared storage: Configuring Disaster Recovery

Action Description
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Reviewing the requirements
Review the following installation and configuration requirements for your 

systems before installation. Minimum requirements and Symantec 

recommended requirements may vary.

■ “Disk space requirements” on page 443

■ “Requirements for Veritas Storage Foundation High Availability for 

Windows (SFW HA)” on page 443

Review additional configuration topics before setting up disaster recovery.

Configure the global cluster 

option for wide-area failover

■ Link clusters (adding a remote cluster to a local 

cluster

■ Converting the application service group that is 

common to all the clusters to a global service group

■ Converting the local service group to a global group

■ Bringing the global service group online

See “Configuring the global cluster option for wide-area 

failover” on page 521.

Verify the disaster recover 

configuration

Verify that the secondary site has been fully configured 

for disaster recovery

See “Verifying the disaster recovery configuration” on 

page 525.

(Optional) Add secure 

communication

Add secure communication between local clusters within 

the global cluster (optional task)

See “Establishing secure communication within the 

global cluster (optional)” on page 527.

(Optional) Add additional DR 

sites

Optionally, add additional DR sites to a VVR 

environment

See “Adding multiple DR sites (optional)” on page 529.

Handling service group 

dependencies after failover

If your environment includes dependent service groups, 

review the considerations for bringing the service groups 

online after failover to the secondary site

See “Recovery procedures for service group 

dependencies” on page 534.

Table 13-2 Non-shared storage: Configuring Disaster Recovery

Action Description
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Disk space requirements
The following table estimates disk space requirements for SFW HA.

 

Requirements for Veritas Storage Foundation High Availability  
for Windows (SFW HA)

Before installing Veritas Storage Foundation High Availability for Windows 

(SFW HA), ensure that you review the following:

■ Review the general installation requirements for SFW HA in the Veritas 

Storage Foundation and High Availability Solutions for Windows Installation 

and Upgrade Guide.

■ Review the SFW HA Hardware Compatibility List to confirm supported 

hardware:

http://www.symantec.com/docs/TECH152806

■ Review the SFW HA Software Compatibility List to confirm supported 

software:

http://www.symantec.com/docs/TECH201485

Note: Solutions wizards cannot be used to perform Disaster Recovery, Fire 

Drill, or Quick Recovery remotely on Windows Server Core systems.

■ Review the operating systems supported with Veritas Storage Foundation 

High Availability for Windows (SFW HA).

■ When installing SFW HA for a Disaster Recovery configuration, ensure that 

you select the VCS Global Clustering Option and if required for your 

replication solution, select the SFW Veritas Volume Replicator option.

■ When installing SFW HA for a Replicated Data Cluster configuration, ensure 

that you select the VCS option to install Veritas Volume Replicator.

Supported operating systems
SFW and SFW HA have client and server components that run on specific 

Windows operating systems.

Table 13-3 Disk space requirements

Installation options Required disk space

SFW HA + all options 832 MB

Client components 916 MB

http://www.symantec.com/docs/TECH152806
http://www.symantec.com/docs/TECH201485
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SFW and SFW HA software for servers

Your system must run one of the operating systems listed to install the SFW or 

SFW HA server software.

Note: SFW software for servers supports Hyper-V and parent partitions. SFW 

HA software for servers does not support Hyper-V and parent partitions.

The following table shows supported operating systems.

SFW and SFW HA software for clients

The SFW or SFW HA client software can be installed on any one of the operating 

system versions, editions, and architectures that the Server Components are 

supported on, except Server Core.

The following table shows the additional client operating systems that are 

supported.

Table 13-4 Supported operating systems

Windows Server Platform Edition Version

Windows Server 2012 x64 Standard, Datacenter GA

Windows 2012 Server Core x64 GA

Table 13-5 Additional supported client operating systems

Windows Client Platform Edition Version

Windows XP x86, x64 SP3 required 

for x86; SP2 

required for 

x64

Windows Vista x86, x64 Ultimate, Business, Premium SP1 or SP2 

required

Windows 7 x86, x64 Professional, Ultimate RTM or SP1 

required

Windows 8 x86, x64 Windows 8, Windows 8 Pro GA
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System requirements for SFW HA
Systems must meet the following requirements for SFW HA:

■ Memory must be a minimum 4 GB of RAM per server for SFW HA.

■ Shared disks to support applications that migrate between nodes in the 

cluster. Campus clusters require more than one array for mirroring. Disaster 

recovery configurations require one array for each site. Replicated data 

clusters with no shared storage are also supported.

If your storage devices are SCSI-3 compliant, and you wish to use SCSI-3 

Persistent Group Reservations (PGR), you must enable SCSI-3 support using 

the Veritas Enterprise Administrator (VEA). See the Veritas Storage 

Foundation Administrator’s Guide for more information.

■ SCSI, Fibre Channel, iSCSI host bus adapters (HBAs), or iSCSI Initiator 

supported NICs to access shared storage.

■ A minimum of two NICs is required. One NIC will be used exclusively for 

private network communication between the nodes of the cluster. The 

second NIC will be used for both private cluster communications and for 

public access to the cluster. Symantec recommends three NICs.

See “Best practices for SFW HA” on page 448.

■ NIC teaming is not supported for the VCS private network.

Network requirements for SFW HA
SFW HA has the following network requirements:

■ Do not install SFW HA on servers that are assigned the role of a Domain 

Controller. Configuring a cluster on a domain controller is not supported.

■ Ensure that your firewall settings allow access to ports used by SFW HA 

wizards and services. For a detailed list of services and ports used by SFW 

HA, refer to the Veritas Storage Foundation and High Availability Solutions 

for Windows Installation and Upgrade Guide.

■ Static IP addresses are required for certain purposes when configuring high 

availability or disaster recovery solutions. For IPv4 networks, ensure that 

you have the addresses available to enter. For IPv6 networks, ensure that the 

network advertises the prefix so that addresses are autogenerated. Static IP 

addresses are required for the following purposes:

■ One static IP address per site for each application virtual server.

■ A minimum of one static IP address for each physical node in the 

cluster.
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■ One static IP address per cluster used when configuring Notification or 

the Global Cluster Option. The same IP address may be used for all 

options.

■ For VVR replication in a disaster recovery configuration, a minimum of 

one static IP address per site for each application instance running in 

the cluster.

■ For VVR replication in a Replicated Data Cluster configuration, a 

minimum of one static IP address per zone for each application 

instance running in the cluster.

■ Configure name resolution for each node.

■ Verify the availability of DNS Services. AD-integrated DNS or BIND 8.2 or 

higher are supported.

Make sure a reverse lookup zone exists in the DNS. Refer to the application 

documentation for instructions on creating a reverse lookup zone.

■ DNS scavenging affects virtual servers configured in SFWHA because the 

Lanman agent uses Dynamic DNS (DDNS) to map virtual names with IP 

addresses. If you use scavenging, then you must set the DNSRefreshInterval 

attribute for the Lanman agent. This enables the Lanman agent to refresh 

the resource records on the DNS servers.

See the Veritas Cluster Server Bundled Agents Reference Guide.

■ In an IPv6 environment, the Lanman agent relies on the DNS records to 

validate the virtual server name on the network. If the virtual servers 

configured in the cluster use IPv6 addresses, you must specify the DNS 

server IP, either in the network adapter settings or in the Lanman agent’s 

AdditionalDNSServers attribute.

■ If Network Basic Input/Output System (NetBIOS) is disabled over the TCP/IP, 

then you must set the Lanman agent’s DNSUpdateRequired attribute to 1 

(True).
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IPv6 support

For IPv6 networks, the following is supported:

Note: Support is limited to mixed mode (IPv4 and IPv6) network configurations 

only; a pure IPv6 environment is currently not supported.

Permission requirements for SFW HA
The following permissions are required:

■ You must be a domain user.

■ You must be a member of the local Administrators group on all nodes where 

you are installing.

■ You must have write permissions for the Active Directory objects 

corresponding to all the nodes.

■ If you plan to create a new user account for the VCS Helper service, you must 

have Domain Administrator privileges or belong to the Account Operators 

group. If you plan to use an existing user account context for the VCS Helper 

service, you must know the password for the user account.

■ If User Access Control (UAC) is enabled on Windows Server systems, then 

you cannot log on to VEA GUI with an account that is not a member of the 

Types of addresses The following types of IPv6 addresses are supported:

■ Unicast addresses

Only Global Unicast and Unique Local Unicast addresses are 

supported.

■ Automatic configuration

Only Stateless IPv6 address configuration is supported. In 

stateless mode, the IP address is configured automatically 

based on router advertisements. The prefix must be 

advertised.

LLT over UDP LLT over UDP is supported on both IPv4 and IPv6.

You can use the Cluster Configuration Wizard (VCW) to configure 

LLT over UDP over IPv6.

VCS agents, wizards, 

and other 

components

VCS agents that require an IP address attribute and wizards that 

configure or discover IP addresses now support IPv6 addresses (of 

the type described above).

The VCS High Availability Engine (HAD) and the Global Cluster 

resource (WAC) also support IPv6 addresses.
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Administrators group, such as a guest user. This happens because such user 

does not have the "Write" permission for the "Veritas" folder in the 

installation directory (typically, C:\Program Files\Veritas). As a 

workaround, an OS administrator user can set "Write" permission for the 

guest user using the Security tab of the "Veritas" folder's properties.

Additional requirements for SFW HA
Please review the following additional requirements:

■ Installation media for all products and third-party applications.

■ Licenses for all products and third-party applications.

■ For a Replicated Data Cluster, install only in a single domain.

Best practices for SFW HA
Symantec recommends that you perform the following tasks:

■ Verify that you have three network adapters (two NICs exclusively for the 

private network and one for the public network).

When using only two NICs, lower the priority of one NIC and use the 

low-priority NIC for public and private communication.

Note: If you wish to use Windows NIC teaming, you must select the Static 

Teaming mode. Only the Static Teaming mode is currently supported.

■ Route each private NIC through a separate hub or switch to avoid single 

points of failure.

■ NIC teaming is not supported for the VCS private network.

■ Verify that your DNS server is configured for secure dynamic updates. For 

the Forward and Reverse Lookup Zones, set the Dynamic updates option to 

"Secure only". (DNS > Zone Properties > General tab)

■ This is applicable for a Replicated Data Cluster configuration.

You can configure single node clusters as the primary and secondary zones. 

However, if using a shared storage configuration, you must create the disk 

groups as clustered disk groups. If you cannot create a clustered disk group 

due to the unavailability of disks on a shared bus, use the vxclus 

UseSystemBus ON command.
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Reviewing the configuration
This configuration overview describes active/passive high availability within a 

cluster and disaster recovery between two sites. In an active/passive 

configuration, one or more application virtual servers can exist in a cluster, but 

each server must be managed by a service group configured with a distinct set of 

nodes in the cluster.

Active/passive clusters involve one-to-one failover capabilities. For instance, if 

you have two nodes on each site (SYSTEM1 and SYSTEM2 on the primary site, 

SYSTEM5 and SYSTEM6 on the secondary site), then SYSTEM1 can fail over to 

SYSTEM2, and SYSTEM5 can fail over to SYSTEM6. The figure that follows 

illustrates the cluster configuration on the primary site. For a view of the DR 

configuration that includes both sites, see the illustration in the section “About 

a disaster recovery solution” on page 427.

Figure 13-1 DR configuration primary site
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Supported disaster recovery configurations 
for service group dependencies

Service group dependencies have special requirements and limitations for 

disaster recovery configuration and for actions to be taken in a disaster recovery 

scenario.

Service group dependency configurations are described in detail in the VCS 

documentation.

See Veritas Cluster Server Administrator’s Guide.

For disaster recovery only certain dependent service group configurations are 

supported:

■ Online local soft

■ Online local firm

■ Online local hard

If the service group has an unsupported type of dependency and you select it in 

the DR wizard, you receive an error notification when you attempt to move to 

the next wizard page.

In a hardware replication environment, the Disaster Recovery wizard supports 

one level of dependency (one child). If you need to configure more levels, you 

will need to add the service group and the dependency link manually on the 

secondary site after you finish running the DR wizard.

In a VVR environment, the wizard cannot configure DR for a service group that 

has a child and you will need to configure the secondary site manually. For more 

information on configuring VVR, see the Volume Replicator Administrator’s 

Guide. For more information on configuring GCO, see the Veritas Cluster Server 

Administrator's Guide.
 

 

Configuring the storage hardware and network
Use the following procedures to configure the hardware and verify DNS 

settings. Repeat this procedure for every node in the cluster.

To configure the hardware

1 Install the required network adapters, and SCSI controllers or Fibre Channel 

HBA.

2 Connect the network adapters on each system.

■ To prevent lost heartbeats on the private networks, and to prevent VCS 

from mistakenly declaring a system down, Symantec recommends 
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disabling the Ethernet autonegotiation options on the private network 

adapters. Contact the NIC manufacturer for details on this process.

■ Symantec recommends removing TCP/IP from private NICs to lower 

system overhead.

3 Use independent hubs or switches for each VCS communication network 

(GAB and LLT). You can use cross-over Ethernet cables for two-node 

clusters. LLT supports hub-based or switch network paths, or two-system 

clusters with direct network links.

4 Verify that each system can access the storage devices. Verify that each 

system recognizes the attached shared disk and that the attached shared 

disks are visible.

To verify the DNS settings and binding order for Windows Server systems

1 Open the Control Panel (Start > Control Panel).

2 Click Network and Internet, and then click Network and Sharing Center.

3 In the Network and Sharing Center window, on the left side of the screen 

under Tasks, double-click Manage network connections.

4 Ensure the public network adapter is the first bound adapter:

■ From the Advanced menu in the Network Connections window, click 

Advanced Settings.

■ In the Adapters and Bindings tab, verify the public adapter is the first 

adapter in the Connections list. If necessary, use the arrow button to 

move the adapter to the top of the list.

■ Click OK.

5 Open the Public status dialog box by doing one of the following in the 

Network Connections window:

■ Double-click the adapter for the public network.

■ Right-click the adapter for the public network and click Status.

■ Select the adapter for the public network and click View status of this 

connection in the toolbar.

When enabling DNS name resolution, make sure that you use the public 

network adapters, and not those configured for the VCS private network.

6 In the Public Status dialog box, on the General tab, click Properties.

7 In the Public Properties dialog box, on the General tab:

■ Select the Internet Protocol Version 4 (TCP/IPv4) or Internet Protocol 

Version 6 (TCP/IPv6) check box, depending on which protocol your 

network is using.
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■ Click Properties.

8 Select the Use the following DNS server addresses option.

9 Verify the correct value for the IP address of the DNS server.

10 Click Advanced.

11 In the DNS tab, make sure the Register this connection’s address in DNS 

check box is selected.

12 Make sure the correct domain suffix is entered in the DNS suffix for this 

connection field.

13 Click OK.
 

Managing disk groups and volumes

Note: If your storage devices are SCSI-3 compliant, and you wish to use SCSI-3 

Persistent Group Reservations (PGR), you must enable SCSI-3 support using the 

Veritas Enterprise Administrator (VEA - Control Panel - System Settings). See the 

Veritas Storage Foundation Administrator’s Guide for more information.

This section includes the following procedures:

■ Importing a disk group and mounting a shared volume

■ Unmounting a volume and deporting a disk group

During the process of setting up an SFW environment, refer to these general 

procedures for managing disk groups and volumes:

■ When a disk group is initially created, it is imported on the node where it is 

created.

■ A disk group can be imported on only one node at a time. 

■ To move a cluster dynamic disk group from one node to another, unmount 

the volumes in the disk group, deport the disk group from its current node, 

import it to a new node and mount the volumes.

Importing a disk group and mounting a volume
Use the VEA Console to import a disk group and mount a volume.

To import a disk group

1 From the VEA Console, right-click a disk name in a disk group or the group 

name in the Groups tab or tree view.
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2 From the menu, click Import Dynamic Disk Group.

To mount a volume

1 If the disk group is not imported, import it.

2 To verify if a disk group is imported, from the VEA Console, click the Disks 

tab and check if the status is imported.

3 Right-click the volume, click File System, and click Change Drive Letter and 

Path.

4 Select one of the following options in the Drive Letter and Paths dialog box 

depending on whether you want to assign a drive letter to the volume or 

mount it as a folder.

■ To assign a drive letter

Select Assign a Drive Letter, and select a drive letter.

■ To mount the volume as a folder

Select Mount as an empty NTFS folder, and click Browse to locate an 

empty folder on the shared disk.

5 Click OK.

Unmounting a volume and deporting a disk group
Use the VEA Console to unmount a volume and deport a disk group.

To unmount a volume and deport the dynamic disk group

1 From the VEA tree view, right-click the volume, click File System, and click 

Change Drive Letter and Path.

2 In the Drive Letter and Paths dialog box, click Remove. Click OK to continue.

3 Click Yes to confirm.

4 From the VEA tree view, right-click the disk group, and click Deport Dynamic 

Disk Group.

5 Click Yes.
 

Setting up the secondary site: Configuring 
SFW HA and setting up a cluster

Begin with verifying that the requirements are met on the secondary site:

■ See “Reviewing the requirements” on page 442.

Then continue with the following topics:
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■ “Installing SFW HA” on page 454

■ “Configuring the cluster” on page 464

Installing SFW HA
You can install SFW HA using either the product installer wizard or the 

command line interface (CLI). Before you begin to install the product, ensure 

that you have reviewed and performed the required preinstallation and 

planning tasks.

Note: The Windows MPIO feature must be enabled for Windows Server before 

you proceed with SFW HA installation.
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During the installation you can choose to separately install the server 

components or the client components. If you choose to install the server 

components, the following components are installed by default.

Note: The high availability agents that get installed with the product software 

are also available in the form of an agent pack. The agent pack is released on a 

quarterly basis. The agent pack includes support for new applications as well as 

fixes and enhancements to existing agents. You can install the agent pack on an 

existing SFW HA installation. Refer to the Symantec Operations Readiness 

Tools (SORT) website for information on the latest agent pack availability.  
https://sort.symantec.com 
Refer to the agent-specific configuration guide for more details about the 

application agents.

Table 13-6 List of options installed by default

Option Description

Client components Installs the VCS Java Console on the same node where 

the server components are installed.

High Availability Hardware 

Replication Agents

■ Veritas Cluster Server Hardware Replication 

Agent for EMC MirrorView

Enables VCS to manage MirrorView replicated 

devices.

■ Veritas Cluster Server Hardware Replication 

Agent for EMC SRDF

Enables VCS to manage SRDF replicated devices. 

■ Veritas Cluster Server Hardware Replication 

Agent for EMC SRDFSTAR

Enables VCS to manage SRDFSTAR replicated 

devices.

■ Veritas Cluster Server Hardware Replication 

Agent for Hitachi TrueCopy

Enables VCS to manage TrueCopy replicated 

devices.

■ Veritas Cluster Server Hardware Replication 

Agent for MetroMirror

Enables VCS to manage MetroMirror replicated 

devices.

High Availability Database 

Agents

■ Veritas Cluster Server Database Agent for SQL 

Server—installs the VCS agent for SQL Server 

2008, 2008 R2, and 2012
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To install the server components,

See “Installing SFW HA server components using the product installer” on 

page 456.

To install the client components,

See “Installing the client components using the product installer” on page 462.

Installing SFW HA server components using the product installer
Use the following procedure to install SFW HA server components using the 

product installer.

Ensure that there are no parallel installations, live updates, or Microsoft 

Windows updates in progress.

During installation, some product features are installed by default and others 

must be selected, as follows:

■ For a disaster recovery configuration, select the VCS global cluster (GCO) 

option. 

■ If you plan to use Veritas Volume Replicator (VVR) for replication, select the 

SFW VVR option. 

■ If you plan to use the Fast Failover feature, select the VCS Fast Failover 

option.

To install SFW HA server components using the product installer

1 Insert the disc containing the installation software into your system’s disk 

drive or download the installation software from the Symantec website.

https://fileconnect.symantec.com

2 Allow the autorun feature to start the installation or double-click Setup.exe. 

The CD browser appears.

Note: If you are installing the software using the product software disc, the 

CD browser displays the installation options for all the products specified 

earlier. However, if you are downloading the installation package from the 

Symantec website, the CD browser displays the installation options only for 

the product to be installed.

3 Click to download the required contents.
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Note: The client components are installed by default along with the server 

components. However, on a server core machine, the client components will 

not be installed.

4 On the Welcome panel, review the list of prerequisites and click Next.

5 On the License panel, read the license terms, select I accept the terms of 

License Agreement, and then click Next.

6 On the System Selection panel, select the systems and the desired 

Installation and Product options.

You can select the systems in one of the following ways:

■ In the System Name or IP text box, manually type the system name or 

its IP address and click Add.

Note: The wizard does not support IPv6. To add systems having IPv6, 

you must type the system name.

The local host is populated by default.

■ Alternatively, browse to select the systems.

The systems that belong to the domain in which you have logged in are 

listed in the Available Systems list. Select one or more systems and 

Storage Foundation HA 

for Windows

Click to install the server and client components for 

SFW HA.

Late Breaking News Click to access the latest information about updates, 

patches, and software issues regarding this release.

Windows Data Collector Click to verify that your configuration meets all 

pertinent software and hardware requirements.

SORT Click to access the Symantec Operations Readiness 

Tools site.

In addition to the product download you can also 

download the custom reports about your computer 

and Symantec enterprise products, a checklist 

providing configuration recommendations, and 

system and patch requirements to install or upgrade 

your software.

Browse Content Click to view the software disc contents.

Technical Support Click to contact Symantec Technical Support.
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click the right arrow to move them to the Selected Systems list. Click 

OK.

Once you add or select a system, the wizard performs certain validation 

checks and notes the details in the Verification Details box. To review the 

details, select the desired system.

To select the installation and product options, perform the following tasks 

on each of the selected systems.

Note: To apply the selection to multiple systems, select the system for 

which you have selected the installation and product options and then click 

Apply to multiple systems. 
See “Applying the selected installation and product options to multiple 

systems” on page 461.

■ By default the wizard uses %ProgramFiles%\Veritas as the 

installation directory. To customize the installation directory, click 

Browse and select the desired location. Click OK.

■ Select the required license type from the License key drop-down list.

Note: The default license type is “Keyless”.

If you select the "Keyless" license type, all the available product options 

are displayed and are selected by default.

If you select "User entered license key" as your license type, the License 

Details panel appears by default. On the License Details panel, enter the 

license key and then click Add. You can add multiple licenses for the 

various product options you want to use.

The wizard validates the entered license keys and displays the relevant 

error if the validation fails. After the validation is complete, click OK.
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■ From the list of product options, select the appropriate options to be 

installed. The options differ depending on your product and 

environment.

Storage 

Foundation 

Options

■ Veritas Volume Replicator (VVR): Replicates data 

across multiple sites for disaster recovery.

■ FlashSnap: Allows you to create and maintain 

split-mirror, persistent snapshots of volumes and 

application components. FlashSnap supports VSS 

based snapshots to provide application data in a 

consistent state after the application is restored.

■ Replace Disk Management Snap-in with SFW VEA 

GUI: Replaces the Disk Management Snap-in in the 

Windows Computer Management console and the 

Server Manager console with the Veritas Enterprise 

Administrator GUI for Windows Server.



460 Deploying disaster recovery: New application installation

Setting up the secondary site: Configuring SFW HA and setting up a cluster
7 On the System Selection panel, click Next. 

Note that the wizard fails to proceed with the installation unless all the 

selected systems have passed the validation checks and are ready for 

installation. If the validation checks have failed on any of the systems, 

review the details and rectify the issue. Before you choose to proceed with 

DMP Device 

Specific Modules

■ 3PARDATA array (V3PAR)

■ Dell Compellent array (VCOMPLNT)

■ Dell EqualLogic array (VEQLOGIC)

■ EMC cx4240 array (VEMCCLAR)

■ EMC VMAX array (VEMCSYMM)

■ Hitachi VSP array (VHDSAA)

■ HP P6000 array (VHPEVA)

■ IBM DS8000 array (VIBMAADS)

■ IBM XiV Storage System (VXIV)

Symantec maintains a Hardware Compatibility List (HCL), 

which provides information on HBAs and firmware that 

have been tested with each supported array. Check the HCL 

for details about your hardware before installing or using 

DMP DSMs.

The HCL is located at:

http://www.symantec.com/docs/TECH152806

Note: Do not use a DMP DSM together with a third-party 

DSM for the same array. Only one DSM at a time can claim 

the LUNs in an array. According to Microsoft Multipath I/O 

(MPIO) documentation, if multiple DSMs are installed, the 

Microsoft MPIO framework contacts each DSM to 

determine which is appropriate to handle a device. There is 

no particular order in which the MPIO framework contacts 

the DSMs. The first DSM to claim ownership of the device is 

associated with that device. Other DSMs cannot claim an 

already claimed device. Therefore, to ensure that the DMP 

DSM claims the LUNs of an array, no other DSM should be 

installed for that same array.

Veritas Cluster 

Server Options

■ Global Cluster Option (GCO): Enables you to link the 

clusters located in different geographies. This 

provides wide-area failover and disaster recovery.

■ Fast Failover: Improves the failover time taken by 

storage resources during the service group failovers, in 

a clustered environment. Fast failover is particularly 

noticeable in clusters having multiple storage stacks 

configured, typically over 20 disk groups and over 150 

volumes.

http://www.symantec.com/docs/TECH152806
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the installation, select the system and click Re-verify to re-initiate the 

validation checks for this system.

8 On the Pre-install Summary panel, review the summary and click Next. 

Note that the Automatically reboot systems after installer completes 

operation check box is selected by default. This will reboot all the selected 

remote systems immediately after the installation is complete on the 

respective system. If you do not want the wizard to initiate this auto reboot, 

clear the selection of Automatically reboot systems after installer 

completes operation check box. 

9 On the Installation panel, review the progress of installation and click Next 

after the installation is complete.

If an installation is not successful on any of the systems, the status screen 

shows a failed installation.

10 On the Post-install Summary panel, review the installation result and click 

Next.

If the installation has failed on any of the systems, refer to the log file for 

details. You may have to re-install the software.

11 On the Finish panel, click Finish.

If you chose to initiate the auto reboot, a confirmation message to reboot 

the local system appears. Click Yes to reboot immediately or No to reboot 

later.

If you did not choose to initiate the auto reboot, ensure that you manually 

reboot these systems.

This completes the product installation. 

Applying the selected installation and product options to 
multiple systems

The following procedure gives details on applying options to multiple systems.

To apply the selected installation and product options to multiple systems

1 Click on any one of the selected systems and select the desired installation 

and product options.

2 Click Apply to multiple systems.

3 On the Apply Installation Options panel, select the installation options to be 

applied and then select the desired systems. Click OK.



462 Deploying disaster recovery: New application installation

Setting up the secondary site: Configuring SFW HA and setting up a cluster
Installing the client components using the product installer
Use the following procedure to install SFW HA client components using the 

product installer.

Note: Client components cannot be installed on server core systems.

Before you begin the installation, ensure that there are no parallel installations, 

live updates, or Microsoft Windows updates in progress on the system where 

you want to install the client components.

To install SFW HA client components using the product installer

1 Insert the software disk containing the installation package into your 

system's disc drive or download the installation package from the following 

Symantec Web site.

https://fileconnect.symantec.com

2 Allow the autorun feature to start the installation or double-click Setup.exe.

The CD browser appears.

3 Click to download the required contents.

4 On the Welcome panel, review the list of prerequisites and click Next.

Veritas Storage 

Foundation HA for 

Windows

Click to install the server or client components for 

SFW HA.

Late Breaking News Click to access the latest information about updates, 

patches, and software issues regarding this release.

Windows Data Collector Click to verify that your configuration meets all 

pertinent software and hardware requirements.

SORT Click to access the Symantec Operations Readiness 

Tools site.

In addition to the product download you can also 

download the custom reports about your computer 

and Symantec enterprise products, a checklist 

providing configuration recommendations, and 

system and patch requirements to install or upgrade 

your software.

Browse Content Click to view the software disc contents.

Technical Support Click to contact Symantec Technical Support.
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5 On the License Agreement panel, read the license terms, select I accept the 

terms of License Agreement, and then click Next.

6 On the System Selection panel, select the systems and the installation 

directory.

You can select the systems in one of the following ways:

■ In the System Name or IP text box, manually type the system name or 

its IP address and click Add.

Note: The wizard does not support IPv6. To add the systems having 

IPv6, you must type the system name.

Local host is populated by default.

■ Alternatively, browse to select the systems.

The systems that belong to the domain in which you have logged in are 

listed in the Available Systems list. Select one or more systems and 

click the right arrow to move them to the Selected Systems list. Click 

OK.

Once you add or select a system, the wizard performs certain validation 

checks and notes the details in the Verification Details box. To review the 

details, select the desired system.

By default the wizard uses %ProgramFiles%\Veritas as the installation 

directory. To customize the installation directory, click Browse and select 

the desired location. Click OK.

To apply the customized directory to multiple systems, click Apply to 

multiple systems. On the Apply Installation Options panel, select the 

systems to apply the customized directory. Click OK.

7 On the System Selection panel, click Next.

Note that the wizard fails to proceed with the installation unless all the 

selected systems have passed the validation checks and are ready for 

installation. If the validation checks have failed on any of the system, 

review the details and rectify the issue. Before you choose to proceed with 

the installation select the system and click Re-verify to re-initiate the 

validation checks for this system.

8 On the Pre-install Summary panel, review the summary and click Next.

9 On the Installation panel, review the progress of installation and click Next 

after the installation is complete.

If an installation is not successful on any of the systems, the status screen 

shows a failed installation.

10 On the Post-install Summary panel, review the installation result and click 

Next.
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If the installation has failed on any of the system, refer to the log file for 

details. You may have to re-install the software.

11 On the Finish panel, click Finish.

This completes the installation of the client components.
 

Configuring the cluster
After installing SFW HA using the installer, set up the components required to 

run a cluster. The VCS Cluster Configuration Wizard (VCW) sets up the cluster 

infrastructure, including LLT and GAB, and configures Symantec Product 

Authentication Service in the cluster. The wizard also configures the 

ClusterService group, which contains resources for notification and global 

clusters. 

Complete the following tasks before creating a cluster:

■ Verify that each node uses static IP addresses (DHCP is not supported) and 

name resolution is configured for each node. 

■ Set the required permissions:

■ You must have administrator privileges on the system where you run 

the wizard. The user account must be a domain account.

■ You must have administrative access to all systems selected for cluster 

operations. Add the domain user to the Local Administrators group of 

each system.

■ If you plan to create a new user account for the VCS Helper service, you 

must have Domain Administrator privileges or belong to the Domain 

Account Operators group. If you plan to use an existing user account 

for the VCS Helper service, you must know the password for the user 

account.

■ When configuring a user account for the VCS Helper service, make sure 

that the user account is a domain user. The VCS HAD, which runs in the 

context of the local system built-in account, uses the VCS Helper 

service user context to access the network. This account does not 

require domain admin privileges.

■ Make sure the VCS Helper service domain user account has “Add 

workstations to domain” privilege enabled in the Active Directory.

Refer to the Veritas Cluster Server Administrator’s Guide for complete 

installation and configuration details on VCS, and additional instructions on 

removing or modifying cluster configurations.

Ensure that the name you assign to the secondary site cluster is different from 

the name assigned to the primary site cluster. 
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To configure a VCS cluster

1 Start the VCS Cluster Configuration Wizard.

Click Start > All Programs > Symantec > Veritas Cluster Server > 

Configuration Tools > Cluster Configuration Wizard.

2 Read the information on the Welcome panel and click Next.

3 On the Configuration Options panel, click Cluster Operations and click 

Next.

4 On the Domain Selection panel, select or type the name of the domain in 

which the cluster resides and select the discovery options.

Do one of the following:

■ To discover information about all systems and users in the domain:

■ Clear the Specify systems and users manually check box.

■ Click Next.

■ Proceed to step 8 on page 467.

■ To specify systems and user names manually (recommended for large 

domains):

■ Check the Specify systems and users manually check box.

Additionally, you may instruct the wizard to retrieve a list of 

systems and users in the domain by selecting appropriate check 

boxes.

■ Click Next.
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■ If you chose to retrieve the list of systems, proceed to step 6 on 

page 466. Otherwise, proceed to the next step.

5 On the System Selection panel, type the name of each system to be added, 

click Add, and then click Next.

Do not specify systems that are part of another cluster.

Proceed to step 8 on page 467.

6 On the System Selection panel, specify the systems for the cluster and then 

click Next. Do not select systems that are part of another cluster.

Enter the name of the system and click Add to add the system to the 

Selected Systems list, or click to select the system in the Domain Systems 

list and then click the > (right-arrow) button.

7 The System Report panel displays the validation status, whether Accepted 

or Rejected, of all the systems you specified earlier. Review the status and 

then click Next.

Click on a system name to see the validation details. If you wish to include a 

rejected system, rectify the error based on the reason for rejection and then 

run the wizard again.

A system can be rejected for any of the following reasons:

■ System is not pingable.

■ WMI access is disabled on the system.

■ Wizard is unable to retrieve the system architecture or operating 

system.
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■ VCS is either not installed on the system or the version of VCS is 

different from what is installed on the system on which you are 

running the wizard.

8 On the Cluster Configuration Options panel, click Create New Cluster and 

click Next.

9 On the Cluster Details panel, specify the details for the cluster and then 

click Next.

Cluster Name Type a name for the new cluster. Symantec recommends a 

maximum length of 32 characters for the cluster name.

Cluster ID Select a cluster ID from the suggested cluster IDs in the 

drop-down list or type a unique ID for the cluster. The 

cluster ID can be any number from 0 to 65535.

Caution: If you chose to specify systems and users manually in 

step 4 or if you share a private network between more than one 

domain, make sure that the cluster ID is unique.

Operating System From the drop-down list select the operating system.

All the systems running Windows Server 2012 are displayed.



468 Deploying disaster recovery: New application installation

Setting up the secondary site: Configuring SFW HA and setting up a cluster
10 The wizard validates the selected systems for cluster membership. After the 

systems are validated, click Next.

If a system is not validated, review the message associated with the failure 

and restart the wizard after rectifying the problem.

If you chose to configure a private link heartbeat in the earlier step, proceed 

to the next step. Otherwise, proceed to step 12 on page 471.

11 On the Private Network Configuration panel, configure the VCS private 

network and then click Next.

You can configure the VCS private network either over ethernet or over the 

User Datagram Protocol (UDP) layer using IPv4 or IPv6 network.

Do one of the following:

■ To configure the VCS private network over the ethernet, complete the 

following steps:

■ Select Configure LLT over Ethernet.

Available Systems Select the systems that you wish to configure in the cluster.

Check the Select all systems check box to select all the 

systems simultaneously.

The wizard discovers the network interface cards (NICs) on 

the selected systems. For single-node clusters with the 

required number of NICs, the wizard prompts you to 

configure a private link heartbeat. In the dialog box, click 

Yes to configure a private link heartbeat.
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■ Select the check boxes next to the two NICs to be assigned to the 

private network. You can assign a maximum of eight network 

links.

Symantec recommends reserving two NICs exclusively for the 

private network. However, you could lower the priority of one of 

the NICs and use the low-priority NIC for both public and private 

communication.

■ If you have only two NICs on a selected system, it is recommended 

that you lower the priority of at least one NIC that will be used for 

private as well as public network communication.

To lower the priority of a NIC, right-click the NIC and select Low 

Priority from the pop-up menu.

Note: If you wish to use Windows NIC teaming, you must select the 

Static Teaming mode. Only the Static Teaming mode is currently 

supported.

■ If your configuration contains teamed NICs, the wizard groups 

them as "NIC Group #N" where "N" is a number assigned to the 

teamed NIC. A teamed NIC is a logical NIC, formed by grouping 

several physical NICs together. All NICs in a team have an identical 

MAC address. Symantec recommends that you do not select 

teamed NICs for the private network.

The wizard configures the LLT service (over ethernet) on the selected 

network adapters.
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■ To configure the VCS private network over the User Datagram Protocol 

(UDP) layer, complete the following steps:

■ Select Configure LLT over UDP on IPv4 network or Configure LLT 

over UDP on IPv6 network depending on the IP protocol that you 

wish to use.

The IPv6 option is disabled if the network does not support IPv6.

■ Select the check boxes next to the two NICs to be assigned to the 

private network. You can assign a maximum of eight network 

links. Symantec recommends reserving at least two adapters 

exclusively for the VCS private network.

■ For each selected NIC, verify the displayed IP address. If a selected 

NIC has multiple IP addresses assigned, double-click the field and 

choose the desired IP address from the drop-down list. In case of 

IPv4, each IP address can be in a different subnet.

The IP address is used for the VCS private communication over the 

specified UDP port.

■ Specify a unique UDP port for each of the link. Click Edit Ports if 

you wish to edit the UDP ports for the links. You can use ports in 

the range 49152 to 65535. The default ports numbers are 50000 

and 50001 respectively. Click OK.

For each selected NIC, double-click the respective field in the Link 

column and choose a link from the drop-down list. Specify a 

different link (Link1 or Link2) for each adapter. Each link is 

associated with a UDP port that you specified earlier.
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The wizard configures the LLT service (over UDP) on the selected 

network adapters. The specified UDP ports will be used for the private 

network communication.

12 On the VCS Helper Service User Account panel, specify a domain user 

account for the VCS Helper service. The VCS high availability engine (HAD), 

which runs in the context of the local system built-in account, uses the VCS 

Helper service user context to access the network.

This account does not require Domain Administrator privileges.

Specify a domain user as follows:

■ To specify an existing user, do one of the following:

■ Click Existing user and select a user name from the drop-down list

■ If you chose not to retrieve the list of users in step 4 on page 465, 

type the user name in the Specify User field, and then click Next.

■ To specify a new user, click New user and type a valid user name in the 

Create New User field, and then click Next.

Do not append the domain name to the user name; do not type the user 

name as Domain\user or user@domain.

■ In the Password dialog box, type the password for the specified user 

and click OK, and then click Next.

13 On the Configure Security Service Option panel, specify the security options 

for the cluster communications and then click Next.

Do one of the following:
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■ To use VCS cluster user privileges, click Use VCS User Privileges and 

then type a user name and password.

The wizard configures this user as a VCS Cluster Administrator. In this 

mode, communication between cluster nodes and clients, including the 

Cluster Manager (Java Console), occurs using the encrypted VCS cluster 

administrator credentials. The wizard uses the VCSEncrypt utility to 

encrypt the user password.

The default user name for the VCS administrator is admin and the 

password is password. Both are case-sensitive. You can accept the 

default user name and password for the VCS administrator account or 

type a new name and password.

Symantec recommends that you specify a new user name and 

password.

■ To configure a secure cluster using the single sign-on feature, click Use 

Single Sign-on.

In this mode, the VCS Authentication Service is used to secure 

communication between cluster nodes and clients by using digital 

certificates for authentication and SSL to encrypt communication over 

the public network. VCS uses SSL encryption and platform-based 

authentication. The VCS high availability engine (HAD) and Veritas 

Command Server run in secure mode.

The wizard configures all the cluster nodes as root brokers (RB) and

authentication brokers (AB). Authentication brokers serve as 

intermediate registration and certification authorities. Authentication 

brokers have certificates signed by the root. These brokers can 

authenticate clients such as users and services. The wizard creates a 

copy of the certificates on all the cluster nodes.

14 Review the summary information on the Summary panel, and click 

Configure.

The wizard configures the VCS private network. If the selected systems 

have LLT or GAB configuration files, the wizard displays an informational 

dialog box before overwriting the files. In the dialog box, click OK to 

overwrite the files. Otherwise, click Cancel, exit the wizard, move the 

existing files to a different location, and rerun the wizard.

The wizard starts running commands to configure VCS services. If an 

operation fails, click View configuration log file to see the log.

15 On the Completing Cluster Configuration panel, click Next to configure the 

ClusterService group; this group is required to set up components for 

notification and for global clusters.

To configure the ClusterService group later, click Finish.
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At this stage, the wizard has collected the information required to set up the 

cluster configuration. After the wizard completes its operations, with or 

without the ClusterService group components, the cluster is ready to host 

application service groups. The wizard also starts the VCS engine (HAD) 

and the Veritas Command Server at this stage.

Note: After configuring the cluster you must not change the names of the 

nodes that are part of the cluster. If you wish to change a node name, run 

this wizard to remove the node from the cluster, rename the system, and 

then run this wizard again to add that system to the cluster.

16 On the Cluster Service Components panel, select the components to be 

configured in the ClusterService service group and click Next.

■ Check the Notifier Option check box to configure notification of 

important events to designated recipients.

See “Configuring notification” on page 473.

■ Check the GCO Option check box to configure the wide-area connector 

(WAC) process for global clusters. The WAC process is required for 

inter-cluster communication.

Configure the GCO Option using this wizard only if you are configuring 

a Disaster Recovery (DR) environment and are not using the Disaster 

Recovery wizard.

Refer to the Veritas Cluster Server Administrator’s Guide for details on 

configuring GCO using the cluster configuration wizard.

You can configure the GCO Option using the DR wizard. The Disaster 

Recovery chapters discuss how to use the Disaster Recovery wizard to 

configure the GCO option.

Configuring notification
This section describes steps to configure notification.
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To configure notification

1 On the Notifier Options panel, specify the mode of notification to be 

configured and click Next.

You can configure VCS to generate SNMP (V2) traps on a designated server 

and send emails to designated recipients in response to certain events.

2 If you chose to configure SNMP, specify information about the SNMP 

console and click Next.

■ Click a field in the SNMP Console column and type the name or IP 

address of the console. The specified SNMP console must be MIB 2.0 

compliant.
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■ Click the corresponding field in the Severity column and select a 

severity level for the console.

■ Click ‘+’ to add a field; click ‘-’ to remove a field.

■ Enter an SNMP trap port. The default value is “162”.

3 If you chose to configure SMTP, specify information about SMTP recipients 

and click Next.

■ Type the name of the SMTP server.

■ Click a field in the Recipients column and enter a recipient for 

notification. Enter recipients as admin@example.com.

■ Click the corresponding field in the Severity column and select a 

severity level for the recipient. VCS sends messages of an equal or 

higher severity to the recipient.

■ Click + to add fields; click - to remove a field.
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4 On the Notifier Network Card Selection panel, specify the network 

information and click Next.

■ If the cluster has a ClusterService service group configured, you can 

use the NIC resource configured in the service group or configure a new 

NIC resource for notification.

■ If you choose to configure a new NIC resource, select a network adapter 

for each node in the cluster. The wizard lists the public network 

adapters along with the adapters that were assigned a low priority.

5 Review the summary information and choose whether you want to bring the 

notification resources online when VCS is started.

6 Click Configure.

7 Click Finish to exit the wizard.
 

Verifying that your application or server role 
is configured for HA at the primary site 

Make sure that your application has been configured for high availability at the 

primary site. If you have not yet configured the application for high availability 

at the primary site, go to High Availability (HA) Configuration in the Solutions 

Configuration Center and follow the steps in the order shown.

See Chapter 6, “Deploying SFW HA for high availability: New installation” on 

page 63.
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To verify the configuration, use the Cluster Manager (Java console) on the 

primary site and check the status of the service group in the tree view. Verify 

that all the resources are online.

Note: If you are setting up a replicated data cluster at the primary site, use the 

replicated data cluster instructions rather than the high availability 

configuration steps in the Solutions Configuration Center. See 

Chapter 11, “Deploying Replicated Data Clusters: New application installation” 

on page 291.

Setting up your replication environment
The DR wizard can assist you with setting up replication for the following 

methods of replication:

■ Veritas Volume Replicator (VVR)

■ EMC SRDF

■ Hitachi TrueCopy

Note: The DR wizard cannot be used if you are setting up DR in a non-shared 

storage environment.

For array-based hardware replication, you can use any replication agent 

supported by Veritas Cluster Server. The DR wizard can help with configuring 

the methods listed above. If you choose a different replication method, you must 

run the wizard first to complete configuring global clustering; then afterwards, 

you configure replication separately.

See “Configuring global clustering only” on page 518.

Before configuring replication with the wizard, ensure that you set up the 

replication environment prerequisites. Choose from the following topics, 

depending on which replication method you are using:

■ “Configuring the VVR security service” on page 478

■ “Requirements for EMC SRDF array-based hardware replication” on 

page 480

■ “Requirements for Hitachi TrueCopy array-based hardware replication” on 

page 482
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Configuring the VVR security service
If you are using Veritas Volume Replicator (VVR) replication, you must 

configure the VxSAS service on all cluster nodes on both the primary and 

secondary sites. 

Complete the following procedure to configure the VxSAS service for VVR.

The procedure has these prerequisites:

■ You must be logged on with administrative privileges on the server for the 

wizard to be launched.

■ The account you specify must have administrative and log-on as service 

privileges on all the specified hosts.

■ Avoid specifying blank passwords. In a Windows Server environment, 

accounts with blank passwords are not supported for log-on service 

privileges.

■ Make sure that the hosts on which you want to configure the VxSAS service 

are accessible from the local host.

Note: For details on this required service, see Veritas Storage Foundation Veritas 

Volume Replicator Administrator’s Guide.

To configure the VxSAS service

1 Launch the VVR Security Service Configuration Wizard.

Click Start > All Programs > Symantec > Veritas Storage Foundation > 

Configuration Wizards > VVR Security Service Configuration Wizard.

or 

Type vxsascfg.exe at the command prompt.

2 Read the information provided on the Welcome page and click Next.

3 Complete the Account Information panel as follows and then click Next:

If you have already configured the VxSAS service for one host that is 

intended to be a part of the RDS, make sure you specify the same username 

and password when configuring the VxSAS service on the other hosts.

Account name 

(domain\account)

Enter the administrative account name.

Password Specify a password.
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4 On the Domain Selection panel, select the domain to which the hosts that 

you want to configure belong and then click Next:

5 On the Host Selection panel, select the required hosts:

Selecting domains The Available domains pane lists all the domains that are 

present in the Windows network neighborhood.

Move the appropriate name from the Available domains list 

to the Selected domains list, either by double-clicking it or 

using the arrow button.

Adding a domain If the domain name that you require is not displayed, click 

Add domain. This displays a dialog that allows you to 

specify the domain name. Click Add to add the name to the 

Selected domains list.

Selecting hosts The Available hosts pane lists the hosts that are present in 

the specified domain.

Move the appropriate host from the Available hosts list to 

the Selected hosts list, either by double-clicking it or using 

the arrow button. Use the Shift key with the up or down 

arrow keys to select multiple hosts.
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After you have selected a host name, the Configure button is enabled. Click 

Configure to proceed with configuring the VxSAS service.

6 After the configuration completes, the Configuration Results page displays 

whether or not the operation was successful. If the operation was not 

successful, the page displays the details on why the account update failed, 

along with the possible reasons for failure and recommendations on getting 

over the failure.

When configuring the VxSAS service for VVR in a firewall setup, the VxSAS 

wizard may not be able to configure the machines that are across the 

firewall, although the Host Selection dialog may list these nodes. In this 

case, configure the VxSAS service locally on the machines that are across 

the firewall.

Click Back to change any information you had provided earlier.

7 Click Finish to exit the wizard.
 

Requirements for EMC SRDF array-based hardware replication
The DR wizard configures the settings required for the VCS hardware 

replication agent for EMC SRDF. The wizard configures the required settings for 

the SRDF resource in the VCS application service group. The wizard also 

configures the Symm heartbeat. Optional resource settings are left in the 

default state. 

For more information about the EMC SRDF agent functions and the 

configuration options, see Veritas Cluster Server Hardware Replication Agent for 

EMC SRDF, Configuration Guide.

Before using the DR wizard, review the following topics:

■ “Software requirements for configuring EMC SRDF” on page 480

■ “Replication requirements for EMC SRDF” on page 481

Software requirements for configuring EMC SRDF

The EMC SRDF agent supports SYMCLI versions that EMC recommends for the 

firmware on the array. The agent supports SRDF on all microcode levels on all 

Symmetrix arrays, provided that the host/HBA/array combination is in EMC’s 

hardware compatibility list.

Adding a host If the host name you require is not displayed, click Add 

host. In the Add Host dialog specify the required host name 

or IP in the Host Name field. Click Add to add the name to 

the Selected hosts list.
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To use the DR wizard to configure the required agent settings for EMC SRDF, 

ensure that the following software requirements are met:

■ The EMC Solutions Enabler is installed on all cluster nodes.

■ The SYMCLI version that is installed supports the generation of XML 

output.

■ The SYMCLI version and the microcode level support dynamic swapping.

■ The VCS EMC SRDF agent is installed on all cluster nodes.
 

Replication requirements for EMC SRDF

Before it performs any tasks, the wizard validates the array configuration as 

follows:

■ On the primary site, the wizard verifies that no devices are RDF2.

■ On the secondary site, the wizard verifies that no devices are RDF1.

Otherwise, the wizard displays an invalid configuration message and is unable 

to proceed.

The DR wizard does not start or stop replication. Array replication 

configuration is not a prerequisite for the wizard to perform storage cloning or 

service group cloning.

After the service group cloning task is complete, the DR wizard displays a screen 

describing the following replication requirements:

■ All disks in SFW disk groups must belong to the same device group.

■ The device group must not span more than one array (no composite device 

groups).

■ A device group can contain one or more disk groups.

■ Dynamic swap must be enabled on both sites.

■ On the primary site:

■ All devices must be RDF1 and part of an RDF1 device group.

■ Devices must have write access.

■ On the secondary site:

■ All devices must be RDF2 and part of an RDF2 device group.

■ Write access must be disabled.

It is recommended that you ensure that these requirements are met before 

proceeding with the wizard. The wizard then validates the array replication 

configuration.
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If replication is configured correctly, the wizard populates the resource 

configuration screen with the required replication settings for the SRDF 

resource.

If the replication configuration does not meet the requirements, the wizard 

leaves the fields on the resource configuration screen blank. You can optionally 

enter the resource configuration information in the wizard and configure the 

array replication requirements later. The information you enter is applied only 

to the SRDF resource, not to the array configuration. However, the SRDF 

resource will be unable to come online in the service group until replication has 

been configured correctly.

In addition, note the following agent requirement:

■ Device group configuration must be the same on all nodes of the cluster.
 

Requirements for Hitachi TrueCopy array-based 
hardware replication

The DR wizard configures the settings required for the VCS hardware 

replication agent for Hitachi TrueCopy. The wizard configures the required 

settings for the HTC resource in the VCS application service group. Optional 

settings are left in the default state.

For more information about the Hitachi TrueCopy agent functions and the 

configuration options, see Veritas Cluster Server Hardware Replication Agent for 

Hitachi TrueCopy, Configuration Guide.

Before using the DR wizard, review the following topics:

■ “Software requirements for Hitachi TrueCopy” on page 482

■ “Replication requirements for Hitachi TrueCopy” on page 483

Software requirements for Hitachi TrueCopy

The Hitachi TrueCopy agent supports all versions of Hitachi RAID Manager.

For details, see Veritas Cluster Server Hardware Replication Agent for Hitachi 

TrueCopy, Configuration Guide.

To use the DR wizard to configure the required agent settings for Hitachi 

TrueCopy, ensure that the following requirements are met:

■ RAID Manager is installed in the same location on all nodes on a site.

■ Enter the primary and secondary site file paths for the horcm files on the 

Hitachi TrueCopy Path Information panel in the wizard. The default location 

is:

System Driver\Windows
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■ The horcm files are named horcmnn.conf (where nn is a positive number 

without a leading zero, for example, horcm1.conf but not horcm01.conf).
 

Replication requirements for Hitachi TrueCopy

Before it performs any tasks, the wizard validates the array configuration as 

follows:

■ On the primary site, the wizard verifies that all devices are the same type, 

but not S-SWS or SSUS.

■ On the secondary site, the wizard verifies that all devices are the same type, 

but not P-VOL or PSUS.

Otherwise, the wizard displays an invalid configuration message and does not 

proceed.

The DR wizard does not start or stop replication. Array replication 

configuration is not a prerequisite for the wizard to perform storage cloning or 

service group cloning.

After the service group cloning task is complete, the DR wizard displays a screen 

describing the following replication requirements:

■ All configured instances are running.

■ No disks in the SFW disk group span across the Device Group.

■ A device group can contain one or more disk groups.

■ The device group does not span more than one array.

■ At the primary site, all devices are of the type P-VOL.

■ At the secondary site, all devices are of the type S-VOL.

■ All device groups at the primary site are paired to an IP address which must 

be online on the secondary node.

■ Device group and device names include only alphanumeric characters or the 

underscore character.

It is recommended that you ensure that these requirements are met before 

proceeding with the wizard. The wizard then validates the array replication 

configuration.

If replication is configured correctly, the wizard populates the resource 

configuration screen with the required replication settings for the HTC 

resource.

If the replication configuration does not meet the requirements, the wizard 

leaves the fields on the resource configuration screen blank. You can optionally 

enter the resource configuration information in the wizard and configure the 

array replication requirements later. The information you enter is applied only 
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to the HTC resource, not to the array configuration. However, the HTC resource 

will be unable to come online in the service group until replication has been 

configured correctly.
 

Assigning user privileges (secure clusters only)
In order to enable remote cluster operations you must configure a VCS user with 

the same name and privileges in each cluster.

When assigning privileges in secure clusters, you must specify fully-qualified 

user names, in the format username@domain. You cannot assign or change 

passwords for users when VCS is running in secure mode.

You must assign service group rights to the application service group as well as 

any dependent service groups except for the RVG service group.

See the Veritas Cluster Server Administrator’s Guide.

To assign user privileges at the primary site

1 Set the configuration to read/write mode:

haconf -makerw

2 Add the user. Specify the name in the format username@domain.

hauser -add user [-priv <Administrator|Operator>]

3 Modify the attribute of the service group to add the user. Specify the 

application service group and any dependent service groups except for the 

RVG service group.

hauser -add user [-priv <Administrator|Operator>  
[-group service_groups]]

4 Reset the configuration to read-only:

haconf -dump -makero

To assign user privileges at the secondary site

1 Set the configuration to read/write mode:

haconf -makerw

2 Add the user. Specify the name in the format username@domain.

hauser -add user [-priv <Administrator|Operator>]

3 Reset the configuration to read-only:

haconf -dump -makero
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Configuring disaster recovery with the DR wizard

Note: The DR wizard cannot be used if you are setting up DR in a non-shared 

storage environment.

The Disaster Recovery Configuration Wizard (DR wizard) assists you to perform 

the following tasks for the selected service group:

■ Clone the storage configuration (VVR replication) or prepare a temporary 

storage configuration for application installation (array-based hardware 

replication)

■ Clone the service group

■ Optionally, configure VVR replication, or configure the VCS hardware 

replication agent settings for EMC SRDF or Hitachi TrueCopy

■ Configure global clustering

Warning: To use the Disaster Recovery Configuration Wizard in an 

array-based hardware replication environment that is not configured by the 

wizard, you must first run the wizard to configure global clustering before 

configuring replication.

The wizard allows you to exit after the logical completion of each task. Each 

time you re-start the wizard, you specify the primary site system, service group, 

secondary site system, and replication method, as described in the following 

procedure. Clicking Next then takes you to the start page of the process 

following the one that you had last completed.

The DR Wizard list of service groups shows only those that contain a MountV 

resource. For a dependent service group to be listed, the parent service group 

must also contain a MountV resource.

Warning: Once you have completed configuring replication and global clustering 

with the DR wizard, you cannot use the wizard to change the method of 

replication.

Before running the DR wizard to configure disaster recovery, ensure that you 

meet the following prerequisites:

■ SFW HA is installed and a cluster is configured at the secondary site. Ensure 

that the name assigned to the secondary site cluster is different than the 

name assigned to the primary site cluster.
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■ Your application or server role is configured for HA at the primary site and 

all required services are running at the primary site.

■ The clusters taking part in the DR configuration should have distinct names.

■ Enough free disk space is available at the secondary site to duplicate the 

storage configuration at the primary site.

■ Global Cluster Option (GCO) is installed at the primary and secondary site, 

and one static IP address is available at each site for configuring GCO.

■ For IPv4 networks, static IP addresses are available to enter for the following 

(for IPv6, they are generated during configuration):

■ One static IP address per application service group to be cloned.

■ One static IP address at each site for configuring GCO.

■ If using VVR for replication, a minimum of one static IP address per 

site for each application instance running in the cluster.

■ The service group to be cloned can use either IPv4 IP addresses or IPv6 

addresses but not a mixture of both.

■ To configure IPv6 settings, the wizard must be launched from a system on 

which the IPv6 stack is installed.

■ For VVR replication, the service group to be cloned cannot contain a child 

service group.

■ A VCS user is configured with the same name and privileges in each cluster.

■ If a firewall exists between the wizard and any systems it needs access to, 

the firewall is set to allow both ingoing and outgoing TCP requests on port 

7419.

Note: The DR wizard does not support VVR configurations that include a Bunker 

secondary site.

 

In addition, see the following replication prerequisites, depending on the 

replication method you are using:

■ “Configuring the VVR security service” on page 478

■ “Requirements for EMC SRDF array-based hardware replication” on 

page 480

■ “Requirements for Hitachi TrueCopy array-based hardware replication” on 

page 482
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To start configuring disaster recovery with the DR wizard

1 Start the DR Configuration Wizard from the Solutions Configuration Center. 

Click Start > All Programs > Symantec > Veritas Cluster Server > Solutions 

Configuration Center. Expand the  Solutions for Additional Applications tab 

and click Disaster Recovery Configuration > Configure Disaster Recovery > 

Disaster Recovery Configuration Wizard.

Note: By design, the DR wizard requires specific settings for the Lanman 

attributes on the primary and secondary sites. Before beginning the DR 

configuration, the wizard checks for these values, and if they are not set as 

required, the wizard will automatically proceed with setting these values, 

both at the primary and secondary sites. 

2 In the Welcome panel, review the prerequisites to ensure that they are met 

and click Next.

3 In the System Selection panel, complete the requested information:

Click Next.

4 In the Service Group Selection panel, select the service group that you want 

to clone to the secondary site. 

For a hardware replication environment, you can choose to clone only the 

parent service group by not selecting the dependent service group. Only 

online and local dependencies are supported, in soft, firm, or hard 

configurations. The wizard can configure only one level of dependency.

In a VVR environment, the DR wizard does not support configuring DR for a 

service group that has a child. If you select a service group that has a child, 

you will receive an error message when you select the VVR replication 

method later in the wizard.

The panel lists only service groups that contain a MountV resource. 

Click Next.

5 In the Secondary System Selection panel, enter the Fully Qualified Host 

Name (FQHN) or the IP address of the secondary system for which you want 

to configure disaster recovery.

Click Next.

System Name Enter the IP address or Fully Qualified Host Name (FQHN) of 

the primary system where the application is online. 

If you have launched the wizard on the system where the 

application is online at the primary site, you can also specify 

localhost to connect to the system.
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6 In the Replication Options panel, select the replication method. Although 

you must select the replication method now, configuring replication and the 

global cluster option is done later, after service group cloning.

Configure Veritas Volume 

Replicator (VVR) and the 

Global Cluster Option (GCO)

Select this option if you want to configure VVR 

replication.

Select this option even if you plan to configure VVR 

replication or the GCO option manually. This option is 

required for the wizard to configure the storage 

cloning correctly for a VVR environment.

The wizard verifies each configuration task and 

recognizes if a task has been completed successfully.

You cannot mix replication methods. That is, if your 

primary site is using array-based replication, and you 

select the VVR option, the wizard will warn you that 

you cannot use VVR replication for the disaster 

recovery site.

Configure EMC SRDF and the 

Global Cluster Option (GCO)

Select this replication option if you want to configure 

the settings for the VCS EMC SRDF agent. All disks 

used for the service group on the primary site must 

belong to an EMC SRDF array. 

Select this option even if you plan to configure EMC 

SRDF replication or the GCO option manually. The 

wizard verifies each configuration task and recognizes 

if a task has been completed successfully.

Configure Hitachi TrueCopy 

and the Global Cluster 

Option (GCO)

Select this replication option if you want to configure 

the settings for the VCS Hitachi TrueCopy agent. All 

disks used for the service group on the primary site 

must belong to a Hitachi TrueCopy array. 

Select this option even if you configure GCO manually. 

The wizard verifies each configuration task and 

recognizes if a task has been completed successfully.
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Click Next.

7 Continue with the next DR configuration task.
 

For VVR replication, see “Cloning the storage on the secondary site using 

the DR wizard (VVR replication option)” on page 489.

For array-based replication, see “Creating temporary storage on the 

secondary site using the DR wizard (array-based replication)” on page 493.

Cloning the storage on the secondary site 
using the DR wizard (VVR replication option)

The DR wizard enables you to clone the storage configuration present at the 

primary site on to the secondary site. To do this successfully, the systems at the 

secondary site must have adequate free storage. If you have created the 

configuration but there is a mismatch in the volume sizes, the wizard can 

correct this and then complete the configuration.

Note: The DR wizard cannot be used if you are setting up DR in a non-shared 

storage environment.

If you have not yet started the wizard, see the following topic before continuing 

with the storage cloning procedure:

“Configuring disaster recovery with the DR wizard” on page 485.

Configure the Global Cluster 

Option (GCO) only

If you select this option, the DR wizard does not 

configure any replication settings. It configures the 

global cluster option. 

Select this option if you want to use the wizard in an 

array-based replication environment that is not 

supported by this wizard. You must configure 

replication manually after you finish the wizard.

If you select the GCO only option, the DR wizard sets 

up the storage and service group configuration on the 

secondary site for an array-based hardware replication 

environment. Therefore, you cannot use this option to 

clone the storage and service group for a VVR 

replication environment. 
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To clone the storage configuration from the primary site to the secondary 

site (VVR replication method)

1 If you have not yet done so, start the Disaster Recovery Configuration 

Wizard and specify the information for the primary site system, the service 

group, and the secondary site system. In the Replication Options panel, 

select the VVR replication method and click Next.

2 Review the information in the Storage Validation Results panel. This panel 

compares the configuration at the secondary site with that on the primary. 

If the storage is already configured identically on both sites, the panel shows 

that results are identical. Otherwise, the panel shows the differences and 

recommended actions. You can toggle between a summary and detailed view 

of information about the differences. 

The detailed view shows the following:

The summary view shows the following:

Disk Group Displays the disk group name that needs to be created on the 

secondary site. 

Volume Displays the list of volumes, if necessary, that need to be created 

at the secondary site. 

Size Displays the size of the volume that needs to be created on the 

secondary site. 

Mount Displays the mount to be assigned the volume on the secondary 

site.

Recommended 

Action

Indicates the action that needs to be taken at the secondary to 

make the configuration similar to that on the primary.

■ If the volume does not exist, a new volume will be created.

■ If the volume exists but is of a smaller size than that on the 

primary, the volume will be expanded to the required size.

■ If the volume is of a greater size than that on the primary, 

the volume will be recreated using the appropriate size. 

■ If the volume is the same as that on the primary, the 

message indicates that the volumes are identical and no 

action is required.

Disk groups that do 

not exist

Displays the names of any disk groups that exist on the 

primary but do not exist on the secondary.

Existing disk groups 

that need 

modification

Displays the names of any disk groups on the secondary that 

need to be modified to match the primary.
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If the panel displays a message indicating that the available disks are 

inadequate to clone the primary site configuration on the secondary, you 

can free some disks on the secondary or add more storage. Then click 

Refresh/Validate to have the wizard update its information about the 

secondary storage configuration. 

You continue with the wizard to provide information for the recommended 

actions. Before proceeding to the service group configuration, the wizard 

ensures that the configuration of the disk groups and volumes for the 

service group is the same at the primary and secondary site.

Click Next.

3 In the Disk Selection for Storage Cloning panel, for each of the disk groups 

that does not exist or is not same as the corresponding disk group at the 

primary site, select disks that the wizard can use to create the respective 

disk groups at the secondary site.

Click Next.

4 In the Volume Layout for Secondary Site Storage panel, complete the 

requested information:

Free disks present on 

secondary

Displays the list of free disks that exist on the secondary 

along with details about the free space and total disk space 

information.

Selecting Disks For each of the disk groups that needs to be created, select the 

required disks from the Available Disks pane. Either double-click 

on the host name or the >> option to move the hosts into the 

Selected disks pane.

Under the Available Disks label, a drop-down list allows you to 

filter available disks by disk enclosure name. The default is All, 

which displays all free disks available on all enclosures. 

Disk Group Displays the disk group name to which the volume belongs.

Volume (Volume Size) Displays the name and the size of the volume, corresponding 

to that on the primary, that needs to be created on the 

secondary.
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Click Next.

5 In the Storage Configuration Cloning Summary panel, review the displayed 

information. If you want to change any selection, click Back. Otherwise, 

click Next to allow the wizard to implement the storage configuration at the 

secondary site.

Note: On the VEA GUI of the secondary site, a Windows dialog box might 

appear prompting you to format a disk. Click Cancel to close the dialog. 
The appearance of this dialog box has no impact on the operations being 

performed by the DR wizard. You can safely ignore it.

6 In the Implementation panel, wait until the status for all the completed 

tasks is marked with a check symbol, indicating successful completion. Wait 

until the wizard completes cloning the storage. The progress bar indicates 

the status of the tasks. If some task could not be completed successfully, 

then the task is marked with an (x) symbol. The Information column 

displays details about the reasons for task failure.

Click Next.

Available Disks Select the disks on which you want the wizard to create the 

volumes. From the Available Disks pane, either double-click 

on the disk name or the >> option to move the disks into the 

Selected Disks pane. For each disk group the Available disks 

pane displays the list of disks that are part of the disk group.

Select disks for each unavailable volume that you want to 

clone on to the secondary.

Layout By default, the same layout as the one specified for the 

primary volume is selected. Click Edit to change the layout to 

suit your specific requirements.

Selected Disks Displays the list of disks that have been moved in from the 

Available Disks pane.

View Primary Layout Displays the volume layout at the primary site. Use this 

information as a reference to specify the details for the 

Secondary layout.
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Note: If SCSI-3 support is enabled for using Persistent Group Reservations 

(PGR), and if one of the selected disks is not SCSI-3 compliant, the following 

error is displayed: “Unable to reserve a majority of dynamic disk group 

members. Failed to start SCSI reservation thread.” 
Recommended action: Click Finish to exit the wizard. Either replace the 

non-compliant disk with a SCSI-3 compliant disk, or enable SCSI-2 support, 

and then run the wizard again.

7 In the Storage Cloning Configuration Result screen, view the results and 

click Next.

8 In the Application Installation panel, review the information and do one of 

the following:

■ If the application is already installed on the required nodes, click Next 

to continue with service group cloning.

■ If the application is not yet installed on the secondary site, proceed 

with installation on the required nodes as follows:

For applications that require installing components on shared storage, 

before you begin installation, ensure that your disk groups are 

imported and volumes are mounted. If volumes were mounted as drive 

paths (folder mount) on the primary site, the wizard does not mount 

the volumes on the secondary site. You must manually format the 

volumes and assign the drive path to the volumes using Veritas 

Enterprise Administrator. Use the same letters and folder names that 

were assigned on the primary site.

click Finish to exit the wizard before proceeding with installation on 

that node. Afterwards, restart the Disaster Recovery wizard and 

continue through the wizard from the Welcome panel.
 

Creating temporary storage on the secondary 
site using the DR wizard (array-based replication)

To enable you to install applications, the DR wizard can create a temporary disk 

group, DR_APP_INSTALL__DG, which contains the volumes and mount points 

for use in application installation. The temporary configuration uses 500 MB 

volumes or the volume size at the primary site, depending on which is smaller. 

The wizard deletes the temporary configuration after application installation. 

Note: The DR wizard cannot be used if you are setting up DR in a non-shared 

storage environment.
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If you have already installed the application on all nodes, you can skip this 

storage cloning step by unchecking the Perform storage cloning check box on 

the Storage Cloning panel.

If you are starting the wizard for the first time, see the following topic before 

continuing with the storage cloning procedure:

■ “Configuring disaster recovery with the DR wizard” on page 485.

To create temporary storage for application installation (array-based 

replication)

1 If you have not yet done so, start the Disaster Recovery Configuration 

Wizard and specify the information for the primary site system, the service 

group, and the secondary site system. 

2 In the Replication Options panel, select the array-based replication method 

you plan to use and click Next:

■ EMC SRDF

■ Hitachi TrueCopy

■ Global Cluster Option only (select if you are using another 

agent-supported array-based replication method)

3 If you selected Hitachi TrueCopy replication, the Hitachi TrueCopy File 

Paths panel is displayed. The wizard populates the fields if it locates the 

files in the default location. Otherwise, fill in the file path information for 

both the primary and secondary sites as follows:

4 In the Storage Cloning panel, you can choose whether or not to perform 

storage cloning, which creates a temporary storage disk group and volumes 

for application installation. The wizard will delete the temporary storage 

once you confirm application installation is complete. 

Choose one of the following:

RAID Manager bin path Path to the RAID Manager Command Line interface

Default: C:\HORCM\etc

where C is the system drive.

HORCM files location Path to the horcm configuration files (horcmnn.conf)

Default: C:\Windows

where C is the system drive

An horcm configuration file is required by the RAID 

Manager on all nodes; however the wizard does not 

validate this.
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■ If you have not yet installed the application on all nodes, leave Perform 

storage cloning checked and click Next. Continue with the next step in 

this procedure.

■ If you have already installed the application on all nodes, uncheck 

Perform storage cloning and click Next. Continue with the procedure 

for service group cloning.

5 The Storage Validation Results panel shows the temporary storage 

configuration that the wizard will configure at the secondary site. You can 

click Show Summary to toggle to a summary view and toggle back to a 

detailed view by clicking Show Details. 

The detailed view shows the following:

The summary view shows the following:.

If the panel displays a message indicating that the available disks on the 

secondary are inadequate, you can free some disks on the secondary or add 

more storage. Then click Refresh/Validate so that the wizard can update its 

information about the secondary storage configuration.

Click Next.

6 In the Disk Selection for Storage Cloning panel, a default disk selection is 

shown for the temporary storage at the secondary site. You can change the 

selection by moving disks to and from the Available Disks and Selected 

Disks pane. Under the Available Disks label, a drop-down list allows you to 

Disk Group Displays the name of the single disk group required on the 

secondary site for temporary storage:

DR_APP_INSTALL__DG

Volume Displays the list of volumes required at the secondary site. 

Size Displays the size of the volumes required on the secondary 

site. 

Mount Displays the mounts required at the secondary site.

Recommended 

Action

Indicates the action that the wizard will take at the secondary 

site.

Existing 

configuration

Displays the existing secondary configuration.

Free disks present 

on secondary

Displays the list of free disks that exist on the secondary along 

with details about the free space and total disk space 

information.
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filter available disks by disk enclosure name. The default is All, which 

displays all free disks available on all enclosures. Click Next.

7 The Volume Layout for Secondary Site Storage panel shows a default volume 

layout for the temporary storage based on the primary site volume layout. 

Optionally, you can change the default disk assignment and layout for any 

volume:

Click Next.

8 In the Storage Configuration Cloning Summary panel, review the displayed 

information. If you want to change any selection, click Back. Otherwise, 

click Next to allow the wizard to implement the temporary storage 

configuration at the secondary site.

9 In the Implementation panel, wait until the status for all the completed 

tasks is marked with a check symbol, indicating successful completion. Wait 

until the wizard completes cloning the storage. The progress bar indicates 

the status of the tasks. If some task could not be completed successfully, 

then the task is marked with an (x) symbol. The Information column 

displays details about the reasons for task failure.

Click Next.

Disk Group Displays the DR_APP_INSTALL__DG disk group.

Volume (Volume Size) Displays the name and the size of the volume to be created on 

the secondary.

Available Disks Displays the disks that are available for the volumes. To 

select a disk, either double-click on the host name or click the 

>> button to move the hosts into the Selected Disks pane.

Layout By default, the same layout as the one specified for the 

primary volume is selected. Click Edit to change the layout to 

suit your specific requirements.

Selected Disks Displays the list of disks that have been selected for the 

volume. To remove a disk from the list, select it and click the 

<< button.

View Primary Layout Displays the volume layout at the primary site.
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Note: If SCSI-3 support is enabled for using Persistent Group Reservations 

(PGR), and if one of the selected disks is not SCSI-3 compliant, the following 

error is displayed: “Unable to reserve a majority of dynamic disk group 

members. Failed to start SCSI reservation thread.” 
Recommended action: Click Finish to exit the wizard. Either replace the 

non-compliant disk with a SCSI-3 compliant disk, or enable SCSI-2 support, 

and then run the wizard again.

10 In the Storage Configuration Cloning Result screen, view the results and 

click Next.

11 In the Application Installation panel, review the information and do one of 

the following:

■ For applications that require installing components on shared storage, 

before you begin installation, ensure that your disk groups are 

imported and volumes are mounted. If volumes were mounted as drive 

paths (folder mount) on the primary site, the wizard does not mount 

the volumes on the secondary site. You must manually format the 

volumes and assign the drive path to the volumes using Veritas 

Enterprise Administrator. Use the same letters and folder names that 

were assigned on the primary site.

■ If you keep the wizard running during installation, once application 

installation is complete, click Next to proceed with service group 

cloning. Otherwise, restart the DR wizard and continue through the 

wizard from the Welcome panel. 

Once the application is installed, the temporary cloned storage is no 

longer needed. Before beginning service group cloning, the wizard 

displays the Temporary Storage Deletion panel to confirm the deletion 

of the temporary storage.
 

Installing and configuring the application 
or server role (secondary site)

This section provides important points which you must consider before you 

install the application.

The FileShare application is installed as a part of the SFW HA installation. For 

any other application refer to the documentation provided with the application 

to complete the installation.
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Installing the FileShare application
Points to note when installing FileShare:

■ Make sure the disk group and volumes that contain the file server shared 

directory exist on the shared storage (VMDg) or non-shared storage 

(VMNSDg).

■ When installing and configuring a new file server shared directory, create 

the disk groups and volumes on the shared storage (VMDg) or non-shared 

storage (VMNSDg) and subsequently create the directory structure for the 

file shares.

■ If your configuration already has a file server with shares on the local 

storage, then move these shares to the shared storage (VMDg) or non-shared 

storage (VMNSDg) using practices recommended by Microsoft.

 

Installing the IIS application
Points to note when installing IIS:

■ Verify that IIS is installed and configured identically on all nodes hosting 

the service group. Verify that the sites to be monitored are on the shared 

storage (VMDg) or non-shared storage (VMNSDg).

■ Import the disk groups and mount the volumes that contain the website 

data, on the first node.

■ For a new IIS installation, while creating new websites, create the site folder 

on the shared storage (VMDg) or non-shared storage (VMNSDg) and place 

the site content in that folder.

■ Change the default home directory path for all the IIS sites to be monitored 

to a location on the shared storage (VMDg) or non-shared storage 

(VMNSDg). See the IIS documentation for instructions.

■ For existing websites, stop the sites and then move the website content to 

volumes on the shared storage (VMDg) or non-shared storage (VMNSDg). 

You must also reconfigure the home directory location for the website in IIS 

and then restart the website again.

■ Verify the port numbers assigned to IIS sites are not used by other 

applications or sites.

■ Synchronize the IIS configuration on all nodes hosting the service group.

Installing additional applications
Following are some very generic points for installing any application:
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■ Make sure that the disk groups and volumes are mounted on the node. The 

DR wizard mounts volumes assigned to drive letters on the first node. 

However, if the primary site uses folder mounts, you must format the 

volumes and specify the drive path manually using the Veritas Enterprise 

Administrator. For each additional node, you must unmount volumes and 

deport the disk groups and import and mount them on the additional node.

■ VCS requires the application program files to be installed on the same local 

drive on all nodes. For example, if you install the application program files 

on drive C of one node, installation of these same files on all other nodes. 

must be on drive C. Make sure that the same drive letter is available on all 

nodes and has adequate space for the installation.

■ The data files and any associated files, such as log files, should be installed 

on the shared storage (VMDg) or non-shared storage (VMNSDg).

Cloning the service group configuration 
from the primary to the secondary site

Before cloning the service group on the secondary site, verify that you have 

installed the application on the secondary site.

Note: The DR wizard cannot be used if you are setting up DR in a non-shared 

storage environment.

If you are launching the wizard for the first time, see the following topic for 

additional information:

“Configuring disaster recovery with the DR wizard” on page 485

Note: Although you can view the cloning progress in the VCS Java Console, do 

not save and close the configuration while cloning is in progress. Otherwise, the 

cloning fails and you have to delete the service group on the secondary site and 

run the wizard again.

To clone the service group configuration from the primary site to the 

secondary site

1 At the primary site, verify that you have brought the application service 

group online.

2 Start the DR Configuration Wizard from the Solutions Configuration Center. 

Click Start > All Programs > Symantec > Veritas Cluster Server > Solutions 

Configuration Center. 
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Expand the  Solutions for Additional Applications tab and click Disaster 

Recovery Configuration > Configure Disaster Recovery > Disaster Recovery 

Configuration Wizard.

3 In the Welcome panel, click Next and continue through the wizard, 

providing the requested information for the primary site system, the service 

group, the secondary site system, and the replication method. 

If you selected the VVR replication method, the wizard proceeds to the 

storage cloning task and notifies you if it detects that the storage is 

identical. Click Next until you reach the Service Group Analysis panel. 

If you selected an array-based replication method (EMC SRDF, HTC, or GCO 

only), the temporary storage is no longer needed once the application is 

installed and the wizard confirms whether or not to delete it. 

4 Array-based replication method only) In the Temporary Storage Deletion 

panel, confirm whether or not to delete the cloned storage:

■ If the application is already installed on the required nodes, leave 

Delete cloned storage checked and click Next. When the wizard 

prompts you to confirm deleting the shared storage, click Yes.

■ If you want to delete the cloned storage manually later, uncheck Delete 

cloned storage and click Next.

5 (Array-based replication method only) If you selected to delete the cloned 

storage, the wizard shows the progress of the tasks in the Implementation 

panel. If the storage deletion fails, the wizard will show a failure summary 

page. Otherwise, when it shows the tasks are complete, click Next.

6 Review the following information displayed in the Service Group Analysis 

panel and click Next to continue with service group cloning. 

Service Group Name Displays the list of application-related service groups 

present on the cluster at the primary site.

Service Group Details 

on the Primary 

Cluster

Displays the resource attributes for the service group at 

the primary site. 

The NIC resource consists of the MAC address.

The IP resource consists of the IP address and subnet 

mask. 

Service Group Details 

on the Secondary 

Cluster

Displays a message to indicate whether the service group 

or the corresponding attributes have been configured at 

the secondary site. 
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7 In the Service Group Cloning panel, specify the requested system 

information for the secondary site.

Click Next.

8 In the Service Group Attribute Selection panel, complete the requested 

information to create the required resources on the secondary site. The 

panel also displays the service group resource name and the attribute 

information at the primary site. 

Service Group Name Depending on the application service group already created at 

the primary site, and subsequently selected on the Service 

Group Selection page, the wizard displays the names of the 

service groups that will be cloned at the secondary site.

Available Systems Displays a list of available systems on the secondary cluster 

that are not yet selected for service group cloning.

Select any additional secondary systems on which you want 

the wizard to clone the application service group 

configuration.

Either double-click on the system name or use the > option to 

move the hosts into the Selected Systems pane. 

Note: If you want to add systems to a service group after you 

finish cloning the service group configuration with the DR 

wizard, you cannot do so by running the DR wizard again. 

Instead, run the VCS configuration wizard and edit the system 

list of the existing service group.

Selected Systems Displays the list of selected systems. The secondary system 

that you selected earlier in the wizard is listed by default.

Resource Name Displays the list of resources that exist on the primary 

cluster. 

Attribute Name Displays the attribute name associated with each of the 

resources displayed in the Resource Name column. 

If you need to edit additional attributes that are not shown, 

you must edit them manually on the secondary site service 

group once service group cloning is complete.

Primary Cluster Displays the primary attribute values for each of the 

displayed attributes.
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Click Next.

9 In the Service Group Summary, review the attribute information that will be 

cloned on to the secondary cluster. Click Back to change any of the 

secondary service group attributes. Otherwise, click Next to proceed with 

cloning the service group configuration on the secondary site.

10 In the Implementation panel, wait until all the tasks are completed.The 

progress bar indicates the status of the tasks. Successful tasks are marked 

with a check symbol. If some task could not be completed successfully, the 

task is marked with an (x) symbol. The Information column displays details 

about the reasons for task failure. Click Next

11 If the cloning failed, review the troubleshooting information. Otherwise, 

click Next to continue with the replication and GCO configuration, or with 

GCO only, depending on which option you selected. 

Optionally, you can exit the wizard at this point and launch the wizard 

again later. When you launch the wizard again, continue through the 

wizard, specifying the primary site system, the service group, the secondary 

site system, and the replication method. Click Next to continue to the 

replication and/or GCO configuration task.
 

Configuring the application service group  
in a non-shared storage environment

This is applicable only if you are setting up disaster recovery in a non-shared 

storage environment.

You cannot use the DR wizard to clone the application service group created at 

the primary site if the service group contains VCS resources configured for 

non-shared storage (VMNSDg agent resources). You must configure the service 

group manually using the Cluster Manager (Java Console).

Secondary Cluster For an IPv4 network, the default is the same as the primary 

cluster; the same virtual IP address can be used if both 

sites exist on the same network segment. You can specify 

different attributes depending on your environment. 

For IPv6, select the network from the dropdown list. An IP 

address will be generated from the network. 

For the MACAddress attribute select the appropriate public 

NIC from the drop-down list. 

For IPv6 available NICs are those belonging to the selected 

IPv6 network.
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Note the following before configuring the service group at the secondary site:

■ Ensure that the application agent resources, the Lanman resource (if 

configured), and the IP resource is offline in the service group on the 

primary site. The remaining resources, including the storage resources, 

must be online.

■ Ensure that the name of the service group is the same as that on the primary 

site.

■ After configuring the service group do not bring it online on the secondary 

site at this time. You can bring it online later after completing all the DR 

configuration steps.

See “Configuring the service group in a non-shared storage environment” on 

page 157.

Configuring replication and global clustering
After creating the identical service group configuration on both sites, the DR 

wizard helps you set up replication and global clustering (GCO option). You can 

choose to configure replication using VVR or an agent-supported array-based 

hardware replication.

Note: The DR wizard cannot be used if you are setting up DR in a non-shared 

storage environment.

If you are using an array-based replication that is not supported by the wizard, 

you configure global clustering only. In this case, you must complete 

configuring global clustering before configuring replication.

The following topics cover the steps required for each replication method:

■ “Configuring VVR replication and global clustering” on page 503

■ “Configuring EMC SRDF replication and global clustering” on page 511

■ “Configuring Hitachi TrueCopy replication and global clustering” on 

page 514

■ “Configuring global clustering only” on page 518

Configuring VVR replication and global clustering
After you complete the service group configuration task in the DR wizard, you 

configure VVR replication and global clustering.

Before you begin, ensure that you have met the following prerequisites:
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■ Ensure that Veritas Volume Replicator is installed at the primary and 

secondary site. 

■ Ensure that Global Cluster Option (GCO) is installed at the primary and 

secondary site. One static IP address must be available per site for 

configuring GCO.

■ Ensure that VVR Security Service (VxSAS) is configured at the primary and 

secondary site. See the following topic:

■ “Configuring the VVR security service” on page 478

■ Ensure that you have set the appropriate IP preference, whether VVR should 

use IPv4 or IPv6 addresses. The default setting is IPv4.

When you specify host names while configuring replication, VVR resolves 

the host names with the IP addresses associated with them. This setting 

determines which IP protocol VVR uses to resolve the host names. 

Use Veritas Enterprise Administrator (VEA) (Control Panel > VVR 

Configuration > IP Settings tab) to set the IP preference. 

■ Ensure that a minimum of one static IP address per site is available for each 

application instance running in the cluster.

■ Ensure that, for remote cluster configuration, you configure a VCS user with 

the same name and privileges in each cluster.

Use the following procedure to configure VVR replication and global clustering 

with the DR wizard. 

To configure VVR replication and GCO

1 Verify that the application server service group is online at the primary site 

and the appropriate disk groups are imported at the secondary site.

2 If the wizard is still open after the previous wizard task, continue with the 

Replication Setup panel. Otherwise, launch the wizard and proceed to the 

Replication Setup panel as follows:

■ Expand the Solutions for Additional Applications tab and click Disaster 

Recovery Configuration > Configure Disaster Recovery > Disaster 

Recovery Configuration Wizard.

■ Start the DR Configuration Wizard from the Solutions Configuration 

Center. Click Start > All Programs > Symantec > Veritas Cluster Server 

> Solutions Configuration Center. 

■ On the Welcome panel, click Next and continue through the wizard, 

providing the requested information.

■ On the Replication Methods panel, click Configure VVR and the Global 

Cluster Option (GCO). Click Next. 
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3 In the Internet Protocol panel, select IPv4 or IPv6 depending on which type 

of network you are using. (You must use the same on primary and secondary 

sites.) Click Next. 

4 In the Replication Setup panel, review the replication requirements. If you 

have met the requirements, click Next. If not, click Cancel and restart the 

wizard after meeting the requirements.

5 In the Replication Settings for Replicated Volume Group panel, specify the 

requested information. If you are adding a DR site to an existing DR 

configuration, fields that must match the existing settings, such as the RVG 

or RDS name, are dimmed so that you cannot change them.

Disk Group The left column lists the disk groups. By design, an RVG 

is created for each disk group.

RVG Name Displays the default RVG name. If required, change this 

to a name of your choice.

RDS Name Displays the default Replicated Data Set (RDS) name. If 

required, change this to a name of your choice.
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■ Click Advanced Settings to specify some additional replication 

properties. The options on the dialog box are described column-wise, 

Available Volumes Displays the list of available volumes that have not been 

selected to be a part of the RVG.

Either double-click on the volume name or use the > 

option to move the volumes into the Selected RVG 

Volumes pane.

Selected RVG Volumes Displays the list of volumes that have been selected to 

be a part of the RVG.

To remove a selected volume, either double-click the 

volume name or use the < option to move the volumes 

into the Available Volumes pane.

Primary SRL If you did not create a Replicator Log volume on the 

primary site, click Create New on the drop-down menu. 

On the New Volume dialog box, specify the name, size, 

and disk.

Otherwise, select the appropriate primary Replicator 

Log volume from the drop-down menu and enter an 

appropriate size.

Secondary SRL If you did not create a Replicator Log volume on the 

primary site, click Create New on the drop-down menu. 

On the New Volume dialog box, specify the same name 

and size as you specified for the primary SRL.

Otherwise, select the appropriate secondary Replicator 

Log volume from the drop-down menu and enter an 

appropriate size. 

Add RVG Click this option to create a new RVG. This option is 

especially useful if you want to organize the volumes 

present in a disk group under separate RVGs. By, default 

the wizard is designed to organize all the volumes under 

a disk group under one RVG. However, using the Add 

RVG option you can choose to organize them differently, 

based on your specific requirements.

Delete RVG Click this option to delete any of the existing RVGs 

related to the DR set up that you are creating.

Start Replication after the 

wizard completes

Select this check box to start replication automatically 

after the wizard completes the necessary 

configurations.

Once replication is configured and running, deselecting 

the checkbox does not stop replication.
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from left to right; refer to the Veritas Volume Replicator 

Administrator’s Guide for additional information on VVR replication 

options.

Replication Mode Select the required mode of replication; Synchronous, 

Asynchronous, or Synchronous Override. The default is 

synchronous override. 

Log Protection Select the appropriate log protection from the list. 

The AutoDCM is the default selected mode for the 

Replicator Log overflow protection when all the volumes 

in the Primary RVG have a DCM log. The DCM is enabled 

when the Replicator Log overflows. 

The Off option disables Replicator Log Overflow 

protection. 

The Override option enables log protection. If the 

Secondary node is still connected and the Replicator Log 

is about to overflow then the writes are stalled until a 

predetermined amount of space, that is, 5% or 20 MB 

(whichever is lesser) becomes available in the Replicator 

Log.

If the Secondary becomes inactive due to disconnection or 

administrative action then Replicator log protection is 

disabled, and the Replicator Log overflows.

The Fail option enables log protection. If the log is about 

to overflow the writes are stalled until a predetermined 

amount of space, that is, 5% or 20 MB (whichever is lesser) 

becomes available in the Replicator Log. If the connection 

between primary and secondary RVG is broken, then, any 

new writes to the primary RVG are failed.
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Primary RLINK 

Name

Enter a name of your choice for the primary RLINK. If you 

do not specify any name then the wizard assigns a default 

name.

Secondary RLINK 

Name

Enter a name of your choice for the Secondary RLINK. If 

you do not specify any name then the wizard assigns a 

default name.

Bandwidth By default, VVR replication uses the maximum available 

bandwidth. You can select Specify to specify a bandwidth 

limit. 

The default unit is Mega bits per second (Mbps) and the 

minimum allowed value is 1 Mbps.

Protocol Choose TCP or UDP. UDP/IP is the default replication 

protocol. 

Packet Size (Bytes) Default is 1400 Bytes. From the drop-down list, choose the 

required packet size for data transfer. The default unit for 

the packet size is Bytes. You can set the packet size only if 

the protocol is UDP/IP. 

Latency Protection By default, latency protection is set to Off. 

When this option is selected the High Mark Value and the 

Low Mark Value are disabled. Select the Fail or Override 

option to enable Latency protection. 

This Override option behaves like the Off option when the 

Secondary is disconnected and behaves like the Fail 

option when the Secondary is connected.

High Mark Value This option is enabled only when Latency Protection is set 

to Override or Fail. It specifies the maximum number of 

pending updates by which the secondary site can be 

behind the primary site. The default value is 10000.

To ensure that latency protection is most effective the 

difference between the high and low mark values must 

not be very large.

Low Mark Value This option is enabled only when Latency Protection is set 

to Override or Fail. When the updates in the Replicator log 

reach the High Mark Value, then the writes to the system 

at the primary site continues to be stalled until the 

number of pending updates on the Replicator log falls 

back to the Low Mark Value. The default is 9950.



509Deploying disaster recovery: New application installation

Configuring replication and global clustering
To apply changes to advanced settings, click OK. On the Replication 

Settings for Replicated Volume Group panel click Next.

6 In the Replication Attribute Settings panel, specify required replication 

attribute information for the cluster at the primary and secondary site. Click 

the arrow icon to expand an RVG row and display the replication attribute 

fields. If you are configuring an additional secondary site (multiple DR sites), 

some fields are disabled.

Initial 

Synchronization

If you are doing an initial setup, then use the Auto 

Synchronous option to synchronize the secondary site 

and start replication. This is the default. 

When this option is selected, VVR by default performs 

intelligent synchronization to replicate only those blocks 

on a volume that are being used by the file system. If 

required, you can disable intelligent synchronization. 

If you want to use the Synchronize from Checkpoint 

method then you must first create a checkpoint. 

If you have a considerable amount of data on the primary 

data volumes then you may first want to synchronize the 

secondary for existing data using the backup-restore 

method with checkpoint. After the restore is complete, 

use the Synchronize from Checkpoint option to start 

replication from the checkpoint to synchronize the 

secondary with the writes that happened when 

backup-restore was in progress. 

Disk Group Displays the list of disk groups that have been configured.

RVG Name Displays the Replicated Volume Groups corresponding to 

the disk groups.

IP Address For IPv4 networks, enter replication IPs that will be used 

for replication, one for the primary site and another for 

the secondary site.

For IPv6, select the network from the dropdown list. An IP 

address will be generated.

Subnet Mask 
or 
Prefix

For IPv4, enter the subnet mask for the system at the 

primary site and the secondary site.

For IPv6, enter the prefix.
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After specifying the replication attributes for each of the RVGs, click 

Next.

7 In the Global Cluster Settings panel specify the heartbeat information for 

the wide-area connector resource. You must specify this information for the 

primary and the secondary cluster. Any existing WAC resource information 

can be reused. If you are adding a DR site to an existing DR configuration, 

GCO is already configured at the primary site, so the primary site fields are 

dimmed.

Public NIC Select the public NIC from the drop-down list for the 

system at the primary and secondary site. For IPv6, 

available NICs are those belonging to the selected 

network.

Copy Enables you to copy the above network settings to any 

additional RVGs that are listed on this screen. If there is 

only one RVG, this option does not apply.

Use existing settings Allows you to use a WAC resource that already exists at either 

the primary or secondary site. Click Primary or Secondary, 

depending on the site at which the WAC resource already 

exists.

Resource Name Select the existing WAC resource name from the resource 

name list box.

Create new settings Select the appropriate site, primary or secondary, for which 

you want to create a new WAC resource.

IP Address For IPv4, enter a virtual IP for the WAC resource.

For IPv6, select the network from the dropdown list. An IP 

address will be generated.

Subnet Mask 
or 
Prefix

For IPv4, enter the subnet mask for the system at the primary 

site and the secondary site.

For IPv6, enter the prefix.

Public NIC Select the public NIC for each system from the drop-down list 

for the system at the primary and secondary site.
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8 In the Settings Summary panel, review the displayed information. Click 

Back if you want to change any of the parameters. If you have a printer 

installed, you can click the printer icon at the bottom of the scrollable list to 

print the settings.

Click Next to implement the settings.

9 In the Implementation panel, wait till the wizard completes creating the 

replication configuration and the WAC resource required for global 

clustering. If a task could not be completed successfully, it is marked with an 

(x) symbol. For any critical errors, the wizard displays an error message. For 

less critical errors, the Information column displays a brief description 

about the task failure and the next screen displays additional information 

on what action you can take to remedy it. Click Next.

10 In the Finish panel, review the displayed information. If a task did not 

complete successfully, the panel displays an error message, which will 

provide some insight into the cause for failure. Click Finish to exit the 

wizard.
 

Configuring EMC SRDF replication and global clustering
After you complete the service group configuration task in the DR wizard, you 

configure replication and global clustering.

The wizard helps you to configure the settings for the SRDF resource in the 

application service group. 

Ensure that you have met the prerequisites for replication. See the following 

topic:

■ “Requirements for EMC SRDF array-based hardware replication” on 

page 480

In addition, ensure that the Global Cluster Option (GCO) is installed at the 

primary and secondary site. One static IP address must be available per site for 

configuring GCO.

The wizard configures the required agent settings as well as the SYMM 

heartbeat. It uses defaults for optional settings. See the following topic:

Start GCO after 

configuration

Select this check box to bring the cluster service group online 

and start GCO automatically after the wizard completes the 

necessary configurations. Otherwise, you must bring the 

service group online and start GCO manually, after the wizard 

completes. 

Once GCO is configured and running, deselecting the 

checkbox does not stop GCO.
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■ “Optional settings for EMC SRDF” on page 514

To configure EMC SRDF replication and GCO

1 Verify that you have brought the application service group online at the 

primary site.

2 If the wizard is still open after the service group cloning task, continue with 

the Replication Setup panel. Otherwise, launch the wizard and proceed to 

the Replication Setup panel as follows:

■ Start the DR Configuration Wizard from the Solutions Configuration 

Center. Click Start > All Programs > Symantec > Veritas Cluster Server 

> Solutions Configuration Center. Expand the  Solutions for Additional 

Applications tab and click Disaster Recovery Configuration > 

Configure Disaster Recovery > Disaster Recovery Configuration 

Wizard.

■ In the Welcome panel, click Next and continue through the wizard, 

providing the requested information. 

■ In the Replication Methods panel, click Configure EMC SRDF and the 

Global Cluster Option (GCO). Click Next and continue to the Replication 

Setup panel.

3 In the Replication Setup panel, review the replication requirements. If you 

have met the requirements, click Next. 

Warning: Although you can continue with the wizard even if replication 

requirements are not met, the wizard will warn you that the configuration 

is not valid. If the configuration is not valid, the SRDF resource cannot come 

online in the service group.

4 In the SRDF Resource Configuration panel, the wizard populates the 

required resource fields if replication has been configured. Otherwise, you 

must enter the required resource settings manually. 

5 If you want to configure an additional SRDF resource for the instance, click 

Add. Otherwise, click Next.

Symmetrix Array ID (SID) Specify the array ID for the primary site and for the 

secondary site.

Device Group name Specify the name of the Symmetrix device group that 

contains the disks of the disk group for the selected 

instance.

Available VMDG Resources Select the disk groups associated with the selected 

application instance.
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6 In the Global Cluster Settings panel, specify the heartbeat information for 

the wide-area connector resource. You must specify this information for the 

primary and the secondary cluster. Any existing WAC resource information 

can be reused. If you are adding a DR site to an existing DR configuration, 

GCO is already configured at the primary site, so the primary site fields are 

dimmed.

Click Next.

7 In the Settings Summary panel, review the displayed information. Click 

Back if you want to change any of the parameters specified for the 

replication resource settings or the global cluster settings. 

Click Next.

8 In the Implementation panel, wait until the wizard completes creating the 

replication configuration and the WAC resource required for global 

clustering, A check (✔) symbol indicates successful completion of a task. An 

(x) symbol indicates a task that could not be completed successfully. The 

Information column shows details about the reasons for task failure. Click 

Next.

Use existing settings Allows you to use a WAC resource that already exists at either 

the primary or secondary site. Click Primary or Secondary, 

depending on the site at which the WAC resource already 

exists.

Resource Name Select the existing WAC resource name from the resource 

name list box.

Create new settings Select the appropriate site, primary or secondary, for which 

you want to create a new WAC resource.

IP Address Enter a virtual IP for the WAC resource.

Subnet Mask Enter the subnet mask for the system at the primary site and 

the secondary site.

Public NIC Select the public NIC for each system from the drop-down list 

for the system at the primary and secondary site.

Start GCO after 

configuration

Select this check box to bring the cluster service group online 

and start GCO automatically after the wizard completes the 

necessary configurations. Otherwise, you must bring the 

service group online and start GCO manually, after the wizard 

completes.

Once GCO is configured and running, deselecting the 

checkbox does not stop GCO.
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9 In the Finish panel, review the displayed information. If a task did not 

complete successfully, the panel displays an error message, which will 

provide some insight into the cause for failure. Click Finish to exit the 

wizard.

10 Proceed with configuring additional optional settings for the SRDF resource 

if desired, and then verifying the disaster recovery configuration.
 

Optional settings for EMC SRDF

The wizard configures the required settings for the SRDF resource in the VCS 

application service group. The wizard also detects and configures the SymHome 

attribute.

Other settings are left in the default state. For information on configuring the 

optional settings, see Veritas Cluster Server Hardware Replication Agent for EMC 

SRDF, Configuration Guide. If you change any settings, ensure that you edit the 

resource on both the primary and secondary sites.

The optional settings use the following defaults:

Configuring Hitachi TrueCopy replication and global clustering 
After you complete the service group configuration task in the DR wizard, you 

configure replication and global clustering.

The wizard helps you to configure the settings for the HTC resource in the 

application service group.

Ensure that you have met the prerequisites. See the following topic:

■ “Requirements for Hitachi TrueCopy array-based hardware replication” on 

page 482

In addition, ensure that the Global Cluster Option (GCO) is installed at the 

primary and secondary site. One static IP address must be available per site for 

configuring GCO.

Option Default setting

DevFOTime  2 seconds per device required for a device to fail over

AutoTakeover The default is 1; the agent performs a read-write enable on parti-

tioned devices in the write-disabled state during a failover, if 

devices are consistent.

SplitTakeover The default is 1; the agent brings service groups online on the R2 

side even if the devices are in the split state because they are 

read-write enabled.
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The wizard configures the required agent settings. It uses defaults for optional 

settings. See the following topic:

■ “Optional settings for HTC” on page 517

To configure Hitachi TrueCopy replication and GCO

1 Verify that you have brought the application server service group online at 

the primary site.

2 If the wizard is still open after the service group cloning task, continue with 

the Replication Setup panel. Otherwise, launch the wizard and proceed to 

the Replication Setup panel as follows:

■ Start the DR Configuration Wizard from the Solutions Configuration 

Center. Click Start > All Programs > Symantec > Veritas Cluster Server 

> Solutions Configuration Center. Expand the  Solutions for Additional 

Applications tab and click Disaster Recovery Configuration > 

Configure Disaster Recovery > Disaster Recovery Configuration 

Wizard.

■ In the Welcome panel, click Next and continue through the wizard, 

providing the requested information.

■ In the Replication Methods panel, click Configure Hitachi TrueCopy and 

the Global Cluster Option (GCO). Click Next and continue to the 

Replication Setup panel.

3 In the Replication Setup panel, review the replication requirements. If you 

have met the requirements, click Next.

Warning: Although you can continue with the wizard even if replication 

requirements are not met, the wizard will warn you that the configuration 

is not valid. If the configuration is not valid, the HTC resource cannot come 

online in the service group.

4 In the HTC Resource Configuration panel, the wizard populates the required 

resource fields if the horcm file is configured properly. If not, you can 

configure the horcm file and click Refresh to populate the fields. 

Alternatively, enter the required resource settings manually:

Instance ID Specify the instance number of the device group.

Multiple device groups may have the same instance 

number.
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5 If you want to configure an additional HTC resource for the instance, click 

Add. Otherwise, click Next.

6 In the Global Cluster Settings panel, specify the heartbeat information for 

the wide-area connector resource. You must specify this information for the 

primary and the secondary cluster. Any existing WAC resource information 

can be reused. If you are adding a DR site to an existing DR configuration, 

GCO is already configured at the primary site, so the primary site fields are 

dimmed.

Device Group name Specify the name of the Hitachi device group that 

contains the disk group for the selected instance. The 

device group name must be the same on both the 

primary and secondary sites.

Available VMDG Resources Select the disk groups associated with the selected 

application instance.

Add, Remove, Reset buttons Click Add or Remove to display empty fields so that 

you can manually add or remove additional resources. 

Click Refresh to repopulate all fields from the current 

horcm file.

Use existing settings Allows you to use a WAC resource that already exists at either 

the primary or secondary site. Click Primary or Secondary, 

depending on the site at which the WAC resource already 

exists.

Resource Name Select the existing WAC resource name from the resource 

name list box.

Create new settings Select the appropriate site, primary or secondary, for which 

you want to create a new WAC resource.

IP Address Enter a virtual IP for the WAC resource.

Subnet Mask Enter the subnet mask for the system at the primary site and 

the secondary site.

Public NIC Select the public NIC for each system from the drop-down list 

for the system at the primary and secondary site.
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7 In the Settings Summary panel, review the displayed information. Click 

Back if you want to change any of the parameters specified for the 

replication resource settings or the global cluster settings. 

Click Next.

8 In the Implementation panel, wait until the wizard completes creating the 

replication configuration and the WAC resource required for global 

clustering, A check (✔) symbol indicates successful completion of a task. An 

(x) symbol indicates a task that could not be completed successfully. The 

Information column shows details about the reasons for task failure. Click 

Next.

9 In the Finish panel, review the displayed information. If a task did not 

complete successfully, the panel displays an error message, which will 

provide some insight into the cause for failure. Click Finish to exit the 

wizard.

10 Proceed with configuring additional optional settings for the HTC resource 

if desired, and then verifying the disaster recovery configuration.
 

Optional settings for HTC

The wizard configures the required settings for the HTC resource in the VCS 

application service group. 

Optional settings are left in the default state. For information on configuring the 

optional settings, see Veritas Cluster Server Hardware Replication Agent for 

Hitachi TrueCopy, Configuration Guide.

The optional settings use the following defaults:

Start GCO after 

configuration

Select this check box to bring the cluster service group online 

and start GCO automatically after the wizard completes the 

necessary configurations. Otherwise, you must bring the 

service group online and start GCO manually, after the wizard 

completes.

Once GCO is configured and running, deselecting the 

checkbox does not stop GCO.

Option Default setting

LinkMonitor The default is 0; the agent does not periodically attempt to resyn-

chronize the S-VOL side if the replication link is disconnected.The 

value 1 indicates that when the replication link is disconnected, 

the agent periodically attempts to resynchronize the S-VOL side 

using the pairresync command.



518 Deploying disaster recovery: New application installation

Configuring replication and global clustering
Configuring global clustering only

If  you  are using a replication method that the DR wizard does not configure, you 
must select the replication option to configure global clustering only. 

For the GCO only option, you use the wizard to complete all DR tasks except the 

replication configuration task. You must complete the final wizard task of 

configuring global clustering before configuring replication.

Before configuring GCO:

■ Ensure that the Global Cluster Option (GCO) is installed at the primary and 

secondary site. One static IP address must be available per site for 

configuring GCO.

■ If you created secure clusters at the primary site and secondary site, ensure 

that you have configured a VCS user with the same name and privileges in 

each cluster, and the user must be added in the Administrator role.

The following procedure assumes that you have completed the earlier wizard 

tasks through the service group cloning task and are continuing with the final 

step of configuring global clustering. 

To configure GCO only

1 If the wizard is still open after the service group cloning task, continue with 

the GCO Setup panel. Otherwise, launch the wizard and proceed to the GCO 

Setup panel as follows:

■ Start the DR Configuration Wizard from the Solutions Configuration 

Center. Click Start > All Programs > Symantec > Veritas Cluster Server 

> Solutions Configuration Center. Expand the Solutions for Additional 

Applications tab and click Disaster Recovery Configuration > 

Configure Disaster Recovery > Disaster Recovery Configuration 

Wizard.

■ In the Welcome panel, click Next and continue through the wizard, 

providing the requested information. 

■ In the Replication Methods panel, click Configure Global Cluster 

Option (GCO) only. Click Next and continue to the GCO Setup panel.

2 In the GCO Setup panel, review the requirements. If you have met the 

requirements, click Next. 

SplitTakeover The default is 0; the agent does not permit a failover to S-VOL 

devices if the replication link is disconnected; that is, if P-VOL 

devices are in the PSUE state.

Option Default setting
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3 In the Global Cluster Settings panel specify the heartbeat information for 

the wide-area connector resource. You must specify this information for the 

primary and the secondary cluster. Any existing WAC resource information 

can be reused. If you are adding a DR site to an existing DR configuration, 

GCO is already configured at the primary site, so the primary site fields are 

dimmed.

4 In the Settings Summary panel, review the displayed information. Click 

Back if you want to change any of the parameters specified. 

Click Next.

5 In the Implementation panel, wait until the wizard completes creating the 

replication configuration and the WAC resource required for global 

clustering, A check (✔) symbol indicates successful completion of a task. An 

(x) symbol indicates a task that could not be completed successfully. The 

Information column shows details about the reasons for task failure. Click 

Next.

Use existing settings Allows you to use a WAC resource that already exists at either 

the primary or secondary site. Click Primary or Secondary, 

depending on the site at which the WAC resource already 

exists.

Resource Name Select the existing WAC resource name from the resource 

name list box.

Create new settings Select the appropriate site, primary or secondary, for which 

you want to create a new WAC resource.

IP Address For IPv4, enter a virtual IP for the WAC resource.

For IPv6, select the network from the dropdown list. An IP 

address will be generated.

Subnet Mask 
or 
Prefix

For IPv4, enter the subnet mask for the system at the primary 

site and the secondary site.

For IPv6, enter the prefix.

Public NIC Select the public NIC for each system from the drop-down list 

for the system at the primary and secondary site.

Start GCO after 

configuration

Select this check box to bring the cluster service group online 

and start GCO automatically after the wizard completes the 

necessary configurations. Otherwise, you must bring the 

service group online and start GCO manually, after the wizard 

completes.

Once GCO is configured and running, deselecting the 

checkbox does not stop GCO.
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6 In the Finish panel, review the displayed information. If a task did not 

complete successfully, the panel displays an error message, which will 

provide some insight into the cause for failure. Click Finish to exit the 

wizard.
 

Creating the replicated data sets (RDS) for VVR 
replication

This is applicable only if you are setting up disaster recovery in a non-shared 

storage environment.

You cannot use the DR wizard to configure VVR replication if the service group 

contains VCS resources configured for non-shared storage (VMNSDg agent 

resources). You must configure replication using the Setup Replicated Data Set 

Wizard.

Configuring VVR involves setting up the replicated data sets (RDS) on the hosts 

for the primary and secondary sites. The Setup Replicated Data Set Wizard 

enables you to configure Replicated Data Sets for both sites.

See “Setting up the Replicated Data Sets (RDS)” on page 386.

Creating the VVR RVG service group for replication
This is applicable only if you are setting up disaster recovery in a non-shared 

storage environment.

You cannot use the DR wizard to configure VVR replication if the service group 

contains VCS resources configured for non-shared storage (VMNSDg agent 

resources). You must configure the replication service group manually using the 

Cluster Manager (Java Console).

Complete the following procedures first on the node in the primary site. Then 

repeat all the steps on the node in the secondary site. You must follow the order 

of the procedures as mentioned.

Refer to the following topics:

■ See “Configuring a RVG service group for replication” on page 398.

■ See “Creating the RVG service group” on page 398.

■ See “Configuring the IP and NIC resources” on page 400.

■ See “Configuring the VMDg or VMNSDg resources for the disk groups” on 

page 402.

■ See “Adding the VVR RVG resources for the disk groups” on page 404.
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■ See “Linking the VVR RVG resources to establish dependencies” on 

page 405.

■ See “Deleting the VMDg or VMNSDg resource from the application service 

group” on page 406.

■ See “Configuring the RVG Primary resources” on page 406.

■ See “Creating the RVG Primary resources” on page 407.

■ See “Linking the RVG Primary resources to establish dependencies” on 

page 408.

■ See “Bringing the RVG Primary resources online” on page 408. (only on the 

primary site)

■ See “Setting a dependency between the service groups” on page 409.

Configuring the global cluster option for wide-area 
failover

This is applicable only if you are setting up disaster recovery in a non-shared 

storage environment.

The Global Cluster option is required to manage global clustering for wide-area 

disaster recovery. The process of creating a global cluster environment involves

the following tasks:

■ Connecting standalone clusters by adding a remote cluster to a local cluster

■ Converting the local service group that is common to all the clusters to a 

global service group

Use the VCS Java Console and perform the following global cluster operations:

■ See “Linking clusters: Adding a remote cluster to a local cluster” on 

page 521.

■ See “Converting a local service group to a global service group” on page 523.

■ See “Bringing a global service group online” on page 525.

Linking clusters: Adding a remote cluster to a local cluster
This is applicable only if you are setting up DR manually in a non-shared storage 

environment.

The VCS Cluster Manager (Java Console) provides a wizard to create global 

clusters by linking standalone clusters or bringing a standalone cluster into an 

existing global environment. 
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Note the following uses of the wizard:

■ If you are creating a global cluster environment for the first time with two 

standalone clusters, run the wizard from either the cluster on the primary 

site or the cluster on the secondary site.

■ If you are adding a standalone cluster to an existing global cluster 

environment, run the wizard from a cluster already in the global cluster 

environment.

The following information is required for the Remote Cluster Configuration 

Wizard in VCS Cluster Manager:

■ The active host name or IP address of each cluster in the global 

configuration and of the cluster being added to the configuration.

■ The user name and password of the administrator for each cluster in the 

configuration.

■ The user name and password of the administrator for the cluster being 

added to the configuration.

Symantec does not support adding a cluster that is already part of a global 

cluster environment. To merge the clusters of one global cluster 

environment (for example, cluster A and cluster B) with the clusters of 

another global environment (for example, cluster C and cluster D), separate 

cluster C and cluster D into standalone clusters and add them one by one to 

the environment containing cluster A and cluster B.

To add a remote cluster in Cluster Explorer

1 From Cluster Explorer, click Add/Delete Remote Cluster on the Edit menu.

or

From the Cluster Explorer configuration tree, right-click the cluster name, 

and click Add/Delete Remote Cluster.

2 Review the required information for the Remote Cluster Configuration 

Wizard and then click Next.

3 In the Wizard Options panel, click Add Cluster, then click Next.

4 In the New Cluster Details panel, enter the details of the new cluster.

If the cluster is not running in secure mode, specify the following:

■ Enter the host name of a cluster system, an IP address of a cluster 

system, or the IP address of the cluster that will join the global 

environment.

■ If necessary, change the default port number.

■ Enter the user name and the password.

■ Click Next.
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If the cluster is running in secure mode, specify the following:

■ Enter the host name of a cluster system, an IP address of a cluster 

system, or the IP address of the cluster that will join the global 

environment.

■ Verify the port number.

■ Choose to connect to the remote cluster with the credentials used for 

the current cluster connection, or enter new credentials, including the 

user name, password, and the domain.

■ If you connected to the remote cluster earlier through the wizard, you 

can use the credentials from the previous connection.

■ Click Next.

5 Click Finish. After running the wizard, the configurations on all the relevant 

clusters are in read-write mode; the wizard does not close the 

configurations.

6 Verify that the heartbeat connection between clusters is alive. From the 

command window enter hahb -display. The state attribute in the output 

should show alive.

If the state is unknown, then offline and online the ClusterService group.
 

Converting a local service group to a global service group
This is applicable only if you are setting up DR manually in a non-shared storage 

environment.

To convert a local service group to a global group

1 From Cluster Explorer, click Configure Global Groups on the Edit menu.

or

From the Cluster Explorer configuration tree, right-click the cluster, and 

click Configure Global Groups.

or

From the Cluster Explorer configuration tree, right-click the service group, 

click Configure As Global, and proceed to step 3.

2 Review the information required for the Global Group Configuration wizard 

and click Next.

3 Enter the details of the service group to modify, as follows:

■ Click the name of the service group that will be converted from a local 

group to a global group, or vice versa.

■ From the Available Clusters box, click the clusters on which the group 

can come online. Click the right arrow to move the cluster name to the 
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Clusters for Service Group box; for global to local cluster conversion, 

click the left arrow to move the cluster name back to the Available 

Clusters box. A priority number (starting with 0) indicates the cluster 

on which the group will attempt to come online. If necessary, 

double-click the entry in the Priority column and enter the new value.

■ Select the policy for cluster failover as follows:

■ Click Next.

4 Enter or review the connection details for each cluster. Click the Configure 

icon to review the remote cluster information for each cluster, as follows:

5 Click Next, then click Finish.

Manual Prevents a group from automatically failing over to 

another cluster.

Auto Enables a group to automatically fail over to another 

cluster if it is unable to fail over within the cluster, or if 

the entire cluster fails.

Connected Enables a group to automatically fail over to another 

cluster if it is unable to fail over within the cluster.

Cluster not in 

secure mode

■ Enter the IP address of the remote cluster, the IP address 

of a cluster system, or the host name of a cluster system.

■ Verify the port number.

■ Enter the user name.

■ Enter the password.

■ Click OK.

■ Repeat these steps for each cluster in the global 

environment.

Cluster in secure 

mode

■ Enter the IP address of the remote cluster, the IP address 

of a cluster system, or the host name of a cluster system.

■ Verify the port number.

■ Choose to connect to the remote cluster with the 

credentials used for the current cluster connection, or 

enter new credentials, including the user name, 

password, and domain.

■ If you connected to the remote cluster earlier through the 

wizard, you can use the credentials from the previous 

connection.

■ Click OK.

■ Repeat these steps for each cluster in the global 

environment.
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Verifying the disaster recovery configuration
At this point, you must bring the global service group online from Cluster 

Explorer.
 

Bringing a global service group online
This is applicable only if you are setting up DR manually in a non-shared storage 

environment.

To bring a remote global service group online from Cluster Explorer

1 In the Service Groups tab of the configuration tree, right-click the service 

group.

or

Click a cluster in the configuration tree, click the Service Groups tab, and 

right-click the service group icon in the view panel.

2 Click Online, and click Remote online.

3 In the Online global group dialog box, specify the following:

■ Click the remote cluster to bring the group online.

■ Click the specific system, or click Any System, to bring the group 

online.

■ Click OK
 

Verifying the disaster recovery configuration
The steps you need to take to verify your DR configuration depend on the type of 

replication you are using.

After the DR wizard has completed, you can confirm the following to verify the 

DR configuration:

■ For VVR replication, confirm that the configuration of disk groups and 

volumes at the DR site have been created by the DR wizard storage cloning.

■ Confirm that the application VCS service group has been created in the DR 

cluster including the same service group name, same resources, and same 

dependency structure as the primary site's application VCS service group.

■ Confirm that the application service group is online at the primary site. The 

application service group should remain offline at the DR site.

■ For VVR replication:

■ Ensure VVR replication configuration. This includes ensuring that the 

RVGs have been created at primary and secondary with the correct 
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volume inclusion, replication mode, Replicator Log configuration, and 

any specified advanced options.

■ Confirm that the replication state matches what was specified during 

configuration. If specified to start immediately, ensure that it is 

started. If specified to start later, ensure that it is stopped.

■ Ensure that the VVR RVG VCS service group is configured on the 

primary and secondary clusters, including the correct dependency to 

the application service group, the specified IP for replication, and the 

correct disk group and RVG objects within the RVG VCS service group.

■ Confirm that the RVG service groups are online at the primary and 

secondary sites.

■ Confirm that the RVG Primary resources are online in the primary 

cluster's application service group. If they are offline, then bring them 

online in the primary site's cluster's application service group. Do not 

bring them online in the secondary site application service group.

■ For array-based replication, verify that the required array resource is 

created in the primary and secondary cluster’s application service group 

and that a dependency is set between the VMDg resource and the array 

resource. 

■ For EMC SRDF replication, verify that the SRDF resource is online in the 

primary cluster’s application service group. If not, bring it online.

■ For Hitachi TrueCopy replication, verify that the HTC resource is online in 

the primary cluster’s application service group. If not, bring it online.

■ For Hitachi TrueCopy replication, you must perform a manual Volume 

Manager rescan on all the secondary nodes after setting up replication and 

other dependent resources, in order to bring the disk groups online. This 

must be performed only once, after which the failover works uninterrupted. 

For more information, see Veritas™ Cluster Server Hardware Replication 

Agent for Hitachi TrueCopy Installation and Configuration Guide.

■ Ensure that the application service groups are configured as global.

■ Check to ensure that the two clusters are communicating and that the status 

of communication between the two clusters has a state of Alive.

■ If you are using VVR for replication and configuring an additional DR site, 

verify the heartbeat and replication configuration between all sites.

■ If you are using VVR for replication and chose to start replication manually 

in the DR wizard, to avoid replicating large amounts of data over the 

network the first time, then you will need to start the process necessary to 

synchronize from checkpoint. This typically consists of 

■ starting a VVR replication checkpoint
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■ performing a block level backup

■ ending the VVR replication checkpoint

■ restoring the block level backup at the DR site

■ starting replication from the VVR replication checkpoint

To learn more about the process of starting replication from a checkpoint, 

refer to the Veritas Volume Replicator Administrator's Guide.

■ Do not attempt a wide area failover until data has been replicated and the 

state is consistent and up to date. The Solutions Configuration Center 

provides a Fire Drill Wizard to test wide area failover for VVR-based 

replication.
 

Establishing secure communication 
within the global cluster (optional)

A global cluster is created in non-secure mode by default. You may continue to 

allow the global cluster to run in non-secure mode or choose to establish secure 

communication between clusters.

The following prerequisites are required for establishing secure communication 

within a global cluster:

■ The clusters within the global cluster must be running in secure mode.

■ You must have Administrator privileges for the domain.

The following information is required for adding secure communication to a 

global cluster:

■ The active host name or IP address of each cluster in the global 

configuration.

■ The user name and password of the administrator for each cluster in the 

configuration.

■ If the local clusters do not point to the same root broker, the host name and 

port address of each root broker.

Adding secure communication involves the following tasks:

■ Taking the ClusterService-Proc (wac) resource in the ClusterService group 

offline on the clusters in the global environment. 

■ Adding the -secure option to the StartProgram attribute on each node.

■ Establishing trust between root brokers if the local clusters do not point to 

the same root broker. 
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■ Bringing the ClusterService-Proc (wac) resource online on the clusters in the 

global cluster.

To take the ClusterService-Proc (wac) resource offline on all clusters

1 From Cluster Monitor, log on to a cluster in the global cluster.

2 In the Service Groups tab of the Cluster Explorer configuration tree, expand 

the ClusterService group and the Process agent. 

3 Right-click the ClusterService-Proc resource, click Offline, and click the 

appropriate system from the menu.

4 Repeat step 1 to step 3 for the additional clusters in the global cluster.

To add the -secure option to the StartProgram resource

1 In the Service Groups tab of the Cluster Explorer configuration tree, 

right-click the ClusterService-Proc resource under the Process type in the 

ClusterService group.

2 Click View, and then Properties view.

3 Click the Edit icon to edit the StartProgram attribute.

4 In the Edit Attribute dialog box, add -secure switch to the path of the 

executable Scalar Value. 

For example:

“C:\Program Files\Veritas\Cluster Server\bin\wac.exe” 

-secure

5 Repeat step 4 for each system in the cluster.

6 Click OK to close the Edit Attribute dialog box.

7 Click the Save and Close Configuration icon in the tool bar.

8 Repeat step 1 to step 7 for each cluster in the global cluster.

To establish trust between root brokers if there is more than one root broker 

◆ Establishing trust between root brokers is only required if the local clusters 

do not point to the same root broker. 

Log on to the root broker for each cluster and set up trust to the other root 

brokers in the global cluster. The complete syntax of the command is:

vssat setuptrust --broker <host:port> --securitylevel 

<low|medium|high> [--hashfile <filename> | --hash <root 

hash in hex>]

For example, to establish trust with a low security level in a global cluster 

comprised of Cluster1 pointing to RB1 and Cluster2 pointing to RB2:

from RB1, type:
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vssat setuptrust --broker RB2:14141 --securitylevel low

from RB2, type:

vssat setuptrust --broker RB1:14141 --securitylevel low

To bring the ClusterService-Proc (wac) resource online on all clusters

1 In the Service Groups tab of the Cluster Explorer configuration tree, expand 

the ClusterService group and the Process agent. 

2 Right-click the ClusterService-Proc resource, click Online, and click the 

appropriate system from the menu.

3 Repeat step 1 and step 2 for the additional clusters in the global cluster.

Adding multiple DR sites (optional)
In a Veritas Volume Replicator replication environment only, you can use the 

DR wizard to add additional secondary DR sites. Veritas Cluster Server supports 

up to four DR sites. In other replication environments, additional DR sites 

require manual configuration.

Run the DR wizard and on the Secondary System selection panel, select the new 

site.

Before you start the wizard on the task of configuring replication and global 

clustering, ensure that the cluster service group is online at the existing primary 

and secondary sites. This enables the wizard to configure GCO not only between 

the selected primary site and the new secondary site but also between the new 

site and the earlier configured secondary site. Otherwise, the wizard displays a 

warning message after the global clustering task.

When configuring the VVR replication settings with the wizard for the 

additional site, fields that must match existing settings are dimmed so that you 

cannot change them. For example, you cannot change the RVG name or RVG 

layout on the Replication Settings panel. Similarly, on the Global Cluster 

Settings panel, GCO has already been configured at the primary site, so the 

primary site fields are dimmed.
 

Possible task after creating the DR environment: 
Adding a new failover node to a VVR environment

The following procedure describes how to add an additional node to the cluster 

at either the primary or secondary site after your disaster recovery environment 

is in operation. The clusters at each site are not required to have the same 

number of nodes or the same failover configuration. 
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Preparing the new node
Install SFW HA on the new system and then add the system to the cluster. 

To install SFW HA and add the system to the cluster

1 Refer to “Installing SFW HA” on page 454 for installation instructions.

2 Start the Veritas Cluster Server Configuration Wizard from the Solutions 

Configuration Center. Click Start > All Programs > Symantec > Veritas 

Cluster Server > Solutions Configuration Center or click the shortcut for 

the Solutions Configuration Center.

From the Solutions Configurations Center expand Disaster Recovery 

Configuration > Configure the cluster at the Secondary site and from the 

display click Configure the cluster to add the new system to the cluster. If 

necessary, refer to the Veritas Cluster Server Administrator’s Guide for 

information on this procedure.

Preparing the existing DR environment
If you plan to add a failover node to the secondary site, you must temporarily 

switch the roles of the Primary and Secondary sites so that the current site 

becomes the Primary. This action reverses the direction of replication. 

To prepare the existing DR environment

1 If you are adding the failover node to the cluster at the primary site, proceed 

directly to step 2. If you are adding a failover node to the secondary site, you 

must switch the roles of the primary and secondary sites. This action 

reverses the direction of replication.

■ In the Service Groups tab of the Cluster Explorer configuration tree, 

right-click the service group that is online at the current primary site.

■ Click Switch To, and click Remote switch.

■ In the Switch global group dialog box, click the cluster at the secondary 

site you want to switch the group to. Then click the specific system 

where you want to bring the global application service group online. 

Click OK.

2 Take the global application service group offline at the current primary site.

3 Take the VVR replication service group offline.

Modifying the replication and application service groups
Add the new failover node to the system lists in the replication and application 

service groups. 
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To add the failover node to the system lists

1 Bring the replication service group online on an existing cluster node of the 

current primary site.

2 Bring the MountV resources of the corresponding application service group 

online on the same node.

3 Use the Modify an existing replication service group option of the Volume 

Replicator Agent Configuration Wizard (Start > All Programs > Symantec > 

Veritas Cluster Server > Configuration Tools > Volume Replicator Agent 

Configuration Wizard) to add a new node to the system list for the 

replication service group. If necessary, refer to the Veritas Storage 

Foundation Veritas Volume Replicator, Administrator’s Guide for 

information on this procedure.

4 Use the Modify service group option of the FileShare and IIS Configuration 

Wizard or Application Configuration Wizard.

Start the appropriate Configuration Wizard from the Solutions 

Configuration Center. For example, for FileShare click Start > All Programs 

> Symantec > Veritas Cluster Server > Solutions Configuration Center High 

Availability (HA) Configuration > Configure the Service Group > FileShare 

Configuration Wizard to add the new node to the system list for the 

respective application service group. Check the check box to bring the 

service group online after the wizard completes. If necessary, refer to the 

Cluster Server Administrator’s Guide for information on this procedure. 

5 After bringing the application service group online, configure all the 

application database stores to automatically mount on start-up. 

Reversing replication direction 
If you added a failover node at the original secondary site and migrated the RVG 

in “Preparing the existing DR environment” on page 530, move the global 

application service group back to the original primary site and reverse the 

direction of replication. These actions switch the Primary and Secondary sites 

back to their original roles.

To reverse the replication direction

1 In the Service Groups tab of the Cluster Explorer configuration tree, 

right-click the service group that is online at the current primary site.

2 Click Switch To, and click Remote switch.

3 In the Switch global group dialog box:

■ Click the cluster to switch the group to.
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■ Click the specific system where you want to bring the global application 

service group online.

■ Click OK.

Maintaining: Normal operations and 
recovery procedures (VVR environment)

This section provides tasks during normal operations of the DR solutions and 

also describes the recovery process.

Normal operations: Monitoring the status of the replication
Under normal operating conditions, you can monitor the status of the 

replication using the following tools:

■ The VEA GUI

■ The Command Line Interface (CLI)

■ Perfmon

■ Alerts

For details, refer to the “Monitoring Replication” chapter in the Veritas Storage 

Foundation Veritas Volume Replicator, Administrator’s Guide.

Performing planned migration
For maintenance purposes, or for testing the readiness of the secondary host, 

you may want to migrate the application to the secondary host. The following 

are a generic set of tasks that you may need to perform:

■ Take the RVG resource offline on both the clusters.

■ Transfer the primary role to the host at the secondary site by using the 

Migrate option.

■ From the VEA screen, right-click the primary RVG and select Migrate.

■ Select the secondary host and click OK. The replication role is migrated 

to the secondary host.

■ Assign drive letters to the volumes on the new primary. 

Make sure that these drive letters are the same as those of the original 

primary.

■ Bring the RVG resource online on the new secondary.

■ Bring the application group online on the new primary.
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You can now verify that the application functions properly on the new primary 

with the replicated data. After verifying its functioning, you can revert the roles 

to what they were originally by repeating the procedure.

Note: Any changes that you make to the data on the new primary will get 

replicated to the original primary, which is now the secondary.

Disaster recovery procedures
This section provides information on bringing up an application server on the 

secondary host, in the event of a disaster. It also explains how to migrate the 

primary role back to the original primary host once it is returned to normal 

functioning after a disaster.

To bring up the application on the secondary host

1 From the left pane in the VEA GUI console on the secondary host, right-click 

the desired secondary RVG node inside the replication network.

2 Select Takeover and follow the instructions to perform the takeover 

operation. You can choose to perform takeover with the following options:

■ Perform Takeover with the fast-failback option to restore the original 

primary easily once it becomes available again. When performing 

Takeover with fast-failback, make sure that you do not select the 

Synchronize Automatically option.

■ Perform Takeover without the fast-failback option. In this case, you 

will need to perform a complete synchronization of the original 

primary with the new primary. This may take quite a while, depending 

on the size of the data volume. Only after the synchronization is 

complete can you migrate the primary role back to the original 

primary. 

After the takeover, the existing secondary becomes the new primary.

3 Assign drive letters to the volumes on the new primary. Make sure that these 

drive letters are the same as those of the original primary.

4 Bring the application group online.

Now you can start using the application on the new primary.

Restoring the primary host

After a disaster, when the original primary becomes available again, you may 

want to revert the role of the primary back to this host. 
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To restore the primary host

1 Take the RVG resource off-line on both the clusters.

2 Depending on whether you performed Takeover with or without the 

fast-failback option, do one of the following:

■ For Takeover with the Fast-failback option:

The original primary, after it has recovered, will be in the Acting as 

secondary state. If the original primary is not in the Acting as 

secondary state, verify whether your network connection has been 

restored.

To synchronize this original primary and the new primary, use the 

Resynchronize Secondaries option from new primary’s context menu. 

■ For Takeover without the Fast-failback option:

After performing a takeover without fast-failback, you must convert 

the original primary to a secondary by using the Make Secondary 

option. 

Before performing the Make Secondary operation, the original 

primary’s RVG and the new primary’s RVG will be shown in separate 

RDS’s. However, after this operation, they will be merged under a 

single RDS.

After the Make Secondary operation, the original primary will be 

converted to a secondary. Right-click on this secondary RVG and select 

Start Replication with the Synchronize Automatically option.

3 After the sychronization is complete, perform a migrate operation to 

transfer the primary role back to the original primary. Right-click on the 

primary RVG and select Migrate from the menu that appears.

4 Make sure that the volumes have retained the same drive letters as they had 

before the disaster. 

5 Bring the RVG resource online on the secondary.

6 Bring the application group online on the original primary.

Recovery procedures for service group 
dependencies

Service group dependencies have special requirements and limitations for 

disaster recovery configuration and for actions to be taken in a disaster recovery 

scenario.

See “Supported disaster recovery configurations for service group 

dependencies” on page 450.
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The procedure and requirements for bringing service group dependencies 

online at the secondary site depends on their configuration: soft, firm, or hard.

In general, if a child or parent remains online at the primary site, you take it 

offline before you bring the child and parent service groups online in the correct 

order on the secondary site.

An exception is the RVG service group, used for VVR replication, which the 

wizard creates with an online, local, hard dependency. The RVG group remains 

online at the primary site in all cases and should be left online at the primary 

site.

The following tables show the recovery requirements if a child or parent service 

group fails at the primary site and is unable to fail over on the primary site, thus 

requiring the secondary site to be brought online.

Using a scenario of a parent and one child, the following table shows the 

expected results and necessary actions you must take for an online, local, soft 

dependency link.

Table 13-7 Online, local, soft dependency link

Failure condition Results Action required

The child service group 

fails

■ The parent remains online on 

the primary site.

■ An alert notification at the 

secondary site occurs for the 

child service group only.

■ The RVG group remains online.

1 Primary site: Manually take the parent 

service group offline at the primary site. 

Leave the RVG group online.

2 Secondary site: Bring the parent and child 

service groups online in the appropriate 

order (child first, then parent).

The parent service 

group fails

■ The child remains online on the 

primary site. 

■ An alert notification at the 

secondary site occurs for the 

parent only.

■ The RVG group remains online.

1 Primary site: Manually take the child 

service group offline at the primary site. 

Leave the RVG group online.

2 Secondary site: Bring the service groups 

online in the appropriate order (child first, 

then parent).
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Using a scenario of a parent and one child, the following table shows the 

expected results and necessary actions you must take for an online, local, firm 

dependency link.

Using a scenario of a parent and one child, the following table shows the 

expected results and necessary actions you must take for an online, local, hard 

dependency link.

 

Table 13-8 Online, local, firm dependency link

Failure condition Results Action required

The child service group 

fails

■ The parent goes offline on the 

primary site.

■ An alert notification at the 

secondary site occurs for the 

child service group only.

■ The RVG group remains online.

Secondary site: Bring the service groups online 

in the appropriate order (child first, then parent).

Leave the RVG group online at the primary site.

The parent service 

group fails

■ The child remains online on the 

primary site. 

■ An alert notification at the 

secondary site occurs for the 

parent only.

■ The RVG group remains online.

1 Primary site: Manually take the child 

service group offline at the primary site. 

Leave the RVG group online.

2 Secondary site: Bring the service groups 

online in the appropriate order (child first, 

then parent).

Table 13-9 Online, local, hard dependency link 

Failure condition Results Action required

The child service group 

fails

■ The parent goes offline on the 

primary site.

■ An alert notification at the 

secondary site occurs for the 

child service group only.

■ The RVG group remains online.

Secondary site: Bring the service groups online 

in the appropriate order (child first, then parent).

Do not take the RVG group offline at the primary 

site.

The parent service 

group fails

■ The child remains online on the 

primary site.

■ An alert notification at the 

secondary site occurs for the 

parent only.

■ The RVG group remains online.

1 Primary site: Manually take the child 

service group offline at the primary site. 

Leave the RVG group online.

2 Secondary site: Bring the service groups 

online in the appropriate order (child first, 

then parent).



Chapter
 14
Testing fault readiness by 

running a fire drill

Topics in this chapter include:

■ About disaster recovery fire drills

■ About the Fire Drill Wizard

■ About post-fire drill scripts

■ Tasks for configuring and running fire drills

■ Prerequisites for a fire drill

■ Preparing the fire drill configuration

■ Running a fire drill

■ Recreating a fire drill configuration that has changed

■ Restoring the fire drill system to a prepared state

■ Deleting the fire drill configuration

About disaster recovery fire drills
A disaster recovery plan should include regular testing of an environment to 

ensure that a DR solution is effective and ready should disaster strike. This 

testing is called a fire drill. 

A fire drill is performed at the secondary site using a special service group for 

fire drills. The fire drill service group uses a copy of the data that is used by the 

application service group.
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About the Fire Drill Wizard
About the Fire Drill Wizard
Veritas Storage Foundation High Availability for Windows (SFW HA) provides a 

Fire Drill Wizard to help you set up and run a fire drill on a disaster recovery 

environment. You launch the Fire Drill Wizard from the Solutions Configuration 

Center.

The Fire Drill Wizard tests the fault readiness of a disaster recovery 

configuration by mimicking a failover from the primary site to the secondary 

site. The wizard does this without stopping the application at the primary site 

and disrupting user access.

The Fire Drill Wizard supports conducting a fire drill for a disaster recovery site 

that uses Veritas Volume Replicator (VVR) or that uses Hitachi TrueCopy or 

EMC SRDF hardware replication. 

Note: After upgrading to 6.0.1 or later, the existing fire drill service groups will 

not be usable. In a Hitachi TrueCopy or EMC SRDF environment, you must 
manually edit the existing fire drill service groups. In a VVR environment, you 

must run the Fire Drill Wizard to re-create them. For more information, see the 

Installation and Upgrade Guide.

About Fire Drill Wizard general operations
The Fire Drill Wizard performs the following operations:

■ Prepares for the fire drill by creating a fire drill service group on the 

secondary site

The fire drill service group is a copy of the application service group. When 

creating the fire drill service group, the wizard uses the application service 

group name, with the suffix _fd. The wizard renames the fire drill service 

group resources with a prefix FDnn and changes attribute values as 

necessary to refer to the FD resources. 

The wizard also supports fire drill service groups created under a different 

naming convention by an earlier version of the wizard.

■ Runs the fire drill by bringing the fire drill service group online on the 

secondary site

This operation demonstrates the ability of the application service group to 

failover and come online at the secondary site should the need arise. 

Fire drill service groups do not interact with outside clients or with other 

instances of resources, so they can safely come online even when the 

application service group is online on the primary site. 
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■ Restores the fire drill configuration, taking the fire drill service group 

offline

After you complete the fire drill, you run the wizard to restore the fire drill 

configuration to a prepared state. Otherwise, the fire drill service group 

remains online. If you run a fire drill on one service group, restore that 

service group before you continue with a fire drill on another service group.

You must also restore the fire drill configuration before you can delete it. 

Warning: If the fire drill service group remains online, it could cause failures 

in your environment. For example, if the application service group were to 

fail over to the node hosting the fire drill service group, there would be 

resource conflicts, resulting in both service groups faulting. Therefore, 

always use the wizard to restore the fire drill configuration to a prepared 

state as soon as possible after completing the fire drill testing for a service 

group. 
See “Restoring the fire drill system to a prepared state” on page 560.

■ Deletes the fire drill configuration

The details of some Fire Drill Wizard operations are different depending on the 

replication environment.

See “About Fire Drill Wizard operations in a VVR environment” on page 539.

See “About Fire Drill Wizard operations in a Hitachi TrueCopy or EMC SRDF 

environment” on page 541.

About Fire Drill Wizard operations in a VVR environment
The general operations of the Fire Drill Wizard are the same in all replication 

environments.

■ Prepares for the fire drill, creating a fire drill service group on the 

secondary site

■ Runs the fire drill, bringing the fire drill service group online on the 

secondary site

■ Restores the fire drill configuration, taking the fire drill service group 

offline

■ Deletes the fire drill configuration

See “About the Fire Drill Wizard” on page 538.

However, the following additional Fire Drill Wizard operations are specific to a 

VVR environment.
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Preparing the fire drill configuration

In a VVR environment, when preparing the fire drill configuration, the wizard 

does the following:

■ Replaces the RVGPrimary resources with VVRSnap resources in the fire drill 

service group

■ Uses the SFW HA VxSnap feature to prepare snapshot mirrors for use 

during the fire drill

While running the wizard, you assign one or more disks for the mirrored 

volumes. Mirror preparation can take some time, so you can exit the wizard 

after this step is started and let the preparation continue in the background.

■ Sets the offline-local-firm dependency between the service groups, where 

the fire drill service group is the parent and the application service group is 

the child

■ Configures the VVRSnap resource by setting the following attributes to the 

appropriate values:

■ RVG

■ AppDiskGroupName

■ DiskGroupName

■ Sets the FireDrill attribute of the following resources to true:

■ IP

■ Lanman

■ RegRep

■ Sets the ForFireDrill attribute of the MountV resource to true in the fire drill 

service group
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Running the fire drill 

The Fire Drill Wizard brings the fire drill service group online. Optionally, you 

can also run the fire drill using the VOM console.

In a VVR environment, when running the fire drill, the VVRSnap agent does the 

following:

■ Detaches the mirrors from the original volumes to create point-in-time 

snapshots of the production data

■ Creates a fire drill disk group on the secondary site with a snapshot of the 

application data to use for testing purposes

Restoring the fire drill configuration

The Fire Drill Wizard takes the fire drill service group offline. Optionally, you 

can also restore the fire drill using the VOM console.

In a VVR environment, restoring the fire drill system to a prepared state, the 

VVRSnap agent does the following:

■ Joins the fire drill disk group to the application service group disk group

■ Snaps back the snapshot mirrors to reattach to the original volumes

Deleting the fire drill configuration

In a VVR environment, when deleting the fire drill configuration, the wizard 

does the following:

■ Sets the FireDrill attribute of the following resources to false:

■ IP

■ Lanman

■ RegRep

■ Unlinks the fire drill service group

■ Deletes the fire drill service group and any associated registry entry

■ Performs the snap abort operation on the snapshot mirrors to free up the 

disk space

About Fire Drill Wizard operations in a Hitachi TrueCopy  
or EMC SRDF environment

The general operations of the Fire Drill Wizard are the same in all replication 

environments.
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■ Prepares for the fire drill, creating a fire drill service group on the 

secondary site

■ Runs the fire drill, bringing the fire drill service group online on the 

secondary site

■ Restores the fire drill configuration, taking the fire drill service group 

offline

■ Deletes the fire drill configuration

See “About the Fire Drill Wizard” on page 538.

However, additional Fire Drill Wizard operations are specific to a Hitachi 

TrueCopy or EMC SRDF replication environment.

In a Hitachi TrueCopy or EMC SRDF replication environment, the wizard 

performs the following additional actions during preparation, running of the 

fire drill, restoring the configuration, and deleting the configuration. You must 

configure the ShadowImage (for Hitachi) or BCV (for SRDF) pairs before running 

the wizard.

Preparing the fire drill configuration

When preparing the fire drill configuration, the wizard does the following:

■ In the fire drill service group, the wizard creates HTCSnap or SRDFSnap 

resources for each HTC and SRDF resource in the application service group. 

The SRDFSnap and HTCSnap resources from the fire drill service group are 

linked to the respective resources configured in the main application service 

group. 

■ The wizard configures the Snap resource. The following Snap resource 

attributes are set to a value of 1:

■ UseSnapshot (take a local snapshot of the target array)

■ RequireSnapshot (require a successful snapshot for the Snap resource 

to come online)

■ MountSnapshot (use the snapshot to bring the fire drill service group 

online

Running the fire drill 

When running the fire drill, the wizard brings the HTCSnap or SRDFSnap agent 

online. The HTCSnap or SRDFSnap agent manage the replication and mirroring 

functionality according to the attribute settings. The Snap agents take a 

consistent snapshot of the replicating data using the mirroring technology 

provided by the array vendor. The Snap agents also import the disk group 

present on the snapshot devices with a different name.
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In more detail, the Snap agent does the following:

■ Suspends replication to get a consistent snapshot

■ For HTCSnap, takes a snapshot of the replicating application data on a 

ShadowImage device

■ For SRDFSnap, takes a snapshot of the replicating application data on a 

BCV device

■ Resumes replication

■ Modifies the disk group name in the snapshot

Restoring the fire drill configuration

When restoring the fire drill configuration to a prepared state, the wizard does 

the following:

■ Takes the fire drill service group offline, thus also taking offline the SRDF 

and HTC Snap agents

This action reattaches the hardware mirrors to the replicating secondary 

devices and resynchronizes them.

Deleting the fire drill configuration

When deleting the fire drill configuration, the wizard does the following:

■ Deletes the fire drill service group

■ Deletes any associated registry entry 

If you want to remove the hardware mirrors, you must do so manually.

For more information about the Hitachi TrueCopy Snap agent functions, see 

Veritas Cluster Server Hardware Replication Agent for Hitachi TrueCopy, 

Configuration Guide.

For more information about the EMC SRDF Snap agent functions, see Veritas 

Cluster Server Hardware Replication Agent for EMC SRDF, Configuration Guide. 

About post-fire drill scripts
You can specify a script for the Fire Drill Wizard to run on the secondary site at 

the end of the fire drill.

For the wizard to run the script, the script must exist on the secondary system 

that you are specifying for the fire drill. 
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Note: The wizard does not support using script commands to launch a user 

interface window. In such a case, the process is created but the UI window does 

not display.

Optionally, you can specify to run a Windows PowerShell cmdlet by creating a 

.bat file.

To run a cmdlet, create a .bat file with the following entry:

%windir%\system32\WindowsPowerShell\v1.0\PowerShell.exe -command 
“$ScriptName”

Where

$ScriptName = <fully qualified .ps1 script> OR <cmdlet entered by 
user>

For example:

D:\WINDOWS\system32\WindowsPowerShell\v1.0\PowerShell.exe -command 
C:\myTest.ps1

Specify the name of the .bat file as the script to run.

Tasks for configuring and running fire drills
While running the Fire Drill Wizard, the following sequence of actions are 

available:

■ Prepare the fire drill configuration

■ Run the fire drill or delete the configuration

■ Restore the fire drill configuration after running a fire drill

■ Run another fire drill or delete the configuration

In addition, you have the option to recreate a fire drill configuration that has 

changed.

After an action is complete, the next action becomes available in the wizard. You 

can select the next action or exit the wizard and perform the next action later.

Table 14-1 gives more details of the process of configuring and running fire 

drills with the wizard.

Table 14-1 Process for configuring and running fire drills

Action Description

Verify the hardware and 

software prerequisites

Before running the wizard, review the prerequisites 

and make sure that they are met.

See “Prerequisites for a fire drill” on page 546.
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Prepare the fire drill 

configuration

Use the wizard to configure the fire drill.

See “Preparing the fire drill configuration” on 

page 549.

Recreate a fire drill 

configuration that has 

changed

If a fire drill configuration exists for the selected 

service group, the wizard checks for differences 

between the fire drill service group and the application 

service group. If differences are found, the wizard can 

recreate the fire drill configuration before running the 

fire drill. 

See “Recreating a fire drill configuration that has 

changed” on page 557.

Run the fire drill Use the wizard to run the fire drill. Running the fire 

drill brings the fire drill service group online. 

Optionally you can specify a script to be run once the 

fire drill is complete.

See “Running a fire drill” on page 555.

Perform your own tests of the application to confirm 

that it is operational

Note: After completing the fire drill testing, run the 

wizard again as soon as possible to restore the 

configuration. Otherwise the fire drill service groups 

remain online. It is recommended that you restore a 

fire drill service group to a prepared state before 

running a fire drill on another service group.

Restore the fire drill 

configuration to a prepared 

state

Use the wizard to restore the fire drill system to a state 

of readiness for future fire drills or to prepare for 

removal of the fire drill configuration

This is a required action after running the fire drill.

See “Restoring the fire drill system to a prepared state” 

on page 560.

This operation takes the fire drill service group offline 

and reattaches snapshot mirrors.

Table 14-1 Process for configuring and running fire drills

Action Description
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Prerequisites for a fire drill
Before running the Fire Drill Wizard make sure that you meet the following 

general requirements:

■ You can run the Fire Drill Wizard from any node in the domain of the cluster, 

as long as the SFW HA client is installed on that node.

■ If the cluster is secured, the login you use to run the Fire Drill Wizard must 

have the appropriate permissions to make changes in the cluster.

■ If a firewall exists between the wizard and any systems it needs access to, 

the firewall must be set to allow both ingoing and outgoing TCP requests on 

port 7419.

■ For an application service group using IPv4 addresses, for each IP address in 

the service group, an IP address must be available to use on the secondary 

site for the fire drill service group.

To configure IPv6 settings, the wizard must be launched from a system on 

which the IPv6 stack is installed.

The wizard can accept input for one IP address and Lanman resource. If the 

application service group has multiple IP addresses and Lanman resources, 

the wizard notifies you to edit the fire drill service group resources to 

supply these values. Information on editing service group resources is 

covered in the VCS administration guide.

Delete the fire drill 

configuration

If a fire drill service group is no longer needed, or if you 

want to free up resources, use the wizard to remove the 

fire drill configuration 

See “Deleting the fire drill configuration” on page 561.

The wizard deletes the service group on the secondary 

site. In a VVR environment, the wizard performs a 

snap abort to delete the snapshot mirrors created on 

the secondary site for use in the fire drill. In hardware 

replication environments, you can delete these 

manually.

If a fire drill has been run, the wizard ensures that you 

first restore the fire drill configuration to a prepared 

state before this option becomes available. This 

ensures that mirrors are reattached and the fire drill 

service group is offline before the configuration is 

deleted.

Table 14-1 Process for configuring and running fire drills

Action Description
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See Veritas Cluster Server Administrator’s Guide.

For IPv6, the IP address will be autogenerated.

■ If you want the fire drill wizard to run a script that you supply, ensure that 

the script file is available on any secondary site nodes where you plan to run 

the fire drill. 

Additional requirements apply to specific replication environments.

See “Prerequisites for a fire drill in a VVR environment” on page 547.

See “Prerequisites for a fire drill in a Hitachi TrueCopy environment” on 

page 548.

See “Prerequisites for a fire drill in an EMC SRDF environment” on page 548.

Prerequisites for a fire drill in a VVR environment
Before you run the Fire Drill Wizard make sure that you meet both the general 

requirements and the specific requirements for your replication environment.

General requirements are covered separately.

See “Prerequisites for a fire drill” on page 546.

Make sure that the following additional prerequisites are met before configuring 

and running a fire drill in a VVR environment:

■ The primary and secondary sites must be fully configured with VVR 

replication and the global cluster option.

■ The Veritas FlashSnap option must be installed on all nodes of the 

secondary site cluster.

■ The secondary system where you plan to run the fire drill must have access 

to the replicated volumes.

■ On the secondary site, empty disks must be available with enough disk space 

to create snapshot mirrors of the volumes. Snapshot mirrors take up the 

same amount of space as the original volumes. In addition, two disk change 

object (DCO) volumes are created for each snapshot mirror, one for the 

source volume and one for the snapshot volume. The two DCO volumes 

must be on different disks. Allow 2 MB additional space for each DCO 

volume.

The empty disks must be in the same disk group that contains the RVG. If 

the disk group does not have empty disks available, you must use the VEA to 

add the disks to the disk group before you run the wizard. The secondary 

system must have access to the disks or LUNs.

■ All disk groups in the service group must be configured for replication. The 

Fire Drill wizard does not support a VVR configuration in which disk groups 
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are excluded from replication. However, you can exclude individual volumes 

within a disk group from replication.

Prerequisites for a fire drill in a Hitachi TrueCopy environment
Before you run the Fire Drill Wizard make sure that you meet both the general 

requirements and the specific requirements for your replication environment.

General requirements are covered separately.

See “Prerequisites for a fire drill” on page 546.

Make sure that the following prerequisites are met before configuring and 

running a fire drill in a Hitachi TrueCopy environment:

■ The primary and secondary sites must be fully configured with Hitachi 

TrueCopy replication and the global cluster option. The configuration must 

follow the applicable instructions in the Veritas Storage Foundation High 

Availability for Windows documentation for configuring disaster recovery 

with Hitachi TrueCopy.

■ The secondary system where you plan to run the fire drill must have access 

to the replicated volumes.

■ Make sure that Hitachi RAID Manager/Command Control Interface (CCI) is 

installed.

■ ShadowImage for TrueCopy must be installed and configured for each LUN 

on the secondary site target array. ShadowImage pairs must be created to 

allow for mirroring at the secondary site.

■ The name of the ShadowImage device group must be the same as the 

replicated device group for both replicated and non-replicated LUNs that are 

to be snapshot. The instance number should be different.

■ Make sure the HORCM instance managing the S-VOLs runs continuously; 

the agent does not start this instance.

Prerequisites for a fire drill in an EMC SRDF environment
Before you run the Fire Drill Wizard make sure that you meet both the general 

requirements and the specific requirements for your replication environment.

General requirements are covered separately.

See “Prerequisites for a fire drill” on page 546. 

Make sure that the following prerequisites are met before configuring and 

running a fire drill in an EMC SRDF environment:

■ The primary and secondary sites must be fully configured with EMC SRDF 

replication and the global cluster option. The configuration must follow the 
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applicable instructions in the Veritas Storage Foundation High Availability 

for Windows documentation for configuring disaster recovery with EMC 

SRDF.

■ The secondary system where you plan to run the fire drill must have access 

to the replicated volumes.

■ The infrastructure to take snapshots at the secondary site must be properly 

configured between the secondary site source and target arrays. This 

process involves associating Symmetric Business Continuance Volumes 

(BCVs) and synchronizing them with the secondary site source.

■ If you plan to run a fire drill on SRDF/A devices, you must have a 

TimeFinder/CG license. Make sure TimeFinder for SRDF is installed and 

configured at the target array.

■ To take snapshots of R2 devices, BCVs must be associated with the RDF2 

device group and fully established with the devices.

■ To take snapshots of non-replicated devices, create a EMC Symmetrix device 

group with the same name as the SFW disk group. The device group must 

contain the same devices as in the disk group and have the corresponding 

BCVs associated. 

Preparing the fire drill configuration
Preparing the fire drill configuration creates a fire drill service group. You 

specify the application service group and the secondary system to use. Only one 

service group can be prepared for a fire drill at one time. 

For a VVR environment, the preparation step also prepares snapshot mirrors of 

production data at the specified node on the secondary site. 

Note: Preparing the snapshot mirrors takes some time to complete. 

Before you prepare the fire drill configuration with the Fire Drill Wizard, make 

sure that you meet the prerequisites.

See “Prerequisites for a fire drill” on page 546.

To prepare the fire drill configuration

1 Open the Solutions Configuration Center (Start > All Programs > Symantec 

> Veritas Cluster Server > Solutions Configuration Center).

2 Start the Fire Drill Wizard (expand Solutions for Additional Applications, 

expand Fire Drill, expand Configure or run a fire drill, and click Fire Drill 

Wizard).
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3 In the Welcome panel, review the information and click Next.

4 In the System Selection panel, specify a system in the primary site cluster 

and click Next.

See “System Selection panel details” on page 551.

5 In the Service Group Selection panel, select the service group that you want 

to use for the fire drill and click Next. 

See “Service Group Selection panel details” on page 552.

6 In the Secondary System Selection panel, select the cluster and the system 

to be used for the fire drill at the secondary site, and then click Next.

See “Secondary System Selection panel details” on page 552.

7 If the Fire Drill Prerequisites panel is displayed, review the information and 

ensure that all prerequisites are met. Click Next.

See “Prerequisites for a fire drill” on page 546.

Otherwise, if a fire drill service group already exists on this system for the 

specified service group, one of the following panels is displayed:

8 If the Fire Drill Service Group Settings panel is displayed, assign the virtual 

IP address and virtual name (Lanman name) to be used for the fire drill 

service group that will be created on the secondary site. 

See “Fire Drill Service Group Settings panel details” on page 552.

If the Run Fire Drill option or 

Delete Fire Drill options are 

shown, a fire drill service 

group has already been 

prepared.

You can run the fire drill with no further preparation. 

Click Run Fire Drill and follow the procedure for 

running a fire drill.

See “Running a fire drill” on page 555.

If the Fire Drill Restoration 

panel is displayed, the fire 

drill service group remains 

online from a previous fire 

drill.

Follow the procedure for restoring the fire drill 

configuration to a prepared state. This must be done 

before running a new fire drill.

See “Restoring the fire drill system to a prepared 

state” on page 560.

If the Recreate Fire Drill 

Service Group panel is 

displayed, a fire drill service 

group has already been 

prepared but is not up to 

date.

You can choose to recreate the fire drill configuration 

to bring it up to date.

See “Recreating a fire drill configuration that has 

changed” on page 557.

Or you can clear the check box to recreate the 

configuration and run the fire drill on the existing 

configuration.
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9 The wizard selects the appropriate panel to display next, depending on the 

replication method. Fill in any required information on the panel that is 

displayed.

Click Next.

10 In the Fire Drill Preparation panel, the wizard shows the status of the 

preparation tasks. 

See “Fire Drill Preparation panel details” on page 555.

When preparation is complete, click Next. 

11 The Summary panel displays the message that preparation is complete. 

To run the fire drill now, click Next. Continue with the procedure to run the 

fire drill.

See “Running a fire drill” on page 555.

To run the fire drill later, click Finish. The fire drill preparation remains in 

place.

System Selection panel details
Use the System Selection panel of the wizard to specify a system in the primary 

site cluster.

All systems containing online global service groups are available to select. The 

default system is the node where you launched the wizard (localhost) if a global 

service group is online on that system. When selecting a system you can specify 

either a fully qualified host name or IP address.

VVR replication Disk Selection panel

See “Disk Selection panel details” on page 552.

Hitachi TrueCopy 

replication

Horcm Files Path Selection panel

See “Hitachi TrueCopy Path Information panel details” on 

page 553.

HTCSnap Resource Configuration panel

See “HTCSnap Resource Configuration panel details” on 

page 554.

EMC SRDF 

replication

SRDFSnap Resource Configuration panel

See “SRDFSnap Resource Configuration panel details” on 

page 554.
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Service Group Selection panel details
Use the Service Group Selection panel of the wizard to select the service group 

that you want to use for the fire drill. You can select only one service group at a 

time for a fire drill.

Secondary System Selection panel details
Use the Secondary System Selection panel of the wizard to select the cluster and 

the system to be used for the fire drill at the secondary site.

The selected system must have access to the replicated data.

The system must have access to disks for the snapshots that will be created for 

the fire drill. 

Fire Drill Service Group Settings panel details
Use the Fire Drill Service Group Settings panel of the wizard to assign the 

virtual IP address and virtual name (Lanman name) to be used for the fire drill 

service group that will be created on the secondary site. These must be an 

address and name not currently in use.

For IPv4, you must manually assign the IP address. For IPv6, the IP address will 

be autogenerated and display in the Virtual IP address field.

If the service group contains more than one IP and Lanman resource, this panel 

does not display. After the fire drill service group is created, the wizard notifies 

you to manually update the IP and Lanman resources in the fire drill service 

group. 

Disk Selection panel details
During fire drill preparation in a VVR replication environment, you must ensure 

that information is available to the wizard for creating the fire drill snapshots. 
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Use the Disk Selection panel of the wizard to review the information on disks 

and volumes and make the selections for the fire drill snapshots, as follows:

Hitachi TrueCopy Path Information panel details
During fire drill preparation in a Hitachi TrueCopy replication environment, the 

Hitachi TrueCopy Path Information panel is displayed. 

The wizard populates the path field with the customary default location:

C:\Windows

where C is the system drive.

Volume Select the volumes for the fire drill snapshots. By default all 

volumes associated with the service group are selected. If you 

deselect a volume that might result in the fire drill service group 

failing to come online, the wizard displays a warning message.

Note: The Disk Selection panel also appears if the wizard is 

recreating a fire drill service group to which volumes have been 

added. In that case, only the new volumes are shown for selection.

Disk Group Shows the name of the disk group that contains the original 

volumes. This field is display only.

Fire Drill DG Shows the name of the fire drill disk group that running the fire 

drill will create on the secondary system to contain the snapshots. 

This field is display only. For the fire drill disk group name, the 

wizard prefixes the original disk group name with FDnn.

Disk Click the plus icon to the right of the Disk column and specify the 

disk to be used for the snapshot volume. Repeat for each row that 

contains a selected volume.

If the production volumes reside on disks in the same disk group, 

you can store multiple snapshot volumes on a single disk. If the 

volumes in a disk group are configured on multiple RVG resources, 

provide a separate disk for each RVG.

Note: The Fire Drill Wizard does not allow creating mirrors of 

multiple RVGs from a single disk group on the same disk. You must 

select a different disk for each RVG in a disk group.

If there is not enough disk space, you can use the Veritas Enterprise 

Administrator to add disks to the disk group. Then click the Refresh 

button in the wizard.

Mount Details Shows the mount details for the snapshot volumes on the secondary 

system, which match the mounts for the production volumes. This 

field is display only.
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If the horcm configuration files are in a different location, edit the field to 

specify that location.

HTCSnap Resource Configuration panel details
During fire drill preparation in a Hitachi TrueCopy replication environment, the 

wizard discovers the HTC resources and non-replicating SFW disk groups in the 

application service group

This information is used to configure the HTCSnap resources.

The wizard lists each HTCSnap resource that will be configured. You can clear 

the HTCSnap resource name check box if you do not want to include its 

dependent disk groups in the fire drill.

You must specify the ShadowImage instance. 

The HTCSnap Resource Configuration panel shows the following:

More information about HTCSnap resource configuration and operation is 

available.

See “About Fire Drill Wizard operations in a Hitachi TrueCopy or EMC SRDF 

environment” on page 541.

SRDFSnap Resource Configuration panel details
During fire drill preparation in an EMC SRDF replication environment, the 

wizard validates whether at least one BCV device is attached to every device 

(RDF2) of the SRDF device group. If not, the wizard displays an informational 

message on this panel. The panel shows as the Target Resource Name the name 

of the resource that is managing the LUNs that you want to snapshot. For data 

being replicated from the primary site, the Target Resource Name is the name of 

the SRDF resource. For data that is not replicated, the Target Resource Name is 

the name of the disk group resource.

Target Resource Name The panel shows the HTC resource name in the case of a 

Replication Device Group or the disk group resource name 

in the case of a non-replicating disk group.

ShadowImage Instance ID For every HTC resource, specify the ID of the ShadowImage 

instance associated with the replicating secondary devices. 

Refresh If you click the Refresh button, the wizard rediscovers and 

validates the HTC configuration.
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The wizard lists each SRDFSnap resource that will be configured. You can clear 

the SRDFSnap resource name check box if you do not want to include its 

dependent disk groups in the fire drill.

More information about SRDFSnap resource configuration and operation is 

available.

See “About Fire Drill Wizard operations in a Hitachi TrueCopy or EMC SRDF 

environment” on page 541.

Fire Drill Preparation panel details
After you enter the information required to prepare a fire drill configuration, 

the Fire Drill Preparation panel is displayed. You wait while the wizard 

completes the preparation tasks. 

The fire drill service group is created on the secondary site (but remains offline). 

In addition, for a VVR replication environment, the snapshot mirrors for the 

volumes are prepared; this can take some time. You may want to minimize the 

wizard while the task runs in the background. You can also track the mirror 

preparation progress in the VEA. When done, the wizard displays a message 

that the fire drill preparation is complete. If the wizard is completing the 

preparation steps as part of recreating a fire drill configuration, snapshot 

mirrors are prepared only for new volumes.

See “Recreating a fire drill configuration that has changed” on page 557.

Running a fire drill
After you complete the initial fire drill preparation step using the Fire Drill 

Wizard, you can run the fire drill immediately without exiting the wizard or run 

the wizard later to run the fire drill. 

Running the fire drill does the following:

■ Creates the snapshots

■ Enables the firedrill resources

■ Brings the fire drill service group online

■ Optionally, executes a specified command to run a script

See “About post-fire drill scripts” on page 543.

For details on the operations that occur when running a fire drill, see the 

following topics:

■ “About Fire Drill Wizard operations in a VVR environment” on page 539
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■ “About Fire Drill Wizard operations in a Hitachi TrueCopy or EMC SRDF 

environment” on page 541

Warning: After running the fire drill, the fire drill service group remains online. 

After you verify the fire drill results, run the wizard again to restore the system 

to the prepared state. Otherwise, if the fire drill service group remains online, it 

could cause failures in your environment. For example, if the application service 

group were to fail over to the node hosting the fire drill service group, there 

would be resource conflicts, resulting in both service groups faulting. 
See “Restoring the fire drill system to a prepared state” on page 560.

To run a fire drill

1 If you completed the initial preparation and have not exited the wizard, or if 

you are returning to this procedure after recreating a fire drill service 

group, go to step 8. Otherwise, if you need to restart the wizard, continue 

with the next step.

2 From the Solutions Configuration Center, start the Fire Drill Wizard (expand 

Solutions for Additional Applications, expand Fire Drill, expand Configure 

or run a fire drill, and click Fire Drill Wizard).

3 In the Welcome panel, click Next.

4 In the System Selection panel, specify a system in the primary site cluster 

and click Next.

5 In the Service Group Selection panel, select the service group and click Next.

6 In the Secondary System Selection panel, specify the system previously 

prepared for the fire drill at the secondary site and click Next.

If the fire drill configuration is in a prepared state, the wizard compares the 

resources of the fire drill service group with the resources of the application 

service group. 

7 If the application service group changed since the fire drill configuration 

was prepared, the wizard displays the Recreate Fire Drill Service Group 

panel, showing the differences. Choose one of the following:

■ Leave the option checked to recreate the configuration before running 

the fire drill and click Next. You complete additional steps in the wizard 

before running the fire drill.

For more information, see “Recreating a fire drill configuration that 

has changed” on page 557.

■ To run the fire drill on the existing configuration, clear the option to 

recreate the fire drill service group and click Next.
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8 In the Fire Drill Mode Selection panel, click Run Fire Drill and click Next.

9 In the Post Fire Drill Script panel, optionally specify the full path to a script 

for the wizard to run on the secondary system right after running the fire 

drill. The script must already exist on the secondary system. Click Next. 

See “About post-fire drill scripts” on page 543.

10 In the Fire Drill Implementation screen, wait until all fire drill tasks are 

performed and click Next. The Summary panel displays the message that 

the fire drill is complete. You can leave the wizard running while you verify 

the results or exit the wizard. To exit the wizard, click Finish.

11 Run your own tests to verify the fire drill results.

Warning: You should always restore the fire drill system to a prepared state 

immediately after completing fire drill testing on a service group.

12 Restore the fire drill configuration to the prepared state. 

See “Restoring the fire drill system to a prepared state” on page 560.

Recreating a fire drill configuration that has 
changed

When you run the Fire Drill wizard, a fire drill service group may already exist 

for the selected application service group. However, the application service 

group may have changed since the fire drill service group was created. The 

wizard compares the resource names of the two service groups. If differences 

are found, the wizard lists them on the Recreate Fire Drill Service Group panel.

The wizard also checks the RVGs configured for disk groups. If a single RVG is 

configured per disk, the wizard allows you to re-create the service group; the 

existing snapshots are retained. If multiple RVGs are configured on a disk, the 

wizard only allows you to delete the service group; the existing snapshots are 

deleted. To create a corresponding new one, you need to launch the wizard again 

and perform the fire drill preparation steps.
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Note: The wizard does not check for changes in volume attributes, such as the 

MountPath attribute. For example, if you have a MountV resource with an 

attribute that points to drive Y and you change that attribute to point to drive X, 

the wizard does not identify this change and does not give the option to recreate 

the fire drill service group. 
You can choose whether to manually edit the fire drill service group for such 

changes and then run the fire drill, ignore the differences, or delete the 

configuration and start over.

You have the following choices from the Recreate Fire Drill Service Group panel:

■ Leave the option checked to recreate the fire drill service group. Proceed 

with using the wizard to recreate the configuration to match the application 

service group. The wizard deletes the existing fire drill configuration first, 

before creating the new one.

For a VVR replication environment, the wizard handles existing volumes as 

follows: It does not delete the mirrors for volumes that still exist. When it 

recreates the fire drill configuration, it prepares new mirrors only for new 

volumes. If volumes have been removed, the wizard displays an additional 

option to snap abort the obsolete snapshot volumes to free up disk space.

■ Clear the option to recreate the fire drill service group. You can then proceed 

with using the wizard to do either of the following:

■ Run the fire drill, ignoring the differences.

■ Delete the entire fire drill configuration. Then start over with 

preparing the fire drill configuration.

The following procedure describes the choice of recreating the fire drill 

configuration.

To recreate the fire drill configuration if the service group has changed

1 In the Recreate Fire Drill Service Group panel, leave the option checked to 

recreate the configuration before running the fire drill. 

For a VVR replication environment, if volumes have been removed, 

optionally select to snap abort the volumes. 

Click Next. 

2 In the Fire Drill Mode Selection panel, Delete Fire Drill Configuration is 

selected. Click Next, and click Yes to confirm the deletion.

3 The Fire Drill Deletion panel shows the progress of the deletion. 

For a VVR replication environment, the wizard leaves the existing fire drill 

snapshot volumes so that those snapshot mirrors do not have to be 

prepared again. If volumes were removed and you selected the option to 

snap abort, the wizard snap aborts the snapshots of those volumes. 
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Warning: If you close the wizard after deleting the fire drill configuration 

without continuing on to the fire drill preparation step, the information of 

the existing snapshot volumes is lost. 

When all tasks are complete, click Next. 

4 In the Fire Drill Prerequisites panel, review the information and ensure that 

all prerequisites are met. Click Next.

See “Prerequisites for a fire drill” on page 546.

5 The wizard selects the appropriate panel to display next, depending on the 

replication method. Fill in any required information on the panel that is 

displayed.

Click Next.

6 The Fire Drill Preparation panel is displayed. Wait while the wizard 

recreates the fire drill service group.

For VVR replication environments, wait while the wizard starts mirror 

preparation. 

Mirror creation can take some time. You may want to minimize the wizard 

while the task runs in the background. You can also close the wizard and 

track the mirror preparation progress in the VEA. 

7 Once preparation is complete, click Next. The Summary page is displayed. 

To continue with running the fire drill, click Next.

VVR replication If volumes have been added, the Disk Selection panel is 

displayed. Specify the information for the added volumes. 

If there is not enough disk space, you can use the Veritas 

Enterprise Administrator to add disks to the disk group. Then 

click the Refresh button in the wizard.

See “Disk Selection panel details” on page 552.

Hitachi TrueCopy 

replication

Horcm Files Path Selection panel

See “Hitachi TrueCopy Path Information panel details” on 

page 553.

HTCSnap Resource Configuration panel

See “HTCSnap Resource Configuration panel details” on 

page 554.

EMC SRDF 

replication

SRDFSnap Resource Configuration panel

See “SRDFSnap Resource Configuration panel details” on 

page 554.
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Restoring the fire drill system to a prepared state
See “Running a fire drill” on page 555.

Restoring the fire drill system to a prepared state
After running a fire drill and verifying the results, use the Fire Drill Wizard as 

soon as possible to restore the fire drill system at the secondary site to a 

prepared state. A prepared state is the initial fire drill configuration created by 

the wizard, in which the fire drill service group has been prepared but is offline.

Restoring the fire drill system to a prepared state is required for any of the 

following:

■ Making the secondary system available for failover of the application 

service group at the primary site.

■ Running another fire drill.

■ Deleting the fire drill configuration after a fire drill has been run.

For details on the operations that occur when restoring a fire drill configuration, 

see the following topics:

■ “About Fire Drill Wizard operations in a VVR environment” on page 539

■ “About Fire Drill Wizard operations in a Hitachi TrueCopy or EMC SRDF 

environment” on page 541

To restore the fire drill system to a prepared state

1 If you completed running a fire drill and have not exited the wizard, go to 

step 8. Otherwise, continue with the next step.

2 From the Solutions Configuration Center, start the Fire Drill Wizard (expand 

Solutions for Additional Applications, expand Fire Drill, expand Configure 

or run a fire drill, and click Fire Drill Wizard).

3 In the Welcome panel, click Next.

4 In the System Selection panel, specify a system in the primary site cluster 

and click Next.

The default system is the node where you launched the wizard. 

5 In the Service Group Selection panel, select the service group that was used 

for the fire drill and click Next.

6 In the Secondary System Selection panel, specify the system on which the 

fire drill was run at the secondary site.

7 In the Fire Drill Restoration Information panel, review the requirements for 

restoration and click Next.
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8 In the Fire Drill Restoration screen, wait until the screen shows the 

restoration tasks are completed and click Next.

9 In the Summary screen, click Next if you want to delete the fire drill 

configuration. Otherwise click Finish to exit the wizard, leaving the fire drill 

configuration in a prepared state.

Deleting the fire drill configuration
If you no longer need a fire drill configuration you can delete it. 

Deleting a fire drill configuration deletes the fire drill service group on the 

secondary site.

In a VVR replication environment, deleting a fire drill configuration also 

performs a snap abort of the snapshot mirrors created on the secondary site for 

use in the fire drill. It frees up the disk space used for the snapshot mirrors for 

other use. 

In a Hitachi TrueCopy or EMC SRDF environment, you could manually remove 

mirrors after the deletion is complete.

To delete a fire drill configuration

1 If you have just used the wizard to prepare or restore a fire drill 

configuration and have not exited the wizard, go to step 10. Otherwise 

continue with the next step.

2 From the Solutions Configuration Center, start the Fire Drill Wizard (expand 

Solutions for Additional Applications, expand Fire Drill, expand Configure 

or run a fire drill, and click Fire Drill Wizard).

3 In the Welcome panel, click Next.

4 In the System Selection panel, specify a system in the primary site cluster 

and click Next.

The default system is the node where you launched the wizard. 

5 In the Service Group Selection panel, select the service group that was used 

for the fire drill and click Next.

6 In the Secondary System Selection panel, specify the system on which the 

fire drill was run at the secondary site.

7 If the wizard detects that the fire drill service group is different from the 

application service group, it displays the Recreate Fire Drill Service Group 

panel. Clear the option to recreate the fire drill service group and click Next.
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8 If the wizard detects that the fire drill service group is still online, the Fire 

Drill Restoration panel is displayed. Review the requirements for restoration 

and click Next.

9 In the Restore Fire Drill screen, wait until the screen shows the restoration 

tasks are completed. Then click Next.

10 In the Fire Drill Mode Selection panel, click Delete Fire Drill Configuration 

and click Next, and click Yes to confirm the deletion.

11 The Fire Drill Deletion panel shows the progress of the deletion. Wait until 

all tasks are complete and then click Next. 

If errors occur while deleting the fire drill configuration, the wizard will list 

any incomplete steps so that you can complete them manually. 

12 The Summary panel is displayed. Click Finish.

Considerations for switching over fire drill service 
groups

In a VVR environment, if you directly switch the fire drill service group from 

one node to another, the VVRSnap resource fails to come online on the target 

node. The fire drill service group depends on the RVG service group. To make 

the switch successfully, you must first switch the RVG service group to the 

intended node and then switch the fire drill service group.
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Chapter 
15
Deploying SFW with 

Microsoft failover 

clustering 

This chapter covers the following topics:

■ “Tasks for deploying SFW with Microsoft failover clustering” on page 566

■ “Reviewing the requirements” on page 567

■ “Reviewing the configuration” on page 570

■ “Configuring the storage hardware and network” on page 571

■ “Establishing a failover cluster” on page 572

■ “Installing SFW” on page 574

■ “Creating SFW disk groups and volumes” on page 584

■ “Creating a group for the application in the failover cluster” on page 591

■ “Installing the application on cluster nodes” on page 593

■ “Completing the setup of the application group in the failover cluster” on 

page 594

■ “Implementing a dynamic quorum resource” on page 595

■ “Verifying the cluster configuration” on page 598
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Tasks for deploying SFW with Microsoft failover clustering
Tasks for deploying SFW with Microsoft 
failover clustering 

This chapter describes how to install and configure Storage Foundation for 

Windows with Microsoft failover clustering in a new installation, using a two-

node active/passive cluster configuration as an example. 

The example describes a generic database application in order to present 

general recommendations that apply to multiple applications. For specific 

examples of an SFW-Microsoft failover cluster solution, see the following:

■ Veritas Storage Foundation and High Availability Solutions Microsoft 

Clustering Solutions Guide for Microsoft SQL

Table  outlines the high-level objectives for implementing the configuration and 

the tasks for each objective: 

Task list for deploying SFW with Microsoft failover clustering 

Objectives Tasks

“Reviewing the requirements” on 

page 567

■ Verify hardware and software 

prerequisites.

■ Review the configuration requirements.

“Reviewing the configuration” on 

page 570

■ Understanding the configuration for the 

failover cluster

“Configuring the storage hardware and 

network” on page 571

■ Install the operating system on both 

nodes.

■ Make necessary networking settings on 

both nodes.

“Establishing a failover cluster” on 

page 572

■ Refer to Microsoft documentation for 

instructions on establishing a cluster 

under Microsoft failover clustering.

“Installing SFW” on page 574 ■ Install SFW

■ Install Cluster Option for Microsoft 

Cluster Service (MSCS) 

“Creating SFW disk groups and 

volumes” on page 584

■ In SFW on Node A, create at least two 

dynamic cluster disk groups on the 

storage—one or more for the application 

data files and one for the mirrored 

quorum. 

■ The disk group for the quorum can be 

created later, if desired.
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Reviewing the requirements
Verify that the following requirements for your configuration are met before 

starting the Storage Foundation for Windows installation:

“Creating a group for the application 

in the failover cluster” on page 591

■ Create a group within the failover cluster 

for the application.

■ Include the cluster disk group or groups 

for the application as Volume Manager 

Disk Group type resources in the group.

“Installing the application on cluster 

nodes” on page 593

■ Install the application program files on 

the local drive of the first node.

■ Install files relating to the data and logs 

on the shared storage.

■ Move the cluster resources to the second 

node.

■ Make sure that the volumes on the second 

node have the same drive letters or mount 

points that they had on the first node.

■ Install the application on the second node.

“Completing the setup of the 

application group in the failover 

cluster” on page 594

■ Refer to the application documentation 

for help on creating its resource.

■ Establish the appropriate dependencies.

■ Test the application group by moving the 

cluster resources to the other node.

“Implementing a dynamic quorum 

resource” on page 595

■ Create a dynamic disk group for the 

quorum with a mirrored volume if this 

task was not done earlier.

■ Make that disk group a Volume Manager 

Disk Group type resource in the default 

Cluster Group.

■ Configure the quorum resource.

“Verifying the cluster configuration” 

on page 598

■ Move the cluster resources to the second 

node. Move them back to the first node.

■ Optionally, simulate a failure by turning 

off the power to the server that has 

control of the cluster resources.

Task list for deploying SFW with Microsoft failover clustering (Continued)

Objectives Tasks
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Reviewing the requirements
■ “Supported software for Microsoft failover clustering with SFW” on 

page 568

■ “Disk space requirements” on page 569

■ “System requirements” on page 569

Supported software for Microsoft failover clustering with SFW
Review the SFW HA Hardware Compatibility List to confirm supported 

hardware:

http://www.symantec.com/docs/TECH152806

Review the SFW HA Software Compatibility List to confirm supported software:

http://www.symantec.com/docs/TECH201485

The following software is supported for deploying SFW and Microsoft 

clustering:

■ Veritas Storage Foundation for Windows (SFW)

Include the following option during installation:

■ Cluster Option for Microsoft Failover Cluster

For a DR configuration with Veritas Volume Replicator, include the 

following option:

■ Veritas Volume Replicator option

The following table shows supported Windows Server operating systems for 

SFW server software.

Note: SFW software for servers supports Hyper-V and parent partitions. 

 

Table 15-1 Supported Windows Server operating systems 

Windows Server Platform Edition Version

Windows Server 2012 (Full/

Core)

x64 Standard, Datacenter

http://www.symantec.com/docs/TECH152806
http://www.symantec.com/docs/TECH201485
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Disk space requirements
The following table summarizes disk space requirements for SFW.

 

System requirements

■ The configuration described requires shared disks to support applications 

that migrate between nodes in the cluster. 

■ SCSI or Fibre Channel host bus adapters (HBAs) can be used to access shared 

storage.

■ Microsoft clustering requires at least two network adapters per system (one 

NIC to connect each system to the public network, and one NIC for the 

private network on each system). Symantec recommends having two 

adapters for the private network and routing each private network adapter 

through a separate hub or switch to avoid single points of failure.

■ Each system requires 1 GB of RAM for SFW.

■ Systems to be clustered must be configured as part of a Windows Server 

2012 domain. Each system in an Microsoft failover cluster must be in the 

same domain and must be using the same operating system version.

■ To install and work with the SFW and Microsoft clustering software, you 

must have an account with Administrator privileges. You must also have a 

license key to install SFW.

■ Using static IP addresses for the public network and private network cards is 

highly recommended. DHCP is not supported for VVR. Six network interface 

cards, three for each server (two each for the private network and one for the 

public network) are required. You also need a static IP address for the cluster 

itself.

Note: To determine the approved hardware for SFW, see the Hardware 

Compatibility List on the Symantec Support website: 
http://www.symantec.com/docs/TECH152806

Table 15-2 Disk space requirements

Installation options Required disk space

SFW + all options 1124 MB

Client components 632 MB

http://www.symantec.com/docs/TECH152806
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Reviewing the configuration
The example of a new installation with two servers and one storage array in an 

active/passive configuration is a typical configuration for a cluster. In an active/

passive configuration the active node of the cluster hosts the virtual server and 

the second node is a dedicated redundant server able to take over and host the 

virtual server in the event of a failure on the active node. The example describes 

a generic database application.

Figure 15-1 Storage Foundation configuration with Microsoft failover clustering 

and two servers

This configuration does not include DMP. For information about DMP and 

clustering, see “Adding DMP to a clustering configuration” on page 173.

Key points about the configuration:

■ A Microsoft failover cluster must be running before you install SFW. 

Therefore, you need to set up the hardware and install the operating system 

on both systems and establish the failover cluster before installing SFW. 

Installing SFW requires a reboot, but a reboot on the active cluster node 

causes it to fail over. Use a “rolling install” procedure to install SFW first on 

the inactive cluster node, then move the active cluster resources to the 

other node, and install on the now inactive node.

■ SFW enables you to create a dynamic mirrored quorum. The quorum 

resource maintains the cluster database and critical recovery information in 

a recovery log.

Microsoft clustering only supports a basic physical disk and does not enable 

you to mirror the quorum resource. One advantage of SFW is that it 
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provides a dynamic mirrored quorum resource for Microsoft clustering. If a 

quorum disk fails, a mirror on another disk (another plex) takes over and 

the resource remains online. For this configuration, Symantec recommends 

creating a three-way mirror for the quorum to provide additional fault 

tolerance. If possible, do not use the disks assigned to the quorum for any 

other purpose.

Configuring the storage hardware and network
Use the following procedures to configure the hardware and verify DNS 

settings. Repeat this procedure for every node in the cluster.

To configure the hardware

1 Install the required network adapters, and SCSI controllers or Fibre Channel 

HBA.

2 Connect the network adapters on each system.

To prevent lost heartbeats on the private networks, and to prevent the 

Microsoft cluster from mistakenly declaring a system down, Symantec 

recommends disabling the Ethernet autonegotiation options on the private 

network adapters. Contact the NIC manufacturer for details on this process.

3 Use independent hubs or switches for the private heartbeats. You can use 

cross-over Ethernet cables for two-node clusters.

4 Verify that each system can access the storage devices. Verify that each 

system recognizes the attached shared disk and that the attached shared 

disks are visible.

To verify the DNS settings and binding order for all systems

1 Open the Control Panel (Start > Control Panel).

2 Click Network and Internet, and then click Network and Sharing Center.

3 In the Network and Sharing Center window, on the left side of the screen 

under Tasks, double-click Manage network connections.

4 Ensure the public network adapter is the first bound adapter:

■ From the Advanced menu in the Network Connections window, click 

Advanced Settings.

■ In the Adapters and Bindings tab, verify the public adapter is the first 

adapter in the Connections list. If necessary, use the arrow button to 

move the adapter to the top of the list.

■ Click OK.
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5 Open the Public status dialog box by doing one of the following in the 

Network Connections window:

■ Double-click the adapter for the public network.

■ Right-click the adapter for the public network and click Status.

■ Select the adapter for the public network and click View status of this 

connection in the toolbar.

When enabling DNS name resolution, make sure that you use the public 

network adapters, and not those configured for the private network.

6 In the Public Status dialog box, on the General tab, click Properties.

7 In the Public Properties dialog box, on the General tab:

■ Select the Internet Protocol Version 4 (TCP/IPv4) check box.

■ Click Properties.

8 Select the Use the following DNS server addresses option.

9 Verify the correct value for the IP address of the DNS server.

10 Click Advanced.

11 In the DNS tab, make sure the Register this connection’s address in DNS 

check box is selected.

12 Make sure the correct domain suffix is entered in the DNS suffix for this 

connection field.

To find the domain suffix, click Start > Control Panel > System. The domain 

suffix is listed in the “Computer Name, domain, and workgroup settings” 

section.

13 Close the window.
 

Establishing a failover cluster
Before installing SFW, you must first verify that Microsoft failover clustering is 

enabled (if a new installation of Windows Server 2012), and then establish a 

Microsoft failover cluster. This section summarizes the tasks; refer to Microsoft 

documentation for complete details.

To enable Microsoft failover clustering

1 In Server Manager, select Features in the left pane (tree view) and then click 

Add Features (link on the right side of the screen).

2 In the Add Features Wizard, check the Failover Clustering option, and click 

Next.

3 Click Install.
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4 When the installation is complete, click Close.

To establish a Microsoft failover cluster 

1 Ensure that you have met the hardware prerequisites for a failover cluster. 

You can run the Microsoft wizard to validate the configuration. See the 

Microsoft documentation for details.

2 Configure the shared storage and create a volume with drive letter “Q” for 

the cluster quorum disk. Use of other drive letters may result in the quorum 

recognition problems. You must have a basic disk reserved for this purpose 

on your shared storage.

Microsoft recommends a minimum of 500 MB for the quorum disk; refer to 

Microsoft documentation for specific requirements.

3 Create the first node of the cluster using Failover Cluster Management 

(Start > Administrative Tools > Failover Cluster Management).

4 In the action pane, click Create a Cluster. The Create Cluster Wizard will 

start.

If this is the first time this wizard has been run, the Before You Begin page 

will appear. Review the information that is displayed and then click Next. 

You can hide this page on subsequent uses of the wizard; if this has been 

done, the first page might be the Select Servers page.

5 In the Select Servers panel, type the name of the first node in the Enter 

server name field and click Add. You can also use the Browse button to 

browse the Active Directory for the computers you want to add.

Repeat this step for the second node.

6 After both nodes have been added to the list of Selected Servers, click Next.

7 Based on the information on the validation warning screen, assess your 

hardware configuration, and select one of the options. Symantec 

recommends that you select Yes, which starts the Validate a Configuration 

wizard. Follow the wizard instructions.

8 In the Access Point for Administering the Cluster screen, in the Cluster 

Name field, type the name for the failover cluster. This is the name that you 

use to connect to and administer the cluster.

9 In the Address field of the network area, type the appropriate IP address and 

then click Next.

10 In the Confirmation screen, verify that the cluster configuration is correct, 

and then click Next to create the cluster.

11 Review the Summary page and then click Finish to close the wizard.
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Note: Setting up the cluster creates physical disk resources for all the basic disks 

on the shared bus. To use these disks when you create your SFW cluster disk 

groups, you must first remove the physical disk resources from the cluster. 

Otherwise, a reservation conflict occurs. After creating the SFW cluster disk 

groups, you will add Volume Manager Disk Group resources to the cluster, 

instead of physical disk resources.

 

Installing SFW
This section assumes you are running a Microsoft failover cluster and you are 

installing SFW on an inactive system that does not own any cluster resources.

Symantec recommends a rolling installation to install SFW. For a rolling 

installation, you must first install SFW on an inactive system. Our example uses 

a two node configuration, so the inactive system is the second node. After SFW 

is installed on an inactive system, move the resource groups to this system, and 

make the other systems inactive. Then install SFW on the other inactive 

systems in the Microsoft failover cluster simultaneously.

SFW installation tasks
Installing SFW involves the following:

■ Performing pre-installation tasks 

See “Pre-installation tasks” on page 574.

■ Installing the product 

See “Post-installation tasks” on page 583.

■ Performing post-installation tasks

See “Post-installation tasks” on page 583.

Pre-installation tasks
Perform the following pre-installation tasks:

■ Moving the online groups 

See “Moving the online groups” on page 574.

Moving the online groups

If your resource groups are on the system where you are installing SFW, you 

must move the resource groups from the SFW system to another system in the 

cluster.
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To move the online groups

1 Open Failover Cluster Management (Start > Administrative Tools > Failover 

Cluster Management).

2 In the left pane, under Services and Applications, right-click a resource 

group and then click Move this service or application to another node > 

Move to node [name of node].

If there is more than one resource group, you must repeat this step until all 

the resource groups are moved.

3 In the Failover Cluster Management console, center panel, verify that the 

Current Owner name has changed for all of the resource groups that were 

moved. This confirms that the resource groups have moved to another 

system.

4 If you need to move the resource groups back to the original system, repeat 

Step 2.

Installing SFW server components using the product installer
Use the following procedure to install the SFW server components using the 

product installer. If you choose to install the server components, the client 

components are installed by default.

Note: Ensure that there are no parallel installations, live updates, or Microsoft 

Windows updates in progress and the Windows MPIO feature is enabled before 

you proceed with SFW installation.

To install SFW server components using the product installer

1 Insert the disc containing the installation software into your system’s disk 

drive or download the installation software from the Symantec website.

https://fileconnect.symantec.com

2 Allow the autorun feature to start the installation or double-click Setup.exe. 

The CD browser appears.

Note: If you are installing the software using the product software disc, the 

CD browser displays the installation options for all the products specified 

earlier. However, if you are downloading the installation package from the 

Symantec website, the CD browser displays the installation options only for 

the product to be installed.

2008-04-30|
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3 Click to download the required contents.

4 On the Welcome panel, review the list of prerequisites and click Next.

5 On the License panel, read the license terms, select I accept the terms of 

License Agreement, and then click Next.

6 On the System Selection panel, select the systems and the desired 

Installation and Product options.

You can select the systems in one of the following ways:

■ In the System Name or IP text box, manually type the system name or 

its IP address and click Add.

Note: The wizard does not support the internet protocol version 6. To 

add the systems having internet protocol version 6, you must type the 

system name.

The local host is populated by default.

■ Alternatively, browse to select the systems.

The systems that belong to the domain in which you have logged in are 

listed in the Available Systems list. Select one or more systems and 

click the right arrow to move them to the Selected Systems list. Click 

OK.

Storage Foundation for 

Windows

Click to install the server components for Storage 

Foundation for Windows.

Late Breaking News Click to access the latest information about updates, 

patches, and software issues regarding this release.

Windows Data Collector Click to verify that your configuration meets all 

pertinent software and hardware requirements.

SORT Click to access the Symantec Operations Readiness 

Tools site.

In addition to the product download you can also 

download the custom reports about your computer 

and Symantec enterprise products, a checklist 

providing configuration recommendations, and 

system and patch requirements to install or upgrade 

your software.

Browse Content Click to view the software disc contents.

Technical Support Click to contact Symantec Technical Support. 
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Once you add or select a system, the wizard performs certain validation 

checks and notes the details in the Verification Details box. To review the 

details, select the desired system.

To select the installation and product options, perform the following tasks 

on each of the selected systems.

Note: To apply the selection to multiple systems, select the system for 

which you have selected the installation and product options and then click 

Apply to multiple systems.  
See Applying the selected installation and product options to multiple 

systems.

■ By default the wizard uses %ProgramFiles%\Veritas as the installation 

directory. To customize the installation directory, click Browse and 

select the desired location. Click OK.

Note: The installation directory is selected by default on the systems 

where the product is being upgraded.

■ Select the required license type from the License key drop-down list.

Note: The default license type is “Keyless”.

If you select the “Keyless” license type, all the available product options 

are displayed and are selected by default.

If you select “User entered license key” as your license type, the License 

Details panel appears by default. On the License Details panel, enter the 

license key and then click Add. You can add multiple licenses for the 

various product options you want to use.

The wizard validates the entered license keys and displays the relevant 

error if the validation fails. After the validation is complete, click Ok.
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■ From the list of features, select the appropriate product options to be 

installed. The options differ depending on your product and 

environment. The following product options are available for SFW:

Storage Foundation 

Options

■ Veritas Volume Replicator (VVR)

Veritas Volume Replicator (VVR) replicates data 

across multiple sites for disaster recovery.

■ FlashSnap

FlashSnap allows you to create and maintain split-

mirror, persistent snapshots of volumes and 

application components. FlashSnap supports VSS 

based snapshots to provide application data in a 

consistent state after the application is restored.

■ Cluster Option for Microsoft Failover Cluster

Provides support for Microsoft Failover Cluster; you 

can select this option even if Microsoft clustering is 

not currently configured. If you choose to select this 

option even if Microsoft clustering is not currently 

configured, you must manually register the VMDg 

and RVG resource while configuring the service 

groups and resources.

■ Replace Disk Management Snap-in with SFW VEA 

GUI

Replaces the Disk Management Snap-in in the 

Windows Computer Management console and the 

Server Manager console with the Veritas Enterprise 

Administrator GUI for Windows Server 2012.
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7 On the System Selection panel, click Next. 

Note that the wizard fails to proceed with the installation, unless all the 

selected systems have passed the validation checks and are ready for 

installation. In case the validation checks have failed on any of the systems, 

review the details and rectify the issue. Before you choose to proceed with 

the installation select the system and click Re-verify to re-initiate the 

validation checks for this system.

8 On the Pre-install Summary panel, review the summary and click Next. 

Note that the Automatically reboot systems after installer completes 

operation check box is selected by default. This will reboot all the selected 

remote systems immediately after the installation is complete on the 

respective system. If you do not want the wizard to initiate this auto reboot, 

DMP Device Specific 

Modules

■ 3PARDATA array (V3PAR)

■ Dell Compellent array (VCOMPLNT)

■ Dell EqualLogic array (VEQLOGIC)

■ EMC cx4240 array (VEMCCLAR)

■ EMC VMAX array (VEMCSYMM)

■ Hitachi VSP array (VHDSAA)

■ HP P6000 array (VHPEVA)

■ IBM DS8000 array (VIBMAADS)

■ IBM XiV Storage System (VXIV)

Symantec maintains a Hardware Compatibility List (HCL), 

which provides information on HBAs and firmware that 

have been tested with each supported array. Check the HCL 

for details about your hardware before installing or using 

DMP DSMs.

The HCL is located at:

http://www.symantec.com/docs/TECH152806

Note: Do not use a DMP DSM together with a third-party 

DSM for the same array. Only one DSM at a time can claim 

the LUNs in an array. According to Microsoft Multipath I/O 

(MPIO) documentation, if multiple DSMs are installed, the 

Microsoft MPIO framework contacts each DSM to 

determine which is appropriate to handle a device. There is 

no particular order in which the MPIO framework contacts 

the DSMs. The first DSM to claim the ownership of the 

device is associated with that device. Other DSMs cannot 

claim an already claimed device. Therefore, to ensure that 

the DMP DSM claims the LUNs of an array, no other DSM 

should be installed for that same array.

http://www.symantec.com/docs/TECH152806
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clear the selection of Automatically reboot systems after installer 

completes operation check box. 

9 On the Installation panel, review the progress of installation and click Next 

after the installation is complete.

If an installation is not successful on any of the systems, the status screen 

shows a failed installation.

10 On the Post-install Summary panel, review the installation result and click 

Next.

If the installation has failed on any of the system, refer to the log file for 

details. You may have to re-install the software.

11 On the Finish panel, click Finish.

If you chose to initiate the auto reboot, a confirmation message to reboot 

the local system appears. Click Yes to reboot immediately or No to reboot 

later.

In case you had not selected to initiate the auto reboot, ensure that you 

manually reboot these systems.

This completes the product installation. 

Note: If you have installed SFW with Microsoft Failover Cluster but if Microsoft 

Failover Cluster is not yet configured in your environment, you must register 

the Volume Manager Disk Group resource after configuring the Microsoft 

clustering software. See “Registering the Volume Manager Disk Group 

resource”. 

Applying the selected installation and product options to 
multiple systems

The following procedure gives details on applying options to multiple systems.

To apply the selected installation and product options to multiple systems

1 Click on any one of the selected system and select the desired installation 

and product options.

2 Click Apply to multiple systems.

3 On the Apply Installation Options panel, select the installation options to be 

applied and then select the desired systems. Click Ok.
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Note: The installation directory is selected by default on the systems where 

the product is being upgraded. The selected Install Directory option does 

not apply to these systems.

Registering the Volume Manager Disk Group resource

You must perform this task only if you have installed SFWwith Microsoft 

Failover Cluster option but Microsoft Failover Cluster is not yet configured in 

your environment.

If you have installed SFW with Microsoft Failover Cluster option but if Microsoft 

Failover Cluster is not yet configured in your environment you must register the 

Volume Manager Disk Group resource, after configuring the Microsoft 

clustering software.

To register the Volume Manager Disk Group resource

1 Navigate to

c:\windows\cluster folder

2 From the command prompt run the following command.

cluster RESTYPE "Volume Manager Disk Group" /CREATE /
DLL:vxres.dll/TYPE:"Volume Manager Disk Group"

Installing the SFW client components using the product installer
Use the following procedure to install SFW client components using the product 

installer.

Note: Client components cannot be installed on server core systems.

Ensure that there are no parallel installations, live updates, or Microsoft 

Windows updates in progress.

To install the SFW client components using the client installer

1 Insert the software disk containing the installation package into your 

system's disc drive or download the installation package from the following 

Symantec Web site.

https://fileconnect.symantec.com

2 Allow the autorun feature to start the installation or double-click Setup.exe.

The CD browser appears.
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3 Click to download the required contents.

4 On the Welcome panel, review the list of prerequisites and click Next.

5 On the License Agreement panel, read the license terms, select I accept the 

terms of License Agreement, and then click Next.

6 On the System Selection panel, select the systems and the installation 

directory.

You can select the systems in one of the following ways:

■ In the System Name or IP text box, manually type the system name or 

its IP address and click Add.

Note: The wizard does not support the internet protocol version 6. To 

add the systems having internet protocol version 6, you must type the 

system name.

Local host is populated by default.

■ Alternatively, browse to select the systems.

The systems that belong to the domain in which you have logged in are 

listed in the Available Systems list. Select one or more systems and 

click the right arrow to move them to the Selected Systems list. Click 

OK.

Veritas Storage 

Foundation for Windows

Click to install the server or client components for 

SFW.

Late Breaking News Click to access the latest information about updates, 

patches, and software issues regarding this release.

Windows Data Collector Click to verify that your configuration meets all 

pertinent software and hardware requirements.

SORT Click to access the Symantec Operations Readiness 

Tools site.

In addition to the product download you can also 

download the custom reports about your computer 

and Symantec enterprise products, a checklist 

providing configuration recommendations, and 

system and patch requirements to install or upgrade 

your software.

Browse Content Click to view the software disc contents.

Technical Support Click to contact Symantec Technical Support. 
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Once you add or select a system, the wizard performs certain validation 

checks and notes the details in the Verification Details box. To review the 

details, select the desired system.

By default the wizard uses %ProgramFiles%\Veritas as the installation 

directory. To customize the installation directory, click Browse and select 

the desired location. Click OK.

To apply the customized directory to multiple systems, click Apply to 

multiple systems. On the Apply Installation Options panel, select the 

systems to apply the customized directory. Click OK.

Note: The installation directory is selected by default on the systems where 

the product is being upgraded. The Install Directory option does not apply 

to these systems.

7 On the System Selection panel, click Next.

Note that the wizard fails to proceed with the installation, unless all the 

selected systems have passed the validation checks and are ready for 

installation. If the validation checks have failed on any of the systems, 

review the details and rectify the issue. Before you choose to proceed with 

the installation select the system and click Re-verify to re-initiate the 

validation checks for this system.

8 On the Pre-install Summary panel, review the summary and click Next.

9 On the Installation panel, review the progress of installation and click Next 

after the installation is complete.

If an installation is not successful on any of the systems, the status screen 

shows a failed installation.

10 On the Post-install Summary panel, review the installation result and click 

Next.

If the installation has failed on any of the systems, refer to the log file for 

details. You may have to re-install the software.

11 On the Finish panel, click Finish.

This completes the installation of the client components.

Post-installation tasks
You must perform the following post-installation tasks:

■ Moving the online groups 

See “Moving the online groups” on page 584.

■ Completing the SFW installation 

See “Completing the SFW installation” on page 584.
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Moving the online groups

You can move the resource groups from the current system, back to the previous 

system where SFW is installed.

To move the online groups

1 Open the Failover Cluster Management tool. (Start > Administrative Tools > 

Failover Cluster Management). 

2 In the left pane, under Services and Applications, right-click the resource 

group and then click Move this service or application to another node > 

Move to node [name of original node].

If there is more than one resource group, you must repeat this step until all 

the resource groups are moved back to the original node.

3 In the Failover Cluster Management console, center panel, verify that the 

Current Owner name has changed for all of the resource groups that were 

moved. This confirms that all the resource groups have moved back to the 

original system.

Completing the SFW installation

You must repeat the SFW installation tasks for the other systems in the 

Microsoft failover cluster.

See “SFW installation tasks” on page 574.
 

Creating SFW disk groups and volumes
Use Veritas Storage Foundation for Windows to create disk groups and dynamic 

volumes for the application on the shared storage. A dynamic disk group is a 

collection of one or more disks that behave as a single storage repository. 

Within each disk group, you can have dynamic volumes with different volume 

layouts. Configuring disk groups and volumes involves the following tasks:

■ Planning disk groups and volumes

■ Creating dynamic cluster disk groups

■ Creating dynamic volumes

Planning disk groups and volumes
Decide how you want to organize the disk groups and the number and type of 

volumes you want to create. 

Before creating a disk group, consider:



585Deploying SFW with Microsoft failover clustering

Creating SFW disk groups and volumes
■ The type of volume configurations that are required.

■ The number of LUNs required for the disk group.

■ The implications of backup and restore operations on the disk group setup.

■ The size of databases and logs which depend on the traffic load.

■ The number of disk groups that are needed

The number of disk groups depends on your application and the planned 

organization of the data. The application program files need to be installed 

on the local drive of the server. Data files and other related files, such as 

logs, are placed on the shared storage. Typically, a main organizational unit 

in your application, such as the storage group in Microsoft SQL Server, is 

contained in a single disk group. 

You will also need to create a disk group with three disks and a mirrored 

volume for the quorum resource. If possible, use small disks. Microsoft 

recommends 500 MB for the quorum disk. See “Implementing a dynamic 

quorum resource” on page 595.

Recommendations: 

■ Use mirrored volumes for logs.

■ Use striped or mirrored striped volumes for data.

The following illustration shows a typical setup of shared storage disks for a 

clustered database application and a dynamic mirrored quorum resource. The 

log volume is on a separate disk. The log and data volumes are in the application 

dynamic cluster disk group. The dynamic mirrored quorum is in a separate disk 

group and has a minimum of two disks, but three are recommended for added 

fault tolerance. 
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Figure 15-2 Microsoft failover clustered database with disks for data, the log, 

and the quorum resource

Creating dynamic cluster disk groups
Follow the steps in this section to create one or more disk groups for your 

application.

Create a cluster disk group and volumes on only one node of a cluster. The 

volumes can be accessed by other nodes in the cluster by first deporting the 

cluster disk group from the current node and then importing it on the desired 

node.

Note: Setting up the cluster creates physical disk resources for all the basic disks 

on the shared bus. To use those disks for the SFW cluster disk groups, you must 

remove the physical disk resources from the cluster. Otherwise, a reservation 

conflict occurs.
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Note: Dynamic disks belonging to a Microsoft Disk Management Disk Group do 

not support cluster disk groups.

To create a dynamic disk group

1 Open the VEA console by clicking Start > All Programs > Symantec > Veritas 

Storage Foundation > Veritas Enterprise Administrator (or launch the VEA 

from the Solutions Configuration Center) and select a profile if prompted.

2 Click Connect to a Host or Domain.

3 In the Connect dialog box, select the host name from the pull-down menu 

and click Connect.

To connect to the local system, select localhost. Provide the user name, 

password, and domain if prompted.

4 To start the New Dynamic Disk Group wizard, expand the tree view under 

the host node, right click the Disk Groups icon, and select New Dynamic Disk 

Group from the context menu.

5 In the Welcome screen of the New Dynamic Disk Group wizard, click Next.

6 Provide information about the cluster disk group:

■ Enter the disk group name (for example, DG1).

■ Check the Create cluster group check box if you wish to create cluster 

dynamic disk groups that are used in a shared storage environment.
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■ Select the appropriate disks in the Available disks list, and use the Add 

button to move them to the Selected disks list.

Optionally, check the Disk names prefix checkbox and enter a disk 

name prefix to give the disks in the disk group a specific identifier.

For example, entering TestGroup as the prefix for a disk group that 

contains three disks creates TestGroup1, TestGroup2, and TestGroup3 

as internal names for the disks in the disk group.

Note: For Windows Server operating systems, Windows Disk Management 

Compatible Dynamic Disk Group creates a type of disk group that is created 

by Windows Disk Management (LDM).

■ Click Next.

7 Click Next to accept the confirmation screen with the selected disks.

8 Click Finish to create the dynamic disk group.
 

Creating dynamic volumes
Once the disk groups are created, make the disks within them usable by creating 

the dynamic volumes that will store data.

To create dynamic volumes

1 If the VEA console is not already open, click Start > All Programs > 

Symantec > Veritas Storage Foundation > Veritas Enterprise Administrator 

and select a profile if prompted.

2 Click Connect to a Host or Domain.

3 In the Connect dialog box select the host name from the pull-down menu 

and click Connect.

To connect to the local system, select localhost. Provide the user name, 

password, and domain if prompted.

4 To start the New Volume wizard, expand the tree view under the host node 

to display all the disk groups. Right click a disk group and select New 

Volume from the context menu.

You can right-click the disk group you have just created.

5 At the New Volume wizard opening screen, click Next.

6 Select the disks for the volume.

■ Make sure the appropriate disk group name appears in the Group name 

drop-down list.
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■ For Site Preference, leave the setting as Siteless (the default).

■ Automatic disk selection is the default setting. To manually select the 

disks, click Manually select disks and use the Add and Remove buttons 

to move the appropriate disks to the Selected disks list. Manual 

selection of disks is recommended.

■ You may also check Disable Track Alignment to disable track alignment 

for the volume. Disabling Track Alignment means that the volume does 

not store blocks of data in alignment with the boundaries of the 

physical track of the disk.

■ Click Next.

7 Specify the volume attributes.

■ Enter a volume name. The name is limited to 18 ASCII characters and 

cannot contain spaces or forward or backward slashes.

■ Select a volume layout type. To select mirrored striped, click both the 

Mirrored checkbox and the Striped radio button.

■ If you are creating a striped volume, the Columns and Stripe unit size 

boxes need to have entries. Defaults are provided.

■ Provide a size for the volume.

■ If you click on the Max Size button, a size appears in the Size box that 

represents the maximum possible volume size for that layout in the 

dynamic disk group.

■ In the Mirror Info area, select the appropriate mirroring options. 

■ Click Next.
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8 In the Add Drive Letter and Path dialog box, assign a drive letter or mount 

point to the volume. You must use the same drive letter or mount point on 

all systems in the cluster. Make sure to verify the availability of the drive 

letter before assigning it. 

■ To assign a drive letter, select Assign a Drive Letter, and choose a drive 

letter.

■ To mount the volume as a folder, select Mount as an empty NTFS 

folder, and click Browse to locate an empty folder on the disk.

9 Click Next.
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10 Create an NTFS file system.

■ Make sure the Format this volume checkbox is checked and click NTFS.

■ Select an allocation size or accept the Default.

■ The file system label is optional. SFW makes the volume name the file 

system label.

■ Select Perform a quick format if you want to save time.

■ Select Enable file and folder compression to save disk space. Note that 

compression consumes system resources and performs encryption and 

decryption, which may result in reduced system performance.

■ Click Next.

11 Click Finish to create the new volume.

12 Repeat these steps to create additional volumes.

Create the cluster disk group and volumes on the first node of the cluster 

only.
 

Creating a group for the application in the failover 
cluster

After you create SFW disk groups and volumes for the application, use the 

Failover Cluster Management tool to set up a cluster group for the application. 
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You then add Volume Manager Disk Group resources for the SFW disk groups 

that you created for the application.

After the application is installed on both nodes and its accompanying files are 

placed on the shared storage, you will do additional steps to complete the setup 

of the application group. 

See “Completing the setup of the application group in the failover cluster” on 

page 594.

To set up the application cluster group

1 Launch Failover Cluster Management by selecting Start > Administrative 

Tools > Failover Cluster Management. Connect to the appropriate cluster 

through the console.

2 Create a new group by selecting the Services and Applications node from 

the tree that is displayed in the left hand pane. Right-click and select More 

Actions > Create Empty Service or Application. An empty group named New 

service or application is created.

3 Specify a name for the group by right-clicking it and selecting Rename from 

the drop down menu .

4 Type the name of the new group (for example, App_Grp) in the Name field. 

You can now add Volume Manager Disk Group resources to the application 

group.

To create a Volume Manager Disk Group resource for the application

1 If Failover Cluster Management is already open, then proceed to Step 2.

To launch Failover Cluster Management, select it from Start > 

Administrative Tools > Failover Cluster Management. 

2 In the left pane of Failover Cluster Management, right-click the application 

cluster group (for example, App_Grp) and select Add a resource > More 

resources > Add Volume Manager Disk Group.

3 In the center panel under Disk Drives, double-click New Volume Manager 

Disk Group to open its Properties dialog box.

4 On the General tab of the Properties dialog box, type a name for the 

resource.

For example, type APP_DG_RES.

5 On the Properties tab, in the Disk Group Name field, type the name of the 

disk group you previously created for the application (for example, DG1), 

and click OK to close the dialog box.

6 Right-click the newly named resource and select Bring this resource online.
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7 If you created more than one disk group for the application, repeat this 

procedure to add another Volume Manager Disk Group resource for another 

disk group.
 

Installing the application on cluster nodes
Install the application program files on the same local drive on all the cluster 

nodes. Install the application data and log files or other files related to the 

application data on the shared storage. 

Pointers for installing the application on the first node

■ Applications may have built-in procedures for running on a cluster. Consult 

the application documentation to determine whether these procedures are 

available.

■ Some applications install on both nodes at once.

■ All nodes of the clustered application need to share the same virtual name 

and IP address. 

■ Do not accept the default locations for the application data and log files. 

Instead, set the paths for these files to the drive letters or mount points of 

the volumes created in “Creating dynamic volumes” on page 588.

Pointers for installing the application on the second node

■ In Failover Cluster Management, move the cluster resources to the second 

node.

■ Verify that the volumes on shared storage can be accessed from the second 

node using the same drive letters or mount points that were assigned when 

they were created on the first node. 

■ If you are installing a database, you may need to stop the database service on 

the first node while the shared disks are being manipulated by the 

installation on the second node. You then restart the service after the 

application is installed. 

To add or change a drive letter or mount point

1 In VEA, right-click on the volume for which the drive letter will be added or 

changed.

2 Select File System and click Change Drive Letter and Path. The Drive Letter 

and Paths window appears. You can choose from the following:
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■ To add a drive letter, click Add. The Assign a drive letter drop-down list 

becomes available. Assign a drive letter and click OK.

■ To change a drive letter, click Modify. The Assign a drive letter drop-

down list becomes available. Change the drive letter and click OK.

■ To add a mount point, click Add, click the Mount as an empty NTFS 

folder radio button, browse to select an empty folder or click the New 

Folder button to create a new folder, and click OK to mount the volume.

■ To change a mount point, you must remove it and then select the Add 

option to add it back. To remove it, select it in the Drive Letter and 

Paths window and click Remove.

Completing the setup of the application group in the 
failover cluster

The additional steps in this section make the application group functional in the 

failover cluster. The application resource needs to be added, as well as any other 

resources that are associated with the application. Also, dependencies need to be 

established for the resources. The following list presents a high-level summary 

of the process for completing the application group setup. 

■ Before creating the application resource, make sure that all the other 

application resources, including the Volume Manager Disk Group resource 

and any additional application resources, are online.

■ Refer to the application documentation for information on creating its 

resource and additional resources that may be required, such as the IP 

address resource. 

When creating the application resource, add the Volume Manager Disk 

Group resource as a resource dependency. 

■ The following dependency chart indicates the dependencies that are 

established.
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Figure 15-3 Application group dependencies

■ Testing: After the application group is set up, test it by moving the cluster 

resources to another node and then move them back.

Implementing a dynamic quorum resource
Although Symantec recommends implementing a dynamic quorum resource in 

order to take full advantage of the Storage Foundation functionality, it is not a 

required task. To implement a dynamic quorum resource, complete the 

following tasks:

■ “Creating a dynamic cluster disk group and a mirrored volume for the 

quorum resource” on page 596

■ “Creating the quorum resource for the cluster group” on page 596

■ “Changing the quorum resource to a dynamic mirrored quorum resource” 

on page 597

Note: If you are using DMP, you must create a dynamic quorum resource in 

order for the groups to fail over properly.

Other Resources

Application Resource

Application Group 

(App_Grp)

Additional Resources required 

by the application

“Volume Manager Disk 

Group” Resource
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Note: If you are planning to create a dynamic mirrored quorum for your Volume 

Manager Disk (VMDG) resource, then make your ClusSvc resource dependent on 

the VxBridge service. Refer to Microsoft documentation for details on creating 

resource dependencies. This dependency is required only in cases when you will 

reboot all the cluster nodes at the same time 

Creating a dynamic cluster disk group and a mirrored volume  
for the quorum resource

If you have not already completed this step, use SFW to create a cluster disk 

group for the quorum disks. Symantec recommends using three small disks for 

the mirrored quorum volume; you need a minimum of two disks. Microsoft 

recommends 500 MB for the quorum disk.

To create a three-way mirrored volume in the New Volume wizard, select the 

Concatenated layout, select the Mirrored checkbox, and specify three mirrors. 

For full details about creating cluster disk groups and volumes, see “Creating 

SFW disk groups and volumes” on page 584.

Note: If you add other volumes to this disk group, any failures related to their 

operation can cause disruptive failovers of the quorum volume. If a volume in 

the group experiences a high level of read/write activity, failovers may result 

from delayed access to the quorum volume by Microsoft clustering.

Creating the quorum resource for the cluster group
You add the Volume Manager Disk Group resource corresponding to the disk 

group that you created for the quorum.

To add a Volume Manager Disk Group resource for the quorum 

1 If Failover Cluster Management is already open, then proceed to Step 2.

To launch Failover Cluster Management, select it from Start > 

Administrative Tools > Failover Cluster Management. 

2 Verify that the cluster is online on the same node where you created the disk 

group.

3 In the left pane of Failover Cluster Management, right-click Services and 

Applications and select More Actions > Create Empty Service or 

Application.

4 Right-click the new group and rename it, for example QUORUM.
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5 Right-click QUORUM and select Add a resource > More resources > Add 

Volume Manager Disk Group.

6 Right-click New Volume Manager Disk Group in the center pane and click 

Properties. 

7 In the General tab of the Properties dialog box, type a name for the resource 

in the Resource Name field, for example, QUORUM_DG_RES.

8 On the Properties tab, in the Disk Group Name field, type the name of the 

disk group that you previously created for the quorum, and click OK to close 

the dialog box.

9 Right-click the Quorum disk group resource (for example, QUORUM_DG_RES) 

in the left pane and select Bring this resource online.

The specified disk group resource, QUORUM_DG_RES resource, is created 

under the Quorum group (for example, QUORUM).
 

Changing the quorum resource to a dynamic mirrored  
quorum resource

Use the following procedure to configure the cluster quorum settings and 

change the quorum resource to a dynamic mirrored quorum resource.

To change the quorum to a dynamic mirrored quorum resource

1 In Failover Cluster Management, right-click the cluster node in the 

configuration tree, and select More Actions > Configure Cluster Quorum 

Settings. 

The Configure Cluster Quorum Wizard opens.

2 Review the screen and click Next.

3 Select either the Node and Disk Majority or No Majority: Disk Only radio 

button, and click Next.

4 Select the storage resource that you want to assign as the disk witness for 

the quorum and click Next.

This is the Volume Manager Disk Group resource that you previously 

created for the quorum disk group, for example, QUORUM_DG_RES.

5 Review the information in the Confirmation screen and click Next.

6 Click Finish to close the wizard.
 

You add the Volume Manager Disk Group resource corresponding to the disk 

group that you created for the quorum.
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To add a Volume Manager Disk Group resource for the quorum 

1 If Failover Cluster Management is already open, then proceed to Step 2.

To launch Failover Cluster Management, select it from Start > 

Administrative Tools > Failover Cluster Management. 

2 Verify that the cluster is online on the same node where you created the disk 

group.

3 In the left pane of Failover Cluster Management, right-click Services and 

Applications and select More Actions > Create Empty Service or 

Application.

4 Right-click the new group and rename it, for example QUORUM.

5 Right-click QUORUM and select Add a resource > More resources > Add 

Volume Manager Disk Group.

6 Right-click New Volume Manager Disk Group in the center pane and click 

Properties. 

7 In the General tab of the Properties dialog box, type a name for the resource 

in the Resource Name field, for example, QUORUM_DG_RES.

8 On the Properties tab, in the Disk Group Name field, type the name of the 

disk group that you previously created for the quorum, and click OK to close 

the dialog box.

9 Right-click the Quorum disk group resource (for example, QUORUM_DG_RES) 

in the left pane and select Bring this resource online.

The specified disk group resource, QUORUM_DG_RES resource, is created 

under the Quorum group (for example, QUORUM).
 

Verifying the cluster configuration
You can verify your installation by moving the cluster group between nodes to 

see if it fails over properly. The ultimate test of the cluster’s failover capability 

involves shutting down the node that is currently online and bringing it back up 

after the cluster fails over to the other node.

To verify the configuration of a cluster, either move the online groups, or shut 

down an active cluster node. 

■ Use Failover Cluster Management to move all the resource groups from one 

node to another. 

■ Simulate a failover by shutting down an active cluster node.

Do not simulate failover in a production environment. 
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To move online groups

1 Open the Failover Cluster Management tool (Start > All Programs > 

Administrative Tools > Failover Cluster Management).

2 In the left pane, under Services and Applications, right-click a resource 

group and then click Move this service or application to another node > 

Move to node [name of node].

If there is more than one resource group, you must repeat this step until all 

the resource groups are moved.

3 In the Failover Cluster Management console, center panel, verify that the 

Current Owner name has changed for all of the resource groups that were 

moved. This confirms that the resource groups have moved to another 

system.

4 If you need to move the resource groups back to the original system, repeat 

Step 2.

To shut down an active cluster node

1 Shut down the active cluster node normally.

2 Open Failover Cluster Management. Click Start > All Programs > 

Administrative Tools > Failover Cluster Management from any node in the 

cluster.

3 In Failover Cluster Management, verify that the owner name has changed. 

This confirms that all the resource groups have moved to another node. 

4 If you need to move the resource groups back to the original node, restart 

the node you shut down in step 1, select the resource group, and use Move 

this service or application to another node > Move to node [name of node] 

to move the resource group.
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Chapter
 16
Microsoft clustering 

solutions overview

About Microsoft clustering with high availability

About Microsoft clustering with Veritas Volume Replicator

About Microsoft clustering with campus clustering

About Microsoft clustering with high availability
Microsoft clustering may be used with Veritas Storage Foundation for Windows 

to provide high availability for your application. 

A high availability solution maintains continued functioning of applications in 

the event of computer failure, where data and applications are available using 

redundant software and hardware. “High availability” can refer to any software 

or hardware that provides fault tolerance, but generally it has become 

associated with clustering. 

A cluster is a group of independent computers working together as a single 

system to ensure that mission-critical applications and resources are highly 

available. The cluster is managed as a single system, shares a common 

namespace, and is specifically designed to tolerate component failures and to 

support the addition or removal of components in a way that is transparent to 

users.

Keeping data and applications functioning 24 hours a day and seven days a week 

is a requirement for critical applications today. Clustered systems have several 

advantages, including fault tolerance, high availability, scalability, simplified 

management, and support for rolling upgrades.



602 Microsoft clustering solutions overview

About Microsoft clustering with Veritas Volume Replicator
About Microsoft clustering with Veritas Volume 
Replicator

Microsoft clustering may be used with Veritas Storage Foundation for Windows 

and Veritas Volume Replicator to provide replication support for your 

application. Using VVR with Microsoft clustering provides a replicated backup 

of your application data, which can be used for recovery after an outage or 

disaster. However, this solution does not provide the automated failover 

capability for disaster recovery that can be achieved using VVR with VCS.

About Microsoft clustering with campus clustering
Campus clusters are multiple-node clusters that provide protection against 

disasters. These clusters are in separate buildings (or sites) with mirrored SAN-

attached storage located in each building. Typical campus clusters involve two 

sites; you can use more than two sites for additional redundancy.

In a typical configuration, each node has its own storage array and contains 

mirrored data of the storage on the other array. 

This environment also provides a simpler solution for disaster recovery than a 

more elaborate Symantec disaster recovery environment with replication 

software; however, a campus cluster generally stretches a shorter distance than 

a replication-based solution depending on the hardware.

About the SFW-Microsoft clustering-VVR 
configuration 

A typical disaster recovery configuration requires that you have a source host 

on the primary site and a destination host on the secondary site. The application 

data is stored on the primary site and replicated to the secondary site by using a 

tool such as the Veritas Volume Replicator. The primary site provides data and 

services during normal operation. If a disaster occurs on the primary site and its 

data is destroyed, a secondary host can take over the role of the primary host to 

make the data accessible. The application can be restarted on that host. 

This Disaster Recovery section includes a SFW-Microsoft clustering-VVR 

configuration. The configuration is described with a generic database 

application that includes both data and a database log.
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About the SFW-Microsoft clustering-VVR configuration
The illustration below shows the SFW HA-VVR configuration with Microsoft 

clustering. For a SFW-Microsoft clustering-VVR configuration, at least two disk 

groups are necessary—one for the application and one for the quorum resource 

volume, which has to be in a separate disk group, as shown in the illustration 

that follows.

Figure 16-1 SFW-Microsoft clustering-VVR configuration 

The quorum volume is not replicated from the primary site to the secondary 

site. Each site has its own quorum volume. A two-way or four-way mirror is 

recommended for the quorum volume for redundancy.

Configuring the quorum device for high availability

Either a single basic disk used as a physical disk resource or a volume located on 

a three-disk SFW cluster disk group can serve as the Microsoft clustering 

quorum device.

In general, a disk group containing a dedicated, three-way mirrored volume 

makes an ideal quorum device. 
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About the SFW-Microsoft clustering-VVR configuration
In Microsoft clustering environments, the proper configuration of a quorum 

device is critical to providing the highest availability with SFW storage. 

Using a single disk as the quorum device introduces a nonredundant component 

into an otherwise highly available system. A failure-tolerant volume used as a 

quorum device provides a level of availability that is consistent with that of the 

rest of the cluster. 

An SFW cluster disk group containing a volume used as a quorum device should 

contain that volume only. Any other volumes in that disk group fail over 

whenever the quorum device changes ownership. 

A disk group containing only a three-way mirrored volume makes an ideal 

quorum device. Such a device tolerates both disk failures, because it is mirrored, 

and server and interconnect failures, because SFW can import it when the disks 

and at least one server are running. 

For a server to take ownership of a disk group containing the cluster quorum 

device, SFW must successfully import the disk group, and obtain SCSI 

reservations on more than half of its disks. Disk groups containing odd numbers 

of disks are best for use as quorum devices because of this behavior. 
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Deploying SFW with 

Microsoft failover 

clustering in a campus 

cluster

This chapter covers the following topics:

■ “Tasks for deploying SFW with Microsoft failover clustering in a campus 

cluster (Windows Server 2012)” on page 606

■ “Reviewing the requirements” on page 608

■ “Reviewing the configuration” on page 610

■ “Configuring the network and storage” on page 618

■ “Establishing a Microsoft failover cluster” on page 620

■ “Installing SFW” on page 622

■ “Creating disk groups and volumes” on page 632

■ “Implementing a dynamic quorum resource” on page 643

■ “Setting up a group for the application in the failover cluster” on page 645

■ “Installing the application on the cluster nodes” on page 646

■ “Completing the setup of the application group in the cluster” on page 648

■ “Verifying the cluster configuration” on page 649
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Tasks for deploying SFW with Microsoft failover  
clustering in a campus cluster (Windows Server 
2012)

This chapter presents a Microsoft failover clustering example with a two-node 

campus cluster on Windows Server 2012.

The table below outlines the high-level objectives and the tasks for each 

objective:

Table 17-1 Task list for deploying SFW with Microsoft failover clustering in a 

campus cluster 

Objectives Tasks

“Reviewing the requirements” on 

page 608

■ Verify hardware and software 

prerequisites.

“Reviewing the configuration” on 

page 610

■ Review the configuration requirements.

■ Overview of a campus cluster using 

Microsoft clustering and recovery 

scenarios.

“Configuring the network and storage” 

on page 618

■ Install and configure the hardware for 

each node in the cluster.

■ Verify the DNS settings and binding order 

for all systems.

“Establishing a Microsoft failover 

cluster” on page 620

■ Enable the Microsoft failover clustering 

feature.

■ Ensure that you have met the hardware 

requirements for a failover cluster.

■ Run the Microsoft wizard to validate the 

configuration.

■ Use Failover Cluster Management to 

create the first node of the cluster.

■ Create the second node of the cluster.

■ Connect the two nodes.

“Installing SFW” on page 622 ■ Install SFW on Node A (Node B active).

■ Install SFW on Node B (Node A active).
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“Creating disk groups and volumes” on 

page 632

■ In SFW on Node A, create two or more 

dynamic cluster disk groups on the 

storage, one or more for the application 

data files and one for the mirrored 

quorum.

“Implementing a dynamic quorum 

resource” on page 643

■ If not done earlier, create a dynamic disk 

group for the quorum with a mirrored 

volume.

■ Add the volume manager disk group for 

the quorum.

■ Change the quorum resource to the 

dynamic mirrored quorum resource.

“Setting up a group for the application 

in the failover cluster” on page 645

■ Create a group within failover clustering 

for the application.

■ Include the cluster disk group or groups 

for the application as Volume Manager. 

Disk Group type resources in the group.

“Installing the application on the 

cluster nodes” on page 646

■ Install the application program files on 

the local drive of the first node.

■ Install files relating to the data and logs 

on the shared storage.

■ Move the cluster resources to the second 

node.

■ Make sure that the volumes on the second 

node have the same drive letters or mount 

points as they had on the first node.

■ Install the application on the second node.

“Completing the setup of the 

application group in the cluster” on 

page 648

■ Refer to the application documentation 

for help on creating its resource.

■ Establish the appropriate dependencies.

■ Test the application group by moving the 

cluster resources to the other node.

“Verifying the cluster configuration” 

on page 649

■ Verify the cluster configuration by either 

moving all the resource groups from one 

node to another or by simulating a 

failover by shutting down the active 

cluster node.

Table 17-1 Task list for deploying SFW with Microsoft failover clustering in a 

campus cluster (Continued)

Objectives Tasks
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Reviewing the requirements
Reviewing the requirements
Reviewing the requirements and the configuration allows you to gain an overall 

understanding of the configuration and its requirements.

See the following topics:

■ Supported software

■ System requirements

■ Disk space requirements

Supported software
Review the SFW HA Hardware Compatibility List to confirm supported 

hardware:

http://www.symantec.com/docs/TECH152806

Review the SFW HA Software Compatibility List to confirm supported software:

http://www.symantec.com/docs/TECH201485

The following software is supported for deploying SFW and Microsoft 

clustering:

■ Veritas Storage Foundation for Windows (SFW)

Include the following option during installation:

■ Cluster Option for Microsoft Failover Cluster

For a DR configuration with Veritas Volume Replicator, include the 

following option:

■ Veritas Volume Replicator option

The following table shows supported Windows Server operating systems for 

SFW server software.

Note: SFW software for servers supports Hyper-V and parent partitions. 

 

Table 17-2 Supported Windows Server operating systems 

Windows Server Platform Edition Version

Windows Server 2012 (Full/

Core)

x64 Standard, Datacenter

http://www.symantec.com/docs/TECH152806
http://www.symantec.com/docs/TECH201485
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System requirements

■ One CD-ROM drive accessible to each system on which you are installing 

Microsoft clustering.

■ SCSI or Fibre Channel host bus adapters (HBAs) can be used to access the 

storage.

■ Microsoft clustering requires at least two network adapters per system (one 

network adapter to connect each system to the public network and one 

network adapter for the private network on each system). Symantec 

recommends having two adapters for the private network and routing each 

private network adapter through a separate hub or switch to avoid single 

points of failure.

■ Refer to application documentation to determine disk space requirements 

for your application.

■ Each system requires 1 GB of RAM.

■ The configuration requires two sites with a storage array for each site, with 

an equal number of disks at each site for the mirrored volumes. 

■ Interconnects between the clusters are required for the storage and the 

network. 

■ Systems to be clustered must be configured as part of a Windows Server 

2012 domain. Each system in a cluster with Microsoft failover clustering 

must be in the same domain and must be using the same operating system 

version.

■ To install and work with the SFW and Microsoft clustering software, you 

must have an account with Administrator privileges. You must also have a 

license key to install SFW.

■ Using static IP addresses for the public network and private network cards is 

highly recommended. DHCP is not supported. Six network interface cards, 

three for each server (two each for the private network and one for the 

public network). You also need a static IP address for the cluster itself.

Note: To determine the approved hardware for SFW, review the Hardware 

Compatibility List on the Symantec Support web site at: 
http://www.symantec.com/docs/TECH152806

http://www.symantec.com/docs/TECH152806
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Disk space requirements
The following table summarizes disk space requirements for SFW.

 

Note: Plan for an equal number of disks on the two sites, because each disk 

group should contain the same number of disks on each site. 

Reviewing the configuration
This configuration example describes a two-node campus cluster with each node 

at a separate site. 

For an overview of campus clusters with Microsoft clustering or for recovery 

scenarios, see the following:

■ “Overview of campus clustering with Microsoft clustering” on page 612

■ “Campus cluster failure with Microsoft clustering scenarios” on page 613

Table 17-3 Disk space requirements

Installation options Required disk space

SFW + all options 1124 MB

Client components 632 MB
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Figure 17-1 Campus clustering with Microsoft clustering configuration example

The two nodes can be located miles apart and are connected via a single subnet 

and Fibre Channel SAN. Each node has its own storage array and contains 

mirrored data of the storage on the other array. Each disk group should contain 

the same number of disks on each site for the mirrored volumes. 

Microsoft clustering uses the quorum architecture, where the cluster database 

resides in the quorum resource. If you are using Microsoft clustering, adding 

SFW to the configuration protects the quorum disk from being a single point of 

failure in the cluster because SFW provides dynamic volumes and software 

mirroring of the quorum device. To avoid a single point of failure, set up the 

quorum as a dynamic mirrored device. This example includes the dynamic 

mirrored quorum and requires setting up two or more dynamic cluster disk 

groups in SFW— one or more cluster disk groups for the application and data 

and one for the dynamic mirrored quorum.

The example configuration does not include DMP. For instructions on how to 

add DMP to a clustering configuration, see the DMP chapter, “Adding DMP to a 

clustering configuration” on page 173.
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When you are installing SFW and Microsoft clustering together, remember the 

following:

■ A cluster using Microsoft clustering must be running to install SFW.

You need to set up the hardware and install the operating system and 

Microsoft clustering on all systems and establish the failover cluster before 

installing SFW. 

Installing SFW requires a reboot, but a reboot on the active cluster node 

causes it to fail over. Use a “rolling install” procedure to install SFW first on 

the inactive cluster node. Then move the cluster resources to the other node 

and install on the now inactive node.

■ After SFW is installed, create one or more cluster disk groups with SFW and 

set up the volumes for your application. At the same time, you can create the 

mirrored volume for the dynamic quorum resource. 

■ SFW allows you to add fault tolerance to your data volumes. Mirroring of log 

volumes is recommended, and a mirrored striped RAID layout is 

recommended for your data volumes. SFW also offers multiple disk groups, 

multiple mirrors, capacity management and Automatic Volume Growth, 

online storage migration, performance tuning, hot relocation, dirty region 

logging, RAID-5 logging, Dynamic Multi-pathing, and enhanced snapshot 

capabilities with FlashSnap.

Overview of campus clustering with Microsoft clustering
Figure 17-2 on page 613 shows a campus cluster configuration with Microsoft 

clustering. It features mirrored storage across clusters and a mirrored quorum 

resource. The figure shows a four-way mirrored quorum that has an extra set of 

mirrors for added redundancy. Although a campus cluster setup with Microsoft 

clustering can work without Storage Foundation for Windows, SFW provides 

key advantages over using Microsoft clustering alone. Through a dynamic 

mirrored volume that functions on multiple disks across multiple sites, SFW 

protects the quorum resource in the cluster from being the single point of 

failure in the cluster. 
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Figure 17-2 Typical campus clustering configuration with Microsoft clustering

Most customers use hardware RAID to protect the quorum disk, but that will not 

work when a natural disaster takes down the primary node and its attached 

storage. If the quorum resource is lost to the cluster, the cluster fails, because 

none of the cluster servers can gain control of the quorum resource and 

ultimately the cluster. Microsoft clustering alone cannot provide fault tolerance 

to the quorum disk. 

Campus cluster failure with Microsoft clustering scenarios
This section focuses on the failure and recovery scenarios with a campus cluster 

with Microsoft clustering and SFW installed. 

For information about the quorum resource and arbitration in Microsoft 

clustering, see

“Microsoft clustering quorum and quorum arbitration” on page 617.

Site A Site B

Mirrored  Volumes

Ethernet

Heartbeat Connections

4-way Mirrored Quorum Resource

1 3 2 4

Other Mirrored Data Other Mirrored Data
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Table 17-4 lists failure situations and the outcomes that occur:

Table 17-4 List of failure situations and possible outcomes 

Failure Situation Outcome Comments

Application fault

May mean the services 

stopped for an application, a 

NIC failed, or a database 

table went offline.

Failover If the services stop for an application 

failure, the application automatically fails 

over to the other site.

Server failure (Site A)

May mean that a power cord 

was unplugged, a system 

hang occurred, or another 

failure caused the system to 

stop responding.

Failover Assuming a two-node cluster pair, failing a 

single node results in a cluster failover. 

Service is temporarily interrupted for 

cluster resources that are moved from the 

failed node to the remaining live node.

Server failure (Site B)

May mean that a power cord 

was unplugged, a system 

hang occurred, or another 

failure caused the system to 

stop responding.

No 

interruption 

of service. 

Failure of the passive site (Site B) does not 

interrupt service to the active site (Site A).

Partial SAN network failure

May mean that SAN fiber 

channel cables were 

disconnected to Site A or 

Site B Storage.

No 

interruption 

of service. 

Assuming that each of the cluster nodes 

has some type of Dynamic Multi-pathing 

(DMP) solution, removing one SAN fiber 

cable from a single cluster node should not 

effect any cluster resources running on that 

node, because the underlying DMP solution 

should seamlessly handle the SAN fiber 

path failover.

Private IP Heartbeat 

Network Failure

May mean that the private 

NICs or the connecting 

network cables failed.

No 

interruption 

of service.

With the standard two-NIC configuration 

for a cluster node, one NIC for the public 

cluster network and one NIC for the private 

heartbeat network, disabling the NIC for 

the private heartbeat network should not 

effect the cluster software and the cluster 

resources, because the cluster software 

simply routes the heartbeat packets 

through the public network. 
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Public IP Network Failure

May mean that the public 

NIC or LAN network has 

failed.

Failover.

Mirroring 

continues.

When the public NIC on the active node, or 

public LAN fails, clients cannot access the 

active node, and failover occurs.

Public and Private IP or 

Network Failure

May mean that the LAN 

network, including both 

private and public NIC 

connections, has failed.

No 

interruption 

of service. 

No Public 

LAN access.

Mirroring 

continues.

The site that owned the quorum resource 

right before the “network partition” 

remains the owner of the quorum resource, 

and is the only surviving cluster node. The 

cluster software running on the other 

cluster node self-terminates because it has 

lost the cluster arbitration for the quorum 

resource. 

Lose Network Connection 

(SAN & LAN), failing both 

heartbeat and connection to 

storage

May mean that all network 

and SAN connections are 

severed; for example, if a 

single pipe is used between 

buildings for the Ethernet 

and storage.

No 

interruption 

of service. 

Disks on the 

same node 

are 

functioning. 

Mirroring is 

not working.

The node/site that owned the quorum 

resource right before the “network 

partition” remains the owner of the quorum 

resource, and is the only surviving cluster 

node. The cluster software running on the 

other cluster node self-terminates because 

it has lost the cluster arbitration for the 

quorum resource. By default, the Microsoft 

clustering clussvc service tries to auto-start 

every minute, so after LAN/SAN 

communication has been re-established, 

the Microsoft clustering clussvc auto-starts 

and will be able to re-join the existing 

cluster.

Storage Array failure on Site 

A, or on Site B

May mean that a power cord 

was unplugged, or a storage 

array failure caused the 

array to stop responding.

No 

interruption 

of service. 

Disks on the 

same node 

are 

functioning. 

Mirroring is 

not working.

The campus cluster is divided equally 

between two sites with one array at each 

site. Completely failing one storage array 

should have no effect on the cluster or any 

cluster resources that are online. However, 

you cannot move any cluster resources 

between nodes after this storage failure, 

because neither node will be able to obtain a 

majority of disks within the cluster disk 

group.

Table 17-4 List of failure situations and possible outcomes (Continued)

Failure Situation Outcome Comments
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Dealing with a failover situation

In summary, the site scenarios that can occur when there is a cluster server 

failure include the following possibilities:

■ If the site not owning the quorum volume and the cluster goes offline, the 

quorum and data volumes stay online at the other site and other cluster 

resources stay online or move to that site. Storage Foundation for Windows 

allows the owning cluster node to remain online with 50% ownership of the 

disks in the quorum group. 

■ If the site owning the quorum volume goes offline, the remaining site 

cannot gain control of the quorum volume because it cannot reserve a 

majority of disks in the quorum group. This is a safeguard to prevent 

multiple nodes from onlining members of a cluster disk group to which they 

have access.

Caution: Manual failover of a cluster between two sites should be performed 

only after coordination between the two sites to ensure that the primary server 

has actually failed. If you manually import a cluster disk group containing the 

Microsoft clustering quorum to the secondary (failover) server when the 

primary server is still active, this causes a split-brain situation. If the split-brain 

situation occurs, you may lose data because each plex of the mirrored volume 

may be updated independently when the same disk group is imported on both 

nodes.

Site A failure (power)

Means that all access to site 

A, including server and 

storage, is lost.

Manual 

failover.

If the failed site contains the cluster node 

that owned the quorum resource, then the 

overall cluster is offline and cannot be 

onlined on the remaining live site without 

manual intervention.

Site B failure (power)

Means that all access to site 

B, including server and 

storage, is lost.

No 

interruption 

of service. 

Disks on the 

same node 

are 

functioning. 

Mirroring is 

not working.

If the failed site did not contain the cluster 

node that owned the quorum resource, then 

the cluster is still alive with whatever 

cluster resources that were online on that 

node right before the site failure.

Table 17-4 List of failure situations and possible outcomes (Continued)

Failure Situation Outcome Comments
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Microsoft clustering quorum and quorum arbitration
This section provides an explanation of the quorum and quorum arbitration in 

Microsoft clustering.

Quorum

The quorum resource maintains the cluster database, as well as critical recovery 

information, in a recovery log. The quorum resource has to be available to all 

nodes through a SCSI or Fibre Channel bus. With Microsoft clustering alone, the 

quorum disk must be located on a single physical disk. However, with SFW, the 

quorum disk can be a mirrored volume that spans multiple disks and cluster 

nodes. 

The quorum resource also determines ownership of the cluster. When a node 

that is controlling the cluster goes offline, other nodes use a challenge/defense 

protocol to determine which node can have control of the quorum resource and 

the cluster.

Cluster ownership of the quorum resource

The Microsoft clustering challenge/defense protocol uses a low-level bus reset 

of the SCSI buses between the machines to attempt to gain control of the 

quorum resource.

After a SCSI bus reset, the reservation that each server had been holding on the 

quorum disk is lost. Each server then has roughly 10 seconds to re-establish that 

reservation, which would in turn let the other servers know that it is still 

functioning, even though the other servers would not necessarily be able to 

communicate with it. 

If the active cluster server does not re-establish the SCSI reservation on the 

quorum resource within the time limit, all applications that were on the server 

will then transfer to the server that establishes the SCSI reservation first. The 

new server servicing the application may now be a bit slower, but clients will 

still get their applications serviced. The IP (Internet Protocol) address and 

network names will move, applications will be reconstituted according to the 

defined dependencies, and clients will still be serviced, without any question as 

to the state of the cluster. 

The challenge/defense protocol is more complex when the quorum device is a 

volume in a Storage Foundation for Windows disk group. For a server to take 

ownership of the disk group containing the cluster quorum device, SFW on that 

server must successfully import the disk group, obtaining SCSI reservations on 

more than half of its disks. Because a campus cluster configuration has an even 

number of disks on each site, failover cannot occur automatically. The manual 
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CLI command, vxclus enable must be used to bring the cluster disk groups 

online on the secondary node after a site failure. 

The vxclus utility

Storage Foundation for Windows provides the vxclus command line utility to 

allow forcing a failover to the secondary site. The command vxclus enable 

creates an entry in the Registry that enables the cluster disk group to be brought 

online on a node with a minority of the disks. Once vxclus enable is executed, 

you can bring the disk group resource online in Failover Cluster Management. 

After the cluster disk group is brought online, the vxclus functionality is 

disabled.

To bring a cluster online on a node with a minority of the cluster disks

1 Use the following vxclus command for each disk group on your cluster 

node:

vxclus enable -g<DynamicDiskGroupName>

You will be asked to confirm the use of this command.

Caution: When bringing a cluster disk group online with a minority of cluster 

disks, make sure that a majority of the disk group disks are NOT online on any 

other cluster node before (and after) onlining the disk group. If a majority of disk 

group disks are online on another node, data corruption can occur.

2 If the cluster service has stopped because of a dynamic quorum resource 

failure, start the cluster service (clussvc).

3 Then, using Failover Cluster Management, bring the cluster disk groups 

online.

For more information on the vxclus utility, see the “Command Line Interface” 

chapter of the Storage Foundation Administrator’s Guide. The vxclus utility also 

provides support for booting from a SAN, but you must have a hardware storage 

array that supports the capability.

Configuring the network and storage
Use the following procedures to configure the hardware and verify DNS 

settings. Repeat this procedure for every node in the cluster.

To configure the hardware

1 Install the required network adapters, and SCSI controllers or Fibre Channel 

HBA.
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2 Connect the network adapters on each system.

To prevent lost heartbeats on the private networks, and to prevent the 

Microsoft cluster from mistakenly declaring a system down, Symantec 

recommends disabling the Ethernet autonegotiation options on the private 

network adapters. Contact the NIC manufacturer for details on this process.

3 Use independent hubs or switches for the private heartbeats. You can use 

cross-over Ethernet cables for two-node clusters.

4 Verify that each system can access the storage devices. Verify that each 

system recognizes the attached shared disk and that the attached shared 

disks are visible.

To verify the DNS settings and binding order for all systems

1 Open the Control Panel (Start > Control Panel).

2 Click Network and Internet, and then click Network and Sharing Center.

3 In the Network and Sharing Center window, on the left side of the screen 

under Tasks, double-click Manage network connections.

4 Ensure the public network adapter is the first bound adapter:

■ From the Advanced menu in the Network Connections window, click 

Advanced Settings.

■ In the Adapters and Bindings tab, verify the public adapter is the first 

adapter in the Connections list. If necessary, use the arrow button to 

move the adapter to the top of the list.

■ Click OK.

5 Open the Public status dialog box by doing one of the following in the 

Network Connections window:

■ Double-click the adapter for the public network.

■ Right-click the adapter for the public network and click Status.

■ Select the adapter for the public network and click View status of this 

connection in the toolbar.

When enabling DNS name resolution, make sure that you use the public 

network adapters, and not those configured for the private network.

6 In the Public Status dialog box, on the General tab, click Properties.

7 In the Public Properties dialog box, on the General tab:

■ Select the Internet Protocol Version 4 (TCP/IPv4) check box.

■ Click Properties.

8 Select the Use the following DNS server addresses option.

9 Verify the correct value for the IP address of the DNS server.
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10 Click Advanced.

11 In the DNS tab, make sure the Register this connection’s address in DNS 

check box is selected.

12 Make sure the correct domain suffix is entered in the DNS suffix for this 

connection field.

To find the domain suffix, click Start > Control Panel > System. The domain 

suffix is listed in the “Computer Name, domain, and workgroup settings” 

section.

13 Close the window.
 

Establishing a Microsoft failover cluster
Before installing SFW, you must first verify that Microsoft failover clustering is 

enabled (if a new installation of Windows Server 2012), and then establish a 

Microsoft failover cluster. This section summarizes the tasks; refer to Microsoft 

documentation for complete details.

To enable Microsoft failover clustering

1 In Server Manager, select Features in the left pane (tree view) and then click 

Add Features (link on the right side of the screen).

2 In the Add Features Wizard, check the Failover Clustering option, and click 

Next.

3 Click Install.

4 When the installation is complete, click Close.

To establish a Microsoft failover cluster 

1 Ensure that you have met the hardware prerequisites for a failover cluster. 

You can run the Microsoft wizard to validate the configuration. See the 

Microsoft documentation for details.

2 Configure the shared storage and create a volume with drive letter “Q” for 

the cluster quorum disk. Use of other drive letters may result in the quorum 

recognition problems. You must have a basic disk reserved for this purpose 

on your shared storage.

Microsoft recommends a minimum of 500 MB for the quorum disk; refer to 

Microsoft documentation for specific requirements.

3 Create the first node of the cluster using Failover Cluster Management 

(Start > Administrative Tools > Failover Cluster Management).



621Deploying SFW with Microsoft failover clustering in a campus cluster

Establishing a Microsoft failover cluster
4 In the action pane, click Create a Cluster. The Create Cluster Wizard will 

start.

If this is the first time this wizard has been run, the Before You Begin page 

will appear. Review the information that is displayed and then click Next. 

You can hide this page on subsequent uses of the wizard; if this has been 

done, the first page might be the Select Servers page.

5 In the Select Servers panel, type the name of the first node in the Enter 

server name field and click Add. You can also use the Browse button to 

browse the Active Directory for the computers you want to add.

Repeat this step for the second node.

6 After both nodes have been added to the list of Selected Servers, click Next.

7 Based on the information on the validation warning screen, assess your 

hardware configuration, and select one of the options. Symantec 

recommends that you select Yes, which starts the Validate a Configuration 

wizard. Follow the wizard instructions.

8 In the Access Point for Administering the Cluster screen, in the Cluster 

Name field, type the name for the failover cluster. This is the name that you 

use to connect to and administer the cluster.

9 In the Address field of the network area, type the appropriate IP address and 

then click Next.

10 In the Confirmation screen, verify that the cluster configuration is correct, 

and then click Next to create the cluster.

11 Review the Summary page and then click Finish to close the wizard.

Note: Setting up the cluster creates physical disk resources for all the basic disks 

on the shared bus. To use these disks when you create your SFW cluster disk 

groups, you must first remove the physical disk resources from the cluster. 

Otherwise, a reservation conflict occurs. After creating the SFW cluster disk 

groups, you will add Volume Manager Disk Group resources to the cluster, 

instead of physical disk resources.

 

Connecting the two nodes
Make the necessary connections between the two sites. The cluster is already 

active on Server A, so Microsoft clustering is now in control of the cluster 

storage on Server A, and both nodes of the storage cannot be accessed at the 

same time by the operating system.
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To connect the two nodes

1 Connect corresponding cables between the three network cards on the two 

sites.

2 Connect the two switches at the two sites through the storage interconnect. 

3 Test the connectivity between the two sites. Test the IP addresses of all the 

network adapter cards in the cluster. Bring up the command window and 

type ping ipaddress, where the ipaddress is the corresponding network 

adapter in the other node.

Installing SFW
This section assumes you are running a Microsoft failover cluster and you are 

installing SFW on an inactive system that does not own any cluster resources.

Symantec recommends a rolling installation to install SFW. For a rolling 

installation, you must first install SFW on an inactive system. Our example uses 

a two node configuration, so the inactive system is the second node. After SFW 

is installed on an inactive system, move the resource groups to this system, and 

make the other systems inactive. Then install SFW on the other inactive 

systems in the Microsoft failover cluster simultaneously.

SFW installation tasks
Installing SFW involves the following:

■ Performing pre-installation tasks 

See “Pre-installation tasks” on page 622.

■ Installing the product 

See “Post-installation tasks” on page 631.

■ Performing post-installation tasks

See “Post-installation tasks” on page 631.

Pre-installation tasks
Perform the following pre-installation tasks:

■ Moving the online groups 

See “Moving the online groups” on page 623.
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Moving the online groups

If your resource groups are on the system where you are installing SFW, you 

must move the resource groups from the SFW system to another system in the 

cluster.

To move the online groups

1 Open Failover Cluster Management (Start > Administrative Tools > Failover 

Cluster Management).

2 In the left pane, under Services and Applications, right-click a resource 

group and then click Move this service or application to another node > 

Move to node [name of node].

If there is more than one resource group, you must repeat this step until all 

the resource groups are moved.

3 In the Failover Cluster Management console, center panel, verify that the 

Current Owner name has changed for all of the resource groups that were 

moved. This confirms that the resource groups have moved to another 

system.

4 If you need to move the resource groups back to the original system, repeat 

Step 2.

Installing SFW server components using the product installer
Use the following procedure to install the SFW server components using the 

product installer. If you choose to install the server components, the client 

components are installed by default.

Note: Ensure that there are no parallel installations, live updates, or Microsoft 

Windows updates in progress and the Windows MPIO feature is enabled before 

you proceed with SFW installation.

To install SFW server components using the product installer

1 Insert the disc containing the installation software into your system’s disk 

drive or download the installation software from the Symantec website.

https://fileconnect.symantec.com

2 Allow the autorun feature to start the installation or double-click Setup.exe. 

The CD browser appears.

2008-04-30|
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Note: If you are installing the software using the product software disc, the 

CD browser displays the installation options for all the products specified 

earlier. However, if you are downloading the installation package from the 

Symantec website, the CD browser displays the installation options only for 

the product to be installed.

3 Click to download the required contents.

4 On the Welcome panel, review the list of prerequisites and click Next.

5 On the License panel, read the license terms, select I accept the terms of 

License Agreement, and then click Next.

6 On the System Selection panel, select the systems and the desired 

Installation and Product options.

You can select the systems in one of the following ways:

■ In the System Name or IP text box, manually type the system name or 

its IP address and click Add.

Note: The wizard does not support the internet protocol version 6. To 

add the systems having internet protocol version 6, you must type the 

system name.

The local host is populated by default.

Storage Foundation for 

Windows

Click to install the server components for Storage 

Foundation for Windows.

Late Breaking News Click to access the latest information about updates, 

patches, and software issues regarding this release.

Windows Data Collector Click to verify that your configuration meets all 

pertinent software and hardware requirements.

SORT Click to access the Symantec Operations Readiness 

Tools site.

In addition to the product download you can also 

download the custom reports about your computer 

and Symantec enterprise products, a checklist 

providing configuration recommendations, and 

system and patch requirements to install or upgrade 

your software.

Browse Content Click to view the software disc contents.

Technical Support Click to contact Symantec Technical Support. 
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■ Alternatively, browse to select the systems.

The systems that belong to the domain in which you have logged in are 

listed in the Available Systems list. Select one or more systems and 

click the right arrow to move them to the Selected Systems list. Click 

OK.

Once you add or select a system, the wizard performs certain validation 

checks and notes the details in the Verification Details box. To review the 

details, select the desired system.

To select the installation and product options, perform the following tasks 

on each of the selected systems.

Note: To apply the selection to multiple systems, select the system for 

which you have selected the installation and product options and then click 

Apply to multiple systems.  
See Applying the selected installation and product options to multiple 

systems.

■ By default the wizard uses %ProgramFiles%\Veritas as the installation 

directory. To customize the installation directory, click Browse and 

select the desired location. Click OK.

Note: The installation directory is selected by default on the systems 

where the product is being upgraded.

■ Select the required license type from the License key drop-down list.

Note: The default license type is “Keyless”.

If you select the “Keyless” license type, all the available product options 

are displayed and are selected by default.

If you select “User entered license key” as your license type, the License 

Details panel appears by default. On the License Details panel, enter the 

license key and then click Add. You can add multiple licenses for the 

various product options you want to use.

The wizard validates the entered license keys and displays the relevant 

error if the validation fails. After the validation is complete, click Ok.



626 Deploying SFW with Microsoft failover clustering in a campus cluster

Installing SFW
■ From the list of features, select the appropriate product options to be 

installed. The options differ depending on your product and 

environment. The following product options are available for SFW:

Storage Foundation 

Options

■ Veritas Volume Replicator (VVR)

Veritas Volume Replicator (VVR) replicates data 

across multiple sites for disaster recovery.

■ FlashSnap

FlashSnap allows you to create and maintain split-

mirror, persistent snapshots of volumes and 

application components. FlashSnap supports VSS 

based snapshots to provide application data in a 

consistent state after the application is restored.

■ Cluster Option for Microsoft Failover Cluster

Provides support for Microsoft Failover Cluster; you 

can select this option even if Microsoft clustering is 

not currently configured. If you choose to select this 

option even if Microsoft clustering is not currently 

configured, you must manually register the VMDg 

and RVG resource while configuring the service 

groups and resources.

■ Replace Disk Management Snap-in with SFW VEA 

GUI

Replaces the Disk Management Snap-in in the 

Windows Computer Management console and the 

Server Manager console with the Veritas Enterprise 

Administrator GUI for Windows Server 2012.
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7 On the System Selection panel, click Next. 

Note that the wizard fails to proceed with the installation, unless all the 

selected systems have passed the validation checks and are ready for 

installation. In case the validation checks have failed on any of the systems, 

review the details and rectify the issue. Before you choose to proceed with 

the installation select the system and click Re-verify to re-initiate the 

validation checks for this system.

8 On the Pre-install Summary panel, review the summary and click Next. 

Note that the Automatically reboot systems after installer completes 

operation check box is selected by default. This will reboot all the selected 

remote systems immediately after the installation is complete on the 

respective system. If you do not want the wizard to initiate this auto reboot, 

DMP Device Specific 

Modules

■ 3PARDATA array (V3PAR)

■ Dell Compellent array (VCOMPLNT)

■ Dell EqualLogic array (VEQLOGIC)

■ EMC cx4240 array (VEMCCLAR)

■ EMC VMAX array (VEMCSYMM)

■ Hitachi VSP array (VHDSAA)

■ HP P6000 array (VHPEVA)

■ IBM DS8000 array (VIBMAADS)

■ IBM XiV Storage System (VXIV)

Symantec maintains a Hardware Compatibility List (HCL), 

which provides information on HBAs and firmware that 

have been tested with each supported array. Check the HCL 

for details about your hardware before installing or using 

DMP DSMs.

The HCL is located at:

http://www.symantec.com/docs/TECH152806

Note: Do not use a DMP DSM together with a third-party 

DSM for the same array. Only one DSM at a time can claim 

the LUNs in an array. According to Microsoft Multipath I/O 

(MPIO) documentation, if multiple DSMs are installed, the 

Microsoft MPIO framework contacts each DSM to 

determine which is appropriate to handle a device. There is 

no particular order in which the MPIO framework contacts 

the DSMs. The first DSM to claim the ownership of the 

device is associated with that device. Other DSMs cannot 

claim an already claimed device. Therefore, to ensure that 

the DMP DSM claims the LUNs of an array, no other DSM 

should be installed for that same array.

http://www.symantec.com/docs/TECH152806
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clear the selection of Automatically reboot systems after installer 

completes operation check box. 

9 On the Installation panel, review the progress of installation and click Next 

after the installation is complete.

If an installation is not successful on any of the systems, the status screen 

shows a failed installation.

10 On the Post-install Summary panel, review the installation result and click 

Next.

If the installation has failed on any of the system, refer to the log file for 

details. You may have to re-install the software.

11 On the Finish panel, click Finish.

If you chose to initiate the auto reboot, a confirmation message to reboot 

the local system appears. Click Yes to reboot immediately or No to reboot 

later.

In case you had not selected to initiate the auto reboot, ensure that you 

manually reboot these systems.

This completes the product installation. 

Note: If you have installed SFW with Microsoft Failover Cluster but if Microsoft 

Failover Cluster is not yet configured in your environment, you must register 

the Volume Manager Disk Group resource after configuring the Microsoft 

clustering software. See “Registering the Volume Manager Disk Group 

resource”. 

Applying the selected installation and product options to 
multiple systems

The following procedure gives details on applying options to multiple systems.

To apply the selected installation and product options to multiple systems

1 Click on any one of the selected system and select the desired installation 

and product options.

2 Click Apply to multiple systems.

3 On the Apply Installation Options panel, select the installation options to be 

applied and then select the desired systems. Click Ok.
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Note: The installation directory is selected by default on the systems where 

the product is being upgraded. The selected Install Directory option does 

not apply to these systems.

Registering the Volume Manager Disk Group resource

You must perform this task only if you have installed SFWwith Microsoft 

Failover Cluster option but Microsoft Failover Cluster is not yet configured in 

your environment.

If you have installed SFW with Microsoft Failover Cluster option but if Microsoft 

Failover Cluster is not yet configured in your environment you must register the 

Volume Manager Disk Group resource, after configuring the Microsoft 

clustering software.

To register the Volume Manager Disk Group resource

1 Navigate to

c:\windows\cluster folder

2 From the command prompt run the following command.

cluster RESTYPE "Volume Manager Disk Group" /CREATE /
DLL:vxres.dll/TYPE:"Volume Manager Disk Group"

Installing the SFW client components using the product installer
Use the following procedure to install SFW client components using the product 

installer.

Note: Client components cannot be installed on server core systems.

Ensure that there are no parallel installations, live updates, or Microsoft 

Windows updates in progress.

To install the SFW client components using the client installer

1 Insert the software disk containing the installation package into your 

system's disc drive or download the installation package from the following 

Symantec Web site.

https://fileconnect.symantec.com

2 Allow the autorun feature to start the installation or double-click Setup.exe.

The CD browser appears.
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3 Click to download the required contents.

4 On the Welcome panel, review the list of prerequisites and click Next.

5 On the License Agreement panel, read the license terms, select I accept the 

terms of License Agreement, and then click Next.

6 On the System Selection panel, select the systems and the installation 

directory.

You can select the systems in one of the following ways:

■ In the System Name or IP text box, manually type the system name or 

its IP address and click Add.

Note: The wizard does not support the internet protocol version 6. To 

add the systems having internet protocol version 6, you must type the 

system name.

Local host is populated by default.

■ Alternatively, browse to select the systems.

The systems that belong to the domain in which you have logged in are 

listed in the Available Systems list. Select one or more systems and 

click the right arrow to move them to the Selected Systems list. Click 

OK.

Veritas Storage 

Foundation for Windows

Click to install the server or client components for 

SFW.

Late Breaking News Click to access the latest information about updates, 

patches, and software issues regarding this release.

Windows Data Collector Click to verify that your configuration meets all 

pertinent software and hardware requirements.

SORT Click to access the Symantec Operations Readiness 

Tools site.

In addition to the product download you can also 

download the custom reports about your computer 

and Symantec enterprise products, a checklist 

providing configuration recommendations, and 

system and patch requirements to install or upgrade 

your software.

Browse Content Click to view the software disc contents.

Technical Support Click to contact Symantec Technical Support. 



631Deploying SFW with Microsoft failover clustering in a campus cluster

Installing SFW
Once you add or select a system, the wizard performs certain validation 

checks and notes the details in the Verification Details box. To review the 

details, select the desired system.

By default the wizard uses %ProgramFiles%\Veritas as the installation 

directory. To customize the installation directory, click Browse and select 

the desired location. Click OK.

To apply the customized directory to multiple systems, click Apply to 

multiple systems. On the Apply Installation Options panel, select the 

systems to apply the customized directory. Click OK.

Note: The installation directory is selected by default on the systems where 

the product is being upgraded. The Install Directory option does not apply 

to these systems.

7 On the System Selection panel, click Next.

Note that the wizard fails to proceed with the installation, unless all the 

selected systems have passed the validation checks and are ready for 

installation. If the validation checks have failed on any of the systems, 

review the details and rectify the issue. Before you choose to proceed with 

the installation select the system and click Re-verify to re-initiate the 

validation checks for this system.

8 On the Pre-install Summary panel, review the summary and click Next.

9 On the Installation panel, review the progress of installation and click Next 

after the installation is complete.

If an installation is not successful on any of the systems, the status screen 

shows a failed installation.

10 On the Post-install Summary panel, review the installation result and click 

Next.

If the installation has failed on any of the systems, refer to the log file for 

details. You may have to re-install the software.

11 On the Finish panel, click Finish.

This completes the installation of the client components.

Post-installation tasks
You must perform the following post-installation tasks:

■ Moving the online groups 

See “Moving the online groups” on page 632.

■ Completing the SFW installation 

See “Completing the SFW installation” on page 632.
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Moving the online groups

You can move the resource groups from the current system, back to the previous 

system where SFW is installed.

To move the online groups

1 Open the Failover Cluster Management tool. (Start > Administrative Tools > 

Failover Cluster Management). 

2 In the left pane, under Services and Applications, right-click the resource 

group and then click Move this service or application to another node > 

Move to node [name of original node].

If there is more than one resource group, you must repeat this step until all 

the resource groups are moved back to the original node.

3 In the Failover Cluster Management console, center panel, verify that the 

Current Owner name has changed for all of the resource groups that were 

moved. This confirms that all the resource groups have moved back to the 

original system.

Completing the SFW installation

You must repeat the SFW installation tasks for the other systems in the 

Microsoft failover cluster.

See “SFW installation tasks” on page 622.
 

Creating disk groups and volumes 
Use Veritas Storage Foundation for Windows to create disk groups and dynamic 

volumes on the cluster storage, which in a campus cluster consists of at least 

two storage arrays.

Before you create disk groups and volumes, consider the following items:

■ The type of volume configurations that are required

■ The number of LUNs required for the disk group

■ The implications of backup and restore operations on the disk group setup

■ The size of databases and logs which depend on the traffic load

■ The disk groups and number of disks on each site 

Note: For campus clusters, each disk group must contain an equal number 

of disks on each site. 
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■ Types of volumes required and location of the plex of each volume in the 

storage array

Note: Each volume should be a mirrored volume with one plex of the volume 

on Site A’s storage array and the other plex of the volume on Site B’s 

storage array.

Create two or more dynamic cluster disk groups on the storage—one or more for 

the application data files and one for the mirrored quorum. 

See the following topics:

■ “Example disk group and volume configuration in campus cluster” on 

page 633

■ “Considerations when creating disk groups and volumes for a campus 

cluster” on page 634

■ “Viewing the available disk storage” on page 635

■ “Creating a dynamic (cluster) disk group” on page 636

■ “Adding disks to campus cluster sites” on page 638

■ “Creating a volume” on page 638

Example disk group and volume configuration in campus cluster
The illustration that follows shows a typical Microsoft failover cluster with a 

campus cluster setup of disks. For campus clusters, each disk group must 

contain an equal number of disks on each site. This example has only one 

application disk group that spans the storage arrays at both sites. 

The data and database log on Site A are mirrored to Site B. Each mirrored 

volume can have more than two disks, but must have an even number, such as 

four. All the application data could be in one large mirrored volume with 

multiple disks, but the same number of disks are required on both sites for the 

mirroring. It is recommended that the log volumes be on separate disks from the 

data.

In the example, a four-way mirror for the quorum volume provides additional 

redundancy. The minimum configuration would be a two-way mirror. If 

possible, use small disks for the quorum volume. Microsoft recommends 500 MB 

for the quorum volume. 
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Figure 17-3 Microsoft failover cluster with campus cluster disks and disk groups 

example

Considerations when creating disk groups and volumes  
for a campus cluster

When you create the disk groups for a campus cluster, ensure that each disk 

group has the same number of disks on each physical site. You create each 

volume as a mirrored volume with one plex of the volume on Site A’s storage 

array and the other plex of the volume on Site B’s storage array.

Symantec recommends using the SFW site-aware allocation feature for campus 

cluster storage. Site-aware allocation can ensure that site boundary limits are 

maintained for operations like volume grow, subdisk move, and disk relocation. 

Enabling site-aware allocation for campus clusters requires the following steps 

in the VEA:

■ After creating the disk groups, you tag the disks with site names to enable 

site-aware allocation. This is a separate operation, referred to in the VEA as 

adding disks to a site.

As an example, say you had a disk group with four disks. Disk1 and Disk2 

are physically located on Site A. Disk3 and Disk4 are physically located on 

Site B. Therefore, you add Disk1 and Disk2 to “site_a” and add Disk3 and 

Disk4 to “site_b”. 

■ During volume creation, you specify the volume site type as Site Separated. 

This ensures that the volume is restricted to the disks on the selected site.
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Note: The hot relocation operation does not  adhere to site boundary 

restrictions. If hot relocation causes the site boundary to be crossed, then the 

Site Separated property of the volumes is changed to Siteless. This is done so as 

not to disable hot relocation. To restore site boundaries later, you can relocate 

the data that crossed the site boundary back to a disk on the original site and 

then change back the properties of the affected volumes. 

For more information on site-aware allocation, refer to the Veritas Storage 

Foundation Administrator’s Guide.

When you create the volumes for a campus cluster, consider the following:

■ During disk selection, configure the volume as “Site Separated” and select 

the two sites of the campus cluster from the site list.

■ For volume attributes, select the “mirrored” and “mirrored across 

enclosures” options. 

■ Symantec recommends using either simple mirrored (concatenated) or 

striped mirrored options for the new volumes. Striped mirrored gives you 

better performance compared to concatenated.

When selecting striped mirrored, select two columns in order to stripe one 

enclosure that is mirrored to the second enclosure.

■ During the volume creation procedure for Site Separated volumes, you can 

only create as many mirrors as there are sites. However, once volume 

creation is complete, you can add additional mirrors if desired.

■ Choosing “Mirrored” and the “mirrored across” option without having two 

enclosures that meet requirements causes new volume creation to fail.

■ You cannot selecting RAID-5 for mirroring.

■ Selecting “stripe across enclosures” is not recommended because then you 

need four enclosures, instead of two.

■ Logging can slow performance.
 

Viewing the available disk storage
Before creating disk groups and volumes you may want to view available disk 

storage.

To view the available disk storage

1 Open the VEA console by clicking Start > All Programs >Symantec> Veritas 

Storage Foundation >Veritas Enterprise Administrator and select a profile 

if prompted.
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2 Click Connect to a Host or Domain. 

3 In the Connect dialog box select the host name from the pull-down menu 

and click Connect. 

To connect to the local system, select localhost. Provide the user name, 

password, and domain if prompted.

4 In the VEA configuration tree, expand hostname > StorageAgent and then 

click Disks.

The internal names for the disks which the current system can access for 

available storage are displayed, with names Harddisk1, Harddisk2, etc. The 

list includes both disks internal to the local system and any external storage 

that is available.

Creating a dynamic (cluster) disk group
Use the following procedure to create a dynamic cluster disk group.

Note: Setting up the cluster creates physical disk resources for all the basic disks 

on the shared bus. To use those disks for the SFW cluster disk groups, you must 

remove the physical disk resources from the cluster. Otherwise, a reservation 

conflict occurs.

Note: Dynamic disks belonging to a Microsoft Disk Management Disk Group do 

not support cluster disk groups.

To create a dynamic disk group

1 Open the VEA console by clicking Start > All Programs > Symantec > Veritas 

Storage Foundation > Veritas Enterprise Administrator (or launch the VEA 

from the Solutions Configuration Center) and select a profile if prompted.

2 Click Connect to a Host or Domain.

3 In the Connect dialog box, select the host name from the pull-down menu 

and click Connect.

To connect to the local system, select localhost. Provide the user name, 

password, and domain if prompted.

4 To start the New Dynamic Disk Group wizard, expand the tree view under 

the host node, right click the Disk Groups icon, and select New Dynamic Disk 

Group from the context menu.

5 In the Welcome screen of the New Dynamic Disk Group wizard, click Next.
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6 Provide information about the cluster disk group:

■ Enter the disk group name (for example, DG1).

■ Check the Create cluster group check box if you wish to create cluster 

dynamic disk groups that are used in a shared storage environment.

■ Select the appropriate disks in the Available disks list, and use the Add 

button to move them to the Selected disks list.

Optionally, check the Disk names prefix checkbox and enter a disk 

name prefix to give the disks in the disk group a specific identifier.

For example, entering TestGroup as the prefix for a disk group that 

contains three disks creates TestGroup1, TestGroup2, and TestGroup3 

as internal names for the disks in the disk group.

Note: For Windows Server operating systems, Windows Disk Management 

Compatible Dynamic Disk Group creates a type of disk group that is created 

by Windows Disk Management (LDM).

■ Click Next.

7 Click Next to accept the confirmation screen with the selected disks.

8 Click Finish to create the dynamic disk group.
 

Proceed to create the appropriate volumes on each disk.
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Adding disks to campus cluster sites
For campus cluster storage, Symantec recommends using Veritas Storage 

Foundation for Windows (SFW) site-aware allocation. To enable site-aware 

allocation, you assign a site name to disks after they are added to a disk group. In 

the VEA assigning a site name is referred to as adding disks to a site.

For example, Disk1 and Disk2 are physically located on Site A and Disk3 and 

Disk4 are physically located on Site B. Therefore, you add Disk1 and Disk2 to 

site_a and add Disk3 and Disk4 to site_b.

To add disks to a site

1 From the VEA console, right-click a disk that needs to be added to a site and 

select Add Disk to Site.

Disks must be part of a dynamic disk group in order to add them to a site.

2 In the Add Disk to a Site screen, choose one of the following:

■ Choose Select a new site and specify a new site name.

The site name can include any alphanumeric value and valid characters 

like the period (.), dash (-), and underscore ( _ ). It cannot exceed 31 

characters. Site names are case insensitive; all names are converted to 

lowercase.

■ Choose Available Sites and select a site from the list.

3 From the Available Disks column, select the disk or disks to add to the 

specified site.

4 Click OK.
 

Creating a volume
Use the following procedure to create dynamic volumes.

Note: When assigning drive letters to volumes, ensure that the drive letters that 

you assign are available on all nodes.

To create dynamic volumes

1 If the VEA console is not already open, click Start > All Programs > 

Symantec > Veritas Storage Foundation > Veritas Enterprise Administrator 

on the desktop. (Skip to step 4 if VEA is already connected to the appropriate 

host.)

2 Click Connect to a Host or Domain. 
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3 In the Connect dialog box select the host name and click Connect.  
To connect to the local system, select localhost. Provide the user name, 

password, and domain if prompted.

4 To start the New Volume wizard, expand the tree view under the host node 

to display all the disk groups. Right click a disk group and select New 

Volume from the context menu.

You can right-click the disk group you have just created.

5 At the New Volume wizard opening screen, click Next.

6 Select the disks for the volume as follows:

Click Next.

Group name Make sure the appropriate disk group is selected.

Site preference Select the Site Separated option.

Select site from Select the campus cluster sites. Press CTRL to select multiple 

sites.

Note: If no sites are listed, the disks have not yet been added to 

a site. 

Auto select disks Automatic disk selection is recommended for campus clusters. 

SFW automatically selects the disks based on the following 

criteria:

■ Their port assignment (disks with two different ports are 

selected). Note that in the list of available disks, the entry 

after each disk name starts with the port number. For 

example, the “P3” in the entry P3C0T2L1 refers to port 3.

■ Amount of available space on the disks. SFW will pick 

two disks (one from each array) with the most space.

Manually select disks If you manually select disks, use the Add and Remove buttons 

to move the appropriate disks to the Selected disks list.

Disable Track 

Alignment

You may also check Disable Track Alignment to disable track 

alignment for the volume. Disabling Track Alignment means 

that the volume does not store blocks of data in alignment 

with the boundaries of the physical track of the disk.
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7 Specify the volume attributes as follows:

Click Next.

Volume name Specify a name for the volume. The name is limited to 18 

ASCII characters and cannot contain spaces or forward or 

backward slashes.

Size Specify a size for the volume. If you click Max Size, the Size 

box shows the maximum possible volume size for that layout 

in the dynamic disk group.

Layout Ensure that the Mirrored checkbox is selected.

Select a layout type as follows:

Select either Concatenated or Striped. 

If you are creating a striped volume, the Columns and Stripe 

unit size boxes need to have entries. Defaults are provided. In 

addition, click the Stripe across checkbox and select Ports 

from the drop-down list.

Mirror Info Click Mirror across and select Enclosures from the drop-down 

list. 

When creating a site separated volume, as required for 

campus clusters, the number of mirrors must correspond to 

the number of sites. If needed, you can add more mirrors after 

creating the volume.

Enable logging Verify that this option is not selected.
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8 In the Add Drive Letter and Path dialog box, assign a drive letter or mount 

point to the volume. You must use the same drive letter or mount point on 

all systems in the cluster. Make sure to verify the availability of the drive 

letter before assigning it. 

■ To assign a drive letter, select Assign a Drive Letter, and choose a drive 

letter.

■ To mount the volume as a folder, select Mount as an empty NTFS 

folder, and click Browse to locate an empty folder on the shared disk.

9 Click Next.
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10 Create an NTFS file system.

■ Make sure the Format this volume checkbox is checked and select 

NTFS.

■ Select an allocation size or accept the Default.

■ The file system label is optional. SFW makes the volume name the file 

system label.

■ Select Perform a quick format if you want to save time.

■ Select Enable file and folder compression to save disk space. Note that 

compression consumes system resources and performs encryption and 

decryption, which may result in reduced system performance. Click 

Next.

11 Click Finish to create the new volume.

12 Repeat these steps to create additional volumes as needed.

Note: Create the cluster disk group and volumes on the first node of the 

cluster only.
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Figure 17-4 View of disks with volumes in VEA Console

Implementing a dynamic quorum resource
One of the key advantages of using SFW with Microsoft clustering is that you 

can create a mirrored quorum resource that adds fault tolerance to the quorum. 

The tasks for creating a mirrored quorum resource are:

■ “Creating a dynamic cluster disk group and a mirrored volume for the 

quorum resource” on page 643

■ “Adding the volume manager disk group for the quorum” on page 644

■ “Changing the quorum resource to the dynamic mirrored quorum resource” 

on page 645

Creating a dynamic cluster disk group 
and a mirrored volume for the quorum resource

If you have not already completed this step, use SFW to create a cluster disk 

group for the quorum disks. Symantec recommends using four (small) disks for 

the mirrored quorum volume; you need a minimum of two disks. Microsoft 

recommends 500 MB for the quorum disk. 

To create a four-way mirrored volume using the New Volume wizard

1 Create the cluster disk group with four small disks.

2 Create a volume with the four disks.
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3 Select the Concatenated layout, click the Mirrored check box, and specify 

four mirrors. 

For full details on a creating cluster disk groups and volumes, see “Creating 

disk groups and volumes” on page 632.

Note: If you add other volumes to this disk group, any failures related to 

their operation can cause disruptive failovers of the quorum volume. If a 

volume in the group experiences a high level of read/write activity, 

failovers may result from delayed access to the quorum volume by 

Microsoft clustering.

Adding the volume manager disk group for the quorum
You add the Volume Manager Disk Group resource corresponding to the disk 

group that you created for the quorum.

To add a Volume Manager Disk Group resource for the quorum 

1 If Failover Cluster Management is already open, then proceed to Step 2.

To launch Failover Cluster Management, select it from Start > 

Administrative Tools > Failover Cluster Management. 

2 Verify that the cluster is online on the same node where you created the disk 

group.

3 In the left pane of Failover Cluster Management, right-click Services and 

Applications and select More Actions > Create Empty Service or 

Application.

4 Right-click the new group and rename it, for example QUORUM.

5 Right-click QUORUM and select Add a resource > More resources > Add 

Volume Manager Disk Group.

6 Right-click New Volume Manager Disk Group in the center pane and click 

Properties. 

7 In the General tab of the Properties dialog box, type a name for the resource 

in the Resource Name field, for example, QUORUM_DG_RES.

8 On the Properties tab, in the Disk Group Name field, type the name of the 

disk group that you previously created for the quorum, and click OK to close 

the dialog box.

9 Right-click the Quorum disk group resource (for example, QUORUM_DG_RES) 

in the left pane and select Bring this resource online.

The specified disk group resource, QUORUM_DG_RES resource, is created 

under the Quorum group (for example, QUORUM).
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Changing the quorum resource to the 
dynamic mirrored quorum resource

Use the following procedure to configure the cluster quorum settings and 

change the quorum resource to a dynamic mirrored quorum resource.

To change the quorum to a dynamic mirrored quorum resource

1 In Failover Cluster Management, right-click the cluster node in the 

configuration tree, and select More Actions > Configure Cluster Quorum 

Settings. 

The Configure Cluster Quorum Wizard opens.

2 Review the screen and click Next.

3 Select either the Node and Disk Majority or No Majority: Disk Only radio 

button, and click Next.

4 Select the storage resource that you want to assign as the disk witness for 

the quorum and click Next.

This is the Volume Manager Disk Group resource that you previously 

created for the quorum disk group, for example, QUORUM_DG_RES.

5 Review the information in the Confirmation screen and click Next.

6 Click Finish to close the wizard.
 

Setting up a group for the application in the failover 
cluster

After you create SFW disk groups and volumes for the application, use the 

Failover Cluster Management tool to set up a cluster group for the application.

You then add Volume Manager Disk Group resources for the SFW disk groups 

that you created for the application.

After the application is installed on both nodes and its accompanying files are 

placed on the shared storage, you will do additional steps to complete the setup 

of the application group. 

See “Completing the setup of the application group in the cluster” on page 648. 

To set up the application cluster group

1 Launch Failover Cluster Management by selecting Start > Administrative 

Tools > Failover Cluster Management. Connect to the appropriate cluster 

through the console.
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2 Create a new group by selecting the Services and Applications node from 

the tree that is displayed in the left hand pane. Right-click and select More 

Actions > Create Empty Service or Application. An empty group named New 

service or application is created.

3 Specify a name for the group by right-clicking it and selecting Rename from 

the drop down menu.

4 Type the name of the new group (for example, App_Grp) in the Name field. 

You can now add Volume Manager Disk Group resources to the application 

group.

To create a Volume Manager Disk Group resource for the application

1 If Failover Cluster Management is already open, then proceed to Step 2.

To launch Failover Cluster Management, select it from Start > 

Administrative Tools > Failover Cluster Management. 

2 In the left pane of Failover Cluster Management, right-click the application 

cluster group (for example, App_Grp) and select Add a resource > More 

resources > Add Volume Manager Disk Group.

3 In the center panel under Disk Drives, double-click New Volume Manager 

Disk Group to open its Properties dialog box.

4 On the General tab of the Properties dialog box, type a name for the 

resource.

For example, type APP_DG_RES.

5 On the Properties tab, in the Disk Group Name field, type the name of the 

disk group you previously created for the application (for example, DG1), 

and click OK to close the dialog box.

6 Right-click the newly named resource and select Bring this resource online.

7 If you created more than one disk group for the application, repeat this 

procedure to add another Volume Manager Disk Group resource for another 

disk group.

Installing the application on the cluster nodes
The application program files must be installed on the same local drive of all the 

cluster nodes. The application data and log files or other files related to the 

application data are installed on the shared storage. 

Refer to the Microsoft documentation for any specific requirements for the 

application in a failover cluster environment.
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Pointers for installing the application on the first node

■ Applications may have built-in procedures for running on a cluster. Consult 

the application documentation to determine whether these procedures are 

available.

■ Some applications install on both nodes at once.

■ All nodes of the clustered application need to share the same virtual name 

and IP address. 

■ Remember not to accept the default location for the application data and log 

files. Instead, browse to the dynamic volumes that were prepared previously.

Pointers for installing the application on the second node

■ In Failover Cluster Management, move the cluster resources to the second 

node.

■ Make sure that the shared volumes, when accessed on the second node, have 

the corresponding drive letters or mount points that they had when 

accessed from the first node. 

■ If you are installing a database, you may need to stop the database service on 

the first node while the shared disks are being manipulated by the 

installation on the second node. Then restart the service after the 

application is installed. 

To add or change a drive letter or mount point

1 In VEA, right-click on the volume for which the drive letter will be added or 

changed.

2 Select File System and click Change Drive Letter and Path. The Drive Letter 

and Paths window appears. You can choose from the following:

■ To add a drive letter, click Add. The Assign a drive letter drop-down list 

becomes available. Assign a drive letter and click OK.

■ To change a drive letter, click Modify. The Assign a drive letter drop-

down list becomes available. Change the drive letter and click OK.

■ To add a mount point, click Add, click the Mount as an empty NTFS 

folder radio button, browse to select an empty folder or click the New 

Folder button to create a new folder, and click OK to mount the volume.

■ To change a mount point, you must remove it and then select the Add 

option to add it back. To remove it, select it in the Drive Letter and 

Paths window and click Remove.
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Completing the setup of the application group in the 
cluster

To make the application group functional in Microsoft clustering, the 

application resource needs to be added, as well as any other resources that are 

associated with the application. Also, dependencies need to be established for 

the resources. This section presents a summary of the process for completing 

the application group setup. 

■ Before creating the application resource, make sure that all the other 

resources that you created are online, including the disk group resource and 

any additional application resources.

■ Refer to the application documentation for help on creating its resource and 

additional resources that may be required. You may need to create an IP 

address resource and a network name resource in addition to the Volume 

Manager Disk Group resource that you created earlier.

Ensure that you select the appropriate disk group resource as the storage 

resource on which the application resource is dependent.
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The following dependency chart indicates the dependencies that are 

established.

Figure 17-5 Application group dependencies

■ Testing: After the application group is set up, test it by moving the cluster 

resources to another node and then move them back.

Verifying the cluster configuration
After completing the configuration, verify that failover occurs as desired.

To verify the configuration of a cluster, either move the online groups, or shut 

down an active cluster node. 

■ Use Failover Cluster Management to move all the resource groups from one 

node to another. 

■ Simulate a failover by shutting down an active cluster node.

Do not simulate failover in a production environment. 

To move online groups

1 Open the Failover Cluster Management tool (Start > All Programs > 

Administrative Tools > Failover Cluster Management).

Other Resources

Application Resource

Application Group 

(App_Grp)

Additional Resources 

required by the application

“Volume Manager Disk 

Group” Resource
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2 In the left pane, under Services and Applications, right-click a resource 

group and then click Move this service or application to another node > 

Move to node [name of node].

If there is more than one resource group, you must repeat this step until all 

the resource groups are moved.

3 In the Failover Cluster Management console, center panel, verify that the 

Current Owner name has changed for all of the resource groups that were 

moved. This confirms that the resource groups have moved to another 

system.

4 If you need to move the resource groups back to the original system, repeat 

Step 2.

To shut down an active cluster node

1 Shut down the active cluster node normally.

2 Open Failover Cluster Management. Click Start > All Programs > 

Administrative Tools > Failover Cluster Management from any node in the 

cluster.

3 In Failover Cluster Management, verify that the owner name has changed. 

This confirms that all the resource groups have moved to another node. 

4 If you need to move the resource groups back to the original node, restart 

the node you shut down in step 1, select the resource group, and use Move 

this service or application to another node > Move to node [name of node] 

to move the resource group.
 



Chapter
 18
Deploying SFW and VVR 

with Microsoft failover 

clustering

This chapter covers the following topics:

■ “Tasks for deploying SFW and VVR with Microsoft failover clustering” on 

page 651

■ “Part 1: Setting up the cluster on the primary site” on page 655

■ “Completing the primary site configuration” on page 665

■ “Part 2: Setting up the cluster on the secondary site” on page 665

■ “Part 3: Adding the VVR components for replication” on page 667

■ “Part 4: Maintaining normal operations and recovery procedures” on 

page 685

Tasks for deploying SFW and VVR with Microsoft 
failover clustering 

You can set up a disaster recovery (DR) solution using SFW with a Microsoft 

failover cluster and VVR on Windows Server 2012. 

The example describes a generic database application in order to present 

general recommendations that apply to applications in a DR solution. 

The process for setting up and working with the SFW-Microsoft failover cluster-

VVR disaster recovery solution has four main parts:

■ Part 1: Setting up the cluster on the primary site
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■ Part 2: Setting up the cluster on the secondary site

■ Part 3: Adding the VVR components for replication

■ Part 4: Maintaining normal operations and recovery procedures

The steps for setting up the failover cluster that were described in the High 

Availability section of this guide are the basic foundation on which this disaster 

recovery solution is built (see Chapter 15, “Deploying SFW with Microsoft 

failover clustering” on page 565). 

The main differences in the process of setting up the cluster for a disaster 

recovery rather than for HA alone are that you need to make sure that the VVR 

option is selected during the SFW installation and to configure the Veritas 

Volume Replicator Security Service (VxSAS) after the installation completes. In 

setting up the secondary site, the cluster process is similar. 

Once the two clusters are set up, one at the primary site and the other at the 

secondary site, VVR is used to enable replication from the primary site to the 

secondary site. 

The high-level objectives and the tasks to complete each objective for the 

configuration are as follows:

Table 18-1 Tasks for deploying SFW with Microsoft failover clustering and VVR 

Objective Tasks

“Reviewing the prerequisites 

and the configuration” on 

page 655

■ Verify hardware and software prerequisites.

■ Review configuration requirements.

Part 1: Setting up the cluster on the primary site 

“Installing and configuring 

the hardware” on page 659

■ Set up and configure the hardware according to 

the manufacturers’ instructions.

“Installing Windows and 

configuring network 

settings” on page 659

■ Install the operating system on both nodes.

■ Make necessary networking settings on both 

nodes.

“Establishing the Microsoft 

failover cluster (primary 

site)” on page 659

■ Refer to Microsoft documentation for instructions 

on establishing a Microsoft failover cluster.

“Installing SFW (primary 

site)” on page 661

■ In the Options screen of the installer, select the 

VVR option in addition to the Microsoft Cluster 

option.

“Installing Veritas Volume 

Replicator Security Services 

(VxSAS)” on page 661

■ Complete the steps to configure VxSAS.
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“Creating SFW disk groups 

and volumes” on page 664

■ In SFW on the primary cluster node, create two or 

more dynamic cluster disk groups on the storage—

one or more for the application data files and one 

for the mirrored quorum. 

■ The disk group for the quorum can be created 

later, if desired.

“Creating a group for the 

application in the failover 

cluster” on page 591

■ Create a group for the application using the 

Microsoft Failover Cluster Management tool.

■ Include the cluster disk group or groups for the 

application as Volume Manager Disk Group type 

resources in the group.

“Installing the application on 

cluster nodes” on page 593

■ Install the application program files on the local 

drive of the first node.

■ Install files relating to the data and logs on the 

shared storage.

■ Move the cluster resources to the second node.

■ Make sure that the volumes on the second node 

have the same drive letters or mount points that 

they had on the first node.

■ Install the application on the second node.

“Completing the setup of the 

application group in the 

failover cluster” on page 594

■ Refer to the application documentation for help 

on creating its resource.

■ Establish the appropriate dependencies.

■ Test the application group by moving the cluster 

resources to the other node.

“Implementing a dynamic 

quorum resource” on 

page 595

■ Create a dynamic disk group for the quorum with 

a mirrored volume if this task was not done 

earlier.

■ Make the disk group a Volume Manager Disk 

Group type resource in the default Cluster Group.

■ Change the quorum resource to the dynamic 

mirrored quorum resource.

“Verifying the cluster 

configuration” on page 598

■ Move the cluster resources to the second node. 

Move them back to the first node.

■ Optionally, simulate a failure by turning off the 

power to the server that has control of the cluster 

resources.

Part 2: Setting up the cluster on the secondary site

Table 18-1 Tasks for deploying SFW with Microsoft failover clustering and VVR 

Objective Tasks
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“Repeating cluster 

configuration steps for the 

secondary site” on page 666

The tasks are:

■ Installing and configuring hardware

■ Installing Windows and configuring network 

settings

■ Establishing the Microsoft failover cluster

■ Installing SFW with the VVR option and Microsoft 

Cluster option

■ Installing Veritas Volume Replicator Security 

Services (VxSAS)

■ Creating SFW disk groups and volumes

■ Setting up a group for the application in Failover 

Cluster Management

■ Installing the application on cluster nodes

■ Completing the setup of the application group in 

Failover Cluster Management

■ Changing the quorum resource to the dynamic 

quorum resource

■ Final testing of the cluster

Part 3: Adding the VVR components for replication

“Configuring the Replicator 

Log volumes for VVR” on 

page 668

■ Use SFW to create Replicator Log volumes for the 

primary and secondary sites if this wasn’t done 

earlier when configuring the SFW disk groups and 

volumes for the application.

“Setting up the Replicated 

Data Sets (RDS) for VVR” on 

page 670

■ Create Replicated Data Sets with VVR’s Replicated 

Data Set wizard and start replication for the 

primary and secondary sites.

“Creating resources for VVR” 

on page 682

■ In Failover Cluster Management, create the 

network name and IP resource to be used for VVR 

replication.

“Creating an RVG resource 

and setting the 

dependencies” on page 682

■ In Failover Cluster Management, create an RVG 

resource for replication.

■ Set the application resource dependency on the 

RVG resource.

■ Remove the direct dependency of the application 

resource on the Volume Manager Disk Group 

resource.

Part 4: Maintaining normal operations and recovery procedures

Table 18-1 Tasks for deploying SFW with Microsoft failover clustering and VVR 

Objective Tasks
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Part 1: Setting up the cluster on the primary site
This section provides more information on the steps for creating the cluster on 

the primary site.

Reviewing the prerequisites and the configuration
This topic describes the hardware and software requirements and gives an 

overview of the configuration.

Note: Before configuring the cluster, refer to the Microsoft documentation for 

Microsoft failover cluster requirements and the application documentation for 

application-specific requirements.

Supported software for Microsoft failover clusters with SFW
Review the SFW HA Hardware Compatibility List to confirm supported 

hardware:

http://www.symantec.com/docs/TECH152806

Review the SFW HA Software Compatibility List to confirm supported software:

http://www.symantec.com/docs/TECH201485

The following software is supported for deploying SFW and Microsoft 

clustering:

■ Veritas Storage Foundation for Windows (SFW)

Include the following option during installation:

■ Cluster Option for Microsoft Failover Cluster

For a DR configuration with Veritas Volume Replicator, include the 

following option:

■ Veritas Volume Replicator option

“Normal operations: 

Monitoring the status of the 

replication” on page 686

■ Monitor replication.

■ Perform planned migration.

“Disaster recovery 

procedures” on page 687

■ Complete the recovery procedures after the 

primary site goes down.

Table 18-1 Tasks for deploying SFW with Microsoft failover clustering and VVR 

Objective Tasks

http://www.symantec.com/docs/TECH152806
http://www.symantec.com/docs/TECH201485
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The following table shows supported Windows Server operating systems for 

SFW server software.

Note: SFW software for servers supports Hyper-V and parent partitions. 

 

System requirements

■ One CD-ROM drive accessible to the system from which you are installing 

SFW.

■ The configuration described requires shared disks to support applications 

that migrate between nodes in each cluster. 

■ SCSI or Fibre Channel host bus adapters (HBAs) can be used to access shared 

storage.

■ Microsoft clustering requires at least two network adapters per system (one 

network adapter to connect each system to the public network and one 

network adapter for the private network on each system). Symantec 

recommends having two adapters for the private network and routing each 

private network adapter through a separate hub or switch to avoid single 

points of failure.

■ Each system requires a minimum of 1 GB of RAM.

■ Each system in a cluster must be in the same domain and must be using the 

same operating system version.

■ To install and work with the SFW and Microsoft clustering software, you 

must have an account with Domain Administrator privileges. You must also 

have a license key to install SFW.

■ Using static IP addresses for the public network and private network cards is 

highly recommended. DHCP is not supported. Six Network Interface Cards 

(NICs), three for each server (two each for the private network and one for 

the public network) are required. You also need a static IP address for the 

cluster itself. Thus, you need seven IP addresses for each cluster.

Table 18-2 Supported Windows Server operating systems 

Windows Server Platform Edition Version

Windows Server 2012 (Full/

Core)

x64 Standard, Datacenter
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■ In addition, you need two more IP addresses for replication, one for the 

primary site and one for the secondary site.

Note: To determine the approved hardware for SFW, review the Hardware 

Compatibility List on the Symantec Support web site at: 
http://www.symantec.com/docs/TECH152806

Disk space requirements

The following table summarizes disk space requirements for SFW.

 

Reviewing the configuration

This configuration overview highlights the active/passive high availability 

within a cluster and disaster recovery between two sites. In an active/passive 

configuration, one or more application virtual servers can exist in a cluster, but 

each server must be managed by a service group configured with a distinct set of 

nodes in the cluster.

Active/passive clusters involve one-to-one failover capabilities. For instance, if 

you have two nodes on each site (SYSTEM1 and SYSTEM2 on the primary site, 

SYSTEM5 and SYSTEM6 on the secondary site), SYSTEM1 can fail over to 

SYSTEM2, and SYSTEM5 can fail over to SYSTEM6.The figure that follows 

illustrates the cluster configuration on the primary site. For a view of the 

configuration that includes both sites, see the illustration in the section “About 

a disaster recovery solution” on page 427.

Table 18-3 Disk space requirements

Installation options Required disk space

SFW + all options 1124 MB

Client components 632 MB

http://www.symantec.com/docs/TECH152806


658 Deploying SFW and VVR with Microsoft failover clustering

Part 1: Setting up the cluster on the primary site
Figure 18-1 DR configuration primary site

This configuration does not include DMP. For information about DMP and 

clustering, see “Adding DMP to a clustering configuration” on page 173.

The following are some other key points about the configuration:

■ A Microsoft failover cluster must be running before you install SFW.

Installing SFW requires a reboot, but a reboot on the active cluster node 

causes it to fail over. Thus, Symantec recommends that you use a “rolling 

install” procedure to install SFW first on the inactive cluster node, then 

move the active cluster resources to the other node, and install on the now 

inactive node.

■ SFW adds the advantage of the dynamic mirrored quorum. The quorum 

resource maintains the cluster database and critical recovery information in 

a recovery log.

Microsoft clustering only supports a basic physical disk and does not enable 

you to mirror the quorum resource. One advantage of SFW is that it 

provides a dynamic mirrored quorum resource for Microsoft clustering. If a 

quorum disk fails, a mirror on another disk (another plex) takes over and 

the resource remains online. For this configuration, Symantec recommends 
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creating a three-way mirror for the quorum to provide additional fault 

tolerance. If possible, do not use the disks assigned to the quorum for any 

other purpose.

After SFW is installed on the cluster nodes, the next task is to create one or 

more cluster disk groups with SFW and set up the volumes for your 

application. At the same time, you can create the disk group and mirrored 

volume for the dynamic quorum resource.

The quorum disk group on each site does not get replicated because each 

cluster has its own quorum.

Installing and configuring the hardware
Refer to the hardware documentation and Microsoft documentation for specific 

details of your hardware setup. 

As a best practice, Microsoft recommends that you wait until after the cluster is 

established on the first node before connecting the second node to the storage 

array in order to avoid corruption of data on the disks.

Installing Windows and configuring network settings
This topic summarizes the steps for installing the operating system and 

configuring the network settings. For specific details, refer to the Microsoft 

documentation.

To install Windows and configure network settings

1 Install the operating system and enable the Failover Clustering feature on 

both servers.

2 Establish the network settings for the NICs and the domain on both servers.

You need to establish static IP addresses for all six NICs—two private NICs 

and one public NIC for each system. 

Establishing the Microsoft failover cluster (primary site)
Before installing SFW, you must first verify that Microsoft failover clustering is 

enabled (if a new installation of Windows Server 2012), and then establish a 

Microsoft failover cluster. This section summarizes the tasks; refer to Microsoft 

documentation for complete details.

To enable Microsoft failover clustering

1 In Server Manager, select Features in the left pane (tree view) and then click 

Add Features (link on the right side of the screen).
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2 In the Add Features Wizard, check the Failover Clustering option, and click 

Next.

3 Click Install.

4 When the installation is complete, click Close.

To establish a Microsoft failover cluster 

1 Ensure that you have met the hardware prerequisites for a failover cluster. 

You can run the Microsoft wizard to validate the configuration. See the 

Microsoft documentation for details.

2 Configure the shared storage and create a volume with drive letter “Q” for 

the cluster quorum disk. Use of other drive letters may result in the quorum 

recognition problems. You must have a basic disk reserved for this purpose 

on your shared storage.

Microsoft recommends a minimum of 500 MB for the quorum disk; refer to 

Microsoft documentation for specific requirements.

3 Create the first node of the cluster using Failover Cluster Management 

(Start > Administrative Tools > Failover Cluster Management).

4 In the action pane, click Create a Cluster. The Create Cluster Wizard will 

start.

If this is the first time this wizard has been run, the Before You Begin page 

will appear. Review the information that is displayed and then click Next. 

You can hide this page on subsequent uses of the wizard; if this has been 

done, the first page might be the Select Servers page.

5 In the Select Servers panel, type the name of the first node in the Enter 

server name field and click Add. You can also use the Browse button to 

browse the Active Directory for the computers you want to add.

Repeat this step for the second node.

6 After both nodes have been added to the list of Selected Servers, click Next.

7 Based on the information on the validation warning screen, assess your 

hardware configuration, and select one of the options. Symantec 

recommends that you select Yes, which starts the Validate a Configuration 

wizard. Follow the wizard instructions.

8 In the Access Point for Administering the Cluster screen, in the Cluster 

Name field, type the name for the failover cluster. This is the name that you 

use to connect to and administer the cluster.

9 In the Address field of the network area, type the appropriate IP address and 

then click Next.
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10 In the Confirmation screen, verify that the cluster configuration is correct, 

and then click Next to create the cluster.

11 Review the Summary page and then click Finish to close the wizard.

Note: Setting up the cluster creates physical disk resources for all the basic disks 

on the shared bus. To use these disks when you create your SFW cluster disk 

groups, you must first remove the physical disk resources from the cluster. 

Otherwise, a reservation conflict occurs. After creating the SFW cluster disk 

groups, you will add Volume Manager Disk Group resources to the cluster, 

instead of physical disk resources.

 

Installing SFW (primary site)
The procedure for adding SFW support to the cluster on the primary site 

involves the same installation steps that were described earlier in the chapter on 

setting up a cluster with SFW and Microsoft failover clustering with one 

important difference: that you select the VVR option from the product installer 

Options screen.

See “Installing SFW” on page 574.

Installing Veritas Volume Replicator Security Services (VxSAS)
After installing SFW, you can configure the VxSAS service for Veritas Volume 

Replicator (VVR).

Complete the following procedure to configure the VxSAS service for VVR.

The procedure has these prerequisites:

■ You must be logged on with administrative privileges on the server for the 

wizard to be launched.

■ The account you specify must have administrative and log-on as service 

privileges on all the specified hosts.

■ Avoid specifying blank passwords. In a Windows Server environment, 

accounts with blank passwords are not supported for log-on service 

privileges.

■ Make sure that the hosts on which you want to configure the VxSAS service 

are accessible from the local host.

Note: For details on this required service, see Veritas Storage Foundation Veritas 

Volume Replicator Administrator’s Guide.
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To configure the VxSAS service

1 Launch the VVR Security Service Configuration Wizard.

Click Start > All Programs > Symantec > Veritas Storage Foundation > 

Configuration Wizards > VVR Security Service Configuration Wizard.

or 

Type vxsascfg.exe at the command prompt.

2 Read the information provided on the Welcome page and click Next.

3 Complete the Account Information panel as follows and then click Next:

If you have already configured the VxSAS service for one host that is 

intended to be a part of the RDS, make sure you specify the same username 

and password when configuring the VxSAS service on the other hosts.

4 On the Domain Selection panel, select the domain to which the hosts that 

you want to configure belong and then click Next:

Account name 

(domain\account)

Enter the administrative account name.

Password Specify a password.

Selecting domains The Available domains pane lists all the domains that are 

present in the Windows network neighborhood.

Move the appropriate name from the Available domains list 

to the Selected domains list, either by double-clicking it or 

using the arrow button.

Adding a domain If the domain name that you require is not displayed, click 

Add domain. This displays a dialog that allows you to 

specify the domain name. Click Add to add the name to the 

Selected domains list.
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5 On the Host Selection panel, select the required hosts:

After you have selected a host name, the Configure button is enabled. Click 

Configure to proceed with configuring the VxSAS service.

6 After the configuration completes, the Configuration Results page displays 

whether or not the operation was successful. If the operation was not 

successful, the page displays the details on why the account update failed, 

along with the possible reasons for failure and recommendations on getting 

over the failure.

When configuring the VxSAS service for VVR in a firewall setup, the VxSAS 

wizard may not be able to configure the machines that are across the 

firewall, although the Host Selection dialog may list these nodes. In this 

Selecting hosts The Available hosts pane lists the hosts that are present in 

the specified domain.

Move the appropriate host from the Available hosts list to 

the Selected hosts list, either by double-clicking it or using 

the arrow button. Use the Shift key with the up or down 

arrow keys to select multiple hosts.

Adding a host If the host name you require is not displayed, click Add 

host. In the Add Host dialog specify the required host name 

or IP in the Host Name field. Click Add to add the name to 

the Selected hosts list.
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case, configure the VxSAS service locally on the machines that are across 

the firewall.

Click Back to change any information you had provided earlier.

7 Click Finish to exit the wizard.
 

Creating SFW disk groups and volumes
The following figure shows a typical setup of volumes for an failover cluster 

with VVR configuration with a database application. The example has one disk 

group for the application on each site. 

If there are more application disk groups in your configuration, note that each 

disk group requires an additional Replicator Log volume. In the procedures 

described in this chapter, the Replicator Log volume will be created later; but 

you will need to allow sufficient disk space for the number of Replicator Log 

volumes required by your configuration. 

The quorum volume is not replicated to the second site and is in a separate disk 

group. It has to be created on each site and functions only on that site. The 

minimum number of disks for the mirrored quorum is two disks. Symantec 

recommends using three disks for the mirrored quorum for additional 

redundancy.

Figure 18-2 Microsoft clustered database with disks for data, logs, and the 

quorum resource

Do not use the following types of volumes for the data and Replicator Log 

volumes; VVR does not support these types of volumes:

■ Storage Foundation for Windows (software) RAID 5 volumes

■ Volumes with the Dirty Region Log (DRL) 

■ Volumes with a comma in their names 
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For the Replicator Log volume, in addition to the above types also make sure 

that the volume does not have a DCM.

For detailed steps in creating disk groups and volumes, see.“Creating SFW disk 

groups and volumes” on page 584 in Chapter 15, “Deploying SFW with 

Microsoft failover clustering”.

Completing the primary site configuration
The remainder of the tasks for the primary site configuration are identical to the 

tasks described in the chapter for configuring Microsoft failover clustering with 

SFW for high availability:

Chapter 15, “Deploying SFW with Microsoft failover clustering”.

See the following topics in that chapter to complete configuring the primary 

site:

■ “Creating a group for the application in the failover cluster” on page 591

■ “Installing the application on cluster nodes” on page 593

■ “Completing the setup of the application group in the failover cluster” on 

page 594

■ “Implementing a dynamic quorum resource” on page 595

■ “Verifying the cluster configuration” on page 598

Part 2: Setting up the cluster on the secondary site
On the secondary site, repeat the tasks performed on the primary site to create a 

cluster that duplicates the primary site’s disk groups and volumes. 

The secondary disk groups and volumes should have the same names as those 

on the primary site. The data volumes should be the same sizes as the 

corresponding data volumes on the primary site. The log volume on the 

secondary site can be a different size, but Symantec recommends that the sizes 

be the same. Install the application on the secondary cluster nodes the same as 

on the primary cluster.
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Figure 18-3 DR configuration secondary site

Repeating cluster configuration steps for the secondary site
After configuring the cluster with SFW and the application on the primary site, 

follow the same procedures when configuring the secondary site. Follow the 

task list table.

See “Tasks for deploying SFW and VVR with Microsoft failover clustering” on 

page 651.

In addition, note the following special requirements for configuring the 

secondary site:

■ During the creation of disk groups and volumes on the secondary site, make 

sure the following is exactly the same as the cluster on the primary site:

■ Cluster disk group name

■ Volume names and sizes 

■ Drive letters
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■ Before installing the application on the secondary site, offline all the 

resources in the failover cluster application group on the primary site, 

except the Volume Manager Disk Group resource.

After both clusters are running, one on the primary site and one on the 

secondary site, you can add the VVR components to the configuration. 

See “Part 3: Adding the VVR components for replication” on page 667.

Part 3: Adding the VVR components for replication
This section provides information on configuring the VVR components for 

replication. Topics include:

■ “VVR components overview” on page 667

■ “Configuring the Replicator Log volumes for VVR” on page 668

■ “Setting up the Replicated Data Sets (RDS) for VVR” on page 670

■ “Creating resources for VVR” on page 682

■ “Creating an RVG resource and setting the dependencies” on page 682

VVR components overview
You configure the following Veritas Volume Replicator components:

Replicated Volume 

Group (RVG)

An RVG is made up of one or more volumes in a SFW disk group. 

The updates made on the RVG on the primary host are sent to a 

configured secondary host. Thus, on the secondary host there is a 

corresponding RVG with a disk group of the same name and 

volumes with the same names. The data volumes should be the 

same size. Optionally, to add more redundancy, you can have 

multiple secondary hosts, all with the same corresponding copy of 

the RVG.

An RVG within a disk group is the container for replication, so if 

you have multiple disk groups, you will need to create a separate 

RVG for each disk group. It is possible to have more than one RVG 

in a disk group; however, the RVG cannot span across disk groups.

Replicated Data Set 

(RDS)

An RVG on the primary host and any corresponding RVGs on the 

secondary host or hosts make up a Replicated Data Set (RDS). 
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Configuring the Replicator Log volumes for VVR

Note: Before configuring the Replicator Log volumes, make sure that all the 

resources in the failover cluster application group are offline, except the disk 

group resource. This task must be done on the primary site as well as the 

secondary site.

Create the volume for the Replicator Log at each site. The task of creating the 

logs can also be done during the RDS creation process, but some storage 

administrators may prefer to do it manually (as is being done here) as a 

preparatory step to setting up the RDS.

Note: To improve write performance, Symantec recommends that you create the 

Replicator Log volume on a different disk from the disks used for your 

application data volumes.

To configure the Replicator Log volumes for VVR

1 Click Start > All Programs > Symantec > Veritas Storage Foundation > 

Veritas Enterprise Administrator on the desktop to open the VEA console on 

the active node of the primary site.

2 Create a volume for the disk group that contains the storage group data:

■ On the System configuration tree, click the disk group where the log 

volume will be created (Hostname>Disk Groups>Diskgroupname).

■ Right-click on a disk group that has the volumes to be replicated, and 

click New Volume.

3 On the Welcome page of the New Volume wizard, click Next.

4 Select the disks for the volume:

■ Select the group name.

Replicator Log 

volume

Each RVG must have a Replicator Log associated with it. The 

Replicator Log volume at the primary site holds a copy of any RVG 

updates that are sent to the secondary site. The Replicator Log on 

the secondary site is held in reserve so that it can be used if the 

primary site becomes nonfunctional and the secondary site needs 

to become the new primary site. The log volumes at the two sites 

must have the same name. Symantec recommends having 

Replicator Log volumes of the same size at the primary site and the 

secondary site.
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■ Select Manually select disks.

■ Click the disk name.

■ Click Add.

■ After selecting all the necessary disks, click Next.

5 Specify the parameters of the volume:

■ Enter the volume name.

■ Enter the size. The size of the Replicator Log volume varies for 

different environments. To determine the appropriate size for your 

environment, refer to the Veritas Storage Foundation Veritas Volume 

Replicator, Administrator’s Guide.

■ Select the volume layout.

■ Select the appropriate mirror options.

■ Click Next.

6 On the Add Drive Letter and Paths dialog box:

■ Click Do not assign a drive letter.

■ Click Next.

7 When prompted to format the volume:

■ Deselect Format this volume.

■ Click Next.

8 Click Finish to create the new volume.

9 If necessary, repeat step 2 through step 8 to create Replicator Log volumes 

for any additional RVGs on the primary site.

10 Repeat step 2 through step 8 to create Replicator Log volumes for additional 

disk groups on the secondary site. 
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Setting up the Replicated Data Sets (RDS) for VVR
Configuring VVR involves setting up the Replicated Data Sets on the hosts for 

the primary and secondary sites. The Setup Replicated Data Set Wizard enables 

you to configure Replicated Data Sets for both sites.

If you are using IPv6, make sure that you have set the appropriate IP preference 

for VVR before configuring VVR replication. The default setting is IPv4.

When you specify host names while configuring replication, VVR resolves the 

host names with the IP addresses associated with them. This setting determines 

which IP protocol VVR uses to resolve the host names. Use Veritas Enterprise 

Administrator (VEA) (Control Panel > VVR Configuration > IP Settings tab) to 

set the IP preference. 

To create the Replicated Data Set

1 Use the Veritas Enterprise Administrator (VEA) console to launch the Setup 

Replicated Data Set Wizard from the cluster node on the Primary where the 

cluster disk group is imported:

Click Start > All Programs > Symantec > Veritas Storage Foundation > 

Veritas Enterprise Administrator.

From the VEA console, click View > Connection > Replication Network.

2 Right-click Replication Network and select Setup Replicated Data Set.

3 Read the information on the Welcome page and then click Next.
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4 Specify names for the Replicated Data Set (RDS) and Replicated Volume 

Group (RVG) and then click Next.

By default, the local host is selected as the Primary Host. To specify a 

different host name, make sure the required host is connected to the VEA 

console and select it in the Primary Host list.

If the required primary host is not connected to the VEA console, it does not 

appear in the drop-down list of the Primary Host field. Use the VEA console 

to connect to the host.
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5 Select from the table the dynamic disk group and data volumes that will 

undergo replication and then click Next.

To select multiple volumes, press the Shift or Control key while using the up 

or down arrow keys.

By default, a mirrored DCM log is automatically added for all selected 

volumes. If disk space is inadequate to create a DCM log with two plexes, a 

single plex is created.
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6 Complete the Select or create a volume for Replicator Log page as follows:

To select an existing volume

■ Select the volume for the Replicator Log in the table (APP_REPL_LOG).

If the volume does not appear in the table, click Back and verify that the 

Replicator Log volume was not selected on the previous page.

■ Click Next.

To create a new volume

■ Click Create Volume and enter the following information in the dialog 

box that displays.

Name Enter the name for the volume in the Name field.

Size Enter a size for the volume in the Size field.

Layout Select the desired volume layout.
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■ Click OK to create the Replicator Log volume.

■ Click Next in the Select or create a volume for Replicator Log dialog 

box.

7 Review the information on the summary page and click Create Primary RVG.

8 After the Primary RVG has been created successfully, VVR displays the 

following message:

RDS with Primary RVG has been created successfully. Do you want 
to add Secondary host to this RDS for replication now?

Click No to exit the Setup Replicated Data Set wizard without adding the 

Secondary host. To add the Secondary host later, use the Add Secondary 

option from the RDS right-click menu.

Click Yes to add the Secondary host to the Primary RDS now. The Specify 

Secondary host for replication page appears.

9 On the Specify Secondary host for replication page, enter the name or IP 

address of the Secondary host in the Secondary Host field and then click 

Next.

If the Secondary host is not connected to VEA, the wizard tries to connect it 

when you click Next. This wizard allows you to specify only one Secondary 

host. Additional Secondary hosts can be added using the Add Secondary 

option from the RDS right-click menu.

Disk Selection Enables you to specify the disk selection method.

■ Enable the Thin Provisioned Disks Only check box to 

ensure that the Replicator Log volume is created 

only on Thin Provisioned (TP) disks.

Note: The check box will remain disabled if the diskgroup 

does not have any TP disk.

If this option is selected along with the Select disks 

automatically option, then the Replicator Log volume will 

be created only on TP disks. However, if you enable this 

check box along with Select disks manually option, then 

the user can select only TP disks from Available Disks.

For more information on Thin Provisioning refer to the 

Veritas Storage Foundation Administrator’s Guide.

■ Choose the Select disks automatically option if you 

want VVR to select the disks.

■ Choose the Select disks manually option to use 

specific disks from the Available disks pane for 

creating the volume. Either double-click on it or 

select Add to move the disks into the Selected disks 

pane.
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Wait till the connection process is complete and then click Next again.

10 If only a disk group without any data volumes or Replicator Log, as on the 

Primary host exists on the Secondary, then VVR displays a message. Read 

the message carefully.

The option to automatically create volumes on the Secondary host is 

available only if the disks that are part of the disk group have:

■ The same or larger amount of space as that on the Primary

■ Enough space to create volumes with the same layout as on the Primary

Otherwise, the RDS setup wizard enables you to create the required 

volumes manually.

■ Click Yes to automatically create the Secondary data volumes and the 

Replicator Log.

■ Click No to create the Secondary data volumes and the Replicator Log 

manually, using the Volume Information on the connected hosts page.

11 The Volume Information on connected hosts page appears. This page 

displays information on the availability of volumes on the Secondary nodes, 

if the Primary and Secondary hosts are connected to VEA.

This page does not appear if all the required volumes that are available on 

the Primary host are also available on the Secondary hosts.

■ If the required data volumes and the Replicator Log have not been 

created on the Secondary host, then the page displays the appropriate 

message against the volume name on the Secondary.

■ If an error occurs or a volume needs to be created, a volume displays 

with a red icon and a description of the situation. To address the error, 

or to create a new Replicator Log volume on the secondary site, click 

the volume on the secondary site, click the available task button and 

follow the wizard.

Depending on the discrepancies between the volumes on the primary 

site and the secondary site, you may have to create a new volume, 

recreate or resize a volume (change attributes), or remove either a DRL 

or DCM log.

When all the replicated volumes meet the replication requirements and 

display a green check mark, click Next.

■ If all the data volumes to be replicated meet the requirements, this 

screen does not occur.
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12 Complete the Edit replication settings page to specify the basic and 

advanced replication settings for a Secondary host as follows:

■ To modify each of the default values listed on this page, select the 

required value from the drop-down list for each property. If you do not 

wish to modify basic properties then replication can be started with the 

default values when you click Next.

Primary side IP Enter the virtual IP address for the Primary IP resource 

that will be used for replication. If there is more than one IP 

address available for replication, you can choose the one 

that you want to use from the drop-down list. If the 

required IP address is not displayed in the list then edit the 

field to add the IP address.

Secondary side IP Enter the virtual IP address on the Secondary that is to be 

used for replication. If there is more than one IP address 

available for replication, you can choose the one that you 

want to use from the drop-down list. If the required IP 

address is not displayed in the list then edit the field to add 

the IP address.



677Deploying SFW and VVR with Microsoft failover clustering

Part 3: Adding the VVR components for replication
Replication Mode Select the required mode of replication: Synchronous 

Override, Synchronous, or Asynchronous. The default is 

synchronous override.

Synchronous Override enables synchronous updates under 

typical operating conditions. If the Secondary site is 

disconnected from the Primary site, and write operations 

occur on the Primary site, the mode of replication 

temporarily switches to Asynchronous.

Synchronous determines updates from the application on 

the Primary site are completed only after the Secondary 

site successfully receives the updates.

Asynchronous determines updates from the application on 

the Primary site are completed after VVR updates in the 

Replicator Log. From there, VVR writes the data to the data 

volume and replicates the updates to the secondary site 

asynchronously.

If the Secondary is set to the synchronous mode of 

replication and is disconnected, the Primary data volumes 

with NTFS file systems may be displayed with the status as 

MISSING.

Replicator Log 

Protection

The AutoDCM is the default selected mode for the 

Replicator Log overflow protection when all the volumes in 

the Primary RVG have a DCM log. The DCM is enabled 

when the Replicator Log overflows.

The DCM option enables the Replicator Log protection for 

the Secondary host when the Replicator Log overflows, and 

the connection between the Primary and Secondary is lost. 

This option is available only if all the data volumes under 

the Primary RVG have a DCM Log associated with them.

The Off option disables Replicator Log Overflow protection.

In the case of the Bunker node. Replicator Log protection is 

set to Off, by default. Thus, if the Primary RLINK overflows 

due to the Bunker RLINK, then this RLINK is detached.
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The Override option enables log protection. If the 

Secondary node is still connected and the Replicator Log is 

about to overflow then the writes are stalled until a 

predetermined amount of space, that is, 5% or 20 MB 

(whichever is lesser) becomes available in the Replicator 

Log.

If the Secondary becomes inactive due to disconnection or 

administrative action then Replicator Log protection is 

disabled, and the Replicator Log overflows.

The Fail option enables log protection. If the log is about to 

overflow the writes are stalled until a predetermined 

amount of space, that is, 5% or 20 MB (whichever is lesser) 

becomes available in the Replicator Log. If the connection 

between Primary and Secondary RVG is broken, then, any 

new writes to the Primary RVG are failed.

Primary RLINK Name This option enables you to specify a Primary RLINK name 

of your choice. If you do not specify any name then VVR 

assigns a default name.

Secondary RLINK Name This option enables you to specify a Secondary RLINK 

name of your choice. If you do not specify any name then 

VVR assigns a default name.
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■ If you want to specify advanced replication settings, click Advanced. 

Edit the replication settings for a secondary host as needed.

Latency protection Determines the extent of stalling write operations on the 

primary site to allow the secondary site to “catch up” with 

the updates before new write operations can occur.

Off is the default option and disables latency protection.

Fail enables latency protection. If the number of 

outstanding write operations reaches the High Mark Value 

(described below), and the secondary site is connected, 

VVR stalls the subsequent write operations until the 

number of outstanding write operations is lowered to the 

Low Mark Value (described below). If the secondary site is 

disconnected, the subsequent write operations fail.

Override enables latency protection. This option 

resembles the Off option when the secondary site is 

disconnected, and the Fail option when the secondary site 

is connected.

Throttling of write operations affects application 

performance on the primary site; use this protection only 

when necessary according to replication throughput and 

application write patterns.

High Mark Value Is enabled only when either the Override or Fail latency 

protection option is selected. This value triggers the 

stalling of write operations and specifies the maximum 

number of pending updates on the Replicator Log waiting 

for replication to the secondary site. The default value is 

10000, the maximum number of updates allowed in a 

Replicator Log.
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Click OK to close the dialog box and then click Next.

13 On the Start Replication page, choose the appropriate option as follows:

Low Mark Value Is enabled only when either the Override or Fail latency 

protection options is selected. After reaching the High 

Mark Value, write operations on the Replicator Log are 

stalled until the number of pending updates drops to an 

acceptable point at which the secondary site can “catch 

up” to the activity on the primary site; this acceptable 

point is determined by the Low Mark Value. The default 

value is 9950.

Caution: When determining the high mark and low mark values for latency 

protection, select a range that is sufficient but not too large to prevent long 

durations of throttling for write operations.

Protocol UDP/IP is the default protocol for replication.

Packet Size Updates to the host on the secondary site are sent in 

packets; the default size 1400 bytes. The option to select 

the packet size is enabled only when UDP/IP protocol is 

selected.

Bandwidth By default, VVR uses the maximum available bandwidth. 

To control the bandwidth used, specify the bandwidth 

limit in Mbps.

Enable Compression Enable this checkbox if you want to enable Compression 

for the secondary host.
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■ To add the Secondary and start replication immediately, select Start 

Replication with one of the following options:

■ To add the secondary without starting replication, deselect the Start 

Replication option. You can start replication later by using the Start 

Replication option from the Secondary RVG right-click menu.

■ Click Next to display the Summary page.

14 Review the information.

Click Back to change any information you had specified and click Finish to 

add the secondary host to the RDS and exit the wizard.
 

Synchronize 

Automatically

If virtual IPs have been created, select the Synchronize 

Automatically option, which is the default recommended 

for initial setup to start synchronization of Secondary 

and start replication immediately.

If the virtual IPs for replication are not yet created, 

automatic synchronization remains paused and resumes 

after the Replication Service Group is created and 

brought online.

When this option is selected, VVR by default performs 

intelligent synchronization to replicate only those blocks 

on a volume that are being used by the file system. If 

required, you can disable intelligent synchronization.

Note: Intelligent synchronization is applicable only to 

volumes with the NTFS file systems and not to raw 

volumes or volumes with FAT/FAT32 file systems.

Synchronize from 

Checkpoint

If you want to use this method, then you must first create 

a checkpoint.

If you have considerable amount of data on the Primary 

data volumes, then you may first want to synchronize the 

secondary for existing data using the backup-restore 

method with checkpoint. After the restore is complete, 

use the Synchronize from Checkpoint option to start 

replication from checkpoint to synchronize the 

secondary with the writes that happened when backup-

restore was in progress.

For information on synchronizing from checkpoints, 

refer Veritas Storage Foundation TM Volume Replicator 

Administrator's Guide.
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Creating resources for VVR
Create the resources for VVR replication at the primary and secondary sites 

using the Failover Cluster Management tool. You create a network name 

resource and IP address resource to be used for VVR replication.

A separate valid IP address is necessary for VVR replication, because on the 

secondary cluster before a disaster, the application IP must be offline whereas 

the VVR IP must be online.

You create the resources for the primary site and then repeat the procedure to 

create the resources on the secondary site.

To create a Network Name resource and IP address resource for VVR 

replication

1 Right-click on the application group and select Add a Resource > Client 

Access Point.

2 In the Client Access Point panel of the New Resource Wizard, specify the 

following:

■ In the Name field, specify a name for the Network Name resource. The 

default is the name of the group you selected. Specify any name except 

the node and the virtual server name. The network name you assign 

when creating the resource for the secondary site must be different 

from the network name for the primary site.

■ Select the network and specify the IP address.

Click Next.

3 In the Confirmation panel, review the information and click Next.

4 When configuration is complete, click Finish.

5 Repeat the same procedure to create the IP and the Network Name resource 

at the secondary site. 

6 Bring the resources online.
 

Creating an RVG resource and setting the dependencies
This section describes additional tasks that must be done to complete the 

configuration of the Microsoft Failover Cluster application service group at both 

the primary and secondary sites. The tasks are:

■ Creating a replicated volume group (RVG) resource 

■ Setting the application resource dependency on the RVG resource
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Creating a replicated volume group (RVG) resource

To create a Replicated Volume Group (RVG) resource 

1 In Failover Cluster Management, expand Services and Applications, right-

click the application group that you have created and select Add a resource 

> More resources > Add Replicated Volume Group. 

The New Replicated Volume Group appears in the center panel under Disk 

Drives. 

2 Right-click New Replicated Volume Group and click Properties. 

3 On the General tab of the Properties dialog box, in the Resource Name field, 

type a name for the RVG resource.

4 On the Dependencies tab, add the dependencies for the RVG resource:

■ Click the box Click here to add a dependency

■ From the Resource drop-down list, select the network name you 

created for the RVG. Click Insert.

■ Click the box Click here to add a dependency

■ From the Resource drop-down list, select the Volume Manager Disk 

Group resource created for the application disk group. Click Insert.

5 On the Properties tab, specify the following:

■ In the rvgName field, type the same name that you assigned the RVG on 

the General tab. 

■ In the dgName field, type the name assigned in the VEA to the 

application disk group.

6 Click OK to close the Properties dialog box.

7 Right-click the RVG resource and click Bring this resource online.

8 Repeat the same steps to create the RVG resource at the secondary site.
 

Setting the application resource dependency on the RVG 
resource

When you specify resource dependencies, you control the order in which the 

cluster service brings resources online and takes them offline. 

The application resource has a direct dependency on the Volume Manager Disk 

Group resource. With the addition of the RVG resource to the application group, 

the application’s dependency will change. The application will have a direct 

dependency on the RVG resource, which in turn depends on the Volume 

Manager Disk Group resource.
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Note: The Volume Manager Disk Group resource represents the cluster disk 

groups created and managed by SFW.

1 Make sure the application resource is offline before attempting to modify 

the dependencies. Right-click the resource and click Take this resource 

offline.

2 Right-click the application resource and click Properties.

3 In the Dependencies tab of the Properties dialog box:

■ Click the box Click here to add a dependency.

■ Select the Replicated Volume Group resource from the dropdown list of 

available resources. 

■ Select the Volume Manager Disk Group (VMDG) resource from the 

dependencies list and click Delete.

4 Click OK to close the Properties dialog box.

The cluster configuration is now complete. Bring online the entire application 

group on the primary cluster. 
 

The dependency chart that follows indicates the dependencies that have been 

established.
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Figure 18-4 Dependencies of VVR-related resources

The chart shows only the VVR-related resources. Normally, there would be 

other resources involved in any clustered application. The main point of the 

chart is to show that the RVG resource is now dependent on the Volume 

Manager Disk Group resource and the VVR virtual IP resource. The 

dependencies relationship has changed. The application resource is no longer 

directly dependent on the Volume Manager Disk Group resource.

Part 4: Maintaining normal operations and recovery 
procedures

This section provides tasks during normal operations of this solution and also 

describes the recovery process.

Other Resources

Application Resource

Additional resources required by 

the application

“Volume Manager Disk 

Group” Resource 

Application Group 

“Replicated Volume Group” 

Resource 

“IP” Resource used for 

replication
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Normal operations: Monitoring the status of the replication
Under normal operating conditions, you can monitor the status of the 

replication using:

■ The VEA GUI

■ The command line interface (CLI)

■ Perfmon

■ Alerts

For details, refer to the “Monitoring Replication” chapter in the Veritas Storage 

Foundation Veritas Volume Replicator, Administrator’s Guide.

Performing planned migration
For maintenance purposes or for testing the readiness of the secondary host, 

you may want to migrate the application to the secondary host. The following 

are a generic set of tasks that you may need to perform:

To migrate the application to the secondary host

1 Take the Application resource offline on both the clusters. Stop the 

application so that volumes are not in use and secondary is up-to-date.

2 Transfer the primary role to the host at the secondary site by using the 

Migrate option.

■ From the VEA screen, right-click the primary RVG and select Migrate.

■ Select the secondary host and click OK. The replication role is migrated 

to the secondary host.

3 Assign drive letters to the volumes on the new primary. 

Make sure that these drive letters are the same as those of the original 

primary.

4 Bring the application group online on the new primary.

You can now verify that the application functions properly on the new primary 

with the replicated data. After verifying its functioning, you can revert the roles 

to what they were originally by repeating the procedure.

Note: Any changes that you make to the data on the new primary will get 

replicated to the original primary, which is now the secondary.
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Disaster recovery procedures
This section provides information on bringing up an application server on the 

secondary host in the event of a disaster. It also explains how to migrate the 

primary role back to the original Primary host once it is returned to normal 

functioning after a disaster.

Bringing up the application on the secondary host

To bring up the application on the secondary host

1 From the left pane in the VEA GUI console on the secondary host, right-click 

on the desired secondary RVG node inside the replication network. Select 

the Take Over option. The Take Over dialog box is displayed.

■ By default, the Enable Fast-Failback Logging option is selected if the 

data volumes have DCM logs associated with them. You can use this 

option to perform takeover with fast-failback logging.

The DCM is activated for fast-failback logging and the new incoming 

writes are marked on the DCM of the New Primary. 

If the replication status of Secondary RVG was Inactive when the 

Primary failed, then the Enable Fast-Failback Logging option is 

unavailable for selection. In this case you can perform Take Over 

without using fast-failback logging.

■ Select the Synchronize Automatically option if you want the new 

Primary and the original Primary to get synchronized automatically, 

after the original Primary recovers. 

If you have not selected this option, the original Primary, after it 

recovers will be in the Acting as Secondary state. To synchronize 

this original Primary with the new Primary use the Resynchronize 

Secondaries option from new Primary RVG’s right-click menu. When 

the resynchronization starts, the original Primary which was in the 

Acting as Secondary state is converted to a Secondary of the new 

Primary. The new Primary now starts replaying the DCM to update the 

Secondary with the writes that were written to the DCM.

2 If you do not want to use the Enable Fast-Failback Logging option, clear the 

checkbox, and click OK to perform Take Over without the fast-failback 

logging.

After takeover is complete, to add the Secondary hosts of the original 

Primary as Secondary hosts of the new Primary, delete the existing RVGs of 

the original Secondary hosts and then add them as a part of the new 

Primary. 
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3 If you have chosen to perform the Take Over operation without using fast-

failback logging and the original Primary becomes available again, convert 

it to a Secondary using the Make Secondary option. Then resynchronize the 

original Primary with the new Primary using the Synchronize Automatically 

option. Depending on the size of the data volume this may take quite a 

while.

Only after the synchronization is complete can you migrate the Primary 

role back to the original Primary. 

After takeover, the existing Secondary becomes the new Primary.

4 Assign drive letters to the volumes on the new Primary. Make sure that these 

drive letters are the same as those of the original Primary.

5 Bring the application resource online.

Now you can start using the application on the new Primary.

Restoring the primary host

After a disaster, if the original primary becomes available again, you may want 

to revert the role of the Primary back to this host. 

To restore the primary host

1 Depending on whether you performed Takeover with or without the fast-

failback option, do one of the following:

■ For Takeover with the Fast-failback option:

The original primary, after it has recovered, will be in the Acting as 

secondary state. If the original Primary is not in the Acting as 

secondary state, verify whether your network connection has been 

restored.

To synchronize this original Primary and the new Primary, use the 

Resynchronize Secondaries option from new Primary’s context menu. 

■ For Takeover without the Fast-failback option:

After performing a takeover without fast-failback, you must convert 

the original Primary to a Secondary by using the Make Secondary 

option. 

Note: Before performing the Make Secondary operation, the original Primary’s 

RVG and the new Primary’s RVG will be shown in separate RDSs. However, after 

this operation, they will be merged under a single RDS.

After the Make Secondary operation, the original primary will be 

converted to a secondary. Right-click on this Secondary RVG and select 

Start Replication with the Synchronize Automatically option.
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2 Take the application resource offline and stop the application.

3 After the sychronization is complete, perform a migrate operation to 

transfer the primary role back to the original Primary. To do this, right-click 

on the Primary RVG and select Migrate from the menu that appears.

4 Make sure that the volumes have retained the same drive letters as they had 

before the disaster. 

5 Bring the application group online on the original Primary.
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 8

Server Consolidation

This section highlights server consolidation, the practice of consolidating server 

hardware, software, and data from multiple smaller servers to fewer, larger 

servers. This section also includes two sample configurations.

This section contains the following chapters:

■ Server consolidation overview

■ Server consolidation configurations
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Chapter
 19
Server consolidation 

overview

This overview chapter describes server consolidation and focuses on how 

Veritas Storage Foundation for Windows (SFW) supports a server consolidation 

solution. The chapter’s topics are:

■ “Server consolidation definition” on page 693

■ “Need for implementing server consolidation” on page 693

■ “Advantages of using SFW with server consolidation” on page 694

■ “Overview of the server consolidation process” on page 695

Server consolidation definition
Server consolidation is the consolidation of server hardware, applications, and 

data from multiple smaller, less powerful machines to fewer, more powerful 

servers. It involves sharing data in storage pools, usually in a storage area 

network (SAN).

Need for implementing server consolidation
Server consolidation provides the benefit of overall cost reduction by reducing 

the number of servers and their maintenance and administrative costs. Server 

consolidation also frees up space in the data center and improves security by 

reducing virus or software gateway risks, while improving service and 

availability. The larger, more powerful servers are better able to provide the 

computing power necessary to keep businesses competitive for the future.
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Advantages of using SFW with server consolidation
Storage Foundation for Windows is ideally suited to support a server 

consolidation environment. Once servers are consolidated, SFW provides key 

features that assure fault tolerance and improve storage utilization. SFW’s 

fault-tolerant features, such as software mirroring and RAID-5, Dynamic Multi-

pathing (DMP), and clustering support assure high availability for consolidated 

storage, when business continuity is a requirement in a competitive business 

environment.

The SFW features that support server consolidation are:

■ Ability to work in a heterogeneous storage environment

You are not tied to a solution offered by a single hardware vendor.

■ Simple migration of data with disk group import and deport commands

If you have SFW disk groups already set up on multiple servers, you deport 

them on the source server, disconnect the attached storage, reattach the 

storage on the new larger server, and use the disk group import command 

to import the disk groups on the new server.

■ Storage virtualization with software RAID volumes 

Once the applications and data are consolidated on the new server, 

mirrored and RAID-5 volumes provide fault tolerance for critical data. 

Striped volumes add performance capabilities. Volumes that are both 

striped and mirrored offer both better performance and fault tolerance. 

Logical RAID volumes overcome the limitations of physical disks because 

these RAID volumes can span across disks and even disk arrays, thus 

assuring more efficient use of storage. Volumes can be configured online 

without restarting the server.

■ Capacity management and online volume growth 

Managing the space allocated for different functions is an important task 

that a system administrator must do on a consolidated server. SFW has a 

capacity monitoring function that alerts administrators when used space 

on a volume is near its capacity so that the volume can grow while it 

remains online. With this feature, you do not have to preallocate set 

amounts of storage for different purposes. More storage can be held in 

reserve in a pool for use only when it is needed. SFW volumes can be 

configured to increase capacity automatically when they pass a certain 

threshold. 

■ Online storage migration 

If you need to take down a disk or even a whole disk array for maintenance, 

you can migrate the data online through the Move Subdisk command. 

■ Special features that support storage in a SAN 
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The importing and deporting of disk groups with host ID protection and 

private disk group protection can support storage in a SAN. 

■ Dynamic Multi-pathing (DMP) 

The DMP software option increases performance of SAN-based disk arrays 

by spreading I/O between multiple paths to an array. Each path has a 

separate host adapter and cabling connecting the array and the server. If 

one path goes down, the DMP software automatically switches the storage 

associated with the failed path to an alternate path. Thus, the DMP software 

provides both fault tolerance for path failure and increases in performance 

through load balancing.

■ Clustering 

Storage Foundation for Windows supports clustering with MSCS and 

Storage Foundation HA for Windows includes Veritas Cluster Server. 

Clustering adds fault tolerance for servers. If one server in a clustered 

group of servers goes down, the storage of that server is taken over by 

another server in the cluster.

■ Additional fault tolerance features 

RAID-5 logging, dirty region logging, Hot Relocation, and FastResync (FR) 

increase the efficiency of the mirroring and RAID-5 functions in SFW.

■ Performance monitoring 

Online performance monitoring and tuning tools provide easy 

identification and minimization of I/O bottlenecks. These features allow 

you to increase throughput of the I/O in your system.

Overview of the server consolidation process
The server consolidation process involves more than just implementing the 

consolidation itself. It requires advance planning and approval of upper 

management. Here are some high-level steps:

■ Preliminary analysis: Determine what servers need to be consolidated. 

Take into account the applications being used and the departments 

involved. Research the hardware and software needs and costs.

■ Design a plan for the consolidation and secure approval and budget from 

upper management. 

The primary justifications in the plan are cost savings and the need to 

remain competitive in today’s business environment. The plan should also 

address IT management of the servers after the consolidation takes place.

■ Communicate with users about the proposed plan and identify the 

advantages of the plan before implementing the consolidation. 
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Involve users in the planning process. 

■ Do a proof of concept for the consolidation. Prototype the consolidation with 

a smaller number of servers that are not in production to see if your plan 

works. 

In the next section, two sample configurations are provided for 

demonstrating a proof of concept for consolidation. 

■ Implement the consolidation on actual production servers. 

■ Purchase, install, and configure the new hardware and software for the 

migration.

■ Migrate the data.

■ Test to see that everything is working properly.

■ Put into effect new IT management processes for the consolidated 

servers.

■ In the months following the consolidation, implement a procedure to 

evaluate its effectiveness and the effectiveness of the IT management 

processes for the consolidated servers.
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The chapter’s topics are:

■ “Typical server consolidation configuration” on page 697

■ “Server consolidation configuration 1—many to one” on page 699

■ “Server consolidation configuration 2—many to two: Adding clustering and 

DMP” on page 705

■ “SFW features that support server consolidation” on page 714

Typical server consolidation configuration
This chapter provides two sample configurations that can be used as proof of 

concept for a consolidation. 

The example shows a typical server consolidation situation. The consolidation 

could involve consolidating as many as 20 to 40 servers to one or two servers.
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Figure 20-1 General server consolidation configuration

Proof of concept
Testing the consolidation steps on a smaller number of servers provides an 

overview of the issues involved and how the process would work. In the 

configurations presented in this chapter, four servers are consolidated into one 

or two servers. The first configuration, which consolidates four smaller servers 

to one large server, provides fault tolerance through mirroring. In the second 

configuration, clustering and DMP are added to improve the fault tolerance, and 

an additional server is needed to support clustering. New, larger, more powerful 

servers can be used in this proof of concept testing. Once the concept is tested, 

the main task is to migrate the data from the production servers to the new 

larger servers.
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Server consolidation configuration 1—many to one
The following configuration illustrates consolidating many servers to one.

Figure 20-2 Proof of concept: Consolidating four small servers to one large 

server

About this configuration
In this configuration, four small servers are consolidated into a single larger 

server. The configuration also demonstrates that a server consolidation does 

not require that you eliminate all existing direct-attached storage units and 

replace them with large storage arrays. Setting up the storage on a SAN allows 

you to use different combinations of storage devices and still derive the benefits 

from SFW’s storage management features once the storage has been migrated 

from the small servers to a SAN. 
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Proof of concept

The four servers represent different Windows operating systems and Storage 

Foundation for Windows software combinations, which might be present in a 

production environment. The steps demonstrate that slightly different 

procedures are needed in preparing the storage for migration in each of these 

combinations.

In setting up your server consolidation configuration for proof of concept, select 

servers to migrate that have different combinations of typical hardware and 

software to determine the special requirements of such cases. 

Phased approach: Flexible use of storage devices

In this example configuration, the steps are organized in phases:

■ Preparing to consolidate

■ Migrating the data to the large server

■ Migrating data from the direct-attached storage to the storage array

■ Adding the storage array

■ Completing the consolidation process by migrating the storage from 

remaining servers

After the second phase in this example, all the direct-attached storage units 

have been detached from the small servers and are a storage pool on a SAN that 

is under the control of the new, large Windows Server system that is running 

SFW. You could stop at this point and still have many benefits from the storage 

that is now under SFW’s management. If circumstances do not permit the 

purchase of a large storage array, you can simply use the existing direct-

attached storage. Another alternative is to use both a storage array and some of 

the direct-attached storage. In this configuration and in Server Consolidation 

Configuration 2, using both a storage array and some of the direct-attached 

storage is shown.

The table below outlines the high-level objectives for implementing the 

configuration and the tasks for each objective: 

Table 20-1 Tasks for server consolidation for many to one configuration

Objectives Tasks

“Reviewing the configuration 

requirements” on page 702

✔ Verify hardware and software 

requirements.
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“Preparing to consolidate” on 

page 702

✔ Make sure the data is backed up 

from the smaller servers before 

proceeding.

✔ Set up the new large server and 

install the operating system and 

SFW. Connect it to the switch.

✔ Prepare the data from each smaller 

server for consolidation by 

upgrading the server’s disks to 

dynamic disk groups, using either 

Disk Management or a version of 

Volume Manager for Windows. 

✔ Power down all the smaller servers 

and detach the storage.

“Migrating the data to the large 

server” on page 703

✔ Reattach the direct-attached 

storage to the switch. 

✔ From the large server, import the 

disk groups from the direct-

attached storage. 

The direct-attached storage is now 

attached to the SAN and is under 

the management of the large server 

that is running SFW. You could stop 

at this point if a large storage array 

is not available.

“Adding the storage array” on 

page 704

✔ If you want to use a large storage 

array, set up the hardware array and 

connect it to the switch. 

✔ Migrate the data to the large storage 

array.

“Completing the consolidation 

process” on page 705

✔ Migrate the data from the 

remaining servers.

Table 20-1 Tasks for server consolidation for many to one configuration

Objectives Tasks
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Reviewing the configuration requirements
Reviewing the prerequisites and the configuration allows you to gain an overall 

understanding of the configuration and its requirements.

Prerequisites

These procedures assume:

■ Experience in setting up computer hardware, switches, and storage arrays

■ Familiarity with the Windows operating systems and SFW/Volume Manager 

for Windows commands

Supported software

■ Veritas Storage Foundation 6.0.2 for Windows (SFW) 

or

Veritas Storage Foundation HA 6.0.2 for Windows (SFW HA) 

■ One of the Windows Server 2012 operating systems supported by SFW or 

SFW HA

Note: To determine the supported software for SFW or SFW HA, review the 

Software Compatibility List on the Symantec Support web site at: 
http://www.symantec.com/docs/TECH201485

Hardware setup

■ 4 smaller servers with direct-attached storage

■ 1 larger, more powerful server

■ Fibre switch and appropriate cabling for the SAN

■ Hardware storage array

Note: To determine the approved hardware for SFW or SFW HA, review the 

Hardware Compatibility List on the Symantec Support web site at: 
http://www.symantec.com/docs/TECH152806

Preparing to consolidate
In this phase, set up the large server and prepare the data for migration.

http://www.symantec.com/docs/TECH201485
http://www.symantec.com/docs/TECH152806
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To prepare for consolidation

1 Identify the applications and data on the smaller servers that are a subset of 

the applications and data to be moved to the large server. You may want to 

have the users delete unnecessary files before the consolidation takes place.

2 Back up the data from the small servers.

Caution: back up the data from the small servers before proceeding.

3 Set up the large server and connect it to the switch.

4 Install the Windows Server 2012 operating system and Storage Foundation 

for Windows on the large server.

5 Prepare the data from each smaller server for migration by upgrading the 

server's disks to dynamic disk groups and powering down the server.

For Windows Server 2012 (no VM or SFW installed)

■ Use Disk Management to upgrade basic disks to dynamic disks.

■ Power down the server.

Migrating the data to the large server
Migrate the data to the large server. Perform the steps for each smaller server, 

one at a time.

To migrate the data to the large server

1 Disconnect the direct-attached storage from the small server.

2 Connect the direct-attached storage to the switch to make it accessible to the 

large server.

Note: All the direct-attached storage devices and the large server need to be 

in the same zone on the switch.

3 Using SFW on the large server, rescan the disks.

4 In SFW, import the disk groups from the direct-attached storage to make 

them a part of the storage that the large server manages.

Clear the host ID during the import process, if the source disk group was not 

created with SFW. A dialog box will come up for this purpose during the 

import command.

5 Assign drive letters to the imported disk groups.

On a Windows Server 2012 system, the default operating system setting 

requires the manual assignment of drive letters. Many administrators 
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prefer to set drive letters manually rather than have the operating system 

do it.

Note: If you want the drive letters to be assigned automatically after a disk 

group is imported, use the mountvol command to change the default 

setting. Refer to the Microsoft documentation about the mountvol 

command for information on how to set up the automatic assignment of 

drive letters.

6 If desired, update the imported disk groups to the latest version of dynamic 

disk group type.

This is recommended to take advantage of the Windows Server 2012 

features in SFW. Use the Upgrade Dynamic Disk Group Version command.

7 Test the data on the Windows Server 2012 system.

At this point, you can stop if you do not have a large storage array available. You 

can still take advantage of SFW’s storage management features by having the 

direct-attached storage on the SAN. It is not necessary to have a large storage 

array to have these benefits.

Adding the storage array
If you have a large storage array available, the data may also be migrated to a 

hardware storage array on the SAN. You can eliminate all the direct-attached 

storage devices or keep them to increase your storage capacity. They can also be 

added into the configuration when needed.

To add the storage array

1 Set up and connect the hardware storage array to the switch.

On the switch, the hardware storage array must be in the same zone as the 

direct-attached storage devices and the large server.

2 Configure the array so that half of its disks are a mirror to the other half, 

using RAID-1. This provides fault tolerance to the storage.

3 Join the disk groups on the array storage and the direct-attached storage. 

This is done through the Join Dynamic Disk Group command.

4 Use the Move Subdisk command to move the volumes with data from the 

direct-attached storage to the array storage. You may want to keep some of 

the direct-attached storage on the SAN under the control of the large server.

To access the Move Subdisk command:

■ Select the volume that contains the subdisk you want to move.

■ Click on the Subdisks tab in the right pane of the window.
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■ Right-click the desired subdisk in the Subdisks tab and select Move 

Subdisk from the context menu.

The Move Subdisk command also can be done by dragging and dropping the 

subdisks between disks in the Disk View. This method should be used with 

care to make sure that you do not move the subdisk to the wrong disk.

5 Test the data on the Windows Server 2012 system.

At this point, the migration of the storage from the four smaller servers is 

complete.

Completing the consolidation process
When you are satisfied that everything is working properly, migrate data from 

the remaining servers, using the methods shown in this configuration example.

Server consolidation configuration 2—many  
to two: Adding clustering and DMP

The following configuration consolidates many servers to two with Microsoft 

clustering and DMP.
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Figure 20-3 Adding fault tolerance with Microsoft clustering and DMP — 

requires two servers

About this configuration
This configuration is an upgrade to Server Consolidation Configuration 1, to add 

Microsoft clustering and DMP. Add a new server and host adapters, NICs, and a 

new switch.

The table below outlines the high-level objectives for implementing the 

configuration and the tasks for each objective: 

Server A

Switch 1
Controller 1

Controller 2

HBA 1

Channel 2

Channel 2

Channel 1

Channel 1

HBA 2

HBA 2

HBA 1

Server B

Switch 2
Direct

Attached
Storage

Direct
Attached
Storage

Storage Array

Ethernet LAN

Table 20-2 Tasks for server consolidation adding Microsoft clustering and DMP

Objectives Tasks

“Reviewing the configuration 

requirements” on page 709

✔ Verify hardware and software 

requirements.
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“Adding the new hardware” on 

page 710

✔ Add the new server, HBAs, network 

cards, and fibre switch.

✔ Leave the second path for DMP 

unconnected on the existing server 

and the new server. It does not get 

connected until the end of the 

installation process.

“Establishing the Microsoft 

failover cluster” on page 710

✔ Refer to Microsoft instructions for 

establishing the cluster under 

Microsoft clustering.

“Adding SFW support to the 

cluster” on page 711

✔ With Server B as the active cluster 

node, use Add or Remove Programs 

to add DMP and the Microsoft 

clustering option to the first server.

✔ With Server A as the active node, 

install SFW with the DMP and 

Microsoft clustering options to 

Server B.

✔ Change the existing disk groups to 

cluster disk groups.

✔ Prepare a disk group for the 

dynamic mirrored quorum.

“Setting up Microsoft failover 

cluster groups for the 

applications” on page 712

✔ If you have applications on the 

server that you want to cluster, 

create Microsoft failover cluster 

groups for them.

“Installing applications on the 

second computer” on page 712

✔ Install the applications’ program 

files on the local drive of Server B.

“Completing the setup of the 

application group in the Microsoft 

cluster” on page 712

■ Complete the cluster application 

group by adding resources and 

setting dependencies.

Table 20-2 Tasks for server consolidation adding Microsoft clustering and DMP

Objectives Tasks
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More on DMP paths

In this configuration, there are two DMP paths, one going through Switch 1, 

which includes HBA 1 from Server A, HBA 1 from Server B, Channel 1 from the 

first direct-attached storage device, and Channel 1 from the second direct-

attached storage device. The second path includes HBA 2 from Server A, HBA 2 

from Server B, Channel 2 from the first direct-attached storage device, and 

Channel 2 from the second direct-attached storage device.

Caution: Do not have the second path to the storage connected to the SAN until 

DMP is installed and the storage array is included under DMP. If you allow two 

paths to the storage without DMP control, data can become corrupted.

The two switches keep the paths separate. You could use one large switch and 

zone it with two zones, one for each path. 

In most DMP configurations, direct-attached storage is not included along with 

a storage array, but it is shown in this example to demonstrate that you can use 

direct-attached storage with DMP.

“Changing the quorum resource to 

the dynamic quorum resource” on 

page 712

■ Create a dynamic disk group for the 

quorum with a mirrored volume if 

this task was not done earlier.

■ Make that disk group a Volume 

Manager Disk Group type resource 

in the default Cluster Group.

■ Change the quorum resource to the 

dynamic mirrored quorum 

resource.

“Verifying the cluster 

configuration” on page 713

■ Test the cluster by moving the 

cluster resources to the other node.

“Enabling DMP” on page 713 ■ Using DMP, include the main 

storage array and, optionally, the 

direct-attached storage devices. 

Now attach the second path to the 

configuration and rescan.

Table 20-2 Tasks for server consolidation adding Microsoft clustering and DMP

Objectives Tasks
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Note: When Storage Foundation for Windows is first installed, DMP control is 

not in effect. All arrays attached to the system come up as excluded. You must 

include the storage array and any direct-attached storage devices to enable 

DMP.

Reviewing the configuration requirements
Reviewing the prerequisites and the configuration allows you to gain an overall 

understanding of the configuration and its requirements.

Prerequisites

These procedures assume:

■ Experience in setting up computer hardware, switches, and storage arrays

■ Familiarity with the Windows operating systems and SFW commands

Supported software

■ Veritas Storage Foundation 6.0.2 for Windows (SFW) 

or

Veritas Storage Foundation HA 6.0.2 for Windows (SFW HA) 

■ One of the Windows Server 2012 operating systems supported by SFW or 

SFW HA

Note: To determine the supported software for SFW or SFW HA, review the 

Software Compatibility List on the Symantec Support web site at: 
http://www.symantec.com/docs/TECH201485

Hardware setup

Assume an original configuration of one large already consolidated server, one 

storage array, and two direct-attached storage devices that are all connected on 

a SAN.

Add:

■ 1 large server of the same type as the first server

■ Fibre switch

■ 2 HBAs, one for each computer, required for DMP

http://www.symantec.com/docs/TECH201485
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■ 6 network interface cards, 3 for each server (2 each for the private network 

and 1 for the public network)

Note: To determine the approved hardware for SFW or SFW HA, review the 

Hardware Compatibility List on the Symantec Support web site at: 
http://www.symantec.com/docs/TECH152806

Recommendations

It is acceptable to use one NIC for the private network, but using two cards is 

strongly recommended to avoid making the private network a single point of 

failure in the configuration.

Refer to the Microsoft documentation for the specific requirements for the 

Microsoft failover cluster. For example, you will need a static IP address for each 

network interface card and a static IP address for the cluster. The two clusters 

need to be members of the same domain.

Refer to Chapter 15, “Deploying SFW with Microsoft failover clustering” on 

page 565 for more information on the process of setting up an Microsoft failover 

cluster to work with SFW.

Adding the new hardware
Install the necessary hardware on both Server A and Server B. 

To add the new hardware

1 Verify that your data from the large server is backed up before proceeding.

2 Install two host adapters in each server.

Caution: Do not connect the second path through HBA 2 on each server at this 

time.

3 Install the three network interface cards in each server. Do not make the 

connections between the two servers at this time.

4 Do any necessary configuration of the second switch without actually 

connecting it to the servers.

Establishing the Microsoft failover cluster
Complete the steps necessary to install a cluster on Server A and Server B, using 

Microsoft clustering. Refer to the Microsoft documentation for the detailed 

instructions. The general steps are:

http://www.symantec.com/docs/TECH152806
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■ Do the necessary network configuration steps on Server A.

■ For example, establish the static IP addresses of the network cards and make 

sure a domain is set up that can be used by the two servers on the cluster.

■ On Server A, access SFW and create a 500 MB partition on a disk that will be 

used as the quorum disk when the first node of the cluster is created. You 

may need to revert a dynamic disk to basic to implement this step.

■ Create the first node of the cluster on Server A.

■ Install the Windows Server 2012 operating system on Server B and do the 

networking configuration steps for Server B.

■ Connect the networks between the two sites and verify their connectivity.

■ Add the second node of the cluster to Server B.

■ Test the cluster by moving the cluster resources from Server A to Server B. 

Server B becomes the active node. At this point, keep the control of the 

cluster with Server B.

Adding SFW support to the cluster
Use the following procedure to add SFW support to the cluster.

To add SFW support to the cluster

1 With the active node of the cluster on Server B, use Add/Remove Programs 

on Server A to add the Microsoft clustering and DMP options to SFW on that 

server and reboot. Then move the cluster resources back to server A. Server 

A is now the active node.

Note: If you reboot a server that has the active node of the cluster, it will fail 

over to the other node. You have more control of the situation by moving 

the resources to the other node before doing a reboot.

2 On Server B, install SFW with the DMP and Microsoft clustering options and 

reboot.

3 On Server A, which is now the active node of the cluster, use SFW to create a 

dynamic cluster disk group that will be used for the dynamic quorum. The 

disk group should contain three disks, and the disk size is recommended to 

be 500 MB. You need to create a three-way mirrored volume on the three 

disks with SFW. You can also use two disks, but three disks provide added 

redundancy.

4 Change the existing regular SFW dynamic disk groups on Server A to cluster 

disk groups. 
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A regular dynamic disk group is converted to a cluster disk group through 

the command line by using the command to import a disk group, vxdg 

import, with the -s option, the option that does the conversion. You will 

need to deport the disk groups first before you can import them. You can 

deport them through the GUI Deport Dynamic Disk Group command.

Setting up Microsoft failover cluster groups for the applications
If you have applications on the server that you want to cluster, you need to set 

up a cluster group for each application. Set up the groups first before the 

application is installed because if the application is cluster-aware, it may need to 

reference the cluster group. For detailed steps on setting up Microsoft failover 

cluster groups, see “Creating a group for the application in the failover cluster” 

on page 591.

Note that you will not be able to finish setting up the resources for the group 

until the application is installed on the second node.

Installing applications on the second computer
If you have one or more applications on the existing computer and you want 

their data and associated files to be clustered, you need to install the 

applications on the local drive of the new computer. The applications may be 

cluster-aware and require specific procedures to install. Refer to the application 

documentation.

For tips on installing applications in an Microsoft clustering environment, see 

“Installing the application on cluster nodes” on page 593.

Completing the setup of the application group  
in the Microsoft cluster

Once the application is installed, complete the configuration of the application 

group in the Microsoft cluster. For details, see “Completing the setup of the 

application group in the failover cluster” on page 594.

Changing the quorum resource to the dynamic quorum resource
For details about changing the quorum resource to the dynamic quorum 

resource, see “Implementing a dynamic quorum resource” on page 595.
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Verifying the cluster configuration
Verify that the cluster can fail over by moving the cluster group manually 

between the nodes to make sure it works properly. For details, see “Verifying the 

cluster configuration” on page 598.

Enabling DMP
These steps assume that SFW with the DMP option has been installed. See 

“Adding SFW support to the cluster” on page 711 in this example.

To enable DMP

1 With SFW on the first server, bring up DMP and include the disks on the 

storage array and optionally the two direct-attached storage devices. To 

include each storage array or direct-attached storage device under DMP 

control:

a Display the Array Settings screen for the device you are including by 

doing the following:

■ In the tree view under the Disks icon, select a disk from the storage 

array.

■ In the right pane, click the Paths tab for the disk. Only one path 

should display in the Paths tab, since the disk is not yet under DMP 

control.

■ Right-click the path and select Array Settings from the path 

context menu that comes up.

■ The Array Settings window comes up. The Exclude checkbox is 

checked.

b Uncheck the Exclude checkbox.

2 Using appropriate cables, connect the second path on Server A to Switch 2. 

a Connect the path through Server A, HBA 2, Channel 2 of the direct-

attached storage, and Controller 2 of the large storage array.

b Complete any necessary configuration of the switch.

3 Go to Actions and select Rescan to verify that two paths are shown under 

the Paths tab. This indicates that one set of disks has two paths and that 

DMP is installed correctly.

4 Complete step 1 to step 3 on Server B.

Microsoft clustering and DMP are now set up, and the upgraded configuration 

steps are complete.
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With consolidated servers, Storage Foundation for Windows has multiple 

features that assure fault tolerance and improve storage utilization. Many of 

those features are highlighted in the section “Advantages of using SFW with 

server consolidation” on page 694.

The following section adds more information about some of the features. It 

describes how to create a script for Automatic Volume Growth based on capacity 

and gives a high-level view of SFW features for supporting storage in a SAN and 

for performance management. Topics in this section include:

■ Automatic volume growth

■ Features that support storage in a SAN

■ Performance monitoring

Automatic volume growth
Storage Foundation for Windows comes with an Automatic Volume Growth 

feature that monitors the capacity of dynamic volumes and automatically 

increases the size of the volume when used space on it reaches a predetermined 

size. 

With this procedure, you can conserve disk space on your servers because space 

is distributed automatically on an as-needed basis. You do not have to be 

available to allocate the additional disk space when it is required. 

Features that support storage in a SAN
In a SAN environment, it is important to protect storage so that it cannot be 

accessed by more than one host at a time. SFW provides the feature of private 

dynamic disk group protection that protects a disk group with a SCSI 

reservation so that other hosts cannot access the data. For more information on 

this feature, see the Veritas Storage Foundation Administrator’s Guide. 

Clustering is another way to protect the storage in a SAN. It also uses a SCSI 

reservation to keep the disk group from being accessed by other hosts in a SAN.

Performance monitoring
The statistics feature of SFW provides I/O statistics to allow performance tuning 

to improve overall disk and system performance. Through the Online 

Monitoring window, hot spots are identified. A hot spot is an area of high I/O 

activity that may cause bottlenecks in I/O throughput. If a disk has these hot 

spots, consider moving one or more of its subdisks to another disk that shows 
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below-average I/O activity. For more information on this topic, see the Veritas 

Storage Foundation Administrator’s Guide.
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